SECTION 1
SCOPE

1.1
IDENTIFICATION

This VDD describes differences in the Tactical Automated Mission Planning System (TAMPS) 6.2 Build dated 11 March 1998, as compared against the (TAMPS) 6.1.1 Release Build dated 23 July 1997. This document has been written in accordance with DOD-STD-2167A and Data Item Description DI-MCCR-80013.

1.2
SYSTEM OVERVIEW

TAMPS provides the Navy and the Marine Corps with an automated means to plan and analyze mission routes against targets in an operational area.  TAMPS is an interactive, computer graphics-aided system used to develop, analyze, store, and download mission data for strike aircraft, support aircraft, and standoff weapon systems.

TAMPS prepares and maintains an extensive database (DB) of geographical and cultural features supporting specialized weapons that have unique mission planning requirements.  TAMPS employs a modular architecture to support these requirements while maintaining consistent displays, user interfaces, and a set of common databases (i.e., "tamps," MIDB, NID, DAFIF/GPS).  A set of core modules satisfies common mission planning requirements and serves as a basis for the integration of independently developed vehicle (or weapon system) specific application packages supporting unique requirements.  These application packages are referred to as Mission Planning Modules (MPMs).  Modules which operate in the TAMPS mission planning environment have access to the TAMPS core libraries (i.e., Workstation Executive (WSE), Object Hierarchy, Database Access, Data Bucket Manager, Mapping System, Utility, Aircraft Mission Planning, System, Threat, Mission Planning Tool, System Administration, Products, Tactical Map Tool Kit, Help, Intelligence, Global Positioning System (GPS), Flight Performance Module (FPM), and Joint Services Imagery Processing System, Navy (JSIPS-N)/TAMPS Interface Module (JTIM) Core Extension) which support interactive, graphics-oriented mission planning.

The TAMPS Version 6.2 system consists of 11 Computer Software Configuration Items (CSCIs), including the TAMPS Common Operating Environment (COE) Core, TAMPS Core Extension, F/A-18, High Speed Anti-Radiation Missile (HARM), Forward Area Minefield Planning (FAMP), E-2C, Aircraft, Joint Standoff Weapon (JSOW)/Joint Direct Attack Munition (JDAM), Standoff Land Attack Missile (SLAM), Common Operational Modeling, Planning, and Simulation Strategy (COMPASS), and Tactical Electronic Reconnaissance Processing and Evaluation System (TERPES).

The MPMs supported by TAMPS 6.2 include:  F/A-18, HARM, FAMP, E-2C, A-6E, F-14A/B/D, EA-6B, AV-8B, S-3B, SH-60B, CH-46E, AH-1W, UH-1N, CH-53E, P-3C, CH-53D, KC-130F/R/T, HH-60H, SH-60F, JSOW/JDAM, SLAM, C-2A, COMPASS, and TERPES.  The F/A-18, HARM, FAMP, E-2C, JSOW/JDAM, SLAM, COMPASS, and TERPES MPMs are separate CSCIs within the TAMPS 6.2 architecture.  The remaining MPMs reside within the Aircraft CSCI.

TAMPS internal interfaces allow the TAMPS MPMs to include the following TAMPS Core libraries (i.e., object code modules) at link time:  WSE, Object Hierarchy, Database Access, Data Bucket Manager, Mapping System, Utility,  Aircraft Mission Planning, System, Threat, Mission Planning Tool, System Administration, Products, Tactical Map Tool Kit, Help, Intelligence, GPS, FPM, and JTIM Core Extension.  Inclusion of these libraries provides the TAMPS MPMs with access to WSE functions, the Object Hierarchy client layer software, the TAMPS databases, the data bucket manager (to store, retrieve, and manipulate data in a single data structure), the mapping system (to manipulate the map background and objects displayed in the map background), general utilities, aircraft mission planning utilities, standard TAMPS initialization functions, threat libraries for generating Radar Terrain Masks (RTMs), mission planning tools, system administration functions, products software (to preview and print formatted reports), the tactical map tool kit, the help capability for TAMPS applications, intelligence utilities, GPS functions, FPM computation software, and map imagery functions.

1.3
DOCUMENT OVERVIEW

SECTION 1.  This section contains the VDD Identification, System Overview, and Document Overview.

SECTION 2.  This section identifies the documents, both government and non-government, relevant to this report.

SECTION 3.  This section covers the following version description material.

3.1
Inventory of material

3.2
Inventory of CSCI Contents

3.3
Class I changed installed

3.4
Class II changed installed

3.5
Adaptation Data

3.6
Interface compatibility

3.7
Bibliography of reference documents

3.8
Operational Description

3.9
Installation instruction update for ULTRA 2 Model 1200/1300, ULTRA 2 Model 2300, and Enterprise 4002 Server Hardware

3.10
SOR, STR, DTR, and Non-DTR change descriptions and file listings for this release

3.11
Description of all STRs and DTRs in closed, in test, and in work

3.12
Possible problems and known errors

SECTION 4.  This section defines acronyms and abbreviations.

APPENDIX A.  This appendix contains the SOR, STR, DTR, and Non-DTR changes in this release as of 11 March 1998.

APPENDIX B.  This appendix contains descriptions for all STRs closed, in test, and in work as of 11 March 1998.

APPENDIX C.  This appendix contains descriptions for all DTRs closed, in test, and in work as of 11 March 1998.

APPENDIX D.  This appendix contains the OPNOTES written against TAMPS 6.2 as of 11 March 1998.

APPENDIX E.  This appendix contains the TAMPS 6.2 installation procedures.

SECTION 2
REFERENCE DOCUMENTS

2.1
GOVERNMENT DOCUMENTS

2.1.1
 SPECIFICATIONS

a.
TAMPS 6.2 System Specification, Version 1.1, 22 January 1998

2.1.2
 STANDARDS

a.
MIL-STD-973, Configuration Management, 13 Jan 95 Notice 3 ñ (Being replaced by National Consensus Standard for CM (EIA/IS649 8/95))

2.1.3
 OTHER PUBLICATIONS

a.
TAMPS 6.2 Interface Design Document, February 1998.

b.
TAMPS 6.2 Interface Requirement Specification, Version 1.1, 22 January 1998.

c.
TAMPS 6.2 Software Development and Configuration Management Plan, May 1997.

d.
TAMPS 6.1 Software Design Document for CORE CSCI (DRAFT), March 1997.

SECTION 3
VERSION DESCRIPTION

3.0
VERSION DESCRIPTION

This VDD describes differences in the TAMPS 6.2 and the 6.1.1 Release Build versions.

3.1
INVENTORY OF MATERIALS RELEASED

The following material will be prepared and delivered for initial release of software release 6.2:

a.
One (1) TAMPS 6.2 CD-ROM  (11 March 1998)

3.2
INVENTORY OF CSCI CONTENTS

The following is a description of the contents of the TAMPS 6.2 CDROM by directory.  Files ending in ì.TGZî are compressed tar sets.

Check Sum
Blocks
Date
File Name
Contents

/cdrom_62_Build_4:

1240
13
Mar 11 11:11
ARCTIC.CSH

15370
16
Mar 11 11:07
ARCTIC.ENV

54419
216
Oct 19 1995
GUNZIP.EXE


42950
2
Mar 12 01:08
VERSION.DAT

/cdrom_62_Build_4/SOURCE:

28192
3 
Mar 11 18:05
CONNECT.DOC

538
1136 
Mar 11 11:00
LOADINST.MSW

36457
55
Mar 11 18:05
MIDBFAC.MSW

27488
7
Mar 11 11:09
README.SRC

/cdrom_62_Build_4/SOURCE/TAMPS:

12231
557
Mar 11 20:25
A6E_SRC.TGZ

50343
3529
Mar 11 20:45
BINDINGS.TGZ

21595
48
Mar 11 20:25
CONFIG.TGZ

56048
1190
Mar 11 20:44
INCLUDE.TGZ

51413
77074
Mar 11 20:43
LIB.TGZ

/cdrom_62_Build_4/TAMPS:

/cdrom_62_Build_4/TAMPS/CORE:

10801
5
Mar 11 20:25
CDYNAMIC.TGZ

9754
1727
Mar 11 20:24
CSTATIC.TGZ

41911
978
Mar 11 20:24
DYNAMIC.TGZ

5052
58534
Mar 11 20:24
STATIC.TGZ

/cdrom_62_Build_4/TAMPS/COTS:

48837
4924
Mar 11 17:53
COMPASS.TGZ

38904
3389
Mar 11 17:52
DCW.TGZ

11875
1
Mar 11 17:44
DRIVERS.TGZ

39491
3984
Mar 11 17:54
FORE.TGZ

46205
5765
Mar 11 17:44
GNU.TGZ

56516
10042
Mar 11 17:53
HPNP.TGZ

3510
245
Mar 11 17:52
JNL.TGZ

23875
1389
Mar 11 17:52
LIBS.TGZ

64227
3
Mar 11 17:53
MAGVAR.TGZ

57303
913
Mar 11 17:52
METACARD.TGZ

269
187441
Mar 11 17:52
MIDB.TGZ

44832
14769
Mar 11 17:44
MOTIF.TGZ

18948
1756
Mar 11 17:53
MROUTED.TGZ

29961
37214
Mar 11 17:43
PATCHES.TGZ

13725
128780
Mar 11 17:41
PKGS_OS.TGZ

35636
16166
Mar 11 17:41
PKGS_U2.TGZ

8762
28945
Mar 11 17:47
REP_SVR.TGZ

6864
52412
Mar 11 17:46
SYBASE.TGZ

4867
912
Mar 11 17:53
TCL.TGZ

968
11166
Mar 11 17:37
VVM.TGZ

28673
7493
Mar 11 17:53
XEROX.TGZ

/cdrom_62_Build_4/TAMPS/MPM:

38968
475
Mar 11 20:18
MPM1.TGZ
AV8B

21772
4170
Mar 11 20:22
MPM10.TGZ
F14

55110
12230
Mar 11 20:23
MPM11.TGZ
FAMP

29841
293
Mar 11 20:23
MPM12.TGZ
HH60H

44381
416
Mar 11 20:23
MPM13.TGZ
KC130F

23815
364
Mar 11 20:23
MPM14.TGZ
KC130R

37782
364
Mar 11 20:23
MPM15.TGZ
KC130T

43470
1393
Mar 11 20:24
MPM16.TGZ
P3C

13575
738
Mar 11 20:24
MPM17.TGZ
S3B

39985
299
Mar 11 20:24
MPM18.TGZ
SH60B

55811
298
Mar 11 20:24
MPM19.TGZ
SH60F

33204
260
Mar 11 20:18
MPM2.TGZ
AH1W

6616
285
Mar 11 20:24
MPM20.TGZ
UH1N

26083
270
Mar 11 20:18
MPM3.TGZ
C2A

52858
303
Mar 11 20:18
MPM4.TGZ
CH46E

30235
334
Mar 11 20:18
MPM5.TGZ
CH53D

50299
378
Mar 11 20:19
MPM6.TGZ
CH53E

34806
3386
Mar 11 20:19
MPM7.TGZ
COMPASS

22777
4366
Mar 11 20:21
MPM8.TGZ
E2C

11055
349
Mar 11 20:21
MPM9.TGZ
EA6B

62663
2
Mar 11 20:18
MPMHDR.TGZ
INSTALL HEADER

/cdrom_62_Build_4/TAMPS/SYSGEN:

54170
1584
Mar 12 01:09
ARCTIC.TGZ

3.3
CLASS I CHANGES INSTALLED

This section does not apply.

3.4
CLASS II CHANGES INSTALLED

This section does not apply.

3.5
ADAPTATION DATA

The following Commercial-Off-The-Shelf (COTS) software is required to execute the released software:

a.
Sun Solaris 2.5.1 Operating System

3.6
INTERFACE COMPATIBILITY

None.

3.7
BIBLIOGRAPHY OF REFERENCE DOCUMENTS

3.8
OPERATIONAL DESCRIPTION

TAMPS 6.2 consists of twenty-one (21) CSCIs: One (1) Core CSCI which includes the majority of the TAMPS 6.2 capabilities and twenty (20) weapon/aircraft CSCIs that make extensive use of Core processing, while making some adjustments for unique requirements.

3.9
INSTALLATION INSTRUCTIONS

Refer to Appendix F of this document for the Installation procedures.

3.10
SOR, STR, DTR, AND NON-DTR CHANGE DESCRIPTIONS AND FILE LISTINGS FOR THIS RELEASE

Refer to Appendix A of this document for 6.2 incorporated changes.

3.11
DESCRIPTION OF ALL STRs AND DTRs IN WORK, IN TEST, AND CLOSED

Refer to Appendices B and C of this document for all 6.2 STR and DTR descriptions.

3.12
POSSIBLE PROBLEMS AND KNOWN ERRORS.

Refer to the OPNOTES in Appendix D of this document for the list of possible problems and known errors contained in this version.

SECTION 4

NOTES

4.1
ACRONYMS AND ABBREVIATIONS

ADRG
ARC Digitized Raster Graphics

COTS
Commercial Off-The-Shelf

CSCI
Computer Software Configuration Item

CSC
Computer Software Component

DAFID
Digital Aeronautical Flight Information Data

DCW
Digital Chart of the World

DI
Data Item

DoD
Department of Defense

DOD-STD
Department of Defense Standard

DON
Department of Navy

DTED
Digital Terrain Elevation Data

DTR
Discrepancy Trouble Report

ECAC
Electronic Compatibility Analysis Center

EPL
ELINT Parameter Limits List

EWIR
Electronic Warfare Integrated Reprogrammable

GUAC
Gridded Upper Air Climatology

IDB
Integrated Database

JSOW
Joint Stand-Off Weapon

MCCR
Mission Critical Computer Resource

MMI
Man-Machine Interface

MPM
Mission Planning Module

NDI
Non-Developmental Item

NID
Naval Intelligence Database

SLAM
Stand-Off Land Attack Missile

SPS
Software Product Specification

STR
Software Trouble Report

TAMPS
Tactical Automated Mission Planning System

TMS
Tactical Mapping System

UAV
Unmanned Aerial Vehicle

VDD
Version Description Document

Front Matter

APPENDIX C

APPENDIX A

TAMPS 6.2 INCORPORATED CHANGES

A.1
SCOPE

This appendix contains a detailed listing of all SORs, STRs, DTRs, and Non-DTRs delivered in this release.

A.2
SORs in This Release

SORs in release TAMPS 6.2 dated, 11 March 1998.

===================================================================

Package: ICN-149

Item(s)

-------

tamps/src/bindings/aft_event_defs.a

tamps/src/bindings/axt.a

tamps/src/bindings/axt_defines.a

===================================================================

Package: ICN-149.6

Item(s)

-------

tamps/src/bindings/axt.a

===================================================================

Package: ICN-149B

Item(s)

-------

tamps/src/bindings/axt.a

===================================================================

Package: ICN-171

Item(s)

-------

tamps/src/bindings/aft_event_defs.a

===================================================================

Package: ICN-172

Item(s)

-------

tamps/src/bindings/mpt.a

===================================================================

Package: ICN-174

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/aet.a

tamps/src/bindings/aet_defines.a

tamps/src/bindings/aft.a

tamps/src/bindings/ait.a

tamps/src/bindings/amt.a

tamps/src/bindings/axt.a

tamps/src/bindings/axt_defines.a

tamps/src/bindings/dat.a

tamps/src/bindings/lbt.a

tamps/src/bindings/uxt.a

tamps/src/bindings/uxt_defines.a

tamps/src/bindings/uzt_structs.a

===================================================================

Package: ICN-177

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/tet.a

===================================================================

Package: ICN-177.3

Item(s)

-------

tamps/src/bindings/upl.a

tamps/src/bindings/upl_defines.a

===================================================================

Package: ICN-177.4

Item(s)

-------

tamps/src/bindings/dft_structs.a

===================================================================

Package: ICN-177B

Item(s)

-------

tamps/src/Makefile

tamps/src/bindings/dft_structs.a

tamps/src/bindings/tet.a

tamps/src/bindings_prot/Makefile

tamps/src/bindings_prot/tammac_ce.a

===================================================================

Package: ICN-178

Item(s)

-------

tamps/src/bindings/mpt.a

tamps/src/bindings/mt_defs.a

===================================================================

Package: ICN-179

Item(s)

-------

tamps/src/bindings/dft_structs.a

===================================================================

Package: ICN-179.4

Item(s)

-------

tamps/src/bindings/dit_defines.a

===================================================================

Package: ICN-179.5

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/dct_idbf_struct.a

tamps/src/bindings/dct_idbfql_struct.a

tamps/src/bindings/dct_idbp_struct.a

tamps/src/bindings/dct_idbu_struct.a

tamps/src/bindings/dct_idbul_struct.a

tamps/src/bindings/dct_idbuql_struct.a

tamps/src/bindings/dct_objects_struct.a

tamps/src/bindings/dot.a

tamps/src/bindings/dot_defines.a

tamps/src/bindings/dot_struct.a

tamps/src/bindings/drt.a

tamps/src/bindings/drt_defines.a

tamps/src/bindings/drt_struct.a

tamps/src/bindings/irt.a

===================================================================

Package: ICN-179.6

Item(s)

-------

tamps/src/bindings/apt_route.a

tamps/src/bindings/axt_defines.a

tamps/src/bindings/sit_default_defines.a

===================================================================

Package: ICN-179B

Item(s)

-------

tamps/src/bindings/sit_default_defines.a

===================================================================

Package: ICN-179C

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/adt.a

tamps/src/bindings/adt_structs.a

tamps/src/bindings/apt_route.a

tamps/src/bindings/dat.a

tamps/src/bindings/dft_structs.a

tamps/src/bindings/dit.a

tamps/src/bindings/dit_defines.a

tamps/src/bindings/dit_enums.a

===================================================================

Package: ICN-181

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/oil_defs.a

tamps/src/bindings/oml.a

===================================================================

Package: ICN-181.1

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/oil_defs.a

tamps/src/bindings/oml.a

===================================================================

Package: ICN-182

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/dat.a

tamps/src/bindings/dat_defs.a

tamps/src/bindings/udl.a

tamps/src/bindings/umt_defines.a

tamps/src/bindings/ust.a

tamps/src/bindings/uul.a

tamps/src/bindings/uul_struct.a

===================================================================

Package: ICN-182B

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/dlt_device_defines.a

tamps/src/bindings/ldl.a

tamps/src/bindings/ldl_defines.a

tamps/src/bindings/ldl_errors.a

tamps/src/bindings/udl.a

===================================================================

Package: ICN-183

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/upl.a

tamps/src/bindings/upl_defines.a

tamps/src/bindings/upl_structs.a

===================================================================

Package: ICN-183B

Item(s)

-------

tamps/src/bindings/upl.a

tamps/src/bindings/upl_defines.a

tamps/src/bindings/upl_structs.a

===================================================================

Package: ICN-184

Item(s)

-------

tamps/src/bindings/Makefile

tamps/src/bindings/jet.a

tamps/src/bindings/jet_structs.a

tamps/src/bindings/lbt.a

tamps/src/bindings/mpt.a

tamps/src/bindings/mt_defs.a

tamps/src/bindings/sit_default_defines.a

tamps/src/bindings/tet.a

tamps/src/bindings/tit_imagery.a

===================================================================

Package: ICN-184.4

Item(s)

-------

tamps/src/bindings/jet.a

tamps/src/bindings/jet_structs.a

===================================================================

Package: ICN-184.6

Item(s)

-------

tamps/src/bindings/jet_structs.a

tamps/src/bindings/tet.a

===================================================================

Package: ICN-184.7

Item(s)

-------

tamps/src/bindings/jet.a

tamps/src/bindings/jet_structs.a

===================================================================

Package: ICN-184.8

Item(s)

-------

tamps/src/bindings/tet.a

===================================================================

Package: ICN-186

Item(s)

-------

tamps/src/bindings/apt_route.a

tamps/src/bindings/sit_default_defines.a

===================================================================

Package: ICN-186.4

Item(s)

-------

tamps/src/bindings/axt_defines.a

===================================================================

Package: ICN-188

Item(s)

-------

tamps/src/bindings/apt_route.a

tamps/src/bindings/zrt_defines.a

===================================================================

Package: ICN-188.1

Item(s)

-------

tamps/src/bindings/adt.a

===================================================================

Package: ICN-189

Item(s)

-------

tamps/src/bindings/apt_route.a

tamps/src/bindings/bsa_DataStruct.a

tamps/src/bindings/bsa_Definitions.a

===================================================================

Package: ICN-189.2

Item(s)

-------

tamps/src/bindings/bsa_Definitions.a

===================================================================

Package: ICN-189.3

Item(s)

-------

tamps/src/bindings/bsa_Definitions.a

===================================================================

Package: ICN-190

Item(s)

-------

tamps/src/bindings/sit_default_defines.a

===================================================================

Package: ICN-190.1

Item(s)

-------

tamps/src/bindings/ait.a

===================================================================

Package: ICN-191

Item(s)

-------

tamps/src/bindings/mt_defs.a

===================================================================

Package: ICN-194

Item(s)

-------

tamps/src/bindings/apt_route.a

===================================================================

Package: ICN-195

Item(s)

-------

tamps/src/bindings/aft_attack_event.a

tamps/src/bindings/aft_flight_events.a

tamps/src/bindings/ait.a

tamps/src/bindings/apt_route.a

tamps/src/bindings/aut.a

tamps/src/bindings/mpt.a

tamps/src/bindings/mpt.old.a

tamps/src/bindings/mt_struct.a

tamps/src/bindings/ust.a

===================================================================

Package: SOR-95-43

Item(s)

-------

tamps/bin/refdir_makeskel.prl

tamps/env/.cshrc_include

===================================================================

Package: SOR-95-47

Item(s)

-------

tamps/CLASSIFIED/mpm/a6e/dbinstall/Install_a6e_classload.csh

tamps/CLASSIFIED/mpm/a6e/dbinstall/tamps_loadout_default.a6e.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/create/DeltacMsn.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/create/DeltacMsn_triggers.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/create/Umpm_create.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/index/deltac_ac_indx.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/index/deltac_ac_mine_indx.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/index/deltac_mine_indx.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/index/deltac_mine_info_indx.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/index/deltac_mission_indx.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/index/umpm_act_indx.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/index/umpm_indx.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/load/Install_umpm_load.csh

tamps/CLASSIFIED/mpm/famp/dbinstall/load/ddt_Install_umpm_load.csh

tamps/CLASSIFIED/mpm/famp/dbinstall/load/deltac_ac_load.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/load/deltac_ac_mine_load.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/load/deltac_mine_info_load.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/load/deltac_mine_load.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/remove/Deltac_delete.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/remove/Deltac_truncate.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/remove/Umpm_delete.sql

tamps/CLASSIFIED/mpm/famp/dbinstall/remove/Umpm_truncate.sql

tamps/CLASSIFIED/src/dbinstall/eotda/bel_create_sensor.sql

tamps/CLASSIFIED/src/dbinstall/eotda/bel_create_target.sql

tamps/CLASSIFIED/src/dbinstall/idb/index/create_pks_idb.sql

tamps/CLASSIFIED/src/dbinstall/load/data/Install_load_c.csh

tamps/CLASSIFIED/src/dbinstall/load/data/dbt_procedures.sql

tamps/CLASSIFIED/src/dbinstall/load/data/dd_country_code_insert.sql

tamps/CLASSIFIED/src/dbinstall/sprocs/Install_sprocs.csh

tamps/CLASSIFIED/src/dbinstall/sprocs/dd_aaacat.insert

tamps/CLASSIFIED/src/dbinstall/sprocs/dd_aaafac.insert

tamps/CLASSIFIED/src/dbinstall/sprocs/dd_aaaspec.insert

tamps/CLASSIFIED/src/dbinstall/sprocs/dd_aaatype.insert

tamps/CLASSIFIED/src/dbinstall/sprocs/dd_aob.insert

tamps/CLASSIFIED/src/dbinstall/sprocs/dd_aobcap.insert

tamps/CLASSIFIED/src/dbinstall/sprocs/dd_aobfixed.insert

tamps/CLASSIFIED/src/dbinstall/sprocs/dd_aobrotary.insert

tamps/CLASSIFIED/src/dbinstall/sprocs/dd_eob.insert
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tamps/src/libs/dbase/dut/dut_mapCb.c

tamps/src/libs/dbase/dwl/Makefile

tamps/src/libs/dbase/dzt/dzt_oparea.c

tamps/src/libs/dbase/include/Makefile

tamps/src/libs/dbase/include/dlt_dbase.h

tamps/src/libs/dbase/include/dlt_priv_proto.h

tamps/src/libs/dbase/include/dml_DbMaint_class.h

tamps/src/libs/dbase/include/dml_defines.h

tamps/src/libs/dbase/include/dml_priv_proto.h

tamps/src/libs/dbase/include/dml_struct.h

tamps/src/libs/dbase/include/dut_util_struct.h

tamps/src/libs/dbase/include/dwl_priv_proto.h

tamps/src/libs/gpskey/gct/gct_bdf_audit.c

tamps/src/libs/lan/Makefile

tamps/src/libs/lan/include/Makefile

tamps/src/libs/lan/include/ldl_priv_defines.h

tamps/src/libs/lan/include/ldl_priv_proto.h

tamps/src/libs/lan/include/ldl_priv_structs.h

tamps/src/libs/lan/include/lsl_proto.h

tamps/src/libs/lan/ldl/MakeLib

tamps/src/libs/lan/ldl/Make_CASE

tamps/src/libs/lan/ldl/Make_pong

tamps/src/libs/lan/ldl/Makefile

tamps/src/libs/lan/ldl/ldl_ClientSupport.c

tamps/src/libs/lan/ldl/ldl_SvcProc.c

tamps/src/libs/lan/ldl/ldl_SvcSupport.c

tamps/src/libs/lan/ldl/ldl_land.x

tamps/src/libs/lan/ldl/ldl_pong.c

tamps/src/libs/lan/lsl/Makefile

tamps/src/libs/lan/lsl/lsl_establishClient.c

tamps/src/libs/maps/include/mmt_priv_proto.h

tamps/src/libs/maps/mmt/mmt_bkgndcb.c

tamps/src/libs/maps/mmt/mmt_coverage.c

tamps/src/libs/maps/mmt/mmt_mapUsg.c

tamps/src/libs/tms/include/tut_priv_proto.h

tamps/src/libs/tms/tit/tit_adri_load.c

tamps/src/libs/tms/tit/tit_getImageryFiles.c

tamps/src/libs/tms/tit/tit_readnitfimageheader.c

tamps/src/libs/tms/trt/trt_getADRGfiles.c

tamps/src/libs/tms/ttt/ttt_getdtedfiles.c

tamps/src/libs/tms/tut/tut_cd_2_dk.c

tamps/src/libs/util/Makefile

tamps/src/libs/util/umt/umt_udmdefaults.c

tamps/src/libs/util/ust/ust_utils.c

tamps/src/libs/util/uul/Makefile

tamps/src/libs/util/uul/uul_users.c

tamps/src/libs/util/uul/uul_utils.c

tamps/src/libs/util/uxt/Makefile

tamps/src/libs/util/uxt/uxt_passwd.c

tamps/src/libs/zsystem/zrt/zrt_init.c

tamps/src/scripts/dbase/bin/checkBackUpServer

tamps/src/scripts/dbase/bin/dlt_symbol_export.csh

tamps/src/scripts/dbase/bin/dlt_symbol_import.csh

tamps/src/scripts/dbase/bin/dml_tar.csh

tamps/src/scripts/dbase/bin/make_scripts

tamps/src/scripts/dbase/bin/tamps_bcpIN_Xfer.csh

tamps/src/scripts/dbase/bin/tamps_bcpOUT_xfer.csh

tamps/src/scripts/dbase/bin/tamps_dataXferCreate.sql

tamps/src/scripts/dbase/bin/tamps_dataXferDrop.sql

tamps/src/scripts/dbase/bin/tamps_truncate_temp_xfer.csh

tamps/src/scripts/dbase/bin/tamps_truncate_xfer.csh

tamps/src/scripts/dbase/bin/tamps_xfer_UserDbData.csh

tamps/src/scripts/dbase/bin/tamps_xfer_dbData.csh

tamps/src/scripts/lan/Makefile

tamps/src/scripts/lan/lcl/Connect.sh.temp

tamps/src/scripts/lan/lcl/ConnectUsers.sh.temp

tamps/src/scripts/lan/lcl/Makefile

tamps/src/scripts/lan/lcl/lcl_RemoveAccounts.sh

tamps/src/scripts/lan/lcl/lcl_changeuser.sh

tamps/src/scripts/lan/lcl/lcl_initializeClient.sh

tamps/src/scripts/lan/lcl/lcl_preConnection.sh

tamps/src/scripts/lan/lcl/lcl_preDisconnect.sh

tamps/src/scripts/lan/lcl/lcl_updateuser.sh

tamps/src/scripts/lan/lcl/lsl_addUser.sh

tamps/src/scripts/lan/lcl/lsl_checkUserExist.sh

tamps/src/scripts/lan/lcl/lsl_credClient.sh

tamps/src/scripts/lan/lcl/lsl_credClient.sh~

tamps/src/scripts/lan/lcl/lsl_credUser.sh

tamps/src/scripts/lan/lcl/lsl_removeClient.sh

tamps/src/scripts/lan/lcl/make_scripts

===================================================================

Package: SOR-95-47BLD3A

Item(s)

-------

tamps/include/lan/ldl_Errors.h

tamps/include_prot/lan/ldl_prot_defines.h

tamps/include_prot/util/uxt_prot_proto.h

tamps/src/apps/lan/include/lcl_proto.h

tamps/src/apps/lan/lal/lal_createLANadminHMI.c

tamps/src/apps/lan/lcl/Makefile

tamps/src/apps/lan/lcl/lcl_connectHMIcb.c

tamps/src/apps/lan/lcl/lcl_connectfail.c

tamps/src/apps/lan/lcl/lcl_disconnectHMIcb.c

tamps/src/apps/lan/lcl/lcl_update_interfaces.c

tamps/src/apps/lan/lcl/lcl_usrconfHMIcb.c

tamps/src/apps/lan/lcl/lcl_usrconfmain.c

tamps/src/apps/lan/lcl/lcl_usrinitmain.c

tamps/src/apps/lan/lcl/make_lcl_connect_fail

tamps/src/apps/lan/ldl/Make_LAND

tamps/src/apps/lan/ldl/Make_NodeSet

tamps/src/apps/lan/ldl/Makefile

tamps/src/apps/lan/ldl/ldl_NodeSet.c

tamps/src/apps/lan/lol/lol_Connection.c

tamps/src/apps/lan/lsl/lsl_credUser.c

tamps/src/apps/lan/lsl/make_lsl_cred_user

tamps/src/data/sysadmin/zet/.mplan_init

tamps/src/data/sysadmin/zet/.xinitrc

tamps/src/data/sysadmin/zet/make_data

tamps/src/libs/b_msn_tools/bmt/bmt_export.c

tamps/src/libs/dbase/dlt/dlt_adri.c

tamps/src/libs/dbase/dlt/dlt_dted.c

tamps/src/libs/dbase/dlt/dlt_load.c

tamps/src/libs/dbase/dlt/dlt_loadMMI.c

tamps/src/libs/dbase/dlt/dlt_mpLdMMI.c

tamps/src/libs/dbase/dut/dut_mapCb.c

tamps/src/libs/lan/ldl/ldl_ClientSupport.c

tamps/src/libs/lan/ldl/ldl_SvcProc.c

tamps/src/libs/lan/lsl/lsl_establishClient.c

tamps/src/libs/maps/mmt/mmt_covercb.c

tamps/src/libs/tms/tit/tit_getImageryFiles.c

tamps/src/libs/tms/tit/tit_imagery.c

tamps/src/libs/tms/trt/trt_getADRGfiles.c

tamps/src/libs/tms/ttt/ttt_getdtedfiles.c

tamps/src/libs/tms/tut/tut_cd_2_dk.c

tamps/src/libs/util/uxt/uxt_passwd.c

tamps/src/scripts/lan/lcl/Connect.sh.temp

tamps/src/scripts/lan/lcl/Disconnect.sh.temp

tamps/src/scripts/lan/lcl/lcl_changeuser.sh

tamps/src/scripts/lan/lcl/lcl_preConnection.sh

tamps/src/scripts/lan/lcl/lcl_preDisconnect.sh

tamps/src/scripts/lan/lcl/lcl_updateuser.sh

tamps/src/scripts/lan/lcl/lsl_checkUserExist.sh

tamps/src/scripts/lan/lcl/lsl_credUser.sh

tamps/src/scripts/lan/lcl/lsl_removeClient.sh

tamps/src/scripts/lan/lcl/make_scripts

===================================================================

Package: SOR-95-47BLD3B

Item(s)

-------

sysgen/src/arctic/skel/root/.xinitrc

tamps/src/apps/lan/lcl/lcl_connectHMIcb.c

tamps/src/apps/lan/lcl/lcl_disconnectHMIcb.c

tamps/src/apps/lan/lol/lol_Connection.c

tamps/src/scripts/lan/lcl/Connect.sh.temp

tamps/src/scripts/lan/lcl/Disconnect.sh.temp

tamps/src/scripts/lan/lcl/lcl_preDisconnect.sh

===================================================================

Package: SOR-95-47BLD4

Item(s)

-------

tamps/include/help/thc_defines.h

tamps/include/lan/ldl_Errors.h

tamps/include_prot/lan/lcl_prot_structs.h

tamps/include_prot/lan/ldl_prot_defines.h

tamps/include_prot/lan/ldl_prot_structs.h

tamps/include_prot/lan/lut_prot_defines.h

tamps/mpm/a6e/scripts/Makefile

tamps/mpm/a6e/scripts/cold_start/a6e_install_script.csh

tamps/mpm/a6e/scripts/cold_start/a6e_load_tape_script.csh

tamps/mpm/a6e/scripts/cold_start/a6e_remove_files.csh

tamps/mpm/a6e/scripts/cold_start/lan/Makefile

tamps/mpm/a6e/scripts/cold_start/lan/connect/Makefile

tamps/mpm/a6e/scripts/cold_start/lan/connect/a6e_connect.csh

tamps/mpm/a6e/scripts/cold_start/lan/connect/make_scripts

tamps/mpm/a6e/scripts/cold_start/lan/disconnect/Makefile

tamps/mpm/a6e/scripts/cold_start/lan/disconnect/a6e_disconnect.csh

tamps/mpm/a6e/scripts/cold_start/lan/disconnect/make_scripts

tamps/mpm/a6e/scripts/cold_start/lan/update/Makefile

tamps/mpm/a6e/scripts/cold_start/lan/update/a6e_update.csh

tamps/mpm/a6e/scripts/cold_start/lan/update/make_scripts

tamps/mpm/a6e/scripts/lan/Makefile

tamps/mpm/a6e/scripts/lan/connect/Makefile

tamps/mpm/a6e/scripts/lan/connect/a6e_connect.csh

tamps/mpm/a6e/scripts/lan/connect/make_scripts

tamps/mpm/a6e/scripts/lan/disconnect/Makefile

tamps/mpm/a6e/scripts/lan/disconnect/a6e_disconnect.csh

tamps/mpm/a6e/scripts/lan/disconnect/make_scripts

tamps/mpm/a6e/scripts/lan/update/Makefile

tamps/mpm/a6e/scripts/lan/update/a6e_update.csh

tamps/mpm/a6e/scripts/lan/update/make_scripts

tamps/src/apps/b_msn_tools/bct/afp/arc_dbio.a

tamps/src/apps/b_msn_tools/bct/bct_ColdStart.c

tamps/src/apps/b_msn_tools/bct/bct_EditUtil.c

tamps/src/apps/b_msn_tools/bct/bct_FMTTraining.c

tamps/src/apps/b_msn_tools/bct/bct_NetCovCB.c

tamps/src/apps/b_msn_tools/bct/bct_Presets.c

tamps/src/apps/b_msn_tools/bct/bct_WOD.c

tamps/src/apps/lan/Makefile

tamps/src/apps/lan/include/ljl_proto.h

tamps/src/apps/lan/include/lpl_defines.h

tamps/src/apps/lan/include/lpl_protos.h

tamps/src/apps/lan/include/lpl_structs.h

tamps/src/apps/lan/include/msgbox.h

tamps/src/apps/lan/lal/lal_createLANadminHMI.c

tamps/src/apps/lan/lcl/lcl_connectHMI.c

tamps/src/apps/lan/lcl/lcl_disconnectHMIcb.c

tamps/src/apps/lan/lcl/lcl_update_interfaces.c

tamps/src/apps/lan/lcl/lcl_usrconfHMIcb.c

tamps/src/apps/lan/ljl/Makefile

tamps/src/apps/lan/ljl/ljl_connectCb.c

tamps/src/apps/lan/ljl/ljl_connectmain.c

tamps/src/apps/lan/ljl/ljl_disconnectCb.c

tamps/src/apps/lan/ljl/ljl_disconnectmain.c

tamps/src/apps/lan/ljl/ljl_resyncCb.c

tamps/src/apps/lan/ljl/ljl_resyncmain.c

tamps/src/apps/lan/ljl/make_ljl_connect

tamps/src/apps/lan/ljl/make_ljl_disconnect

tamps/src/apps/lan/ljl/make_ljl_resync

tamps/src/apps/lan/lol/lol_Connection.c

tamps/src/apps/lan/lpl/Makefile

tamps/src/apps/lan/lpl/lpl_Create_Default_Printer_HMI.c

tamps/src/apps/lan/lpl/lpl_Create_Net_Prnt_Desig_HMI.c

tamps/src/apps/lan/lpl/lpl_Net_Prnt_Desig_main.c

tamps/src/apps/lan/lpl/lpl_Set_Default_Printer_main.c

tamps/src/apps/lan/lpl/lpl_Utilities.c

tamps/src/apps/lan/lpl/make_lpl_default

tamps/src/apps/lan/lpl/make_lpl_net

tamps/src/apps/lan/lpl/msgbox.c

tamps/src/contrib/jmcis_gots/profiler/lib/libnprofui.a

tamps/src/data/environment/tamps.env

tamps/src/data/sysadmin/zet/.xinitrc

tamps/src/data/wse/system_admin.menu

tamps/src/dbinstall/dwl/Install_dwl.csh

tamps/src/dbinstall/dwl/dwl_install_weather_admin.sql

tamps/src/dbinstall/dwl/make_sql

tamps/src/libs/b_msn_tools/bmt/Makefile

tamps/src/libs/b_msn_tools/bmt/bmt_create.c

tamps/src/libs/b_msn_tools/bmt/bmt_createsp.c

tamps/src/libs/b_msn_tools/bmt/bmt_exportsp.c

tamps/src/libs/b_msn_tools/bmt/bmt_importsp.c

tamps/src/libs/b_msn_tools/bmt/bmt_mission.c

tamps/src/libs/b_msn_tools/bmt/bmt_strike.c

tamps/src/libs/b_msn_tools/bmt/bmt_strikeOptMenuCb.c

tamps/src/libs/b_msn_tools/include/bmt_priv_proto.h

tamps/src/libs/b_msn_tools/include/bmt_strike.h

tamps/src/libs/dbase/dlt/dlt_dcw.c

tamps/src/libs/dbase/dml/dml_dataXfer.c

tamps/src/libs/dbase/dwl/dwl_dbase_weather_admin.c

tamps/src/libs/lan/include/ldl_priv_defines.h

tamps/src/libs/lan/include/ldl_priv_proto.h

tamps/src/libs/lan/include/ldl_priv_structs.h

tamps/src/libs/lan/ldl/MakeLib

tamps/src/libs/lan/ldl/ldl_3rdParty.c

tamps/src/libs/lan/ldl/ldl_ClientSupport.c

tamps/src/libs/lan/ldl/ldl_ProcessSupport.c

tamps/src/libs/lan/ldl/ldl_SvcProc.c

tamps/src/libs/lan/ldl/ldl_SvcSupport.c

tamps/src/libs/lan/ldl/ldl_land.x

tamps/src/libs/lan/ldl/ldl_pong.c

tamps/src/libs/tms/tut/tut_cd_2_dk.c

tamps/src/libs/util/uul/uul_users.c

tamps/src/libs/wse/wmt/wmt_roles.c

tamps/src/scripts/lan/lcl/Connect.sh.temp

tamps/src/scripts/lan/lcl/Disconnect.sh.temp

tamps/src/scripts/lan/lcl/lcl_preConnection.sh

tamps/src/scripts/lan/lcl/lcl_preDisconnect.sh

===================================================================

Package: SOR-96-01

Item(s)

-------

tamps/CLASSIFIED/src/dbinstall/load/data/dbt_procedures.sql

tamps/CLASSIFIED/src/dbinstall/sprocs/DD_MENU.BCP

tamps/CLASSIFIED/src/dbinstall/sprocs/DD_MENU_INDEX.BCP

tamps/CLASSIFIED/src/dbinstall/sprocs/make_sql

tamps/config/projpath

tamps/env/tamps.env.dev

tamps/include/a_msn_plan/amt_menu.h

tamps/include/dbase/dat_proto.h

tamps/include/dbase/dft_struct.h

tamps/include/dbase/dit_defines.h

tamps/include/dbase/dit_enums.h

tamps/include/dbase/dit_proto.h

tamps/include/dbase/dut_scr.h

tamps/include/system/sit_default_defines.h

tamps/include/zsystem/zrt_defines.h

tamps/include_prot/dbase/dat_prot_proto.h

tamps/include_prot/dbase/dmt_default_defines.h

tamps/include_prot/dbase/dqt_prot_proto.h

tamps/include_prot/intel/iot_prot_proto.h

tamps/include_prot/objh/out_prot_proto.h

tamps/include_prot/util/ult_prot_proto.h

tamps/include_prot/util/ust_prot_proto.h

tamps/include_prot/util/utt_prot_proto.h

tamps/include_prot/util/uzt_prot_proto.h

tamps/src/apps/dbase/Makefile

tamps/src/apps/dbase/ddt/ddt_bulk.c

tamps/src/apps/objh/include/oet_priv_proto.h

tamps/src/apps/objh/oet/oet_addAction.c

tamps/src/apps/objh/oet/oet_lltab.c

tamps/src/apps/objh/oet/oet_objDsp.c

tamps/src/apps/zsystem/Makefile

tamps/src/apps/zsystem/include/zet_defines.h

tamps/src/apps/zsystem/include/zet_proto.h

tamps/src/apps/zsystem/zet/make_scripts

tamps/src/apps/zsystem/zet/zet_addMIDBUser.sh

tamps/src/apps/zsystem/zet/zet_dbMMIcb.c

tamps/src/apps/zsystem/zet/zet_delMIDBUser.sh

tamps/src/apps/zsystem/zet/zet_roleMMIcb.c

tamps/src/apps/zsystem/zet/zet_userMMI.c

tamps/src/apps/zsystem/zet/zet_userMMIcb.c

tamps/src/apps/zsystem/zmt/Makefile

tamps/src/apps/zsystem/zmt/zmt_blts.c

tamps/src/data/environment/tamps.env

tamps/src/dbinstall/data_dict/Install_datadict.csh

tamps/src/dbinstall/data_dict/dd_databases_create.sql

tamps/src/dbinstall/data_dict/dd_databases_insert.sql

tamps/src/dbinstall/data_dict/dd_datasets_create.sql

tamps/src/dbinstall/data_dict/dd_datasets_insert.sql

tamps/src/dbinstall/data_dict/dd_dbload_insert.sql

tamps/src/dbinstall/data_dict/make_sql

tamps/src/dbinstall/security/Install_security.csh

tamps/src/dbinstall/security/Makefile

tamps/src/dbinstall/security/grant_privs.pl

tamps/src/dbinstall/security/make_scripts

tamps/src/dbinstall/tampsdb/create/menu/tamps_menu_create.sql

tamps/src/libs/dbase/Makefile

tamps/src/libs/dbase/dat/dat_delQuery.c

tamps/src/libs/dbase/dat/dat_execute.c

tamps/src/libs/dbase/dat/dat_func.c

tamps/src/libs/dbase/dat/dat_getDbStr.c

tamps/src/libs/dbase/dat/dat_queries.c

tamps/src/libs/dbase/dbt/Makefile

tamps/src/libs/dbase/dbt/dbt_bcp_inout.c

tamps/src/libs/dbase/dbt/dbt_progressMeter.c

tamps/src/libs/dbase/dft/Makefile

tamps/src/libs/dbase/dft/dft_getOrderOfBattle_c.C

tamps/src/libs/dbase/dit/Makefile

tamps/src/libs/dbase/dit/dit_Aka_c.C

tamps/src/libs/dbase/dit/dit_EquipmentIndex_c.C

tamps/src/libs/dbase/dit/dit_Equipment_c.C

tamps/src/libs/dbase/dit/dit_Facility_c.C

tamps/src/libs/dbase/dit/dit_Observation_c.C

tamps/src/libs/dbase/dit/dit_RemarkLine_c.C

tamps/src/libs/dbase/dit/dit_Remarks_c.C

tamps/src/libs/dbase/dit/dit_Target_c.C

tamps/src/libs/dbase/dit/dit_Track_c.C

tamps/src/libs/dbase/dit/dit_Unit_c.C

tamps/src/libs/dbase/dit/dit_equipmentHandle.C

tamps/src/libs/dbase/dit/dit_equipmentIdxHandle.C

tamps/src/libs/dbase/dit/dit_error.C

tamps/src/libs/dbase/dit/dit_facilityHandle.C

tamps/src/libs/dbase/dit/dit_midbBase_c.C

tamps/src/libs/dbase/dit/dit_midbUtilities.C

tamps/src/libs/dbase/dit/dit_observationHandle.C

tamps/src/libs/dbase/dit/dit_remarksHandle.C

tamps/src/libs/dbase/dit/dit_sqlStmt_c.C

tamps/src/libs/dbase/dit/dit_targetHandle.C

tamps/src/libs/dbase/dit/dit_targetUtilities.C

tamps/src/libs/dbase/dit/dit_trackHandle.C

tamps/src/libs/dbase/dit/dit_unitHandle.C

tamps/src/libs/dbase/dlt/Makefile

tamps/src/libs/dbase/dlt/dlt_aicMMI.c

tamps/src/libs/dbase/dlt/dlt_aiccb.c

tamps/src/libs/dbase/dlt/dlt_aictape.c

tamps/src/libs/dbase/dlt/dlt_bcp.c

tamps/src/libs/dbase/dlt/dlt_bcpIn.c

tamps/src/libs/dbase/dlt/dlt_bcpMMI.c

tamps/src/libs/dbase/dlt/dlt_bcpcb.c

tamps/src/libs/dbase/dlt/dlt_bcpdb.c

tamps/src/libs/dbase/dlt/dlt_cc_db.c

tamps/src/libs/dbase/dlt/dlt_eplnerf.c

tamps/src/libs/dbase/dlt/dlt_idbtf.c

tamps/src/libs/dbase/dlt/dlt_load.c

tamps/src/libs/dbase/dlt/dlt_nidcb.c

tamps/src/libs/dbase/dmt/dmt_menu.c

tamps/src/libs/dbase/dmt/dmt_qnebcb.c

tamps/src/libs/dbase/dmt/dmt_qsavcb.c

tamps/src/libs/dbase/dnt/dnt_dafidCb.c

tamps/src/libs/dbase/dqt/Makefile

tamps/src/libs/dbase/dqt/dqt_cond.c

tamps/src/libs/dbase/dqt/dqt_select.c

tamps/src/libs/dbase/dqt/dqt_sp.c

tamps/src/libs/dbase/dqt/dqt_sql.c

tamps/src/libs/dbase/dut/Makefile

tamps/src/libs/dbase/dut/dut_arResMMI.c

tamps/src/libs/dbase/dut/dut_archive_restore.c

tamps/src/libs/dbase/dut/dut_drmMMI.c

tamps/src/libs/dbase/dut/dut_dumpResMMI.c

tamps/src/libs/dbase/dut/dut_dump_restore.c

tamps/src/libs/dbase/dut/dut_idb.c

tamps/src/libs/dbase/include/Makefile

tamps/src/libs/dbase/include/dat_priv_proto.h

tamps/src/libs/dbase/include/dbt_priv_proto.h

tamps/src/libs/dbase/include/dft_getOrderOfBattle_c.H

tamps/src/libs/dbase/include/dit_Aka_c.H

tamps/src/libs/dbase/include/dit_EquipmentIndex_c.H

tamps/src/libs/dbase/include/dit_Equipment_c.H

tamps/src/libs/dbase/include/dit_Facility_c.H

tamps/src/libs/dbase/include/dit_Observation_c.H

tamps/src/libs/dbase/include/dit_RemarkLine_c.H

tamps/src/libs/dbase/include/dit_Remarks_c.H

tamps/src/libs/dbase/include/dit_Target_c.H

tamps/src/libs/dbase/include/dit_Track_c.H

tamps/src/libs/dbase/include/dit_Unit_c.H

tamps/src/libs/dbase/include/dit_midbBase_c.H

tamps/src/libs/dbase/include/dit_priv_defines.h

tamps/src/libs/dbase/include/dit_priv_enums.h

tamps/src/libs/dbase/include/dit_priv_eqpIdxStructs.h

tamps/src/libs/dbase/include/dit_priv_eqpStructs.h

tamps/src/libs/dbase/include/dit_priv_facStructs.h

tamps/src/libs/dbase/include/dit_priv_obsStructs.h

tamps/src/libs/dbase/include/dit_priv_proto.H

tamps/src/libs/dbase/include/dit_priv_rmkStructs.h

tamps/src/libs/dbase/include/dit_priv_structs.h

tamps/src/libs/dbase/include/dit_priv_tgtStructs.h

tamps/src/libs/dbase/include/dit_priv_trackStructs.h

tamps/src/libs/dbase/include/dit_priv_unitStructs.h

tamps/src/libs/dbase/include/dit_sqlStmt_c.H

tamps/src/libs/dbase/include/dlt_priv_proto.h

tamps/src/libs/dbase/include/dlt_scr.h

tamps/src/libs/dbase/include/dqt_priv_proto.h

tamps/src/libs/dbase/include/dut_priv_proto.h

tamps/src/libs/dbase/include/dut_util_struct.h

tamps/src/libs/e_threat/edt/edt_layer.c

tamps/src/libs/intel/include/iot_priv_proto.h

tamps/src/libs/intel/iot/Makefile

tamps/src/libs/intel/iot/iot_aaa.c

tamps/src/libs/intel/iot/iot_aaaUnitEq.c

tamps/src/libs/intel/iot/iot_aaacat.c

tamps/src/libs/intel/iot/iot_aaafac.c

tamps/src/libs/intel/iot/iot_aaafcrdr.c

tamps/src/libs/intel/iot/iot_aaaspec.c

tamps/src/libs/intel/iot/iot_aaatype.c

tamps/src/libs/intel/iot/iot_aob.c

tamps/src/libs/intel/iot/iot_aobcap.c

tamps/src/libs/intel/iot/iot_aobfix.c

tamps/src/libs/intel/iot/iot_aobrot.c

tamps/src/libs/intel/iot/iot_aobspec.c

tamps/src/libs/intel/iot/iot_sam.c

tamps/src/libs/intel/iot/iot_samfix.c

tamps/src/libs/intel/iot/iot_samtac.c

tamps/src/libs/intel/iot/iot_samunit.c

tamps/src/libs/intel/ist/ist_amp.c

tamps/src/libs/layer/lbt/lbt_dbbuild.c

tamps/src/libs/maps/mpt/mpt_symbol.c

tamps/src/libs/objh/out/out_dbfuncs.c

tamps/src/libs/products/pml/pml_make_obrep.c

tamps/src/libs/products/pml/pml_make_othgold.c

tamps/src/libs/products/pml/pml_make_tacelint.c

tamps/src/libs/products/pml/pml_make_tacrep.c

tamps/src/libs/system/sit/sit_defaultMenu.c

tamps/src/libs/util/include/ust_priv_proto.h

tamps/src/libs/util/include/utt_priv_proto.h

tamps/src/libs/util/ult/ult_conv.c

tamps/src/libs/util/ust/ust_bind.c

tamps/src/libs/util/ust/ust_utils.c

tamps/src/libs/util/utt/utt_build_tablist.c

tamps/src/libs/util/utt/utt_createDBMenu.c

tamps/src/libs/util/utt/utt_execscript.c

tamps/src/libs/util/utt/utt_finds.c

tamps/src/libs/util/uzt/uzt_utils.c

tamps/src/libs/zsystem/zrt/zrt_init.c

tamps/src/scripts/zsystem/make_scripts

tamps/src/scripts/zsystem/zet_addMIDBUser.sh

tamps/src/scripts/zsystem/zet_delMIDBUser.sh

tamps/src/test/Makefile

tamps/src/test/SOR9601/Makefile

tamps/src/test/SOR9601/api/code/Makefile

tamps/src/test/SOR9601/api/code/test_driver.C

tamps/src/test/SOR9601/api/code/test_eqp.C

tamps/src/test/SOR9601/api/code/test_eqpElint.C

tamps/src/test/SOR9601/api/code/test_eqpIdx.C

tamps/src/test/SOR9601/api/code/test_fac.C

tamps/src/test/SOR9601/api/code/test_list.C

tamps/src/test/SOR9601/api/code/test_obs.C

tamps/src/test/SOR9601/api/code/test_obsElnot.C

tamps/src/test/SOR9601/api/code/test_obsPar.C

tamps/src/test/SOR9601/api/code/test_obsRep.C

tamps/src/test/SOR9601/api/code/test_rmk.C

tamps/src/test/SOR9601/api/code/test_target.C

tamps/src/test/SOR9601/api/code/test_track.C

tamps/src/test/SOR9601/api/code/test_trackElint.C

tamps/src/test/SOR9601/api/code/test_trackLoc.C

tamps/src/test/SOR9601/api/code/test_unit.C

tamps/src/test/SOR9601/api/code/test_utilities.C

tamps/src/test/SOR9601/api/include/dit_priv_defines.h

tamps/src/test/SOR9601/api/include/dit_priv_enums.h

tamps/src/test/SOR9601/api/include/dit_priv_eqpIdxStructs.h

tamps/src/test/SOR9601/api/include/dit_priv_eqpStructs.h

tamps/src/test/SOR9601/api/include/dit_priv_facStructs.h

tamps/src/test/SOR9601/api/include/dit_priv_obsStructs.h

tamps/src/test/SOR9601/api/include/dit_priv_rmkStructs.h

tamps/src/test/SOR9601/api/include/dit_priv_structs.h

tamps/src/test/SOR9601/api/include/dit_priv_tgtStructs.h

tamps/src/test/SOR9601/api/include/dit_priv_trackStructs.h

tamps/src/test/SOR9601/api/include/dit_priv_unitStructs.h

tamps/src/test/SOR9601/api/include/test_eqp.H

tamps/src/test/SOR9601/api/include/test_eqpElint.H

tamps/src/test/SOR9601/api/include/test_eqpIdx.H

tamps/src/test/SOR9601/api/include/test_fac.H

tamps/src/test/SOR9601/api/include/test_list.H

tamps/src/test/SOR9601/api/include/test_obs.H

tamps/src/test/SOR9601/api/include/test_obsEln.H

tamps/src/test/SOR9601/api/include/test_obsElnot.H

tamps/src/test/SOR9601/api/include/test_obsPar.H

tamps/src/test/SOR9601/api/include/test_obsRep.H

tamps/src/test/SOR9601/api/include/test_rmk.H

tamps/src/test/SOR9601/api/include/test_target.H

tamps/src/test/SOR9601/api/include/test_track.H

tamps/src/test/SOR9601/api/include/test_trackElint.H

tamps/src/test/SOR9601/api/include/test_trackLoc.H

tamps/src/test/SOR9601/api/include/test_unit.H

tamps/src/test/SOR9601/api/include/test_utilities.H

tamps/src/test/SOR9601/dat_getdb/Makefile

tamps/src/test/SOR9601/dat_getdb/ddt_getDB_main.c

tamps/src/test/SOR9601/test_driver.C

tamps/src/test/SOR9601/test_eqp.C

tamps/src/test/SOR9601/test_eqpElint.C

tamps/src/test/SOR9601/test_eqpIdx.C

tamps/src/test/SOR9601/test_fac.C

tamps/src/test/SOR9601/test_list.C

tamps/src/test/SOR9601/test_obs.C

tamps/src/test/SOR9601/test_obsElnot.C

tamps/src/test/SOR9601/test_obsPar.C

tamps/src/test/SOR9601/test_obsRep.C

tamps/src/test/SOR9601/test_rmk.C

tamps/src/test/SOR9601/test_target.C

tamps/src/test/SOR9601/test_track.C

tamps/src/test/SOR9601/test_trackElint.C

tamps/src/test/SOR9601/test_trackLoc.C

tamps/src/test/SOR9601/test_unit.C

tamps/src/test/SOR9601/test_utilities.C

tamps/src/test/sor9710/app/dmt_menu.c

tamps/src/test/sor9710/app/sor9710TestDriver.c

===================================================================

Package: SOR-96-01BLD3

Item(s)

-------

sysgen/src/arctic/data/directories.dat

sysgen/src/arctic/data/env_updates.dat

sysgen/src/arctic/scripts/load_midb.prl

sysgen/src/common/lib/dlt_ProgressMeter.pm

sysgen/src/common/lib/dlt_TapeInfo.pm

sysgen/src/common/lib/make_lib

sysgen/src/common/lib/zrt_roles.pm

tamps/CLASSIFIED/src/dbinstall/load/data/DD_CONDITIONS.backup

tamps/CLASSIFIED/src/dbinstall/load/data/DD_QUERY.backup

tamps/CLASSIFIED/src/dbinstall/load/data/DD_SAM_XREF.BCP

tamps/CLASSIFIED/src/dbinstall/load/data/DD_SUBQUERY.backup

tamps/CLASSIFIED/src/dbinstall/load/data/DD_USER_FIELDS.backup

tamps/CLASSIFIED/src/dbinstall/load/data/DD_VALID_XREF.bcp

tamps/CLASSIFIED/src/dbinstall/load/data/Install_load_c.csh

tamps/CLASSIFIED/src/dbinstall/load/data/OH_ATTRIBUTES.BCP.Z

tamps/CLASSIFIED/src/dbinstall/load/data/OH_CHILDREN.BCP

tamps/CLASSIFIED/src/dbinstall/load/data/OH_DELETED_IDS.BCP

tamps/CLASSIFIED/src/dbinstall/load/data/OH_GRAPHIC.BCP

tamps/CLASSIFIED/src/dbinstall/load/data/OH_OBJECT.BCP

tamps/CLASSIFIED/src/dbinstall/load/data/TAMPS_INTERIM_THREAT_TYPES.BCP

tamps/CLASSIFIED/src/dbinstall/load/data/TAMPS_SPEC_VALID_VALUES.bcp

tamps/CLASSIFIED/src/dbinstall/load/data/make_data

tamps/CLASSIFIED/src/dbinstall/sprocs/DD_MENU.BCP

tamps/config/lMake.sparcworks

tamps/env/tamps.env.dev

tamps/include/a_msn_plan/adt_msn_struct.h

tamps/include/a_msn_plan/apt_route.h

tamps/include/dbase/dft_struct.h

tamps/include/dbase/dit_defines.h

tamps/include/dbase/dit_enums.h

tamps/include/dbase/dit_proto.h

tamps/include_prot/a_msn_plan/adt_prot_proto.h

tamps/include_prot/b_msn_tools/btt_prot_proto.h

tamps/include_prot/dbase/dmt_default_defines.h

tamps/include_prot/dbase/dqt_prot_proto.h

tamps/include_prot/dbase/dut_prot_proto.h

tamps/src/apps/dbase/ddt/ddt_drmtool.c

tamps/src/apps/dbase/ddt/ddt_main.c

tamps/src/apps/dbase/dtf/Makefile

tamps/src/apps/dbase/dtf/dtf_filter.c

tamps/src/apps/dbase/dtt/Makefile

tamps/src/apps/dbase/dtt/dtt_Signal.c

tamps/src/apps/dbase/dtt/dtt_adline.c

tamps/src/apps/dbase/dtt/dtt_adline_tactical.c

tamps/src/apps/dbase/dtt/dtt_alloc.c

tamps/src/apps/dbase/dtt/dtt_deltab.c

tamps/src/apps/dbase/dtt/dtt_deltab_tactical.c

tamps/src/apps/dbase/dtt/dtt_free.c

tamps/src/apps/dbase/dtt/dtt_func.c

tamps/src/apps/dbase/dtt/dtt_load.c

tamps/src/apps/dbase/dtt/dtt_load_tactical.c

tamps/src/apps/dbase/dtt/dtt_modline.c

tamps/src/apps/dbase/dtt/dtt_modline_tactical.c

tamps/src/apps/dbase/dtt/dtt_stats.c

tamps/src/apps/dbase/dtt/dtt_statsmain.c

tamps/src/apps/dbase/dtt/dtt_switch.c

tamps/src/apps/dbase/dtt/dtt_sytest.c

tamps/src/apps/dbase/dtt/dtt_utils.c

tamps/src/apps/dbase/dtt/make_core

tamps/src/apps/dbase/dtt/make_core_dtt

tamps/src/apps/dbase/dtt/make_core_stats

tamps/src/apps/dbase/dtt/make_tac_dtt

tamps/src/apps/dbase/dtt/make_tac_stats

tamps/src/apps/dbase/dtt/make_tactical

tamps/src/apps/dbase/dvt/Makefile

tamps/src/apps/dbase/dvt/dvt_copyData.c

tamps/src/apps/dbase/dvt/dvt_dblists.c

tamps/src/apps/dbase/dvt/dvt_debug.c

tamps/src/apps/dbase/dvt/dvt_mainBest.c

tamps/src/apps/dbase/dvt/dvt_mainExtract.c

tamps/src/apps/dbase/dvt/dvt_mainUpdate.c

tamps/src/apps/dbase/dvt/dvt_updtBest.c

tamps/src/apps/dbase/dvt/dvt_updtData.c

tamps/src/apps/dbase/dvt/make_best

tamps/src/apps/dbase/dvt/make_extract

tamps/src/apps/dbase/dvt/make_update

tamps/src/apps/dbase/include/Makefile

tamps/src/apps/dbase/include/dtt_load.h

tamps/src/apps/dbase/include/dtt_priv_proto.h

tamps/src/apps/dbase/include/dtt_stream.h

tamps/src/apps/dbase/include/dvt_priv_proto.h

tamps/src/apps/dbase/include/dvt_structs.h

tamps/src/data/dbase/dlt_gmi_load_full.dat

tamps/src/data/dbase/dlt_gmi_load_small.dat

tamps/src/data/dbase/make_data

tamps/src/dbinstall/Install_classified.csh

tamps/src/dbinstall/data_dict/DD_JOINS.BCP

tamps/src/dbinstall/data_dict/DD_JOINS_ECAC.BCP

tamps/src/dbinstall/data_dict/DD_JOINS_EPL.BCP

tamps/src/dbinstall/data_dict/DD_JOINS_EWIR.BCP

tamps/src/dbinstall/data_dict/DD_QUERY.BCP

tamps/src/dbinstall/data_dict/DD_TRANSLATE.BCP

tamps/src/dbinstall/data_dict/Install_datadict.csh

tamps/src/dbinstall/data_dict/dd_databases_insert.sql

tamps/src/dbinstall/data_dict/dd_datasets_insert.sql

tamps/src/dbinstall/data_dict/dd_dbload_insert.sql

tamps/src/dbinstall/data_dict/dd_joins_checkpoint.bcp

tamps/src/dbinstall/data_dict/dd_joins_dafif.bcp

tamps/src/dbinstall/data_dict/dd_joins_insert.sql

tamps/src/dbinstall/data_dict/dd_joins_midb_subviews.bcp

tamps/src/dbinstall/data_dict/dd_joins_midb_tables.bcp

tamps/src/dbinstall/data_dict/dd_joins_nid.bcp

tamps/src/dbinstall/data_dict/dd_pks_dafif.bcp

tamps/src/dbinstall/data_dict/dd_pks_insert.sql

tamps/src/dbinstall/data_dict/dd_pks_midb.bcp

tamps/src/dbinstall/data_dict/dd_pks_nid.bcp

tamps/src/dbinstall/data_dict/dd_pks_pln_tgts.bcp

tamps/src/dbinstall/data_dict/dd_scenarios_create.sql

tamps/src/dbinstall/data_dict/dd_translate_insert.sql

tamps/src/dbinstall/data_dict/dd_valid_xref_insert.sql

tamps/src/dbinstall/data_dict/make_sql

tamps/src/dbinstall/security/grant_privs.pl

tamps/src/dbinstall/sprocs/Install_tamps_sp.csh

tamps/src/dbinstall/sprocs/gen_planner_sk_sp.sql

tamps/src/dbinstall/sprocs/make_sql

tamps/src/dbinstall/tampsdb/create/intel/tamps_interim_threats_create.sql

tamps/src/dbinstall/tampsdb/create/mission/Install_mission.csh

tamps/src/dbinstall/tampsdb/create/mission/make_sql

tamps/src/dbinstall/tampsdb/create/mission/tamps_midb_defaults.bcp

tamps/src/dbinstall/tampsdb/create/mission/tamps_midb_defaults_create.sql

tamps/src/dbinstall/tampsdb/create/mission/tamps_plnr_target_create.sql

tamps/src/dbinstall/tampsdb/create/mission/tamps_target_create.sql

tamps/src/dbinstall/tampsdb/create/mission/tamps_target_sk_create.sql

tamps/src/dbinstall/tampsdb/create/triggers/tamps_mission_plan_triggers.sql

tamps/src/dbinstall/tampsdb/create/triggers/tamps_triggers.sql

tamps/src/libs/a_msn_plan/adt/Makefile

tamps/src/libs/a_msn_plan/adt/adt_msn.c

tamps/src/libs/a_msn_plan/adt/adt_obsoleteCHK.c

tamps/src/libs/a_msn_plan/adt/adt_target.c

tamps/src/libs/a_msn_plan/adt/adt_tgData.c

tamps/src/libs/a_msn_plan/aet/aet_CkPtRefQuery.c

tamps/src/libs/a_msn_plan/aet/aet_RefChkpCb.c

tamps/src/libs/a_msn_plan/aet/aet_RefOAPCb.c

tamps/src/libs/a_msn_plan/amt/amt_bkdata.c

tamps/src/libs/a_msn_plan/amt/amt_rtdisp.c

tamps/src/libs/a_msn_plan/art/art_bkData.c

tamps/src/libs/a_msn_plan/art/art_utils.c

tamps/src/libs/a_msn_plan/axt/axt_createHandle.c

tamps/src/libs/a_msn_plan/include/adt_priv_proto.h

tamps/src/libs/a_msn_plan/include/aet_CkPtRefQuery.h

tamps/src/libs/a_msn_plan/include/axt_handle_defines.h

tamps/src/libs/b_msn_tools/btt/Makefile

tamps/src/libs/b_msn_tools/btt/btt_deftgt.c

tamps/src/libs/b_msn_tools/btt/btt_deftgtcb.c

tamps/src/libs/b_msn_tools/btt/btt_targetUtilities.c

tamps/src/libs/b_msn_tools/include/btt_deftgt.h

tamps/src/libs/b_msn_tools/include/btt_priv_proto.h

tamps/src/libs/dbase/dat/dat_delete.c

tamps/src/libs/dbase/dat/dat_insert.c

tamps/src/libs/dbase/dat/dat_obj_defs.c

tamps/src/libs/dbase/dat/dat_objects.c

tamps/src/libs/dbase/dat/dat_retrieve.c

tamps/src/libs/dbase/dat/dat_tab_defs.c

tamps/src/libs/dbase/dat/dat_update.c

tamps/src/libs/dbase/dat/dat_updateHook.c

tamps/src/libs/dbase/dat/dat_utils.c

tamps/src/libs/dbase/dat/dat_valid.c

tamps/src/libs/dbase/dbt/dbt_bcp_inout.c

tamps/src/libs/dbase/dft/Makefile

tamps/src/libs/dbase/dft/dft_getTargetData_c.C

tamps/src/libs/dbase/dil/Makefile

tamps/src/libs/dbase/dil/dil_Callbacks.c

tamps/src/libs/dbase/dil/dil_CreateDbaThreatEditorBB.c

tamps/src/libs/dbase/dil/dil_CreateIntThreatEditorBB.c

tamps/src/libs/dbase/dil/dil_DataBucketRoutines.c

tamps/src/libs/dbase/dil/dil_DbaAddInterimThreatToIdb.c

tamps/src/libs/dbase/dil/dil_DbaThreatEditor.c

tamps/src/libs/dbase/dil/dil_DeleteThreat.c

tamps/src/libs/dbase/dil/dil_DisplayInterimThreats.c

tamps/src/libs/dbase/dil/dil_EditThreat.c

tamps/src/libs/dbase/dil/dil_IdbQueries.c

tamps/src/libs/dbase/dil/dil_IdbfQueries.c

tamps/src/libs/dbase/dil/dil_IdbfqlQueries.c

tamps/src/libs/dbase/dil/dil_IdbuQueries.c

tamps/src/libs/dbase/dil/dil_InsertIdbRow.c

tamps/src/libs/dbase/dil/dil_InsertIdbfRow.c

tamps/src/libs/dbase/dil/dil_InsertIdbfqlRow.c

tamps/src/libs/dbase/dil/dil_InsertIdbuRow.c

tamps/src/libs/dbase/dil/dil_InsertInterimRow.c

tamps/src/libs/dbase/dil/dil_InterimThreatEditor.c

tamps/src/libs/dbase/dil/dil_InterimThreatQueries.c

tamps/src/libs/dbase/dil/dil_MapRoutines.c

tamps/src/libs/dbase/dil/dil_UpdateIdbData.c

tamps/src/libs/dbase/dil/dil_midbAAA.c

tamps/src/libs/dbase/dil/dil_midbSAM.c

tamps/src/libs/dbase/dil/dil_midbUnit.c

tamps/src/libs/dbase/dit/Makefile

tamps/src/libs/dbase/dit/dit_Aka_c.C

tamps/src/libs/dbase/dit/dit_EquipmentIndex_c.C

tamps/src/libs/dbase/dit/dit_Equipment_c.C

tamps/src/libs/dbase/dit/dit_Facility_c.C

tamps/src/libs/dbase/dit/dit_Observation_c.C

tamps/src/libs/dbase/dit/dit_PlannerTarget_c.C

tamps/src/libs/dbase/dit/dit_RemarkLine_c.C

tamps/src/libs/dbase/dit/dit_Remarks_c.C

tamps/src/libs/dbase/dit/dit_Target_c.C

tamps/src/libs/dbase/dit/dit_Track_c.C

tamps/src/libs/dbase/dit/dit_Unit_c.C

tamps/src/libs/dbase/dit/dit_equipmentHandle.C

tamps/src/libs/dbase/dit/dit_error.C

tamps/src/libs/dbase/dit/dit_facilityHandle.C

tamps/src/libs/dbase/dit/dit_midbBase_c.C

tamps/src/libs/dbase/dit/dit_midbUtilities.C

tamps/src/libs/dbase/dit/dit_observationHandle.C

tamps/src/libs/dbase/dit/dit_plnrTargetHandle.C

tamps/src/libs/dbase/dit/dit_sqlStmt_c.C

tamps/src/libs/dbase/dit/dit_targetHandle.C

tamps/src/libs/dbase/dit/dit_targetUtilities.C

tamps/src/libs/dbase/dit/dit_trackHandle.C
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tamps/mpm/raap/src/apps/dbase/drfl/drfl_format_tgt_insert.c

tamps/mpm/raap/src/apps/dbase/dril/Makefile

tamps/mpm/raap/src/apps/dbase/dril/dril_imagery_load_int.c

tamps/mpm/raap/src/apps/dbase/drrl/Makefile

tamps/mpm/raap/src/apps/dbase/drrl/drrl_auto_update_dbase.c

tamps/mpm/raap/src/apps/dbase/drrl/drrl_auto_update_dbase.make

tamps/mpm/raap/src/apps/dbase/drrl/drrl_retrieve.c

tamps/mpm/raap/src/apps/dbase/drrl/drrl_retrieve.make

tamps/mpm/raap/src/apps/dbase/drul/Makefile

tamps/mpm/raap/src/apps/dbase/drul/drul_raap_updates.c

tamps/mpm/raap/src/contrib/Makefile

tamps/mpm/raap/src/contrib/cml/Makefile

tamps/mpm/raap/src/contrib/cml/cml_mt_config_ed.c

tamps/mpm/raap/src/contrib/csl/Makefile

tamps/mpm/raap/src/contrib/csl/csl_raap_sybase_int_ed.c

tamps/mpm/scenarios/Makefile

tamps/mpm/scenarios/data/Makefile

tamps/mpm/scenarios/data/make_dirs

tamps/mpm/scenarios/data/make_sql

tamps/mpm/scenarios/data/scenarios_dbt_procedures.sql

tamps/mpm/scenarios/data/scenarios_dd_conditions.bcp

tamps/mpm/scenarios/data/scenarios_dd_menu.bcp

tamps/mpm/scenarios/data/scenarios_dd_query.bcp

tamps/mpm/scenarios/data/scenarios_dd_user_fields.bcp

tamps/mpm/scenarios/data/scenarios_drop_procedures.sql

tamps/mpm/scenarios/data/scenarios_remove_dd_data.sql

tamps/mpm/scenarios/scripts/Makefile

tamps/mpm/scenarios/scripts/cold_start/Makefile

tamps/mpm/scenarios/scripts/cold_start/scenarios_install_script.csh

tamps/mpm/scenarios/scripts/cold_start/scenarios_load_tape_script.csh

tamps/mpm/scenarios/scripts/mpm/Makefile

tamps/mpm/scenarios/scripts/mpm/scenarios_activate.csh

tamps/mpm/scenarios/scripts/mpm/scenarios_deactivate.csh

tamps/mpm/scenarios/scripts/mpm/scenarios_install_data.csh

tamps/src/apps/appgen/Makefile

tamps/src/apps/appgen/ddedit/Makefile

tamps/src/apps/appgen/ddedit/dddflt/Makefile

tamps/src/apps/appgen/ddedit/dddflt/df_cb.c

tamps/src/apps/appgen/ddedit/dddflt/df_create.c

tamps/src/apps/appgen/ddedit/dddflt/df_main.c

tamps/src/apps/appgen/ddedit/dddflt/df_qry.c

tamps/src/apps/appgen/ddedit/ddelnot/Makefile

tamps/src/apps/appgen/ddedit/ddelnot/el_cb.c

tamps/src/apps/appgen/ddedit/ddelnot/el_create.c

tamps/src/apps/appgen/ddedit/ddelnot/el_main.c

tamps/src/apps/appgen/ddedit/ddelnot/el_qry.c

tamps/src/apps/appgen/defs/BuildApps.csh

tamps/src/apps/appgen/defs/Makefile

tamps/src/apps/appgen/defs/NERF.def

tamps/src/apps/appgen/defs/NTCSA_UNIT.data

tamps/src/apps/appgen/defs/TFACEQP.def

tamps/src/apps/appgen/defs/TFACEXT.def

tamps/src/apps/appgen/defs/TFACPRM.def

tamps/src/apps/appgen/defs/TLOC.def

tamps/src/apps/appgen/defs/TRMKS.def

tamps/src/apps/appgen/defs/TUNIT.def

tamps/src/apps/appgen/defs/make_addEdit

tamps/src/apps/appgen/dil/Makefile

tamps/src/apps/appgen/dil/NTCSA/Makefile

tamps/src/apps/appgen/dil/NTCSA/NTCSA_AddEdit.ad

tamps/src/apps/appgen/dil/NTCSA/NTCSA_AddEdit.c

tamps/src/apps/appgen/dil/NTCSA/NTCSA_AddEdit.h

tamps/src/apps/appgen/dil/NTCSA/NTCSA_WindowCreation.c

tamps/src/apps/appgen/dil/NTCSA/dal_NTCSA.c

tamps/src/apps/appgen/dil/NTCSA/dal_NTCSA.h

tamps/src/apps/appgen/dil/NTCSA/dal_NTCSA_proto.h

tamps/src/apps/appgen/dil/NTCSA/dal_trans_NTCSA.h

tamps/src/apps/appgen/dil/NTCSA_UNIT/Makefile

tamps/src/apps/appgen/dil/NTCSA_UNIT/NTCSA_UNIT_AddEdit.ad

tamps/src/apps/appgen/dil/NTCSA_UNIT/NTCSA_UNIT_AddEdit.c

tamps/src/apps/appgen/dil/NTCSA_UNIT/NTCSA_UNIT_AddEdit.h

tamps/src/apps/appgen/dil/NTCSA_UNIT/NTCSA_UNIT_WindowCreation.c

tamps/src/apps/appgen/dil/NTCSA_UNIT/dal_NTCSA_UNIT.c

tamps/src/apps/appgen/dil/NTCSA_UNIT/dal_NTCSA_UNIT.h

tamps/src/apps/appgen/dil/NTCSA_UNIT/dal_NTCSA_UNIT_proto.h

tamps/src/apps/appgen/dil/NTCSA_UNIT/dal_trans_NTCSA_UNIT.h

tamps/src/apps/appgen/dil/TFAC/Makefile

tamps/src/apps/appgen/dil/TFAC/TFAC_AddEdit.ad

tamps/src/apps/appgen/dil/TFAC/TFAC_AddEdit.c

tamps/src/apps/appgen/dil/TFAC/TFAC_AddEdit.h

tamps/src/apps/appgen/dil/TFAC/TFAC_WindowCreation.c

tamps/src/apps/appgen/dil/TFAC/dal_TFAC.c

tamps/src/apps/appgen/dil/TFAC/dal_TFAC.h

tamps/src/apps/appgen/dil/TFAC/dal_TFAC_proto.h

tamps/src/apps/appgen/dil/TFAC/dal_trans_TFAC.h

tamps/src/apps/dbase/Makefile

tamps/src/apps/dbase/dit/Makefile

tamps/src/apps/dbase/dit/dit_callbacks.c

tamps/src/apps/dbase/dit/dit_creation.c

tamps/src/apps/dbase/dit/dit_image_input.c

tamps/src/apps/dbase/dit/dit_internals.c

tamps/src/apps/dbase/dit/dit_main.c

tamps/src/apps/dbase/include/Makefile

tamps/src/apps/dbase/include/dit_seh_defs.h

tamps/src/apps/dbase/include/dit_sids_defs.h

tamps/src/apps/dbase/include/dit_sui_defs.h

tamps/src/apps/lan/Makefile

tamps/src/apps/lan/include/lgt_priv_proto.h

tamps/src/apps/lan/lgt/Makefile

tamps/src/apps/lan/lgt/lgt_main.C

tamps/src/apps/lan/lgt/lgt_read.C

tamps/src/apps/lan/lgt/lgt_reset.C

tamps/src/apps/lan/lgt/lgt_save.C

tamps/src/apps/lan/lut/Makefile

tamps/src/apps/lan/lut/lut_wdtAlert.c

tamps/src/apps/zsystem/zbt/dt_defs.h

tamps/src/apps/zsystem/zet/zet_userMMIcb.c

tamps/src/data/aic/dbxref.dat

tamps/src/data/aic/make_data

tamps/src/data/environment/tamps.env

tamps/src/data/wse/system_admin.menu

tamps/src/dbinstall/Install_classified.csh

tamps/src/dbinstall/Install_dbinstall.csh

tamps/src/dbinstall/data_dict/DD_QUERY.BCP

tamps/src/dbinstall/data_dict/DD_TRANSLATE.BCP

tamps/src/dbinstall/data_dict/Install_datadict.csh

tamps/src/dbinstall/data_dict/cc_primary.sql

tamps/src/dbinstall/data_dict/dd_canIDB_create.sql

tamps/src/dbinstall/data_dict/dd_country_code_create.sql

tamps/src/dbinstall/data_dict/dd_country_code_insert.sql

tamps/src/dbinstall/data_dict/dd_cutdown_create.sql

tamps/src/dbinstall/data_dict/dd_datasets_insert.sql

tamps/src/dbinstall/data_dict/dd_dbload_insert.sql

tamps/src/dbinstall/data_dict/dd_defaults_create.sql

tamps/src/dbinstall/data_dict/dd_defaults_insert.sql

tamps/src/dbinstall/data_dict/dd_dot_defaults_create.sql

tamps/src/dbinstall/data_dict/dd_dot_defaults_insert.sql

tamps/src/dbinstall/data_dict/dd_elnot_create.sql

tamps/src/dbinstall/data_dict/dd_joins_midb_subviews.bcp

tamps/src/dbinstall/data_dict/dd_keys_create.sql

tamps/src/dbinstall/data_dict/dd_keys_insert.sql

tamps/src/dbinstall/data_dict/dd_maintTabs_create.sql

tamps/src/dbinstall/data_dict/dd_maintTabs_insert.sql

tamps/src/dbinstall/data_dict/dd_oneups_create.sql

tamps/src/dbinstall/data_dict/dd_oneups_insert.sql

tamps/src/dbinstall/data_dict/dd_pks_pln_tgts.bcp

tamps/src/dbinstall/data_dict/make_sql

tamps/src/dbinstall/extensions/Install_extensions.csh

tamps/src/dbinstall/extensions/Makefile

tamps/src/dbinstall/extensions/create_extensions.sql

tamps/src/dbinstall/extensions/make_scripts

tamps/src/dbinstall/extensions/make_sql

tamps/src/dbinstall/load/Install_load_c.csh

tamps/src/dbinstall/load/make_dbt

tamps/src/dbinstall/make_dirs

tamps/src/dbinstall/midb_tamps/Install_midb_tamps.csh

tamps/src/dbinstall/midb_tamps/Makefile

tamps/src/dbinstall/midb_tamps/X_PROFILE_ENTRY_TAMPS_SUBSET_I.bcp

tamps/src/dbinstall/midb_tamps/X_PROFILE_TAMPS_SUBSET_I.bcp

tamps/src/dbinstall/midb_tamps/delete_tamps_profile.sql

tamps/src/dbinstall/midb_tamps/make_scripts

tamps/src/dbinstall/midb_tamps/make_sql

tamps/src/dbinstall/nerf/Install_nerf.csh

tamps/src/dbinstall/nerf/Makefile

tamps/src/dbinstall/nerf/create_index_nerf.sql

tamps/src/dbinstall/nerf/create_table_nerf.sql

tamps/src/dbinstall/nerf/drop_table_nerf.sql

tamps/src/dbinstall/nerf/make_scripts

tamps/src/dbinstall/nerf/make_sql

tamps/src/dbinstall/nerf/nerf_primarykeys.sql

tamps/src/dbinstall/nerf/trunc_table_nerf.sql

tamps/src/dbinstall/security/grant_privs.pl

tamps/src/dbinstall/sprocs/Install_tamps_sp.csh

tamps/src/dbinstall/sprocs/dvt_IDBMainKeys.sql

tamps/src/dbinstall/sprocs/dvt_countIDBMainKeys.sql

tamps/src/dbinstall/sprocs/dvt_updtBest.sql

tamps/src/dbinstall/sprocs/insert_idbf_targets_sp.sql

tamps/src/dbinstall/sprocs/make_sql

tamps/src/dbinstall/tampsdb/create/catalog/Install_catalog.csh

tamps/src/dbinstall/tampsdb/create/catalog/make_sql

tamps/src/dbinstall/tampsdb/create/catalog/tamps_remote_updates_create.sql

tamps/src/dbinstall/tampsdb/create/mission/tamps_plnr_target_create.sql

tamps/src/dbinstall/tampsdb/load/intel/Install_intel_load.csh

tamps/src/dbinstall/tampsdb/load/intel/make_sql

tamps/src/dbinstall/tampsdb/load/intel/tamps_remote_updates_insert.sql

tamps/src/libs/Makefile

tamps/src/libs/a_msn_plan/awt/awt_createCB.c

tamps/src/libs/a_msn_plan/axt/axt_createHandle.c

tamps/src/libs/a_msn_plan/include/axt_handle_defines.h

tamps/src/libs/appgen/arl/IDBLentry.c

tamps/src/libs/appgen/arl/Makefile

tamps/src/libs/appgen/arl/PrimaryKeyUpdate.c

tamps/src/libs/appgen/arl/TerpesPrimaryKeyUpdate.c

tamps/src/libs/appgen/dal/Makefile

tamps/src/libs/appgen/dal/dal_TLOC.c

tamps/src/libs/appgen/include/dal_TLOC_proto.h

tamps/src/libs/appgen/include/dal_trans_TLOC.h

tamps/src/libs/appgen/include/make_includes

tamps/src/libs/b_msn_tools/bam/bam_wpnload.c

tamps/src/libs/b_msn_tools/btt/btt_deftgt.c

tamps/src/libs/b_msn_tools/btt/btt_deftgtcb.c

tamps/src/libs/b_msn_tools/btt/btt_targetUtilities.c

tamps/src/libs/b_msn_tools/include/btt_deftgt.h

tamps/src/libs/b_msn_tools/include/btt_priv_proto.h

tamps/src/libs/dbase/Makefile

tamps/src/libs/dbase/dat/Makefile

tamps/src/libs/dbase/dat/dat_geo.c

tamps/src/libs/dbase/dat/dat_oneUps.c

tamps/src/libs/dbase/dat/dat_utils.c

tamps/src/libs/dbase/det/det_aAARept.c

tamps/src/libs/dbase/det/det_aOBRept.c

tamps/src/libs/dbase/det/det_eOBRept.c

tamps/src/libs/dbase/det/det_gOBRept.c

tamps/src/libs/dbase/det/det_nOBRept.c

tamps/src/libs/dbase/det/det_oBRepts.c

tamps/src/libs/dbase/det/det_oBRpMMI.c

tamps/src/libs/dbase/det/det_sAMRept.c

tamps/src/libs/dbase/dft/Makefile

tamps/src/libs/dbase/dft/dft_IDBF.c

tamps/src/libs/dbase/dft/dft_IDBFQL.c

tamps/src/libs/dbase/dft/dft_IDBSITE.c

tamps/src/libs/dbase/dft/dft_IDBU.c

tamps/src/libs/dbase/dft/dft_IDBUL.c

tamps/src/libs/dbase/dft/dft_IDBUQL.c

tamps/src/libs/dbase/dft/dft_TACEQP.c

tamps/src/libs/dbase/dft/dft_TACR.c

tamps/src/libs/dbase/dft/dft_TACR_TEXT.c

tamps/src/libs/dbase/dft/dft_getOrderOfBattle.c

tamps/src/libs/dbase/dft/dft_getTargetData.c

tamps/src/libs/dbase/dht/dht_coverage.c

tamps/src/libs/dbase/dit/dit_error.C

tamps/src/libs/dbase/dit/dit_midbUtilities.C

tamps/src/libs/dbase/dlt/dlt_aictape.c

tamps/src/libs/dbase/dlt/dlt_eplnerf.c

tamps/src/libs/dbase/dlt/dlt_load.c

tamps/src/libs/dbase/dmt/dmt_DbaCoreManUpdate.c

tamps/src/libs/dbase/dmt/dmt_editMidbCb.c

tamps/src/libs/dbase/dmt/dmt_menu.c

tamps/src/libs/dbase/dnt/Makefile

tamps/src/libs/dbase/dnt/dnt_aaa.c

tamps/src/libs/dbase/dnt/dnt_aob.c

tamps/src/libs/dbase/dnt/dnt_eob.c

tamps/src/libs/dbase/dnt/dnt_gob.c

tamps/src/libs/dbase/dnt/dnt_nob.c

tamps/src/libs/dbase/dnt/dnt_oBMMI.c

tamps/src/libs/dbase/dnt/dnt_sam.c

tamps/src/libs/dbase/dot/Makefile

tamps/src/libs/dbase/dot/dot_obrep.c

tamps/src/libs/dbase/dot/dot_obrepCB.c

tamps/src/libs/dbase/dot/dot_obrepMMI.c

tamps/src/libs/dbase/dot/dot_process.c

tamps/src/libs/dbase/dot/dot_processMMI.c

tamps/src/libs/dbase/dot/dot_request.c

tamps/src/libs/dbase/dot/dot_requestMMI.c

tamps/src/libs/dbase/dot/dot_system_data.c

tamps/src/libs/dbase/dqt/dqt_select.c

tamps/src/libs/dbase/drt/Makefile

tamps/src/libs/dbase/drt/drt_reUtils.c

tamps/src/libs/dbase/drt/drt_remarks.c

tamps/src/libs/dbase/drt/drt_remkMMI.c

tamps/src/libs/dbase/dut/dut_matchRecs.c

tamps/src/libs/dbase/dut/dut_runMIDB.c

tamps/src/libs/dbase/dut/dut_scenariosMMI.c

tamps/src/libs/dbase/include/Makefile

tamps/src/libs/dbase/include/dat_priv_proto.h

tamps/src/libs/dbase/include/det_priv_proto.h

tamps/src/libs/dbase/include/det_reports_struct.h

tamps/src/libs/dbase/include/dft_priv_proto.h

tamps/src/libs/dbase/include/dit_priv_defines.h

tamps/src/libs/dbase/include/dlt_dbase.h

tamps/src/libs/dbase/include/dnt_ob_defines.h

tamps/src/libs/dbase/include/dnt_ob_struct.h

tamps/src/libs/dbase/include/dnt_priv_proto.h

tamps/src/libs/dbase/include/dot_obrep_struct.h

tamps/src/libs/dbase/include/dot_priv_proto.h

tamps/src/libs/dbase/include/dot_request_defines.h

tamps/src/libs/dbase/include/dot_request_struct.h

tamps/src/libs/dbase/include/drt_priv_proto.h

tamps/src/libs/dbase/include/dut_alert_defines.h

tamps/src/libs/dbase/include/dut_priv_proto.h

tamps/src/libs/intel/irt/Makefile

tamps/src/libs/intel/irt/irt_remarks.c

tamps/src/libs/layer/lbt/lbt_bucket.c

tamps/src/libs/layer/lbt/lbt_display.c

tamps/src/libs/maps/include/mwl_priv_proto.h

tamps/src/libs/maps/mwl/Makefile

tamps/src/libs/maps/mwl/mwl_DBAEnvironmentCB.c

tamps/src/libs/maps/mwl/mwl_DBASelection.c

tamps/src/libs/maps/mwl/mwl_getCDBSData.c

tamps/src/libs/products/include/Makefile

tamps/src/libs/products/include/prl_obrpt_column_array.h

tamps/src/libs/products/include/prl_priv_defs.h

tamps/src/libs/products/include/prl_priv_proto.h

tamps/src/libs/products/include/prl_target_column_array.h

tamps/src/libs/products/include/prl_toggle_defs.h

tamps/src/libs/products/prl/Makefile

tamps/src/libs/products/prl/prl_filter_obrpt.c

tamps/src/libs/products/prl/prl_format_obrpt_land.c

tamps/src/libs/products/prl/prl_format_obrpt_port.c

tamps/src/libs/products/prl/prl_format_target_land.c

tamps/src/libs/products/prl/prl_format_target_port.c

tamps/src/libs/products/prl/prl_obrpt_sql.c

tamps/src/libs/products/prl/prl_print.c

tamps/src/libs/products/prl/prl_report_tool.c

tamps/src/libs/products/prl/prl_select_rpt.c

tamps/src/libs/products/prl/prl_short_format.c

tamps/src/libs/products/prl/prl_target_sql.c

tamps/src/libs/system/include/sit_priv_proto.h

tamps/src/libs/system/sit/sit_defaultMenu.c

tamps/src/scripts/dbase/bin/clear_TEMP.scr

tamps/src/scripts/dbase/bin/create_header.scr

tamps/src/scripts/dbase/bin/create_schema.scr

tamps/src/scripts/dbase/bin/dlt_loadMIDBTF

tamps/src/scripts/dbase/bin/dlt_loadMIDBTape

tamps/src/scripts/dbase/bin/dumpTidbDb

tamps/src/scripts/dbase/bin/get_CC_name.scr

tamps/src/scripts/dbase/bin/get_header.scr

tamps/src/scripts/dbase/bin/load.scr

tamps/src/scripts/dbase/bin/load_CC.scr

tamps/src/scripts/dbase/bin/make_scripts

tamps/src/scripts/dbase/bin/maketape.scr

tamps/src/scripts/dbase/bin/nrfload.scr

tamps/src/scripts/dbase/bin/restoreTidbDb

tamps/src/scripts/dbase/bin/set_CC.scr

tamps/src/scripts/dbase/bin/unload.scr

tamps/src/scripts/dbase/bin/unload_CC.scr

tamps/src/scripts/lan/Makefile

tamps/src/scripts/lan/lut/Makefile

tamps/src/scripts/lan/lut/lut_GCCSStateUpd.pl

tamps/src/scripts/lan/lut/lut_dropSubscrips.sh

tamps/src/scripts/lan/lut/lut_loadRSAccts.pl

tamps/src/scripts/lan/lut/lut_quiesceRS.sh

tamps/src/scripts/lan/lut/lut_rsDisconnect.pl

tamps/src/scripts/lan/lut/lut_rsReSync.pl

tamps/src/scripts/lan/lut/lut_rsStatLoad.pl

tamps/src/scripts/lan/lut/lut_rsStatus.sh

tamps/src/scripts/lan/lut/make_scripts

===================================================================

Package: SOR-96-10

Item(s)

-------

tamps/include/help/thc_defines.h

tamps/include_prot/dbase/dmt_default_defines.h

tamps/include_prot/dbase/dpl_online_update.h

tamps/include_prot/dbase/dpl_prot_proto.h

tamps/src/apps/dbase/dpl/Makefile

tamps/src/apps/dbase/dpl/dpl_main.c

tamps/src/data/gps/Makefile

tamps/src/data/gps/auto_config

tamps/src/data/gps/make_data

tamps/src/libs/dbase/dgt/dgt_almanac.c

tamps/src/libs/dbase/dlt/dlt_magVarGPS.c

tamps/src/libs/dbase/dmt/dmt_menu.c

tamps/src/libs/dbase/dpl/Makefile

tamps/src/libs/dbase/dpl/dpl_DbaGPSOnlineUpdate.c

tamps/src/libs/dbase/dpl/dpl_gpsOnlineUI.c

tamps/src/libs/dbase/dpl/dpl_gpsOnlineUpdateCB.c

tamps/src/libs/dbase/dpl/dpl_message_proc.c

tamps/src/libs/dbase/include/dgt_priv_proto.h

tamps/src/libs/dbase/include/dlt_load_defines.h

tamps/src/libs/dbase/include/dpl_priv_proto.h

tamps/src/scripts/dbase/scripts/Makefile

tamps/src/scripts/dbase/scripts/gps_ftp.dat

tamps/src/scripts/dbase/scripts/gps_update.dat

tamps/src/scripts/dbase/scripts/make_gps

===================================================================

Package: SOR-96-52M

Item(s)

-------

tamps/include/devices/psl_ioctl.h

tamps/include/util/upl_defines.h

tamps/include/util/upl_proto.h

tamps/include/util/upl_structs.h

tamps/src/data/usr/kernel/drv/make_data

tamps/src/data/usr/kernel/drv/psl.conf

tamps/src/data/usr/kernel/drv/psl_add.sh

tamps/src/data/usr/kernel/drv/psl_rem.sh

tamps/src/devices/ad_hoc/Makefile

tamps/src/devices/ad_hoc/include/Makefile

tamps/src/devices/ad_hoc/include/psl_defs.h

tamps/src/devices/ad_hoc/include/psl_struct.h

tamps/src/devices/ad_hoc/psl/Makefile

tamps/src/devices/ad_hoc/psl/psl.c

tamps/src/libs/util/Makefile

tamps/src/libs/util/include/Makefile

tamps/src/libs/util/include/upl_priv_defines.h

tamps/src/libs/util/include/upl_priv_proto.h

tamps/src/libs/util/include/upl_priv_structs.h

tamps/src/libs/util/upl/MakeLib

tamps/src/libs/util/upl/Make_pccat

tamps/src/libs/util/upl/Make_pccp

tamps/src/libs/util/upl/Make_pcdf

tamps/src/libs/util/upl/Make_pcdump

tamps/src/libs/util/upl/Make_pcformat

tamps/src/libs/util/upl/Make_pcls

tamps/src/libs/util/upl/Make_pcrm

tamps/src/libs/util/upl/Make_pcscrub

tamps/src/libs/util/upl/Make_uplmap

tamps/src/libs/util/upl/Makefile

tamps/src/libs/util/upl/TestCardInfo.c

tamps/src/libs/util/upl/TestCat.c

tamps/src/libs/util/upl/TestCopy.c

tamps/src/libs/util/upl/TestDisect.c

tamps/src/libs/util/upl/TestDumpFS.c

tamps/src/libs/util/upl/TestFormat.c

tamps/src/libs/util/upl/TestListFiles.c

tamps/src/libs/util/upl/TestRemove.c

tamps/src/libs/util/upl/TestScrubCard.c

tamps/src/libs/util/upl/upl_CardInfo.c

tamps/src/libs/util/upl/upl_Close.c

tamps/src/libs/util/upl/upl_DisectFilePath.c

tamps/src/libs/util/upl/upl_FSUtils.c

tamps/src/libs/util/upl/upl_Format.c

tamps/src/libs/util/upl/upl_IOUtils.c

tamps/src/libs/util/upl/upl_ListFiles.c

tamps/src/libs/util/upl/upl_MapCache.c

tamps/src/libs/util/upl/upl_Open.c

tamps/src/libs/util/upl/upl_Read.c

tamps/src/libs/util/upl/upl_Remove.c

tamps/src/libs/util/upl/upl_ScrubCard.c

tamps/src/libs/util/upl/upl_Seek.c

tamps/src/libs/util/upl/upl_Support.c

tamps/src/libs/util/upl/upl_Write.c

tamps/src/libs/util/upl/uplmap.tab

===================================================================

Package: SOR-96-60A

Item(s)

-------

tamps/config/projpath

tamps/include/reports/rht_defs.h

tamps/include/reports/rtt_txtTool.h

tamps/include_prot/reports/rcl_prot_proto.h

tamps/src/libs/layer/include/llt_defines.h

tamps/src/libs/layer/lht/lht_handler.c

tamps/src/libs/layer/llt/llt_calbaks.c

tamps/src/libs/layer/llt/llt_create.c

tamps/src/libs/reports/Makefile

tamps/src/libs/reports/include/Makefile

tamps/src/libs/reports/include/rcl_CountBy.h

tamps/src/libs/reports/include/rcl_CountByBucketObject.h

tamps/src/libs/reports/include/rcl_CountByDrawingArea.h

tamps/src/libs/reports/include/rcl_CountByMap.h

tamps/src/libs/reports/include/rcl_CountByPreferences.h

tamps/src/libs/reports/include/rcl_CountByResult.h

tamps/src/libs/reports/include/rcl_CountByTriad.h

tamps/src/libs/reports/include/rcl_CountByWindow.h

tamps/src/libs/reports/include/rcl_defines.h

tamps/src/libs/reports/include/rtt_priv_proto.h

tamps/src/libs/reports/rcl/Makefile

tamps/src/libs/reports/rcl/rcl_CountBy.c

tamps/src/libs/reports/rcl/rcl_CountByBucket.c

tamps/src/libs/reports/rcl/rcl_CountByBucketObject.c

tamps/src/libs/reports/rcl/rcl_CountByDrawingArea.c

tamps/src/libs/reports/rcl/rcl_CountByExternalActions.c

tamps/src/libs/reports/rcl/rcl_CountByLocalActions.c

tamps/src/libs/reports/rcl/rcl_CountByMap.c

tamps/src/libs/reports/rcl/rcl_CountByOperations.c

tamps/src/libs/reports/rcl/rcl_CountByOutput.c

tamps/src/libs/reports/rcl/rcl_CountByPreferences.c

tamps/src/libs/reports/rcl/rcl_CountByResult.c

tamps/src/libs/reports/rcl/rcl_CountByTriad.c

tamps/src/libs/reports/rcl/rcl_CountByWindow.c

tamps/src/libs/reports/rcl/rcl_CountByWindowCallbacks.c

tamps/src/libs/reports/rcl/rcl_CountByWindowHMI.c

tamps/src/libs/reports/rcl/rcl_CountByWindowHandlers.c

tamps/src/libs/reports/rtt/rtt_mmi.c

tamps/src/libs/reports/rtt/rtt_textTool.c

===================================================================

Package: SOR-96-60H

Item(s)

-------

tamps/include/help/thc_defines.h

tamps/src/apps/objh/Makefile

tamps/src/apps/objh/include/oet_objDsp.h

tamps/src/apps/objh/include/oet_priv_proto.h

tamps/src/apps/objh/include/oil_CAliasEntry.h

tamps/src/apps/objh/include/oil_CBitmapEntry.h

tamps/src/apps/objh/include/oil_CChildEntry.h

tamps/src/apps/objh/include/oil_CCondEntry.h

tamps/src/apps/objh/include/oil_CControlRecord.h

tamps/src/apps/objh/include/oil_CFileAccess.h

tamps/src/apps/objh/include/oil_CFileRecord.h

tamps/src/apps/objh/include/oil_CMenuEntry.h

tamps/src/apps/objh/include/oil_CObjectBranch.h

tamps/src/apps/objh/include/oil_CObjectList.h

tamps/src/apps/objh/include/oil_CQueryEntry.h

tamps/src/apps/objh/include/oil_CReqAction.h

tamps/src/apps/objh/include/oil_CSubQuery.h

tamps/src/apps/objh/include/oil_CTableEntry.h

tamps/src/apps/objh/include/oil_CUserField.h

tamps/src/apps/objh/include/oil_ErrorValues.h

tamps/src/apps/objh/include/oil_defines.h

tamps/src/apps/objh/include/oil_structs.h

tamps/src/apps/objh/include/oml_priv_proto.h

tamps/src/apps/objh/oet/Makefile

tamps/src/apps/objh/oet/oet_editMMI.c

tamps/src/apps/objh/oet/oet_impexpMMI.c

tamps/src/apps/objh/oil/Make.export

tamps/src/apps/objh/oil/Make.import

tamps/src/apps/objh/oil/Makefile

tamps/src/apps/objh/oil/oil_CAliasEntry.C

tamps/src/apps/objh/oil/oil_CBitmapEntry.C

tamps/src/apps/objh/oil/oil_CChildEntry.C

tamps/src/apps/objh/oil/oil_CCondEntry.C

tamps/src/apps/objh/oil/oil_CCondList.C

tamps/src/apps/objh/oil/oil_CControlRecord.C

tamps/src/apps/objh/oil/oil_CFileAccess.C

tamps/src/apps/objh/oil/oil_CMenuEntry.C

tamps/src/apps/objh/oil/oil_CObjectBranch.C

tamps/src/apps/objh/oil/oil_CObjectList.C

tamps/src/apps/objh/oil/oil_CQueryEntry.C

tamps/src/apps/objh/oil/oil_CReqAction.C

tamps/src/apps/objh/oil/oil_CSubQuery.C

tamps/src/apps/objh/oil/oil_CTableEntry.C

tamps/src/apps/objh/oil/oil_CUserField.C

tamps/src/apps/objh/oil/oil_export_main.C

tamps/src/apps/objh/oil/oil_import_main.C

tamps/src/apps/objh/oml/Make.appendObj

tamps/src/apps/objh/oml/Make.deleteObj

tamps/src/apps/objh/oml/Makefile

tamps/src/apps/objh/oml/oml_AppendObjects.C

tamps/src/apps/objh/oml/oml_deleteMain.c

tamps/src/apps/objh/oml/oml_deleteObject.c

tamps/src/test/SOR9660H/README

tamps/src/test/SOR9660H/oil_dumpfile

===================================================================

Package: SOR-96-60HBLD4

Item(s)

-------

tamps/mpm/a6e/scripts/cold_start/Make_objects

tamps/mpm/a6e/scripts/cold_start/Makefile

tamps/mpm/a6e/scripts/cold_start/Objects/Makefile

tamps/mpm/a6e/scripts/cold_start/Objects/TEST_OBJECT.odf

tamps/mpm/a6e/scripts/cold_start/Objects/make_data

tamps/mpm/a6e/scripts/cold_start/a6e_install_objects.csh

tamps/mpm/a6e/scripts/cold_start/a6e_load_tape_script.csh

tamps/mpm/a6e/scripts/cold_start/make_scripts

tamps/src/apps/objh/include/oil_defines.h

===================================================================

Package: SOR-96-68

Item(s)

-------

tamps/config/projpath

tamps/include/a_msn_plan/axt_defines.h

tamps/include/a_msn_plan/axt_proto.h

tamps/include_prot/a_msn_plan/aet_prot_proto.h

tamps/include_prot/a_msn_plan/axt_prot_proto.h

tamps/mpm/Makefile

tamps/mpm/f14/src/f14/f14_route_validation.c

tamps/mpm/f14/src/f14et/fet_validate_event.c

tamps/mpm/f14/src/f14it/fit_define_callbacks.c

tamps/src/libs/a_msn_plan/aet/aet_EditNavCb.c

tamps/src/libs/a_msn_plan/aet/aet_MCPRcallBacks.c

tamps/src/libs/a_msn_plan/aet/aet_NavUtils.c

tamps/src/libs/a_msn_plan/aet/aet_RouteUtils.c

tamps/src/libs/a_msn_plan/aft/aft_AttackUtils.c

tamps/src/libs/a_msn_plan/aft/aft_FlightUtils.c

tamps/src/libs/a_msn_plan/ait/ait_LaunchDialogCb.c

tamps/src/libs/a_msn_plan/ait/ait_LaunchUtils.c

tamps/src/libs/a_msn_plan/ait/ait_memManagement.c

tamps/src/libs/a_msn_plan/amt/amt_rtdisp.c

tamps/src/libs/a_msn_plan/axt/axt_createHandle.c

tamps/src/libs/a_msn_plan/axt/axt_deleteHandle.c

tamps/src/libs/a_msn_plan/axt/axt_insert.c

tamps/src/libs/a_msn_plan/axt/axt_utils.c

tamps/src/libs/a_msn_plan/axt/axt_waypoint.c

tamps/src/libs/a_msn_plan/include/axt_handle_defines.h

tamps/src/libs/b_msn_tools/Makefile

tamps/src/test/SOR9668/app/Makefile

tamps/src/test/SOR9668/app/a6e_error.c

tamps/src/test/SOR9668/app/a6e_exit.c

tamps/src/test/SOR9668/app/a6e_il_define_callbacks.c

tamps/src/test/SOR9668/app/a6e_main.c

tamps/src/test/SOR9668/app/a6e_route_validation.c

tamps/src/test/SOR9668/include/a6e_dl_DataPnt.h

tamps/src/test/SOR9668/include/a6e_dl_DataPnt_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_1.h

tamps/src/test/SOR9668/include/a6e_dl_dal_12.h

tamps/src/test/SOR9668/include/a6e_dl_dal_12_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_13.h

tamps/src/test/SOR9668/include/a6e_dl_dal_13_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_15.h

tamps/src/test/SOR9668/include/a6e_dl_dal_15_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_16.h

tamps/src/test/SOR9668/include/a6e_dl_dal_16_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_17.h

tamps/src/test/SOR9668/include/a6e_dl_dal_17_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_1_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_2.h

tamps/src/test/SOR9668/include/a6e_dl_dal_20.h

tamps/src/test/SOR9668/include/a6e_dl_dal_20_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_21.h

tamps/src/test/SOR9668/include/a6e_dl_dal_21_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_22.h

tamps/src/test/SOR9668/include/a6e_dl_dal_22_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_25.h

tamps/src/test/SOR9668/include/a6e_dl_dal_25_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_2_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_3.h

tamps/src/test/SOR9668/include/a6e_dl_dal_3_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_4.h

tamps/src/test/SOR9668/include/a6e_dl_dal_4_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_5.h

tamps/src/test/SOR9668/include/a6e_dl_dal_5_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_6.h

tamps/src/test/SOR9668/include/a6e_dl_dal_6_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_7.h

tamps/src/test/SOR9668/include/a6e_dl_dal_7_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_8.h

tamps/src/test/SOR9668/include/a6e_dl_dal_8_proto.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_1.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_12.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_13.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_15.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_16.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_17.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_2.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_20.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_21.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_22.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_25.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_3.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_4.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_5.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_6.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_7.h

tamps/src/test/SOR9668/include/a6e_dl_dal_trans_8.h

tamps/src/test/SOR9668/include/a6e_el_hold_event.h

tamps/src/test/SOR9668/include/a6e_el_validate_event.h

tamps/src/test/SOR9668/include/a6e_error.h

tamps/src/test/SOR9668/include/a6e_error_defs.h

tamps/src/test/SOR9668/include/a6e_errors_general.h

tamps/src/test/SOR9668/include/a6e_exit.h

tamps/src/test/SOR9668/include/a6e_global_defs.h

tamps/src/test/SOR9668/include/a6e_il_define_callbacks.h

tamps/src/test/SOR9668/include/a6e_il_toolbar_init.h

tamps/src/test/SOR9668/include/a6e_ml_chk_flight_mode_event.h

tamps/src/test/SOR9668/include/a6e_ml_default_flight_mode.h

tamps/src/test/SOR9668/include/a6e_ml_determine_cruise_spd.h

tamps/src/test/SOR9668/include/a6e_ml_divert_calcs.h

tamps/src/test/SOR9668/include/a6e_ml_drag_calcs.h

tamps/src/test/SOR9668/include/a6e_ml_eval_table.h

tamps/src/test/SOR9668/include/a6e_ml_flight_modes.h

tamps/src/test/SOR9668/include/a6e_ml_get_flight_mode.h

tamps/src/test/SOR9668/include/a6e_ml_mil_settings.h

tamps/src/test/SOR9668/include/a6e_ml_optimum_cruise.h

tamps/src/test/SOR9668/include/a6e_ml_poly_process_modes.h

tamps/src/test/SOR9668/include/a6e_ml_process_modes.h

tamps/src/test/SOR9668/include/a6e_ml_set_flight_mode.h

tamps/src/test/SOR9668/include/a6e_ml_table_perf_vals.h

tamps/src/test/SOR9668/include/a6e_ml_table_process_modes.h

tamps/src/test/SOR9668/include/a6e_ml_validate_flight_mode.h

tamps/src/test/SOR9668/include/a6e_route_validation.h

tamps/src/test/SOR9668/include/a6e_static_data.h

tamps/src/test/SOR9668/include/a6e_test_api_menu.h

===================================================================

Package: SOR-96-71

Item(s)

-------

tamps/include/maps/mt_defs.h

tamps/include/tms/tit_nitf.h

tamps/include_prot/maps/mpt_prot_proto.h

tamps/include_prot/tms/tit_prot_proto.h

tamps/src/libs/b_msn_tools/bsa/bsa_LoadADRI8.c

tamps/src/libs/dbase/dlt/dlt_adri.c

tamps/src/libs/dbase/dmt/dmt_menu.c

tamps/src/libs/maps/include/mmt_priv_proto.h

tamps/src/libs/maps/mmt/mmt_bkgndcb.c

tamps/src/libs/maps/mmt/mmt_hook.c

tamps/src/libs/maps/mmt/mmt_imageDisp.c

tamps/src/libs/maps/mmt/mmt_imagery.c

tamps/src/libs/maps/mpt/mpt_bldPrim.c

tamps/src/libs/maps/mpt/mpt_draw.c

tamps/src/libs/maps/mpt/mpt_loadNitf.c

tamps/src/libs/maps/mpt/mpt_mapDisp.c

tamps/src/libs/maps/mpt/mpt_mgmtFnc.c

tamps/src/libs/maps/mpt/mpt_prot_proto.h

tamps/src/libs/maps/mpt/tit_nitfutilities.c

tamps/src/libs/maps/mwl/mwl_DisplayData.c

tamps/src/libs/products/include/prl_image_column_array.h

tamps/src/libs/products/include/prl_priv_defs.h

tamps/src/libs/products/prl/prl_dted_sql.c

tamps/src/libs/products/prl/prl_filter_image.c

tamps/src/libs/products/prl/prl_format_dtedrpt_land.c

tamps/src/libs/products/prl/prl_format_dtedrpt_port.c

tamps/src/libs/products/prl/prl_short_format.c

tamps/src/libs/system/sit/sit_defaultMenu.c

tamps/src/libs/tms/include/tit_nitf_jpegdata.h

tamps/src/libs/tms/tit/tit_nitf_jrdjfif.c

tamps/src/libs/tms/tit/tit_nitfgeorectify.c

tamps/src/libs/tms/tit/tit_nitfutilities.c

tamps/src/libs/tms/tit/tit_readnitfheader.c

tamps/src/libs/tms/tit/tit_readnitfimageheader.c

tamps/src/libs/tms/tit/tit_readnitfjpeg.c

===================================================================

Package: SOR-97-10A

Item(s)

-------

tamps/config/projpath

tamps/include/dbase/dft_struct.h

tamps/include/dbase/dft_table_struct.h

tamps/include/system/st_sysdefs.h

tamps/include_prot/dbase/dft_prot_proto.h

tamps/include_prot/dbase/dft_threat_defines.h

tamps/include_prot/tms/tet_prot_proto.h

tamps/src/dbinstall/data_dict/dd_valid_threat_types_create.sql

tamps/src/dbinstall/data_dict/dd_valid_threat_types_insert.sql

tamps/src/dbinstall/data_dict/make_sql

tamps/src/libs/dbase/dft/Makefile

tamps/src/libs/dbase/dft/dft_NID_SAM.c

tamps/src/libs/dbase/dft/dft_getDefenseChar.c

tamps/src/libs/dbase/dft/dft_getOrderOfBattle.c

tamps/src/libs/dbase/dft/dft_selectNid.c

tamps/src/libs/dbase/include/dft_priv_proto.h

tamps/src/libs/tms/Makefile

tamps/src/libs/tms/tet/Makefile

tamps/src/libs/tms/tet/tet_api.C

tamps/src/libs/tms/tet_api.C

tamps/src/test/sor9710/app/Makefile

tamps/src/test/sor9710/app/ddt_main.c

tamps/src/test/sor9710/app/ddt_mnucb.c

tamps/src/test/sor9710/app/ddt_pswdMMI.c

tamps/src/test/sor9710/app/ddt_pswdcb.c

tamps/src/test/sor9710/app/dmt_menu.c

tamps/src/test/sor9710/app/sor9710TestCb.c

tamps/src/test/sor9710/app/sor9710TestDriver.c

tamps/src/test/sor9710/app/sor9710TestMenus.c

tamps/src/test/sor9710/include/dmt_default_defines.h

tamps/src/test/sor9710/include/sor9710Test.h

===================================================================

Package: SOR-97-10B

Item(s)

-------

tamps/src/test/sor9710/app/ddt_main.c

tamps/src/test/sor9710/app/dmt_menu.c

tamps/src/test/sor9710/include/dmt_default_defines.h

===================================================================

Package: SOR-97-11A

Item(s)

-------

tamps/config/projpath

tamps/env/tamps.env.dev

tamps/include/jtim/jet_defines.h

tamps/include/jtim/jet_proto.h

tamps/include/jtim/jet_structs.h

tamps/include/layer/lbt_proto.h

tamps/include/maps/mpt_proto.h

tamps/include/maps/mt_defs.h

tamps/include/maps/mt_maoi.h

tamps/include/system/sit_default_defines.h

tamps/include/tms/tet_proto.h

tamps/include/tms/tit_imagery.h

tamps/include_prot/dbase/dmt_default_defines.h

tamps/include_prot/jtim/jet_ce_proto.h

tamps/include_prot/jtim/jet_prot_proto.h

tamps/include_prot/maps/mpt_prot_proto.h

tamps/include_prot/tms/tet_prot_proto.h
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tamps/src/libs/jtim/include/jsg_detail.h

tamps/src/libs/jtim/include/jsg_priv_define.h

tamps/src/libs/jtim/include/jsg_priv_proto.h

tamps/src/libs/jtim/include/jsg_priv_structs.h

tamps/src/libs/jtim/include/jtg_ce_proto.h

tamps/src/libs/jtim/include/jtg_vwrapp.h

tamps/src/libs/jtim/include/jtg_vwrapp_misc.h

tamps/src/libs/jtim/include/jug_gui.h

tamps/src/libs/jtim/include/jug_vwrgui.h

tamps/src/libs/jtim/include/jvg_attributes.h

tamps/src/libs/jtim/include/jvg_attributes.sh

tamps/src/libs/jtim/include/jvg_geographic_display.h

tamps/src/libs/jtim/include/jvg_geographic_display.sh

tamps/src/libs/jtim/include/jvg_geolocate.h

tamps/src/libs/jtim/include/jvg_geolocate.sh

tamps/src/libs/jtim/include/jvg_priv_proto.h

tamps/src/libs/jtim/include/jvg_refresh_display.h

tamps/src/libs/jtim/include/jvg_refresh_display.sh

tamps/src/libs/jtim/include/jvg_rotate.h

tamps/src/libs/jtim/include/jvg_rotate.sh

tamps/src/libs/jtim/jet/jet_init.c

tamps/src/libs/jtim/jfg/Makefile

tamps/src/libs/jtim/jfg/jfg_vwrapp_file.c

tamps/src/libs/jtim/jqg/Makefile

tamps/src/libs/jtim/jqg/jqg_Convert_Boundaries.c

tamps/src/libs/jtim/jqg/jqg_ErrQuerySPA.c

tamps/src/libs/jtim/jqg/jqg_ImageQuery.c

tamps/src/libs/jtim/jqg/jqg_ProductQuery.c

tamps/src/libs/jtim/jqg/jqg_QueryBase.c

tamps/src/libs/jtim/jqg/jqg_QueryIDStr.c

tamps/src/libs/jtim/jqg/jqg_QueryResultListTAMPS.c

tamps/src/libs/jtim/jqg/jqg_QuerySPA.c

tamps/src/libs/jtim/jqg/jqg_QueryTAMPS.c

tamps/src/libs/jtim/jqg/jqg_SpaQueryBase.c

tamps/src/libs/jtim/jqg/jqg_query.c

tamps/src/libs/jtim/jqg/jqg_query_cb.c

tamps/src/libs/jtim/jrg/Makefile

tamps/src/libs/jtim/jrg/jrg_ProductStr.c

tamps/src/libs/jtim/jrg/jrg_TAMPS_Inter.c

tamps/src/libs/jtim/jrg/jrg_functions.c

tamps/src/libs/jtim/jrg/jrg_messages.c

tamps/src/libs/jtim/jrg/jrg_retrieve.c

tamps/src/libs/jtim/jrg/jrg_retrieve_cb.c

tamps/src/libs/jtim/jsg/Makefile

tamps/src/libs/jtim/jsg/jsg_Conversions.c

tamps/src/libs/jtim/jsg/jsg_CreatePGM_ProdStr.c

tamps/src/libs/jtim/jsg/jsg_DeepCopy.c

tamps/src/libs/jtim/jsg/jsg_ErrSocket.c

tamps/src/libs/jtim/jsg/jsg_FileMonitor.c

tamps/src/libs/jtim/jsg/jsg_Free.c

tamps/src/libs/jtim/jsg/jsg_GenerateProduct.c

tamps/src/libs/jtim/jsg/jsg_GenerationRequest.c

tamps/src/libs/jtim/jsg/jsg_LinkedList.c

tamps/src/libs/jtim/jsg/jsg_LinkedListItemBase.c

tamps/src/libs/jtim/jsg/jsg_LinkedListStringItem.c

tamps/src/libs/jtim/jsg/jsg_MsgBox.c

tamps/src/libs/jtim/jsg/jsg_RequestBase.c

tamps/src/libs/jtim/jsg/jsg_RetrievalRequest.c

tamps/src/libs/jtim/jsg/jsg_RetrieveProduct.c

tamps/src/libs/jtim/jsg/jsg_b64.c

tamps/src/libs/jtim/jsg/jsg_detail.c

tamps/src/libs/jtim/jsg/jsg_detail_cb.c

tamps/src/libs/jtim/jsg/jsg_jtim_jpeg_decompress.c

tamps/src/libs/jtim/jsg/jsg_socket_message.c

tamps/src/libs/jtim/jsg/jsg_sockets.c

tamps/src/libs/jtim/jsg/jsg_sr.c

tamps/src/libs/jtim/jtg/Makefile

tamps/src/libs/jtim/jtg/jtg_main.c

tamps/src/libs/jtim/jtg/jtg_vwrapp.c

tamps/src/libs/jtim/jtg/jtg_vwrapp_misc.c

tamps/src/libs/jtim/jug/Makefile

tamps/src/libs/jtim/jug/jug_gui.c

tamps/src/libs/jtim/jug/jug_stubs.c

tamps/src/libs/jtim/jug/jug_vwrgui.c

tamps/src/libs/jtim/jvg/Makefile

tamps/src/libs/jtim/jvg/jvg_attributes.c

tamps/src/libs/jtim/jvg/jvg_geographic_display.c

tamps/src/libs/jtim/jvg/jvg_geolocate.c

tamps/src/libs/jtim/jvg/jvg_refresh_display.c

tamps/src/libs/jtim/jvg/jvg_rotate.c

tamps/src/libs/tms/tit/tit_nitfutilities.c

===================================================================

Package: SOR-97-11B4A

Item(s)

-------

tamps/config/projpath

tamps/env/tamps.env.dev

tamps/include/jtim/jet_proto.h

tamps/src/apps/Makefile

tamps/src/apps/jtim/Makefile

tamps/src/apps/jtim/include/Makefile

tamps/src/apps/jtim/include/jsg_SpaClientInterface.h

tamps/src/apps/jtim/include/jsg_SpaClientInterface_main.h

tamps/src/apps/jtim/jpg/Makefile

tamps/src/apps/jtim/jpg/jpg_MPM_Monitor.c

tamps/src/apps/jtim/jsg/Makefile

tamps/src/apps/jtim/jsg/jsg_SpaClientInterface.c

tamps/src/apps/jtim/jsg/jsg_SpaClientInterface_main.c

tamps/src/contrib/jtim_gots/iiviewer/include/app_local_types.h

tamps/src/contrib/jtim_gots/iiviewer/include/doc_local_types.h

tamps/src/contrib/jtim_gots/iiviewer/include/gui_local_types.h

tamps/src/contrib/jtim_gots/iiviewer/include/view_local_types.h

tamps/src/contrib/jtim_gots/iiviewer/include/vwrapp_callbacks.h

tamps/src/contrib/jtim_gots/iiviewer/include/vwrapp_file.h

tamps/src/contrib/jtim_gots/iiviewer/include/vwrapp_types.h

tamps/src/contrib/jtim_gots/iiviewer/include/vwrdoc.h

tamps/src/contrib/jtim_gots/iiviewer/include/vwrgui.h

tamps/src/contrib/jtim_gots/iiviewer/include/vwrview.h

tamps/src/contrib/jtim_gots/iiviewer/include/vwrview_types.h

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.a

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.so

tamps/src/contrib/jtim_gots/matrix/include/gio/giocol_types.sh

tamps/src/contrib/jtim_gots/matrix/include/gio/giolst.h

tamps/src/contrib/jtim_gots/matrix/include/gio/gioobj.h

tamps/src/contrib/jtim_gots/matrix/include/img/img_local_types.h

tamps/src/contrib/jtim_gots/matrix/include/nt2/obj_types.sh

tamps/src/contrib/jtim_gots/matrix/lib/Makefile

tamps/src/contrib/jtim_gots/matrix/lib/libaridpcm.so

tamps/src/contrib/jtim_gots/matrix/lib/libcgm.so

tamps/src/contrib/jtim_gots/matrix/lib/libcopy.so

tamps/src/contrib/jtim_gots/matrix/lib/libdsp.so

tamps/src/contrib/jtim_gots/matrix/lib/libenh.so

tamps/src/contrib/jtim_gots/matrix/lib/libgio.a

tamps/src/contrib/jtim_gots/matrix/lib/libgio.so

tamps/src/contrib/jtim_gots/matrix/lib/libgio2.a

tamps/src/contrib/jtim_gots/matrix/lib/libgio2.sa

tamps/src/contrib/jtim_gots/matrix/lib/libgio2.so

tamps/src/contrib/jtim_gots/matrix/lib/libmath.so

tamps/src/contrib/jtim_gots/matrix/lib/libmcom.so

tamps/src/contrib/jtim_gots/matrix/lib/libvwr.a

tamps/src/contrib/jtim_gots/matrix/lib/libvwr.so

tamps/src/data/environment/services

tamps/src/data/environment/tamps.env

tamps/src/libs/jtim/Makefile

tamps/src/libs/jtim/include/Makefile

tamps/src/libs/jtim/include/jeg_priv_proto.h

tamps/src/libs/jtim/include/jet_priv_proto.h

tamps/src/libs/jtim/include/jfg_DataStructures.h

tamps/src/libs/jtim/include/jfg_priv_proto.h

tamps/src/libs/jtim/include/jfg_priv_structs.h

tamps/src/libs/jtim/include/jfg_vwrapp_file.h

tamps/src/libs/jtim/include/jgg_priv_defines.h

tamps/src/libs/jtim/include/jgg_priv_proto.h

tamps/src/libs/jtim/include/jpg_priv_proto.h

tamps/src/libs/jtim/include/jpg_priv_structs.h

tamps/src/libs/jtim/include/jqg_ImageQuery.h

tamps/src/libs/jtim/include/jqg_ProductQuery.h

tamps/src/libs/jtim/include/jqg_SpaQueryBase.h

tamps/src/libs/jtim/include/jqg_ce_proto.h

tamps/src/libs/jtim/include/jqg_ce_structs.h

tamps/src/libs/jtim/include/jqg_priv_define.h

tamps/src/libs/jtim/include/jqg_priv_proto.h

tamps/src/libs/jtim/include/jrg_ce_structs.h

tamps/src/libs/jtim/include/jrg_messages.h

tamps/src/libs/jtim/include/jrg_priv_define.h

tamps/src/libs/jtim/include/jrg_priv_proto.h

tamps/src/libs/jtim/include/jrg_priv_structs.h

tamps/src/libs/jtim/include/jrg_retrieve.h

tamps/src/libs/jtim/include/jrg_widgets.h

tamps/src/libs/jtim/include/jsg_FileMonitor.h

tamps/src/libs/jtim/include/jsg_GenerationRequest.h

tamps/src/libs/jtim/include/jsg_InternalSocket_IF.h

tamps/src/libs/jtim/include/jsg_LinkedList.h

tamps/src/libs/jtim/include/jsg_LinkedListItemBase.h

tamps/src/libs/jtim/include/jsg_LinkedListStringItem.h

tamps/src/libs/jtim/include/jsg_RequestBase.h

tamps/src/libs/jtim/include/jsg_RetrievalRequest.h

tamps/src/libs/jtim/include/jsg_detail.h

tamps/src/libs/jtim/include/jsg_priv_define.h

tamps/src/libs/jtim/include/jsg_priv_proto.h

tamps/src/libs/jtim/include/jsg_priv_structs.h

tamps/src/libs/jtim/include/jtg_priv_proto.h

tamps/src/libs/jtim/include/jtg_vwrapp.h

tamps/src/libs/jtim/include/jtg_vwrapp_misc.h

tamps/src/libs/jtim/include/jug_GeneratePerspectiveScenePixmaps.h

tamps/src/libs/jtim/include/jug_gui.h

tamps/src/libs/jtim/include/jug_pixmaps.h

tamps/src/libs/jtim/include/jug_priv_pixmaps.h

tamps/src/libs/jtim/include/jug_priv_proto.h

tamps/src/libs/jtim/include/jug_priv_structs.h

tamps/src/libs/jtim/include/jug_vwrgui.h

tamps/src/libs/jtim/include/jvg_attributes.h

tamps/src/libs/jtim/include/jvg_attributes.sh

tamps/src/libs/jtim/include/jvg_geographic_display.h

tamps/src/libs/jtim/include/jvg_geographic_display.sh

tamps/src/libs/jtim/include/jvg_geolocate.h

tamps/src/libs/jtim/include/jvg_geolocate.sh

tamps/src/libs/jtim/include/jvg_priv_proto.h

tamps/src/libs/jtim/include/jvg_refresh_display.h

tamps/src/libs/jtim/include/jvg_refresh_display.sh

tamps/src/libs/jtim/include/jvg_rotate.h

tamps/src/libs/jtim/include/jvg_rotate.sh

tamps/src/libs/jtim/include/jxg_priv_proto.h

tamps/src/libs/jtim/jeg/Makefile

tamps/src/libs/jtim/jeg/jeg_delete.c

tamps/src/libs/jtim/jeg/jeg_edit_cb.c

tamps/src/libs/jtim/jet/jet_MTFFunctions.c

tamps/src/libs/jtim/jet/jet_init.c

tamps/src/libs/jtim/jet/jet_mapFunctions.c

tamps/src/libs/jtim/jet/jet_queryFunctions.c

tamps/src/libs/jtim/jfg/Makefile

tamps/src/libs/jtim/jfg/jfg_file_cb.c

tamps/src/libs/jtim/jfg/jfg_vwrapp_file.c

tamps/src/libs/jtim/jgg/Makefile

tamps/src/libs/jtim/jgg/jgg_displayMapData.c

tamps/src/libs/jtim/jgg/jgg_graphics_cb.c

tamps/src/libs/jtim/jgg/jgg_targets.c

tamps/src/libs/jtim/jpg/Makefile

tamps/src/libs/jtim/jpg/jpg_GenerateJsipsnProduct.c

tamps/src/libs/jtim/jpg/jpg_GenerateJsipsnProduct_CB.c

tamps/src/libs/jtim/jpg/jpg_GeneratePerspectiveScene.c

tamps/src/libs/jtim/jpg/jpg_GeneratePerspectiveScene_CB.c

tamps/src/libs/jtim/jpg/jpg_chip_file.c

tamps/src/libs/jtim/jpg/jpg_products_cb.c

tamps/src/libs/jtim/jqg/Makefile

tamps/src/libs/jtim/jqg/jqg_Convert_Boundaries.c

tamps/src/libs/jtim/jqg/jqg_ErrQuerySPA.c

tamps/src/libs/jtim/jqg/jqg_ImageQuery.c

tamps/src/libs/jtim/jqg/jqg_ProductQuery.c

tamps/src/libs/jtim/jqg/jqg_QueryBase.c

tamps/src/libs/jtim/jqg/jqg_QueryResultListTAMPS.c

tamps/src/libs/jtim/jqg/jqg_QuerySPA.c

tamps/src/libs/jtim/jqg/jqg_QueryTAMPS.c

tamps/src/libs/jtim/jqg/jqg_SpaQueryBase.c

tamps/src/libs/jtim/jqg/jqg_query.c

tamps/src/libs/jtim/jqg/jqg_query_cb.c

tamps/src/libs/jtim/jrg/Makefile

tamps/src/libs/jtim/jrg/jrg_ProductStr.c

tamps/src/libs/jtim/jrg/jrg_TAMPS_Inter.c

tamps/src/libs/jtim/jrg/jrg_functions.c

tamps/src/libs/jtim/jrg/jrg_messages.c

tamps/src/libs/jtim/jrg/jrg_retrieve.c

tamps/src/libs/jtim/jrg/jrg_retrieve_cb.c

tamps/src/libs/jtim/jsg/Makefile

tamps/src/libs/jtim/jsg/jsg_Conversions.c

tamps/src/libs/jtim/jsg/jsg_CreatePGM_ProdStr.c

tamps/src/libs/jtim/jsg/jsg_DeepCopy.c

tamps/src/libs/jtim/jsg/jsg_ErrSocket.c

tamps/src/libs/jtim/jsg/jsg_FileMonitor.c

tamps/src/libs/jtim/jsg/jsg_Free.c

tamps/src/libs/jtim/jsg/jsg_GenerateProduct.c

tamps/src/libs/jtim/jsg/jsg_GenerationRequest.c

tamps/src/libs/jtim/jsg/jsg_ImageSave.c

tamps/src/libs/jtim/jsg/jsg_LinkedList.c

tamps/src/libs/jtim/jsg/jsg_LinkedListItemBase.c

tamps/src/libs/jtim/jsg/jsg_LinkedListStringItem.c

tamps/src/libs/jtim/jsg/jsg_MsgBox.c

tamps/src/libs/jtim/jsg/jsg_RequestBase.c

tamps/src/libs/jtim/jsg/jsg_RetrievalRequest.c

tamps/src/libs/jtim/jsg/jsg_RetrieveProduct.c

tamps/src/libs/jtim/jsg/jsg_TextStrings.c

tamps/src/libs/jtim/jsg/jsg_b64.c

tamps/src/libs/jtim/jsg/jsg_detail.c

tamps/src/libs/jtim/jsg/jsg_detail_cb.c

tamps/src/libs/jtim/jsg/jsg_jtim_jpeg_decompress.c

tamps/src/libs/jtim/jsg/jsg_sockets.c

tamps/src/libs/jtim/jsg/jsg_sr.c

tamps/src/libs/jtim/jtg/Makefile

tamps/src/libs/jtim/jtg/jtg_main.c

tamps/src/libs/jtim/jtg/jtg_vwrapp.c

tamps/src/libs/jtim/jtg/jtg_vwrapp_misc.c

tamps/src/libs/jtim/jug/Makefile

tamps/src/libs/jtim/jug/jug_GenerateJsipsnProduct.c

tamps/src/libs/jtim/jug/jug_GeneratePerspectiveScene.c

tamps/src/libs/jtim/jug/jug_gui.c

tamps/src/libs/jtim/jug/jug_stubs.c

tamps/src/libs/jtim/jug/jug_vwrgui.c

tamps/src/libs/jtim/jvg/Makefile

tamps/src/libs/jtim/jvg/jvg_attributes.c

tamps/src/libs/jtim/jvg/jvg_displayGeo.c

tamps/src/libs/jtim/jvg/jvg_display_utils.c

tamps/src/libs/jtim/jvg/jvg_geographic_display.c

tamps/src/libs/jtim/jvg/jvg_geolocate.c

tamps/src/libs/jtim/jvg/jvg_refresh_display.c

tamps/src/libs/jtim/jvg/jvg_rotate.c

tamps/src/libs/jtim/jvg/jvg_view_cb.c

tamps/src/libs/jtim/jxg/Makefile

tamps/src/libs/jtim/jxg/jxg_text_cb.c

tamps/src/libs/jtim/jxg/jxg_text_cb.o

===================================================================

Package: SOR-97-11B4B

Item(s)

-------

tamps/src/contrib/jtim_gots/iiviewer/include/vwrdoc.h

tamps/src/contrib/jtim_gots/iiviewer/include/vwrview.h

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.a

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.so

tamps/src/contrib/jtim_gots/matrix/include/chn_types.h

tamps/src/contrib/jtim_gots/matrix/lib/libgio.a

tamps/src/contrib/jtim_gots/matrix/lib/libgio.so

tamps/src/contrib/jtim_gots/matrix/lib/libvwr.a

tamps/src/contrib/jtim_gots/matrix/lib/libvwr.so

tamps/src/libs/jtim/include/jgg_priv_proto.h

tamps/src/libs/jtim/include/jpg_priv_proto.h

tamps/src/libs/jtim/include/jpg_priv_structs.h

tamps/src/libs/jtim/include/jrg_priv_proto.h

tamps/src/libs/jtim/include/jrg_priv_structs.h

tamps/src/libs/jtim/include/jrg_retrieve.h

tamps/src/libs/jtim/include/jrg_widgets.h

tamps/src/libs/jtim/include/jsg_priv_define.h

tamps/src/libs/jtim/include/jsg_priv_proto.h

tamps/src/libs/jtim/include/jug_priv_proto.h

tamps/src/libs/jtim/include/jug_priv_structs.h

tamps/src/libs/jtim/jeg/Makefile

tamps/src/libs/jtim/jeg/jeg_editGraphics.c

tamps/src/libs/jtim/jeg/jeg_edit_cb.c

tamps/src/libs/jtim/jfg/jfg_file_cb.c

tamps/src/libs/jtim/jfg/jfg_vwrapp_file.c

tamps/src/libs/jtim/jgg/Makefile

tamps/src/libs/jtim/jgg/jgg_displayMapData.c

tamps/src/libs/jtim/jgg/jgg_displayNorthArrow.c

tamps/src/libs/jtim/jgg/jgg_graphics_cb.c

tamps/src/libs/jtim/jpg/Makefile

tamps/src/libs/jtim/jpg/jpg_CalculatePerspectiveScene.c

tamps/src/libs/jtim/jpg/jpg_CancelRequest.c

tamps/src/libs/jtim/jpg/jpg_GenerateJsipsnProduct.c

tamps/src/libs/jtim/jpg/jpg_GenerateJsipsnProduct_CB.c

tamps/src/libs/jtim/jpg/jpg_GeneratePerspectiveScene.c

tamps/src/libs/jtim/jpg/jpg_GeneratePerspectiveScene_CB.c

tamps/src/libs/jtim/jpg/jpg_chip_file.c

tamps/src/libs/jtim/jpg/jpg_products_cb.c

tamps/src/libs/jtim/jqg/jqg_query.c

tamps/src/libs/jtim/jqg/jqg_query_cb.c

tamps/src/libs/jtim/jrg/jrg_ProductStr.c

tamps/src/libs/jtim/jrg/jrg_TAMPS_Inter.c

tamps/src/libs/jtim/jrg/jrg_functions.c

tamps/src/libs/jtim/jrg/jrg_messages.c

tamps/src/libs/jtim/jrg/jrg_retrieve.c

tamps/src/libs/jtim/jrg/jrg_retrieve_cb.c

tamps/src/libs/jtim/jsg/jsg_MsgBox.c

tamps/src/libs/jtim/jsg/jsg_TextStrings.c

tamps/src/libs/jtim/jsg/jsg_detail.c

tamps/src/libs/jtim/jsg/jsg_detail_cb.c

tamps/src/libs/jtim/jtg/jtg_vwrapp.c

tamps/src/libs/jtim/jug/jug_GenerateJsipsnProduct.c

tamps/src/libs/jtim/jug/jug_GeneratePerspectiveScene.c

tamps/src/libs/jtim/jug/jug_gui.c

tamps/src/libs/jtim/jug/jug_vwrgui.c

tamps/src/libs/jtim/jvg/jvg_attributes.c

tamps/src/libs/jtim/jvg/jvg_displayGeo.c

tamps/src/libs/jtim/jvg/jvg_geolocate.c

tamps/src/libs/jtim/jvg/jvg_view_cb.c

===================================================================

Package: SOR-97-11B4C

Item(s)

-------

tamps/env/tamps.env.dev

tamps/src/apps/Makefile

tamps/src/apps/jtim/Makefile

tamps/src/apps/jtim/jpg/Makefile

tamps/src/apps/jtim/jpg/jpg_MPM_Monitor.c

tamps/src/contrib/jtim_gots/iiviewer/include/vwrdoc.h

tamps/src/contrib/jtim_gots/iiviewer/include/vwrview.h

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.a

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.so

tamps/src/contrib/jtim_gots/matrix/include/gio/giocol_types.h

tamps/src/contrib/jtim_gots/matrix/include/gio/giolst.h

tamps/src/contrib/jtim_gots/matrix/include/gio/gioobj.h

tamps/src/contrib/jtim_gots/matrix/include/vwr/vwrmgr.h

tamps/src/contrib/jtim_gots/matrix/lib/libXg.so

tamps/src/contrib/jtim_gots/matrix/lib/libXs.so

tamps/src/contrib/jtim_gots/matrix/lib/libaridpcm.so

tamps/src/contrib/jtim_gots/matrix/lib/libcgm.so

tamps/src/contrib/jtim_gots/matrix/lib/libcmt.so

tamps/src/contrib/jtim_gots/matrix/lib/libcopy.so

tamps/src/contrib/jtim_gots/matrix/lib/libdsp.a

tamps/src/contrib/jtim_gots/matrix/lib/libdsp.so

tamps/src/contrib/jtim_gots/matrix/lib/libelib.so

tamps/src/contrib/jtim_gots/matrix/lib/libenh.so

tamps/src/contrib/jtim_gots/matrix/lib/libgio.a

tamps/src/contrib/jtim_gots/matrix/lib/libgio.so

tamps/src/contrib/jtim_gots/matrix/lib/libimg.so

tamps/src/contrib/jtim_gots/matrix/lib/libimg_nomet.so

tamps/src/contrib/jtim_gots/matrix/lib/libmath.so

tamps/src/contrib/jtim_gots/matrix/lib/libmcom.so

tamps/src/contrib/jtim_gots/matrix/lib/libvwr.a

tamps/src/contrib/jtim_gots/matrix/lib/libvwr.so

tamps/src/contrib/jtim_gots/matrix/lib/libyrd.so

tamps/src/data/environment/tamps.env

tamps/src/libs/jtim/include/Makefile

tamps/src/libs/jtim/include/jeg_priv_proto.h

tamps/src/libs/jtim/include/jgg_priv_proto.h

tamps/src/libs/jtim/include/jpg_priv_proto.h

tamps/src/libs/jtim/include/jpg_priv_structs.h

tamps/src/libs/jtim/include/jqg_priv_proto.h

tamps/src/libs/jtim/include/jsg_FileMonitor.h

tamps/src/libs/jtim/include/jsg_priv_define.h

tamps/src/libs/jtim/include/jsg_priv_proto.h

tamps/src/libs/jtim/include/jtg_priv_proto.h

tamps/src/libs/jtim/include/jug_priv_proto.h

tamps/src/libs/jtim/include/jug_priv_structs.h

tamps/src/libs/jtim/include/jvg_priv_proto.h

tamps/src/libs/jtim/jeg/jeg_editGraphics.c

tamps/src/libs/jtim/jeg/jeg_edit_cb.c

tamps/src/libs/jtim/jfg/jfg_vwrapp_file.c

tamps/src/libs/jtim/jgg/jgg_displayMapData.c

tamps/src/libs/jtim/jgg/jgg_displayNorthArrow.c

tamps/src/libs/jtim/jgg/jgg_graphics_cb.c

tamps/src/libs/jtim/jpg/jpg_CalculatePerspectiveScene.c

tamps/src/libs/jtim/jpg/jpg_GeneratePerspectiveScene.c

tamps/src/libs/jtim/jpg/jpg_chip_file.c

tamps/src/libs/jtim/jpg/jpg_products_cb.c

tamps/src/libs/jtim/jqg/jqg_SpaQueryBase.c

tamps/src/libs/jtim/jqg/jqg_query.c

tamps/src/libs/jtim/jqg/jqg_query_cb.c

tamps/src/libs/jtim/jsg/jsg_FileMonitor.c

tamps/src/libs/jtim/jsg/jsg_RequestBase.c

tamps/src/libs/jtim/jsg/jsg_TextStrings.c

tamps/src/libs/jtim/jsg/jsg_detail_cb.c

tamps/src/libs/jtim/jtg/Makefile

tamps/src/libs/jtim/jtg/jtg_psUpdateFxn.c

tamps/src/libs/jtim/jtg/jtg_vwrapp.c

tamps/src/libs/jtim/jtg/jtg_vwrapp_misc.c

tamps/src/libs/jtim/jug/jug_gui.c

tamps/src/libs/jtim/jug/jug_vwrgui.c

tamps/src/libs/jtim/jvg/jvg_attributes.c

tamps/src/libs/jtim/jvg/jvg_display_utils.c

tamps/src/libs/jtim/jvg/jvg_geolocate.c

tamps/src/libs/jtim/jvg/jvg_rotate.c

tamps/src/libs/jtim/jvg/jvg_view_cb.c

tamps/src/libs/jtim/jxg/jxg_text_cb.c

===================================================================

Package: SOR-97-11B4D

Item(s)

-------

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.a

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.so

tamps/src/contrib/jtim_gots/jpeg/include/jerror.h

tamps/src/contrib/jtim_gots/matrix/lib/libdsp.a

tamps/src/contrib/jtim_gots/matrix/lib/libdsp.so

tamps/src/contrib/jtim_gots/matrix/lib/libgio.a

tamps/src/contrib/jtim_gots/matrix/lib/libgio.so

tamps/src/contrib/jtim_gots/matrix/lib/libvwr.a

tamps/src/contrib/jtim_gots/matrix/lib/libvwr.so

tamps/src/libs/jtim/include/jgg_priv_proto.h

tamps/src/libs/jtim/include/jpg_priv_proto.h

tamps/src/libs/jtim/include/jrg_priv_proto.h

tamps/src/libs/jtim/include/jrg_widgets.h

tamps/src/libs/jtim/include/jsg_priv_define.h

tamps/src/libs/jtim/include/jsg_priv_proto.h

tamps/src/libs/jtim/include/jug_priv_proto.h

tamps/src/libs/jtim/jfg/jfg_vwrapp_file.c

tamps/src/libs/jtim/jgg/Makefile

tamps/src/libs/jtim/jgg/jgg_displayGraphics.c

tamps/src/libs/jtim/jgg/jgg_displayNorthArrow.c

tamps/src/libs/jtim/jgg/jgg_graphics_cb.c

tamps/src/libs/jtim/jpg/jpg_CalculatePerspectiveScene.c

tamps/src/libs/jtim/jpg/jpg_CancelRequest.c

tamps/src/libs/jtim/jpg/jpg_GenerateJsipsnProduct.c

tamps/src/libs/jtim/jpg/jpg_GenerateJsipsnProduct_CB.c

tamps/src/libs/jtim/jpg/jpg_GeneratePerspectiveScene.c

tamps/src/libs/jtim/jqg/jqg_ImageQuery.c

tamps/src/libs/jtim/jqg/jqg_ProductQuery.c

tamps/src/libs/jtim/jqg/jqg_QueryBase.c

tamps/src/libs/jtim/jqg/jqg_query_cb.c

tamps/src/libs/jtim/jrg/jrg_TAMPS_Inter.c

tamps/src/libs/jtim/jrg/jrg_functions.c

tamps/src/libs/jtim/jrg/jrg_messages.c

tamps/src/libs/jtim/jrg/jrg_retrieve_cb.c

tamps/src/libs/jtim/jsg/jsg_GenerationRequest.c

tamps/src/libs/jtim/jsg/jsg_ImageSave.c

tamps/src/libs/jtim/jsg/jsg_RequestBase.c

tamps/src/libs/jtim/jsg/jsg_RetrievalRequest.c

tamps/src/libs/jtim/jsg/jsg_sr.c

tamps/src/libs/jtim/jug/jug_GenerateJsipsnProduct.c

tamps/src/libs/jtim/jug/jug_gui.c

tamps/src/libs/jtim/jug/jug_vwrgui.c

tamps/src/libs/jtim/jvg/jvg_geolocate.c

tamps/src/libs/jtim/jvg/jvg_rotate.c

tamps/src/libs/jtim/jvg/jvg_view_cb.c

===================================================================

Package: SOR-97-12

Item(s)

-------

tamps/CLASSIFIED/src/libs/gpskey/gkt/gkt_algorithm.C

tamps/include/gpskey/gat_struct.h

tamps/include/gpskey/gkt_gpsMasterKey.H

tamps/include/gpskey/gst_clientAccess.h

tamps/include_prot/gpskey/gat_prot_proto.h

tamps/src/apps/gpskey/gst/gst_clientDBA_error.C

tamps/src/apps/gpskey/gst/gst_clientDBA_manEntry.C

tamps/src/apps/gpskey/gst/gst_gpsKeyMgr.C

tamps/src/apps/gpskey/gst/gst_keyValue_text_field.C

tamps/src/apps/gpskey/gst/gst_requestMgr.C

tamps/src/apps/gpskey/include/gst_audit_events.h

tamps/src/apps/gpskey/include/gst_clientDBA_manEntry.H

tamps/src/apps/gpskey/include/gst_gpsKeyMgr.H

tamps/src/data/defaults/gpsCryptoKey

tamps/src/libs/gpskey/gat/gat_audit_api.c

tamps/src/libs/gpskey/gkt/Makefile

tamps/src/libs/gpskey/gkt/gkt_gpsKey.C

tamps/src/libs/gpskey/gkt/gkt_gpsMasterKey.C

===================================================================

Package: SOR-97-13

Item(s)

-------

tamps/config/projpath

tamps/include/a_msn_plan/apt_route.h

tamps/include/help/thc_defines.h

tamps/include/system/sit_default_defines.h

tamps/include_prot/a_msn_plan/apl_prot_proto.h

tamps/include_prot/dbase/dml_prot_proto.h

tamps/include_prot/util/uul_prot_proto.h

tamps/src/apps/dbase/dml/Makefile

tamps/src/apps/dbase/dml/dml_catmain.c

tamps/src/apps/lan/lcl/Makefile

tamps/src/apps/lan/lcl/lcl_connectUsers.c

tamps/src/apps/lan/lcl/make_lcl_connectUsers

tamps/src/dbinstall/sprocs/insert_generic_mission_sp.sql

tamps/src/dbinstall/sprocs/insert_mission_sp.sql

tamps/src/dbinstall/sprocs/tamps_temp_cat.sql

tamps/src/dbinstall/tampsdb/create/mission/tamps_mission_plan_create.sql

tamps/src/libs/a_msn_plan/Makefile

tamps/src/libs/a_msn_plan/adt/adt_genretr.c

tamps/src/libs/a_msn_plan/adt/adt_gensave.c

tamps/src/libs/a_msn_plan/adt/adt_msn.c

tamps/src/libs/a_msn_plan/ait/ait_msnDefaultCB.c

tamps/src/libs/a_msn_plan/ait/ait_msnNewCB.c

tamps/src/libs/a_msn_plan/ait/ait_msnOpenCB.c

tamps/src/libs/a_msn_plan/ait/ait_msnProtectCB.c

tamps/src/libs/a_msn_plan/apl/Makefile

tamps/src/libs/a_msn_plan/apl/apl_pfps_callbacks.c

tamps/src/libs/a_msn_plan/apl/apl_pfps_creation.c

tamps/src/libs/a_msn_plan/apl/apl_pfps_misc.c

tamps/src/libs/a_msn_plan/include/ait_priv_proto.h

tamps/src/libs/a_msn_plan/include/apl_defines.h

tamps/src/libs/a_msn_plan/include/apl_pfps_class.h

tamps/src/libs/a_msn_plan/include/apl_priv_proto.h

tamps/src/libs/a_msn_plan/include/apl_struct.h

tamps/src/libs/b_msn_tools/bmt/bmt_import.c

tamps/src/libs/b_msn_tools/bmt/bmt_importsp.c

tamps/src/libs/dbase/dlt/dlt_loadMMI.c

tamps/src/libs/dbase/dlt/dlt_mission.c

tamps/src/libs/dbase/dml/dml_dataXfer.c

tamps/src/libs/dbase/dut/dut_dump_restore.c

tamps/src/libs/system/sit/sit_defaultMenu.c

tamps/src/libs/tms/tet/Makefile

tamps/src/libs/util/uul/uul_utils.c

tamps/src/libs/wse/wmt/wmt_roles.c

tamps/src/scripts/lan/lcl/lcl_preConnection.sh

A.3
STRs in this Release

STRs in release TAMPS 6.2 dated, 11 March 1998.

===================================================================

STR:   3660

Title: ADRI Load Function Causes DBA To Crash

Description:

After performing an ADRI load, no other function can access the tape device that was used to load ADRI until the DBA in which the ADRI was loaded is exited.  When attempting to rewind a tape through an XTerm, the system reports the tape device as busy.

By holding on to the 8mm tape drive, the ADRI load function can cause other DBAs to crash if they attempt to use the tape drive, particularly if the original DBA crashes first.  To clear the problem, the user must log completely off the system then back on.

The LANDSAT and/or NITF load functions also hold onto the tape drive until the DBA is exited.  This STR effectively closes T-2032.

Recommend OTRR List

Items:

------

===================================================================

STR:   4612

Title:

Description:

Items:

------

tamps/src/libs/a_msn_plan/ait/ait_CreateFilterDialog.c

tamps/src/libs/a_msn_plan/ait/ait_LaunchFilterCB.c

tamps/src/libs/a_msn_plan/ait/ait_LaunchUtils.c

tamps/src/libs/a_msn_plan/include/ait_launch.h

tamps/src/libs/a_msn_plan/include/ait_structs.h

===================================================================

STR:   5952

Title: GPS Key, No Auto Purge

Description:

The GPS keys are not being automatically purged upon expiration. They should be deleted within a day after expiration. Workaround is for DBA to manually delete expired one every week.

Items:

------

tamps/src/libs/gpskey/gkt/gkt_gpsMasterKey.C

===================================================================

STR:   6190

Title: Gst Server Crash When Loading Multiple Keys

Description:

It appears that attempting to load more than three keys from the CYZ-10 to a TAMPS system at one time causes the gst_server to crash.  Selected 4 keys for transfer from the CYZ-10 to the SLAM DTC-2 and selected 2send3.  After about 20 seconds, an error message was displayed on the DTC, saying 2unable to communicate with server3.  Using a shell, found out that the gst_server was not running.  Restarted the server and tried again with the same result.  Tried loading one key, and the transfer was successful.  Tried loading 3 keys, and the transfer was sucessful.  If this happens, the DBA will be forced to reboot the system to get the server running again.  This was duplicated on the test DTC-2.

This STR may be related to STR 6139.

Items:

------

tamps/include/gpskey/gdt_dtd_io.H

tamps/src/libs/gpskey/gdt/gdt_ds101_frame.C

tamps/src/libs/gpskey/gdt/gdt_dtd_io.C

tamps/src/libs/gpskey/gdt_priv_proto.h

tamps/src/libs/gpskey/include/gdt_priv_proto.h

===================================================================

STR:   6212

Title: GPS Navigation File  (CORE)

Description:

Duplicate processing lists should have labels so that user understands the purpose of the lists.  Left list = Workspace  Right List = Selection Priority.

User doesn5t understand that he is designating a priority.

First four list items are OK, then Military Airbases, Civilain Airbases, and Joint Airbases.

Do away with Hi/Lo option.  Options available will be High or Low.  Hi/Lo will be included in both High and Low options.

Items:

------

tamps/src/libs/b_msn_tools/bgt/bgt_dupcfg.c

tamps/src/libs/b_msn_tools/bgt/bgt_dupman.c

===================================================================

STR:   6213

Title: Object Hierarchy - Symbols  (CORE)

Description:

Generic queries needto use symbols on stickies used now (SAM, RADAR, BOMBER, FIGHTER).

Items:

------

tamps/CLASSIFIED/src/dbinstall/load/data/OH_GRAPHIC.BCP

tamps/src/data/maps/symbols/chart_pack_helo

tamps/src/data/maps/symbols/make_data

===================================================================

STR:   6214

Title: Launch Details Dialog  (CORE)

Description:

Default  time entry.  FUIWG likes the way that time is entered in the Launch details dialog box.  FUIWG wants ALL of the time entries in the system switched to act this way.

Remove Apply button in Launch Details dialog.

2OK3 Button is default button.

Case-by-case review of Apply buttons throughout system to ensure that they are only used on dialogs that require application of a selection without closing the dialog.

Items:

------

===================================================================

STR:   6215

Title: Radar Prediction Dialog  (CORE)

Description:

Close dialog during a get location.

Get rid of vertical scroll bar.

Set feature setting defaults to None.

Radar Display buttons should be Save, Close, Help

Use description as default name.

Items:

------

tamps/src/libs/b_msn_tools/brt/brt_createF18Dialog.c

tamps/src/libs/b_msn_tools/brt/brt_createListDialog.c

tamps/src/libs/b_msn_tools/brt/brt_createRadarDisplay.c

===================================================================

STR:   6216

Title: GEO Window  (CORE)

Description:

Use finger and hide window.

Allow planner to save GEO (DBA only now).

Redesign window to not have subwindows and submenus.

Items:

------

===================================================================

STR:   6217

Title: Annotation Tool  (CORE)

Description:

Remove slider bar from symbol parameter dialog.

Default button is Apply.

Items:

------

===================================================================

STR:   6218

Title: NITF Imagery not displayed properly

Description:

NITF Imagery does not display as a map background, even if the NITF header contains corner coordinates.  This was tested with real imagery from the JMCIS Digital Product Server, both loaded from tape and retrieved across the LAN.  Seems like we are not pulling the lat/longs out of the NITF header properly.

Items:

------

===================================================================

STR:   6249

Title: F18 Recce Integration

Description:

ICN 087 remove the following files that F/A-18 mpm require to support F/A-18 RECCE.

aet_GetLastActionPoint

aet_PropagateActionPoint

aet_ApplyActionPoint

aet_DeleteActionPoint

aet_InsertActionPoint

F/A-18 MPM requires that these functionality be either fixed or substituted in the TAMPS 6.1 IDD

Items:

------

tamps/include/a_msn_plan/aft_event_defs.h

tamps/include/a_msn_plan/axt_defines.h

tamps/include/a_msn_plan/axt_enum.h

tamps/include/a_msn_plan/axt_proto.h

tamps/src/libs/a_msn_plan/adt/adt_fltevnt.c

tamps/src/libs/a_msn_plan/aft/aft_FlightUtils.c

tamps/src/libs/a_msn_plan/axt/Makefile

tamps/src/libs/a_msn_plan/axt/axt_copyHandle.c

tamps/src/libs/a_msn_plan/axt/axt_createHandle.c

tamps/src/libs/a_msn_plan/axt/axt_deleteHandle.c

tamps/src/libs/a_msn_plan/axt/axt_handle.c

tamps/src/libs/a_msn_plan/axt/axt_insert.c

tamps/src/libs/a_msn_plan/axt/axt_update.c

tamps/src/libs/a_msn_plan/axt/axt_utils.c

tamps/src/libs/a_msn_plan/include/axt_handle_defines.h

tamps/src/libs/b_msn_tools/bat/bat_api_funcs.c

===================================================================

STR:   6307

Title: Error in MGRS transformation from WGS-84 to NAD-27

Description:

There is an error in the transformation of MGRS coordinates from the

WGS-84 datum to the NAD-27 datum.

MGRS/LAT/LON Rounding Problems:

When converting from Lat/Lon to MGRS and back to Lat/Lon using the

DD:MM:SS.SS or DD:MM:SS.S Lat/Lon format strings, TAMPS CORE induces a rounding

problem.  This occurs in the MGRS conversion function since the northing and

easting components are accurate to only 1 meter.

Items:

------

===================================================================

STR:   6316

Title: F14D GPSMDL Not loading

Description:

Created a loadset containing JTIDS, Flight Plans, Almanac, Revers, and Tactical Waypt data in F14D on the ACE. Selected Apply and after retrieving the data sets, message window comes up Error erasing cartridge. This cartridge had just been declassified and erased in previous test steps. I tried with another cartridge without erasing and got same error message. When checked MDL using mdlvt, some of the data loaded OK and some gave checksum errors and some not there, using tool (Waypoint Data blank). Planner thinks load fails. Opened new MPM and created new load and downloaded OK, except checksum errors on Almanac. Sometimes works sometimes not. This is a critical failure. SOT 95-02

Items:

------

===================================================================

STR:   6317

Title: Corrupted MDL Loadsets

Description:

Opened a saved mission and created a loadset in F14D containing Flight Plan, Almanac,

Reversionary, and Tactical Waypoint files. Saved As the loadset, then retrieved and all data

looked OK. Added a JTIDS file and did a Save. Retrieved loadset again and JTIDS and

Reversionary  buttons not highlighted. This is a loss of data and is a mission critical failure.

SOT 95-02

Items:

------

tamps/mpm/f14/src/f14gt/f14gt_d_JTIDS_MMI.C

tamps/src/libs/b_msn_tools/bdt/bdt_Almanac_c.C

tamps/src/libs/b_msn_tools/bdt/bdt_RevFile_Cb.C

tamps/src/libs/b_msn_tools/bdt/bdt_Reversionary_c.C

tamps/src/libs/b_msn_tools/bdt/bdt_api_funcs.C

tamps/src/libs/b_msn_tools/bdt/bdt_db_funcs.C

tamps/src/libs/b_msn_tools/bdt/bdt_error.C

tamps/src/libs/b_msn_tools/include/bdt_priv_defines.H

===================================================================

STR:   6323

Title: JMCIS Grid Messaged did not Pull into TAMPS

Description:

Could access the Grid catalog data OK but when selected messages to pull across into TAMPS got lots of alerts in comms processor and no grid data in db to display. HWDs worked OK. STR check.

Items:

------

tamps/include_prot/dbase/dmt_default_defines.h

tamps/src/apps/comms/cnl_DIRscan/cnl_DIRscan_MSGDB.csh

tamps/src/apps/comms/cnl_DIRscan/cnl_grid/cnl_grid.c

tamps/src/apps/comms/cnl_DIRscan/cnl_ovly2/cnl_ovly2.c

tamps/src/apps/lan/lnl/Makefile

tamps/src/apps/lan/lnl/lnl_TampsNTFR.c

tamps/src/contrib/Makefile

tamps/src/contrib/jmcis_gots/Makefile

tamps/src/contrib/jmcis_gots/profiler/Makefile

tamps/src/contrib/jmcis_gots/profiler/include/APMTD_merge.h

tamps/src/contrib/jmcis_gots/profiler/include/AccessHostsDatabase.h

tamps/src/contrib/jmcis_gots/profiler/include/AllocUtilities.h

tamps/src/contrib/jmcis_gots/profiler/include/AmhsAuditLib.h

tamps/src/contrib/jmcis_gots/profiler/include/AmhsCommsUtils.h

tamps/src/contrib/jmcis_gots/profiler/include/AmhsMonitor.h

tamps/src/contrib/jmcis_gots/profiler/include/AmhsRouteUtils.h

tamps/src/contrib/jmcis_gots/profiler/include/AmhsServerConst.h

tamps/src/contrib/jmcis_gots/profiler/include/AmhsUcpUtils.h

tamps/src/contrib/jmcis_gots/profiler/include/AmhsUtils.h

tamps/src/contrib/jmcis_gots/profiler/include/ArrayUtilities.h

tamps/src/contrib/jmcis_gots/profiler/include/ArrowButtonSelectionWidget.h

tamps/src/contrib/jmcis_gots/profiler/include/ArrowButtonSelectionWidgetP.h

tamps/src/contrib/jmcis_gots/profiler/include/AsciiTo.h

tamps/src/contrib/jmcis_gots/profiler/include/AskUser.h

tamps/src/contrib/jmcis_gots/profiler/include/BoxEditArea.h

tamps/src/contrib/jmcis_gots/profiler/include/BoxEditArea_p.h

tamps/src/contrib/jmcis_gots/profiler/include/ButtonBox.h

tamps/src/contrib/jmcis_gots/profiler/include/CCchopChain.h

tamps/src/contrib/jmcis_gots/profiler/include/CCchopMaint.h

tamps/src/contrib/jmcis_gots/profiler/include/CCchopMessage.h

tamps/src/contrib/jmcis_gots/profiler/include/CCnotePad.h

tamps/src/contrib/jmcis_gots/profiler/include/CCoptionSelect.h

tamps/src/contrib/jmcis_gots/profiler/include/CCrelAuth.h

tamps/src/contrib/jmcis_gots/profiler/include/CCuserChop.h

tamps/src/contrib/jmcis_gots/profiler/include/CGIFormat.h

tamps/src/contrib/jmcis_gots/profiler/include/CPkeys.h

tamps/src/contrib/jmcis_gots/profiler/include/CTA_Assoc.h

tamps/src/contrib/jmcis_gots/profiler/include/CTA_AssocTypes.h

tamps/src/contrib/jmcis_gots/profiler/include/CTA_AttribTypes.h

tamps/src/contrib/jmcis_gots/profiler/include/CTA_CandidateTypes.h

tamps/src/contrib/jmcis_gots/profiler/include/CTA_ElintTypes.h

tamps/src/contrib/jmcis_gots/profiler/include/CTA_EntityTypes.h

tamps/src/contrib/jmcis_gots/profiler/include/CTA_GeoTypes.h

tamps/src/contrib/jmcis_gots/profiler/include/CTA_Lib.h

tamps/src/contrib/jmcis_gots/profiler/include/CTA_Tdbm.h
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tamps/src/contrib/jmcis_gots/profiler/include/ps_state.h

tamps/src/contrib/jmcis_gots/profiler/include/ps_user.h

tamps/src/contrib/jmcis_gots/profiler/include/purge.h

tamps/src/contrib/jmcis_gots/profiler/include/qrf_lib.h

tamps/src/contrib/jmcis_gots/profiler/include/qrflib_const.h

tamps/src/contrib/jmcis_gots/profiler/include/qrflib_enum.h

tamps/src/contrib/jmcis_gots/profiler/include/qrflib_types.h

tamps/src/contrib/jmcis_gots/profiler/include/qry_init.h

tamps/src/contrib/jmcis_gots/profiler/include/queryP.h

tamps/src/contrib/jmcis_gots/profiler/include/qusmsgs.h

tamps/src/contrib/jmcis_gots/profiler/include/radius_typeP.h

tamps/src/contrib/jmcis_gots/profiler/include/rans.h

tamps/src/contrib/jmcis_gots/profiler/include/releasability.h

tamps/src/contrib/jmcis_gots/profiler/include/releasability_widget_names.h

tamps/src/contrib/jmcis_gots/profiler/include/release_msg.h

tamps/src/contrib/jmcis_gots/profiler/include/remove_files.h

tamps/src/contrib/jmcis_gots/profiler/include/retrieve_database_names.h

tamps/src/contrib/jmcis_gots/profiler/include/retrieve_db_info.h

tamps/src/contrib/jmcis_gots/profiler/include/retrieve_tape_device.h

tamps/src/contrib/jmcis_gots/profiler/include/rri_profiling.h

tamps/src/contrib/jmcis_gots/profiler/include/rss.h

tamps/src/contrib/jmcis_gots/profiler/include/rules.h

tamps/src/contrib/jmcis_gots/profiler/include/sci_class.h

tamps/src/contrib/jmcis_gots/profiler/include/scrolled_rc_ui.h

tamps/src/contrib/jmcis_gots/profiler/include/search.h

tamps/src/contrib/jmcis_gots/profiler/include/sectionalize_msg.h

tamps/src/contrib/jmcis_gots/profiler/include/setport.h

tamps/src/contrib/jmcis_gots/profiler/include/setup_clean_msgdb.h

tamps/src/contrib/jmcis_gots/profiler/include/setup_clean_msgdb_const.h

tamps/src/contrib/jmcis_gots/profiler/include/setup_msgdb_defs.h

tamps/src/contrib/jmcis_gots/profiler/include/shmovl.h

tamps/src/contrib/jmcis_gots/profiler/include/singocc.h

tamps/src/contrib/jmcis_gots/profiler/include/sort.h

tamps/src/contrib/jmcis_gots/profiler/include/sortList.h

tamps/src/contrib/jmcis_gots/profiler/include/sort_lib.h

tamps/src/contrib/jmcis_gots/profiler/include/soundex.h

tamps/src/contrib/jmcis_gots/profiler/include/spec_rep_query.h

tamps/src/contrib/jmcis_gots/profiler/include/special_decl.h

tamps/src/contrib/jmcis_gots/profiler/include/specific_reports.h

tamps/src/contrib/jmcis_gots/profiler/include/specific_reports_const.h

tamps/src/contrib/jmcis_gots/profiler/include/specific_reports_data.h

tamps/src/contrib/jmcis_gots/profiler/include/specific_reports_types.h

tamps/src/contrib/jmcis_gots/profiler/include/sso_ui.h

tamps/src/contrib/jmcis_gots/profiler/include/st_sysdefs.h

tamps/src/contrib/jmcis_gots/profiler/include/statmsgs.h

tamps/src/contrib/jmcis_gots/profiler/include/str_comp.h

tamps/src/contrib/jmcis_gots/profiler/include/str_tolower.h

tamps/src/contrib/jmcis_gots/profiler/include/str_toupper.h

tamps/src/contrib/jmcis_gots/profiler/include/strip_blanks.h

tamps/src/contrib/jmcis_gots/profiler/include/sunraster.h

tamps/src/contrib/jmcis_gots/profiler/include/sybase_err.h

tamps/src/contrib/jmcis_gots/profiler/include/sybinit.h

tamps/src/contrib/jmcis_gots/profiler/include/sybpl.h

tamps/src/contrib/jmcis_gots/profiler/include/tcp_lib.h

tamps/src/contrib/jmcis_gots/profiler/include/tcq_ui_const.h

tamps/src/contrib/jmcis_gots/profiler/include/tcq_ui_priority.h

tamps/src/contrib/jmcis_gots/profiler/include/tcq_ui_types.h

tamps/src/contrib/jmcis_gots/profiler/include/tcq_ui_widget_names.h

tamps/src/contrib/jmcis_gots/profiler/include/text_ov_const.h

tamps/src/contrib/jmcis_gots/profiler/include/text_ov_lut.h

tamps/src/contrib/jmcis_gots/profiler/include/text_ov_proto.h

tamps/src/contrib/jmcis_gots/profiler/include/text_ov_types.h

tamps/src/contrib/jmcis_gots/profiler/include/text_overview.h

tamps/src/contrib/jmcis_gots/profiler/include/text_srch_eng.h

tamps/src/contrib/jmcis_gots/profiler/include/tor_cutoff.h

tamps/src/contrib/jmcis_gots/profiler/include/tpmh.h

tamps/src/contrib/jmcis_gots/profiler/include/translations.h

tamps/src/contrib/jmcis_gots/profiler/include/trklintab.h

tamps/src/contrib/jmcis_gots/profiler/include/trkmiplintab.h

tamps/src/contrib/jmcis_gots/profiler/include/trkmipvar.h

tamps/src/contrib/jmcis_gots/profiler/include/ui_dtg.h

tamps/src/contrib/jmcis_gots/profiler/include/ui_option.h

tamps/src/contrib/jmcis_gots/profiler/include/ui_prof_analyst.h

tamps/src/contrib/jmcis_gots/profiler/include/ui_prof_dtg.h

tamps/src/contrib/jmcis_gots/profiler/include/ui_pulldown_option.h

tamps/src/contrib/jmcis_gots/profiler/include/updt_cidb.h

tamps/src/contrib/jmcis_gots/profiler/include/usesaveq.h

tamps/src/contrib/jmcis_gots/profiler/include/viewaoi.h

tamps/src/contrib/jmcis_gots/profiler/include/warnmsgs.h

tamps/src/contrib/jmcis_gots/profiler/include/watchdog.h

tamps/src/contrib/jmcis_gots/profiler/include/write_files.h

tamps/src/contrib/jmcis_gots/profiler/include/xli_copyright.h

tamps/src/contrib/jmcis_gots/profiler/include/xloadimage.h

tamps/src/contrib/jmcis_gots/profiler/include/xwd.h

tamps/src/contrib/jmcis_gots/profiler/include/y.tab.h

tamps/src/contrib/jmcis_gots/profiler/lib/libmhs.a

tamps/src/contrib/jmcis_gots/profiler/lib/libnconfig.a

tamps/src/contrib/jmcis_gots/profiler/lib/libnemail.a

tamps/src/contrib/jmcis_gots/profiler/lib/libnff.a

tamps/src/contrib/jmcis_gots/profiler/lib/libnmhs.a

tamps/src/contrib/jmcis_gots/profiler/lib/libnprofui.a

tamps/src/contrib/jmcis_gots/profiler/lib/libnunix.a

tamps/src/contrib/jmcis_gots/profiler/lib/libpl.a

tamps/src/dbinstall/dwl/delete_old_grids.sql

tamps/src/dbinstall/dwl/delete_old_hwds.sql

tamps/src/dbinstall/dwl/grid_mmi.sql

tamps/src/dbinstall/dwl/load_procedures.macro

tamps/src/dbinstall/dwl/make_sql

tamps/src/dbinstall/tampsdb/create/oparea/tamps_op_area_create.sql

tamps/src/dbinstall/tampsdb/create/oparea/tamps_world_op_area.bcp

tamps/src/libs/dbase/dml/Makefile

tamps/src/libs/dbase/dml/dml_xferHighWeather.c

tamps/src/libs/dbase/dmt/dmt_menu.c

tamps/src/libs/dbase/dwl/Makefile

tamps/src/libs/dbase/dwl/dwl_dbase_weather_admin.c

tamps/src/libs/dbase/dzt/dzt_oparea.c

tamps/src/libs/dbase/include/dml_defines.h

tamps/src/libs/dbase/include/dml_priv_proto.h

tamps/src/libs/dbase/include/dwl_priv_proto.h

tamps/src/libs/maps/include/mwl_priv_proto.h

tamps/src/libs/maps/mwl/Makefile

tamps/src/libs/maps/mwl/mwl_BuildCatalog.c

tamps/src/libs/maps/mwl/mwl_CheckOpAreas.c

tamps/src/libs/maps/mwl/mwl_DataExists.c

tamps/src/libs/maps/mwl/mwl_DeleteData.c

tamps/src/libs/maps/mwl/mwl_DeleteOldData.c

tamps/src/libs/maps/mwl/mwl_DisplayData.c

tamps/src/libs/maps/mwl/mwl_GetOpAreaLocation.c

tamps/src/libs/maps/mwl/mwl_HWDOps.c

tamps/src/libs/maps/mwl/mwl_MPMSelection.c

tamps/src/libs/maps/mwl/mwl_RetrvGrid.c

tamps/src/libs/maps/mwl/mwl_RetrvHWD.c

tamps/src/libs/maps/mwl/mwl_StoreGrid.c

tamps/src/scripts/dbase/bin/make_scripts

tamps/src/scripts/dbase/bin/tamps_bcpIN_Weath.csh

tamps/src/scripts/dbase/bin/tamps_bcpOUT_Weath.csh

===================================================================

STR:   6425

Title: Refuel Flight Event

Description:

Took on 6,000 pounds of fuel using the refuel flight event.  Climbed to 25,000 feet and cruised at best speed for 50 nmi.  TAMPS did not account for the additional 6,000 pounds in weight until the next waypoint after the refueling event. Software needs to be changed to account for the weight change at the waypoint of the refueling event.

Items:

------

tamps/src/libs/a_msn_plan/aet/aet_RouteUtils.c

tamps/src/libs/a_msn_plan/aft/aft_ProcessRefuel.c

tamps/src/libs/a_msn_plan/aft/aft_RefuelRecCb.c

tamps/src/libs/a_msn_plan/aft/aft_RefuelTankCb.c

tamps/src/libs/a_msn_plan/include/aet_priv_proto.h

===================================================================

STR:   6426

Title: Multiple Waypoint Edit Feature

Description:

Correct the multiple waypoint edit feature within the Edit Flight Parameters tool so that it correctly applies time, fuel, and distance computations.

Items:

------

tamps/src/libs/a_msn_plan/aet/aet_NavUtils.c

===================================================================

STR:   6429

Title: Change Start Transition/End Transition Logic

Description:

Change start transition / end transition logic so that vehicle ends up at

desired altitude at end of route leg and not before.

Items:

------

tamps/src/libs/a_msn_plan/aet/aet_EditNavCb.c

tamps/src/libs/a_msn_plan/aet/aet_NavUtils.c

tamps/src/libs/a_msn_plan/aut/aut_update_action_pt.c

===================================================================

STR:   6458

Title: Recovery Base Elevation Error

Description:

The Recovery Base elevation will be incorrectly set to zero ft when the following steps are performed. This occured in C2A and S3B thread tests. Note! This will prevent loading of flight plan to GPSMDL due to obsolete data check failure.

1) Open new mission and name it

2) Go to Launch/Recovery and enter ICAO for Launch, Recovery and  Primary/Secondary Diverts

3) OK to close window

4) Open Edit Flight Parameters (EFP) window and enter a NAV Pt

5) Apply change

6) Select NAV Pt just entered and Delete it

7) Look at amplification info of Recovery Base and the elevation is 0

Items:

------

tamps/src/libs/a_msn_plan/aet/aet_NavUtils.c

tamps/src/libs/a_msn_plan/amt/amt_rtdisp.c

===================================================================

STR:   6496

Title: Audit Log Crash

Description:

The Audit Administration function is crashing when attempt to open primary log. I had all audit events selected and opened/closed MPMs and DBAs and in about four hours the /var/audit filled up to about 50%. When about 80% full is when I saw problems opening the logs. Workaround is to archive off logs or delete them from a shell, and then can open new logs.

Items:

------

tamps/src/apps/zsystem/include/zzt_audit_log.H

tamps/src/apps/zsystem/include/zzt_defines.h

tamps/src/apps/zsystem/include/zzt_review.H

tamps/src/apps/zsystem/zzt/zzt_log_cons.C

tamps/src/apps/zsystem/zzt/zzt_revDialog.C

===================================================================

STR:   6552

Title: GPSMDL Empty Primary ID File

Description:

In HH60 MPM on DTC2, using the generic MDL load application, loaded a MDL with all files and everything looked OK.  Closed the MDL Download window and checked the MDL contents using the mdlvt tool and all files were there with good checksum.  Selected MDL Download again and only changed the flight plan file, left Keep Data option on Primary ID file. Selected Apply to download new data to cartridge. Download completed message came up and was acknowledged. In the MDL Download window the Primary ID Data was no longer selected.  The MDL was read using mdlvt with good checksums, and the Primary ID File was there but empty. Closed the MDL Download window, exited the MPM and opened it again, in a new MPM, and the Primary ID button was selected but Keep Data wa not. Tried to select Keep Data but it would turn blue and then deselect itself right away. This is a mission critical failure, since it is corrupting data on the cartridge.

Items:

------

===================================================================

STR:   6556

Title: Login Warning message

Description:

A 'DOD interest computer system' warning message must be displayed when the user

logs in.

Items:

------

===================================================================

STR:   6581

Title: INDIVIDUAL POINT TYPE RECORDS CREATED IN GPS NAV FILES NOT DOWNLOADED TO MDL

Description:

If user defined records are created by using the Individual Point Function in the GPS Waypoints function, the download function skips them and a message is given to the user that

records are missing.

Items:

------

tamps/src/libs/b_msn_tools/bdt/bdt_Dafif_c.C

tamps/src/libs/b_msn_tools/bgt/bgt_pointfl.c

tamps/src/libs/dbase/dgt/dgt_gpsNavfile.c

tamps/src/libs/dbase/include/dgt_gps_struct.h

===================================================================

STR:   6586

Title: INCORRECT VALUE FOR SLAVED VARIATION FOR MDL FLIGHT PLANS

Description:

The mag var value is written in the slaved variation field even though the slaved variation is stored in the database.  The mag var value should only be used if the slaved variation value is unknown/does not apply.

Items:

------

tamps/include/a_msn_plan/apt_route.h

tamps/src/dbinstall/tampsdb/create/mission/tamps_refobj_create.sql

tamps/src/libs/a_msn_plan/adt/adt_msn.c

tamps/src/libs/a_msn_plan/aet/aet_CkPtRefQuery.c

tamps/src/libs/a_msn_plan/aet/aet_EditNavCb.c

tamps/src/libs/a_msn_plan/aet/aet_MCPRcallBacks.c

tamps/src/libs/a_msn_plan/aet/aet_NavUtils.c

tamps/src/libs/a_msn_plan/aet/aet_RefChkpCb.c

tamps/src/libs/a_msn_plan/aet/aet_RouteUtils.c

tamps/src/libs/a_msn_plan/include/axt_handle_defines.h

tamps/src/libs/a_msn_plan/include/axt_priv_defines.h

tamps/src/libs/a_msn_plan/include/axt_priv_structs.h

tamps/src/libs/b_msn_tools/bdt/bdt_FlightPlan_c.C

===================================================================

STR:   6594

Title: CORRUPT RECOVERY AIRBASE DOWNLOADED TO MDL

Description:

Created mission with DAFIF Airbases as Launch/Recovery.  Selected for Download

and received Obsolete Data error.  Reopened mission and also received error.

Checked Workstation Log which displayed that the lat/long was same but

original Elevation = 0 and new Elevation = 15 (This is the elevation from

DAFIF that is in TAMPS database).  Cleared Recovery base and reselected same

base.  Saved mission and reopened and error gone.  Downloaded to mdl and

read back data.  The Recovery base was attached so this will be last point

on MDL.  The last point had Lat/Long = 0 and was lat/long type point.  No

info related to DAFIF airbase was downloaded.  The ident string was all

blanks.

Items:

------

===================================================================

STR:   6602

Title: NEW DAFIF LOAD CORRUPTS EXISTING MISSIONS IF DAFIF OBJECT DELETED

Description:

Created mission with DAFIF 9612 where the Navaid and Waypoint will be

deleted by DAFIF 9702. The 3rd and last nav points had DAFIF records that

will be affected.  Uploaded 9702.  Next day reopened mission and received

Obsolete Data errors.  Here is that status of each area:

3rd Nav point data:

MCR:  Listed Ident and record type but Name is the name of last nav point's

DAFIF record.  Range/Bearing calculated based on Lat/long of last nav

point's DAFIF record.

Geo Display:  Using the lat/long of the last nav point's DAFIF record.  Red

dashed line across screen.

Kneeboard:  Shows all previous DAFIF info (Ident, Channel, type, name, etc)

and Range/Bearing same as when created.

***CHOPPED***

Items:

------

tamps/src/libs/a_msn_plan/adt/adt_obsoleteCHK.c

tamps/src/libs/a_msn_plan/aet/aet_EditNavCb.c

===================================================================

STR:   6654

Title: MDL CARTRIDGE ONLY READ WHEN DOWNLOAD FUNCTION STARTED

Description:

Downloaded data to an MDL.  Removed MDL and inserted another one.  Hit OK and cartridge label was from previous MDL.  New mdl did not have a  label (it was erased).  The user will have no way of knowing what is on the MDL if the wrong label appears.  Primary keep flag set even though no primary file on mdl.  Hit OK and download finished and no error that primary did not exist.

Currently, keep primary button can be set by the user even if no MDL

inserted.  This button needs to be sensitive based on actual data.  If

there is no primary to keep on the MDL, the user must not be able to

set it.  This give the user the false impression that a primary file

exists on the mdl.

There is a basic problem with this design.

***CHOPPED***

Items:

------

===================================================================

STR:   6683

Title: DATA LOAD CORRUPTED WHEN CREATING MULTIPLE GPSMDL COPIES

Description:

Selected the files to be downloaded - 12 flight plans, 200 pt reversionary,

21,000 pt primary, mag var files, almanac (full load GPSMDL).  Hit Apply.

After download finished, checked contents of GPSMDL and data loaded as

expected.  Hit apply again and GPSMDL loaded as expected.  After 4th time,

the data on the GPSMDL was corrupt in some locations (ie, MDL Status file

end of data ptr, etc).

Workaround:  Use only OK button to download data to GPSMDL.  Each GPSMDL

must be download separately

Items:

------

tamps/src/libs/b_msn_tools/bdt/bdt_Cartridge_c.C

tamps/src/libs/b_msn_tools/bdt/bdt_Download_Cb.C

tamps/src/libs/b_msn_tools/bdt/bdt_Download_MMI.C

tamps/src/libs/b_msn_tools/bdt/bdt_init.C

tamps/src/libs/b_msn_tools/include/bdt_Cartridge_c.H

tamps/src/libs/b_msn_tools/include/bdt_Download_MMI.H

===================================================================

STR:   6697

Title: Doghouse component data items

Description:

The available data components that are selectable to be placed within a doghouse also need to be expanded to include current point and next point information, and make more data types available.

The desired data types available for placing in a doghouse component are the following items for both current and next point:  heading (mag and true), altitude(msl and agl), speed (CAS, TAS, GS, Mach), latitude, longitude, distance, leg time, elapsed time, clock time, fuel remaining, leg fuel, ground elevation, UTM zone/coordinates, MGRS coordinates, divert IDENT/course/heading/distance/time/fuel, target time/dist, recovery time/dist/course, bank angle, mag var, fuel flow, and blank.

Modified doghouses should be able to be saved and recalled later for reuse.

This STR encapsulates T-3788 and 4596.

Items:

------

tamps/include/a_msn_plan/apt_route.h

tamps/include/b_msn_tools/bsa_defines.h

tamps/include/b_msn_tools/bsa_structs.h

tamps/include_prot/b_msn_tools/bsa_prot_proto.h

tamps/src/libs/b_msn_tools/bsa/Makefile

tamps/src/libs/b_msn_tools/bsa/bsa_CreateCompDataItem3Part.c

tamps/src/libs/b_msn_tools/bsa/bsa_CreateCompDataItemDouble.c

tamps/src/libs/b_msn_tools/bsa/bsa_CreateCompDataItemSingle.c

tamps/src/libs/b_msn_tools/bsa/bsa_DoghouseEd.c

tamps/src/libs/b_msn_tools/bsa/bsa_EditorStart.c

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

tamps/src/libs/b_msn_tools/bsa/bsa_GetStrips.c

tamps/src/libs/b_msn_tools/bsa/bsa_StripParam.c

tamps/src/libs/b_msn_tools/include/bsa_prl_defs.h

tamps/src/libs/b_msn_tools/include/bsa_prl_priv_defs.h

tamps/src/libs/b_msn_tools/include/bsa_prl_structs.h

tamps/src/libs/b_msn_tools/include/bsa_prl_user_structs.h

tamps/src/libs/b_msn_tools/include/bsa_st_sysdefs.h

===================================================================

STR:   6698

Title:  Kneeboard card defaults

Description:

A better default kneeboard card format is needed. The kneeboard card should print out as a full page in landscape orientation, with the columns arranged so that it can be folded in half or cut in half.

The default layout should include approximately an inch of blank space at the top for notes and then the following columns from left to right (slashes separate data items in the same cell on two lines):

- Left half:  Wpt #, ID BRG RNG/Description, TACAN Chan/VOR Freq, Mag heading/Mag course, Calibrated airspeed/Indicated Mach Number, Groundspeed/True Airspeed, Leg Distance/Cumulative Distance, Leg Time/Clock Time, Leg Fuel/Fuel remaining, altitude/flight mode.

- Right Half:  Wpt #, Lat/Long, Elevation/Magvar, MGRS/UTM, Wind/Temp, Divert ID/Divert BRG RNG.

A Sample kneeboard card of the desired format has been provided to the SSA at Pt. Mugu.

Items:

------

tamps/src/libs/products/include/prl_priv_defs.h

tamps/src/libs/products/include/prl_priv_proto.h

tamps/src/libs/products/include/prl_structs.h

tamps/src/libs/products/prl/Makefile

tamps/src/libs/products/prl/prl_aircrew_bind.c

tamps/src/libs/products/prl/prl_create_kneeb_format.c

tamps/src/libs/products/prl/prl_extract_data.c

tamps/src/libs/products/prl/prl_filter_mission.c

tamps/src/libs/products/prl/prl_navKneeboardHMI.c

tamps/src/libs/products/prl/prl_navKneeboardHMI_1.c

tamps/src/libs/products/prl/prl_navKneeboardPSL.c

tamps/src/libs/products/prl/prl_navReOrderHMI.c

tamps/src/libs/products/prl/prl_report_tool.c

===================================================================

STR:   6699

Title: Kneeboard card field data items

Description:

Better customization of data items need to be available for placing items on the kneeboard card.

The following data items should be selectable for placement in the top or bottom half of any cell, independent of what is placed in the other half:

-heading (mag and true), altitude(msl and agl), speed (CAS, TAS, GS, Mach), latitude, longitude, distance (leg and cumulative), leg time, elapsed time, clock time, fuel remaining, leg fuel, ground elevation, UTM zone/coordinates, MGRS coordinates, divert IDENT/course/heading/distance/time/fuel, target time/dist, recovery time/dist/course, bank angle, mag var, fuel flow, flight mode, and blank.

Modified kneeboard cards should be able to be saved and recalled for future use.

This STR encapsulates T-6114, 6115, 4563, 4566, 5112.

Items:

------

tamps/include/help/thc_defines.h

tamps/src/libs/products/include/prl_priv_proto.h

tamps/src/libs/products/include/prl_structs.h

tamps/src/libs/products/prl/Makefile

tamps/src/libs/products/prl/prl_aircrew_bind.c

tamps/src/libs/products/prl/prl_create_kneeb_format.c

tamps/src/libs/products/prl/prl_dafid_sql.c

tamps/src/libs/products/prl/prl_extract_data.c

tamps/src/libs/products/prl/prl_filter_mission.c

tamps/src/libs/products/prl/prl_filter_obrpt.c

tamps/src/libs/products/prl/prl_filter_util.c

tamps/src/libs/products/prl/prl_format_dtedrpt_land.c

tamps/src/libs/products/prl/prl_format_dtedrpt_port.c

tamps/src/libs/products/prl/prl_initDataItems.c

tamps/src/libs/products/prl/prl_main.c

tamps/src/libs/products/prl/prl_navKneeboardHMI.c

tamps/src/libs/products/prl/prl_navKneeboardHMI_1.c

tamps/src/libs/products/prl/prl_navKneeboardPSL.c

tamps/src/libs/products/prl/prl_navReOrderHMI.c

tamps/src/libs/products/prl/prl_print.c

tamps/src/libs/products/prl/prl_report_selection.c

tamps/src/libs/products/prl/prl_select_rpt.c

===================================================================

STR:   6726

Title: APPLIX Removal

Description:

Remove the APPLIX COTS software package and the associated menus, since it is a security issue.

Items:

------

===================================================================

STR:   6755

Title:

Description:

Items:

------

tamps/include/system/sit_default_defines.h

tamps/include_prot/a_msn_plan/ait_prot_proto.h

tamps/src/data/bitmaps/make_data

tamps/src/libs/a_msn_plan/aat/aat_attack_calcs.c

tamps/src/libs/a_msn_plan/aet/aet_CreateEditNavDialog.c

tamps/src/libs/a_msn_plan/aet/aet_EditNavCb.c

tamps/src/libs/a_msn_plan/aet/aet_FltModeUtils.c

tamps/src/libs/a_msn_plan/aet/aet_NavUtils.c

tamps/src/libs/a_msn_plan/aet/aet_RouteUtils.c

tamps/src/libs/a_msn_plan/afi/afi_farp_event.c

tamps/src/libs/a_msn_plan/afi/afi_fuel_farp_event.c

tamps/src/libs/a_msn_plan/afi/afi_fuel_lz_event.c

tamps/src/libs/a_msn_plan/afi/afi_ground_event.c

tamps/src/libs/a_msn_plan/afi/afi_hold_event.c

tamps/src/libs/a_msn_plan/afi/afi_hover_event.c

tamps/src/libs/a_msn_plan/afi/afi_lz_event.c

tamps/src/libs/a_msn_plan/aft/aft_EditTimeCb.c

tamps/src/libs/a_msn_plan/ait/Makefile

tamps/src/libs/a_msn_plan/ait/ait_msnOpenCB.c

tamps/src/libs/a_msn_plan/ait/ait_validateRouteCB.c

tamps/src/libs/a_msn_plan/ait/ait_validateRouteDialog.c

tamps/src/libs/a_msn_plan/ait/ait_validateRouteStatus.c

tamps/src/libs/a_msn_plan/aut/aut_construct_route.c

tamps/src/libs/a_msn_plan/aut/aut_jettison.c

tamps/src/libs/a_msn_plan/aut/aut_refuel.c

tamps/src/libs/a_msn_plan/aut/aut_update_action_pt.c

tamps/src/libs/a_msn_plan/include/aet_editnavpt.h

tamps/src/libs/a_msn_plan/include/aet_priv_proto.h

tamps/src/libs/a_msn_plan/include/ait_priv_proto.h

tamps/src/libs/a_msn_plan/include/ait_route_validation_defines.h

tamps/src/libs/a_msn_plan/include/aut_priv_proto.h

tamps/src/libs/a_msn_plan/include/make_includes

tamps/src/libs/products/prl/prl_extract_data.c

tamps/src/libs/reports/rkt/rkt_util.c

tamps/src/libs/system/sit/sit_defaultMenu.c

tamps/src/libs/system/sit/sit_init.c

tamps/src/libs/system/sit/sit_tbar.c

===================================================================

STR:   6825

Title: Strip chart time tick marks

Description:

Strip chart time tick mark resets to whole minute every leg.  Fixed to now account for fractional time left over from previous leg and plots correct time tick mark.

Items:

------

tamps/src/libs/b_msn_tools/bsa/bsa_ProcStripD.c

===================================================================

STR:   6850

Title:

Description:

Items:

------

tamps/src/apps/Makefile

tamps/src/apps/a_msn_plan/Make.mission_data

tamps/src/apps/a_msn_plan/Make.mission_list

tamps/src/apps/a_msn_plan/Make.threat_data

tamps/src/apps/a_msn_plan/Makefile

tamps/src/apps/a_msn_plan/atl_mission_data_main.c

tamps/src/apps/a_msn_plan/atl_mission_names_main.c

tamps/src/apps/a_msn_plan/atl_threat_data_main.c

tamps/src/dbinstall/Install_dbinstall.csh

tamps/src/dbinstall/make_dirs

tamps/src/dbinstall/sprocs/Install_tamps_sp.csh

tamps/src/dbinstall/sprocs/make_sql

tamps/src/dbinstall/sprocs/topscene_get_msn_list.sql

tamps/src/dbinstall/sprocs/topscene_get_threat_data.sql

tamps/src/dbinstall/topscene/Install_topscene.csh

tamps/src/dbinstall/topscene/Makefile

tamps/src/dbinstall/topscene/make_scripts

tamps/src/dbinstall/topscene/make_sql

tamps/src/dbinstall/topscene/topscene_sym_create_table.sql

===================================================================

STR:   6874

Title: Correct Problem with Ada binding to C function mpt_latlon2grid

Description:

In mpt, there is a function named mpt_latlon2grid, which converts lat/lon coordinates to a grid string.  The Ada binding for this function is incorrect.  The sequence of the last two parameters is switched and the type for the geoPt parameter is incorrect.  It should not be a pointer in the Ada Binding.

Items:

------

tamps/include/maps/mpt_proto.h

tamps/src/bindings/mpt.a

tamps/src/libs/maps/mpt/mpt_util.c

===================================================================

STR:   6875

Title:

Description:

The Ada bindings for the uxt functions will not link because the function uxt_getXColorIndex is incorrectly identified as uxt_getColorIndex in the Ada binding.

Items:

------

tamps/src/bindings/uxt.a

===================================================================

STR:   6876

Title: Correction to Ada constants for the C enumeration type mpt_units

Description:

In mpt_defs.h there is an enumerated type defined named MPT_UNITS which is used to choose which units you are requesting form the mpt_getCurrentUnits routine.  In C, the integer representation ofthe values of this enumerated type begin at 0.  In the Ada bindings (mpt_defs.a), there are constants defined to correspond to these values, but they begin at 1 instead of 0, so the values do not correspond correctly.

Items:

------

tamps/src/bindings/mpt_defs.a

===================================================================

A.4
DTRs in this Release

DTRs in release TAMPS 6.2 dated, 11 March 1998.

===================================================================

DTR:     D10008

SOR/STR: 6.2 init

Title:   Remove Obsolete Files

Description:

Remove files that are obsolete in 6.2 that were not removed during initialization

Items:

------

tamps/config/iMake

tamps/src/data/environment/DBadmin.env

tamps/src/data/environment/Grafix.ag

tamps/src/data/environment/arctic.env

tamps/src/data/environment/ax_prof3

tamps/src/data/environment/tamps.cm

tamps/src/data/environment/tamps.cno

tamps/src/data/environment/tamps.east

tamps/src/data/environment/tamps.env.dtc

tamps/src/data/environment/tamps.env.sun

tamps/src/data/environment/tamps.jupiter

tamps/src/data/environment/tamps.nophigs

tamps/src/data/environment/tamps.pure

tamps/src/data/environment/tampsmenu.am

tamps/src/data/maps/dcw/browse/cat.

tamps/src/data/maps/dcw/browse/co/coarea.aft

tamps/src/data/maps/dcw/browse/co/ebr.

tamps/src/data/maps/dcw/browse/co/edg.

tamps/src/data/maps/dcw/browse/co/edx.

tamps/src/data/maps/dcw/browse/co/esi.

tamps/src/data/maps/dcw/browse/co/fac.

tamps/src/data/maps/dcw/browse/co/fbr.

tamps/src/data/maps/dcw/browse/co/fcs.

tamps/src/data/maps/dcw/browse/co/fsi.

tamps/src/data/maps/dcw/browse/co/int.vdt

tamps/src/data/maps/dcw/browse/co/rng.

tamps/src/data/maps/dcw/browse/da/daarea.aft

tamps/src/data/maps/dcw/browse/da/ebr.

tamps/src/data/maps/dcw/browse/da/edg.

tamps/src/data/maps/dcw/browse/da/edx.

tamps/src/data/maps/dcw/browse/da/esi.

tamps/src/data/maps/dcw/browse/da/fac.

tamps/src/data/maps/dcw/browse/da/fbr.

tamps/src/data/maps/dcw/browse/da/fcs.

tamps/src/data/maps/dcw/browse/da/fsi.

tamps/src/data/maps/dcw/browse/da/int.vdt

tamps/src/data/maps/dcw/browse/da/rng.

tamps/src/data/maps/dcw/browse/dn/dnarea.aft

tamps/src/data/maps/dcw/browse/dn/dnline.lft

tamps/src/data/maps/dcw/browse/dn/ebr.

tamps/src/data/maps/dcw/browse/dn/edg.

tamps/src/data/maps/dcw/browse/dn/edx.

tamps/src/data/maps/dcw/browse/dn/esi.

tamps/src/data/maps/dcw/browse/dn/fac.

tamps/src/data/maps/dcw/browse/dn/fbr.

tamps/src/data/maps/dcw/browse/dn/fcs.

tamps/src/data/maps/dcw/browse/dn/fsi.

tamps/src/data/maps/dcw/browse/dn/int.vdt

tamps/src/data/maps/dcw/browse/dn/rng.

tamps/src/data/maps/dcw/browse/dqt.

tamps/src/data/maps/dcw/browse/dqx.

tamps/src/data/maps/dcw/browse/dv/dvarea.aft

tamps/src/data/maps/dcw/browse/dv/ebr.

tamps/src/data/maps/dcw/browse/dv/edg.

tamps/src/data/maps/dcw/browse/dv/edx.

tamps/src/data/maps/dcw/browse/dv/esi.

tamps/src/data/maps/dcw/browse/dv/fac.

tamps/src/data/maps/dcw/browse/dv/fbr.

tamps/src/data/maps/dcw/browse/dv/fcs.

tamps/src/data/maps/dcw/browse/dv/fsi.

tamps/src/data/maps/dcw/browse/dv/int.vdt

tamps/src/data/maps/dcw/browse/dv/rng.

tamps/src/data/maps/dcw/browse/gr/char.vdt

tamps/src/data/maps/dcw/browse/gr/ebr.

tamps/src/data/maps/dcw/browse/gr/edg.

tamps/src/data/maps/dcw/browse/gr/edx.

tamps/src/data/maps/dcw/browse/gr/esi.

tamps/src/data/maps/dcw/browse/gr/fac.

tamps/src/data/maps/dcw/browse/gr/fbr.

tamps/src/data/maps/dcw/browse/gr/fcs.

tamps/src/data/maps/dcw/browse/gr/fsi.

tamps/src/data/maps/dcw/browse/gr/grarea.aft

tamps/src/data/maps/dcw/browse/gr/grline.lft

tamps/src/data/maps/dcw/browse/gr/grtext.tft

tamps/src/data/maps/dcw/browse/gr/grtext.tfx

tamps/src/data/maps/dcw/browse/gr/int.vdt

tamps/src/data/maps/dcw/browse/gr/rng.

tamps/src/data/maps/dcw/browse/gr/tsi.

tamps/src/data/maps/dcw/browse/gr/txt.

tamps/src/data/maps/dcw/browse/gr/txx.

tamps/src/data/maps/dcw/browse/grt.

tamps/src/data/maps/dcw/browse/in/ebr.

tamps/src/data/maps/dcw/browse/in/edg.

tamps/src/data/maps/dcw/browse/in/edx.

tamps/src/data/maps/dcw/browse/in/esi.

tamps/src/data/maps/dcw/browse/in/fac.

tamps/src/data/maps/dcw/browse/in/fbr.

tamps/src/data/maps/dcw/browse/in/fcs.

tamps/src/data/maps/dcw/browse/in/fsi.

tamps/src/data/maps/dcw/browse/in/inarea.aft

tamps/src/data/maps/dcw/browse/in/int.vdt

tamps/src/data/maps/dcw/browse/in/intext.tft

tamps/src/data/maps/dcw/browse/in/intext.tfx

tamps/src/data/maps/dcw/browse/in/rng.

tamps/src/data/maps/dcw/browse/in/tsi.

tamps/src/data/maps/dcw/browse/in/txt.

tamps/src/data/maps/dcw/browse/in/txx.

tamps/src/data/maps/dcw/browse/lht.

tamps/src/data/maps/dcw/browse/libref/edg.

tamps/src/data/maps/dcw/browse/libref/edx.

tamps/src/data/maps/dcw/browse/po/ebr.

tamps/src/data/maps/dcw/browse/po/edg.

tamps/src/data/maps/dcw/browse/po/edx.

tamps/src/data/maps/dcw/browse/po/esi.

tamps/src/data/maps/dcw/browse/po/fac.

tamps/src/data/maps/dcw/browse/po/fbr.

tamps/src/data/maps/dcw/browse/po/fcs.

tamps/src/data/maps/dcw/browse/po/fsi.

tamps/src/data/maps/dcw/browse/po/int.vdt

tamps/src/data/maps/dcw/browse/po/poarea.aft

tamps/src/data/maps/dcw/browse/po/poline.lft

tamps/src/data/maps/dcw/browse/po/potext.tft

tamps/src/data/maps/dcw/browse/po/potext.tfx

tamps/src/data/maps/dcw/browse/po/rng.

tamps/src/data/maps/dcw/browse/po/tsi.

tamps/src/data/maps/dcw/browse/po/txt.

tamps/src/data/maps/dcw/browse/po/txx.

tamps/src/data/maps/dcw/browse/pp/end.

tamps/src/data/maps/dcw/browse/pp/fcs.

tamps/src/data/maps/dcw/browse/pp/int.vdt

tamps/src/data/maps/dcw/browse/pp/nsi.

tamps/src/data/maps/dcw/browse/pp/pppoint.pft

tamps/src/data/maps/dcw/browse/pp/pptext.tft

tamps/src/data/maps/dcw/browse/pp/pptext.tfx

tamps/src/data/maps/dcw/browse/pp/tsi.

tamps/src/data/maps/dcw/browse/pp/txt.

tamps/src/data/maps/dcw/browse/pp/txx.

tamps/src/data/maps/dcw/dht.

tamps/src/data/maps/dcw/lat.

===================================================================

DTR:     D10009

SOR/STR: SOR 95-43

Title:   Motif Failures

Description:

Several times while performing normal TAMPS functions (i.e. opening missions, initiating shutdown, etc.) the Motif window manager failed.  Had to logoff and back on to restore it.  There appears to be a greater tendency for this to happen soon after a system reboot.

One way to make Motif fail every time:

1.  Display a system modal window.

2.  Open the DBA or an MPM and move the window.

3.  Perform a database query of any type.

4.  Motif will crash after performing the query.

Motif can be restarted from a shell by typing mwm& and will function properly or by logging out and logging in again.

Items:

------

===================================================================

DTR:     D10010

SOR/STR: 6.2 init

Title:   Recovery Base Symbol Error

Description:

When creating missions, the recovery base is shown as a nav point symbol with a "2" next to it, rather than an airbase or carrier symbol.  When attach recovery is selected, the correct symbol is overlayed on the nav point symbol.

Items:

------

===================================================================

DTR:     D10011

SOR/STR: 6.2 init

Title:   Compass MPM Not Functioning

Description:

The COMPASS MPM is not working.  When it is selected from the Mission Planning menu, the MPM map window flashes on the screen and disappears.

Items:

------

tamps/src/apps/compass/ams/ams_defaultMenu.c

===================================================================

DTR:     D10012

SOR/STR: 6216

Title:   Geo Filter Help is Incorrect

Description:

The help file for the new GEO tool (Display -> Geo Filter -> Custom) is incorrect in several places.  The "Geo" menu is described as containing the options "Current", "Display", "Clear" and "Delete", but the menu in the window actually contains "New Geo", "Current", "Display", "Declutter", "Edit" and "Delete".  The functional descriptions for "Current" and "Display" are also incorrect, and there are several spelling errors/typos.  Also should add a description of the Save and Apply functions.

Items:

------

===================================================================

DTR:     D10013

SOR/STR: 6216

Title:   Geo Filter Menu Logic is Incorrect

Description:

The gray/ungray logic in the Geo menu of the Geo Filter window is not correct.  The user should be able to create a new GEO even if a previously created GEO is highlighted if the "Selectable Geos" list.  "Display" should be grayed out if a GEO that is already displayed is highlighted.  "Declutter" should be grayed out if a GEO that is not displayed is highlighted.  "Current" should be grayed out if the current GEO is highlighted.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geo.c

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10014

SOR/STR: 6216

Title:   Geo Filter Scroll Bar Error

Description:

The scroll bars in the "Selectable Geos" and "Displayed Geos" regions of the GEO Filter window should only appear when the lists get filled to the point where a scroll bar is necessary to view all of the GEOs.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geo.c

===================================================================

DTR:     D10015

SOR/STR: 6216

Title:   Geo Filter Editing Error

Description:

If a previously saved GEO is highlighted in the GEO Filter window, and then edited without changing the name, the system displays a "Delete GEO Confirmation" window.  Selecting either Yes or No appears to give the same result.

Items:

------

tamps/src/libs/dbase/dmt/dmt_gdelete.c

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10016

SOR/STR: 6216

Title:   Creating New Geos

Description:

When creating new GEOs using the Rectangle, Circle or Polygon selection under the Display -> Geo Filter menu, or the GEO toolbar icon, the system displays a "Delete GEO confirmation" window.  Selecting either Yes or No in this window appears to give the same result.

Items:

------

===================================================================

DTR:     D10017

SOR/STR: 6216

Title:   Saving Geos

Description:

In an MPM, if a new GEO is created which has the same name as a GEO that has already been saved to the database, and then "Save" is selected, an error message is displayed that tells the user to change the name of the GEO.  However, when the message is acknowledged, all fields in the new GEO window are grayed out, including the name, so the GEO must be recreated.

Items:

------

===================================================================

DTR:     D10018

SOR/STR: 6216

Title:   Geo Filter Hidden Menu

Description:

When using the new Geo Filter -> Custom function to input a new geo, if cancel out of the draw mode by using the right mouse button or click twice on the same location using the left button, an error message comes up but is hidden behind the "Geo filter" window.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geobox.c

tamps/src/libs/dbase/dmt/dmt_geocb.c

tamps/src/libs/dbase/dmt/dmt_geocirc.c

tamps/src/libs/dbase/dmt/dmt_geopoly.c

tamps/src/libs/dbase/dmt/dmt_georte.c

tamps/src/libs/dbase/include/dmt_priv_proto.h

===================================================================

DTR:     D10019

SOR/STR: 6216

Title:   Geo Filter Edit

Description:

In a DBA module, selected a DBA built GEO that had a * next to it for editing.  Error message comes up: "Selected Geo must be the current Geo", even if the GEO already is the current GEO.  If the selected GEO is not the current GEO, it changes it to the current GEO.  Could not edit any GEOs with the *.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10020

SOR/STR: 6216

Title:   Geo Filter delete

Description:

In a DBA Module, selected a geo and then selected Delete.  A message window came up saying "Selected Geo does not exist".  Also, a confirmation window and a Geo Filter Delete hourglass came up.  When select No on the confirmation window, the file was deleted anyway.

Items:

------

tamps/src/libs/dbase/dmt/dmt_gdelete.c

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10021

SOR/STR: 6.2 init

Title:   Make Arguments Omission for cc compiler

Description:

$TOPDIR/config/projpath needs -xildoff added to STD_CFLAG in make arguments for cc compiler.

Items:

------

tamps/config/projpath

===================================================================

DTR:     D10022

SOR/STR: 6.2 init

Title:   Ada Bindings

Description:

The following ADA bindings are documented in the IDD but are not implemented:

AUT_COMPUTEWINDCOMPONENTS

AUT_COMPUTEWINDDISTANCE

AUT_COMPUTEWINDRANGEFACTOR

DAL_GENCLAUSE

DAL_GENQUERYLIST

MPT_GET_SCALE_AND_ZOOM

UET_ERRORMSG

UMT_UPDATETABLE

The LBT_REGISTER binding is missing the FLAG argument.

Rep Specs were updated for the following record to repair compilation warnings:

APT_ACTION_POINT_T

APT_AIRCRAFT_T

CORNER_RADS

GEO_NODE_CIRCLE

GEO_NODE_POLY

GEO_NODE_ROUTE

POINT_RADIANS

THE TMT_IMAGERY_STRUCT record does not exist in the bindings area.  On the C side, the C structure TMT_ADRI_STRUCT  was changed to TMT_IMAGERY_STRUCT for STR 3112.

Appendix N incorrectly has and AOA field for the APV_JBACKLINK_T record.

The ART_CREATEMSNLAYERNAME ADA binding function description in IDD Appendix G should not have an ID argument.

The BDT_COMPUTECHECKSUM ADA binding function description and example in IDD Appendix G needs to be updated to reflect the actual ADA binding.

Items:

------

tamps/src/bindings/aut.a

tamps/src/bindings/dal.a

tamps/src/bindings/lbt.a

tamps/src/bindings/mpt.a

tamps/src/bindings/tit_adri_struct.a

tamps/src/bindings/umt.a

===================================================================

DTR:     D10025

SOR/STR: SOR 96-60A

Title:   Count By Decouple

Description:

Count By decouple mode is not functioning correctly.  When using Count By to key on a column of

information, highlight 1 or more items and then select decouple.  If a change is made to the map display,

the change is correctly not made to the decoupled widget but if a different column is selected in the

decoupled widget, the items highlighted in the display window of the decoupled widget will match the

objects selected on the map display even though the widget is decoupled.

Items:

------

tamps/src/libs/reports/include/rcl_CountByBucketObject.h

tamps/src/libs/reports/rcl/rcl_CountByBucketObject.c

tamps/src/libs/reports/rcl/rcl_CountByWindowHandlers.c

===================================================================

DTR:     D10026

SOR/STR: SOR 96-60A

Title:   Count By Function Scrolling

Description:

When scrolling in Count By Function, if the scroll bar is clicked-on and dragged using the mouse, the data is not scrolled real-time as the elevator is moved up and down.  All other functions in TAMPS scroll the data real-time as the elevator is moved.

Items:

------

tamps/src/libs/reports/rcl/rcl_CountByWindowHMI.c

===================================================================

DTR:     D10027

SOR/STR: 6.2 init

Title:   TAMPS Database Offline After Restore

Description:

The TAMPS database was still "off-line" after database restore operation had successfully completed.  Could not login as any user except root.  Fix was to manually bring the database on-line with SQL command, "online database tamps".  The actual restore seemed to work fine.  Not sure why tamps database was still off-line.  New sybase 11 behavior?  Change to restore scripts?

SOT Step 95-43.1

Items:

------

===================================================================

DTR:     D10028

SOR/STR: SOR 95-43

Title:   Move magvar.dat

Description:

move magvar.dat from TAMPS Core to Sysgen COTS, just as dcw browse and jnl data have been moved from Core to COTS

Items:

------

tamps/src/data/Makefile

tamps/src/data/magvar/Makefile

tamps/src/data/magvar/magvar.dat

tamps/src/data/magvar/make_data

===================================================================

DTR:     D10029

SOR/STR: 6.2 init

Title:   Archive/Restore Buttons Obscured

Description:

In the Archive/Restore window, the table list box partially obscures the Select All and the Deselect All Buttons.

Items:

------

===================================================================

DTR:     D10030

SOR/STR: 6.2 init

Title:   Import/Export Strike Name

Description:

When the Strike Package Import/Export window is opened and either the Import or Export pushbutton is selected, the Strike Name list box shrinks.

Items:

------

===================================================================

DTR:     D10031

SOR/STR: 6.2 init

Title:   Comms Processor Doesn't Start

Description:

When Communications -> Comms Administration is selected, the Comms Processor does not start.  If this functionality has been removed, the menu selections should be removed or grayed out, otherwise it should be fixed.

SOT Step 95-43.1

Items:

------

tamps/config/lMake.static

tamps/src/apps/Makefile

tamps/src/apps/comms/cal_IPmaster/cal_IPmasterd/IPmaster_clnt.c

tamps/src/apps/comms/cal_IPmaster/cal_IPmasterd/IPmaster_svc.c

tamps/src/apps/comms/cal_IPmaster/cal_IPmasterd/IPmaster_xdr.c

tamps/src/apps/comms/cjl_IOlh_file/Makefile

tamps/src/apps/comms/cnl_DIRscan/cnl_grid/Makefile

tamps/src/apps/comms/cnl_DIRscan/cnl_ovly2/Makefile

tamps/src/apps/comms/col_IOlh_CDBS/Makefile

tamps/src/apps/comms/include/BuildCOMMIncs.csh

tamps/src/apps/comms/include/Makefile

tamps/src/libs/Makefile

===================================================================

DTR:     D10032

SOR/STR: 6216

Title:   Geo Filter Create New Geo

Description:

In an MPM, if a new GEO is created which has the same name as a GEO that has already been saved to the database, and then "Save" is selected, no error message is brought up to tell the user to change the name of the GEO.  Also, all the fields in the new GEO window are grayed out, including the name, so the GEO must be recreated.

Items:

------

tamps/src/libs/dbase/dmt/dmt_gdelete.c

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10033

SOR/STR: 6.2 init

Title:   BAK/GND (background tool)

Description:

The Bak/Gnd widget is not behaving the way it did in 6.1.1. The parent window is hidden whenever Edit is selected on any function that brings up a child window. This makes "Apply" useless on the child windows like Imagery or Grids.

Items:

------

tamps/src/libs/maps/mmt/mmt_bkgndcb.c

===================================================================

DTR:     D10034

SOR/STR: 6.2 init

Title:   Load CADRG Filenames

Description:

Selected load ADRG in a DBA Module, with a Korea ONC/TPC CADRG CD in drive. Then when clicked on map to select Korea area charts, the pick window came up listing two /cdrom directory paths instead of just ONC and TPC like it did in 6.1.1 and earlier.

SOT Step 95-43.1

Items:

------

tamps/src/libs/maps/mpt/mpt_bldPrim.c

===================================================================

DTR:     D10035

SOR/STR: 6216

Title:   Geo Filter Delete Confirmation

Description:

The "Delete GEO Confirmation" dialog box is not descriptive enough.  It asks if you want to "Permanently remove geo?" when in actuality it might just be replacing, overwriting, etc.  The message that the user sees needs to be clearer and more informative as to what action is being taken.

Items:

------

tamps/src/libs/dbase/dmt/dmt_gdelete.c

===================================================================

DTR:     D10036

SOR/STR: 6216

Title:   Geo Filter Save Error

Description:

If you edit an existing geo and then try to save a new geo with a name that already exists, no error message pops up telling you that you are trying to save a geo with a name that already exists and to rename it.  The geo is deleted and the entry form is grayed out.  Should have an error message and the opportunity to rename the geo.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10039

SOR/STR: SOR 96-60A

Title:   Count By Data Display Error

Description:

There are several errors occuring in Count-By:

1.  Initial widget width:  I opened Count-By on AIRBASES NAVAIDS WAYPOINTS Layer and WAYPOINTS TERMINAL Bucket.  The Layer and Bucket titles were partially obscured because the widget was too narrow.

2.  When a Bucket with a large number of items (I used one with over 16,000 items) is selected for Count-By and the Column setting is set to NAME, Latitude or Longitude, you cannot scroll up or down in such a way to view all the data items.  If the Up or Down scroll arrows are selected, the data displayed is scrolled up or down more than one page at a time.  The data should be scrolled only a few items at a time when selecting the Up or Down arrows.  Sometimes resizing the widget will fix this problem.

Also, if the mouse pointer is clicked above or below the elevator positional indicator, the data displayed is scrolled up or down several pages at a time.  The data should be scrolled up or down one page at a time when this action is taken.

3.  When the Count-By widget is near the top of the terminal display and one of the lower column items is being displayed, the top Column item is obscured by the WSE bar when the Column Pull-Down Menu is selected.

Items:

------

===================================================================

DTR:     D10040

SOR/STR: SOR-95-43

Title:   F-14 MPM Missing S/W

Description:

F-14 MPM missing modified s/w in f14/src/f14gt subdirectory.

Items:

------

tamps/mpm/f14/src/f14gt/f14gt_abu_DataFile_MMI.C

tamps/mpm/f14/src/f14gt/f14gt_d_FlightPlan_c.C

tamps/mpm/f14/src/f14gt/f14gt_d_JTIDS_Cb.C

tamps/mpm/f14/src/f14gt/f14gt_d_JTIDS_MMI.C

tamps/mpm/f14/src/f14gt/f14gt_d_TacWayptData.C

tamps/mpm/f14/src/f14gt/f14gt_d_TacWypt_Cb.C

===================================================================

DTR:     D10041

SOR/STR: 6216

Title:   Geo Window Close

Description:

Closing the custom Geo window with the upper left window menu results in multiple copies of all listed geos in the Selectable and Displayed Geo lists.  Deleting one of the copies deletes it normally, but trying to display or delete the remaining copies results in "Selected Geo does not exist" message.  This behavior will be confusing to the user.

Items:

------

tamps/src/libs/dbase/dmt/dmt_gselcb.c

===================================================================

DTR:     D10042

SOR/STR: 6216

Title:   Geo Filter Delete

Description:

If the current Geo is deleted using the drop down menu in the custom Geo window, the Current Geo becomes corrupted.  With the custom Geo window still open, the Current Geo field properly reverts to the current op area.  However, when the Geo window is closed, the Current Geo is left in a corrupted state.  If the custom Geo window is re-opened, the Current Geo field will either be blank or filled with special charcters.  Subsequent queries against the database result in no records found because the query bounds are in an indeterminate state.  A new Geo must be created to clear the problem.  This will confuse users because they will not understand why queries are failing.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10043

SOR/STR: 6216

Title:   Default Current Geo

Description:

There is no way to revert the current Geo to the current Op Area.  The current Op Area is not listed in the selectable Geos list the way the old "No Geo" was listed in the old Geo implementation.  This leaves the user no way to revert to the Op Area for query constraints without deleting the current Geo (which does not work and is a separate DTR).  If the current Geo is a Saved Geo, deleting it to revert will also delete it for future use.  The current Op Area should be listed in the Selectable Geos list to allow reverting to it.

Items:

------

tamps/include_prot/dbase/dmt_geo_defines.h

tamps/include_prot/dbase/dmt_geo_structs.h

tamps/src/libs/dbase/dmt/dmt_geo.c

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10044

SOR/STR: 6216

Title:   Geo Filter Drawing Cancel

Description:

Canceling a Geo creation drawing operation with the right mouse button results in two error messages.  If you cancel after pressing the Geo button on the toolbar, you are asked to confirm deletion of a Geo you have not yet created, and you also get a "unable to create geo" message.  Circle gives two "unable to create geo" messages, and polygon gives something else.  A right mouse button cancel is a cancel and should not require any confirmation actions.  This is inconsistent with the rest of drawing operations in TAMPS.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10047

SOR/STR: SOR 96-60A

Title:   Count-By Motif button crash

Description:

If the motif pull-down is used to close the count-by window, the MPM or DBA module being used will crash.  Query for some objects, select Clutter/Declutter, Highlight a layer and bucket, select Count-By, close with the Motif menu and MPM crashes.

Items:

------

tamps/src/libs/reports/rcl/rcl_CountByWindowHMI.c

===================================================================

DTR:     D10048

SOR/STR: SOR 96-60a

Title:   Count By Op Area Change

Description:

If a count by window is open, it will crash the first time it is accessed after a change op area.

Items:

------

tamps/src/libs/reports/rcl/rcl_CountBy.c

===================================================================

DTR:     D10049

SOR/STR: SOR 97-12

Title:   Crypto Key Algorithm

Description:

The algorithm is not checking Crypto Keys as expected by the customer. For example, it loads a maintenance key as a valid weekly key.

Items:

------

===================================================================

DTR:     D10050

SOR/STR: SOR 96-10

Title:   NAVSSI_Host Environment Variable

Description:

In DBA when select Update>GPS Almanac> On Line Update, a message comes up stating that "unable to access environmental variable NAVSSI_HOST".  No other windows come up.

Items:

------

tamps/src/data/Makefile

tamps/src/libs/dbase/dpl/dpl_DbaGPSOnlineUpdate.c

tamps/src/libs/dbase/dpl/dpl_gpsOnlineUpdateCB.c

===================================================================

DTR:     D10051

SOR/STR: 6.2 init

Title:   Edit Flight Parameters Waypoint Error

Description:

In the A-6E MPM, when a waypoint is highlited and the "Edit

Flight Params" dialog is opened, the wrong waypoint is selected

in the list of waypoints at the top of dialog, but the waypoint # in

the dialog is correct.

Items:

------

tamps/src/libs/a_msn_plan/aet/aet_EditNavCb.c

===================================================================

DTR:     D10055

SOR/STR: 6.2 init

Title:   Initialization Build has incorrect MPMs

Description:

The initial 6.2 build has the wrong MPMs available.  The "RAAP" and

"Scenario" MPMs should be removed from the delivery.  The "C2A"

MPM should be added to the delivery.  The "A6E" and "BLAM" MPMs

should be delivered for test only.

Items:

------

tamps/mpm/Makefile

===================================================================

DTR:     D10056

SOR/STR: 6.2 init

Title:   ACE_Wrappers Makefile does not have correct targets

Description:

The ./tamps/src/contrib/ACE_Wrappers/Makefile does not have the

correct "make" targets. Add "make" targets for std TAMPS

development make scripts.

Items:

------

tamps/src/contrib/ACE_wrappers/Makefile

===================================================================

DTR:     D10057

SOR/STR: 6.2 init

Title:   rootAcces.sh fix

Description:

- rootAccess.sh script fix. Script was hardcoded for /tamps. The

new topdirs should be /Refxxx/tamps62. The script now takes the

TOPDIR as an argument. Script is executed from root crontab.

- Also removed obsolete build scripts from /tamps/bin and checked in new Tamps62 Harvest build scripts; bld62_recovery.csh and

bld62.

Items:

------

tamps/bin/bld62

tamps/bin/bld62_recovery.csh

tamps/bin/buildAllTAMPS.csh

tamps/bin/buildCleanTAMPS.csh

tamps/bin/buildPure.csh

tamps/bin/buildTAMPS.csh

tamps/bin/cm_make_script.csh

tamps/bin/rootAccess.sh

===================================================================

DTR:     D10058

SOR/STR: 6216

Title:   Geo Filter Widget Resize

Description:

The Geo Filter widget cannot be resized.  It should be resizable and when resized, the list boxes should be made larger both in length and width.  Currently, if a Geo has a name longer than 26 characters the complete name cannot be viewed since there are no horizontal scroll bars.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geo.c

tamps/src/libs/dbase/dmt/dmt_geoMMI.c

===================================================================

DTR:     D10059

SOR/STR: 6216

Title:   Geo Filter Cancel

Description:

When a user selects the Geo Pushbutton or selects Display-> Geo Filter-> Rectangle, Circle, or Polygon and then pushes the right mouse button, the Create Geo function should be canceled.

Instead  a  bogus geo named "CURRENT_GEO" is added to the Selectable Geos list.  If this action is repeated, the error message:  "CURRENT_GEO will be removed (if deleting) or overwritten (if editing).  Continue?" is displayed.  Selecting YES continues with creating a new bogus geo which replaces the other bogus geo.  Selecting NO displays error message:  "Geo with name CURRENT_GEO exists.  Please rename geo with a name other than CURRENT_GEO."  It is obviously impossible to rename the geo since there is no HMI to do so.

Items:

------

===================================================================

DTR:     D10060

SOR/STR: 6216

Title:   DBA and MPM Creating Geos concurrently

Description:

If an MPM user and the DBA are concurrently creating geos and the same name is used for a geo by both, the MPM user is not warned of his/her geo being overwritten by the DBA geo and given the opportunity to rename their geo.  This occurs because the database is not searched for geo name conflicts whenever a new geo is being created.

Items:

------

===================================================================

DTR:     D10061

SOR/STR: 6216

Title:   Geo Filter Menu Logic

Description:

The "Display", "Declutter" and "New Geo" functions are still not

completely correct.

When two or more items are selected from the Selectable Geos list,

and if all items are currently displayed, "Display" should be insensitive

but is actually sensitive.

If two or more items are selected from the Selectable Geos list and all

items are NOT displayed, "Declutter" should be insensitive but is actually

sensitive.

If two or more geos are selected from the Selectable Geos list, user

cannot create a new geo.

This DTR is an extension of DTR D10013.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10062

SOR/STR: SOR 96-10

Title:   Update GPS On-Line Almanac ftp script

Description:

The gps_ftp.dat file needs to be updated to specify the path of the almanac file that is to be downloaded.

Items:

------

tamps/src/apps/dbase/Makefile

tamps/src/scripts/dbase/scripts/gps_ftp.dat

===================================================================

DTR:     D10063

SOR/STR: SOR-95-43

Title:   User accounts can't open MPMs

Description:

Due to Solaris 2.5.1 patches, TAMPS users are not able to successfully start MPMs, even with NIS+ at run level 0, due to credentials being created with a non-login password.

Items:

------

tamps/src/scripts/zsystem/zet_credentialuser.sh

===================================================================

DTR:     D10065

SOR/STR: SOR 95-47

Title:   Remove sa password prompt from zet_uadmin

Description:

In build 2, the sybase sa password has been hardcoded, so we need to remove the prompt for the sa password from zet_uadmin.

Items:

------

tamps/src/apps/zsystem/zet/zet_main.c

tamps/src/apps/zsystem/zet/zet_pswdcb.c

===================================================================

DTR:     D10066

SOR/STR: 6.2 init

Title:   Comms Applications not building in harvest environment

Description:

The Comms applications are not building correctly under the new harvest environment.

SOT Step 95-43.1

Items:

------

tamps/src/apps/comms/cnl_DIRscan/cnl_grid/Makefile

tamps/src/apps/comms/cnl_DIRscan/cnl_ovly2/Makefile

tamps/src/apps/comms/col_IOlh_CDBS/Makefile

tamps/src/apps/comms/config/IPgen_license

tamps/src/apps/comms/config/srim

===================================================================

DTR:     D10067

SOR/STR: 6698

Title:   Kneeboard Card Load/Save/ReOrder

Description:

The Load/Save and ReOrder functions do not operate in the new Default Kneeboard Card HMI.

Items:

------

===================================================================

DTR:     D10068

SOR/STR: SOR 96-52

Title:   PC-Card Go/NoGo not implemented.

Description:

The Go/NoGo functionality for PC-Card is not completed.

Items:

------

tamps/src/libs/util/upl/Make_GoNoGo

tamps/src/libs/util/upl/Makefile

tamps/src/libs/util/upl/upl_GoNoGo.c

tamps/src/scripts/gonogo/tgl_config_script.csh

===================================================================

DTR:     D10069

SOR/STR: SOR 95-47

Title:   grant_privs.csh

Description:

Added grant_privs.csh to make_scripts to support changes in SOR-95-47.

Items:

------

tamps/src/dbinstall/security/make_scripts

===================================================================

DTR:     D10070

SOR/STR: SOR 95-47

Title:   MPM DD_MPMTABS data

Description:

After loading build 2, opened a non-poly MPM (AH-1W) and input a launch pt then OK out of launch window. Then got messages about cannot perform constant cruise and DD_MPMTABS data not loaded.  Therefore could not plan a basic route in MPM. Tried in F-14D and it worked OK.

Items:

------

===================================================================

DTR:     D10071

SOR/STR: SOR 95-47

Title:   DAFIF data load crashed DBA

Description:

Selected DAFIF to load in DBA utilities and after input date and classification selected Apply and then the DBA module crashed. Can not load DAFIF data. Almanac and MagVar loaded OK from CD.

Items:

------

tamps/src/libs/dbase/dlt/dlt_dafif.c

tamps/src/libs/dbase/dut/dut_drmcb.c

===================================================================

DTR:     D10072

SOR/STR: SOR 95-47

Title:   Add User account errors

Description:

In the User Admin after creating an account "whale" , I attempted to create another with username "whale2" and received a message user ID already exists. I exited the User Admin tool and opened it again and then could create the "whale2" account

Items:

------

tamps/src/apps/zsystem/zet/zet_userMMIcb.c

tamps/src/libs/zsystem/zrt/zrt_rolesio.c

tamps/src/scripts/zsystem/zet_adduser.sh

===================================================================

DTR:     D10073

SOR/STR: SOR 95-47

Title:   Data Removal tool not starting

Description:

In DBA when select utilities Data removal nothing happens. The next window does not come up.

Items:

------

===================================================================

DTR:     D10074

SOR/STR: SOR 95-47

Title:   Object Server connect problems

Description:

After starting a DBA, loaded magvar, almanac& DAFIF, then try to open an MPM it just brings up the application info window. The mpm process is running when checked in a shell. If the ost_server is killed using kill -9 then the MPM window comes up. The ost_server can then be restarted using the startup scripts. The other option is to reboot the system after using a DBA Module.

Items:

------

===================================================================

DTR:     D10075

SOR/STR: SOR 96-01

Title:   Updte Map Catalog

Description:

After loading build 2 and selecting the preserve maps option, I attempted to use the update maps catalog function to update some preserved DTED data. The following msg was displayed: "dnt_mapCatalogApplyCb cannot open dted directory".

Items:

------

===================================================================

DTR:     D10076

SOR/STR: SOR 95-43

Title:   Update Sysgen for Build 3

Description:

Incorporate Sysgen updates required for Build 3, including COTS updates, MPLAN support and MIDB updates

Items:

------

sysgen/Doc/README.DOC

sysgen/Doc/install_instructions.msw

sysgen/cots/sparc/README.cots

sysgen/cots/sparc/fore/fore.tgz

sysgen/cots/sparc/gnu.src/perl/perl5.001/changes.perl5.001/Std.pm

sysgen/cots/sparc/gnu.src/perl/perl5.001/changes.perl5.001/getopts.pl

sysgen/cots/sparc/gnu.src/perl/perl5.001/perl5.001.pat.gz

sysgen/cots/sparc/gnu.src/perl/perl5.001/perl5.001.tar.gz

sysgen/cots/sparc/jnl/jnl.tgz

sysgen/cots/sparc/metacard/metacard.tgz

sysgen/cots/sparc/midb/midb.tgz

sysgen/cots/sparc/os_packages/os_packages.tgz

sysgen/cots/sparc/patches/103461-17.tar.gz

sysgen/cots/sparc/patches/103461-18.tar.gz

sysgen/cots/sparc/patches/103558-07.tar.gz

sysgen/cots/sparc/patches/103558-10.tar.gz

sysgen/cots/sparc/patches/103566-19.tar.gz

sysgen/cots/sparc/patches/103566-21.tar.gz

sysgen/cots/sparc/patches/103582-10.tar.gz

sysgen/cots/sparc/patches/103582-14.tar.gz

sysgen/cots/sparc/patches/103582-15.tar.gz

sysgen/cots/sparc/patches/103594-10.tar.gz

sysgen/cots/sparc/patches/103600-14.tar.gz

sysgen/cots/sparc/patches/103600-18.tar.gz

sysgen/cots/sparc/patches/103612-23.tar.gz

sysgen/cots/sparc/patches/103612-26.tar.gz

sysgen/cots/sparc/patches/103612-33.tar.gz

sysgen/cots/sparc/patches/103630-06.tar.gz

sysgen/cots/sparc/patches/103630-09.tar.gz

sysgen/cots/sparc/patches/103640-08.tar.gz

sysgen/cots/sparc/patches/103640-12.tar.gz

sysgen/cots/sparc/patches/103663-07.tar.gz

sysgen/cots/sparc/patches/103663-08.tar.gz

sysgen/cots/sparc/patches/103690-05.tar.gz

sysgen/cots/sparc/patches/103743-01.tar.gz

sysgen/cots/sparc/patches/103866-02.tar.gz

sysgen/cots/sparc/patches/103866-03.tar.gz

sysgen/cots/sparc/patches/103879-04.tar.gz

sysgen/cots/sparc/patches/103901-06.tar.gz

sysgen/cots/sparc/patches/103934-04.tar.gz

sysgen/cots/sparc/patches/103934-05.tar.gz

sysgen/cots/sparc/patches/103959-03.tar.gz

sysgen/cots/sparc/patches/103959-05.tar.gz

sysgen/cots/sparc/patches/104331-02.tar.gz

sysgen/cots/sparc/patches/104331-03.tar.gz

sysgen/cots/sparc/patches/104331-04.tar.gz

sysgen/cots/sparc/patches/104338-02.tar.gz

sysgen/cots/sparc/patches/104433-03.tar.gz

sysgen/cots/sparc/patches/104433-04.tar.gz

sysgen/cots/sparc/patches/104516-03.tar.gz

sysgen/cots/sparc/patches/104654-02.tar.gz

sysgen/cots/sparc/patches/104654-03.tar.gz

sysgen/cots/sparc/patches/104708-02.tar.gz

sysgen/cots/sparc/patches/104708-06.tar.gz

sysgen/cots/sparc/patches/104735-02.tar.gz

sysgen/cots/sparc/patches/104736-01.tar.gz

sysgen/cots/sparc/patches/104736-03.tar.gz

sysgen/cots/sparc/patches/104795-02.tar.gz

sysgen/cots/sparc/patches/104956-02.tar.gz

sysgen/cots/sparc/patches/104958-01.tar.gz

sysgen/cots/sparc/patches/104960-01.tar.gz

sysgen/cots/sparc/patches/104968-01.tar.gz

sysgen/cots/sparc/patches/105004-03.tar.gz

sysgen/cots/sparc/patches/105050-01.tar.gz

sysgen/cots/sparc/patches/105251-01.tar.gz

sysgen/cots/sparc/patches/README.PatchReport_aug97

sysgen/cots/sparc/patches/README.PatchReport_jul97

sysgen/cots/sparc/patches/README.PatchReport_sep97

sysgen/cots/sparc/patches/README.patches62_jul97

sysgen/cots/sparc/rep_server/rep_server.tgz

sysgen/cots/sparc/sybase/sybase.tgz

sysgen/cots/sparc/sybase/sybase11.0.2.tgz

sysgen/cots/sparc/xerox/xerox.tgz

sysgen/src/arctic/data/accounts_os.dat

sysgen/src/arctic/data/config_prompts.dat

sysgen/src/arctic/data/database_config.dat

sysgen/src/arctic/data/directories.dat

sysgen/src/arctic/data/disk_slices.dat

sysgen/src/arctic/data/env_updates.dat

sysgen/src/arctic/data/file_copy.dat

sysgen/src/arctic/data/file_permissions.dat

sysgen/src/arctic/data/make_data

sysgen/src/arctic/data/menu_mods.dat

sysgen/src/arctic/data/packages_os.dat

sysgen/src/arctic/data/patches_os.dat

sysgen/src/arctic/data/share_files.dat

sysgen/src/arctic/data/startup_scripts.dat

sysgen/src/arctic/data/symbolic_links.dat

sysgen/src/arctic/data/system_config.dat

sysgen/src/arctic/lib/make_lib

sysgen/src/arctic/lib/ssb_AtmInstall.pm

sysgen/src/arctic/lib/ssb_CompassCOTS.pm

sysgen/src/arctic/lib/ssb_DBInstall.pm

sysgen/src/arctic/lib/ssb_Directories.pm

sysgen/src/arctic/lib/ssb_DiskSlices.pm

sysgen/src/arctic/lib/ssb_EnvUpdates.pm

sysgen/src/arctic/lib/ssb_InstallMIDB.pm

sysgen/src/arctic/lib/ssb_LoadSoftware.pm

sysgen/src/arctic/lib/ssb_MenuUpdates.pm

sysgen/src/arctic/lib/ssb_OsAccounts.pm

sysgen/src/arctic/lib/ssb_OsInstall.pm

sysgen/src/arctic/lib/ssb_OsSetup.pm

sysgen/src/arctic/lib/ssb_PrinterInstall.pm

sysgen/src/arctic/lib/ssb_ShareFiles.pm

sysgen/src/arctic/lib/ssb_StartupScripts.pm

sysgen/src/arctic/lib/ssb_SysgenInit.pm

sysgen/src/arctic/lib/ssb_SysgenPrompt.pm

sysgen/src/arctic/lib/ssb_SystemReboot.pm

sysgen/src/arctic/scripts/arctic.csh

sysgen/src/arctic/scripts/arctic_1.prl

sysgen/src/arctic/scripts/arctic_2.prl

sysgen/src/arctic/scripts/crypt.prl

sysgen/src/arctic/scripts/uaddr.prl

sysgen/src/arctic/scripts/ucb/xsetaccel

sysgen/src/arctic/skel/common/.cshrc

sysgen/src/arctic/skel/midb/.cshrc

sysgen/src/arctic/skel/midb/make_scripts

sysgen/src/arctic/skel/root/.cshrc

sysgen/src/arctic/skel/shutdown/.xinitrc

sysgen/src/cm_tools/cm_build/Makefile

sysgen/src/cm_tools/cm_build/make_readme

sysgen/src/cm_tools/cm_build/make_scripts

sysgen/src/cm_tools/cm_build/ssb_CoreMakeUtils.pm

sysgen/src/cm_tools/env/arctic_cm.env

sysgen/src/cm_tools/lib/ssb_CmSysgenInit.pm

sysgen/src/cm_tools/media_generation/ByteCompare.prl

sysgen/src/cm_tools/media_generation/CdromCut.prl

sysgen/src/cm_tools/media_generation/CoreMedia.prl

sysgen/src/cm_tools/media_generation/README.CDR_GEN

sysgen/src/cm_tools/media_generation/README.SRC

sysgen/src/cm_tools/media_generation/README.TAPE_GEN

sysgen/src/cm_tools/media_generation/make_readme

sysgen/src/common/data/README.DATA

sysgen/src/common/data/core_tarsets.dat

sysgen/src/common/data/sysgen_environment.dat

sysgen/src/common/data/valid_values.dat

sysgen/src/common/lib/ssb_AppUtils.pm

sysgen/src/common/lib/ssb_CdromUtils.pm

sysgen/src/common/lib/ssb_DataFileUtils.pm

sysgen/src/common/lib/ssb_NetworkTools.pm

sysgen/src/common/lib/ssb_PerlUtils.pm

sysgen/src/common/lib/ssb_PromptUtils.pm

sysgen/src/common/lib/ssb_ShellUtils.pm

sysgen/src/common/lib/ssb_StatusDots.pm

sysgen/src/common/lib/ssb_SysgenEnvUtils.pm

sysgen/src/common/lib/ssb_SystemUtils.pm

sysgen/src/common/lib/ssb_TapeUtils.pm

sysgen/src/common/lib/ssb_TarSetUtils.pm

sysgen/src/common/lib/ssb_ValidConfig.pm

sysgen/src/common/lib/ssb_VersionData.pm

sysgen/src/dev_tools/ssb_read_data_file.prl

tamps/bin/refdir_makeskel.prl

tamps/env/tamps.env.dev

tamps/src/data/environment/tamps.env

tamps/src/data/wse/help.menu

===================================================================

DTR:     D10077

SOR/STR: SOR 96-01

Title:   No Default MPM

Description:

Default MPMs are not being saved correctly with user accounts.  Default MPMs do not launch when the user logs into the system.  It appears that the .tamps.default_mpm file in the home directory is not being written to correctly.

Items:

------

tamps/src/apps/zsystem/zet/zet_userMMI.c

===================================================================

DTR:     D10078

SOR/STR: SOR 96-01

Title:   NITF Imagery Load

Description:

When several NITF images are selected from an 8 mm tape for load, only the first image gets an entry in the sybase imagery table.  All other image files are being loaded to the maps directory, but can not be accessed through the background tool.

Items:

------

tamps/src/libs/tms/tit/tit_getImageryFiles.c

tamps/src/libs/tms/tit/tit_imagery.c

===================================================================

DTR:     D10079

SOR/STR: SOR 96-01

Title:   Can't Display Unrectified Imagery

Description:

Unrectified NITF images can not be displayed.  When an unrectified image entry is selected in the background tool, and OK is selected, nothing happens.

Items:

------

===================================================================

DTR:     D10080

SOR/STR: 6.2 init

Title:   sysgen_initialization (.files)

Description:

sysgen_initialization was created for the initial load of the Sysgen

baseline into the Harvest CM system. Harvest does not support

baseline load of ".", or hidden, files. Currently, the only method of

entering "." files is to check them in recursively, which requires a

package.

Items:

------

sysgen/src/arctic/skel/common/.cshrc

sysgen/src/arctic/skel/common/.login

sysgen/src/arctic/skel/common/.logout

sysgen/src/arctic/skel/etc/.tamps.cshrc

sysgen/src/arctic/skel/midb/.cshrc

sysgen/src/arctic/skel/midb/.login

sysgen/src/arctic/skel/midb/.logout

sysgen/src/arctic/skel/root/.OWdefaults

sysgen/src/arctic/skel/root/.Xdefaults

sysgen/src/arctic/skel/root/.cshrc

sysgen/src/arctic/skel/root/.login

sysgen/src/arctic/skel/root/.logout

sysgen/src/arctic/skel/root/.mwmrc

sysgen/src/arctic/skel/root/.xinitrc

sysgen/src/arctic/skel/shutdown/.mwmrc

sysgen/src/arctic/skel/shutdown/.profile

sysgen/src/arctic/skel/shutdown/.xinitrc

sysgen/src/arctic/skel/tamps/.tamps.default_mpm

sysgen/src/arctic/skel/tamps/.tamps.privs

sysgen/src/arctic/skel/tamps/.tamps.roles

===================================================================

DTR:     D10081

SOR/STR: 6.2 Init

Title:   Audit Log empty

Description:

Turned audit function on and selected all event types. Rebooted system and then ran for over an hour. There were log files in /var/audit, about one every two hours, and /var/audit was up to about 10% full. When select Review Audit logs and select Primary file, get a message "No records in audit log.".

Items:

------

===================================================================

DTR:     D10082

SOR/STR: 6.2 Init

Title:   Audit Admin defaults

Description:

The audit admin function is now defaulted to ON vice OFF as it was in 6.1.1.

Items:

------

sysgen/src/arctic/lib/ssb_OsSetup.pm

===================================================================

DTR:     D10083

SOR/STR: 6.2 Init

Title:   SIT_Default_Defines Mismatch

Description:

The standard menu items in the sit_default_defines header file are not the same as the standard menu items in the SIT_DEFAULT_DEFINES Ada binding.

Items:

------

===================================================================

DTR:     D10084

SOR/STR: 6698

Title:   New Kneeboard Card

Description:

When open the new kneeboard card output>route kneeboard card> kneeboard card,  the window is coming up under the wse bar. Reposition the widget so that it does not under the wse.

Items:

------

===================================================================

DTR:     D10085

SOR/STR: SOR 96-01

Title:   E2C MPM symbol sets

Description:

The E2C symbols are not coming up in the MPM. Even when selected via the Display> Change Symbology function. It looks like symbol set is loaded in the appropriate /tamps/static/.... dir but something not setting the objects correctly. Note! The F14 symbols work OK

Items:

------

===================================================================

DTR:     D10086

SOR/STR: E2C

Title:   E2C EMDU Save Crashes

Description:

In E2C MPM when tried to save an EMDU file the MPM crashed.

Items:

------

===================================================================

DTR:     D10087

SOR/STR: 6216

Title:   Deleting  GEO's crashes the module

Description:

When you select two or more GEO's to be deleted in the GEO Filter and then the confirmation window is displayed and you select Yes or No, the DBA Module/Aircraft MPM's will crash.   The GEO's are deleted.

Items:

------

===================================================================

DTR:     D10088

SOR/STR: SOR 96-01

Title:   Periodic query crashes module

Description:

DBA Module/Aircraft MPM's select -> Display -> Query for an object -> and then in  Clutter/Declutter -> highlight Layers -> highlight Buckets: select Periodic and set the time and then select Color By or Count By in Clutter/Declutter and this will crash the modules. This did not crash in build 1A.

Items:

------

tamps/include_prot/reports/rcl_prot_proto.h

tamps/src/libs/reports/include/rcl_CountByWindow.h

tamps/src/libs/reports/include/rcl_priv_proto.h

tamps/src/libs/reports/rcl/rcl_CountBy.c

tamps/src/libs/reports/rcl/rcl_CountByBucket.c

tamps/src/libs/reports/rcl/rcl_CountByDrawingArea.c

tamps/src/libs/reports/rcl/rcl_CountByOperations.c

tamps/src/libs/reports/rcl/rcl_CountByWindow.c

tamps/src/libs/reports/rcl/rcl_CountByWindowCallbacks.c

tamps/src/libs/reports/rcl/rcl_CountByWindowHandlers.c

===================================================================

DTR:     D10089

SOR/STR: 6698

Title:   Report threat assessment crash

Description:

Aircraft MPM's Select File -> Create New or old Msn -> Route -> Launch/Recovery and create the msn . Select Output -> Rpts -> Aircrew -> Threat Assessment and then select create and the Aircraft MPM's will crash.

Items:

------

tamps/src/libs/products/prl/prl_aircrew_bind.c

===================================================================

DTR:     D10090

SOR/STR: E2C

Title:   E2C TID not Initializing

Description:

In E2C selected Output>TID Processing and get message "Unable to initialize TID."  In errors log it shows "Device invalid".

Items:

------

===================================================================

DTR:     D10091

SOR/STR: SOR 95-47

Title:   Strike Package not Saving

Description:

Could not save a Strike package. Get error msg "The strike package was not saved properly."

Items:

------

tamps/src/libs/a_msn_plan/adt/adt_strpkg.c

===================================================================

DTR:     D10092

SOR/STR: 6.2 Init

Title:   Line of Sight function not working

Description:

The line of sight tool under Weaponeering>Radar Prediction is not working. After inputting the data in  the Line of Sight window and Apply or OK, get a msg "Error generating Field of View. See System Log for details." In the Workstation log it just says Error performing LOS calculations for Field of View.

Items:

------

===================================================================

DTR:     D10093

SOR/STR: 6698

Title:   Reports New KCARD

Description:

Aircraft MPM's -> File -> create new msn or use old msn -> Route -> Launch/Recovery and create the new msn -> select Output -> Reports -> Aircrew -> Platform Performance Rpt -> and then if you try to select Kneeboard Card (KCARD)  it will not display.   You have to close out the Aircraft MPM and then reopen the Aircraft MPM and reselect the msn to select the KCARD.

Items:

------

tamps/src/libs/products/prl/prl_create_kneeb_format.c

tamps/src/libs/products/prl/prl_filter_util.c

===================================================================

DTR:     D10094

SOR/STR: 6698

Title:   Report New KCARD output to printer

Description:

Aircraft MPM's -> Output -> Reports -> Aircrew -> Kneeboard Card (KCARD) -> the KCARD is displayed -> select output -> the only msg that is displayed is:Route Kneeboard Card has been sent to the printer.   This process just sent the Kneeboard Card to the printer.   Where is the Output Printer Data Window?

Items:

------

===================================================================

DTR:     D10096

SOR/STR: 3660

Title:   DBA Crash Loading NITF

Description:

The DBA Module crashes after completing the load of ADRI or NITF from 8 mm.

STR 3660 Failure.

Items:

------

===================================================================

DTR:     D10097

SOR/STR: 6214

Title:   No Default in Launch Details Dialog

Description:

STR 6214 asked for a default button as part of the rework for the Launch Details dialog, but this was not implemented.

STR 6214 Failure

Items:

------

tamps/src/libs/a_msn_plan/ait/ait_CreateLaunchDetailsDialog.c

tamps/src/libs/a_msn_plan/ait/ait_LaunchDetailsCb.c

===================================================================

DTR:     D10098

SOR/STR: SOR 96-01

Title:   Typographical problem in sit_default_defines.h

Description:

In sit_default_defines.h, the constants MPM_SETUP_DEFAULTS_SCENARIOS_BUTTON and

MPM_SETUP_DEFAULTS_SCENARIOS_CALLBACK are both #defined as (FILE_TOTAL+24).  MPM_SETUP_DEFAULTS_SCENARIOS_CALLBACK

should be defined as (FILE_TOTAL+25).

Items:

------

===================================================================

DTR:     D10099

SOR/STR: SOR 96-01

Title:   Ada Binding Not Synchronized With C Header File

Description:

The Ada binding file sit_default_defines.a does not align with the C header file

sit_default_defines.h.  The misalignment is causing segmentation violations

in the Ada MPMs.

Items:

------

===================================================================

DTR:     D10100

SOR/STR: SOR 96-52M

Title:   PC Card Declassify (pcscrub utility)

Description:

When an attempt is made to declassify a PC card in either slot using the pcscrub utility, the card appears to be declassified since no error message is displayed after the utility finishes.  When you try accessing the card after scrubbing it using pcls, pcdf or any other utility besides pcformat, get error message "error = 0x011".  After reformatting the card, it works ok.

Items:

------

===================================================================

DTR:     D10101

SOR/STR: SOR 96-52M

Title:   PC Card Format

Description:

Sometimes when formatting a PC card when there is a card in both slots, the formatting process will either fail and provide an error message or freeze up.  When the process freezes up, you cannot kill the process with the Sys Admin Process Manager, from the shell with kill -9, or by logging out.  The only way to kill the frozen format process is to reboot the system.  This happens on an intermittent basis.

Items:

------

===================================================================

DTR:     D10102

SOR/STR: SOR 96-52M

Title:   PC card Format Failure

Description:

If a PC card format process fails, the files that were on the card are garbled but the directory still indicates that there are valid files on the card by listing the file names.

Items:

------

===================================================================

DTR:     D10103

SOR/STR: SOR 96-52M

Title:   PC Card File Copy

Description:

If you attempt to copy a file to a PC card which does not have enough free space to receive the file, the utility pccp will start writing the file to the card but will display an error message when the card gets full.  (Could be a pccp utility problem.)

Items:

------

tamps/src/libs/util/upl/TestCopy.c

tamps/src/libs/util/upl/TestListFiles.c

tamps/src/libs/util/upl/upl_Close.c

tamps/src/libs/util/upl/upl_Open.c

tamps/src/libs/util/upl/upl_Read.c

===================================================================

DTR:     D10104

SOR/STR: 6.2 init

Title:   Audit log fills up with no warnings

Description:

In audit admin I turned auditting on and selected all events. At COB Thurs /var/audit was at about 50%.  After a long weekend, I logged in Monday and there was a message in console about "error softlimit". Checked /var/audit and it was at 99%, the only alerts were green ones related to new audit files. This was fixed in 6.1.1 under STR 6709. Maybe the new COTS or sysgen broke it. Note! This was on "wisconson" with the patch from Rob to get audit to work.

SOT Step 95-43.1

Items:

------

sysgen/src/arctic/data/file_copy.dat

sysgen/src/arctic/data/file_permissions.dat

===================================================================

DTR:     D10105

SOR/STR: 6.2 init

Title:   Saving FAMP data is not working for planner

Description:

As user planner selected from the WSE_BAR -> Mission Planning -> Weapons -> FAMP: File New Msn -> Route -> UMPM and entered selected data and then selected DELTAC and entered data.   Tried to save msn and could not save msn as planner.   The workstation log:INSERT Permission denied on object DELTAC_MISSION_PLAN, databsae tamps, owner dbo.

SOT Step 95-43.1

Note! Problem occurs when logged in using an account with MPM role only.

Items:

------

tamps/src/dbinstall/security/grant_privs.pl

===================================================================

DTR:     D10106

SOR/STR: 6.2 init

Title:   Reports crash

Description:

Aircraft MPM -> File new msn or old msn -> Output -> Reports -> Aircrew -> and by selecting the Load and Drop Report where data is displayed in window or not and then close the Load and Drop Report, and then by selecting the kneeboard Card this will crash the Aircraft MPM.

SOT Step 95-43.1

Items:

------

===================================================================

DTR:     D10107

SOR/STR: SOR 96-10

Title:   SIPRNET Login Failed

Description:

In test lab set up one of the Ultras to emulate the SIPRNET. I could ping siprnet and when bring up the On-Line Update window it shows SIPRNET as being up. However, when select Download Almanac it gives an error message saying the download failed. In errors log it looks like it is looking for a USER and PASS for the login.

Items:

------

===================================================================

DTR:     D10108

SOR/STR: 6.2 init

Title:   Chart Removal

Description:

Can not remove a chart from the system. Installed an ADRG ONC chart for an area that didn't have any charts loaded.  All indications in the data removal dialog box indicated that the chart was removed.  After this, the chart could still be displayed and all data remained intact in the /maps/1 directory.

Items:

------

tamps/src/libs/dbase/dut/dut_mapCb.c

===================================================================

DTR:     D10109

SOR/STR: 6.2 init

Title:   GO/NO GO

Description:

GO/NO GO tests currently in 6.2 build 2 is from the DTC (150 MB tape and 5 1/4 inch floppy Disk Drive, etc) and not for the Ultra-2.

Items:

------

sysgen/src/arctic/lib/ssb_InstallGONOGO.pm

sysgen/src/arctic/scripts/arctic_2.prl

===================================================================

DTR:     D10110

SOR/STR: SOR 96-10

Title:   GPS Almanac Update, No Delete

Description:

In a DBA selected Update>GPS Almanac> Manual Update and  attempted to delete an old almanac file. Kept getting  Warning that "cannot delete last week from almanac". I had three weeks loaded at the time, weeks 154, 161, and 162. Attempting to delete any of them gave the same results.

Items:

------

tamps/src/apps/appgen/dpl/dpl_format.c

tamps/src/apps/appgen/dpl/dpl_utils.c

===================================================================

DTR:     D10111

SOR/STR: SOR 95-47

Title:   Two complete loads of DAFIF.

Description:

Tried to load  two complete Versions of DAFIF, and received the following msg:Can't allocate space for objects in the database 'DAFIF_GPS' because the 'default' segment is full.

Items:

------

===================================================================

DTR:     D10112

SOR/STR: SOR 95-47

Title:   DAFIF Update Delete not working and crashes DBA Module.

Description:

DBA module -> Update -> DAFIF Tear-off Window:Select/Delete -> and the DAFIF Version Window for Selection and Deletion option is displayed.    Then by selecting delete and selecting apply or ok crashes the DBA Module and does not delete the DAFIF Version.   The Workstation Log had the following msg:DB-Library error

Maximum number of DBPROCESSes already allocated.

ddt_mmi Terminated by System Fault 65280.

Items:

------

===================================================================

DTR:     D10113

SOR/STR: SOR 95-47

Title:   One time DAFIF/GPS window

Description:

DBA Module -> Output -> Database Usage Tear-off Window -> Databases -> DAFIF/GPS: Confirm Operation Window -> OK the DAFIF/GPS window is only displayed one time and if you try to query for it a second time the tamps database window is displayed.   You have to close out the DBA Module and reopen the DBA Module again and reselect the DAFIF/GPS Usage tool.

Items:

------

tamps/src/libs/dbase/dut/dut_dbucb.c

===================================================================

DTR:     D10115

SOR/STR: SOR 95-43

Title:   Dynamic Menu Stability Issue

Description:

Public function sit_init allocates a dynamic menu table of predefined length.  It returns a pointer to this table, after storing a copy in a global variable, SIT_table.   The Ada MPMs take the table  pointer and pass it to umt_ResizeTable.  This function allocates a new (larger) table, copies the old table to the new one, then frees the old one.  It then returns the pointer to the new table.  But freeing the old pointer wipes out the memory to which the global variable SIT_table points.  The problem is that sit_ungrayTemp, which is called by mpt_initialExposeCB, tries to manipulate widgets from the contents of SIT_table.  Since Ada code executed subsequent to the call to umt_ResizeTable may have overwritten that "free" memory, the MPM crashes with a segmentation violation.

Items:

------

tamps/src/libs/util/umt/umt_menu.c

===================================================================

DTR:     D10116

SOR/STR: SOR 95-43

Title:   Ada Package Unsigned Enhancement

Description:

The introduction of package BASE_TYPES as the basis for definitions of pointer types in package UNSIGNED has effecively masked the equality operators for those data types.  Types so affected are SHORT_INTEGER_PTR, SHORT_INTEGER_PTR2, SHORT_INTEGER_PTR3, INTEGER_PTR, INTEGER_PTR2, INTEGER_PTR3, FLOAT_PTR, FLOAT_PTR2, FLOAT_PTR3, SHORT_FLOAT_PTR, SHORT_FLOAT_PTR2, and SHORT_FLOAT_PTR3.  The equality operators need to be declared locally as renames of the equivalent BASE_TYPES operators in order to have them visible as members of UNSIGNED.

Items:

------

tamps/src/bindings/unsigned.a

===================================================================

DTR:     D10117

SOR/STR: 6216

Title:   Multiple Geo Delete

Description:

If the DBA attempts to delete 2 or more Geos at the same time, ddt_mmi crashes.

Items:

------

tamps/src/libs/dbase/dmt/dmt_gdelete.c

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10118

SOR/STR: 6216

Title:   Current Geo Setting

Description:

When a new Geo is created by the DBA or an MPM user, it becomes the current Geo.  When the newly created Geo is selected from the Selectable Geos list and "New Geo" option menu is selected, "Current" is sensitive but should not be.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10119

SOR/STR: 6216

Title:   Geo Name Matching

Description:

In an MPM or DBA, create a new Corridor or Polygon Geo and choose a name that exists in the DB.  When trying to save, get a warning to rename but if you rename and attempt a save to DB, another warning is displayed about selecting points from the map.  This means you have to start over and can't use the points already chosen.  This also applies if you try to rename an existing Corridor or Polygon Geo.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10120

SOR/STR: 6216

Title:   Create Geo cancel

Description:

If you try to create a geo using the toolbar icon or from the Display pull-down menu and then try to create another one using the same method, get Delete confirmation warning.  If you select No, get error message:  "Geo with name CURRENT_GEO exists.  Please rename..."  This message should not be displayed after cancelling the create.

Items:

------

tamps/src/libs/dbase/dmt/dmt_gdelete.c

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10123

SOR/STR: 6216

Title:   Geo Edit

Description:

When editing a planner Geo from the DBA, system allows the DBA to save a Geo with the same name since a "*" is placed before the name.  This causes problems displaying, etc.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10124

SOR/STR: 6216

Title:   Deleting Geos

Description:

When deleting a geo, the functionality is correct but the messages are confusing.  The following messages are displayed:

a)  if the Geo is not displayed or is displayed but not current, get the Delete Geo Confirm dialog box and the Geo Filter Delete box at same time.  Should not get the Geo Filter Delete box unless YES is selected.

b)  if Geo is displayed and current, get Delete Geo Confirmation dialog box and Message window saying Selected Geo does not exist.  Should not get the Message window at all.

Items:

------

===================================================================

DTR:     D10125

SOR/STR: SOR 96-60A

Title:   Count By Function window coupling

Description:

In count By Function, if you select an item in the middle of the list box , hold down the shift key, and select an item of lower value, all items are highlighted in between the two both on the map and in the list box.  If you hold down the shift key and select an item of higher value than the first item selected, without deselecting the other highlighted items, all items between the first item selected and the high value item are highlighted on the map.  However, all items between the lowest value and highest value selected are highlighted in the Count By window list box.

Items:

------

tamps/src/libs/reports/include/rcl_CountByWindow.h

tamps/src/libs/reports/rcl/rcl_CountByLocalActions.c

tamps/src/libs/reports/rcl/rcl_CountByWindow.c

===================================================================

DTR:     D10126

SOR/STR: 6216

Title:   Multiple Geo select/Display

Description:

If more than one Geo is selected from the Geo list box, then display is selected from the option menu, none of the non-displayed Geos selected will be displayed if the top Geo in the selected list is already displayed.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10127

SOR/STR: SOR 96-60A

Title:   Count By Function Window Migration

Description:

In Count By Function, if the window is the minimum width possible, an attempt to decrease the width by dragging the left side toward the right side moves the window to the right a small amount.

Items:

------

tamps/src/libs/reports/rcl/rcl_CountByWindow.c

tamps/src/libs/reports/rcl/rcl_CountByWindowHandlers.c

===================================================================

DTR:     D10128

SOR/STR: 6216

Title:   Create Geo Blank Field

Description:

If you leave a field blank while manually creating a rectangle or circle Geo, the blank field will be automatically filled in with zeros.  If you try to perform a query using this Geo, nothing is returned.  If you edit the Geo and put in a new value for the zeroed field, there is still no return from a query.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10129

SOR/STR: 6216

Title:   Geo Lat/Long Error

Description:

If you inadvertantly exchange the North and South Latitudes or the East and West Longitudes when manually creating a rectangle Geo, the Geo will appear to be drawn correctly using the North-most entered latitude on top and the west-most entered longitude on the left side and so forth.  If you use this geo to perform a query, nothing is returned.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10130

SOR/STR: 6216

Title:   Geo  Circle Blank Radius

Description:

If you manually create a circle but leave the radius blank, get a warning to please specify value for field Circle Radius but the input fields are insensitive preventing any entry.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10131

SOR/STR: 6.2 init

Title:   C2A MPM not in Build 2

Description:

Need to add C2A MPM to CD for Build 3.

Items:

------

tamps/mpm/Makefile

tamps/mpm/c2a/Makefile

tamps/mpm/c2a/dbinstall/Install_c2a.csh

tamps/mpm/c2a/dbinstall/Makefile

tamps/mpm/c2a/dbinstall/c2a_truncate_table.sql

tamps/mpm/c2a/dbinstall/make_scripts

tamps/mpm/c2a/dbinstall/make_sql

tamps/mpm/c2a/dbinstall/tamps_acft_defs_lmts_insert.c2a.sql

tamps/mpm/c2a/dbinstall/tamps_acft_documents_insert.c2a.sql

tamps/mpm/c2a/gfe_polynomials/Makefile

tamps/mpm/c2a/gfe_polynomials/c2r.fpm

tamps/mpm/c2a/gfe_polynomials/c2r.plm

tamps/mpm/c2a/gfe_polynomials/c2r.pnx

tamps/mpm/c2a/gfe_polynomials/c2r.pxf

tamps/mpm/c2a/gfe_polynomials/c2r.pyf

tamps/mpm/c2a/gfe_polynomials/c2r.xrf

tamps/mpm/c2a/gfe_polynomials/make_data

tamps/mpm/c2a/scripts/Makefile

tamps/mpm/c2a/scripts/cold_start/Makefile

tamps/mpm/c2a/scripts/cold_start/c2a_install_script.csh

tamps/mpm/c2a/scripts/cold_start/c2a_load_tape_script.csh

tamps/mpm/c2a/scripts/cold_start/c2a_remove_files.csh

tamps/mpm/c2a/scripts/cold_start/c2a_remove_script.csh

tamps/mpm/c2a/scripts/cold_start/make_scripts

tamps/mpm/c2a/src/Makefile

tamps/mpm/c2a/src/c2a/Makefile

tamps/mpm/c2a/src/c2a/c2a_error.c

tamps/mpm/c2a/src/c2a/c2a_exit.c

tamps/mpm/c2a/src/c2a/c2a_main.c

tamps/mpm/c2a/src/c2acw/Makefile

tamps/mpm/c2a/src/c2acw/ccw_route_validation.c

tamps/mpm/c2a/src/c2aew/Makefile

tamps/mpm/c2a/src/c2aew/cew_hold_event.c

tamps/mpm/c2a/src/c2aew/cew_validate_event.c

tamps/mpm/c2a/src/c2aiw/Makefile

tamps/mpm/c2a/src/c2aiw/ciw_define_callbacks.c

tamps/mpm/c2a/src/c2aiw/ciw_toolbar_init.c

tamps/mpm/c2a/src/c2amw/Makefile

tamps/mpm/c2a/src/c2amw/cmw_besth_climb.c

tamps/mpm/c2a/src/c2amw/cmw_check_best_speed.c

tamps/mpm/c2a/src/c2amw/cmw_default_flight_mode.c

tamps/mpm/c2a/src/c2amw/cmw_divert_calcs.c

tamps/mpm/c2a/src/c2amw/cmw_eval_mrange.c

tamps/mpm/c2a/src/c2amw/cmw_get_flight_mode.c

tamps/mpm/c2a/src/c2amw/cmw_load_poly.c

tamps/mpm/c2a/src/c2amw/cmw_process_modes.c

tamps/mpm/c2a/src/c2amw/cmw_set_flight_mode.c

tamps/mpm/c2a/src/c2amw/cmw_validate_flight_mode.c

tamps/mpm/c2a/src/include/Makefile

tamps/mpm/c2a/src/include/c2a_error_defs.h

tamps/mpm/c2a/src/include/c2a_errors_general.h

tamps/mpm/c2a/src/include/c2a_flight_modes.h

tamps/mpm/c2a/src/include/c2a_global_defs.h

tamps/mpm/c2a/src/include/c2a_proto.h

===================================================================

DTR:     D10132

SOR/STR: 6.2 init

Title:   Extra Pages on Xerox Printer

Description:

When printing strip charts from the Sparc ULTRA to the Xerox C55 printer, an extra (nearly blank) page is printed out after about every 2 or 3 pages.  The nearly blank pages have something like X123 or 12345 or X2345 patterns on them (printed once at the top of the page).

Items:

------

sysgen/cots/sparc/xerox/xerox.tgz

===================================================================

DTR:     D10133

SOR/STR: 6698

Title:   KCard, missing Mission Name

Description:

The new Kneeboard card in build 2 does not print out the mission name in top left corner like the example provided in the design notebook shows.

Items:

------

tamps/src/libs/products/prl/prl_aircrew_bind.c

===================================================================

DTR:     D10134

SOR/STR: 6698

Title:   KCard Flight Levels wrong

Description:

In the new KCard the altitude MSL is showing up as FL24000 when it should be either 24000M or FL240.

Items:

------

===================================================================

DTR:     D10135

SOR/STR: 6698

Title:   KCard, Missing Date

Description:

The new kneeboard card does not print out the date in the top left block like shown in example.

Items:

------

===================================================================

DTR:     D10136

SOR/STR: 6698

Title:   KCard, leg time is showing 00

Description:

Sometimes the new Kcard shows leg times equal to 00+00+00.

Items:

------

===================================================================

DTR:     D10137

SOR/STR: 6698

Title:   KCard Default data format wrong

Description:

The new KCard does not have the default data in the columns like the example provided by VX-9.

Items:

------

tamps/src/libs/products/prl/prl_aircrew_bind.c

tamps/src/libs/products/prl/prl_initDataItems.c

===================================================================

DTR:     D10138

SOR/STR: 6698

Title:   KCard, default font

Description:

Change default font size to Courier 10, per VX-9.

Items:

------

===================================================================

DTR:     D10139

SOR/STR: 6698

Title:   KCard UTM Coords

Description:

In the kneeboard card the UTM coordinates do not appear to be the correct format.

Items:

------

tamps/src/libs/products/prl/prl_aircrew_bind.c

tamps/src/libs/products/prl/prl_extract_data.c

tamps/src/libs/products/prl/prl_initDataItems.c

===================================================================

DTR:     D10140

SOR/STR: SOR 97-10

Title:   Missing DD_VALID_THREAT_TYPES table

Description:

There were two new files delivered in Build 2 to support the dft_get_order_of_battle function:

dd_valid_threat_types_create.sql and  dd_valid_threat_types_insert.sql.

These files were not added to the Install_datadict.csh file and therefore NEVER get installed on the target system.  Install_datadict.csh needs to be modified to install these files.

There is also a problem with the insert file.  It still uses the IDB table and field names.  It needs to be modified to reflect the new MIDB table and field names.

The affected directory is ../src/dbinstall/data_dict.

Items:

------

tamps/src/dbinstall/data_dict/Install_datadict.csh

tamps/src/dbinstall/data_dict/dd_valid_threat_types_insert.sql

===================================================================

DTR:     D10141

SOR/STR: SOR 96-52M

Title:   upl_Seek problem

Description:

After creating a one megabyte file and then seeking to (one megabyte - 2) bytes, a subsequent two byte write appears at the wrong offset within the file.

Items:

------

tamps/src/libs/util/upl/upl_Seek.c

===================================================================

DTR:     D10142

SOR/STR: SOR 96-68

Title:   bat library source code cleanup

Description:

BAT functionality was removed under SOR-96-68, however,

the code itself was not marked deleted under harvest version

control. This code should not get synched out since it is not being

built.

Items:

------

tamps/include/b_msn_tools/bat_protos.h

tamps/include/b_msn_tools/bat_structs.h

tamps/include/b_msn_tools/bat_waypoints.h

tamps/src/libs/b_msn_tools/bat/Makefile

tamps/src/libs/b_msn_tools/bat/bat_api_funcs.c

tamps/src/libs/b_msn_tools/bat/bat_bucket_handler.c

tamps/src/libs/b_msn_tools/bat/bat_callbacks.c

tamps/src/libs/b_msn_tools/bat/bat_camera_calcs.c

tamps/src/libs/b_msn_tools/bat/bat_coverage.c

tamps/src/libs/b_msn_tools/bat/bat_creation.c

tamps/src/libs/b_msn_tools/bat/bat_init.c

tamps/src/libs/b_msn_tools/bat/bat_obj_class_data.c

tamps/src/libs/b_msn_tools/bat/bat_storage.c

tamps/src/libs/b_msn_tools/bat/bat_utils.c

tamps/src/libs/b_msn_tools/include/bat_defs.h

tamps/src/libs/b_msn_tools/include/bat_priv_protos.h

===================================================================

DTR:     D10143

SOR/STR: SOR 95-43

Title:   mwm crashes

Description:

mwm crashes after a full system modal application is run, and the user moves another window and attempts to update the map display with query results.  Reading the MPM header file while loading MPMs also causes mwm to crash.

Items:

------

tamps/src/apps/wse/wtn/wtn_main.c

tamps/src/apps/wse/wtt/wtt_create.c

===================================================================

DTR:     D10146

SOR/STR: 6698

Title:   KCard Text Overwrites data

Description:

In the new Kneeboard card, when a long text string is entered for a nav point description it overwrites other data on that nav pt line.

Items:

------

===================================================================

DTR:     D10148

SOR/STR: 6755

Title:   Autosave Message Box for Route Validation

Description:

If Route Validation is disabled and Autosave is enabled, a message

box comes up for each autosave asking the user if they want to

validate the route before saving.  This message box should be

eliminated to keep the autosave operation transparent to the user.

Items:

------

tamps/src/libs/a_msn_plan/ait/ait_msnOpenCB.c

tamps/src/libs/a_msn_plan/ait/ait_saveAlarmCB.c

===================================================================

DTR:     D10150

SOR/STR: 6755

Title:   Bitmaps for Route Validation Toolbar Button

Description:

There is no icon for the route validation pushbutton.

Items:

------

tamps/src/data/bitmaps/rteval.xbm

tamps/src/data/bitmaps/rtevalACE.xbm

===================================================================

DTR:     D10151

SOR/STR: SOR 96-10

Title:   On-Line GPS/Automatic Update

Description:

The fix for DTR 10050 was not implemented in the stand-alone executable (dpl_downloadGPSAlmanac) which performs the Automatic/Scheduled GPS download.  Specifically, dpl_downloadGPSAlmanac looks for  the NAVSSI_Host and SIPRNET_Host environment variables.

Items:

------

tamps/src/apps/dbase/dpl/dpl_main.c

===================================================================

DTR:     D10152

SOR/STR: SOR 96-52M

Title:   PC Card Formatting with Cylinder, Head and Sector Information and Quick Format

Description:

After providing a formatted PC Card to TAMMAC it was determined that Cylinder, Head and Sector information must be included in the formatting partition definition in order for the TAMMAC system to use the PC Cards.  Discussions between the TAMPS IPT and TAMMAC resulted in agreement to add this capability to 96-52M in build 3.  It also was decided that a switch would be implemented in the format command to turn off read after write data integrity checking for high capacity TAMMAC map theater cards.

Items:

------

tamps/include/util/upl_defines.h

tamps/include/util/upl_proto.h

tamps/src/devices/ad_hoc/psl/psl.c

tamps/src/libs/util/include/upl_priv_proto.h

tamps/src/libs/util/upl/TestDumpFS.c

tamps/src/libs/util/upl/TestFormat.c

tamps/src/libs/util/upl/upl_FSUtils.c

tamps/src/libs/util/upl/upl_Format.c

tamps/src/libs/util/upl/upl_Remove.c

tamps/src/libs/util/upl/upl_ScrubCard.c

===================================================================

DTR:     D10155

SOR/STR: SOR 97-10

Title:   Failure to Close Sybase Connection

Description:

The tet_getMapFilenames interface failed on the 26th call made to it.  A message saying unable to connect to Sybase server was given.  Discussions with Chuck Ruby determined that previous connections were not being closed.  Sybase limit is 25 open connections.

Items:

------

===================================================================

DTR:     D10170

SOR/STR: D10076

Title:   Implement fixes required for 6.2 Build 3A

Description:

add fixes required to support MPLAN in Build 3A

SOT Step 95-43.1

Items:

------

sysgen/src/arctic/data/env_updates.dat

sysgen/src/arctic/data/file_copy.dat

sysgen/src/arctic/data/file_permissions.dat

sysgen/src/arctic/data/jmcis_config.dat

sysgen/src/arctic/data/make_data

sysgen/src/arctic/data/startup_scripts.dat

sysgen/src/arctic/lib/make_lib

sysgen/src/arctic/lib/ssb_Directories.pm

sysgen/src/arctic/lib/ssb_JmcisConfig.pm

sysgen/src/arctic/lib/ssb_OsSetup.pm

sysgen/src/arctic/lib/ssb_StartupScripts.pm

sysgen/src/arctic/scripts/arctic_1.prl

sysgen/src/arctic/scripts/arctic_2.prl

sysgen/src/arctic/skel/root/.xinitrc

sysgen/src/arctic/skel/xdm/Xresources

sysgen/src/common/lib/ssb_DataFileUtils.pm

sysgen/src/common/lib/ssb_NetworkTools.pm

sysgen/src/common/lib/ssb_SystemUtils.pm

tamps/src/data/sysadmin/zet/.xinitrc

===================================================================

DTR:     D10171

SOR/STR: SOR-95-47

Title:   Mission Xfer

Description:

MPM's request the ability to save the original planner name to missions being transferred vice having the planner name switched to the person who had initiated the mission transfer.

Items:

------

tamps/src/dbinstall/sprocs/insert_mission_sp.sql

tamps/src/libs/b_msn_tools/bmt/bmt_create.c

tamps/src/libs/b_msn_tools/bmt/bmt_export.c

tamps/src/libs/b_msn_tools/bmt/bmt_import.c

tamps/src/libs/b_msn_tools/bmt/bmt_mission.c

tamps/src/libs/b_msn_tools/bmt/bmt_optMenuCb.c

tamps/src/libs/b_msn_tools/include/bmt_priv_proto.h

===================================================================

DTR:     D10181

SOR/STR: SOR 96-01

Title:   NIS+ cache needs refreshing after user add or delete

Description:

After a user is added or deleted using the TAMPS user administration

HMI, the update is not immediately visible to applications that use

getpwuid() or getpwnam() to get user information.

Many instances of this error were worked around with DTR 10072 (during

testing of which this problem was discovered), but the problem has still

been observed.

The problem is most visible when trying to re-create a user that was

previously removed from the system.  One way that might reproduce the

problem is to delete a user; add a different user (to reuse the old user's

UID); then re-add the first user.  Try this within one zet_uadmin run, or

restarting zet_uadmin before re-adding the user.

It was also noticed that "~user" continued to refer to a directory for

some time after a user was deleted with zet_uadmin (although the

directory no longer existed); it should say "unknown user".  This seems

to be related to this problem.

The best way to fix this would probably be to find some way to force

NIS+ (or the getpwuid library) to rebuild its cache; this could be done

within the zet_adduser.sh, zet_moduser.sh and zet_deluser.sh scripts,

or in the code after the scripts have exited.

Items:

------

===================================================================

DTR:     D10197

SOR/STR: SOR 95-47

Title:   DAFIF transaction stored procedures corrupted.

Description:

The stored procedures for performing DAFIF transaction loading have been corrupted.  The database name prefix was duplicated, causing the insert of the stored procedure.

Items:

------

tamps/src/dbinstall/dafid/create/create_dafid_trans_sp.sql

===================================================================

DTR:     D10198

SOR/STR: SOR 95-47

Title:   DTED Load/Display errors

Description:

The manual option is greyed out for DTED load.

Cannot Display DTED after it is loaded

Items:

------

tamps/src/libs/dbase/dlt/dlt_load.c

tamps/src/libs/maps/mmt/mmt_bkgnd.c

===================================================================

DTR:     D10199

SOR/STR: 6.2 Init

Title:   DOD Banner Not in Center

Description:

The DOD banner sometimes comes up in the upper left corner of the display vice the center.

Items:

------

===================================================================

DTR:     D10200

SOR/STR: SOR 95-47

Title:   Cannot change TAMPS password

Description:

Using the User Admin function the TAMPS password cannot be changed. SA must change it in a shell .

Note! Other problems besides just TAMPS password.

root password mod is difficult

any tamps user password change makes that account unusable

no checking between credential and login password creates good chance for

an unusable account

etc.

D10528i also related

Items:

------

sysgen/src/arctic/data/accounts_os.dat

sysgen/src/arctic/scripts/crypt.prl

sysgen/src/common/lib/ssb_UserAdmin.pm

sysgen/src/common/lib/ssb_embedUserAdmin.pm

tamps/include_prot/util/upb_prot_defines.h

tamps/include_prot/util/upb_prot_proto.h

tamps/src/apps/lan/lcl/lcl_connectHMIcb.c

tamps/src/apps/lan/lcl/lcl_usrinitmain.c

tamps/src/apps/zsystem/zet/Makefile

tamps/src/apps/zsystem/zet/zet_userMMI.c

tamps/src/apps/zsystem/zet/zet_userMMIcb.c

tamps/src/libs/util/upb/upb_userAdmin.c

tamps/src/libs/util/uxt/uxt_passwd.c

tamps/src/scripts/zsystem/make_scripts

tamps/src/scripts/zsystem/zet_adduser.sh

tamps/src/scripts/zsystem/zet_moduser.sh

===================================================================

DTR:     D10201

SOR/STR: 6.2 Init

Title:   Cannot Communicate with the MU

Description:

After loading a standalone system that had both a DSUR & MDLR attached, using MU/MDL utilities I could not view device info for the MU. The MDL worked OK but the MU kept getting "Error opening device".  After a shutdown and boot -r, I could check MU fine.

SOT Step 95-43.1

Items:

------

sysgen/src/arctic/lib/ssb_SystemReboot.pm

sysgen/src/arctic/scripts/arctic_2.prl

===================================================================

DTR:     D10202

SOR/STR: SOR 95-47

Title:   Could not save and reopen a Strike package

Description:

Created a F14 and E2C missions and saved them in a strike package. The strike saved without errors but when selected Strike Open nothing was listed in the window.

Items:

------

===================================================================

DTR:     D10203

SOR/STR: SOR 95-47

Title:   No Warning on Client Connect

Description:

When connecting a client workstation to a server system, no warning is

provided to the user if an unavailable IP address is used.  The user should be

warned and given a chance to change it prior to connecting.

Items:

------

===================================================================

DTR:     D10204

SOR/STR: SOR 95-47

Title:   Client / Server Coverage Tools

Description:

On a client system:  Prior to selecting the server coverage tool, the client

coverage tool correctly displays the data loaded on the client.  However,

once the server coverage tool has been displayed, the coverage tools

display the server data, regardless of whether client or server is selected.

Items:

------

===================================================================

DTR:     D10205

SOR/STR: SOR 95-47

Title:   DBA Crash with DCW Load

Description:

Attempting to load DCW from the client of a client / server system causes the

DBA module on the client to crash.  It appears that the data is loaded to the

server database successfully before crashing,

Items:

------

===================================================================

DTR:     D10206

SOR/STR: SOR 95-47

Title:   DCW Display on Client

Description:

DCW loaded in the server database can not be displayed on the client.  The coverage tool shows no data loaded and DCW features do not appear when zooming in to a DCW area.

Items:

------

===================================================================

DTR:     D10207

SOR/STR: SOR 95-47

Title:   CIB Display on Client / Server

Description:

CIB imagery loaded to the server database from the client workstation can not

be displayed on the client or the server.  The images appear in the coverage

tool on both systems, but do not appear in the background imagery select

tool on the client.

Items:

------

===================================================================

DTR:     D10208

SOR/STR: SOR 95-47

Title:   CADRG Display on Client / Server

Description:

CADRG and ADRG charts loaded to the server database from the client

workstation can not be displayed on the client or the server.  The charts

appear in the coverage tool on both systems, but do not display when

selected from the background tool.  Charts loaded to the server database

from the server station can only be displayed on the server.

Items:

------

===================================================================

DTR:     D10209

SOR/STR: SOR 95-47

Title:   DAFIF Display on Client / Server

Description:

DAFIF loaded to the server database from the client workstation can not be

accessed by either the client or the server.  DAFIF loaded using the server

station can be accessed by both stations.

Items:

------

===================================================================

DTR:     D10210

SOR/STR: 6697

Title:   Printer Error in Console Window

Description:

Console window displayed the following error: Device Busy Can't open  /var/spool/Xerox/xpxx/_dev_bpp0/number.  This happens when you use screen grab and strip Charts.   To get rid of the msg in the console window I had to do a reboot, because if not the msg  repeated over and over again.   Have not checked any all of the print functions.

Items:

------

===================================================================

DTR:     D10211

SOR/STR: SOR 96-01

Title:   MIDB Editors do not support deleting data

Description:

The MIDB production editors (which are GOTS) do not support deleting MIDB

records.  TAMPS has requirements to be able to delete (or to mark as

deleted) GMI and DBA target records.

96-01 SOF statements:

3.2.3.5.6      The GMI Editor CSC shall provide the ability to delete data.

3.2.4.3.4.1   The Target Editor CSC shall allow the DBA to delete any planner

or DBA created targets.

Items:

------

===================================================================

DTR:     D10212

SOR/STR: SOR 96-01a

Title:   Help updates required for Planner Target HMI

Description:

The help information for the Planner Target HMI needs to be updated for

the new HMI.

Items:

------

===================================================================

DTR:     D10213

SOR/STR: SOR 96-01a

Title:   Help updates required for scenario HMI

Description:

Items:

------

===================================================================

DTR:     D10214

SOR/STR: 6755

Title:   Help updates required for Selectable Route Validation

Description:

Items:

------

tamps/include/help/thc_defines.h

tamps/src/libs/a_msn_plan/ait/ait_validateRouteCB.c

tamps/src/libs/a_msn_plan/include/ait_priv_proto.h

===================================================================

DTR:     D10215

SOR/STR: SOR 96-01a

Title:   Help updates required for OOB Query HMI

Description:

Items:

------

===================================================================

DTR:     D10216

SOR/STR: SOR 96-01

Title:   Archive/Restore Effective dates

Description:

The effective date and classification are greyed out in the Archive/Restore Window when you select databases to archive to media (8MM tape or 3.5 disk).

Process:DBA Module -> Util -> Archive/Restore -> Archive/Restore Window.

Gary from TRW said,  this is by design.    The window before this 6.2 B3 was not grayed out.

The Restore option has the effective date and classification not grayed out.

The Dump/Restore has no date or classifcation widget.

Items:

------

===================================================================

DTR:     D10217

SOR/STR: SOR 95-47

Title:   DBA - Database Usage, NID

Description:

When you select NID from the Database Usage tamps datasets, the query will return the whole data for tamps and at the bottom of the window the total is as follows:(NID Total).

Process:DBA -> Output -> Database Usage -> tamps Datasets -> NID.

Before it would just bring the NID data tables.

Items:

------

tamps/src/libs/dbase/dut/dut_datasets.c

===================================================================

DTR:     D10218

SOR/STR: SOR 95-47

Title:   Ready to Reboot Confirmation

Description:

If an invalid client IP address is entered in the Connect to MPLAN window,

an error message is correctly displayed, but the "Ready to Reboot

Workstation" confirmation dialog is displayed on top of it.  The confirmation

dialog should not appear if an error is detected.

Items:

------

===================================================================

DTR:     D10219

SOR/STR: SOR 95-47

Title:   Connect with Different Subnet

Description:

If a client is connected using an IP address subnet that is different than the

server, the client gets hung up in the reboot process and the system must

be reloaded to recover.

Items:

------

===================================================================

DTR:     D10220

SOR/STR: SOR 95-47

Title:   Rename Accounts

Description:

An error message is displayed when trying to rename conflicting user

accounts during a client connect.

Items:

------

===================================================================

DTR:     D10221

SOR/STR: SOR 95-47

Title:   User Initialization HMI

Description:

After connecting a client to the server and logging in, the User

Initialization HMI appears in the upper left corner of the screen, and

without a motif border.

Items:

------

===================================================================

DTR:     D10222

SOR/STR: SOR 95-47

Title:   New Password for Client User

Description:

After connecting a client workstation, I entered and re-entered a new

password in the User Initialization HMI and then tried to log back in to that

account using the new password, but couldn't.  The password for the account

had not been updated.

Items:

------

===================================================================

DTR:     D10223

SOR/STR: SOR 95-47

Title:   Conflicting Accounts

Description:

Deleting conflicting user accounts does not appear to work properly.  I

selected Close in the Conflicting User Accounts HMI and then OK in the Delete

Conflicting Users dialog, but each time I logged back in with a DBA/SA

account, the Conflicting User Accounts HMI appeared with the same

conflicting accounts listed.

Items:

------

===================================================================

DTR:     D10226

SOR/STR: SOR 95-47

Title:   Not Updating Reports Database Catalog after Dump/Restore.

Description:

1. The Dump/Restore is not updating the Reports Database Catalog.   The databases that are not updating are:GMI, NID and DAFIF_GPS.  The DAFIF_GPS was not updated in the DAFIF Version Windows.

2. The loader window:DBA -> Util -> Load of tamps did update the the Reports Database Catalog for MIDB Baseload and NID.   Used the Data Removal Tool to remove the NID from the Reports Database Catalog, and it did remove.   Could not Remove MIDB Baseload with the Data Removal Tool.

3. Stand alone systems.

Items:

------

tamps/src/libs/dbase/dut/dut_dump_restore.c

===================================================================

DTR:     D10228

SOR/STR: 6698

Title:   Kneeboard Card Lattitude Format

Description:

If change default units to DD:MM:SSH and printout a Kcard, it puts a space between the first and second digit of the lattitude. When using the defualt units of HDD:MM:SS the printout looks OK.

Items:

------

tamps/src/libs/products/prl/prl_aircrew_bind.c

===================================================================

DTR:     D10229

SOR/STR: SOR 95-47

Title:   Cannot update NIS+ Host Table with new hostname

Description:

The NIS+ Host Table cannot be updated successfully.  To update the table successfully, you must add an entry with an identical Hostname and Alias first and then can add other Aliases for this Hostname.  When you try to add an entry using the WSE LAN Admin tool, the identical Hostname and Alias entry is created ok but when you try to add Aliases for this Hostname, get an error about duplicate Hostname and the entry is not put into the Table.

Items:

------

===================================================================

DTR:     D10230

SOR/STR: 6699

Title:   Kneeboard Card Reorder Function

Description:

If the Re-Order function is used to add data to the "Blank" column on the left side, there is no room for the extra data in the printout so it tries to print between the page 1& page 2 sections but overwrites some data. If data is added to the blank columns on the right side it is just not printed out, since the right side is already at the edge. Since there is no longer a selection for font size, there is no way to add additional columns and get it to printout in a readable format.

Items:

------

tamps/src/libs/products/include/prl_structs.h

tamps/src/libs/products/prl/prl_aircrew_bind.c

tamps/src/libs/products/prl/prl_extract_data.c

tamps/src/libs/products/prl/prl_initDataItems.c

tamps/src/libs/products/prl/prl_navKneeboardHMI.c

tamps/src/libs/products/prl/prl_navKneeboardPSL.c

tamps/src/libs/products/prl/prl_navReOrderHMI.c

===================================================================

DTR:     D10231

SOR/STR: 6496

Title:   Audit Log Open

Description:

To attempt to fix the crash on open problem a limit of 50K records was imposed on primary file open in the audit logs. After only ten minutes with all audit events turned on I opened the log and received the message "maximum number of audit records (50000) reached. ...." Then it tells the SA to either use the date option or change a ZZT_MAX_NUM... environment variable. After acknowledging the message the log did open but contained only the oldest 50k worth of records, less than three minutes of data. This is an unsatisfactory solution to the problem of crashing on opening a large log. Although the audit functions are only available to a SA user, I doubt many in the Fleet will know how to change an environment variable and this message needs to changed.The logs in /var/audit at this time were only about 10MB total.

Items:

------

tamps/env/tamps.env.dev

tamps/src/apps/zsystem/zzt/zzt_log_cons.C

tamps/src/apps/zsystem/zzt/zzt_revDialog.C

tamps/src/data/environment/tamps.env

===================================================================

DTR:     D10232

SOR/STR: 6755

Title:   Invisible message when adding route points

Description:

When adding points to a route, route validation off, a message window flashes up and then dissapears before it can be read. Don't know what it says but this is annoying.

Items:

------

tamps/src/libs/a_msn_plan/aet/aet_NavUtils.c

===================================================================

DTR:     D10234

SOR/STR: 6699

Title:   Course True Missing From Kneeboard Card Re-Order List

Description:

"Course True" should be one of the data items available in the selection list in the kneeboard card re-order window

Items:

------

===================================================================

DTR:     D10235

SOR/STR: 6698

Title:   Field Width For Elevation Is Too Small In Kneeboard Card

Description:

The field with for elevation is too narrow in the kneeboard card, resulting in in overrunning into the field next to it.  This cause the data next to it in the kneeboard card to be difficult or impossible to read.

Items:

------

===================================================================

DTR:     D10236

SOR/STR: 6699

Title:   Attempting To Load A Non-Kneeboard Card File Crashes The MPM

Description:

If Load File is selected from the Kneeboard Card window, and a file is selected from another directory that is not a kneeboard card file (*.RKC), the MPM crashes.  The user should not be allowed to select anything other than route kneeboard card (.RKC) files.

Items:

------

tamps/src/libs/products/include/prl_priv_proto.h

tamps/src/libs/products/prl/prl_extract_data.c

tamps/src/libs/products/prl/prl_filter_mission.c

tamps/src/libs/products/prl/prl_initDataItems.c

tamps/src/libs/products/prl/prl_main.c

tamps/src/libs/products/prl/prl_navKneeboardHMI.c

tamps/src/libs/products/prl/prl_navKneeboardPSL.c

tamps/src/libs/products/prl/prl_navReOrderHMI.c

tamps/src/libs/products/prl/prl_report_tool.c

===================================================================

DTR:     D10239

SOR/STR: 6698

Title:   Target Data Items Blank in Kneeboard Card

Description:

If the CRS TGT, DIST TGT, or TIME TGT data items are placed in the kneeboard card, they are displayed blank even with an attack target flight event as part of the route.  These data items should display the course, distance, and time direct to the defined target from the turnpoint.

Items:

------

tamps/src/libs/products/include/prl_structs.h

tamps/src/libs/products/prl/prl_aircrew_bind.c

tamps/src/libs/products/prl/prl_create_kneeb_format.c

tamps/src/libs/products/prl/prl_extract_data.c

===================================================================

DTR:     D10240

SOR/STR: 6697

Title:   Doghouse Component Editor Current/Next Off By One Turn Point

Description:

When "Current Point" is selected in the component data editor for a data item, you get next point information.  When "Next Point" is selected, you get next-next (two points subsequent) information.  The current point info needs to be for the waypoint adjacent to the doghouse, and the next point info needs to be for the point subsequent to the point adjacent to the doghouse.

Items:

------

===================================================================

DTR:     D10241

SOR/STR: 6697

Title:   Doghouse Component Data Items Displayed Blank

Description:

The following doghouse component data items do not display any information in the doghouse:

"Distance Leg", "Ident Bearing Range", "Course to Target", "Time to Target", "Distance to Target".

Items:

------

tamps/src/libs/b_msn_tools/bsa/bsa_EditorStart.c

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

===================================================================

DTR:     D10242

SOR/STR: 6697

Title:   Distance Cumulative Displays Leg Distance

Description:

Selecting "Distance Cumulative" in the doghouse component data editor results in display of leg distance instead.

Items:

------

tamps/src/libs/b_msn_tools/bsa/bsa_EditorStart.c

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

tamps/src/libs/b_msn_tools/bsa/bsa_GetStrips.c

===================================================================

DTR:     D10243

SOR/STR: 6697

Title:   Selecting "Altitude MSL" For A Leg Defined As AGL Reverts Selection To AGL.

Description:

If a doghouse is selected for a turn point which is defined by an AGL altitude, and "Altitude MSL" is selected in the component data editor for display, the selection is ignored and AGL altitude is displayed and selected when Exit and Apply Changes is selected.  The planner may want to display MSL altitude for cross reference even if the point is defined as an AGL altitude

Items:

------

tamps/include/b_msn_tools/bsa_defines.h

tamps/src/libs/b_msn_tools/bsa/bsa_CreateCompDataItemSingle.c

tamps/src/libs/b_msn_tools/bsa/bsa_EditorStart.c

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

===================================================================

DTR:     D10244

SOR/STR: 6697

Title:   Incorrect Clock Time Display In Doghouse

Description:

If "Clock Time" is selected for display in the doghouse component data editor, the only thing actually displayed in the doghouse are the words "Clock Time".

Items:

------

tamps/src/libs/b_msn_tools/bsa/bsa_CreateCompDataItemSingle.c

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

===================================================================

DTR:     D10245

SOR/STR: 6697

Title:   Divert Heading Incorrectly Displayed In Doghouse

Description:

If "Divert Heading" is selected for display in the doghouse component data editor, it displays as a true heading.  Divert heading should be displayed as magnetic heading.

Items:

------

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

===================================================================

DTR:     D10246

SOR/STR: 6697

Title:   Divert ID Displayed Incorrectly In Doghouse

Description:

If "Divert ID" is selected for display in a doghouse using the component data editor, the waypoint number is displayed instead.

Items:

------

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

===================================================================

DTR:     D10247

SOR/STR: 6697

Title:   Elevation Displayed Incorrectly In Doghouse

Description:

If "Elevation" is selected for display in a doghouse using the component data editor, the aircraft altitude AGL is displayed instead.

Items:

------

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

===================================================================

DTR:     D10248

SOR/STR: 6697

Title:   Headings In Doghouses Not Taking Wind Into Account.

Description:

If a true or magnetic heading are displayed in a doghouse, they do not take wind (crosswind) into account.

Items:

------

tamps/include/b_msn_tools/bsa_defines.h

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

tamps/src/libs/b_msn_tools/bsa/bsa_StripParam.c

===================================================================

DTR:     D10249

SOR/STR: 6697

Title:   Course Displays In Doghouses Do Not Have T Or M Next To Them

Description:

If true or magnetic course are selected for display in a doghouse using the component data editor, they are just displayed as a 3 digit number, with no M ot T legend next to them to indicate what reference they are using.

Items:

------

===================================================================

DTR:     D10250

SOR/STR: 6697

Title:   Component Data Items Not Saving With Doghouse

Description:

If a doghouse is customized using the component data editor, and then saved, many of the selected data types do not save or recall with the doghouse load function.  The following data items are not recalled when a saved doghouse is loaded:  Bank Angle, Calibrated Air Speed, Course Magnetic, Course to Target, Course True, Description, Distance Leg, Distance to Target, Distance to Divert, Elevation, Flight Mode, Fuel Flow, Ident Bearing Range, MGRS, Speed Mach, Time to Target, True Airspeed, UTM Coord, UTM Zone, Wind Speed/Direction.

Items:

------

tamps/include/b_msn_tools/bsa_defines.h

tamps/src/libs/b_msn_tools/bsa/bsa_DoghouseEd.c

===================================================================

DTR:     D10251

SOR/STR: 6825

Title:   Strip Chart Tick Marks Scaled Incorrectly

Description:

Time ticks on strip charts are scaled incorrectly.  Planned a low level route with a constant groundspeed of 480 KTS.  Each strip in the series had a different scaling between time ticks, especially on strips that had one leg split over two strips.  The distance between tick marks varied from being correct (8 nm) to as short as 4 nm apart on some strip charts, as well as several distances in between.  With a constant 480 GS, the tick marks should all be 8 nm apart.  For legs that were split over two strips, the first strip generally had ticks that were very close together, while the second strip for that leg had correct spacing.

Items:

------

tamps/src/libs/b_msn_tools/bsa/bsa_ProcStripD.c

tamps/src/libs/b_msn_tools/bsa/bsa_StripLatLon.c

tamps/src/libs/b_msn_tools/include/bsa_priv_proto.h

===================================================================

DTR:     D10252

SOR/STR: 6825

Title:   Strip Chart Tick Marks Incorrectly Placed With Respect To Turn Point

Description:

The tick marks are no longer rounding off to the nearest minute at each turn point, but they are not placed correctly with respect to the turn point time, either.  The tick marks are placed approximately 1 to 2 nm short of where they should be in the vicinity of the turn point based on turn point time.  Example: first strip with 3 legs, two turn points, with hack time of 00+00:00 on the second point.  Time zero tick mark appears one mile short of turn point with zero hack.  Time 2 tick appears 2 miles short of next turn point with turn point time of  02:04 elapsed in dog house ( 4 seconds should be .5 nm). Time tick 4 appears 1 nm past next turn point, which is at time 3:42 ( 18 seconds should be 2.4 nm).

Items:

------

===================================================================

DTR:     D10253

SOR/STR: 6825

Title:   Strip Chart Tick Marks Not Drawn Correctly On First Strip

Description:

Not all tick marks are drawn on first strip chart in series.  Had low level route with hack time of 00+00:00 at start point of low level, which was point 4 in mission route. Strip chart editor was brought up with a series of 4 to 10 (end).  The first strip had three legs on it (4-5-6-7).  The only time ticks displayed were at 2 minutes and 5 minutes, and were scaled incorrectly.  If the same route was brought up in the strip chart editor starting one point prior to the hack point (3 through 10),  then time ticks were displayed as "-0" at time -1, 0 (but 1 nm shy of the hack point), 1, and 2.  There was no tick mark for time 3.

Items:

------

===================================================================

DTR:     D10254

SOR/STR: 6496

Title:   Audit Log  ZZT_MAX_NUM_AUDIT_RECORDS environment variable

Description:

When trying to open the audit log with more than 50K of data, an error message tells the user to modify the ZZT_... env variable. When I looked in tamps.env the variable is not there.

Items:

------

===================================================================

DTR:     D10255

SOR/STR: 6217

Title:   Symbol  Annotation, Default Button

Description:

The STR calls for the "Apply" button to be the default. The finger button is set to default after selecting location vice the Apply. Apply is only the default after selecting Apply.

Items:

------

tamps/src/libs/intel/int/int_symbol.C

===================================================================

DTR:     D10256

SOR/STR: 6755

Title:   Manual Route Validation not updating Fuel data

Description:

In E2C MPM, input launch/recovery and then navpt #2. Opened the dynamic kneeboard card and checked it, fuel was blank in brief format. Then selected the calculate button on toolbar, a validating route message pops up briefly but it does nothing else. The fuel data is still not showing up in the Kcard. I checked the regular Kcard and it too, showed --- in the fuel column. I had to turn route validation on under Setup and add another navpoint to get fuel data.

Items:

------

tamps/src/libs/a_msn_plan/ait/ait_validateRouteCB.c

tamps/src/libs/reports/rht/rht_knebdcd.c

tamps/src/libs/reports/rkt/rkt_util.c

===================================================================

DTR:     D10257

SOR/STR: 6755

Title:   Mission Save, Route Validation not Working

Description:

With Route Validation defaulted to off, and select File Save in a MPM, a message comes up asking do you want to validate current mission before saving.  I selected Yes and checked the dynamic and route kneeboard cards. The dynamic brief format still had --- for fuel, but the full format showed fuel and GWT data. The route kneeboard card had --- in the fuel fields. Again the only way to get fuel data in the printed Kcard is to turn route validation on in the setup>defaults. Similar problem to DTR 256.

Items:

------

tamps/include_prot/a_msn_plan/ait_prot_proto.h

tamps/src/libs/a_msn_plan/aet/aet_NavUtils.c

tamps/src/libs/a_msn_plan/aet/aet_RouteUtils.c

tamps/src/libs/a_msn_plan/ait/ait_msnNewCB.c

tamps/src/libs/a_msn_plan/ait/ait_msnOpenCB.c

tamps/src/libs/a_msn_plan/ait/ait_validateRouteCB.c

tamps/src/libs/a_msn_plan/ait/ait_validateRouteStatus.c

tamps/src/libs/products/prl/prl_extract_data.c

===================================================================

DTR:     D10258

SOR/STR: SOR 95-43

Title:   Audit log not tracking logins

Description:

The auditting was configured with just login_logout selected. In the audit log it is only showing the user logouts. The log shows the "username"  login or logout and then WSE logout for logoffs, but there are no login events in log.

SOT Step 95-43.1

Items:

------

tamps/include_prot/wse/wmt_audit_defines.h

tamps/src/apps/wse/wlt/wlt_logout.c

tamps/src/data/etc/security/audit_event

tamps/src/libs/wse/include/wmt_priv_proto.h

tamps/src/libs/wse/wmt/wmt_initMMI.c

tamps/src/libs/wse/wmt/wmt_logout.c

===================================================================

DTR:     D10259

SOR/STR: SOR 95-43

Title:   PST User Manuals will not open

Description:

I loaded the user manuals for mission planner from the 6.1/6.1.1 CD and they loaded OK. I then logged off and logged back on and selected User Manuals from WSE Help menu, and the User Manual window came up with Users Manual, Mission Planner in list. However, when attempt to open the manual nothing happens. In the error logs it shows a message about couldn't ececute "acroread": no such file or directory.

SOT Step 95-43.1

Items:

------

===================================================================

DTR:     D10261

SOR/STR: SOR 96-01

Title:   Remove Archive/Restore IDB

Description:

In DBA Archive/Restore window, IDB is still an option under Select Dataset. This needs to be removed since it is no longer applicable with MIDB and probably won't work anyway.

Items:

------

===================================================================

DTR:     D10262

SOR/STR: 6698

Title:   Reports/Kneeboard Card Causing Crash

Description:

In an MPM opened a mission and then selected the Platform Performance Report. Closed Report without printing and then selected the Route Kneeboard Card, selected create report and  TAMPS format and in a couple of seconds the MPM crashed.

Items:

------

tamps/src/libs/products/prl/prl_report_tool.c

===================================================================

DTR:     D10263

SOR/STR: 6.2 Init

Title:   Database Usage Print causing crash

Description:

If Laser Print Button is selected after querying database usage on DAFIF/GPS, get a print preview window.  If Laser Print Button is selected after querying the same a second time, DBA module will crash.

SOT Step 95-43.1

Items:

------

tamps/src/libs/products/prl/prl_preview.c

tamps/src/libs/products/prl/prl_print.c

===================================================================

DTR:     D10267

SOR/STR: 6317

Title:   GPSMDL Loadset retrieve causes crash

Description:

Created a mdl loadset in F14D and saved it. Selected Retrieve and highlighted the loadset name in list, then OK and MPM crashed. Also, did the same thing in AH-1W.

Items:

------

tamps/src/libs/dbase/dut/dut_catalog.c

===================================================================

DTR:     D10268

SOR/STR: 96-01

Title:   Archive/Restore MIDB (GMI)

Description:

Archive/Restore:

The MIDB (GMI database) is not on the list for archive/restore.   The archive/restore had IDB in the list.

Items:

------

===================================================================

DTR:     D10269

SOR/STR: SOR 95-43

Title:   Sysgen Build 4

Description:

Implement Sysgen changes required for Build 4, including COTS changes, MPLAN and MIDB support.

SOT Step 95-43.1

Items:

------

sysgen/cots/sparc/gnu/gnu.tgz

sysgen/cots/sparc/hpnp/hpnp.tgz

sysgen/src/arctic/data/accounts_os.dat

sysgen/src/arctic/data/database_config.dat

sysgen/src/arctic/data/directories.dat

sysgen/src/arctic/data/disk_slices.dat

sysgen/src/arctic/data/file_copy.dat

sysgen/src/arctic/data/file_permissions.dat

sysgen/src/arctic/data/menu_mods.dat

sysgen/src/arctic/data/packages_os.dat

sysgen/src/arctic/data/share_files.dat

sysgen/src/arctic/data/startup_scripts.dat

sysgen/src/arctic/data/symbolic_links.dat

sysgen/src/arctic/lib/ssb_DBInstall.pm

sysgen/src/arctic/lib/ssb_LoadSoftware.pm

sysgen/src/arctic/lib/ssb_OsInstall.pm

sysgen/src/arctic/lib/ssb_OsSetup.pm

sysgen/src/arctic/lib/ssb_PrinterInstall.pm

sysgen/src/arctic/lib/ssb_ShareFiles.pm

sysgen/src/arctic/lib/ssb_StartupScripts.pm

sysgen/src/arctic/scripts/arctic_1.prl

sysgen/src/arctic/scripts/arctic_2.prl

sysgen/src/arctic/scripts/make_dirs

sysgen/src/arctic/scripts/reinstall/Makefile

sysgen/src/arctic/scripts/reinstall/README

sysgen/src/arctic/scripts/reinstall/install_patches

sysgen/src/arctic/scripts/reinstall/install_printer

sysgen/src/arctic/scripts/reinstall/make_scripts

sysgen/src/common/data/core_tarsets.dat

sysgen/src/common/data/sysgen_environment.dat

sysgen/src/common/env/arctic.env

sysgen/src/common/lib/ssb_LoadMediaUtils.pm

sysgen/src/common/lib/ssb_NetworkTools.pm

sysgen/src/common/lib/ssb_ShellUtils.pm

===================================================================

DTR:     D10270

SOR/STR: SOR 95-43

Title:   Sysgen Volume Manager

Description:

Implement Veritas Volume Manager installation for E-4000

SOT Step 95-43.1

Items:

------

sysgen/cots/sparc/vvm/vvm.tgz

sysgen/src/arctic/data/database_config.dat

sysgen/src/arctic/data/disk_slices.dat

sysgen/src/arctic/data/packages_os.dat

sysgen/src/arctic/lib/make_lib

sysgen/src/arctic/lib/ssb_DBInstall.pm

sysgen/src/arctic/lib/ssb_DiskSlices.pm

sysgen/src/arctic/lib/ssb_LoadSoftware.pm

sysgen/src/arctic/lib/ssb_VolManUtils.pm

sysgen/src/arctic/scripts/arctic_1.prl

sysgen/src/arctic/scripts/arctic_main.prl

sysgen/src/arctic/scripts/arctic_vm1.prl

sysgen/src/arctic/scripts/make_scripts

sysgen/src/arctic/scripts/vminfo

sysgen/src/arctic/skel/root/.cshrc

sysgen/src/common/data/core_tarsets.dat

sysgen/src/common/data/sysgen_environment.dat

sysgen/src/common/data/valid_values.dat

sysgen/src/common/lib/ssb_SystemUtils.pm

sysgen/src/common/lib/ssb_TarSetUtils.pm

===================================================================

DTR:     D10273

SOR/STR: 6697

Title:   Doghouse Component Data Items:  ICN Change

Description:

F/A-18 MPM found a misspelling of a Doghouse Component Data Item #define in "bsa_defines.h".   The item "bSa_DOGHOUSe_ID_BEARING_RANGE_NAME" should be "bsa_DOGHOUSE_ID_BEARING_RANGE".  This error caused an Ada bindings problem.

Items:

------

tamps/include/b_msn_tools/bsa_defines.h

===================================================================

DTR:     D10275

SOR/STR: SOR 97-13

Title:   PFPS Import Messages not coming up in front

Description:

After successfully importing a PFPS mission from floppy the message about a successful import comes up behind the Import window. This also happens with other error messages from PFPS import.

Items:

------

tamps/src/libs/a_msn_plan/apl/apl_pfps_callbacks.c

===================================================================

DTR:     D10276

SOR/STR: SOR 97-12

Title:   Yearly Crypto Keys Change to Weekly

Description:

When a user tries to enter or modify the start/end dates for a yearly GPS

crypto key usin the Modify HMI, part of the logic treats the key as a

weekly key.  If the new dates overlap any dates for weekly keys in the

database, an error message is displayed when Apply is selected, and

the key can not be entered into the database.  This should only happen

when the date of another yearly key is overlapped.  Also, if the date change

is successful, the key type changes to weekly (CVw).

SOT Steps 97-12.4 and 97-12.8

Items:

------

tamps/src/apps/gpskey/gst/gst_clientDBA_modify.C

===================================================================

DTR:     D10277

SOR/STR: SOR 97-12

Title:   GPS Crypto Key Help

Description:

The help files for the crypto key manual entry and modify HMIs are no longer correct.  The help files should be updated to reflect the new short title checks and key type algorithm.

Items:

------

===================================================================

DTR:     D10278

SOR/STR: SOR 97-12

Title:   Incorrect Short Title Error

Description:

If the cursor focus is changed before starting the short title entry in the crypto key manual entry function, an error message is displayed which says: "Key purpose is not operational or simulation. .....".  If no title has been entered yet, no error should be displayed.  If an invalid title is entered, the error should read something like:  "The short title entered does not match the format for an operational or simulation key.  Only operational and simulation keys can be loaded on TAMPS".

Items:

------

tamps/src/apps/gpskey/gst/gst_clientDBA_manEntry.C

===================================================================

DTR:     D10279

SOR/STR: SOR 97-13

Title:   PFPS Import Default Classification

Description:

Since PFPS mission data does not contain Classification, TAMPS needs to set the classification to "Unclassified" as default on import. Otherwise when open a PFPS mission in a MPM, there is no classification at the bottom of the MPM and when go to output a report they come up as Top Secret.

Items:

------

tamps/src/libs/a_msn_plan/apl/apl_pfps_misc.c

===================================================================

DTR:     D10280

SOR/STR: SOR 95-47

Title:   Background Environment Window.

Description:

The environment HMI window in the background tool is not listing the Op Areas.  Select DBA -> Display -> Background -> Weather -> Edit to display the window.

Items:

------

===================================================================

DTR:     D10282

SOR/STR: SOR97-11a

Title:   ICWG 184.2 fixes

Description:

move jet_displayQueryResultsDialog from public to private.

change variable names in JET_IMAGERY_METADATA_T and JET_MTF_DATA.

add PPIP type to JET_CATEGORY_TYPE.

changed descriptions in tet_NITFFunctions to agree with prototypes

Items:

------

tamps/include/jtim/jet_proto.h

tamps/include/jtim/jet_structs.h

tamps/src/libs/jtim/include/jet_priv_proto.h

tamps/src/libs/jtim/jet/jet_MTFFunctions.c

tamps/src/libs/jtim/jet/jet_init.c

tamps/src/libs/jtim/jet/jet_mapFunctions.c

tamps/src/libs/jtim/jet/jet_queryFunctions.c

tamps/src/libs/tms/tet/tet_NITFFunctions.c

tamps/src/libs/tms/tet_NITFFunctions.c

tamps/src/test/SOR9711a/app/sor9711_drv.c

===================================================================

DTR:     D10283

SOR/STR: SOR 95-43

Title:   Sysgen External Interface Prompts

Description:

Implement user prompts for connections to external interfaces during Sysgen, such as SIPRNET, JMCIS...

SOT Step 95-43.1

Items:

------

sysgen/src/arctic/data/config_prompts.dat

sysgen/src/arctic/data/env_updates.dat

sysgen/src/arctic/data/interface_config.dat

sysgen/src/arctic/data/make_data

sysgen/src/arctic/data/system_config.dat

sysgen/src/arctic/lib/make_lib

sysgen/src/arctic/lib/ssb_AtmInstall.pm

sysgen/src/arctic/lib/ssb_DBInstall.pm

sysgen/src/arctic/lib/ssb_DeviceDrivers.pm

sysgen/src/arctic/lib/ssb_InterfaceConfig.pm

sysgen/src/arctic/lib/ssb_SysgenPrompt.pm

sysgen/src/arctic/scripts/arctic_1.prl

sysgen/src/arctic/scripts/arctic_2.prl

sysgen/src/common/data/sysgen_environment.dat

sysgen/src/common/data/valid_values.dat

sysgen/src/common/lib/ssb_DataFileUtils.pm

sysgen/src/common/lib/ssb_NetworkTools.pm

sysgen/src/common/lib/ssb_PromptUtils.pm

sysgen/src/common/lib/ssb_VerifyTools.pm

===================================================================

DTR:     D10284

SOR/STR: SOR 95-47

Title:   Import/Export TAMPS Missions not working

Description:

When select Import/Export tamps missions get the new Mission Data Transfer window. Select Source=Workstation and Destination= Media then select either 8mm tape or 3 1/2 inch disk and OK. An Error Message window comes up saying "In bmt_missionOkCb - Error parsing device name".

Items:

------

===================================================================

DTR:     D10285

SOR/STR: SOR 95-47

Title:   Mission Data Transfer Window  Devices

Description:

Remove the 1/4 inch Cartdrige medial as an option under this new window. There are no QIC 150 drives on any 6.2 hardware.

Items:

------

tamps/src/libs/b_msn_tools/bmt/bmt_create.c

tamps/src/libs/b_msn_tools/include/bmt_mission_defines.h

===================================================================

DTR:     D10286

SOR/STR: SOR 95-47

Title:   Removing IP Addresses on Server

Description:

On a server system, if a user selects view -> NIS+ Host Table from the

LAN administration window, highlights an unassigned IP address and

selects edit -> remove, the IP address is only temporarily removed from

the list , and an error message is displayed saying:  "Error modifying NIS+

table".  When the NIS+ Table is reselected, the IP address is in the list

again.  The remove option works for IP addresses that have been assigned

a hostname, and should be consistent.

Items:

------

===================================================================

DTR:     D10287

SOR/STR: SOR 96-60H

Title:   Object Editor Import/Export FAILS

Description:

Could not Export using the Object Editor Import/Export New HMI window.

From the WSE_BAR selected DBA -> Object Editor -> highlighted DAFID_AIRBASES -> highlighted JOINT -> then selected Import/Export -> and the Object Import/Export new HMI window was displayed:Selected radio button Export -> then selecting 8mm tape or 3.5 disk, and then the verify Export Media Load window is displayed:Selected OK and then selected Apply at the Object Import/Export Window:and received the following Message window.A system error occurred at the completion of the export process.

Items:

------

tamps/src/apps/objh/oil/oil_export_main.C

tamps/src/apps/objh/oil/oil_import_main.C

===================================================================

DTR:     D10288

SOR/STR: 96-60H

Title:   Object Editor Import/Export New HMI window.

Description:

Crashed the Object Editor using the New HMI Import/Export window.

From the WSE_BAR selected DBA -> Object Editor -> highlighted DAFID_AIRBASES -> highlighted JOINT -> then selected Export User Directory radio button:highlighted the JOINT.odf  -> selected 8mm tape or 3.5 disk to active the OK or Apply buttons in the Object Import/Export Window: received the following ACK Window:Verify Export Media is loaded. Then by selecting OK in the ACK Window crashs the ALL the Object Editor Windows.

Items:

------

tamps/src/apps/objh/oet/oet_impexpMMI.c

===================================================================

DTR:     D10289

SOR/STR: SOR 96-52M

Title:   Full PC Card Write Error

Description:

If you attempt to overwrite a file on a nearly full PC card with a file of identical filename, an error is displayed (and the file is not written) saying that the card is full - even if, by overwriting the file, the file being written would fit on the card.  The PC card driver should check for filename match and calculate the space available without the matching file before giving a card full indication.

Items:

------

===================================================================

DTR:     D10290

SOR/STR: SOR 95-47

Title:   Client Info Incorrect

Description:

The location, squadron, POC and phone/extension information is not being

displayed correctly on the server when amplify information is selected for

any of the connected clients.  Some of the fields are interchanged and

some information is just incorrect.  Also, the location is not correct in the connected client list.

Items:

------

tamps/src/apps/lan/lal/lal_createLANadminHMI.c

tamps/src/apps/lan/lcl/lcl_connectHMIcb.c

tamps/src/apps/lan/lol/lol_Connection.c

===================================================================

DTR:     D10291

SOR/STR: SOR 95-47

Title:   Amplify Info Under WSE

Description:

The client Amplify Info window pops up under the WSE bar on the server.

Items:

------

===================================================================

DTR:     D10292

SOR/STR: SOR 95-47

Title:   Client Idle Time

Description:

In the client Amplify Info window, "Idle time" is displayed in seconds only.  The format would be much more usable in days, hours:min:sec.

Note: Modified text of this DTR on 1/15/98

Items:

------

tamps/src/apps/lan/lal/lal_createLANadminHMI.c

tamps/src/apps/lan/lol/lol_Connection.c

===================================================================

DTR:     D10293

SOR/STR: SOR 95-47

Title:   Connected Client Status

Description:

Connected client workstation status, displayed in the server's LAN administration HMI, is not correct.  It shows "Active" if a user is logged in and "Unknown" if not.  The SOF statements state that the status should be "Active" when the client is powered up and "Inactive" when not.

Items:

------

===================================================================

DTR:     D10294

SOR/STR: SOR 95-47

Title:   New Missions on Client/Server

Description:

New missions created on connected clients must be created using op areas

that were created on the client.  Server op areas are listed in the New Mission

HMI, but if one is selected, nothing happens when OK is selected.  The

second time OK is selected, the MPM crashes.  The problem is the opposite

on the server.  Missions must be created using op areas that were created on

the server.

Items:

------

===================================================================

DTR:     D10295

SOR/STR: SOR 95-47

Title:   Opening Op Areas

Description:

When a user on a client opens a DBA module and tries to open an op area

that was created on the server, the selected op area is not displayed.  The

display either remains on the op area that was already displayed or reverts

to the default.

Items:

------

tamps/src/scripts/lan/lcl/lcl_preConnection.sh

===================================================================

DTR:     D10296

SOR/STR: 6755

Title:   Route Validation not being save in Save User Defaults.

Description:

Route Validation is not being saved when you select route validation ON and then select  the Save User Defaults for your msn.   Meaning you have to reselect the route validation each time you open your aircraft mpm.

Items:

------

tamps/include/system/sdt_defs.h

tamps/src/libs/system/sdt/sdt_unitdefcb.c

tamps/src/libs/system/sit/sit_init.c

===================================================================

DTR:     D10298

SOR/STR: 6317

Title:   Error Saving MDL Loadsets in F14B Upgrade

Description:

Could not save a MDL loadset in F14B Upgrade MPM. Kept getting "Error in saving loadset" message. Tried with various combinations of files including only almanac and magvar. Same problem in F14A Upgrade. Other MPMs seem to allow saving

Items:

------

tamps/mpm/f14/src/f14gt/f14gt_abu_DataFile_MMI.C

===================================================================

DTR:     D10299

SOR/STR: SOR 95-47

Title:   Deleting NIS+ Table Entries

Description:

No warning is provided to a system administrator when trying to remove or modify host table entries on the server.  As a minimum, a warning should be displayed anytime an attempt is made to delete or modify any entry for a connected client or the server, since these are destructive actions.

Items:

------

===================================================================

DTR:     D10300

SOR/STR: SOR 95-47

Title:   User Accounts on Clients

Description:

The functionality for creating new accounts on a client is available but does not work.  SOF statement 1.3.4.1.1.1 states that this is still a requirement.  If this requirement has been deferred, the documentation should be updated, and the System Admin -> User Administration -> Accounts option should be grayed out on clients.

Items:

------

tamps/src/libs/wse/wmt/wmt_roles.c

===================================================================

DTR:     D10303

SOR/STR: SOR 96-01

Title:   MIDB Display of WW data is wrong

Description:

After loading MIDB Worldwide data from tape, queried for all primary airfields and they all displayed in the NE Quadrant of the world. In C/D text the coordinates have lat/lons in other quadrants but they are not displaying properlyl

Items:

------

===================================================================

DTR:     D10305

SOR/STR: 6698

Title:   Can only print one kneeboard card per kneeboard card session

Description:

Pressing the Print button in the Kneeboard card window more than once only results in one print job.  Must leave the kneeboard card and re-Create it to get another to print out.  One print job per kneeboard card is unacceptable.

Items:

------

===================================================================

DTR:     D10306

SOR/STR: SOR 95-43

Title:   Cleanup /var/audit on reload

Description:

If preserve /var/audit partition during solaris install, sysgen is not deleting old log files during arctic install.

SOT Step 95-43.1

Items:

------

sysgen/src/arctic/data/directories.dat

===================================================================

DTR:     D10307

SOR/STR: SOR 95-43

Title:   Cannot load two complete versions of DAFIF

Description:

replace of DTR111.

Tried to load two complete versions of DAFIF on standalone Ultra and received the following error message: Can't allocate space for objects in the database 'DAFIF_GPS' because the 'default' segment is full. It looks like only 400MB is allowed for DAFIF.

SOT Step 95-43.1

Items:

------

sysgen/src/arctic/data/database_config.dat

sysgen/src/arctic/data/disk_slices.dat

===================================================================

DTR:     D10308

SOR/STR: SOR 95-47

Title:   MPMs and DBAs sometimes not starting.

Description:

Repeat of D074.

Sometimes MPMs and DBAs will not come up. If check in shell the applications are running but the only thing that comes up is the NATOP msg or starting application msg. It appears to be related to the object server since when kill the ost_server the MPM window comes up. The user would have to reboot to correct this problem. The previous DTR was put into test and developer indicated could not dupe.

Items:

------

===================================================================

DTR:     D10309

SOR/STR: 96-01.1

Title:   Crash displaying AAA planner and DBA threats

Description:

Consistent system crash attempting to display AAA planner and DBA threats.  The sequence I found to be consistent is:

F14D MPM

Threat/Intel -> Planner OOB-> Planner and DBA...

Select planner and OK

Select AAA

Items:

------

tamps/src/libs/dbase/dil/dil_InterimThreatQueries.c

===================================================================

DTR:     D10311

SOR/STR: 96-01

Title:   Disk space required for world-wide MIDB load

Description:

Based on the test world-wide data tape, there must be a minimum of

245 Mb free in $DB_ARCHIVE_RESTORE (which is, via softlinks,

under /var on an installed system) in order to load the complete

FAC table set.  It would be better to leave some margin for growth,

so 300 Mb is a better figure.

Reworking the script to extract one file at a time would reduce the

disk space required to about 100 Mb, at a reduced speed since the

tape would repeatedly be rewould and re-read.

A different temporary directory could be used, if there is another

disk that can be expected to have enough free space.

Items:

------

===================================================================

DTR:     D10313

SOR/STR: SOR 95-47

Title:   Connected Client User Accounts corrupted

Description:

User accounts created on a client workstation prior to connecting to a server get corrupted after connecting.  The user directories do not get created correctly on the server, and the accounts are unusable.

Items:

------

sysgen/src/arctic/data/startup_scripts.dat

sysgen/src/arctic/lib/ssb_StartupScripts.pm

===================================================================

DTR:     D10314

SOR/STR: SOR 95-47

Title:   Bogus Error Message

Description:

An error message about updating the NIS+ table is displayed each time a hostname is assigned to an IP address from the Available IP Addresses list, even though the NIS+ table actually gets updated.

Items:

------

===================================================================

DTR:     D10315

SOR/STR: SOR 95-47

Title:   Conflicting Host Names

Description:

Modified the host name of a previously assigned IP address and selected Apply.  This should have caused an error, but instead the new host name was created with the previous alias and IP address causing the IP address to be used for 2 different host names.

Items:

------

===================================================================

DTR:     D10317

SOR/STR: 6216

Title:   Geo Cancel Warning

Description:

Select Display>Geo Filter>Custom from DBA and select New Geo from the option menu.  Select pointing hand to begin creating a new geo.  When the right mouse button is selected to cancel the create geo function, get a warning message about not being able to create the geo.  There should be no warning since user intentionally cancelled the create geo function.

Items:

------

tamps/src/libs/dbase/dmt/dmt_geocb.c

===================================================================

DTR:     D10318

SOR/STR: 96-01

Title:   FAC table being truncated

Description:

It appears that /var will need to be resized larger to accomodate the FAC tables in a FULL MIDB baseload.  Currently the load stops at the FAC_TIE table without indicating whether the table completed or not - NO alerts or errors are provided.  The last three tables: FAC_TRAIT, FAC_VULNERABILITY and FAC_XREF are all emply.

Items:

------

===================================================================

DTR:     D10319

SOR/STR: SOR 95-47

Title:   MPLAN NIS+ Host Tabel Update

Description:

If an Alias is set up for a valid Hostname and IP address and the Alias entry is removed from the NIS+ Host Table, the entry which has identical Hostname and Alias is also removed from the table.  If you remove an Alias entry, the Host entry should not be removed.

Additional Text (1/27/98): If the local host alias is removed, all of the other local host aliases will also be removed, causing significant system problems.  Recommend allowing alias to be deleted, but not for the local host.

Items:

------

tamps/src/apps/lan/lal/lal_createLANadminHMI.c

===================================================================

DTR:     D10320

SOR/STR: SOR 95-47

Title:   /etc/hostname.xxx error in MPLAN

Description:

When connecting a client and server via either ATM or Ethernet, the MPLAN connect executable should check the /etc/hostname.xxx file on the client.  If connecting via Ethernet, the file in /etc should be hostname.hme0.  If connecting via ATM, the file should be hostname.fa0.  Only one of these files should be in the client /etc directory at one time but currently both can reside in /etc instead of one being replaced with the other depending on the connection method.

Items:

------

===================================================================

DTR:     D10322

SOR/STR: 96-01.2

Title:   MIDB GMI Restore without Modify MIDB privileges

Description:

As a user without Modify MIDB privileges, there is no warning messages when accessing the restore GMI database function.  Messages received are extremely old and does not reflect the current environment.  Without Modify MIDB privileges I should not be able to even try to restore the GMI database.  It should be greyed or not in the list.

Items:

------

tamps/src/dbinstall/data_dict/dd_databases_insert.sql

tamps/src/libs/dbase/dut/dut_dump_restore.c

tamps/src/scripts/dbase/bin/dlt_MIDB_preRestore

tamps/src/scripts/dbase/bin/make_scripts

===================================================================

DTR:     D10324

SOR/STR: SOR 95-43.2

Title:   COMPASS Crashes after connected and open a layer

Description:

The COMPASS MPM now starts and the servers can be started. After connecting if annotation tool is opened and symnbol selected or just about anything else that would creat a layer, open mission, query dafif, it crashes the MPM. If open these layers before connecting the MPM does not crash.

Items:

------

===================================================================

DTR:     D10325

SOR/STR: SOR 96-10.5

Title:   SIPRNET not connecting

Description:

After manually configuring "siprnet" in host table and adding a default router I could manually ftp the NAVSTAR.ALM file from siprnet almanac site. In DBA the SIPRNET shows configured but down and there is no means to pull data. In the shell ping does not work with the siprnet almanac site eventhough I can ftp into it.

Items:

------

tamps/src/apps/dbase/dpl/dpl_main.c

tamps/src/libs/dbase/dpl/dpl_DbaGPSOnlineUpdate.c

tamps/src/libs/dbase/dpl/dpl_gpsOnlineUpdateCB.c

tamps/src/scripts/dbase/scripts/gps_is_alive.dat

===================================================================

DTR:     D10326

SOR/STR: SOR 95-47

Title:   Mission Tranfer - Dynamic_mpm switch

Description:

MPM's need the ability to save mission related data to the /tamps/dynamic/mpm area if the client is looking at Local DB or to the /tamps/dynamic/mpm_server area if the client is looking at the Server DB

Items:

------

tamps/src/libs/b_msn_tools/bmt/bmt_create.c

tamps/src/libs/b_msn_tools/bmt/bmt_export.c

tamps/src/libs/b_msn_tools/bmt/bmt_import.c

tamps/src/libs/b_msn_tools/bmt/bmt_mission.c

tamps/src/libs/b_msn_tools/bmt/bmt_optMenuCb.c

tamps/src/scripts/lan/lcl/lcl_preConnection.sh

===================================================================

DTR:     D10327

SOR/STR: TS96-01_05.doc

Title:   Interim Threat record merge to midb, tables missing.

Description:

Step:12  Hook one of the interim threats and update the MIDB.   Select DBA -> Update -> Threats -> Merge Planner OOB...   Failed

Received the following msg:FAIL to insert new SAM Site.

Mary Collins: Did a isql query for TAMPS_MIDB_DEFAULTS.   Data returned no TAMPS_ MIDB_Defaults Tables.

Also the DBA Interim Window has IDB and not MIDB at the top of the Editor window.

Items:

------

tamps/src/dbinstall/tampsdb/create/mission/make_sql

===================================================================

DTR:     D10328

SOR/STR: 97-13

Title:   handle to mission source

Description:

Need to provide MPMs the ability to access the misison source field from the input mission handle.  Additionally, need to set the apt_file_operation to apt_no_file_op when importing a PFPS route.

Items:

------

tamps/include/a_msn_plan/axt_defines.h

tamps/src/libs/a_msn_plan/apl/apl_pfps_misc.c

tamps/src/libs/a_msn_plan/axt/axt_createHandle.c

===================================================================

DTR:     D10330

SOR/STR: SOR 96-10.

Title:   On-Line GPS, cannot switch between NAVSSI & SIPRNET

Description:

In DBA > Update > OnLine, with both NAVSSI & SIPRNET configured and UP, I could not select SIPRNET as the source since it was grayed out. Opened and closed online gps window and still the same. If closed DBA and opened the DBA then could select either source.

Items:

------

===================================================================

DTR:     D10331

SOR/STR: 6307

Title:   MGRS in NAD-27 to WGS-84

Description:

TAMPS is not calculating MGRS correctly when changing from Datum NAD-27 to

WGS-84 in the planner target updates dialog.  As an example, if an MGRS of 11SLV4634250648 is entered in WGS-84, and then the datum is alternately applied for that point, the sequence is:

WGS-84   11SLV4634250648

NAD-27   11SLK4642250449

WGS-84   11SLV4642550649

NAD-27   11SLK4650550451

WGS-84   11SLV4650950651

The MGRS should have toggled between:

WGS-84   11SLV4634250648

NAD-27   11SLK4642250449

and this was proven on a truth source (MADTRAN).

Items:

------

tamps/src/libs/b_msn_tools/btt/btt_deftgtcb.c

===================================================================

DTR:     D10332

SOR/STR: 96-10

Title:   Almanac load alert coming up Red

Description:

Setup online GPS to auto update from a NAVSSI emulator. After update a Red alert came up about the almanac update. Change the alert to Yellow. Also, the text in the main alert is compressed together and hard to read.

Items:

------

tamps/src/apps/dbase/dpl/dpl_main.c

tamps/src/libs/dbase/dlt/dlt_magVarGPS.c

===================================================================

DTR:     D10333

SOR/STR: 6307

Title:   Target Longitude Changes

Description:

If a target point is entered in the planner target updates dialog using NAD-27 datum, each time the target is selected from the list and apply is selected, the longitude changes by a few seconds.  Example:

35:41:16N, 118:41:53W

35:41:16N, 118:41:50W

35:41:16N, 118:41:47W

35:41:16N, 118:41:44W

Items:

------

===================================================================

DTR:     D10334

SOR/STR: 96-01.3

Title:   Input media information in MIDB Data Exchange does not reflect TAMPS media

Description:

The only way to import certain MIDB data is via the MIDB Data Exchange tool.  When import is selected and File -> Set Tape Information is also selected, it displays a list of media that is not reflective of the TAMPS environment.  I believe what is shown are tape devices for DIA.  Floppy disk and Hard Drive information is also here.  The list should be changed to reflect the TAMPS environment.

Items:

------

sysgen/src/arctic/scripts/load_midb.prl

===================================================================

DTR:     D10338

SOR/STR: SOR 95-43.1

Title:   Remove Import PFPS menus from FAMP and COMPASS MPMs

Description:

Both FAMP and COMPASS MPMs have the Import PFPS Routes menu under File > Import/Export Missions. Import/Export missions is not applicable to these MPMs and when selected it causes the MPMs to crash. This may also be a problem in HARM/SLAM/JSOW if they do not remove this menu.

Items:

------

tamps/mpm/famp/src/fdi_init/fdi_defineButtons.c

tamps/src/apps/compass/ams/ams_defaultMenu.c

tamps/src/apps/compass/ams/fdi_defineButtons.c

===================================================================

DTR:     D10339

SOR/STR: SOR 95-47

Title:   Client Idle Time Cycling

Description:

In the Client Amp Info window, the "idle time" cycles between 0 and 60 for a connected client.  This value should either be displayed as 0 or not be displayed at all until the client disconnects.

Items:

------

===================================================================

DTR:     D10340

SOR/STR: SOR 96-01

Title:   Remove IDB selection from Dataset Removal

Description:

Remove the selection for IDB from the list under DBA> Utilities> Data Removal> Dataset since it no longer applies.

Items:

------

===================================================================

DTR:     D10341

SOR/STR: 96-01

Title:   GMI Dataset removal is not deleting catalog entry

Description:

After using the DBA Dataset removal tool to remove the GMI database it appeared to remove the data OK, however the MIDB Baseload entry is still in the TAMPS catalog when select Output> Database Catalog

Items:

------

tamps/src/libs/dbase/dut/dut_drmcb.c

===================================================================

DTR:     D10343

SOR/STR: 6697

Title:   Doghouse Display for Leg to Recovery Point

Description:

Currently, the Doghouse for the last point in the route (i.e., prior to the recovery point) does not give the option to show any data for the NEXT POINT (recovery pt).  Instead, only data for the current point may be seen.  Lt. D'Acquisto (Fleet Liason Officer) requests that the operator be able to select data for this last leg to the recovery point (e.g., bearing to recovery, fuel remaining, etc.) as for any other point in the route.

Lt. D'Acquisto states that the NEXT POINT option for ANY doghouse WILL NOT BE APPLICABLE for the following items:

True Heading

Magnetic Heading

Leg Time

Leg Fuel

Distance Leg

True Course

Magnetic Course

These items are always for the flight leg ahead; NEXT POINT would show data for the next point beyond the next leg, which is unacceptable.  In addition, the Waypoint # for the current Doghouse must always indicated the adjacent waypoint, not that for the next leg's Doghouse; accordingly, the NEXT POINT option is to be ignored for this composite data item also.

Per Lt. Todd Kiefer (IKE), the AGL and MSL should be relative to the NEXT POINT ONLY.

Items:

------

tamps/src/libs/b_msn_tools/bsa/bsa_CreateCompDataItem3Part.c

tamps/src/libs/b_msn_tools/bsa/bsa_CreateCompDataItemDouble.c

tamps/src/libs/b_msn_tools/bsa/bsa_CreateCompDataItemSingle.c

tamps/src/libs/b_msn_tools/bsa/bsa_DoghouseEd.c

tamps/src/libs/b_msn_tools/bsa/bsa_EditorStart.c

tamps/src/libs/b_msn_tools/bsa/bsa_GetData.c

tamps/src/libs/b_msn_tools/bsa/bsa_GetStrips.c

===================================================================

DTR:     D10346

SOR/STR: SOR 95-43

Title:   Problems Reusing deleted user account names

Description:

The DTR is written against Step 1 of SOR 95-43.

1.  Create a valid user account "example"

2.  Logout and login under another valid user account

3.  Delete the "example" user account using the accounts HMI

4.  Create a new user account using the same user name as the deleted one

5.  Try to log in under the deleted/recreated user account.

Sometimes you can log into this account but if you log out, you cannot log back in.  Other times you cannot log into this account at all.  If you can log into the account and open a shell, if you close the shell, you cannot reopen the shell.  This problem is repeatable on a standalone workstation.

Items:

------

tamps/src/apps/zsystem/zet/zet_userMMIcb.c

tamps/src/libs/util/uxt/uxt_passwd.c

===================================================================

DTR:     D10347

SOR/STR: SOR 95-47

Title:   Modify Available IP Addresses, Apply closes widget

Description:

On a server system, select the Available IP Addresses view and select an entry to modify.  If the Apply button is selected after modifying the entry, the Modify widget should remain open but actually closes.

Items:

------

tamps/src/apps/lan/lal/lal_createLANadminHMI.c

===================================================================

DTR:     D10348

SOR/STR: 95-43

Title:   TAMPS Logins would not bring up WSE, rqrd reload

Description:

On a standalone workstation that had not been connected to a server, I could not login using previously working accounts. I had to login as root but could not find anything obviously wrong. Rebooted system and tried again but still the same. What is happening is the login and password are accepted OK and the DOD warning window comes up but the WSE never comes up. After a couple minutes it brings back up the login window. Note! This was on Bld 3A. I had to reload system to correct the problem.

Items:

------

===================================================================

DTR:     D10350

SOR/STR: SOR 96-10

Title:   On Line GPS showing NAVSSI up when it is really down

Description:

Using a standalone Ultra connected via a router to SIPRNET, I input a bogus IP address for navssi and a valid cofig for siprnet. When open the online GPS update window it shows both NAVSSI and SIPRNET as being up when it should only show SIPRNET as up. When I manually tried to ftp to the navssi host it took about 4minutes and then returned No Route to Host msg.

Items:

------

tamps/include_prot/dbase/dpl_prot_proto.h

tamps/src/apps/dbase/dpl/dpl_main.c

tamps/src/libs/dbase/dpl/dpl_DbaGPSOnlineUpdate.c

tamps/src/scripts/dbase/scripts/gps_is_alive.dat

===================================================================

DTR:     D10351

SOR/STR: SOR 95-47

Title:   Server MIDB Database Dump Update Failure

Description:

On the server, selected Utilities > Database Maintenance > Update Database Dumps.  Selected MIDB and Apply.  Dump flat file was created okay but the following warning message was displayed upon completion:  Attempt to insert NULL value into column "LOAD_DATE", table GMI.dbo.GMI_TEMP_CATALOG; column does not allow NULLS, update fails.  On the server, the Database Catalog for MIDB Baseload displays nothing for Date Last Change.  After a Database Update on the client, the Database Catalog does not display a MIDB entry at all even though the data is updated on the client.

Items:

------

tamps/src/dbinstall/sprocs/tamps_temp_cat.sql

===================================================================

DTR:     D10355

SOR/STR: 95-47

Title:   GUAC load errors on dropping/creating indexes

Description:

Selected to load GUAC  for Korea area. Load completed OK but there were errors in log about dropping and creating indexes and not being the owner or SA. For example "Only the owner of table "GUAC_CLIMATOLOGY" or a user with System Administrator (SA) role can create an index on it." Also, there were DB-LIBRARY errors: Attempt to bulk-copy an oversize row to SQL server. Bottom line, could not display GUAC.

Items:

------

tamps/src/dbinstall/guac/load/dgn_GuacLoad.csh

tamps/src/dbinstall/guac/load/dgn_GuacUnload.csh

tamps/src/libs/maps/mwl/mwl_RetrvGUAC.c

===================================================================

DTR:     D10356

SOR/STR: SOR 95-47

Title:   Disconnect at Shutdown Reminder

Description:

When a user shuts down a connected client workstation, the user should be asked if the workstation should be disconnected from the LAN as well.  However, if the user is shutting down the workstation to update local databases, they should be warned to NOT disconnect from the MPLAN!

Items:

------

===================================================================

DTR:     D10357

SOR/STR: SOR 96-01.03

Title:   Client to Server Update Objects

Description:

Client to Server connected, queried the MIDB for SAM's on the Client:highlighted the object on the DBA Module on the Client and selected Update -> Threats Edit Hooked Object and received the following msg:Error:Unable to obtain SUPPORT table for the window address by ID: -1 NAME: FAC.     Connected by ether net.

Showed gary from TRW he said to write a DTR.

Items:

------

sysgen/src/arctic/scripts/load_midb.prl

===================================================================

DTR:     D10358

SOR/STR: 6214

Title:   Launch Details Crash

Description:

Created a new mission in the F14D MPM.  Selected Setup -> Defaults -> Aircraft.  Then selected Launch Details.  Selected OK and the MPM crashed.  This is repeatable.  Duplicated in AH1W also.  Occurs on standalones and connected clients.

Items:

------

tamps/src/libs/a_msn_plan/ait/ait_LaunchDetailsCb.c

===================================================================

DTR:     D10359

SOR/STR: SOR 95-47

Title:   Removing Conflicting Accounts

Description:

After connecting a client to a server, if the user selects close in the conflicting accounts HMI, a warning is displayed that says the remaining conflicting accounts will be deleted.  The warning should reflect what is actually happening, such as: " The accounts will be inaccessible while connected and restored after disconnecting".

Items:

------

tamps/src/apps/lan/lcl/lcl_usrconfHMIcb.c

===================================================================

DTR:     D10360

SOR/STR: SOR 95-47

Title:   MPLAN - New IDD function uul_getUserList is inaccessible

Description:

MPLAN - New IDD function uul_getUserList is inaccessible

Problem description : During MPLAN client connection, user accounts on the client are transferred to the server.  For those accounts which conflict between client and server, the SA is permitted to rename the client account.  The new IDD function uul_getUserList permits MPMs access to those accounts which have been transferred to the server including those accounts which have been renamed.  This new IDD function is undefined when attempting to link the F/A-18 MPM.  It appears that this function was compiled with the C++ compiler which scrambles the name in the *uul* shared object library.  The F/A-18 MPM is compiled with the C compiler which is unable to find the C++ compiled function.  It appears that the other IDD functions are compiled with the C compiler rather than the C++ compiler.

F/A-18 Impact : Unable to utilize this IDD interface.  The F/A-18 MPM requires knowledge of those accounts which have been renamed in order to change the user names stored with the F/A-18 unique mission data.  Missions owned by users who have had their accounts renamed will be inaccessible while connected to the server via MPLAN.  The information is stored in a TAMPS Core data file *renames* but the content of this file is not documented in the IDD (it appears to be a simple ASCII file which could easily be parsed by the F/A-18 MPM but without being documented in the IDD the file format could change without approval by the F/A-18 program).

Items:

------

===================================================================

DTR:     D10361

SOR/STR: SOR 95-43

Title:   Error Invoking FA-18 MPM from WSE Menu Bar

Description:

Invoking the FA-18 MPM to be run from the WSE menu bar causes the FA-18 MPM to crash during startup.

Impact:  Must change the way the FA-18 MPM is being started up.  At this time we are unclear why the FA-18 MPM is crashing during startup.  We are able to run the FA-18 MPM from a shell, which is how we normally run it during MPM development.  We did notice that the WSE startup has changed where previously a remote shell login was used to invoke WSE.  Now the WSE is run directly.  We temporarily changed the WSE startup to again use a remote shell login and we were able to run FA-18 MPM without a problem.

Items:

------

===================================================================

DTR:     D10363

SOR/STR: SOR 95-47

Title:   Unable to transfer mission between client/server

Description:

The ability to transfer missions between client and server is performed through invocation of the new TAMPS core "Mission Data Transfer" HMI menu.  This new menu allows the user to select "Source" and "Destination" options for controlling the transfer of mission data.  The FA-18 MPM has registered a mission import/export callback that is invoked by the TAMPS core for allowing the MPM to import/export unique FA-18 mission data to tape devices.  It is understood that this MPM callback would be used by the TAMPS core for transfer of mission data between client and server.  Prior to invoking the import/export callback, the TAMPS core will assign the TAMPS environment variable $DYNAMIC_MPM to point to either the server or client dat area as required to handle the mission transfer as indicated by the "Source" and "Destination" fields on the HMI menu.  Our testing has shown that the $DYNAMIC_MPM environment variable is not being assigned correctly for handling data on the client.

FA-18 Impact:  Without being able to register a callback for specifically handling mission transfer across the MPLAN, the FA-18 MPM is being modified to handle the dynamic assignment of the $DYNAMIC_MPM environment variable in order to correctly transfer unique FA-18 mission data between client and server.  Unable to test this capability which allows validation of the MPLAN transfer process.  This is an essential capability of the MPLAN CONOPS.

Items:

------

===================================================================

DTR:     D10364

SOR/STR: SOR 97-13

Title:   PFPS - Unable to list only FA-18 PFPS missions

Description:

The new TAMPS core PFPS import menu lists all the mission contained on the PFPS floppy disk.  An option on the menu allows the user to show only the MPM (FA-18) mission which results in no mission listed.

FA-18 Impact:  No showstopper here since the FA-18 mission could be selected from the list of all missions.

Items:

------

tamps/src/libs/a_msn_plan/apl/apl_pfps_callbacks.c

===================================================================

DTR:     D10365

SOR/STR: SOR 97-13

Title:   PFPS - Improper Invocation of MPM Registered Callbacks

Description:

The FA-18 MPM registers with the TAMPS core callbacks for notification of operations dealing with mission new, open, delete, save, save_as, autosave, import, and export.  Operations dealing with mission save, save_as and autosave all were intended to be used on the current active mission.  Import of a PFPS mission through the TAMPS core functionality is invoking the mission save registered callback with a file operation argument set to APT_SAVE, APT_DELETE, and APT_NEW (note that APT_DELETE and APT_NEW are invalid file operations for the mission save registered callback).  The proper file operation should be APT_NO_FILE_OP which indicates that no file operation should be performed even though the mission save callback has been invoked (this is a patch put in by the TAMPS core when these registered callbacks were first introduced when it when it was discovered that the TAMPS core mission import functionality was invoking the mission save registered callback).

FA-18 Impact:  Invocation of the mission save registered callback without the proper file operation (APT_NO_FILE_OP) causes the FA-18 MPM to try a save of the current mission.  This fails because the data passed to the registered callback is for the PFPS mission being saved no the users current working mission.  An error is returned to the TAMPS core and an FA-18 error message is issued to the user indicating that the mission save operation has failed.  The TAMPS core proceeds to inform the user that the PFPS import of the mission has succeeded.  I am not sure what has really happened with the PFPS mission.

Items:

------

===================================================================

DTR:     D10366

SOR/STR: SOR 97-13

Title:   PFPS - Unable to use AXT_MISSION_SOURCE handle to get origin of mission

Description:

Import of a PFPS mission stores the mission in the TAMPS core mission database with a new mission field (Missison_Source) set to "PFPS".  Unlike a mission import the PFPS mission import does not support MPM registration of a callback to permit the MPM to know about the newly created TAMPS core mission.  The FA-18 MPM must stay in sync with the missions stored by the TAMPS core in order to maintain unique FA-18 mission data.  A new "Mission Handle" for "AXT_MISSION_SOURCE" was to be introduced which can be used when the FA-18 mission open callback is invoked by the TAMPS core.  Supoort for this new handle data is not provided.

FA-18 Impact:  The new "AXT_MISSION_SOURCE" handle will be used by the FA-18 mission open callback for determination of the origin of the mission.  Without this information, PFPS mission imported into TAMPS will be unusable.

Items:

------

===================================================================

DTR:     D10367

SOR/STR: SOR 95-47

Title:   MPLAN User Password for Authentication

Description:

After connecting a client to the server on MPLAN, logging in as root, and giving correct root password, log in under a user account.  After the conflicting account HMI is dismissed, user is asked to enter a password twice.  There is no indication what password is needed (the password of the user who logged in) and if an incorrect password is entered, the user will not be authenticated.  This will cause other problems to occur when using any account (like having the conflicting account HMI displayed every time any user logs in).  In order to correct these problems, you must reload the system.

Items:

------

tamps/include_prot/lan/lsl_prot_proto.h

tamps/src/apps/lan/lcl/lcl_usrinitmain.c

tamps/src/apps/lan/lcl/make_lcl_usrinit

tamps/src/data/sysadmin/zet/.xinitrc

===================================================================

DTR:     D10368

SOR/STR: SOR 95-47

Title:   Modifying Local NIS+ Host Table

Description:

If the SA modifies one of the several Aliases to the local hostname in the NIS+ Host Table, all the other aliases will be deleted causing major problems with MPLAN connection and/or MIDB functions.

Items:

------

===================================================================

DTR:     D10369

SOR/STR: SOR 95-47

Title:   MPLAN Hardware Connection

Description:

If an attempt is made to connect a client workstation to the MPLAN server and the Hardware (either Ethernet or ATM) is disconnected or broken somewhere, the connect process will hang up.  There should be a check at the beginning of the connect process to see if the client can communicate with the server.  If not, the connect process should be aborted and the user informed of a potential cable problem.

Items:

------

sysgen/src/arctic/data/symbolic_links.dat

sysgen/src/arctic/scripts/check_interface.prl

sysgen/src/arctic/scripts/make_scripts

sysgen/src/common/lib/ssb_NetworkTools.pm

===================================================================

DTR:     D10370

SOR/STR: SOR 95-47

Title:   MPLAN Connect Root Password

Description:

When connecting a client to the MPLAN server, if the user inputs an incorrect root password when queried, the connect process is allowed to proceed and succeeds.  After the connection is made and the login screen is displayed, the user can login as root using the incorrect password used at connect.

Items:

------

sysgen/src/arctic/lib/ssb_OsAccounts.pm

sysgen/src/common/lib/make_lib

sysgen/src/common/lib/ssb_PromptUtils.pm

sysgen/src/common/lib/ssb_SystemUtils.pm

sysgen/src/common/lib/ssb_UserAdmin.pm

sysgen/src/common/lib/ssb_embedUserAdmin.pm

tamps/config/projpath

tamps/include_prot/util/upb_prot_defines.h

tamps/include_prot/util/upb_prot_proto.h

tamps/src/apps/lan/lcl/lcl_connectHMIcb.c

tamps/src/apps/lan/lcl/make_lcl_connect

tamps/src/libs/util/Makefile

tamps/src/libs/util/include/Makefile

tamps/src/libs/util/include/upb_priv_proto.h

tamps/src/libs/util/upb/Makefile

tamps/src/libs/util/upb/upb_perlembed.c

tamps/src/libs/util/upb/upb_userAdmin.c

tamps/src/libs/util/uxt/uxt_passwd.c

===================================================================

DTR:     D10371

SOR/STR: SOR 95-47

Title:   Conflicting Accounts Error

Description:

Connected a client to a server which had conflicting user accounts.  When the user conflict HMI appeard, changed a conflicting user name to a name that was already in the valid user list and selected OK.  Got a cryptic error message: "Unable to add user .....: add_status = 16646144".  Changed the name to a different name that was not in the valid user list and selected OK.  The conflicting account name was correctly removed from the conflicting user list, but an entry was added for the name that introduced the initial error.

Items:

------

tamps/include_prot/lan/lsl_prot_defines.h

tamps/src/apps/lan/lsl/lsl_AddUser.c

tamps/src/libs/lan/include/lsl_proto.h

tamps/src/libs/lan/lsl/lsl_establishClient.c

tamps/src/scripts/lan/lcl/lsl_checkUserExist.sh

===================================================================

DTR:     D10373

SOR/STR: SOR 95-47

Title:   MPLAN Database Update Confusing Messages

Description:

When a user performs a database update on a client machine via the MPLAN, a warning message is displayed stating:  "You will have to restart THIS machine, etc...".  After this message is acknowledged, another message is displayed stating:  "Restart the machine where the Sybase server resides".  These two messages are saying the same thing but in different ways which will be confusing to users who may mistakenly restart the server causing numerous problems!

Items:

------

tamps/src/libs/dbase/dml/dml_DbUpdtFromServerProcess.c

tamps/src/libs/dbase/dut/dut_dump_restore.c

===================================================================

DTR:     D10374

SOR/STR: SOR 95-47

Title:   Missions Not Transferred with Account

Description:

Created some missions using an account on a standalone workstation.  Connected the workstation to a server that had an account with the same name.  During the connection, I renamed the account on the workstation.  Logged into the account with the new name on the connected workstation and found that the missions were no longer tied to the account.  They were tied to the account that was already existing on the server prior to connecting.

Items:

------

tamps/src/apps/lan/lcl/lcl_connectHMI.c

tamps/src/apps/lan/lcl/lcl_connectmain.c

tamps/src/apps/lan/lcl/lcl_disconnectmain.c

tamps/src/apps/lan/lcl/lcl_usrconfmain.c

===================================================================

DTR:     D10375

SOR/STR: 4612

Title:   Launch/Recovery Airbase Query Not Working after initial query.

Description:

In any MPM Start a new mission in a SoCal OpArea and open Launch/Recovery window. Select Display Airbases and Apply. Then Deselect All to change the query filters and select US and US-CA prov and Apply. The original query data goes away from the screen but a message comes up saying "No airbases found based on  current filter settings."  This used to work in 6.1.1 before the GEO and OpArea Selections were added to this widget. The only way for a planner to run another airbase query in L/R is to change OpAreas in New Mission or open another MPM.

Items:

------

tamps/src/libs/a_msn_plan/ait/ait_LaunchUtils.c

===================================================================

DTR:     D10376

SOR/STR: SOR 95-47

Title:   Missing/Incorrect Help Files

Description:

The following dialogs do not have help files:

Connect to LAN dialog

Conflicting User Accounts dialog

Update Database Dump dialog

The following dialogs have help files that give inorrect information:

Mission Import/Export dialog

Items:

------

===================================================================

DTR:     D10379

SOR/STR: SOR 95-47

Title:   Mission Import/Export Causes Problems

Description:

Working on an E4000 server with one Ultra connected as a client.  Anytime an import or export was performed on either of the stations, the following problems were noted with the MPM that performed the operation:

1) No op areas listed in the new mission dialog.

2) No missions or planners listed in the mission delete dialog.

3) Mission list frozen in the open mission dialog.

4) Database error when attempting to open a mission.

5) Database error when attempting to save a mission.

These problems made the MPM unusable for mission planning.  Had to exit the MPM and open a new one to get the mission-related functions to work properly.

Items:

------

===================================================================

DTR:     D10381

SOR/STR: SOR 95-47

Title:   Successful Import Message

Description:

If an import or export to either a client or server database is performed and the database already contains missions with the same names as those being transferred, error messages are properly displayed.  However, a message saying "Mission Import Completed Successfully" is displayed also.

Items:

------

tamps/src/libs/b_msn_tools/bmt/bmt_export.c

tamps/src/libs/b_msn_tools/bmt/bmt_exportsp.c

tamps/src/libs/b_msn_tools/bmt/bmt_import.c

tamps/src/libs/b_msn_tools/bmt/bmt_importsp.c

tamps/src/libs/b_msn_tools/bmt/bmt_mission.c

tamps/src/libs/b_msn_tools/bmt/bmt_strike.c

===================================================================

DTR:     D10382

SOR/STR: SOR 95-47

Title:   DAFIF Display Client/Server

Description:

DAFIF loaded to the server database from the client workstation can not be

accessed by either the client or the server.  DAFIF loaded using the server

station can be accessed by both stations.

This is a repeat of DTR #209 (which is in Integration_Build).

Items:

------

tamps/src/scripts/dbase/bin/dlt_dafidVersionDefault.csh

tamps/src/scripts/dbase/bin/dlt_deleteASBoundary.csh

tamps/src/scripts/dbase/bin/dlt_deleteATS.csh

tamps/src/scripts/dbase/bin/dlt_deleteAirbase.csh

tamps/src/scripts/dbase/bin/dlt_deleteDafif.csh

tamps/src/scripts/dbase/bin/dlt_deleteMTR.csh

tamps/src/scripts/dbase/bin/dlt_deleteNavaid.csh

tamps/src/scripts/dbase/bin/dlt_deleteRefuel.csh

tamps/src/scripts/dbase/bin/dlt_deleteSuas.csh

tamps/src/scripts/dbase/bin/dlt_deleteWaypoint.csh

tamps/src/scripts/dbase/bin/dlt_updtStatsASBoundary.csh

tamps/src/scripts/dbase/bin/dlt_updtStatsATS.csh

tamps/src/scripts/dbase/bin/dlt_updtStatsAirbase.csh

tamps/src/scripts/dbase/bin/dlt_updtStatsMTR.csh

tamps/src/scripts/dbase/bin/dlt_updtStatsNavaid.csh

tamps/src/scripts/dbase/bin/dlt_updtStatsRefuel.csh

tamps/src/scripts/dbase/bin/dlt_updtStatsSuas.csh

tamps/src/scripts/dbase/bin/dlt_updtStatsWaypoint.csh

tamps/src/scripts/dbase/bin/dlt_updtVersionASBoundary.csh

tamps/src/scripts/dbase/bin/dlt_updtVersionATS.csh

tamps/src/scripts/dbase/bin/dlt_updtVersionAirbase.csh

tamps/src/scripts/dbase/bin/dlt_updtVersionMTR.csh

tamps/src/scripts/dbase/bin/dlt_updtVersionNavaid.csh

tamps/src/scripts/dbase/bin/dlt_updtVersionRefuel.csh

tamps/src/scripts/dbase/bin/dlt_updtVersionSuas.csh

tamps/src/scripts/dbase/bin/dlt_updtVersionWaypoint.csh

===================================================================

DTR:     D10384

SOR/STR: SOR 95-47

Title:   DTED Load from Server to Client

Description:

When loading DTED from the server to the client, the load window map display will show the correct area if there is only one area of DTED loaded.  If there is more than one area of DTED loaded, the map display will show a small portion of the world centered around the intersection of the Prime Meridian and the Equator.  Top View button will not enlarge view to show whole world so user cannot use box select to choose area desired for load.  Only option seems to be to load ALL DTED loaded on the server!

Items:

------

tamps/src/libs/dbase/dlt/dlt_mpLdMMI.c

===================================================================

DTR:     D10385

SOR/STR: SOR 95-47

Title:   ddt_mmi load utility env variable parsing

Description:

The ddt_mmi load utility is incorrectly parsing the environment variable SYS_TAPE and placing a SERVER entry in the 8 mm Tape option menu.

Items:

------

tamps/src/libs/dbase/dlt/dlt_loadMMI.c

===================================================================

DTR:     D10386

SOR/STR: SOR 95-47

Title:   ADRI Load from Server to Client

Description:

There is no requirement for ADRI load from the server to the client.  Therefore, the From Server radio button on the ddt_mmi Load Utility should be insensitive when ADRI is selected but is sensitive and gives an error message when selected and Apply is selected.

Items:

------

===================================================================

DTR:     D10387

SOR/STR: SOR 95-47

Title:   ARC-210 Unusable

Description:

ARC-210 is UNUSABLE.  Unable to create ARC-210 data files.  When save is selected, get an error about no WOD or MWOD being selected.  All editors, which normally are initialized with data, are empty.  Could be a problem with stored procedures.

Test Step SOR 95-47.17

Items:

------

tamps/src/libs/b_msn_tools/bct/bct_utils.c

===================================================================

DTR:     D10388

SOR/STR: SOR 95-47

Title:   Unable to Save Smartpack Packages

Description:

Created some smartpack contents, added them to a package and selected save.  No error messages were displayed.  Selected File -> Open in the Smartpack Package dialog, and no packages were listed.  No data was contained in sybase table SMARTP_CONTENT.

Test Step SOR 95-47.17

Items:

------

tamps/src/libs/products/psl/psl_package.c

tamps/src/scripts/dbase/bin/tamps_dataXferCreate.sql

tamps/src/scripts/dbase/bin/tamps_dataXferDrop.sql

===================================================================

DTR:     D10389

SOR/STR: SOR 95-47

Title:   Mission Related Data Update

Description:

The Mission Related data update from the server to the client is not working correctly.  Created JNL loads, CAS files, GPS Waypoints files, interim threats, tactical waypoints and custom kneeboard formats on the server.  Then selected DBA -> Utilities -> Database Maintenance -> Update Database from Server on the client.  Selected Mission Related Data, Update Now and OK.  A message was displayed that said the update was successful, but when the corresponding sybase tables were checked, there was no data present.  Disconnected and checked each of the functions, but data was not available.

Test Step SOR 95-47.17

Items:

------

tamps/src/libs/dbase/dml/dml_dataXfer.c

tamps/src/scripts/dbase/bin/tamps_truncate_temp_xfer.csh

===================================================================

DTR:     D10390

SOR/STR: SOR 95-47

Title:   DCW Display on client

Description:

DCW loaded in the server database can not be displayed on the client.  The coverage tool shows no data loaded and DCW features do not appear when zooming in to a DCW area.

This DTR was created to replace DTR 206 which failed testing in the integration build.

Items:

------

tamps/src/data/environment/tamps.env

===================================================================

DTR:     D10391

SOR/STR: SOR 95-47

Title:   Accounts Created on Client not usable on Server

Description:

Any user accounts created on a client machine before connecting to the server cannot be used to login to the server workstation after connecting .  When trying to login on the server using one of the accounts moved from the client to the server, the DOD banner warning will be displayed then the login process fails and the TAMPS Login is displayed.

Items:

------

tamps/src/libs/util/uul/uul_utils.c

===================================================================

DTR:     D10393

SOR/STR: SOR 95-47

Title:   Server/Client background displaying DTED crashes

Description:

Background DTED crashes when you do not deselect Include Server Data at scale 1:1M.

Server Lite wisconsin -> Client arizona:logged in on client as user scud: Selected OpArea with both server lite and client DTED.   Applications tried were DBA Module, FAMP, Aircraft MPM's AH1W, and F14D.

The workstation log error's:

DB-Library error.

Bad token from SQL Server:Datastream processing out of sync.

Items:

------

===================================================================

DTR:     D10394

SOR/STR: 96-01_8

Title:   Use of WGS-84 lat/lon in the DAFIF to locate spatial objects

Description:

SOF statement indicates that the DAFIF database should be using WGS-84 lat/lon columns to determine the location of spatial objects but instead lat_radians / lon_radians are being used.

The value is the same so there is no errors generated due to the use of lat_radians / lon_radians to locate spatial objects.

Items:

------

tamps/src/dbinstall/dafid/create/create_index_dafid.sql

tamps/src/libs/a_msn_plan/aet/aet_CkPtRefQuery.c

tamps/src/libs/a_msn_plan/ait/ait_LaunchUtils.c

tamps/src/libs/b_msn_tools/bgt/bgt_filefuncs.c

tamps/src/libs/b_msn_tools/bgt/bgt_msitefl.c

tamps/src/libs/dbase/dgt/dgt_gpsNavfile.c

tamps/src/libs/dbase/dqt/dqt_cond.c

tamps/src/libs/dbase/dqt/dqt_select.c

tamps/src/libs/objh/out/out_dbfuncs.c

tamps/src/libs/util/ust/ust_bind.c

===================================================================

DTR:     D10397

SOR/STR: 96-01.18

Title:   Using the provided API tester to return data within a bounding box

Description:

Using the provided API tester, set up a query to return data limited by a bounding rectangle. The API tester found "no data" while the same query in ISQL returned eight active records. These records should have been returned via the tester also.

Items:

------

===================================================================

DTR:     D10399

SOR/STR: SOR 95-43

Title:   tet_getmapfilenames is slow

Description:

Calling tet_getmapfilenames to determine existence of files is slow.  For imagery, it can take up to 7 or 8 seconds.  This adds a considerable amount of time to our loading process, since we call tet_getmapfilenames for each CADRG, DTED, and CIB frame we wish to load.  This results in thousands of calls to this routine per load.

Items:

------

tamps/src/libs/tms/include/tut_priv_proto.h

tamps/src/libs/tms/tit/tit_getImageryFiles.c

tamps/src/libs/tms/trt/trt_getADRGfiles.c

tamps/src/libs/tms/ttt/ttt_getdtedfiles.c

tamps/src/libs/tms/tut/Makefile

tamps/src/libs/tms/tut/tut_db_utils.c

===================================================================

DTR:     D10400

SOR/STR: SOR 96-01

Title:   Equipment codes not retrieved by dft_getorderofbattle

Description:

When calling the routine dft_getorderofbattle, we get all of the fields correctly, with the exception that the equipment code field is always empty.  We have to have this field populated to correlate the threat sites returned by dft_getorderofbattle to the NID database.

Items:

------

===================================================================

DTR:     D10401

SOR/STR: STR 6755

Title:   ait_routeValidationGetStatus() change to public

Description:

Need to change function ait_routeValidationGetStatus() from protected

to public.

Items:

------

tamps/include/a_msn_plan/ait_proto.h

tamps/include_prot/a_msn_plan/ait_prot_proto.h

tamps/src/libs/a_msn_plan/aat/aat_attack_calcs.c

tamps/src/libs/a_msn_plan/aet/aet_FltModeUtils.c

tamps/src/libs/a_msn_plan/afi/afi_farp_event.c

tamps/src/libs/a_msn_plan/afi/afi_fuel_farp_event.c

tamps/src/libs/a_msn_plan/afi/afi_fuel_lz_event.c

tamps/src/libs/a_msn_plan/afi/afi_ground_event.c

tamps/src/libs/a_msn_plan/afi/afi_hold_event.c

tamps/src/libs/a_msn_plan/afi/afi_hover_event.c

tamps/src/libs/a_msn_plan/afi/afi_lz_event.c

tamps/src/libs/a_msn_plan/aft/aft_EditTimeCb.c

tamps/src/libs/a_msn_plan/ait/ait_validateRouteCB.c

tamps/src/libs/a_msn_plan/ait/ait_validateRouteDialog.c

tamps/src/libs/a_msn_plan/ait/ait_validateRouteStatus.c

tamps/src/libs/a_msn_plan/aut/aut_construct_route.c

tamps/src/libs/a_msn_plan/aut/aut_jettison.c

tamps/src/libs/reports/rkt/rkt_util.c

tamps/src/libs/system/sdt/sdt_unitdefcb.c

===================================================================

DTR:     D10402

SOR/STR: SOR 96-01

Title:   MIDB Threat Data

Description:

The data is there but HARM MPM cannot get to it. We can't call up any of the threats.

Items:

------

===================================================================

DTR:     D10404

SOR/STR: SOR 95-43

Title:   HARM MU Load crashes when invoked

Description:

We think it is because the stored procedure you call has been moved to the new data base for stored procedures, but you didn't change the address for this particular SP.

Items:

------

===================================================================

DTR:     D10405

SOR/STR: 95-47

Title:   Intermittent crash of Database Catalog Option

Description:

Occasionally when select the View option from the Database Catalog display, the application will crash.

Items:

------

tamps/src/libs/dbase/det/det_catalog.c

===================================================================

DTR:     D10439

SOR/STR: ???

Title:   Creating SLAM ER Tagset crashes MPM

Description:

From SLAM ER MPM Developers:

System crashes when trying to create SLAM ER tagset.

Problem is with BAM tables:

(bam_insertFiles:  Failed to execute insert Failure return from insertFiles)

This problem occurs on both a 6.2 client workstation and the server.

Items:

------

tamps/src/libs/b_msn_tools/bam/bam_wpnload.c

===================================================================

DTR:     D10443

SOR/STR: 96-01a

Title:   Error accessing MIDB Production/DEX tools

Description:

Attempted to open up the Data Exhange (Utilities -> MIDB Tools -> Database Admin -> Data Exchange ) and received the following error message: "Error determining the GCCS connection status."  After acknowledging the error message, nothing happens - can't open the DEX tools.

Further examination indicated that the following also returned the error message: (Error determining the GCCS connection status)

Utilities -> MIDB Tools -> Database Admin -> Data Exchange

Utilities -> MIDB Tools -> Database Admin -> DBA Utility

Utilities -> MIDB Tools -> Database -> Query

Update -> Threats -> MIDB -> New Installation/Facility

Update -> Threats -> MIDB -> New Unit

Update -> Target -> New Target

The following error was received when attempting to access the listed items (Unable to determine GCCS-M connection status)

Update -> Threats -> MIDB -> Edit Hooked Object

Update -> Targets -> Edit Hooked Ojbect

Items:

------

sysgen/src/arctic/data/file_permissions.dat

tamps/src/libs/dbase/dut/dut_runMIDB.c

===================================================================

DTR:     D10486

SOR/STR: 96_01

Title:   MIDB Query Default Print Classification

Description:

DBA Module -> created a New Tgt and then did a query from the MIDB Tools -> Database Query -> Ran a query for the the New Created Tgt, then selected print and the print window class level is defaulted to a (higher classification and cavet).    Meaning it does not let you default to a lower classifcation.

Items:

------

sysgen/src/arctic/scripts/load_midb.prl

tamps/src/libs/dbase/dut/dut_runMIDB.c

===================================================================

DTR:     D10489

SOR/STR: 96-01.13

Title:   Planner target update not displaying correct data after exit and reenter mission

Description:

Created a new mission.  Used planner target update to create a target from scratch (no item was hooked).  Values entered were:

Elevation: 39 meters

Width: 11 meters

Height: 22 meters

Length: 33 meters

Applied the update, cancelled out, saved mission, exited the MPM.

Opened the mission again.

Selected planner target update and selected the target just entered.

Values displayed in the HMI were:

Elevation: 12 meters

Width: 3 meters

Height: 7 meters

Length: 10 meters

The data in the TAMPS_PLANNER_TARGETS table is correct.

Items:

------

===================================================================

DTR:     D10633

SOR/STR: SOR-95-47

Title:   Client Connect Fails to Mount Maps

Description:

The $LAN_MAPS/maps/? mount points are not created during the Client

connect process because Sysgen now creates the $LAN_MAPS directory.

Items:

------

sysgen/src/arctic/data/share_files.dat

sysgen/src/arctic/lib/ssb_OsSetup.pm

sysgen/src/arctic/scripts/arctic_2.prl

sysgen/src/arctic/skel/root/.xinitrc

tamps/src/scripts/lan/lcl/Connect.sh.temp

tamps/src/scripts/lan/lcl/lcl_preConnection.sh

===================================================================

DTR:     D10634

SOR/STR: SOR-97-11

Title:   JTIM_PATH Set Wrong on Client

Description:

JTIM_PATH is set wrong in tamps.env.low - the anonymous ftp fails

during JSIPS-N image fetch to a connected low side client.

Items:

------

sysgen/src/arctic/data/env_updates.dat

===================================================================

DTR:     D10636

SOR/STR: SOR 96-01

Title:   Limit DBA MIDB Tools when connected to GCCS-M

Description:

During testing of the MIDB SOR while connected to GCCS-M, it was found that may of the support data bases do not exist on the GCCS-M server.  This causes the MIDB Query tool to NOT WORK.  Recommend that a message be displayed to the DBA when selecting this option while connected to GCCS-M.

Although Data Exchange does work, it seems dangerous to allow access to it while connected to GCCS-M.  Its main purpose is for a standalone TAMPS to process TFs, which is unnecessary while connected to GCCS-M: the implementation of DEX on GCCS-M should be how that it done.  The other reason for DEX is to backup and apply tactical updates, which should also not be required in a GCCS-M-connected environment.  Recommend that a message be displayed to the DBA when selecting this option while connected to GCCS-M.

Note: Access to the production software via the Update pulldown requires GCCS-M to install the SUPPORT isql directory, which is not done in the current version of their GMIDB segment.  PRC will handle this in the Juliet version of their GMIDB segment.  For now, we installed the appropriate data into jots19 to continue testing.

Items:

------

tamps/src/libs/dbase/dut/dut_runMIDB.c

===================================================================

DTR:     D10637

SOR/STR: SOR 95-43

Title:   E-4000 NIS+ Installation Failed

Description:

NIS+ installation failed on the E-4000, halting Sysgen.

Items:

------

sysgen/src/arctic/lib/ssb_OsSetup.pm

===================================================================

DTR:     D10641

SOR/STR: 6850

Title:   TOPSCENE not processing Threat Data correctly

Description:

Output of the radar and weapon max eff range (nm) does not match values in the database.  Also, need to change the units for lat/lon from radians to decimal.

Items:

------

tamps/src/apps/a_msn_plan/atl/atl_mission_names_main.c

tamps/src/apps/a_msn_plan/atl/atl_threat_data_main.c

===================================================================

DTR:     D10642

SOR/STR: SOR 96-01

Title:   dft_getTargetData only returns Planner Targets

Description:

The function dft_getTargetData() only returns data on Planner targets;

it does not include any data from the MIDB target tables.

Items:

------

tamps/src/libs/dbase/dft/dft_getTargetData_c.C

===================================================================

DTR:     D10643

SOR/STR: 96-01

Title:   OBS and TRACK should not be part of the subset loaded from tape

Description:

The TAMPS subset definition for MIDB GMI does not include TRACK and OBS.  The data file that drives the MIDB Baseload function needs to be modified to exclude these two data sets.  Otherwise, if a baseload tape ever included these two data sets, we may run out of space in GMI.

Items:

------

tamps/src/data/dbase/dlt_gmi_load_small.dat

===================================================================

DTR:     D10644

SOR/STR: D10399

Title:   Load ADRG gives error message

Description:

Whenever a user tries to load ADRG/CADRG, when the OK or Apply

button is pressed, an error message is displayed "cannot determine

ADRG filenames".

Items:

------

tamps/src/libs/tms/tut/tut_db_utils.c

===================================================================

DTR:     D10645

SOR/STR: 6425

Title:   GCCS WX Daemon Startup Script Incorrect

Description:

GCCS WX profiler startup script does not properly set the NIPS_HOME env

var before starting the daemon.  Also the shutdown option does not shut

down the daemon

Items:

------

sysgen/src/arctic/lib/ssb_StartupScripts.pm

===================================================================

DTR:     D10647

SOR/STR: 96-01

Title:   Replication server drop subscription update

Description:

Update the drop subscription script (run when disconnecting from

GCCS-M) so that all subscriptions can be successfully dropped.

It seemed that there are some problems with TIE tables subcriptions deined for one single replication definition. Sometimes, a few of the subscriptions

won't drop until the other related subscriptions are dropped.

Items:

------

tamps/src/scripts/lan/lut/lut_dropSubscrips.sh

===================================================================

DTR:     D10648

SOR/STR: SOR 96-60H

Title:   Import Objects fails with new object

Description:

Created an object NAVY_TACANS under DAFIF_NAVAIDS>TACAN and built a query for the new object and made it a system query. The objec and query worked fine. Exported object to 3.5 FD and tape. Deleted object and then tried to import. Received msg "A system error occurred at the completion of the import process. Also, in .x-errors log showed "ERROR: Non-matching object determinators".

Fails SOT 96-60H.3

Items:

------

tamps/src/apps/objh/oil/Make.dumpfile

tamps/src/apps/objh/oil/oil_dumpfile.C

tamps/src/apps/objh/oil/oil_import_main.C

===================================================================

DTR:     D10649

SOR/STR: SOR 95-47

Title:   mplan connect pre-connect warning help not working

Description:

mplan pre connect warning help does not work

Items:

------

tamps/src/apps/lan/lcl/lcl_connectmain.c

===================================================================

DTR:     D10650

SOR/STR: SOR-97-11B

Title:   Single Point Query Corruptions

Description:

GDE Internal DR delivered for Build 4.

Items:

------

tamps/src/libs/jtim/jqg/jqg_query_cb.c

===================================================================

DTR:     D10652

SOR/STR: SOR 97-11

Title:   JTIM Images Not Retrieved From SPA

Description:

Unable to retrieve an image from the JTIM SPA thinline.  Investigation showed a permission problem on the jtim directory.

Items:

------

sysgen/src/arctic/data/directories.dat

===================================================================

DTR:     D10653

SOR/STR: 6698

Title:   Kcard ReOrder Tool wrong help file

Description:

Help file is the help file of the old Kcard ReOrder Tool

Items:

------

tamps/src/libs/products/prl/prl_navReOrderHMI.c

===================================================================

DTR:     D10654

SOR/STR: 6698

Title:   Kneeboard Card Launch/Recovery Name

Description:

The KCard should, in addition to ICAO, show the launch/recovery pt airbase name, as in the example provided. Some bases do not have an ICAO, and the planner cannot put a description in EFP for launch/recovery pts.

Items:

------

tamps/src/libs/products/prl/prl_aircrew_bind.c

tamps/src/libs/products/prl/prl_extract_data.c

===================================================================

DTR:     D10655

SOR/STR: 95-47

Title:   Strip Charts not displaying Chart data

Description:

Now stripcharts are not displaying any chart data in window. Charts were preserved and updated using DBA MapUpdate. Now not displaying local or server chart data.

DTR 615i refers to not being able to display server chart data when connected.

Items:

------

===================================================================

DTR:     D10656

SOR/STR: SOR 95-47

Title:   HI Client not accessing server Databases

Description:

When connected as a Hi client, all queries to databases returned no data, when there was data loaded on the server but none locally.

Items:

------

tamps/src/dbinstall/data_dict/dd_version_create.sql

tamps/src/libs/dbase/dat/dat_execute.c

tamps/src/libs/dbase/dlt/dlt_load.c

tamps/src/libs/dbase/dmt/dmt_menu.c

tamps/src/libs/dbase/dnt/dnt_dafidCb.c

tamps/src/libs/dbase/dnt/dnt_dafidMMI.c

tamps/src/libs/dbase/dqt/dqt_sql.c

tamps/src/libs/dbase/dut/dut_dafid.c

tamps/src/libs/dbase/include/dqt_priv_proto.h

===================================================================

DTR:     D10657

SOR/STR: SOR 95-47

Title:   Can't Select Local Printer using Printer Designate HMI

Description:

This is a repeat of DTR #610 which fails but cannot be demoted:

MPLAN Admin > Set Default Printer, if a remote printer is the default for the workstation and the user then selects the local printer as the default (highlight and select OK), the designation fails.  The workstation is left with no printers available in the Set Default Printer HMI (including the local printer) and cannot print anywhere.

The correct method is to select Delete (when a remote printer is the default) then the local printer is made the default printer.  The Help file does not mention this fact though!!

Items:

------

sysgen/src/arctic/data/file_permissions.dat

sysgen/src/arctic/data/share_files.dat

sysgen/src/arctic/lib/ssb_PrinterInstall.pm

tamps/src/apps/lan/lpl/lpl_Net_Prnt_Desig_main.c

===================================================================

DTR:     D10658

SOR/STR: SOR 95-47

Title:   Could not print to a remote workstation's printer

Description:

I was on a connected client workstation (california) with another workstation (iowa) and the permanent client (lifeboat) also connected (with printers) to the E4000.  I could designate and print to the printer on the permanent client but could not print to the iowa printer.  The iowa printer showed up as the default printer after designating but any print jobs sent to it did not reach it and also did not show up in the Print Queue HMI.

Items:

------

tamps/src/apps/lan/lcl/lcl_disconnectHMIcb.c

tamps/src/apps/lan/lol/lol_Connection.c

tamps/src/apps/lan/lpl/lpl_Create_Default_Printer_HMI.c

===================================================================

DTR:     D10659

SOR/STR: SOR 95-47

Title:   Default Printer at Disconnect

Description:

If a workstation has a remote printer designated as it's default printer and the remote printer is taken offline (the machine it is attached to is disconnected from the MPLAN), the workstation will then have no default printer.  The problem is, when the Sys Admin on that workstation tries to designate a different printer using the Set Default Printer HMI, this process fails and an error message is displayed.  The SysAdmin has to run:  "lpadmin -d cops" from the command line as the root user to clear the problem (and designate the workstation's local printer as default).

Items:

------

===================================================================

DTR:     D10660

SOR/STR: SOR 95-47

Title:   LAN Printer not working

Description:

With a serve lite(no local printer) using ethernet and one client connected with a printer. Designated the client printer as a network printer using the menu under MPLAN> Designate Network Printer. On the server lite selected the client printer as the default. It showe up in the Set Default Printer window as the default, but could not print anything from the server lite. In shell lpstat -l -p showed cops_arizona  faulted after the entry for Default port settings.

Items:

------

sysgen/src/arctic/data/startup_scripts.dat

tamps/src/apps/lan/include/lpl_defines.h

tamps/src/apps/lan/lol/lol_Connection.c

tamps/src/apps/lan/lpl/lpl_Create_Class.sh

tamps/src/apps/lan/lpl/lpl_Create_Net_Prnt_Desig_HMI.c

tamps/src/apps/lan/lpl/lpl_Utilities.c

===================================================================

DTR:     D10661

SOR/STR: SOR 95-47

Title:   HI Client NIS Passwd table deleted

Description:

After disconnecting a Hi Client from MPLAN, user could not log into system using previous valid accounts. Logged in as root and checked niscat passwd and the table was empty.

Items:

------

sysgen/src/arctic/lib/ssb_OsSetup.pm

tamps/src/scripts/lan/lcl/Connect.sh.temp

tamps/src/scripts/lan/lcl/Disconnect.sh.temp

tamps/src/scripts/lan/lcl/lcl_preConnection.sh

tamps/src/scripts/lan/lcl/lcl_preDisconnect.sh

===================================================================

DTR:     D10662

SOR/STR: SOR 97-11

Title:   JTIM Product Request Crash

Description:

Initiating a request for either a target tasking product or a PPIP product causes the MPM to crash.

Items:

------

tamps/src/libs/jtim/jfg/jfg_file_cb.c

tamps/src/libs/jtim/jpg/jpg_GenerateJsipsnProduct.c

tamps/src/libs/jtim/jrg/jrg_functions.c

tamps/src/libs/jtim/jrg/jrg_retrieve.c

tamps/src/libs/jtim/jsg/jsg_FileMonitor.c

tamps/src/libs/jtim/jsg/jsg_TextStrings.c

tamps/src/libs/jtim/jsg/jsg_detail_cb.c

tamps/src/libs/jtim/jug/jug_gui.c

tamps/src/libs/jtim/jug/jug_vwrgui.c

===================================================================

DTR:     D10663

SOR/STR: SOR 95-47

Title:   Mission Import from tape messages

Description:

This is similar to DTR #381 except this pertains to mission import from media vice xfer between client/server.

If a Mission Import to either a client or server database from Media is performed and the database already contains missions with the same names as those being transferred, error messages are properly displayed.  However, a message saying "Mission Import Completed Successfully" is displayed also.

Items:

------

tamps/src/libs/b_msn_tools/bmt/bmt_mission.c

===================================================================

DTR:     D10666

SOR/STR: 96-01

Title:   AMP Info for DBA Target not showing CC or JMEM Type

Description:

(Object Query for Mary)

Amp information for DBA target does not show value for country code or JMEM_Type

Items:

------

===================================================================

DTR:     D10668

SOR/STR: 96-01a

Title:   C_EQP index not getting created - WW#2 MIDB load

Description:

C_EQP index does not get created on MIDB World Wide #2 load

Items:

------

===================================================================

DTR:     D10669

SOR/STR: 96-01a

Title:   Name in TGT definition not being displayed in AMP INFO

Description:

Name field appearing in TGT definition is not being displayed in AMP INFO for the programmatic planner target object (small triangle)

Items:

------

tamps/src/libs/a_msn_plan/amt/amt_bkdata.c

tamps/src/libs/a_msn_plan/amt/amt_objclass.c

===================================================================

DTR:     D10670

SOR/STR: 96-01a

Title:   Datum selection not functioning in Planner Target Updates

Description:

Datum selection in planner target updates is not functional

Items:

------

tamps/src/libs/b_msn_tools/btt/btt_deftgtcb.c

===================================================================

DTR:     D10671

SOR/STR: SOR 97-11

Title:   Saving JTIM PGMs or TAMs

Description:

When trying to save a PGM product or TAM from the JTIM Query Results / Retrieve HMI, get an error message that says: "Only images may be stored on tamps".  Workaround is to open the image in the imagery toolkit and use File -> Save.

Items:

------

tamps/src/libs/jtim/jrg/jrg_TAMPS_Inter.c

tamps/src/libs/jtim/jrg/jrg_retrieve_cb.c

===================================================================

DTR:     D10672

SOR/STR: SOR 95-43

Title:   No Additional MPM Can Be Opened

Description:

It is becoming relatively common (a daily occurrence), during testing, for one of the workstations to reach a state where no additional MPMs can be opened.  The conditions under which this occurs vary, but a common thread seems to be that a DBA Module is open at the time of the failure, and usually the user reports recently loading or transferring data to/from the database.  Usually stopping and starting the object server clears the problem, but sometimes a reboot is required.

Related to ITR 629i

Items:

------

tamps/src/apps/objh/ost/Makefile

===================================================================

DTR:     D10673

SOR/STR: 96-01a

Title:   MIDB Query printer default classification incorrect

Description:

Print option in the MIDB production tools query window defaults to an incorrect classification.  The default selection is a higher classification with caveats and there are no options for any other classification.

Items:

------

sysgen/src/arctic/scripts/load_midb.prl

===================================================================

DTR:     D10674

SOR/STR: 96-01a

Title:   Planner target update HORIZ_ORIENT_UM not being stored correctly

Description:

If you leave the toggle  alone, a NULL gets entered in the field.  If you toggle it to DEG-MAG, a 1 gets entered in the field.  If I toggle it back to DEG-TRUE, a NULL gets entered into the field.

Note: The object on planner targets is expecting 1 to be DEGREES TRUE and 2 to be DEGREES MAG.

More info from Mary:

Regarding DTR 674 (problems with HORIZ_ORIENT_UM in planner targets), if the decode table needs to have revised values, they are inserted within the src/dbinstall/tampsdb/create/mission/tamps_plnr_target_create.sql file as follows:

insert into TAMPS_HORIZ_ORIENT_UM_XREF

values

("1","DEGREES TRUE")

go

insert into TAMPS_HORIZ_ORIENT_UM_XREF

values

("2","DEGREES MAG")

go

Items:

------

tamps/src/libs/b_msn_tools/btt/btt_deftgt.c

tamps/src/libs/b_msn_tools/btt/btt_deftgtcb.c

tamps/src/libs/b_msn_tools/include/btt_deftgt.h

tamps/src/libs/b_msn_tools/include/btt_priv_proto.h

===================================================================

DTR:     D10677

SOR/STR: SOR 96-01

Title:   MIDB Tools

Description:

On super client 2300 & Clients connected via ATM to server 4000.   Could not use the MIDB Tools on super client 2300 and clients ULTRA2.   This is from the DBA Module -> Util -> MIDB Tools:Database  -> Query & Count, Ref -> Cat Code & Equip Codes & CC & Gen Ref and Data Exchange.

ERROR MSG:Entry for user server TAMPS does not exist in the database access file.  Access to database denied.  Unable to access dataserver TAMPS.  Ether you do not have proper privileges, or the dataserver is not running and needs to be restarted.  Could not find entry for user in database access file.

Items:

------

tamps/src/libs/dbase/dut/dut_runMIDB.c

===================================================================

DTR:     D10679

SOR/STR: SOR96-01

Title:   Update replication server scripts status windows

Description:

After resync is completed successfully, LAN deamon doesn't receive the

"connect" message.

Items:

------

tamps/src/scripts/lan/lut/lut_rsDisconnect.pl

tamps/src/scripts/lan/lut/lut_rsReSync.pl

===================================================================

DTR:     D10680

SOR/STR: SOR 95-47

Title:   GCCS Admin applications need Hour Glass displays

Description:

The GCCS Admins applications sometimes take more than a few seconds.

An hourglass should be displayed per the HMI guide.

Items:

------

tamps/src/apps/lan/ljl/ljl_connectCb.c

tamps/src/apps/lan/ljl/ljl_connectmain.c

tamps/src/apps/lan/ljl/ljl_disconnectCb.c

tamps/src/apps/lan/ljl/ljl_disconnectmain.c

tamps/src/apps/lan/ljl/ljl_reinitCb.c

tamps/src/apps/lan/ljl/ljl_reinitmain.c

tamps/src/apps/lan/ljl/ljl_resyncCb.c

tamps/src/apps/lan/ljl/ljl_resyncmain.c

===================================================================

DTR:     D10681

SOR/STR: SOR 96-01

Title:   RTM's not working

Description:

Queried for radar's and tried to do RTM's.  The systems tried were ULTRA2 Stand Alone, Server 4000, super client 2300 & client's ULTRA2 via ATM.  The system would only hang up and require killing the MPM or logoff to correct. This was with MIDB WW2 and NID from 9711 loaded.

Items:

------

===================================================================

DTR:     D10682

SOR/STR: SOR 97-11

Title:   NITF images

Description:

NITF data for actual and number of bits/pixel and justification of abpp was not being used. causes any NITF data other than 8 bit to be interpreted wrong.

Items:

------

tamps/src/libs/tms/tit/tit_readnitfuncompressed.c

===================================================================

DTR:     D10683

SOR/STR: SOR 96-60H

Title:   Attempt to export an object that was imported, hangs up process

Description:

Exported a new test object NAVY_TACANS with one associated query to 3.5 floppy. Then deleted the object. Imported the object to same system and no problems. Rebooted system and Object/Query was there. Next, tried to export the same object to 8mm tape and it just hung up the process. Used the default tape device 8mm hi dens. Had to kill the oil_Export process. Also, it looked like the .odf file was not created. Created another new object and it exported to tape OK.

96-60H.2

Items:

------

===================================================================

DTR:     D10687

SOR/STR: SOR 97-11

Title:   JTIM MGRS Value Sticks

Description:

The MGRS value in the JTIM imagery toolkit only updates the first time a lat/lon is selected.  After that any lat/lon pick from the image using the arrow updates the lat/lon value, but not the MGRS.

Items:

------

tamps/src/contrib/jtim_gots/iiviewer/include/gui_local_types.h

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.a

tamps/src/contrib/jtim_gots/iiviewer/lib/libiiviewer.so

tamps/src/libs/jtim/include/jpg_priv_proto.h

tamps/src/libs/jtim/include/jsg_priv_define.h

tamps/src/libs/jtim/include/jug_priv_proto.h

tamps/src/libs/jtim/include/jug_priv_structs.h

tamps/src/libs/jtim/jfg/jfg_file_cb.c

tamps/src/libs/jtim/jpg/jpg_CalculatePerspectiveScene.c

tamps/src/libs/jtim/jpg/jpg_GeneratePerspectiveScene.c

tamps/src/libs/jtim/jpg/jpg_GeneratePerspectiveScene_CB.c

tamps/src/libs/jtim/jpg/jpg_chip_file.c

tamps/src/libs/jtim/jpg/jpg_products_cb.c

tamps/src/libs/jtim/jqg/jqg_ImageQuery.c

tamps/src/libs/jtim/jrg/jrg_functions.c

tamps/src/libs/jtim/jsg/jsg_TextStrings.c

tamps/src/libs/jtim/jsg/jsg_detail_cb.c

tamps/src/libs/jtim/jtg/jtg_vwrapp.c

tamps/src/libs/jtim/jug/jug_vwrgui.c

===================================================================

DTR:     D10694

SOR/STR: SOR 97-11

Title:   Cancelling JTIM Product Requests

Description:

Cancelling JTIM product requests does not work correctly.  Cancelling a single request changes the status of all requests to "cancelled".

Items:

------

tamps/src/libs/jtim/jpg/jpg_CancelRequest.c

tamps/src/libs/jtim/jpg/jpg_GenerateJsipsnProduct.c

===================================================================

DTR:     D10695

SOR/STR: SOR 95-47

Title:   Unable to Load Charts from Client

Description:

Tried to load a TPC chart from a client workstation to the E4000 server.  Got error message:  "Ran out of storage space on the selected destination drive.  You may choose another destination or cancel load" even though there is plenty of space available in the server maps directory.

This problem is caused by the problem reported in DTR 633 - server directories not being cross-mounted.

Items:

------

===================================================================

DTR:     D10697

SOR/STR: SOR 96-01

Title:   Missing data items in dft_getTargetData()

Description:

The function dft_getTargetData() does not fill in the vertical location error

or the photo chip number for planner targets, even though this information

is available in the data record.

Items:

------

tamps/CLASSIFIED/src/dbinstall/load/data/DD_USER_FIELDS.backup

tamps/include/dbase/dit_defines.h

tamps/src/bindings/dit_defines.a

tamps/src/libs/a_msn_plan/art/art_utils.c

tamps/src/libs/dbase/dft/dft_getTargetData_c.C

tamps/src/libs/dbase/dit/dit_PlannerTarget_c.C

tamps/src/libs/dbase/dit/dit_plnrTargetHandle.C

tamps/src/libs/dbase/include/dft_TargetData_c.H

===================================================================

DTR:     D10698

SOR/STR: SOR 95-47

Title:   MPM connect/update scripts being run at wrong time.

Description:

The update script is invoked after the user logs in followed by the MPM Connect script.

I would expect only the Connect script to be invoked.  Furthermore, the connect script

must be invoked AFTER the account deconfliction has taken place permitting the FA-18 connect script to address the client accounts which

have been renamed for transfer to the server.

Items:

------

tamps/src/apps/lan/lcl/lcl_connectUsers.c

tamps/src/apps/lan/lcl/lcl_usrconfHMIcb.c

tamps/src/libs/dbase/dml/dml_dataXfer.c

===================================================================

DTR:     D10699

SOR/STR: SOR 95-47

Title:   Misleading Error When Loading Charts

Description:

If a user attempts to reload a chart which has already been loaded, an error message is displayed that says: "Ran out of storage space on the selected destination drive.  You may choose another destination or cancel load".  This error is misleading since the user will believe that there is no room to load additional charts, even though there may be plenty.

This problem is different than the problem described in DTR 695, and happens on any hardware set-up, including stand-alone workstations.

Items:

------

tamps/src/libs/tms/trt/trt_getADRGfiles.c

tamps/src/libs/tms/tut/tut_cd_2_dk.c

===================================================================

DTR:     D10700

SOR/STR: SOR 96-01

Title:   Maximum checks for subscription validation

Description:

I had set a maximum number of checking for subscription validation. It was set to 30. However, since we are not sure how many updates would be submitted during the synchronization process, I feel it would be safer to increse the number so it won't quit due to a large amount of updates.

Items:

------

tamps/src/scripts/lan/lut/lut_validSubscrips.sh

===================================================================

DTR:     D10702

SOR/STR: SOR 95-47

Title:   Loading Radar Aimpoints Fails from Client

Description:

Unable to load radar aimpoints from client to server.  Worked OK on standalone W/S.

Items:

------

===================================================================

DTR:     D10703

SOR/STR: SOR 95-47

Title:   Landsat Imagery Load Fails, from Client

Description:

Unable to load landsat imagery from the client to the server.   Only the header file gets copied to the directory. Worked OK on standalone W/S.

Items:

------

===================================================================

DTR:     D10704

SOR/STR: D10200

Title:   Sysgen Can't Set Root Password

Description:

Set of root password at end of Sysgen prompts fails.  Fixes put in for D10200

assume NIS+ is running, which is not the case during initial Sysgen.

Items:

------

sysgen/src/common/lib/ssb_embedUserAdmin.pm

===================================================================

DTR:     D10710

SOR/STR: SOR 96-52M

Title:   PC Card Formatting Code Missing Colons

Description:

Commas missing from Boeing provided Core PC Card Formatting code.  Makes formatting code which is critical to TAMMAC functionality unusable.

Items:

------

tamps/src/apps/contrib/util/upb/upb_card_formatting_menu.c

===================================================================

DTR:     D10715

SOR/STR: HelpFilesInit

Title:   Lockheed help files

Description:

Corrections to existing help files.

Items:

------

tamps/CLASSIFIED/src/data/help/thc/thc_help_script

===================================================================

DTR:     D10716

SOR/STR: 6697

Title:   Kcard displaying N- for southerly planned msn

Description:

The Kcard is displaying N- for missions planned in the southern hemi.  The N-

should be displayed as an S.

Items:

------

tamps/src/libs/products/prl/prl_aircrew_bind.c

===================================================================

DTR:     D10717

SOR/STR: SOR 96-01

Title:   Replication system status return

Description:

After JMCIS replication server had been shutdown, LAN deamon did not receive a correct status.

Items:

------

tamps/src/scripts/lan/lut/lut_rsDisconnect.pl

tamps/src/scripts/lan/lut/lut_rsStatLoad.pl

tamps/src/scripts/lan/lut/lut_rsStatus.sh

===================================================================

A.5
Non-DTRs in this Release

Non-DTRs in release TAMPS 6.2 dated, 11 March 1998.

===================================================================

Package: 6.2_Initialization

Title:   6.2_Initialization, initial harvest load.

Description:

This package contains further changes required to create the TAMPS 6.2 baseline. The TAMPS 6.1.1 baseline was first loaded into the CCC Harvest CM System to create the 6.2 baseline. A second TAMPS 6.2 baseline, external to Harvest, had diverged prior to Harvest setup. This package incorporates those diverged differences. All TAMPS 6.2 work resumed through the CCC Harvest System.

Item(s)

-------

tamps/bin/cmtree.sh

tamps/bin/refdir_makeskel.prl

tamps/config/kMake

tamps/config/lMake.sparcworks

tamps/config/lMake.static

tamps/config/pMake.sparcworks

tamps/config/sMake

tamps/env/.cshrc_include

tamps/env/README

tamps/env/tamps.env.dev

tamps/include/a_msn_plan/aet_enum.h

tamps/include/a_msn_plan/aet_proto.h

tamps/include/a_msn_plan/aft_proto.h

tamps/include/a_msn_plan/ait_proto.h

tamps/include/a_msn_plan/amt_proto.h

tamps/include/a_msn_plan/axt_defines.h

tamps/include/a_msn_plan/axt_enum.h

tamps/include/a_msn_plan/azt_copter_defines.h

tamps/include/a_msn_plan/azt_copter_proto.h

tamps/include/a_msn_plan/azt_error_defines.h

tamps/include/dbase/dmt_geo_struct.h

tamps/include/dbase/dmt_geocfg_struct.h

tamps/include/maps/mpt_proto.h

tamps/include/maps/mt_defs.h

tamps/include/system/sit_default_defines.h

tamps/include/tms/VPFLock.H

tamps/include/util/uzt_structs.h

tamps/include_prot/a_msn_plan/amt_prot_proto.h

tamps/include_prot/dbase/dmt_default_defines.h

tamps/include_prot/dbase/dmt_geo_defines.h

tamps/include_prot/dbase/dmt_geo_structs.h

tamps/include_prot/dbase/dmt_prot_proto.h

tamps/include_prot/dbase/dpl_prot_proto.h

tamps/mpm/Makefile

tamps/src/apps/Makefile

tamps/src/apps/appgen/defs/BuildApps.csh

tamps/src/apps/appgen/defs/Makefile

tamps/src/apps/appgen/dpl/Makefile

tamps/src/apps/appgen/dpl/dpl_yuma.c

tamps/src/apps/comms/cnl_DIRscan/cnl_grid/Makefile

tamps/src/apps/comms/cnl_DIRscan/cnl_ovly2/Makefile

tamps/src/apps/comms/include/BuildCOMMIncs.csh

tamps/src/apps/comms/include/Makefile

tamps/src/apps/compass/static/make_scripts

tamps/src/apps/dbase/ddt/ddt_loader.c

tamps/src/apps/dbase/ddt/ddt_main.c

tamps/src/apps/products/ppt/make_pltool

tamps/src/apps/wse/Makefile

tamps/src/contrib/ACE_wrappers/include/ace/sysincludes.h

tamps/src/contrib/ACE_wrappers/src/Makefile

tamps/src/data/environment/make_envs

tamps/src/data/environment/tamps.cno

tamps/src/data/environment/tamps.env

tamps/src/data/maps/make_data

tamps/src/data/sysadmin/zet/.xinitrc

tamps/src/data/wse/system_utils.menu

tamps/src/dbinstall/sprocs/tamps_nid_ranges_create.sql

tamps/src/libs/a_msn_plan/Makefile

tamps/src/libs/a_msn_plan/aet/aet_AccessUtils.c

tamps/src/libs/a_msn_plan/aet/aet_EditNavCb.c

tamps/src/libs/a_msn_plan/aet/aet_MCPRutils.c

tamps/src/libs/a_msn_plan/aet/aet_NavUtils.c

tamps/src/libs/a_msn_plan/aet/aet_RouteUtils.c

tamps/src/libs/a_msn_plan/aft/aft_FlightEventsDialog.c

tamps/src/libs/a_msn_plan/aft/aft_FlightUtils.c

tamps/src/libs/a_msn_plan/ait/ait_CreateLaunchDetailsDialog.c

tamps/src/libs/a_msn_plan/ait/ait_LaunchDetailsCb.c

tamps/src/libs/a_msn_plan/ait/ait_memManagement.c

tamps/src/libs/a_msn_plan/ait/ait_msnDefaultDialog.c

tamps/src/libs/a_msn_plan/amt/amt_bkdata.c

tamps/src/libs/a_msn_plan/amt/amt_rtdisp.c

tamps/src/libs/a_msn_plan/axt/Makefile

tamps/src/libs/a_msn_plan/axt/axt_addHandle.c

tamps/src/libs/a_msn_plan/axt/axt_copyHandle.c

tamps/src/libs/a_msn_plan/axt/axt_createHandle.c

tamps/src/libs/a_msn_plan/axt/axt_deleteHandle.c

tamps/src/libs/a_msn_plan/axt/axt_findHandle.c

tamps/src/libs/a_msn_plan/axt/axt_insert.c

tamps/src/libs/a_msn_plan/axt/axt_update.c

tamps/src/libs/a_msn_plan/axt/axt_waypoint.c

tamps/src/libs/a_msn_plan/azt/Makefile

tamps/src/libs/a_msn_plan/azt/azt_copter_polynomial_functions.c

tamps/src/libs/a_msn_plan/azt/azt_error.c

tamps/src/libs/a_msn_plan/include/amt_priv_proto.h

tamps/src/libs/a_msn_plan/include/axt_handle_defines.h

tamps/src/libs/a_msn_plan/include/azt_copter_tables.h

tamps/src/libs/a_msn_plan/include/make_includes

tamps/src/libs/a_msn_plan/include/make_scripts

tamps/src/libs/appgen/arl/IDBLentry.c

tamps/src/libs/b_msn_tools/bat/bat_bucket_handler.c

tamps/src/libs/b_msn_tools/bel/bel_motif.c

tamps/src/libs/b_msn_tools/bgt/bgt_isitefl.c

tamps/src/libs/b_msn_tools/bgt/bgt_util.c

tamps/src/libs/b_msn_tools/blt/blt_ldchc.c

tamps/src/libs/b_msn_tools/blt/blt_ldmnc.c

tamps/src/libs/b_msn_tools/bst/bst_createContentsDialog.c

tamps/src/libs/b_msn_tools/btt/btt_deftgtcb.c

tamps/src/libs/b_msn_tools/include/blt_defines.h

tamps/src/libs/b_msn_tools/include/make_scripts

tamps/src/libs/comms/RIczl/czl_RIendTm.c

tamps/src/libs/comms/RIczl/czl_RIstrTm.c

tamps/src/libs/comms/include/BuildIncs.csh

tamps/src/libs/comms/include/Makefile

tamps/src/libs/dbase/Makefile

tamps/src/libs/dbase/dht/dht_geobox.c

tamps/src/libs/dbase/dlt/Makefile

tamps/src/libs/dbase/dlt/dlt_mpLdMMI.c

tamps/src/libs/dbase/dmt/Makefile

tamps/src/libs/dbase/dmt/dmt_gclear.c

tamps/src/libs/dbase/dmt/dmt_gdelete.c

tamps/src/libs/dbase/dmt/dmt_gdisplay.c

tamps/src/libs/dbase/dmt/dmt_geo.c

tamps/src/libs/dbase/dmt/dmt_geoMMI.c

tamps/src/libs/dbase/dmt/dmt_geobox.c

tamps/src/libs/dbase/dmt/dmt_geocb.c

tamps/src/libs/dbase/dmt/dmt_geocirc.c

tamps/src/libs/dbase/dmt/dmt_geolist.c

tamps/src/libs/dbase/dmt/dmt_geopoly.c

tamps/src/libs/dbase/dmt/dmt_georte.c

tamps/src/libs/dbase/dmt/dmt_geoupdt.c

tamps/src/libs/dbase/dmt/dmt_gsave.c

tamps/src/libs/dbase/dmt/dmt_gselMMI.c

tamps/src/libs/dbase/dmt/dmt_gselcb.c

tamps/src/libs/dbase/dmt/dmt_gselect.c

tamps/src/libs/dbase/dmt/dmt_init.c

tamps/src/libs/dbase/dmt/dmt_menu.c

tamps/src/libs/dbase/dmt/dmt_menuMMI.c

tamps/src/libs/dbase/dmt/dmt_role.c

tamps/src/libs/dbase/dnt/dnt_dafidCb.c

tamps/src/libs/dbase/dnt/dnt_enroute.c

tamps/src/libs/dbase/dwl/dwl_dbase_get_char_data.c

tamps/src/libs/dbase/include/dmt_priv_proto.h

tamps/src/libs/dbase/include/dnt_dafid_struct.h

tamps/src/libs/e_threat/eat/eat_thrAsmnt.c

tamps/src/libs/e_threat/edt/edt_layer.c

tamps/src/libs/e_threat/ert/ert_layer.c

tamps/src/libs/gfe_polynomials/Makefile

tamps/src/libs/gfe_polynomials/make_scripts

tamps/src/libs/layer/ltt/ltt_opnew.c

tamps/src/libs/maps/mmt/mmt_bkgnd.c

tamps/src/libs/maps/mmt/mmt_bkgndcb.c

tamps/src/libs/maps/mmt/mmt_gridcb.c

tamps/src/libs/maps/mmt/mmt_imagery.c

tamps/src/libs/maps/mmt/mmt_legdMMI.c

tamps/src/libs/maps/mmt/mmt_maoiMMI.c

tamps/src/libs/maps/mpt/mpt_bldPrim.c

tamps/src/libs/maps/mpt/mpt_intFnc.c

tamps/src/libs/maps/mpt/mpt_modObjs.c

tamps/src/libs/maps/mwl/mwl_MPMSelection.c

tamps/src/libs/system/sit/sit_defaultMenu.c

tamps/src/libs/system/sit/sit_tbar.c

tamps/src/libs/tms/include/t3t_priv_proto.h

tamps/src/libs/tms/t3t/t3t_generateperspective.c

tamps/src/libs/tms/tit/Makefile

tamps/src/libs/tms/tit/tit_nitfgeorectify.c

tamps/src/libs/util/uxt/uxt_tbar.c

tamps/src/libs/wse/Makefile

tamps/src/libs/wse/wmt/wmt_invoke.c

===================================================================

Package: TAMMAC

Item(s)

-------

tamps/include/maps/mtm_proto.h

tamps/src/bindings/Makefile

tamps/src/bindings/mtm.a

tamps/src/bindings/mtm_.a

tamps/src/libs/maps/Makefile

tamps/src/libs/maps/mtm/Makefile

tamps/src/libs/maps/mtm/mtm_api_functions.c

tamps/src/test/SOR9652A_BOEING/mtm_test.ada

tamps/src/test/SOR9652A_BOEING/mtm_test.c

===================================================================

Package: TAMMAC_PCCard

Item(s)

-------

tamps/include/util/upl_defines.h

tamps/include/util/upl_proto.h

tamps/src/libs/util/upl/MakeLib

tamps/src/libs/util/upl/upl_cardtype.c

===================================================================

Package: e2c

Item(s)

-------

tamps/mpm/Makefile

tamps/mpm/e2c/src/Makefile

tamps/mpm/e2c/src/e2c/Makefile

tamps/mpm/e2c/src/e2c/e2c_cancel_callback.c

tamps/mpm/e2c/src/e2c/e2c_error.c

tamps/mpm/e2c/src/e2c/e2c_exit.c

tamps/mpm/e2c/src/e2c/e2c_main.c

tamps/mpm/e2c/src/e2cada/Makefile

tamps/mpm/e2c/src/e2cada/etv_basic_data_types_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_basic_data_types_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_bdtp__altitude_feet_agl.ada

tamps/mpm/e2c/src/e2cada/etv_bdtp__altitude_feet_msl.ada

tamps/mpm/e2c/src/e2cada/etv_bdtp__altitude_meters_agl.ada

tamps/mpm/e2c/src/e2cada/etv_bdtp__altitude_meters_msl.ada

tamps/mpm/e2c/src/e2cada/etv_bdtp__distance_feet.ada

tamps/mpm/e2c/src/e2cada/etv_bdtp__distance_meters.ada

tamps/mpm/e2c/src/e2cada/etv_bdtp__distance_nm.ada

tamps/mpm/e2c/src/e2cada/etv_bdtp__temperature_centigrade.ada

tamps/mpm/e2c/src/e2cada/etv_bdtp__temperature_fahrenheit.ada

tamps/mpm/e2c/src/e2cada/etv_build_seg.ada

tamps/mpm/e2c/src/e2cada/etv_catalog_fetch.ada

tamps/mpm/e2c/src/e2cada/etv_e2c_data_types_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_e2c_data_types_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_e2cname_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_e2cname_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_egfp__append_di_list.ada

tamps/mpm/e2c/src/e2cada/etv_egfp__append_dla_list.ada

tamps/mpm/e2c/src/e2cada/etv_egfp__append_five_word_geo_point.ada

tamps/mpm/e2c/src/e2cada/etv_egfp__append_four_word_geo_point.ada

tamps/mpm/e2c/src/e2cada/etv_egfp__append_pi_list.ada

tamps/mpm/e2c/src/e2cada/etv_egfp__append_pu_list.ada

tamps/mpm/e2c/src/e2cada/etv_egfp__append_seven_word_geo_point.ada

tamps/mpm/e2c/src/e2cada/etv_egfp__append_six_word_geo_point.ada

tamps/mpm/e2c/src/e2cada/etv_egfp__formatted_geo_data.ada

tamps/mpm/e2c/src/e2cada/etv_emdu_data_handler_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_emdu_data_handler_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_emdu_file.ada

tamps/mpm/e2c/src/e2cada/etv_emdu_file_.ada

tamps/mpm/e2c/src/e2cada/etv_emdu_geo_format_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_emdu_geo_format_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_emdu_load_check.ada

tamps/mpm/e2c/src/e2cada/etv_emdu_map_format_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_emdu_map_format_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_emfp__attach_chain_path.ada

tamps/mpm/e2c/src/e2cada/etv_emfp__formatted_map_data.ada

tamps/mpm/e2c/src/e2cada/etv_extract_emdu.ada

tamps/mpm/e2c/src/e2cada/etv_gps_format_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_gps_format_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_jtids_handler.ada

tamps/mpm/e2c/src/e2cada/etv_jtids_handler_.ada

tamps/mpm/e2c/src/e2cada/etv_new_srlset.c

tamps/mpm/e2c/src/e2cada/etv_short_utilities_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_short_utilities_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_signal_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_signal_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_srlset.c

tamps/mpm/e2c/src/e2cada/etv_srlval.c

tamps/mpm/e2c/src/e2cada/etv_sup__delete_files.ada

tamps/mpm/e2c/src/e2cada/etv_sup__file_exists.ada

tamps/mpm/e2c/src/e2cada/etv_sup__free_disk_space.ada

tamps/mpm/e2c/src/e2cada/etv_sup__run_executable.ada

tamps/mpm/e2c/src/e2cada/etv_sup__submit_job.ada

tamps/mpm/e2c/src/e2cada/etv_system_serial_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_system_serial_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_system_utilities_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_system_utilities_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__disable_ttc.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__enable_ttc.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__erase_ttc.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__get_tid_status.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__load_ttc.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__move_ttc.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__read_ttc.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__skip_ttc.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__test_status.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__tid_ready.ada

tamps/mpm/e2c/src/e2cada/etv_tdp__write_ttc.ada

tamps/mpm/e2c/src/e2cada/etv_tid_driver_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_tid_driver_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_tid_operation_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_tid_operation_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_tid_process.ada

tamps/mpm/e2c/src/e2cada/etv_tid_sendcommand.c

tamps/mpm/e2c/src/e2cada/etv_tid_serial_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_tid_serial_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_ttc_tactical_file_pkg.ada

tamps/mpm/e2c/src/e2cada/etv_ttc_tactical_file_pkg_.ada

tamps/mpm/e2c/src/e2cada/etv_ttc_utilities.c

tamps/mpm/e2c/src/e2cada/etv_ttfp__get_tactical_version.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__read_jtids_data.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__read_system_catalog.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__read_system_supervisor.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__seek_tactical_file.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__store_last_block_number.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__update_system_catalog_data.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__write_geo_data.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__write_gps_data.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__write_jtids_data.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__write_map_data.ada

tamps/mpm/e2c/src/e2cada/etv_ttfp__write_system_catalog_data.ada

tamps/mpm/e2c/src/e2cada/etv_up__adjust_real_number_text.ada

tamps/mpm/e2c/src/e2cada/etv_up__equal_name.ada

tamps/mpm/e2c/src/e2cada/etv_up__float_to_text.ada

tamps/mpm/e2c/src/e2cada/etv_up__insert_text.ada

tamps/mpm/e2c/src/e2cada/etv_up__integer_to_text.ada

tamps/mpm/e2c/src/e2cada/etv_up__long_float_to_text.ada

tamps/mpm/e2c/src/e2cada/etv_up__lower_case.ada

tamps/mpm/e2c/src/e2cada/etv_up__numeric_string_to_text.ada

tamps/mpm/e2c/src/e2cada/etv_up__substring_of_string.ada

tamps/mpm/e2c/src/e2cada/etv_up__text_to_float.ada

tamps/mpm/e2c/src/e2cada/etv_up__text_to_integer.ada

tamps/mpm/e2c/src/e2cada/etv_up__text_to_long_float.ada

tamps/mpm/e2c/src/e2cada/etv_up__text_to_numeric_string.ada

tamps/mpm/e2c/src/e2cada/etv_up__upper_case.ada

tamps/mpm/e2c/src/e2cada/etv_up_tti__adjust_integer_number_text.ada

tamps/mpm/e2c/src/e2cada/etv_v_message.ada

tamps/mpm/e2c/src/e2cada/etv_v_message_.ada

tamps/mpm/e2c/src/e2cada/make_ada

tamps/mpm/e2c/src/e2cada/make_c

tamps/mpm/e2c/src/e2ccv/Makefile

tamps/mpm/e2c/src/e2ccv/ecv_route_validation.c

tamps/mpm/e2c/src/e2cdv/Makefile

tamps/mpm/e2c/src/e2cdv/edv_alphaChk_cb.c

tamps/mpm/e2c/src/e2cdv/edv_di_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_emduAtt.c

tamps/mpm/e2c/src/e2cdv/edv_emduClip.c

tamps/mpm/e2c/src/e2cdv/edv_emduCollectData.c

tamps/mpm/e2c/src/e2cdv/edv_emduDefineAreaCB.c

tamps/mpm/e2c/src/e2cdv/edv_emduDelCB.c

tamps/mpm/e2c/src/e2cdv/edv_emduDropPoint.c

tamps/mpm/e2c/src/e2cdv/edv_emduEditCB.c

tamps/mpm/e2c/src/e2cdv/edv_emduFileListFnc.c

tamps/mpm/e2c/src/e2cdv/edv_emduGeoFileFnc.c

tamps/mpm/e2c/src/e2cdv/edv_emduMapFileFnc.c

tamps/mpm/e2c/src/e2cdv/edv_emduSaveCB.c

tamps/mpm/e2c/src/e2cdv/edv_emduSize.c

tamps/mpm/e2c/src/e2cdv/edv_emduSuasObj.c

tamps/mpm/e2c/src/e2cdv/edv_emduViewCmpCB.c

tamps/mpm/e2c/src/e2cdv/edv_emdu_mdatasel_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_emduatt_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_emdudel_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_emdudelconf_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_emdudroppoint_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_emduedit_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_emdusave_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_emduview_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_octalChk_cb.c

tamps/mpm/e2c/src/e2cdv/edv_pi_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_pu_mmi.c

tamps/mpm/e2c/src/e2cdv/edv_purgePiDiPuValues.c

tamps/mpm/e2c/src/e2cdv/edv_savePiDiPuValues.c

tamps/mpm/e2c/src/e2cev/Makefile

tamps/mpm/e2c/src/e2cev/eev_hold_event.c

tamps/mpm/e2c/src/e2cev/eev_utils.c

tamps/mpm/e2c/src/e2cev/eev_validate_event.c

tamps/mpm/e2c/src/e2cfv/Makefile

tamps/mpm/e2c/src/e2cfv/efv_fuel_usage.c

tamps/mpm/e2c/src/e2cgv/Makefile

tamps/mpm/e2c/src/e2cgv/egv_addCB.c

tamps/mpm/e2c/src/e2cgv/egv_clipBoard.c

tamps/mpm/e2c/src/e2cgv/egv_closeCB.c

tamps/mpm/e2c/src/e2cgv/egv_collectMapData.c

tamps/mpm/e2c/src/e2cgv/egv_data.c

tamps/mpm/e2c/src/e2cgv/egv_deleteCB.c

tamps/mpm/e2c/src/e2cgv/egv_deleteItemCB.c

tamps/mpm/e2c/src/e2cgv/egv_displayMapData.c

tamps/mpm/e2c/src/e2cgv/egv_dragDrop.c

tamps/mpm/e2c/src/e2cgv/egv_editItemCB.c

tamps/mpm/e2c/src/e2cgv/egv_editfp_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_editmsg_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_editnfz_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_editta_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_editwp_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_exportCB.c

tamps/mpm/e2c/src/e2cgv/egv_exportFile.c

tamps/mpm/e2c/src/e2cgv/egv_gps_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_hookCB.c

tamps/mpm/e2c/src/e2cgv/egv_importCB.c

tamps/mpm/e2c/src/e2cgv/egv_importFile.c

tamps/mpm/e2c/src/e2cgv/egv_listSelectionCB.c

tamps/mpm/e2c/src/e2cgv/egv_newCB.c

tamps/mpm/e2c/src/e2cgv/egv_openCB.c

tamps/mpm/e2c/src/e2cgv/egv_openFile.c

tamps/mpm/e2c/src/e2cgv/egv_print_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_reorderfp_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_saveCB.c

tamps/mpm/e2c/src/e2cgv/egv_saveFile.c

tamps/mpm/e2c/src/e2cgv/egv_selectCB.c

tamps/mpm/e2c/src/e2cgv/egv_sortwp_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_utilities.c

tamps/mpm/e2c/src/e2cgv/egv_viewCB.c

tamps/mpm/e2c/src/e2civ/Makefile

tamps/mpm/e2c/src/e2civ/eiv_defaultMMI.c

tamps/mpm/e2c/src/e2civ/eiv_defineButtons.C

tamps/mpm/e2c/src/e2civ/eiv_defineButtons.c

tamps/mpm/e2c/src/e2civ/eiv_define_callbacks.c

tamps/mpm/e2c/src/e2civ/eiv_toolbar_init.c

tamps/mpm/e2c/src/e2clv/Makefile

tamps/mpm/e2c/src/e2clv/elv_FileSelect_Cb.C

tamps/mpm/e2c/src/e2clv/elv_FileSelect_MMI.C

tamps/mpm/e2c/src/e2clv/elv_MDL_Interface.C

tamps/mpm/e2c/src/e2clv/elv_MFCDU_File_Cb.C

tamps/mpm/e2c/src/e2clv/elv_MFCDU_File_MMI.C

tamps/mpm/e2c/src/e2clv/elv_MFCDU_File_c.C

tamps/mpm/e2c/src/e2clv/elv_MFCDU_c.C

tamps/mpm/e2c/src/e2clv/elv_MPM_MDL_Interface.C

tamps/mpm/e2c/src/e2clv/elv_db_funcs.C

tamps/mpm/e2c/src/e2clv/elv_error.C

tamps/mpm/e2c/src/e2clv/elv_mmi_utils.C

tamps/mpm/e2c/src/e2clv/elv_reports.C

tamps/mpm/e2c/src/e2cmv/Makefile

tamps/mpm/e2c/src/e2cmv/emv_default_flight_mode.c

tamps/mpm/e2c/src/e2cmv/emv_divert_calcs.c

tamps/mpm/e2c/src/e2cmv/emv_get_flight_mode.c

tamps/mpm/e2c/src/e2cmv/emv_load_poly.c

tamps/mpm/e2c/src/e2cmv/emv_process_modes.c

tamps/mpm/e2c/src/e2cmv/emv_set_flight_mode.c

tamps/mpm/e2c/src/e2cmv/emv_validate_flight_mode.c

tamps/mpm/e2c/src/e2ctv/Makefile

tamps/mpm/e2c/src/e2ctv/etv_tidCancelPB_cb.c

tamps/mpm/e2c/src/e2ctv/etv_tidCatScrolling_cb.c

tamps/mpm/e2c/src/e2ctv/etv_tidCatSelecting_cb.c

tamps/mpm/e2c/src/e2ctv/etv_tidData.c

tamps/mpm/e2c/src/e2ctv/etv_tidFindTopShell.c

tamps/mpm/e2c/src/e2ctv/etv_tidHelp_mmi.c

tamps/mpm/e2c/src/e2ctv/etv_tidManage_cb.c

tamps/mpm/e2c/src/e2ctv/etv_tidMoveFiles.c

tamps/mpm/e2c/src/e2ctv/etv_tidMsgbx.c

tamps/mpm/e2c/src/e2ctv/etv_tidMsnScrolling_cb.c

tamps/mpm/e2c/src/e2ctv/etv_tidMsnSelecting_cb.c

tamps/mpm/e2c/src/e2ctv/etv_tidMsnStoreJtids.c

tamps/mpm/e2c/src/e2ctv/etv_tidPushButton.c

tamps/mpm/e2c/src/e2ctv/etv_tidSendCommand.c

tamps/mpm/e2c/src/e2ctv/etv_tidTapeSelect.c

tamps/mpm/e2c/src/e2ctv/etv_tidUnHiLite_transfer.c

tamps/mpm/e2c/src/e2ctv/etv_tidUnmanage_cb.c

tamps/mpm/e2c/src/e2ctv/etv_tidWidgetIdsFromNames.c

tamps/mpm/e2c/src/e2ctv/etv_tidWriteDestChk_cb.c

tamps/mpm/e2c/src/e2ctv/etv_tid_mmi.c

tamps/mpm/e2c/src/e2cuv/Makefile

tamps/mpm/e2c/src/e2cuv/euv_matrix_ops.c

tamps/mpm/e2c/src/include/Makefile

tamps/mpm/e2c/src/include/e2c_data_struct.h

tamps/mpm/e2c/src/include/e2c_defines.h

tamps/mpm/e2c/src/include/e2c_error.h

tamps/mpm/e2c/src/include/e2c_error_defs.h

tamps/mpm/e2c/src/include/e2c_errors_attack.h

tamps/mpm/e2c/src/include/e2c_errors_general.h

tamps/mpm/e2c/src/include/e2c_exit.h

tamps/mpm/e2c/src/include/e2c_flight_events.h

tamps/mpm/e2c/src/include/e2c_globalWidgets.h

tamps/mpm/e2c/src/include/e2c_global_defs.h

tamps/mpm/e2c/src/include/e2c_segments.h

tamps/mpm/e2c/src/include/e2c_structs.h

tamps/mpm/e2c/src/include/e2c_update_action_pt.h

tamps/mpm/e2c/src/include/e2c_weapon_defs.h

tamps/mpm/e2c/src/include/eav_attack_modes.h

tamps/mpm/e2c/src/include/ecv_proto.h

tamps/mpm/e2c/src/include/ecv_route_validation.h

tamps/mpm/e2c/src/include/edv_diData.h

tamps/mpm/e2c/src/include/edv_emduAttData.h

tamps/mpm/e2c/src/include/edv_emduDropPointData.h

tamps/mpm/e2c/src/include/edv_emduEditData.h

tamps/mpm/e2c/src/include/edv_emduGlobalTags.h

tamps/mpm/e2c/src/include/edv_emduMapSrcData.h

tamps/mpm/e2c/src/include/edv_emduSaveData.h

tamps/mpm/e2c/src/include/edv_emduViewData.h

tamps/mpm/e2c/src/include/edv_geninclude.h

tamps/mpm/e2c/src/include/edv_piData.h

tamps/mpm/e2c/src/include/edv_proto.h

tamps/mpm/e2c/src/include/edv_puData.h

tamps/mpm/e2c/src/include/eev_hold_event.h

tamps/mpm/e2c/src/include/eev_proto.h

tamps/mpm/e2c/src/include/eev_validate_event.h

tamps/mpm/e2c/src/include/efv_fuel_usage.h

tamps/mpm/e2c/src/include/efv_proto.h

tamps/mpm/e2c/src/include/egv_defines.h

tamps/mpm/e2c/src/include/egv_proto.h

tamps/mpm/e2c/src/include/egv_struct.h

tamps/mpm/e2c/src/include/eiv_define_callbacks.h

tamps/mpm/e2c/src/include/eiv_proto.h

tamps/mpm/e2c/src/include/eiv_toolbar_init.h

tamps/mpm/e2c/src/include/elv_FileSelect_MMI.H

tamps/mpm/e2c/src/include/elv_MFCDU_File_MMI.H

tamps/mpm/e2c/src/include/elv_MFCDU_File_c.H

tamps/mpm/e2c/src/include/elv_MFCDU_c.H

tamps/mpm/e2c/src/include/elv_mdl_interface.H

tamps/mpm/e2c/src/include/elv_priv_defines.H

tamps/mpm/e2c/src/include/elv_priv_proto.H

tamps/mpm/e2c/src/include/elv_proto.h

tamps/mpm/e2c/src/include/elv_structs.H

tamps/mpm/e2c/src/include/emv_flight_modes.h

tamps/mpm/e2c/src/include/emv_proto.h

tamps/mpm/e2c/src/include/etv_proto.h

tamps/mpm/e2c/src/include/euv_matrix_defines.h

tamps/mpm/e2c/src/include/euv_matrix_ops.h

tamps/mpm/e2c/src/include/euv_proto.h

tamps/mpm/e2c/src/include/ewv_attack_calcs.h

===================================================================

Package: e2cBLD3A

Item(s)

-------

tamps/mpm/e2c/dbinstall/e2cplus_symbols.bcp

tamps/mpm/e2c/src/e2c/e2c_main.c

tamps/mpm/e2c/src/e2cada/etv_catalog_fetch.ada

tamps/mpm/e2c/src/e2cada/etv_tid_operation_pkg.ada

tamps/mpm/e2c/src/e2cgv/egv_addCB.c

tamps/mpm/e2c/src/e2cgv/egv_clipBoard.c

tamps/mpm/e2c/src/e2cgv/egv_collectMapData.c

tamps/mpm/e2c/src/e2cgv/egv_data.c

tamps/mpm/e2c/src/e2cgv/egv_deleteItemCB.c

tamps/mpm/e2c/src/e2cgv/egv_displayMapData.c

tamps/mpm/e2c/src/e2cgv/egv_editItemCB.c

tamps/mpm/e2c/src/e2cgv/egv_editfp_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_editmsg_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_editnfz_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_editta_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_editwp_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_exportFile.c

tamps/mpm/e2c/src/e2cgv/egv_gps_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_hookCB.c

tamps/mpm/e2c/src/e2cgv/egv_importFile.c

tamps/mpm/e2c/src/e2cgv/egv_listSelectionCB.c

tamps/mpm/e2c/src/e2cgv/egv_openFile.c

tamps/mpm/e2c/src/e2cgv/egv_print_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_saveCB.c

tamps/mpm/e2c/src/e2cgv/egv_sortwp_mmi.c

tamps/mpm/e2c/src/e2cgv/egv_utilities.c

tamps/mpm/e2c/src/e2cgv/egv_viewCB.c

tamps/mpm/e2c/src/e2ctv/etv_tidMsnStoreJtids.c

tamps/mpm/e2c/src/e2ctv/etv_tidWriteDestChk_cb.c

tamps/mpm/e2c/src/include/egv_defines.h

tamps/mpm/e2c/src/include/egv_proto.h

tamps/mpm/e2c/src/include/egv_struct.h

===================================================================

Package: pcCardFormatting

Item(s)

-------

tamps/src/apps/contrib/util/Makefile

tamps/src/apps/contrib/util/upb/Makefile

tamps/src/apps/contrib/util/upb/make_pc_card_fmt

tamps/src/apps/contrib/util/upb/pc_card_formatting_main.c

tamps/src/apps/contrib/util/upb/pc_card_formatting_menu.c

tamps/src/apps/contrib/util/upb/pc_card_formatting_proto.h

tamps/src/apps/contrib/util/upb/pc_card_formatting_uif.c

tamps/src/apps/contrib/util/upb/pc_card_formatting_uif.h

tamps/src/apps/contrib/util/upb/tu_runtime.c

tamps/src/apps/contrib/util/upb/tu_runtime.h

tamps/src/data/wse/system_admin.menu

===================================================================

Package: PST_additions

Item(s)

-------

tamps/src/data/system/index

tamps/src/data/system/instpst.help

tamps/src/data/wse/help.menu

tamps/src/scripts/system/sop_install

===================================================================

Package: HelpFiles_Init

Item(s)

-------

tamps/CLASSIFIED/src/data/help/thc/thc_help_script

tamps/include/help/thc_defines.h

tamps/src/apps/contrib/util/upb/upb_card_formatting_menu.c

APPENDIX B

STRS CLOSED, IN TEST, AND IN WORK

B.1  SCOPE

This appendix contains descriptions for STRs closed, in test, and in work. Closed items have passed all CM and test phases.  They will appear on this CD release.  In test items have passed CM phases and have been approved by test. cIn teste does not imply that an item has or has not been delivered with this CD release. In test items may be complete, but not yet marked closed at the time of this release snapshot.  Therefore, refer to Appendix A for all items released with this CD version.  In work items do not appear on this CD release.

B.2  STRS CLOSED

STR:   3660

Title: ADRI Load Function Causes DBA To Crash

Description:

After performing an ADRI load, no other function can access the tape device that was used to load ADRI until the DBA in which the ADRI was loaded is exited.  When attempting to rewind a tape through an XTerm, the system reports the tape device as busy.

By holding on to the 8mm tape drive, the ADRI load function can cause other DBAs to crash if they attempt to use the tape drive, particularly if the original DBA crashes first.  To clear the problem, the user must log completely off the system then back on.

The LANDSAT and/or NITF load functions also hold onto the tape drive until the DBA is exited.  This STR effectively closes T-2032.

Recommend OTRR List

===================================================================

STR:   4612

Title:

Description:

===================================================================

STR:   5952

Title: GPS Key, No Auto Purge

Description:

The GPS keys are not being automatically purged upon expiration. They should be deleted within a day after expiration. Workaround is for DBA to manually delete expired one every week.

===================================================================

STR:   6190

Title: Gst Server Crash When Loading Multiple Keys

Description:

It appears that attempting to load more than three keys from the CYZ-10 to a TAMPS system at one time causes the gst_server to crash.  Selected 4 keys for transfer from the CYZ-10 to the SLAM DTC-2 and selected "send".  After about 20 seconds, an error message was displayed on the DTC, saying "unable to communicate with server".  Using a shell, found out that the gst_server was not running.  Restarted the server and tried again with the same result.  Tried loading one key, and the transfer was successful.  Tried loading 3 keys, and the transfer was sucessful.  If this happens, the DBA will be forced to reboot the system to get the server running again.  This was duplicated on the test DTC-2.

This STR may be related to STR 6139.

===================================================================

STR:   6212

Title: GPS Navigation File  (CORE)

Description:

Duplicate processing lists should have labels so that user understands the purpose of the lists.  Left list = Workspace  Right List = Selection Priority.  User doesn't understand that he is designating a priority.  First four list items are OK, then Military Airbases, Civilain Airbases, and Joint Airbases.  Do away with Hi/Lo option.  Options available will be High or Low.  Hi/Lo will be included in both High and Low options.

===================================================================

STR:   6213

Title: Object Hierarchy - Symbols  (CORE)

Description:

Generic queries needto use symbols on stickies used now (SAM, RADAR, BOMBER, FIGHTER).

===================================================================

STR:   6214

Title: Launch Details Dialog  (CORE)

Description:

Default  time entry.  FUIWG likes the way that time is entered in the Launch details dialog box.  FUIWG wants ALL of the time entries in the system switched to act this way.

Remove Apply button in Launch Details dialog.

"OK" Button is default button.

Case-by-case review of Apply buttons throughout system to ensure that they are only used on dialogs that require application of a selection without closing the dialog.

===================================================================

STR:   6215

Title: Radar Prediction Dialog  (CORE)

Description:

Close dialog during a get location.

Get rid of vertical scroll bar.

Set feature setting defaults to None.

Radar Display buttons should be Save, Close, Help

Use description as default name.

===================================================================

STR:   6216

Title: GEO Window  (CORE)

Description:

Use finger and hide window.

Allow planner to save GEO (DBA only now).

Redesign window to not have subwindows and submenus.

===================================================================

STR:   6218

Title: NITF Imagery not displayed properly

Description:

NITF Imagery does not display as a map background, even if the NITF header contains corner coordinates.  This was tested with real imagery from the JMCIS Digital Product Server, both loaded from tape and retrieved across the LAN.  Seems like we are not pulling the lat/longs out of the NITF header properly.

===================================================================

STR:   6307

Title: Error in MGRS transformation from WGS-84 to NAD-27

Description:

There is an error in the transformation of MGRS coordinates from the

WGS-84 datum to the NAD-27 datum.

MGRS/LAT/LON Rounding Problems:

When converting from Lat/Lon to MGRS and back to Lat/Lon using the

DD:MM:SS.SS or DD:MM:SS.S Lat/Lon format strings, TAMPS CORE induces a rounding

problem.  This occurs in the MGRS conversion function since the northing and

easting components are accurate to only 1 meter.

===================================================================

STR:   6316

Title: F14D GPSMDL Not loading

Description:

Created a loadset containing JTIDS, Flight Plans, Almanac, Revers, and Tactical Waypt data in F14D on the ACE. Selected Apply and after retrieving the data sets, message window comes up Error erasing cartridge. This cartridge had just been declassified and erased in previous test steps. I tried with another cartridge without erasing and got same error message. When checked MDL using mdlvt, some of the data loaded OK and some gave checksum errors and some not there, using tool (Waypoint Data blank). Planner thinks load fails. Opened new MPM and created new load and downloaded OK, except checksum errors on Almanac. Sometimes works sometimes not. This is a critical failure. SOT 95-02

===================================================================

STR:   6317

Title: Corrupted MDL Loadsets

Description:

Opened a saved mission and created a loadset in F14D containing Flight Plan, Almanac,

Reversionary, and Tactical Waypoint files. Saved As the loadset, then retrieved and all data

looked OK. Added a JTIDS file and did a Save. Retrieved loadset again and JTIDS and

Reversionary  buttons not highlighted. This is a loss of data and is a mission critical failure.

SOT 95-02

===================================================================

STR:   6458

Title: Recovery Base Elevation Error

Description:

The Recovery Base elevation will be incorrectly set to zero ft when the following steps are performed. This occured in C2A and S3B thread tests. Note! This will prevent loading of flight plan to GPSMDL due to obsolete data check failure.

1) Open new mission and name it

2) Go to Launch/Recovery and enter ICAO for Launch, Recovery and  Primary/Secondary Diverts

3) OK to close window

4) Open Edit Flight Parameters (EFP) window and enter a NAV Pt

5) Apply change

6) Select NAV Pt just entered and Delete it

7) Look at amplification info of Recovery Base and the elevation is 0

===================================================================

STR:   6552

Title: GPSMDL Empty Primary ID File

Description:

In HH60 MPM on DTC2, using the generic MDL load application, loaded a MDL with all files and everything looked OK.  Closed the MDL Download window and checked the MDL contents using the mdlvt tool and all files were there with good checksum.  Selected MDL Download again and only changed the flight plan file, left Keep Data option on Primary ID file. Selected Apply to download new data to cartridge. Download completed message came up and was acknowledged. In the MDL Download window the Primary ID Data was no longer selected.  The MDL was read using mdlvt with good checksums, and the Primary ID File was there but empty. Closed the MDL Download window, exited the MPM and opened it again, in a new MPM, and the Primary ID button was selected but Keep Data wa not. Tried to select Keep Data but it would turn blue and then deselect itself right away. This is a mission critical failure, since it is corrupting data on the cartridge.

===================================================================

STR:   6581

Title: INDIVIDUAL POINT TYPE RECORDS CREATED IN GPS NAV FILES NOT DOWNLOADED TO MDL

Description:

If user defined records are created by using the Individual Point Function in the GPS Waypoints function, the download function skips them and a message is given to the user that

records are missing.

===================================================================

STR:   6594

Title: CORRUPT RECOVERY AIRBASE DOWNLOADED TO MDL

Description:

Created mission with DAFIF Airbases as Launch/Recovery.  Selected for Download

and received Obsolete Data error.  Reopened mission and also received error.

Checked Workstation Log which displayed that the lat/long was same but

original Elevation = 0 and new Elevation = 15 (This is the elevation from

DAFIF that is in TAMPS database).  Cleared Recovery base and reselected same

base.  Saved mission and reopened and error gone.  Downloaded to mdl and

read back data.  The Recovery base was attached so this will be last point

on MDL.  The last point had Lat/Long = 0 and was lat/long type point.  No

info related to DAFIF airbase was downloaded.  The ident string was all

blanks.

===================================================================

STR:   6654

Title: MDL CARTRIDGE ONLY READ WHEN DOWNLOAD FUNCTION STARTED

Description:

Downloaded data to an MDL.  Removed MDL and inserted another one.  Hit OK and cartridge label was from previous MDL.  New mdl did not have a  label (it was erased).  The user will have no way of knowing what is on the MDL if the wrong label appears.  Primary keep flag set even though no primary file on mdl.  Hit OK and download finished and no error that primary did not exist.

Currently, keep primary button can be set by the user even if no MDL

inserted.  This button needs to be sensitive based on actual data.  If

there is no primary to keep on the MDL, the user must not be able to

set it.  This give the user the false impression that a primary file

exists on the mdl.

There is a basic problem with this design.

***CHOPPED***

===================================================================

STR:   6683

Title: DATA LOAD CORRUPTED WHEN CREATING MULTIPLE GPSMDL COPIES

Description:

Selected the files to be downloaded - 12 flight plans, 200 pt reversionary,

21,000 pt primary, mag var files, almanac (full load GPSMDL).  Hit Apply.

After download finished, checked contents of GPSMDL and data loaded as

expected.  Hit apply again and GPSMDL loaded as expected.  After 4th time,

the data on the GPSMDL was corrupt in some locations (ie, MDL Status file

end of data ptr, etc).

Workaround:  Use only OK button to download data to GPSMDL.  Each GPSMDL

must be download separately

===================================================================

B.3  STRS IN TEST

===================================================================

STR:   6217

Title: Annotation Tool  (CORE)

Description:

Remove slider bar from symbol parameter dialog.

Default button is Apply.

===================================================================

STR:   6249

Title: F18 Recce Integration

Description:

ICN 087 remove the following files that F/A-18 mpm require to support F/A-18 RECCE.

aet_GetLastActionPoint

aet_PropagateActionPoint

aet_ApplyActionPoint

aet_DeleteActionPoint

aet_InsertActionPoint

F/A-18 MPM requires that these functionality be either fixed or substituted in the TAMPS 6.1 IDD

===================================================================

STR:   6323

Title: JMCIS Grid Messaged did not Pull into TAMPS

Description:

Could access the Grid catalog data OK but when selected messages to pull across into TAMPS got lots of alerts in comms processor and no grid data in db to display. HWDs worked OK. STR check.

===================================================================

STR:   6425

Title: Refuel Flight Event

Description:

Took on 6,000 pounds of fuel using the refuel flight event.  Climbed to 25,000 feet and cruised at best speed for 50 nmi.  TAMPS did not account for the additional 6,000 pounds in weight until the next waypoint after the refueling event. Software needs to be changed to account for the weight change at the waypoint of the refueling event.

===================================================================

STR:   6426

Title: Multiple Waypoint Edit Feature

Description:

Correct the multiple waypoint edit feature within the Edit Flight Parameters tool so that it correctly applies time, fuel, and distance computations.

===================================================================

STR:   6429

Title: Change Start Transition/End Transition Logic

Description:

Change start transition / end transition logic so that vehicle ends up at

desired altitude at end of route leg and not before.

===================================================================

STR:   6496

Title: Audit Log Crash

Description:

The Audit Administration function is crashing when attempt to open primary log. I had all audit events selected and opened/closed MPMs and DBAs and in about four hours the /var/audit filled up to about 50%. When about 80% full is when I saw problems opening the logs. Workaround is to archive off logs or delete them from a shell, and then can open new logs.

===================================================================

STR:   6556

Title: Login Warning message

Description:

A 'DOD interest computer system' warning message must be displayed when the user

logs in.

===================================================================

STR:   6586

Title: INCORRECT VALUE FOR SLAVED VARIATION FOR MDL FLIGHT PLANS

Description:

The mag var value is written in the slaved variation field even though the slaved variation is stored in the database.  The mag var value should only be used if the slaved variation value is unknown/does not apply.

===================================================================

STR:   6602

Title: NEW DAFIF LOAD CORRUPTS EXISTING MISSIONS IF DAFIF OBJECT DELETED

Description:

Created mission with DAFIF 9612 where the Navaid and Waypoint will be

deleted by DAFIF 9702. The 3rd and last nav points had DAFIF records that

will be affected.  Uploaded 9702.  Next day reopened mission and received

Obsolete Data errors.  Here is that status of each area:

3rd Nav point data:

MCR:  Listed Ident and record type but Name is the name of last nav point's

DAFIF record.  Range/Bearing calculated based on Lat/long of last nav

point's DAFIF record.

Geo Display:  Using the lat/long of the last nav point's DAFIF record.  Red

dashed line across screen.

Kneeboard:  Shows all previous DAFIF info (Ident, Channel, type, name, etc)

and Range/Bearing same as when created.

***CHOPPED***

===================================================================

STR:   6697

Title: Doghouse component data items

Description:

The available data components that are selectable to be placed within a doghouse also need to be expanded to include current point and next point information, and make more data types available.

The desired data types available for placing in a doghouse component are the following items for both current and next point:  heading (mag and true), altitude(msl and agl), speed (CAS, TAS, GS, Mach), latitude, longitude, distance, leg time, elapsed time, clock time, fuel remaining, leg fuel, ground elevation, UTM zone/coordinates, MGRS coordinates, divert IDENT/course/heading/distance/time/fuel, target time/dist, recovery time/dist/course, bank angle, mag var, fuel flow, and blank.

Modified doghouses should be able to be saved and recalled later for reuse.

This STR encapsulates T-3788 and 4596.

===================================================================

STR:   6698

Title:  Kneeboard card defaults

Description:

A better default kneeboard card format is needed. The kneeboard card should print out as a full page in landscape orientation, with the columns arranged so that it can be folded in half or cut in half.

The default layout should include approximately an inch of blank space at the top for notes and then the following columns from left to right (slashes separate data items in the same cell on two lines):

- Left half:  Wpt #, ID BRG RNG/Description, TACAN Chan/VOR Freq, Mag heading/Mag course, Calibrated airspeed/Indicated Mach Number, Groundspeed/True Airspeed, Leg Distance/Cumulative Distance, Leg Time/Clock Time, Leg Fuel/Fuel remaining, altitude/flight mode.

- Right Half:  Wpt #, Lat/Long, Elevation/Magvar, MGRS/UTM, Wind/Temp, Divert ID/Divert BRG RNG.

A Sample kneeboard card of the desired format has been provided to the SSA at Pt. Mugu.

===================================================================

STR:   6699

Title: Kneeboard card field data items

Description:

Better customization of data items need to be available for placing items on the kneeboard card.

The following data items should be selectable for placement in the top or bottom half of any cell, independent of what is placed in the other half:

-heading (mag and true), altitude(msl and agl), speed (CAS, TAS, GS, Mach), latitude, longitude, distance (leg and cumulative), leg time, elapsed time, clock time, fuel remaining, leg fuel, ground elevation, UTM zone/coordinates, MGRS coordinates, divert IDENT/course/heading/distance/time/fuel, target time/dist, recovery time/dist/course, bank angle, mag var, fuel flow, flight mode, and blank.

Modified kneeboard cards should be able to be saved and recalled for future use.

This STR encapsulates T-6114, 6115, 4563, 4566, 5112.

===================================================================

STR:   6726

Title: APPLIX Removal

Description:

Remove the APPLIX COTS software package and the associated menus, since it is a security issue.

===================================================================

STR:   6755

Title:

Description:

===================================================================

STR:   6825

Title: Strip chart time tick marks

Description:

Strip chart time tick mark resets to whole minute every leg.  Fixed to now account for fractional time left over from previous leg and plots correct time tick mark.

===================================================================

STR:   6850

Title:

Description:

===================================================================

STR:   6874

Title: Correct Problem with Ada binding to C function mpt_latlon2grid

Description:

In mpt, there is a function named mpt_latlon2grid, which converts lat/lon coordinates to a grid string.  The Ada binding for this function is incorrect.  The sequence of the last two parameters is switched and the type for the geoPt parameter is incorrect.  It should not be a pointer in the Ada Binding.

===================================================================

STR:   6875

Title:

Description:

The Ada bindings for the uxt functions will not link because the function uxt_getXColorIndex is incorrectly identified as uxt_getColorIndex in the Ada binding.

===================================================================

STR:   6876

Title: Correction to Ada constants for the C enumeration type mpt_units

Description:

In mpt_defs.h there is an enumerated type defined named MPT_UNITS which is used to choose which units you are requesting form the mpt_getCurrentUnits routine.  In C, the integer representation ofthe values of this enumerated type begin at 0.  In the Ada bindings (mpt_defs.a), there are constants defined to correspond to these values, but they

begin at 1 instead of 0, so the values do not correspond correctly.

===================================================================

B.4  STRS IN WORK

===================================================================

STR:   3638

Title: Attach Recovery Leg Editting

Description:

Unable to edit flight parameters associated with an attach recovery leg

===================================================================

STR:   5812

Title: AH-1 Helo Loadout Facing the Wrong Way

Description:

The helo in the AH-1 loadout should be facing away from the planner.  The current loading profile makes loading stations backwards.

===================================================================

STR:   6278

Title: Divert Field Airbase Query Crashed Sybase/MPM

Description:

Performing an Airbase Query using the World Op Area Crashed the MPM.  The operator selects the World Op Area and Zoom in the Area of Johannesburg.  Started a new mission and input mission name, then selected launch/recovery > Airbase Query > Apply > Cancel. Then selected L/R pts then Apply> Cancel, then opened Edit Parameters input nav pt 2,  Select Nav Pt.2 from the list > Divert Field > Airbase Query > Apply > OK.  Then acknowledged the message and selected  "Apply" again. The MPM crashed, Logged-off and Sybase crashed.  This problem is repeatable.

Note! Forces a reboot to start sybase and so far has not been duplicated on 6.1 baseline.

===================================================================

STR:   6282

Title: GPS Week Problem

Description:

SLAM code calls a Core function called dgt_dateToWeek.  This

Core function in turn calls another Core function dgt_diffFromBase.

This function dgt_diffFromBase does not specifically return a

status of ST_SUCCESS when things are Ok.  It returns a status

of ST_FAILURE when things are bad.  What we think is happening

is that because the return status is not being set upon successful

execution of the function dgt_diffFromBase, the function dgt_

dateToWeek sometimes interprets this as a failure and then passes

this FAILED status back to our routine.

Looks like the fix to problem is to simply return a status of

ST_SUCCESS in the function dgt_diffFromBase when it executes

properly instead of returning nothing (i.e. undefined value).

===================================================================

STR:   6453

Title: Datum Selection Not Functioning in Tac Wypts

Description:

Datum selection inside the Manual Waypoint window does not appear to function properly.  The window is located in the F14D MPM under Rotue -> Tactical Waypoints -> Create New Waypoints -> Enter Manual Waypoint Info.  Must change datum using Setup -> Defaults -> Units for grid to change to correct value.

Addendum to STR 6453

Datum selection is also not working in the Edit Tactical Waypoint dialog (Select Route -> Tactical Waypoints -> Edit Waypoints, highlight a point and select Edit Waypoint).  User must use Defaults dialog as described above.

===================================================================

STR:   6485

Title: Datum Selection Not Functioning in Targets Dialogs

Description:

Datum selection inside the Targets Dialogs (both Planner and DBA) does not function properly.  The user must change datum using Setup -> Defaults -> Units for grid to change to correct value. STR Check.

===================================================================

STR:   6510

Title: Selection on Military Training Routes

Description:

TAMPS allows display of MTR's but does not allow the planner to easily add a portion of an MTR as part of his mission route.  TAMPS needs to allow the planner to drag and drop onto an MTR point and prompt the user for where on the route he would like to exit.  TAMPS should then add the appropriate points to the mission route.  If the user wishes to edit the points from there, he can.

===================================================================

STR:   6521

Title: Almanac Loader Missing Error

Description:

When loading GPS Almanac from floppy disk, the user is  asked to enter a filename. If the file cannot be found, the MMI doesn't issue an error message to user. User is left thinking that the Almanac data was successfully loaded. DAFIF Thread.

===================================================================

STR:   6555

Title: Year 2000 Compliance

Description:

TAMPS Core and all MPMs must meet Y2000 compliance.

===================================================================

STR:   6557

Title: State Save

Description:

The mission planning map window state should be saved with the mission so that

when a planner reopens a mission, the planning window looks just like they left

it.  The saved state should include all selected background settings (i.e.

Chart, DTED, Imagery, etc.), as well as all queried objects (i.e. Navaids,

Airfields, Threats, etc.) still displayed on the map.  Just the queries can be

saved and re-executed upon reopening the mission to restore the displayed

objects.  The planner should be able to prevent the state from being restored by

placing a toggle checkbox in the Open Mission window.

===================================================================

STR:   6596

Title: <CR> CAUSING CORRUPT NAVIGATION POINT IN EFP

Description:

Selected DAFIF object (NAVAID or Waypoint - doesn't matter which).  Updated

Bearing field and hit tab.  Updated Range field and hit <CR>.  The lat/long

fields below the Range field are updated incorrectly.  The GEO display is not

updated and the top part of the EFP window listing the Navigation points is

also not updated.  Closed EFP and reopened and top part of EFP updated but

screen still not updated.  Downloaded to MDL and entered Bearing/Range and

incorrectly calculated Lat/long on MDL.  Checked Lat/long calculation by

entering Bearing, hit tab, entering Range hit tab.  This time lat/long

identical to TAMPS 5.1 and MCR.  This happens when adding new nav point or

modifying existing nav point.

After EFP closed and reopened, any time <CR> used, EFP crashes not matter

what field the cursor is in (Speed, Altitude, etc).  If Bearing and/or Range

updated and <CR> used, the lat/long is not updated but sometimes the

modifications to these fields are saved.  Used Tab on both fields and

still happens.

If Apply selected with trackball, EFP stops crashing on <CR>.

===================================================================

STR:   6597

Title: SELECTION OF PREVIOUS NAV POINT IN EFP CORRUPTS SELECTED NAV POINT #1

Description:

Was creating mission - had 10 nav points created.  Selected Add After to

create pt 11.  Using finger, selected ref obj (NAVAID or Waypoint doesn't

matter) from screen.  Did not hit Apply or <CR>.  Selected previous

navigation point (#3) from list.  Did not receive prompt to save edits to nav

point.  Made no changes to selected point and reselect pt 10 (last pt in

list still).  Add After unselectable so hit Apply with trackball.  Ref obj

selected for pt 11 (which wasn't actually added to route) replaces ref obj

for pt 10.  Screen updated but info in EFP still reflects the Ref Obj used to

create pt 10.  MCR reflects screen.  Downloaded to MDL and data reflects

screen and MCR, not EFP.

Did this accidentally - was trying to see what altitude/speed was used in

point #3 for the purpose of modifying altitude/speed for new point.

===================================================================

STR:   6598

Title: SELECTION OF PREVIOUS NAV POINT IN EFP CORRUPTS SELECTED NAV POINT #2

Description:

Was creating mission - had 10 nav points created.  Selected Add After to

create pt 11.  Using finger, selected ref obj (NAVAID or Waypoint doesn't

matter) from screen.  Hit Apply using trackball.  Updated Bearing, hit

Tab, updated Range and didn't hit Apply or <CR>.  Selected previous

navigation point (#4) from list.  Receive prompt to save edits to nav point

and hit yes.  Updated Range for pt 3 and selected Tab and selected Apply with

trackball.  Ref obj from last point replaced ref obj for pt 4 on screen and

MCR but not in EFP.  Downloaded to MDL and data reflects screen and MCR.

Edits to pt 11 Range and bearing fields not saved but lat/long updated in

EFP and GEO (incorrectly calculated) but top part of EFP window not updated.

===================================================================

STR:   6603

Title: INCORRECT OBSOLETE ERROR MESSAGE IN WORKSTATION LOG

Description:

Created mission where the ICAO of the DAFIF airbase was removed in next

DAFIF version.  Uploaded next DAFIF version and opened mission.  Received

Obsolete error that Launch base had been moved.  Checked Workstation Log

and saw same error.  The only change was that the ICAO field was empty,

lat/long was unchanged.  New and Old Lat/long in Workstation Log were

identical.  This error is confusing since the messages are wrong.

===================================================================

STR:   6695

Title: Cancel Any Query in Progress

Description:

Planners should be able to cancel any query in progress if it is taking too long

or if it was an accidental selection.  A Cancel Button should be added to the

pop up window that is present when a query is executing, allowing the planner to

abort the operation if desired.

===================================================================

STR:   6696

Title: Default Defaults

Description:

Better default data selections are needed for the strip chart doghouse data components,

and the same default should be applied for all platforms.  The desired default doghouse

components (from top to bottom) are: blank triangle at top, mag heading to next point,

distance to next point, leg time to next point, altitude to next point, fuel remaining

at current point, elapsed time at current point, latitude at current point (double wide),

longitude at current point (double wide). Sample doghouse drawings have been provided to

the SSA at Pt. Mugu.

This STR will fix T-5985 and T-6605.

===================================================================

STR:   6712

Title: ett_GetTerrainMask function does not support SLAM ER  GPS/AWDL jamming 
requirement.

Description:

The current implementation of the ett_GetTerrainMask function only supports

equipment code and lat/lon.This implementation does not support SLAM ER MPM

functional requirements. SLAM requests ett_GetTerrainMask be modified in TAMPS

6.2 to accomodate antenna height, maximum effective range (MERA) and elevation.

The SLAM ER MPM must have a generic Terrain Masking capability to

support threat analysis.  This new interface will operate just like

ett_getTerrainMask with the exception that Core will be provided with

the antenna height, maximum effective range, and elevation of the site

instead of deriving this information from the equipment code and site

lat/lon.

===================================================================

STR:   6727

Title: Password Guessing

Description:

If log-in attempts exceed an allowed number of password failures (settable by the SA), that account shall be deactivated, and shall not be usable until the SA re-activates the account.     Currently, User is able to log into the system after more than 10 times of password failures. There is no place to allow the system administrator to set the allowable attempts. Failed logins and account deactivation should also be tracked in the Audit Log function.

Additional Info from STR 6531 10/1/97: The Auditing function is not tracking failed login attempts to the TAMPS login window. It does track failed su  to root but not attempts to login to TAMPS that fail. This could be a security issue, especially since TAMPS does not limit the number of failed attempts to login.

===================================================================

APPENDIX C


APPENDIX C
  DTRS: CLOSED, IN TEST, AND IN WORK

C.1  SCOPE

This appendix contains descriptions for DTRs closed, in test, and in work. Closed items have passed all CM and test phases.  They will appear on this CD release. "In test" items have passed CM phases and have been approved by test. cIn teste does not imply that an item has or has not been delivered with this CD release. "In test" items may be complete, but not yet marked closed at the time of this release snapshot. Therefore, refer to Appendix A for all items released with this CD version. "In work" items do not appear on this CD release.

C.2  DTRS CLOSED

DTR:     D10008

SOR/STR: 6.2 init

Title:   Remove Obsolete Files

Description:

Remove files that are obsolete in 6.2 that were not removed during initialization

===================================================================

DTR:     D10009

SOR/STR: SOR 95-43

Title:   Motif Failures

Description:

Several times while performing normal TAMPS functions (i.e. opening missions, initiating shutdown, etc.) the Motif window manager failed.  Had to logoff and back on to restore it.  There appears to be a greater tendency for this to happen soon after a system reboot.

One way to make Motif fail every time:

1.  Display a system modal window.

2.  Open the DBA or an MPM and move the window.

3.  Perform a database query of any type.

4.  Motif will crash after performing the query.

Motif can be restarted from a shell by typing mwm& and will function properly or by logging out and logging in again.

===================================================================

DTR:     D10010

SOR/STR: 6.2 init

Title:   Recovery Base Symbol Error

Description:

When creating missions, the recovery base is shown as a nav point symbol with a "2" next to it, rather than an airbase or carrier symbol.  When attach recovery is selected, the correct symbol is overlayed on the nav point symbol.

===================================================================

DTR:     D10011

SOR/STR: 6.2 init

Title:   Compass MPM Not Functioning

Description:

The COMPASS MPM is not working.  When it is selected from the Mission Planning menu, the MPM map window flashes on the screen and disappears.

===================================================================

DTR:     D10012

SOR/STR: 6216

Title:   Geo Filter Help is Incorrect

Description:

The help file for the new GEO tool (Display -> Geo Filter -> Custom) is incorrect in several places.  The "Geo" menu is described as containing the options "Current", "Display", "Clear" and "Delete", but the menu in the window actually contains "New Geo", "Current", "Display", "Declutter", "Edit" and "Delete".  The functional descriptions for "Current" and "Display" are also incorrect, and there are several spelling errors/typos.  Also should add a description of the Save and Apply functions.

===================================================================

DTR:     D10013

SOR/STR: 6216

Title:   Geo Filter Menu Logic is Incorrect

Description:

The gray/ungray logic in the Geo menu of the Geo Filter window is not correct.  The user should be able to create a new GEO even if a previously created GEO is highlighted if the "Selectable Geos" list.  "Display" should be grayed out if a GEO that is already displayed is highlighted.  "Declutter" should be grayed out if a GEO that is not displayed is highlighted.  "Current" should be grayed out if the current GEO is highlighted.

===================================================================

DTR:     D10014

SOR/STR: 6216

Title:   Geo Filter Scroll Bar Error

Description:

The scroll bars in the "Selectable Geos" and "Displayed Geos" regions of the GEO Filter window should only appear when the lists get filled to the point where a scroll bar is necessary to view all of the GEOs.

===================================================================

DTR:     D10015

SOR/STR: 6216

Title:   Geo Filter Editing Error

Description:

If a previously saved GEO is highlighted in the GEO Filter window, and then edited without changing the name, the system displays a "Delete GEO Confirmation" window.  Selecting either Yes or No appears to give the same result.

===================================================================

DTR:     D10016

SOR/STR: 6216

Title:   Creating New Geos

Description:

When creating new GEOs using the Rectangle, Circle or Polygon selection under the Display -> Geo Filter menu, or the GEO toolbar icon, the system displays a "Delete GEO confirmation" window.  Selecting either Yes or No in this window appears to give the same result.

===================================================================

DTR:     D10017

SOR/STR: 6216

Title:   Saving Geos

Description:

In an MPM, if a new GEO is created which has the same name as a GEO that has already been saved to the database, and then "Save" is selected, an error message is displayed that tells the user to change the name of the GEO.  However, when the message is acknowledged, all fields in the new GEO window are grayed out, including the name, so the GEO must be recreated.

===================================================================

DTR:     D10018

SOR/STR: 6216

Title:   Geo Filter Hidden Menu

Description:

When using the new Geo Filter -> Custom function to input a new geo, if cancel out of the draw mode by using the right mouse button or click twice on the same location using the left button, an error message comes up but is hidden behind the "Geo filter" window.

===================================================================

DTR:     D10019

SOR/STR: 6216

Title:   Geo Filter Edit

Description:

In a DBA module, selected a DBA built GEO that had a * next to it for editing.  Error message comes up: "Selected Geo must be the current Geo", even if the GEO already is the current GEO.  If the selected GEO is not the current GEO, it changes it to the current GEO.  Could not edit any GEOs with the *.

===================================================================

DTR:     D10020

SOR/STR: 6216

Title:   Geo Filter delete

Description:

In a DBA Module, selected a geo and then selected Delete.  A message window came up saying "Selected Geo does not exist".  Also, a confirmation window and a Geo Filter Delete hourglass came up.  When select No on the confirmation window, the file was deleted anyway.

===================================================================

DTR:     D10021

SOR/STR: 6.2 init

Title:   Make Arguments Omission for cc compiler

Description:

$TOPDIR/config/projpath needs -xildoff added to STD_CFLAG in make arguments for cc compiler.

===================================================================

DTR:     D10022

SOR/STR: 6.2 init

Title:   Ada Bindings

Description:

The following ADA bindings are documented in the IDD but are not implemented:

AUT_COMPUTEWINDCOMPONENTS

AUT_COMPUTEWINDDISTANCE

AUT_COMPUTEWINDRANGEFACTOR

DAL_GENCLAUSE

DAL_GENQUERYLIST

MPT_GET_SCALE_AND_ZOOM

UET_ERRORMSG

UMT_UPDATETABLE

The LBT_REGISTER binding is missing the FLAG argument.

Rep Specs were updated for the following record to repair compilation warnings:

APT_ACTION_POINT_T

APT_AIRCRAFT_T

CORNER_RADS

GEO_NODE_CIRCLE

GEO_NODE_POLY

GEO_NODE_ROUTE

POINT_RADIANS

THE TMT_IMAGERY_STRUCT record does not exist in the bindings area.  On the C side, the C structure TMT_ADRI_STRUCT  was changed to TMT_IMAGERY_STRUCT for STR 3112.

Appendix N incorrectly has and AOA field for the APV_JBACKLINK_T record.

The ART_CREATEMSNLAYERNAME ADA binding function description in IDD Appendix G should not have an ID argument.

The BDT_COMPUTECHECKSUM ADA binding function description and example in IDD Appendix G needs to be updated to reflect the actual ADA binding.

===================================================================

DTR:     D10025

SOR/STR: SOR 96-60A

Title:   Count By Decouple

Description:

Count By decouple mode is not functioning correctly.  When using Count By to key on a column of

information, highlight 1 or more items and then select decouple.  If a change is made to the map display,

the change is correctly not made to the decoupled widget but if a different column is selected in the

decoupled widget, the items highlighted in the display window of the decoupled widget will match the

objects selected on the map display even though the widget is decoupled.

===================================================================

DTR:     D10026

SOR/STR: SOR 96-60A

Title:   Count By Function Scrolling

Description:

When scrolling in Count By Function, if the scroll bar is clicked-on and dragged using the mouse, the data is not scrolled real-time as the elevator is moved up and down.  All other functions in TAMPS scroll the data real-time as the elevator is moved.

===================================================================

DTR:     D10027

SOR/STR: 6.2 init

Title:   TAMPS Database Offline After Restore

Description:

The TAMPS database was still "off-line" after database restore operation had successfully completed.  Could not login as any user except root.  Fix was to manually bring the database on-line with SQL command, "online database tamps".  The actual restore seemed to work fine.  Not sure why tamps database was still off-line.  New sybase 11 behavior?  Change to restore scripts?

SOT Step 95-43.1

===================================================================

DTR:     D10028

SOR/STR: SOR 95-43

Title:   Move magvar.dat

Description:

move magvar.dat from TAMPS Core to Sysgen COTS, just as dcw browse and jnl data have been moved from Core to COTS

===================================================================

DTR:     D10029

SOR/STR: 6.2 init

Title:   Archive/Restore Buttons Obscured

Description:

In the Archive/Restore window, the table list box partially obscures the Select All and the Deselect All Buttons.

===================================================================

DTR:     D10030

SOR/STR: 6.2 init

Title:   Import/Export Strike Name

Description:

When the Strike Package Import/Export window is opened and either the Import or Export pushbutton is selected, the Strike Name list box shrinks.

===================================================================

DTR:     D10031

SOR/STR: 6.2 init

Title:   Comms Processor Doesn't Start

Description:

When Communications -> Comms Administration is selected, the Comms Processor does not start.  If this functionality has been removed, the menu selections should be removed or grayed out, otherwise it should be fixed.

SOT Step 95-43.1

===================================================================

DTR:     D10032

SOR/STR: 6216

Title:   Geo Filter Create New Geo

Description:

In an MPM, if a new GEO is created which has the same name as a GEO that has already been saved to the database, and then "Save" is selected, no error message is brought up to tell the user to change the name of the GEO.  Also, all the fields in the new GEO window are grayed out, including the name, so the GEO must be recreated.

===================================================================

DTR:     D10033

SOR/STR: 6.2 init

Title:   BAK/GND (background tool)

Description:

The Bak/Gnd widget is not behaving the way it did in 6.1.1. The parent window is hidden whenever Edit is selected on any function that brings up a child window. This makes "Apply" useless on the child windows like Imagery or Grids.

===================================================================

DTR:     D10034

SOR/STR: 6.2 init

Title:   Load CADRG Filenames

Description:

Selected load ADRG in a DBA Module, with a Korea ONC/TPC CADRG CD in drive. Then when clicked on map to select Korea area charts, the pick window came up listing two /cdrom directory paths instead of just ONC and TPC like it did in 6.1.1 and earlier.

SOT Step 95-43.1

===================================================================

DTR:     D10035

SOR/STR: 6216

Title:   Geo Filter Delete Confirmation

Description:

The "Delete GEO Confirmation" dialog box is not descriptive enough.  It asks if you want to "Permanently remove geo?" when in actuality it might just be replacing, overwriting, etc.  The message that the user sees needs to be clearer and more informative as to what action is being taken.

===================================================================

DTR:     D10036

SOR/STR: 6216

Title:   Geo Filter Save Error

Description:

If you edit an existing geo and then try to save a new geo with a name that already exists, no error message pops up telling you that you are trying to save a geo with a name that already exists and to rename it.  The geo is deleted and the entry form is grayed out.  Should have an error message and the opportunity to rename the geo.

===================================================================

DTR:     D10039

SOR/STR: SOR 96-60A

Title:   Count By Data Display Error

Description:

There are several errors occuring in Count-By:

1.  Initial widget width:  I opened Count-By on AIRBASES NAVAIDS WAYPOINTS Layer and WAYPOINTS TERMINAL Bucket.  The Layer and Bucket titles were partially obscured because the widget was too narrow.

2.  When a Bucket with a large number of items (I used one with over 16,000 items) is selected for Count-By and the Column setting is set to NAME, Latitude or Longitude, you cannot scroll up or down in such a way to view all the data items.  If the Up or Down scroll arrows are selected, the data displayed is scrolled up or down more than one page at a time.  The data should be scrolled only a few items at a time when selecting the Up or Down arrows.  Sometimes resizing the widget will fix this problem.

Also, if the mouse pointer is clicked above or below the elevator positional indicator, the data displayed is scrolled up or down several pages at a time.  The data should be scrolled up or down one page at a time when this action is taken.

3.  When the Count-By widget is near the top of the terminal display and one of the lower column items is being displayed, the top Column item is obscured by the WSE bar when the Column Pull-Down Menu is selected.

===================================================================

DTR:     D10040

SOR/STR: SOR-95-43

Title:   F-14 MPM Missing S/W

Description:

F-14 MPM missing modified s/w in f14/src/f14gt subdirectory.

===================================================================

DTR:     D10041

SOR/STR: 6216

Title:   Geo Window Close

Description:

Closing the custom Geo window with the upper left window menu results in multiple copies of all listed geos in the Selectable and Displayed Geo lists.  Deleting one of the copies deletes it normally, but trying to display or delete the remaining copies results in "Selected Geo does not exist" message.  This behavior will be confusing to the user.

===================================================================

DTR:     D10042

SOR/STR: 6216

Title:   Geo Filter Delete

Description:

If the current Geo is deleted using the drop down menu in the custom Geo window, the Current Geo becomes corrupted.  With the custom Geo window still open, the Current Geo field properly reverts to the current op area.  However, when the Geo window is closed, the Current Geo is left in a corrupted state.  If the custom Geo window is re-opened, the Current Geo field will either be blank or filled with special charcters.  Subsequent queries against the database result in no records found because the query bounds are in an indeterminate state.  A new Geo must be created to clear the problem.  This will confuse users because they will not understand why queries are failing.

===================================================================

DTR:     D10043

SOR/STR: 6216

Title:   Default Current Geo

Description:

There is no way to revert the current Geo to the current Op Area.  The current Op Area is not listed in the selectable Geos list the way the old "No Geo" was listed in the old Geo implementation.  This leaves the user no way to revert to the Op Area for query constraints without deleting the current Geo (which does not work and is a separate DTR).  If the current Geo is a Saved Geo, deleting it to revert will also delete it for future use.  The current Op Area should be listed in the Selectable Geos list to allow reverting to it.

===================================================================

DTR:     D10044

SOR/STR: 6216

Title:   Geo Filter Drawing Cancel

Description:

Canceling a Geo creation drawing operation with the right mouse button results in two error messages.  If you cancel after pressing the Geo button on the toolbar, you are asked to confirm deletion of a Geo you have not yet created, and you also get a "unable to create geo" message.  Circle gives two "unable to create geo" messages, and polygon gives something else.  A right mouse button cancel is a cancel and should not require any confirmation actions.  This is inconsistent with the rest of drawing operations in TAMPS.

===================================================================

DTR:     D10047

SOR/STR: SOR 96-60A

Title:   Count-By Motif button crash

Description:

If the motif pull-down is used to close the count-by window, the MPM or DBA module being used will crash.  Query for some objects, select Clutter/Declutter, Highlight a layer and bucket, select Count-By, close with the Motif menu and MPM crashes.

===================================================================

DTR:     D10048

SOR/STR: SOR 96-60a

Title:   Count By Op Area Change

Description:

If a count by window is open, it will crash the first time it is accessed after a change op area.

===================================================================

DTR:     D10049

SOR/STR: SOR 97-12

Title:   Crypto Key Algorithm

Description:

The algorithm is not checking Crypto Keys as expected by the customer. For example, it loads a maintenance key as a valid weekly key.

===================================================================

DTR:     D10050

SOR/STR: SOR 96-10

Title:   NAVSSI_Host Environment Variable

Description:

In DBA when select Update>GPS Almanac> On Line Update, a message comes up stating that "unable to access environmental variable NAVSSI_HOST".  No other windows come up.

===================================================================

DTR:     D10051

SOR/STR: 6.2 init

Title:   Edit Flight Parameters Waypoint Error

Description:

In the A-6E MPM, when a waypoint is highlited and the "Edit

Flight Params" dialog is opened, the wrong waypoint is selected

in the list of waypoints at the top of dialog, but the waypoint # in

the dialog is correct.

===================================================================

DTR:     D10055

SOR/STR: 6.2 init

Title:   Initialization Build has incorrect MPMs

Description:

The initial 6.2 build has the wrong MPMs available.  The "RAAP" and

"Scenario" MPMs should be removed from the delivery.  The "C2A"

MPM should be added to the delivery.  The "A6E" and "BLAM" MPMs

should be delivered for test only.

===================================================================

DTR:     D10056

SOR/STR: 6.2 init

Title:   ACE_Wrappers Makefile does not have correct targets

Description:

The ./tamps/src/contrib/ACE_Wrappers/Makefile does not have the

correct "make" targets. Add "make" targets for std TAMPS

development make scripts.

===================================================================

DTR:     D10057

SOR/STR: 6.2 init

Title:   rootAcces.sh fix

Description:

- rootAccess.sh script fix. Script was hardcoded for /tamps. The

new topdirs should be /Refxxx/tamps62. The script now takes the

TOPDIR as an argument. Script is executed from root crontab.

- Also removed obsolete build scripts from /tamps/bin and checked in new Tamps62 Harvest build scripts; bld62_recovery.csh and

bld62.

===================================================================

DTR:     D10058

SOR/STR: 6216

Title:   Geo Filter Widget Resize

Description:

The Geo Filter widget cannot be resized.  It should be resizable and when resized, the list boxes should be made larger both in length and width.  Currently, if a Geo has a name longer than 26 characters the complete name cannot be viewed since there are no horizontal scroll bars.

===================================================================

DTR:     D10059

SOR/STR: 6216

Title:   Geo Filter Cancel

Description:

When a user selects the Geo Pushbutton or selects Display-> Geo Filter-> Rectangle, Circle, or Polygon and then pushes the right mouse button, the Create Geo function should be canceled.

Instead  a  bogus geo named "CURRENT_GEO" is added to the Selectable Geos list.  If this action is repeated, the error message:  "CURRENT_GEO will be removed (if deleting) or overwritten (if editing).  Continue?" is displayed.  Selecting YES continues with creating a new bogus geo which replaces the other bogus geo.  Selecting NO displays error message:  "Geo with name CURRENT_GEO exists.  Please rename geo with a name other than CURRENT_GEO."  It is obviously impossible to rename the geo since there is no HMI to do so.

===================================================================

DTR:     D10060

SOR/STR: 6216

Title:   DBA and MPM Creating Geos concurrently

Description:

If an MPM user and the DBA are concurrently creating geos and the same name is used for a geo by both, the MPM user is not warned of his/her geo being overwritten by the DBA geo and given the opportunity to rename their geo.  This occurs because the database is not searched for geo name conflicts whenever a new geo is being created.

===================================================================

DTR:     D10061

SOR/STR: 6216

Title:   Geo Filter Menu Logic

Description:

The "Display", "Declutter" and "New Geo" functions are still not

completely correct.

When two or more items are selected from the Selectable Geos list,

and if all items are currently displayed, "Display" should be insensitive

but is actually sensitive.

If two or more items are selected from the Selectable Geos list and all

items are NOT displayed, "Declutter" should be insensitive but is actually

sensitive.

If two or more geos are selected from the Selectable Geos list, user

cannot create a new geo.

This DTR is an extension of DTR D10013.

===================================================================

DTR:     D10062

SOR/STR: SOR 96-10

Title:   Update GPS On-Line Almanac ftp script

Description:

The gps_ftp.dat file needs to be updated to specify the path of the almanac file that is to be downloaded.

===================================================================

DTR:     D10063

SOR/STR: SOR-95-43

Title:   User accounts can't open MPMs

Description:

Due to Solaris 2.5.1 patches, TAMPS users are not able to successfully start MPMs, even with NIS+ at run level 0, due to credentials being created with a non-login password.

===================================================================

DTR:     D10065

SOR/STR: SOR 95-47

Title:   Remove sa password prompt from zet_uadmin

Description:

In build 2, the sybase sa password has been hardcoded, so we need to remove the prompt for the sa password from zet_uadmin.

===================================================================

DTR:     D10066

SOR/STR: 6.2 init

Title:   Comms Applications not building in harvest environment

Description:

The Comms applications are not building correctly under the new harvest environment.

SOT Step 95-43.1

===================================================================

DTR:     D10067

SOR/STR: 6698

Title:   Kneeboard Card Load/Save/ReOrder

Description:

The Load/Save and ReOrder functions do not operate in the new Default Kneeboard Card HMI.

===================================================================

DTR:     D10068

SOR/STR: SOR 96-52

Title:   PC-Card Go/NoGo not implemented.

Description:

The Go/NoGo functionality for PC-Card is not completed.

===================================================================

DTR:     D10069

SOR/STR: SOR 95-47

Title:   grant_privs.csh

Description:

Added grant_privs.csh to make_scripts to support changes in SOR-95-47.

===================================================================

DTR:     D10070

SOR/STR: SOR 95-47

Title:   MPM DD_MPMTABS data

Description:

After loading build 2, opened a non-poly MPM (AH-1W) and input a launch pt then OK out of launch window. Then got messages about cannot perform constant cruise and DD_MPMTABS data not loaded.  Therefore could not plan a basic route in MPM. Tried in F-14D and it worked OK.

===================================================================

DTR:     D10071

SOR/STR: SOR 95-47

Title:   DAFIF data load crashed DBA

Description:

Selected DAFIF to load in DBA utilities and after input date and classification selected Apply and then the DBA module crashed. Can not load DAFIF data. Almanac and MagVar loaded OK from CD.

===================================================================

DTR:     D10072

SOR/STR: SOR 95-47

Title:   Add User account errors

Description:

In the User Admin after creating an account "whale" , I attempted to create another with username "whale2" and received a message user ID already exists. I exited the User Admin tool and opened it again and then could create the "whale2" account

===================================================================

DTR:     D10073

SOR/STR: SOR 95-47

Title:   Data Removal tool not starting

Description:

In DBA when select utilities Data removal nothing happens. The next window does not come up.

===================================================================

DTR:     D10074

SOR/STR: SOR 95-47

Title:   Object Server connect problems

Description:

After starting a DBA, loaded magvar, almanac& DAFIF, then try to open an MPM it just brings up the application info window. The mpm process is running when checked in a shell. If the ost_server is killed using kill -9 then the MPM window comes up. The ost_server can then be restarted using the startup scripts. The other option is to reboot the system after using a DBA Module.

===================================================================

DTR:     D10075

SOR/STR: SOR 96-01

Title:   Updte Map Catalog

Description:

After loading build 2 and selecting the preserve maps option, I attempted to use the update maps catalog function to update some preserved DTED data. The following msg was displayed: "dnt_mapCatalogApplyCb cannot open dted directory".

===================================================================

DTR:     D10076

SOR/STR: SOR 95-43

Title:   Update Sysgen for Build 3

Description:

Incorporate Sysgen updates required for Build 3, including COTS updates, MPLAN support and MIDB updates

===================================================================

DTR:     D10077

SOR/STR: SOR 96-01

Title:   No Default MPM

Description:

Default MPMs are not being saved correctly with user accounts.  Default MPMs do not launch when the user logs into the system.  It appears that the .tamps.default_mpm file in the home directory is not being written to correctly.

===================================================================

DTR:     D10078

SOR/STR: SOR 96-01

Title:   NITF Imagery Load

Description:

When several NITF images are selected from an 8 mm tape for load, only the first image gets an entry in the sybase imagery table.  All other image files are being loaded to the maps directory, but can not be accessed through the background tool.

===================================================================

DTR:     D10079

SOR/STR: SOR 96-01

Title:   Can't Display Unrectified Imagery

Description:

Unrectified NITF images can not be displayed.  When an unrectified image entry is selected in the background tool, and OK is selected, nothing happens.

===================================================================

DTR:     D10080

SOR/STR: 6.2 init

Title:   sysgen_initialization (.files)

Description:

sysgen_initialization was created for the initial load of the Sysgen

baseline into the Harvest CM system. Harvest does not support

baseline load of ".", or hidden, files. Currently, the only method of

entering "." files is to check them in recursively, which requires a

package.

===================================================================

DTR:     D10081

SOR/STR: 6.2 Init

Title:   Audit Log empty

Description:

Turned audit function on and selected all event types. Rebooted system and then ran for over an hour. There were log files in /var/audit, about one every two hours, and /var/audit was up to about 10% full. When select Review Audit logs and select Primary file, get a message "No records in audit log.".

===================================================================

DTR:     D10082

SOR/STR: 6.2 Init

Title:   Audit Admin defaults

Description:

The audit admin function is now defaulted to ON vice OFF as it was in 6.1.1.

===================================================================

DTR:     D10083

SOR/STR: 6.2 Init

Title:   SIT_Default_Defines Mismatch

Description:

The standard menu items in the sit_default_defines header file are not the same as the standard menu items in the SIT_DEFAULT_DEFINES Ada binding.

===================================================================

DTR:     D10084

SOR/STR: 6698

Title:   New Kneeboard Card

Description:

When open the new kneeboard card output>route kneeboard card> kneeboard card,  the window is coming up under the wse bar. Reposition the widget so that it does not under the wse.

===================================================================

DTR:     D10085

SOR/STR: SOR 96-01

Title:   E2C MPM symbol sets

Description:

The E2C symbols are not coming up in the MPM. Even when selected via the Display> Change Symbology function. It looks like symbol set is loaded in the appropriate /tamps/static/.... dir but something not setting the objects correctly. Note! The F14 symbols work OK

===================================================================

DTR:     D10086

SOR/STR: E2C

Title:   E2C EMDU Save Crashes

Description:

In E2C MPM when tried to save an EMDU file the MPM crashed.

===================================================================

DTR:     D10087

SOR/STR: 6216

Title:   Deleting  GEO's crashes the module

Description:

When you select two or more GEO's to be deleted in the GEO Filter and then the confirmation window is displayed and you select Yes or No, the DBA Module/Aircraft MPM's will crash.   The GEO's are deleted.

===================================================================

DTR:     D10088

SOR/STR: SOR 96-01

Title:   Periodic query crashes module

Description:

DBA Module/Aircraft MPM's select -> Display -> Query for an object -> and then in  Clutter/Declutter -> highlight Layers -> highlight Buckets: select Periodic and set the time and then select Color By or Count By in Clutter/Declutter and this will crash the modules. This did not crash in build 1A.

===================================================================

DTR:     D10089

SOR/STR: 6698

Title:   Report threat assessment crash

Description:

Aircraft MPM's Select File -> Create New or old Msn -> Route -> Launch/Recovery and create the msn . Select Output -> Rpts -> Aircrew -> Threat Assessment and then select create and the Aircraft MPM's will crash.

===================================================================

DTR:     D10090

SOR/STR: E2C

Title:   E2C TID not Initializing

Description:

In E2C selected Output>TID Processing and get message "Unable to initialize TID."  In errors log it shows "Device invalid".

===================================================================

DTR:     D10091

SOR/STR: SOR 95-47

Title:   Strike Package not Saving

Description:

Could not save a Strike package. Get error msg "The strike package was not saved properly."

===================================================================

DTR:     D10092

SOR/STR: 6.2 Init

Title:   Line of Sight function not working

Description:

The line of sight tool under Weaponeering>Radar Prediction is not working. After inputting the data in  the Line of Sight window and Apply or OK, get a msg "Error generating Field of View. See System Log for details." In the Workstation log it just says Error performing LOS calculations for Field of View.

===================================================================

DTR:     D10093

SOR/STR: 6698

Title:   Reports New KCARD

Description:

Aircraft MPM's -> File -> create new msn or use old msn -> Route -> Launch/Recovery and create the new msn -> select Output -> Reports -> Aircrew -> Platform Performance Rpt -> and then if you try to select Kneeboard Card (KCARD)  it will not display.   You have to close out the Aircraft MPM and then reopen the Aircraft MPM and reselect the msn to select the KCARD.

===================================================================

DTR:     D10094

SOR/STR: 6698

Title:   Report New KCARD output to printer

Description:

Aircraft MPM's -> Output -> Reports -> Aircrew -> Kneeboard Card (KCARD) -> the KCARD is displayed -> select output -> the only msg that is displayed is:Route Kneeboard Card has been sent to the printer.   This process just sent the Kneeboard Card to the printer.   Where is the Output Printer Data Window?

===================================================================

DTR:     D10096

SOR/STR: 3660

Title:   DBA Crash Loading NITF

Description:

The DBA Module crashes after completing the load of ADRI or NITF from 8 mm.

STR 3660 Failure.

===================================================================

DTR:     D10097

SOR/STR: 6214

Title:   No Default in Launch Details Dialog

Description:

STR 6214 asked for a default button as part of the rework for the Launch Details dialog, but this was not implemented.

STR 6214 Failure

===================================================================

DTR:     D10098

SOR/STR: SOR 96-01

Title:   Typographical problem in sit_default_defines.h

Description:

In sit_default_defines.h, the constants MPM_SETUP_DEFAULTS_SCENARIOS_BUTTON and

MPM_SETUP_DEFAULTS_SCENARIOS_CALLBACK are both #defined as (FILE_TOTAL+24).  MPM_SETUP_DEFAULTS_SCENARIOS_CALLBACK

should be defined as (FILE_TOTAL+25).

===================================================================

DTR:     D10099

SOR/STR: SOR 96-01

Title:   Ada Binding Not Synchronized With C Header File

Description:

The Ada binding file sit_default_defines.a does not align with the C header file

sit_default_defines.h.  The misalignment is causing segmentation violations

in the Ada MPMs.

===================================================================

DTR:     D10100

SOR/STR: SOR 96-52M

Title:   PC Card Declassify (pcscrub utility)

Description:

When an attempt is made to declassify a PC card in either slot using the pcscrub utility, the card appears to be declassified since no error message is displayed after the utility finishes.  When you try accessing the card after scrubbing it using pcls, pcdf or any other utility besides pcformat, get error message "error = 0x011".  After reformatting the card, it works ok.

===================================================================

DTR:     D10101

SOR/STR: SOR 96-52M

Title:   PC Card Format

Description:

Sometimes when formatting a PC card when there is a card in both slots, the formatting process will either fail and provide an error message or freeze up.  When the process freezes up, you cannot kill the process with the Sys Admin Process Manager, from the shell with kill -9, or by logging out.  The only way to kill the frozen format process is to reboot the system.  This happens on an intermittent basis.

===================================================================

DTR:     D10102

SOR/STR: SOR 96-52M

Title:   PC card Format Failure

Description:

If a PC card format process fails, the files that were on the card are garbled but the directory still indicates that there are valid files on the card by listing the file names.

===================================================================

DTR:     D10103

SOR/STR: SOR 96-52M

Title:   PC Card File Copy

Description:

If you attempt to copy a file to a PC card which does not have enough free space to receive the file, the utility pccp will start writing the file to the card but will display an error message when the card gets full.  (Could be a pccp utility problem.)

===================================================================

DTR:     D10104

SOR/STR: 6.2 init

Title:   Audit log fills up with no warnings

Description:

In audit admin I turned auditting on and selected all events. At COB Thurs /var/audit was at about 50%.  After a long weekend, I logged in Monday and there was a message in console about "error softlimit". Checked /var/audit and it was at 99%, the only alerts were green ones related to new audit files. This was fixed in 6.1.1 under STR 6709. Maybe the new COTS or sysgen broke it. Note! This was on "wisconson" with the patch from Rob to get audit to work.

SOT Step 95-43.1

===================================================================

DTR:     D10105

SOR/STR: 6.2 init

Title:   Saving FAMP data is not working for planner

Description:

As user planner selected from the WSE_BAR -> Mission Planning -> Weapons -> FAMP: File New Msn -> Route -> UMPM and entered selected data and then selected DELTAC and entered data.   Tried to save msn and could not save msn as planner.   The workstation log:INSERT Permission denied on object DELTAC_MISSION_PLAN, databsae tamps, owner dbo.

SOT Step 95-43.1

Note! Problem occurs when logged in using an account with MPM role only.

===================================================================

DTR:     D10106

SOR/STR: 6.2 init

Title:   Reports crash

Description:

Aircraft MPM -> File new msn or old msn -> Output -> Reports -> Aircrew -> and by selecting the Load and Drop Report where data is displayed in window or not and then close the Load and Drop Report, and then by selecting the kneeboard Card this will crash the Aircraft MPM.

SOT Step 95-43.1

===================================================================

DTR:     D10107

SOR/STR: SOR 96-10

Title:   SIPRNET Login Failed

Description:

In test lab set up one of the Ultras to emulate the SIPRNET. I could ping siprnet and when bring up the On-Line Update window it shows SIPRNET as being up. However, when select Download Almanac it gives an error message saying the download failed. In errors log it looks like it is looking for a USER and PASS for the login.

===================================================================

DTR:     D10108

SOR/STR: 6.2 init

Title:   Chart Removal

Description:

Can not remove a chart from the system. Installed an ADRG ONC chart for an area that didn't have any charts loaded.  All indications in the data removal dialog box indicated that the chart was removed.  After this, the chart could still be displayed and all data remained intact in the /maps/1 directory.

===================================================================

DTR:     D10109

SOR/STR: 6.2 init

Title:   GO/NO GO

Description:

GO/NO GO tests currently in 6.2 build 2 is from the DTC (150 MB tape and 5 1/4 inch floppy Disk Drive, etc) and not for the Ultra-2.

===================================================================

DTR:     D10110

SOR/STR: SOR 96-10

Title:   GPS Almanac Update, No Delete

Description:

In a DBA selected Update>GPS Almanac> Manual Update and  attempted to delete an old almanac file. Kept getting  Warning that "cannot delete last week from almanac". I had three weeks loaded at the time, weeks 154, 161, and 162. Attempting to delete any of them gave the same results.

===================================================================

DTR:     D10111

SOR/STR: SOR 95-47

Title:   Two complete loads of DAFIF.

Description:

Tried to load  two complete Versions of DAFIF, and received the following msg:Can't allocate space for objects in the database 'DAFIF_GPS' because the 'default' segment is full.

===================================================================

DTR:     D10112

SOR/STR: SOR 95-47

Title:   DAFIF Update Delete not working and crashes DBA Module.

Description:

DBA module -> Update -> DAFIF Tear-off Window:Select/Delete -> and the DAFIF Version Window for Selection and Deletion option is displayed.    Then by selecting delete and selecting apply or ok crashes the DBA Module and does not delete the DAFIF Version.   The Workstation Log had the following msg:DB-Library error

Maximum number of DBPROCESSes already allocated.

ddt_mmi Terminated by System Fault 65280.

===================================================================

DTR:     D10113

SOR/STR: SOR 95-47

Title:   One time DAFIF/GPS window

Description:

DBA Module -> Output -> Database Usage Tear-off Window -> Databases -> DAFIF/GPS: Confirm Operation Window -> OK the DAFIF/GPS window is only displayed one time and if you try to query for it a second time the tamps database window is displayed.   You have to close out the DBA Module and reopen the DBA Module again and reselect the DAFIF/GPS Usage tool.

===================================================================

DTR:     D10115

SOR/STR: SOR 95-43

Title:   Dynamic Menu Stability Issue

Description:

Public function sit_init allocates a dynamic menu table of predefined length.  It returns a pointer to this table, after storing a copy in a global variable, SIT_table.   The Ada MPMs take the table  pointer and pass it to umt_ResizeTable.  This function allocates a new (larger) table, copies the old table to the new one, then frees the old one.  It then returns the pointer to the new table.  But freeing the old pointer wipes out the memory to which the global variable SIT_table points.  The problem is that sit_ungrayTemp, which is called by mpt_initialExposeCB, tries to manipulate widgets from the contents of SIT_table.  Since Ada code executed subsequent to the call to umt_ResizeTable may have overwritten that "free" memory, the MPM crashes with a segmentation violation.

===================================================================

DTR:     D10116

SOR/STR: SOR 95-43

Title:   Ada Package Unsigned Enhancement

Description:

The introduction of package BASE_TYPES as the basis for definitions of pointer types in package UNSIGNED has effecively masked the equality operators for those data types.  Types so affected are SHORT_INTEGER_PTR, SHORT_INTEGER_PTR2, SHORT_INTEGER_PTR3, INTEGER_PTR, INTEGER_PTR2, INTEGER_PTR3, FLOAT_PTR, FLOAT_PTR2, FLOAT_PTR3, SHORT_FLOAT_PTR, SHORT_FLOAT_PTR2, and SHORT_FLOAT_PTR3.  The equality operators need to be declared locally as renames of the equivalent BASE_TYPES operators in order to have them visible as members of UNSIGNED.

===================================================================

DTR:     D10117

SOR/STR: 6216

Title:   Multiple Geo Delete

Description:

If the DBA attempts to delete 2 or more Geos at the same time, ddt_mmi crashes.

===================================================================

DTR:     D10118

SOR/STR: 6216

Title:   Current Geo Setting

Description:

When a new Geo is created by the DBA or an MPM user, it becomes the current Geo.  When the newly created Geo is selected from the Selectable Geos list and "New Geo" option menu is selected, "Current" is sensitive but should not be.

===================================================================

DTR:     D10119

SOR/STR: 6216

Title:   Geo Name Matching

Description:

In an MPM or DBA, create a new Corridor or Polygon Geo and choose a name that exists in the DB.  When trying to save, get a warning to rename but if you rename and attempt a save to DB, another warning is displayed about selecting points from the map.  This means you have to start over and can't use the points already chosen.  This also applies if you try to rename an existing Corridor or Polygon Geo.

===================================================================

DTR:     D10120

SOR/STR: 6216

Title:   Create Geo cancel

Description:

If you try to create a geo using the toolbar icon or from the Display pull-down menu and then try to create another one using the same method, get Delete confirmation warning.  If you select No, get error message:  "Geo with name CURRENT_GEO exists.  Please rename..."  This message should not be displayed after cancelling the create.

===================================================================

DTR:     D10123

SOR/STR: 6216

Title:   Geo Edit

Description:

When editing a planner Geo from the DBA, system allows the DBA to save a Geo with the same name since a "*" is placed before the name.  This causes problems displaying, etc.

===================================================================

DTR:     D10124

SOR/STR: 6216

Title:   Deleting Geos

Description:

When deleting a geo, the functionality is correct but the messages are confusing.  The following messages are displayed:

a)  if the Geo is not displayed or is displayed but not current, get the Delete Geo Confirm dialog box and the Geo Filter Delete box at same time.  Should not get the Geo Filter Delete box unless YES is selected.

b)  if Geo is displayed and current, get Delete Geo Confirmation dialog box and Message window saying Selected Geo does not exist.  Should not get the Message window at all.

===================================================================

DTR:     D10125

SOR/STR: SOR 96-60A

Title:   Count By Function window coupling

Description:

In count By Function, if you select an item in the middle of the list box , hold down the shift key, and select an item of lower value, all items are highlighted in between the two both on the map and in the list box.  If you hold down the shift key and select an item of higher value than the first item selected, without deselecting the other highlighted items, all items between the first item selected and the high value item are highlighted on the map.  However, all items between the lowest value and highest value selected are highlighted in the Count By window list box.

===================================================================

DTR:     D10126

SOR/STR: 6216

Title:   Multiple Geo select/Display

Description:

If more than one Geo is selected from the Geo list box, then display is selected from the option menu, none of the non-displayed Geos selected will be displayed if the top Geo in the selected list is already displayed.

===================================================================

DTR:     D10127

SOR/STR: SOR 96-60A

Title:   Count By Function Window Migration

Description:

In Count By Function, if the window is the minimum width possible, an attempt to decrease the width by dragging the left side toward the right side moves the window to the right a small amount.

===================================================================

DTR:     D10128

SOR/STR: 6216

Title:   Create Geo Blank Field

Description:

If you leave a field blank while manually creating a rectangle or circle Geo, the blank field will be automatically filled in with zeros.  If you try to perform a query using this Geo, nothing is returned.  If you edit the Geo and put in a new value for the zeroed field, there is still no return from a query.

===================================================================

DTR:     D10129

SOR/STR: 6216

Title:   Geo Lat/Long Error

Description:

If you inadvertantly exchange the North and South Latitudes or the East and West Longitudes when manually creating a rectangle Geo, the Geo will appear to be drawn correctly using the North-most entered latitude on top and the west-most entered longitude on the left side and so forth.  If you use this geo to perform a query, nothing is returned.

===================================================================

DTR:     D10130

SOR/STR: 6216

Title:   Geo  Circle Blank Radius

Description:

If you manually create a circle but leave the radius blank, get a warning to please specify value for field Circle Radius but the input fields are insensitive preventing any entry.

===================================================================

DTR:     D10131

SOR/STR: 6.2 init

Title:   C2A MPM not in Build 2

Description:

Need to add C2A MPM to CD for Build 3.

===================================================================

DTR:     D10133

SOR/STR: 6698

Title:   KCard, missing Mission Name

Description:

The new Kneeboard card in build 2 does not print out the mission name in top left corner like the example provided in the design notebook shows.

===================================================================

DTR:     D10134

SOR/STR: 6698

Title:   KCard Flight Levels wrong

Description:

In the new KCard the altitude MSL is showing up as FL24000 when it should be either 24000M or FL240.

===================================================================

DTR:     D10135

SOR/STR: 6698

Title:   KCard, Missing Date

Description:

The new kneeboard card does not print out the date in the top left block like shown in example.

===================================================================

DTR:     D10136

SOR/STR: 6698

Title:   KCard, leg time is showing 00

Description:

Sometimes the new Kcard shows leg times equal to 00+00+00.

===================================================================

DTR:     D10137

SOR/STR: 6698

Title:   KCard Default data format wrong

Description:

The new KCard does not have the default data in the columns like the example provided by VX-9.

===================================================================

DTR:     D10138

SOR/STR: 6698

Title:   KCard, default font

Description:

Change default font size to Courier 10, per VX-9.

===================================================================

DTR:     D10139

SOR/STR: 6698

Title:   KCard UTM Coords

Description:

In the kneeboard card the UTM coordinates do not appear to be the correct format.

===================================================================

DTR:     D10140

SOR/STR: SOR 97-10

Title:   Missing DD_VALID_THREAT_TYPES table

Description:

There were two new files delivered in Build 2 to support the dft_get_order_of_battle function:

dd_valid_threat_types_create.sql and  dd_valid_threat_types_insert.sql.

These files were not added to the Install_datadict.csh file and therefore NEVER get installed on the target system.  Install_datadict.csh needs to be modified to install these files.

There is also a problem with the insert file.  It still uses the IDB table and field names.  It needs to be modified to reflect the new MIDB table and field names.

The affected directory is ../src/dbinstall/data_dict.

===================================================================

DTR:     D10141

SOR/STR: SOR 96-52M

Title:   upl_Seek problem

Description:

After creating a one megabyte file and then seeking to (one megabyte - 2) bytes, a subsequent two byte write appears at the wrong offset within the file.

===================================================================

DTR:     D10142

SOR/STR: SOR 96-68

Title:   bat library source code cleanup

Description:

BAT functionality was removed under SOR-96-68, however,

the code itself was not marked deleted under harvest version

control. This code should not get synched out since it is not being

built.

===================================================================

DTR:     D10143

SOR/STR: SOR 95-43

Title:   mwm crashes

Description:

mwm crashes after a full system modal application is run, and the user moves another window and attempts to update the map display with query results.  Reading the MPM header file while loading MPMs also causes mwm to crash.

===================================================================

DTR:     D10146

SOR/STR: 6698

Title:   KCard Text Overwrites data

Description:

In the new Kneeboard card, when a long text string is entered for a nav point description it overwrites other data on that nav pt line.

===================================================================

DTR:     D10148

SOR/STR: 6755

Title:   Autosave Message Box for Route Validation

Description:

If Route Validation is disabled and Autosave is enabled, a message

box comes up for each autosave asking the user if they want to

validate the route before saving.  This message box should be

eliminated to keep the autosave operation transparent to the user.

===================================================================

DTR:     D10150

SOR/STR: 6755

Title:   Bitmaps for Route Validation Toolbar Button

Description:

There is no icon for the route validation pushbutton.

===================================================================

DTR:     D10151

SOR/STR: SOR 96-10

Title:   On-Line GPS/Automatic Update

Description:

The fix for DTR 10050 was not implemented in the stand-alone executable (dpl_downloadGPSAlmanac) which performs the Automatic/Scheduled GPS download.  Specifically, dpl_downloadGPSAlmanac looks for  the NAVSSI_Host and SIPRNET_Host environment variables.

===================================================================

DTR:     D10152

SOR/STR: SOR 96-52M

Title:   PC Card Formatting with Cylinder, Head and Sector Information and Quick Format

Description:

After providing a formatted PC Card to TAMMAC it was determined that Cylinder, Head and Sector information must be included in the formatting partition definition in order for the TAMMAC system to use the PC Cards.  Discussions between the TAMPS IPT and TAMMAC resulted in agreement to add this capability to 96-52M in build 3.  It also was decided that a switch would be implemented in the format command to turn off read after write data integrity checking for high capacity TAMMAC map theater cards.

===================================================================

DTR:     D10155

SOR/STR: SOR 97-10

Title:   Failure to Close Sybase Connection

Description:

The tet_getMapFilenames interface failed on the 26th call made to it.  A message saying unable to connect to Sybase server was given.  Discussions with Chuck Ruby determined that previous connections were not being closed.  Sybase limit is 25 open connections.

===================================================================

DTR:     D10170

SOR/STR: D10076

Title:   Implement fixes required for 6.2 Build 3A

Description:

add fixes required to support MPLAN in Build 3A

SOT Step 95-43.1

===================================================================

DTR:     D10171

SOR/STR: SOR-95-47

Title:   Mission Xfer

Description:

MPM's request the ability to save the original planner name to missions being transferred vice having the planner name switched to the person who had initiated the mission transfer.

===================================================================

DTR:     D10181

SOR/STR: SOR 96-01

Title:   NIS+ cache needs refreshing after user add or delete

Description:

After a user is added or deleted using the TAMPS user administration

HMI, the update is not immediately visible to applications that use

getpwuid() or getpwnam() to get user information.

Many instances of this error were worked around with DTR 10072 (during

testing of which this problem was discovered), but the problem has still

been observed.

The problem is most visible when trying to re-create a user that was

previously removed from the system.  One way that might reproduce the

problem is to delete a user; add a different user (to reuse the old user's

UID); then re-add the first user.  Try this within one zet_uadmin run, or

restarting zet_uadmin before re-adding the user.

It was also noticed that "~user" continued to refer to a directory for

some time after a user was deleted with zet_uadmin (although the

directory no longer existed); it should say "unknown user".  This seems

to be related to this problem.

The best way to fix this would probably be to find some way to force

NIS+ (or the getpwuid library) to rebuild its cache; this could be done

within the zet_adduser.sh, zet_moduser.sh and zet_deluser.sh scripts,

or in the code after the scripts have exited.

===================================================================

DTR:     D10197

SOR/STR: SOR 95-47

Title:   DAFIF transaction stored procedures corrupted.

Description:

The stored procedures for performing DAFIF transaction loading have been corrupted.  The database name prefix was duplicated, causing the insert of the stored procedure.

===================================================================

DTR:     D10198

SOR/STR: SOR 95-47

Title:   DTED Load/Display errors

Description:

The manual option is greyed out for DTED load.

Cannot Display DTED after it is loaded

===================================================================

DTR:     D10199

SOR/STR: 6.2 Init

Title:   DOD Banner Not in Center

Description:

The DOD banner sometimes comes up in the upper left corner of the display vice the center.

===================================================================

DTR:     D10200

SOR/STR: SOR 95-47

Title:   Cannot change TAMPS password

Description:

Using the User Admin function the TAMPS password cannot be changed. SA must change it in a shell .

Note! Other problems besides just TAMPS password.

root password mod is difficult

any tamps user password change makes that account unusable

no checking between credential and login password creates good chance for

an unusable account

etc.

D10528i also related

===================================================================

DTR:     D10201

SOR/STR: 6.2 Init

Title:   Cannot Communicate with the MU

Description:

After loading a standalone system that had both a DSUR & MDLR attached, using MU/MDL utilities I could not view device info for the MU. The MDL worked OK but the MU kept getting "Error opening device".  After a shutdown and boot -r, I could check MU fine.

SOT Step 95-43.1

===================================================================

DTR:     D10202

SOR/STR: SOR 95-47

Title:   Could not save and reopen a Strike package

Description:

Created a F14 and E2C missions and saved them in a strike package. The strike saved without errors but when selected Strike Open nothing was listed in the window.

===================================================================

DTR:     D10203

SOR/STR: SOR 95-47

Title:   No Warning on Client Connect

Description:

When connecting a client workstation to a server system, no warning is

provided to the user if an unavailable IP address is used.  The user should be

warned and given a chance to change it prior to connecting.

===================================================================

DTR:     D10204

SOR/STR: SOR 95-47

Title:   Client / Server Coverage Tools

Description:

On a client system:  Prior to selecting the server coverage tool, the client

coverage tool correctly displays the data loaded on the client.  However,

once the server coverage tool has been displayed, the coverage tools

display the server data, regardless of whether client or server is selected.

===================================================================

DTR:     D10205

SOR/STR: SOR 95-47

Title:   DBA Crash with DCW Load

Description:

Attempting to load DCW from the client of a client / server system causes the

DBA module on the client to crash.  It appears that the data is loaded to the

server database successfully before crashing,

===================================================================

DTR:     D10206

SOR/STR: SOR 95-47

Title:   DCW Display on Client

Description:

DCW loaded in the server database can not be displayed on the client.  The coverage tool shows no data loaded and DCW features do not appear when zooming in to a DCW area.

===================================================================

DTR:     D10207

SOR/STR: SOR 95-47

Title:   CIB Display on Client / Server

Description:

CIB imagery loaded to the server database from the client workstation can not

be displayed on the client or the server.  The images appear in the coverage

tool on both systems, but do not appear in the background imagery select

tool on the client.

===================================================================

DTR:     D10208

SOR/STR: SOR 95-47

Title:   CADRG Display on Client / Server

Description:

CADRG and ADRG charts loaded to the server database from the client

workstation can not be displayed on the client or the server.  The charts

appear in the coverage tool on both systems, but do not display when

selected from the background tool.  Charts loaded to the server database

from the server station can only be displayed on the server.

===================================================================

DTR:     D10209

SOR/STR: SOR 95-47

Title:   DAFIF Display on Client / Server

Description:

DAFIF loaded to the server database from the client workstation can not be

accessed by either the client or the server.  DAFIF loaded using the server

station can be accessed by both stations.

===================================================================

DTR:     D10210

SOR/STR: 6697

Title:   Printer Error in Console Window

Description:

Console window displayed the following error: Device Busy Can't open  /var/spool/Xerox/xpxx/_dev_bpp0/number.  This happens when you use screen grab and strip Charts.   To get rid of the msg in the console window I had to do a reboot, because if not the msg  repeated over and over again.   Have not checked any all of the print functions.

===================================================================

DTR:     D10211

SOR/STR: SOR 96-01

Title:   MIDB Editors do not support deleting data

Description:

The MIDB production editors (which are GOTS) do not support deleting MIDB

records.  TAMPS has requirements to be able to delete (or to mark as

deleted) GMI and DBA target records.

96-01 SOF statements:

3.2.3.5.6      The GMI Editor CSC shall provide the ability to delete data.

3.2.4.3.4.1   The Target Editor CSC shall allow the DBA to delete any planner

or DBA created targets.

===================================================================

DTR:     D10212

SOR/STR: SOR 96-01a

Title:   Help updates required for Planner Target HMI

Description:

The help information for the Planner Target HMI needs to be updated for

the new HMI.

===================================================================

DTR:     D10213

SOR/STR: SOR 96-01a

Title:   Help updates required for scenario HMI

Description:

===================================================================

DTR:     D10214

SOR/STR: 6755

Title:   Help updates required for Selectable Route Validation

Description:

===================================================================

DTR:     D10215

SOR/STR: SOR 96-01a

Title:   Help updates required for OOB Query HMI

Description:

===================================================================

DTR:     D10216

SOR/STR: SOR 96-01

Title:   Archive/Restore Effective dates

Description:

The effective date and classification are greyed out in the Archive/Restore Window when you select databases to archive to media (8MM tape or 3.5 disk).

Process:DBA Module -> Util -> Archive/Restore -> Archive/Restore Window.

Gary from TRW said,  this is by design.    The window before this 6.2 B3 was not grayed out.

The Restore option has the effective date and classification not grayed out.

The Dump/Restore has no date or classifcation widget.

===================================================================

DTR:     D10217

SOR/STR: SOR 95-47

Title:   DBA - Database Usage, NID

Description:

When you select NID from the Database Usage tamps datasets, the query will return the whole data for tamps and at the bottom of the window the total is as follows:(NID Total).

Process:DBA -> Output -> Database Usage -> tamps Datasets -> NID.

Before it would just bring the NID data tables.

===================================================================

DTR:     D10218

SOR/STR: SOR 95-47

Title:   Ready to Reboot Confirmation

Description:

If an invalid client IP address is entered in the Connect to MPLAN window,

an error message is correctly displayed, but the "Ready to Reboot

Workstation" confirmation dialog is displayed on top of it.  The confirmation

dialog should not appear if an error is detected.

===================================================================

DTR:     D10219

SOR/STR: SOR 95-47

Title:   Connect with Different Subnet

Description:

If a client is connected using an IP address subnet that is different than the

server, the client gets hung up in the reboot process and the system must

be reloaded to recover.

===================================================================

DTR:     D10220

SOR/STR: SOR 95-47

Title:   Rename Accounts

Description:

An error message is displayed when trying to rename conflicting user

accounts during a client connect.

===================================================================

DTR:     D10221

SOR/STR: SOR 95-47

Title:   User Initialization HMI

Description:

After connecting a client to the server and logging in, the User

Initialization HMI appears in the upper left corner of the screen, and

without a motif border.

===================================================================

DTR:     D10222

SOR/STR: SOR 95-47

Title:   New Password for Client User

Description:

After connecting a client workstation, I entered and re-entered a new

password in the User Initialization HMI and then tried to log back in to that

account using the new password, but couldn't.  The password for the account

had not been updated.

===================================================================

DTR:     D10223

SOR/STR: SOR 95-47

Title:   Conflicting Accounts

Description:

Deleting conflicting user accounts does not appear to work properly.  I

selected Close in the Conflicting User Accounts HMI and then OK in the Delete

Conflicting Users dialog, but each time I logged back in with a DBA/SA

account, the Conflicting User Accounts HMI appeared with the same

conflicting accounts listed.

===================================================================

DTR:     D10226

SOR/STR: SOR 95-47

Title:   Not Updating Reports Database Catalog after Dump/Restore.

Description:

1. The Dump/Restore is not updating the Reports Database Catalog.   The databases that are not updating are:GMI, NID and DAFIF_GPS.  The DAFIF_GPS was not updated in the DAFIF Version Windows.

2. The loader window:DBA -> Util -> Load of tamps did update the the Reports Database Catalog for MIDB Baseload and NID.   Used the Data Removal Tool to remove the NID from the Reports Database Catalog, and it did remove.   Could not Remove MIDB Baseload with the Data Removal Tool.

3. Stand alone systems.

===================================================================

DTR:     D10228

SOR/STR: 6698

Title:   Kneeboard Card Lattitude Format

Description:

If change default units to DD:MM:SSH and printout a Kcard, it puts a space between the first and second digit of the lattitude. When using the defualt units of HDD:MM:SS the printout looks OK.

===================================================================

DTR:     D10229

SOR/STR: SOR 95-47

Title:   Cannot update NIS+ Host Table with new hostname

Description:

The NIS+ Host Table cannot be updated successfully.  To update the table successfully, you must add an entry with an identical Hostname and Alias first and then can add other Aliases for this Hostname.  When you try to add an entry using the WSE LAN Admin tool, the identical Hostname and Alias entry is created ok but when you try to add Aliases for this Hostname, get an error about duplicate Hostname and the entry is not put into the Table.

===================================================================

DTR:     D10230

SOR/STR: 6699

Title:   Kneeboard Card Reorder Function

Description:

If the Re-Order function is used to add data to the "Blank" column on the left side, there is no room for the extra data in the printout so it tries to print between the page 1& page 2 sections but overwrites some data. If data is added to the blank columns on the right side it is just not printed out, since the right side is already at the edge. Since there is no longer a selection for font size, there is no way to add additional columns and get it to printout in a readable format.

===================================================================

DTR:     D10231

SOR/STR: 6496

Title:   Audit Log Open

Description:

To attempt to fix the crash on open problem a limit of 50K records was imposed on primary file open in the audit logs. After only ten minutes with all audit events turned on I opened the log and received the message "maximum number of audit records (50000) reached. ...." Then it tells the SA to either use the date option or change a ZZT_MAX_NUM... environment variable. After acknowledging the message the log did open but contained only the oldest 50k worth of records, less than three minutes of data. This is an unsatisfactory solution to the problem of crashing on opening a large log. Although the audit functions are only available to a SA user, I doubt many in the Fleet will know how to change an environment variable and this message needs to changed.The logs in /var/audit at this time were only about 10MB total.

===================================================================

DTR:     D10232

SOR/STR: 6755

Title:   Invisible message when adding route points

Description:

When adding points to a route, route validation off, a message window flashes up and then dissapears before it can be read. Don't know what it says but this is annoying.

===================================================================

DTR:     D10234

SOR/STR: 6699

Title:   Course True Missing From Kneeboard Card Re-Order List

Description:

"Course True" should be one of the data items available in the selection list in the kneeboard card re-order window

===================================================================

DTR:     D10235

SOR/STR: 6698

Title:   Field Width For Elevation Is Too Small In Kneeboard Card

Description:

The field with for elevation is too narrow in the kneeboard card, resulting in in overrunning into the field next to it.  This cause the data next to it in the kneeboard card to be difficult or impossible to read.

===================================================================

DTR:     D10236

SOR/STR: 6699

Title:   Attempting To Load A Non-Kneeboard Card File Crashes The MPM

Description:

If Load File is selected from the Kneeboard Card window, and a file is selected from another directory that is not a kneeboard card file (*.RKC), the MPM crashes.  The user should not be allowed to select anything other than route kneeboard card (.RKC) files.

===================================================================

DTR:     D10239

SOR/STR: 6698

Title:   Target Data Items Blank in Kneeboard Card

Description:

If the CRS TGT, DIST TGT, or TIME TGT data items are placed in the kneeboard card, they are displayed blank even with an attack target flight event as part of the route.  These data items should display the course, distance, and time direct to the defined target from the turnpoint.

===================================================================

DTR:     D10240

SOR/STR: 6697

Title:   Doghouse Component Editor Current/Next Off By One Turn Point

Description:

When "Current Point" is selected in the component data editor for a data item, you get next point information.  When "Next Point" is selected, you get next-next (two points subsequent) information.  The current point info needs to be for the waypoint adjacent to the doghouse, and the next point info needs to be for the point subsequent to the point adjacent to the doghouse.

===================================================================

DTR:     D10241

SOR/STR: 6697

Title:   Doghouse Component Data Items Displayed Blank

Description:

The following doghouse component data items do not display any information in the doghouse:

"Distance Leg", "Ident Bearing Range", "Course to Target", "Time to Target", "Distance to Target".

===================================================================

DTR:     D10242

SOR/STR: 6697

Title:   Distance Cumulative Displays Leg Distance

Description:

Selecting "Distance Cumulative" in the doghouse component data editor results in display of leg distance instead.

===================================================================

DTR:     D10243

SOR/STR: 6697

Title:   Selecting "Altitude MSL" For A Leg Defined As AGL Reverts Selection To AGL.

Description:

If a doghouse is selected for a turn point which is defined by an AGL altitude, and "Altitude MSL" is selected in the component data editor for display, the selection is ignored and AGL altitude is displayed and selected when Exit and Apply Changes is selected.  The planner may want to display MSL altitude for cross reference even if the point is defined as an AGL altitude

===================================================================

DTR:     D10244

SOR/STR: 6697

Title:   Incorrect Clock Time Display In Doghouse

Description:

If "Clock Time" is selected for display in the doghouse component data editor, the only thing actually displayed in the doghouse are the words "Clock Time".

===================================================================

DTR:     D10245

SOR/STR: 6697

Title:   Divert Heading Incorrectly Displayed In Doghouse

Description:

If "Divert Heading" is selected for display in the doghouse component data editor, it displays as a true heading.  Divert heading should be displayed as magnetic heading.

===================================================================

DTR:     D10246

SOR/STR: 6697

Title:   Divert ID Displayed Incorrectly In Doghouse

Description:

If "Divert ID" is selected for display in a doghouse using the component data editor, the waypoint number is displayed instead.

===================================================================

DTR:     D10247

SOR/STR: 6697

Title:   Elevation Displayed Incorrectly In Doghouse

Description:

If "Elevation" is selected for display in a doghouse using the component data editor, the aircraft altitude AGL is displayed instead.

===================================================================

DTR:     D10248

SOR/STR: 6697

Title:   Headings In Doghouses Not Taking Wind Into Account.

Description:

If a true or magnetic heading are displayed in a doghouse, they do not take wind (crosswind) into account.

===================================================================

DTR:     D10249

SOR/STR: 6697

Title:   Course Displays In Doghouses Do Not Have T Or M Next To Them

Description:

If true or magnetic course are selected for display in a doghouse using the component data editor, they are just displayed as a 3 digit number, with no M ot T legend next to them to indicate what reference they are using.

===================================================================

DTR:     D10250

SOR/STR: 6697

Title:   Component Data Items Not Saving With Doghouse

Description:

If a doghouse is customized using the component data editor, and then saved, many of the selected data types do not save or recall with the doghouse load function.  The following data items are not recalled when a saved doghouse is loaded:  Bank Angle, Calibrated Air Speed, Course Magnetic, Course to Target, Course True, Description, Distance Leg, Distance to Target, Distance to Divert, Elevation, Flight Mode, Fuel Flow, Ident Bearing Range, MGRS, Speed Mach, Time to Target, True Airspeed, UTM Coord, UTM Zone, Wind Speed/Direction.

===================================================================

DTR:     D10251

SOR/STR: 6825

Title:   Strip Chart Tick Marks Scaled Incorrectly

Description:

Time ticks on strip charts are scaled incorrectly.  Planned a low level route with a constant groundspeed of 480 KTS.  Each strip in the series had a different scaling between time ticks, especially on strips that had one leg split over two strips.  The distance between tick marks varied from being correct (8 nm) to as short as 4 nm apart on some strip charts, as well as several distances in between.  With a constant 480 GS, the tick marks should all be 8 nm apart.  For legs that were split over two strips, the first strip generally had ticks that were very close together, while the second strip for that leg had correct spacing.

===================================================================

DTR:     D10252

SOR/STR: 6825

Title:   Strip Chart Tick Marks Incorrectly Placed With Respect To Turn Point

Description:

The tick marks are no longer rounding off to the nearest minute at each turn point, but they are not placed correctly with respect to the turn point time, either.  The tick marks are placed approximately 1 to 2 nm short of where they should be in the vicinity of the turn point based on turn point time.  Example: first strip with 3 legs, two turn points, with hack time of 00+00:00 on the second point.  Time zero tick mark appears one mile short of turn point with zero hack.  Time 2 tick appears 2 miles short of next turn point with turn point time of  02:04 elapsed in dog house ( 4 seconds should be .5 nm). Time tick 4 appears 1 nm past next turn point, which is at time 3:42 ( 18 seconds should be 2.4 nm).

===================================================================

DTR:     D10253

SOR/STR: 6825

Title:   Strip Chart Tick Marks Not Drawn Correctly On First Strip

Description:

Not all tick marks are drawn on first strip chart in series.  Had low level route with hack time of 00+00:00 at start point of low level, which was point 4 in mission route. Strip chart editor was brought up with a series of 4 to 10 (end).  The first strip had three legs on it (4-5-6-7).  The only time ticks displayed were at 2 minutes and 5 minutes, and were scaled incorrectly.  If the same route was brought up in the strip chart editor starting one point prior to the hack point (3 through 10),  then time ticks were displayed as "-0" at time -1, 0 (but 1 nm shy of the hack point), 1, and 2.  There was no tick mark for time 3.

===================================================================

DTR:     D10254

SOR/STR: 6496

Title:   Audit Log  ZZT_MAX_NUM_AUDIT_RECORDS environment variable

Description:

When trying to open the audit log with more than 50K of data, an error message tells the user to modify the ZZT_... env variable. When I looked in tamps.env the variable is not there.

===================================================================

DTR:     D10255

SOR/STR: 6217

Title:   Symbol  Annotation, Default Button

Description:

The STR calls for the "Apply" button to be the default. The finger button is set to default after selecting location vice the Apply. Apply is only the default after selecting Apply.

===================================================================

DTR:     D10256

SOR/STR: 6755

Title:   Manual Route Validation not updating Fuel data

Description:

In E2C MPM, input launch/recovery and then navpt #2. Opened the dynamic kneeboard card and checked it, fuel was blank in brief format. Then selected the calculate button on toolbar, a validating route message pops up briefly but it does nothing else. The fuel data is still not showing up in the Kcard. I checked the regular Kcard and it too, showed --- in the fuel column. I had to turn route validation on under Setup and add another navpoint to get fuel data.

===================================================================

DTR:     D10257

SOR/STR: 6755

Title:   Mission Save, Route Validation not Working

Description:

With Route Validation defaulted to off, and select File Save in a MPM, a message comes up asking do you want to validate current mission before saving.  I selected Yes and checked the dynamic and route kneeboard cards. The dynamic brief format still had --- for fuel, but the full format showed fuel and GWT data. The route kneeboard card had --- in the fuel fields. Again the only way to get fuel data in the printed Kcard is to turn route validation on in the setup>defaults. Similar problem to DTR 256.

===================================================================

DTR:     D10258

SOR/STR: SOR 95-43

Title:   Audit log not tracking logins

Description:

The auditting was configured with just login_logout selected. In the audit log it is only showing the user logouts. The log shows the "username"  login or logout and then WSE logout for logoffs, but there are no login events in log.

SOT Step 95-43.1

===================================================================

DTR:     D10259

SOR/STR: SOR 95-43

Title:   PST User Manuals will not open

Description:

I loaded the user manuals for mission planner from the 6.1/6.1.1 CD and they loaded OK. I then logged off and logged back on and selected User Manuals from WSE Help menu, and the User Manual window came up with Users Manual, Mission Planner in list. However, when attempt to open the manual nothing happens. In the error logs it shows a message about couldn't ececute "acroread": no such file or directory.

SOT Step 95-43.1

===================================================================

DTR:     D10261

SOR/STR: SOR 96-01

Title:   Remove Archive/Restore IDB

Description:

In DBA Archive/Restore window, IDB is still an option under Select Dataset. This needs to be removed since it is no longer applicable with MIDB and probably won't work anyway.

===================================================================

DTR:     D10262

SOR/STR: 6698

Title:   Reports/Kneeboard Card Causing Crash

Description:

In an MPM opened a mission and then selected the Platform Performance Report. Closed Report without printing and then selected the Route Kneeboard Card, selected create report and  TAMPS format and in a couple of seconds the MPM crashed.

===================================================================

DTR:     D10263

SOR/STR: 6.2 Init

Title:   Database Usage Print causing crash

Description:

If Laser Print Button is selected after querying database usage on DAFIF/GPS, get a print preview window.  If Laser Print Button is selected after querying the same a second time, DBA module will crash.

SOT Step 95-43.1

===================================================================

DTR:     D10267

SOR/STR: 6317

Title:   GPSMDL Loadset retrieve causes crash

Description:

Created a mdl loadset in F14D and saved it. Selected Retrieve and highlighted the loadset name in list, then OK and MPM crashed. Also, did the same thing in AH-1W.

===================================================================

DTR:     D10268

SOR/STR: 96-01

Title:   Archive/Restore MIDB (GMI)

Description:

Archive/Restore:

The MIDB (GMI database) is not on the list for archive/restore.   The archive/restore had IDB in the list.

===================================================================

DTR:     D10269

SOR/STR: SOR 95-43

Title:   Sysgen Build 4

Description:

Implement Sysgen changes required for Build 4, including COTS changes, MPLAN and MIDB support.

SOT Step 95-43.1

===================================================================

DTR:     D10270

SOR/STR: SOR 95-43

Title:   Sysgen Volume Manager

Description:

Implement Veritas Volume Manager installation for E-4000

SOT Step 95-43.1

===================================================================

DTR:     D10273

SOR/STR: 6697

Title:   Doghouse Component Data Items:  ICN Change

Description:

F/A-18 MPM found a misspelling of a Doghouse Component Data Item #define in "bsa_defines.h".   The item "bSa_DOGHOUSe_ID_BEARING_RANGE_NAME" should be "bsa_DOGHOUSE_ID_BEARING_RANGE".  This error caused an Ada bindings problem.

===================================================================

DTR:     D10275

SOR/STR: SOR 97-13

Title:   PFPS Import Messages not coming up in front

Description:

After successfully importing a PFPS mission from floppy the message about a successful import comes up behind the Import window. This also happens with other error messages from PFPS import.

===================================================================

DTR:     D10276

SOR/STR: SOR 97-12

Title:   Yearly Crypto Keys Change to Weekly

Description:

When a user tries to enter or modify the start/end dates for a yearly GPS

crypto key usin the Modify HMI, part of the logic treats the key as a

weekly key.  If the new dates overlap any dates for weekly keys in the

database, an error message is displayed when Apply is selected, and

the key can not be entered into the database.  This should only happen

when the date of another yearly key is overlapped.  Also, if the date change

is successful, the key type changes to weekly (CVw).

SOT Steps 97-12.4 and 97-12.8

===================================================================

DTR:     D10277

SOR/STR: SOR 97-12

Title:   GPS Crypto Key Help

Description:

The help files for the crypto key manual entry and modify HMIs are no longer correct.  The help files should be updated to reflect the new short title checks and key type algorithm.

===================================================================

DTR:     D10278

SOR/STR: SOR 97-12

Title:   Incorrect Short Title Error

Description:

If the cursor focus is changed before starting the short title entry in the crypto key manual entry function, an error message is displayed which says: "Key purpose is not operational or simulation. .....".  If no title has been entered yet, no error should be displayed.  If an invalid title is entered, the error should read something like:  "The short title entered does not match the format for an operational or simulation key.  Only operational and simulation keys can be loaded on TAMPS".

===================================================================

DTR:     D10279

SOR/STR: SOR 97-13

Title:   PFPS Import Default Classification

Description:

Since PFPS mission data does not contain Classification, TAMPS needs to set the classification to "Unclassified" as default on import. Otherwise when open a PFPS mission in a MPM, there is no classification at the bottom of the MPM and when go to output a report they come up as Top Secret.

===================================================================

DTR:     D10280

SOR/STR: SOR 95-47

Title:   Background Environment Window.

Description:

The environment HMI window in the background tool is not listing the Op Areas.  Select DBA -> Display -> Background -> Weather -> Edit to display the window.

===================================================================

DTR:     D10282

SOR/STR: SOR97-11a

Title:   ICWG 184.2 fixes

Description:

move jet_displayQueryResultsDialog from public to private.

change variable names in JET_IMAGERY_METADATA_T and JET_MTF_DATA.

add PPIP type to JET_CATEGORY_TYPE.

changed descriptions in tet_NITFFunctions to agree with prototypes

===================================================================

DTR:     D10283

SOR/STR: SOR 95-43

Title:   Sysgen External Interface Prompts

Description:

Implement user prompts for connections to external interfaces during Sysgen, such as SIPRNET, JMCIS...

SOT Step 95-43.1

===================================================================

DTR:     D10284

SOR/STR: SOR 95-47

Title:   Import/Export TAMPS Missions not working

Description:

When select Import/Export tamps missions get the new Mission Data Transfer window. Select Source=Workstation and Destination= Media then select either 8mm tape or 3 1/2 inch disk and OK. An Error Message window comes up saying "In bmt_missionOkCb - Error parsing device name".

===================================================================

DTR:     D10285

SOR/STR: SOR 95-47

Title:   Mission Data Transfer Window  Devices

Description:

Remove the 1/4 inch Cartdrige medial as an option under this new window. There are no QIC 150 drives on any 6.2 hardware.

===================================================================

DTR:     D10286

SOR/STR: SOR 95-47

Title:   Removing IP Addresses on Server

Description:

On a server system, if a user selects view -> NIS+ Host Table from the

LAN administration window, highlights an unassigned IP address and

selects edit -> remove, the IP address is only temporarily removed from

the list , and an error message is displayed saying:  "Error modifying NIS+

table".  When the NIS+ Table is reselected, the IP address is in the list

again.  The remove option works for IP addresses that have been assigned

a hostname, and should be consistent.

===================================================================

DTR:     D10287

SOR/STR: SOR 96-60H

Title:   Object Editor Import/Export FAILS

Description:

Could not Export using the Object Editor Import/Export New HMI window.

From the WSE_BAR selected DBA -> Object Editor -> highlighted DAFID_AIRBASES -> highlighted JOINT -> then selected Import/Export -> and the Object Import/Export new HMI window was displayed:Selected radio button Export -> then selecting 8mm tape or 3.5 disk, and then the verify Export Media Load window is displayed:Selected OK and then selected Apply at the Object Import/Export Window:and received the following Message window.A system error occurred at the completion of the export process.

===================================================================

DTR:     D10288

SOR/STR: 96-60H

Title:   Object Editor Import/Export New HMI window.

Description:

Crashed the Object Editor using the New HMI Import/Export window.

From the WSE_BAR selected DBA -> Object Editor -> highlighted DAFID_AIRBASES -> highlighted JOINT -> then selected Export User Directory radio button:highlighted the JOINT.odf  -> selected 8mm tape or 3.5 disk to active the OK or Apply buttons in the Object Import/Export Window: received the following ACK Window:Verify Export Media is loaded. Then by selecting OK in the ACK Window crashs the ALL the Object Editor Windows.

===================================================================

DTR:     D10289

SOR/STR: SOR 96-52M

Title:   Full PC Card Write Error

Description:

If you attempt to overwrite a file on a nearly full PC card with a file of identical filename, an error is displayed (and the file is not written) saying that the card is full - even if, by overwriting the file, the file being written would fit on the card.  The PC card driver should check for filename match and calculate the space available without the matching file before giving a card full indication.

===================================================================

DTR:     D10290

SOR/STR: SOR 95-47

Title:   Client Info Incorrect

Description:

The location, squadron, POC and phone/extension information is not being

displayed correctly on the server when amplify information is selected for

any of the connected clients.  Some of the fields are interchanged and

some information is just incorrect.  Also, the location is not correct in the connected client list.

===================================================================

DTR:     D10291

SOR/STR: SOR 95-47

Title:   Amplify Info Under WSE

Description:

The client Amplify Info window pops up under the WSE bar on the server.

===================================================================

DTR:     D10292

SOR/STR: SOR 95-47

Title:   Client Idle Time

Description:

In the client Amplify Info window, "Idle time" is displayed in seconds only.  The format would be much more usable in days, hours:min:sec.

Note: Modified text of this DTR on 1/15/98

===================================================================

DTR:     D10293

SOR/STR: SOR 95-47

Title:   Connected Client Status

Description:

Connected client workstation status, displayed in the server's LAN administration HMI, is not correct.  It shows "Active" if a user is logged in and "Unknown" if not.  The SOF statements state that the status should be "Active" when the client is powered up and "Inactive" when not.

===================================================================

DTR:     D10294

SOR/STR: SOR 95-47

Title:   New Missions on Client/Server

Description:

New missions created on connected clients must be created using op areas

that were created on the client.  Server op areas are listed in the New Mission

HMI, but if one is selected, nothing happens when OK is selected.  The

second time OK is selected, the MPM crashes.  The problem is the opposite

on the server.  Missions must be created using op areas that were created on

the server.

===================================================================

DTR:     D10295

SOR/STR: SOR 95-47

Title:   Opening Op Areas

Description:

When a user on a client opens a DBA module and tries to open an op area

that was created on the server, the selected op area is not displayed.  The

display either remains on the op area that was already displayed or reverts

to the default.

===================================================================

DTR:     D10296

SOR/STR: 6755

Title:   Route Validation not being save in Save User Defaults.

Description:

Route Validation is not being saved when you select route validation ON and then select  the Save User Defaults for your msn.   Meaning you have to reselect the route validation each time you open your aircraft mpm.

===================================================================

DTR:     D10298

SOR/STR: 6317

Title:   Error Saving MDL Loadsets in F14B Upgrade

Description:

Could not save a MDL loadset in F14B Upgrade MPM. Kept getting "Error in saving loadset" message. Tried with various combinations of files including only almanac and magvar. Same problem in F14A Upgrade. Other MPMs seem to allow saving

===================================================================

DTR:     D10299

SOR/STR: SOR 95-47

Title:   Deleting NIS+ Table Entries

Description:

No warning is provided to a system administrator when trying to remove or modify host table entries on the server.  As a minimum, a warning should be displayed anytime an attempt is made to delete or modify any entry for a connected client or the server, since these are destructive actions.

===================================================================

DTR:     D10300

SOR/STR: SOR 95-47

Title:   User Accounts on Clients

Description:

The functionality for creating new accounts on a client is available but does not work.  SOF statement 1.3.4.1.1.1 states that this is still a requirement.  If this requirement has been deferred, the documentation should be updated, and the System Admin -> User Administration -> Accounts option should be grayed out on clients.

===================================================================

DTR:     D10303

SOR/STR: SOR 96-01

Title:   MIDB Display of WW data is wrong

Description:

After loading MIDB Worldwide data from tape, queried for all primary airfields and they all displayed in the NE Quadrant of the world. In C/D text the coordinates have lat/lons in other quadrants but they are not displaying properlyl

===================================================================

DTR:     D10305

SOR/STR: 6698

Title:   Can only print one kneeboard card per kneeboard card session

Description:

Pressing the Print button in the Kneeboard card window more than once only results in one print job.  Must leave the kneeboard card and re-Create it to get another to print out.  One print job per kneeboard card is unacceptable.

===================================================================

DTR:     D10306

SOR/STR: SOR 95-43

Title:   Cleanup /var/audit on reload

Description:

If preserve /var/audit partition during solaris install, sysgen is not deleting old log files during arctic install.

SOT Step 95-43.1

===================================================================

DTR:     D10307

SOR/STR: SOR 95-43

Title:   Cannot load two complete versions of DAFIF

Description:

replace of DTR111.

Tried to load two complete versions of DAFIF on standalone Ultra and received the following error message: Can't allocate space for objects in the database 'DAFIF_GPS' because the 'default' segment is full. It looks like only 400MB is allowed for DAFIF.

SOT Step 95-43.1

===================================================================

DTR:     D10308

SOR/STR: SOR 95-47

Title:   MPMs and DBAs sometimes not starting.

Description:

Repeat of D074.

Sometimes MPMs and DBAs will not come up. If check in shell the applications are running but the only thing that comes up is the NATOP msg or starting application msg. It appears to be related to the object server since when kill the ost_server the MPM window comes up. The user would have to reboot to correct this problem. The previous DTR was put into test and developer indicated could not dupe.

===================================================================

DTR:     D10309

SOR/STR: 96-01.1

Title:   Crash displaying AAA planner and DBA threats

Description:

Consistent system crash attempting to display AAA planner and DBA threats.  The sequence I found to be consistent is:

F14D MPM

Threat/Intel -> Planner OOB-> Planner and DBA...

Select planner and OK

Select AAA

===================================================================

DTR:     D10311

SOR/STR: 96-01

Title:   Disk space required for world-wide MIDB load

Description:

Based on the test world-wide data tape, there must be a minimum of

245 Mb free in $DB_ARCHIVE_RESTORE (which is, via softlinks,

under /var on an installed system) in order to load the complete

FAC table set.  It would be better to leave some margin for growth,

so 300 Mb is a better figure.

Reworking the script to extract one file at a time would reduce the

disk space required to about 100 Mb, at a reduced speed since the

tape would repeatedly be rewould and re-read.

A different temporary directory could be used, if there is another

disk that can be expected to have enough free space.

===================================================================

DTR:     D10313

SOR/STR: SOR 95-47

Title:   Connected Client User Accounts corrupted

Description:

User accounts created on a client workstation prior to connecting to a server get corrupted after connecting.  The user directories do not get created correctly on the server, and the accounts are unusable.

===================================================================

DTR:     D10314

SOR/STR: SOR 95-47

Title:   Bogus Error Message

Description:

An error message about updating the NIS+ table is displayed each time a hostname is assigned to an IP address from the Available IP Addresses list, even though the NIS+ table actually gets updated.

===================================================================

DTR:     D10315

SOR/STR: SOR 95-47

Title:   Conflicting Host Names

Description:

Modified the host name of a previously assigned IP address and selected Apply.  This should have caused an error, but instead the new host name was created with the previous alias and IP address causing the IP address to be used for 2 different host names.

===================================================================

DTR:     D10317

SOR/STR: 6216

Title:   Geo Cancel Warning

Description:

Select Display>Geo Filter>Custom from DBA and select New Geo from the option menu.  Select pointing hand to begin creating a new geo.  When the right mouse button is selected to cancel the create geo function, get a warning message about not being able to create the geo.  There should be no warning since user intentionally cancelled the create geo function.

===================================================================

DTR:     D10318

SOR/STR: 96-01

Title:   FAC table being truncated

Description:

It appears that /var will need to be resized larger to accomodate the FAC tables in a FULL MIDB baseload.  Currently the load stops at the FAC_TIE table without indicating whether the table completed or not - NO alerts or errors are provided.  The last three tables: FAC_TRAIT, FAC_VULNERABILITY and FAC_XREF are all emply.

===================================================================

DTR:     D10319

SOR/STR: SOR 95-47

Title:   MPLAN NIS+ Host Tabel Update

Description:

If an Alias is set up for a valid Hostname and IP address and the Alias entry is removed from the NIS+ Host Table, the entry which has identical Hostname and Alias is also removed from the table.  If you remove an Alias entry, the Host entry should not be removed.

Additional Text (1/27/98): If the local host alias is removed, all of the other local host aliases will also be removed, causing significant system problems.  Recommend allowing alias to be deleted, but not for the local host.

===================================================================

DTR:     D10320

SOR/STR: SOR 95-47

Title:   /etc/hostname.xxx error in MPLAN

Description:

When connecting a client and server via either ATM or Ethernet, the MPLAN connect executable should check the /etc/hostname.xxx file on the client.  If connecting via Ethernet, the file in /etc should be hostname.hme0.  If connecting via ATM, the file should be hostname.fa0.  Only one of these files should be in the client /etc directory at one time but currently both can reside in /etc instead of one being replaced with the other depending on the connection method.

===================================================================

DTR:     D10322

SOR/STR: 96-01.2

Title:   MIDB GMI Restore without Modify MIDB privileges

Description:

As a user without Modify MIDB privileges, there is no warning messages when accessing the restore GMI database function.  Messages received are extremely old and does not reflect the current environment.  Without Modify MIDB privileges I should not be able to even try to restore the GMI database.  It should be greyed or not in the list.

===================================================================

DTR:     D10324

SOR/STR: SOR 95-43.2

Title:   COMPASS Crashes after connected and open a layer

Description:

The COMPASS MPM now starts and the servers can be started. After connecting if annotation tool is opened and symnbol selected or just about anything else that would creat a layer, open mission, query dafif, it crashes the MPM. If open these layers before connecting the MPM does not crash.

===================================================================

DTR:     D10325

SOR/STR: SOR 96-10.5

Title:   SIPRNET not connecting

Description:

After manually configuring "siprnet" in host table and adding a default router I could manually ftp the NAVSTAR.ALM file from siprnet almanac site. In DBA the SIPRNET shows configured but down and there is no means to pull data. In the shell ping does not work with the siprnet almanac site eventhough I can ftp into it.

===================================================================

DTR:     D10326

SOR/STR: SOR 95-47

Title:   Mission Tranfer - Dynamic_mpm switch

Description:

MPM's need the ability to save mission related data to the /tamps/dynamic/mpm area if the client is looking at Local DB or to the /tamps/dynamic/mpm_server area if the client is looking at the Server DB

===================================================================

DTR:     D10327

SOR/STR: TS96-01_05.doc

Title:   Interim Threat record merge to midb, tables missing.

Description:

Step:12  Hook one of the interim threats and update the MIDB.   Select DBA -> Update -> Threats -> Merge Planner OOB...   Failed

Received the following msg:FAIL to insert new SAM Site.

Mary Collins: Did a isql query for TAMPS_MIDB_DEFAULTS.   Data returned no TAMPS_ MIDB_Defaults Tables.

Also the DBA Interim Window has IDB and not MIDB at the top of the Editor window.

===================================================================

DTR:     D10328

SOR/STR: 97-13

Title:   handle to mission source

Description:

Need to provide MPMs the ability to access the misison source field from the input mission handle.  Additionally, need to set the apt_file_operation to apt_no_file_op when importing a PFPS route.

===================================================================

DTR:     D10330

SOR/STR: SOR 96-10.

Title:   On-Line GPS, cannot switch between NAVSSI & SIPRNET

Description:

In DBA > Update > OnLine, with both NAVSSI & SIPRNET configured and UP, I could not select SIPRNET as the source since it was grayed out. Opened and closed online gps window and still the same. If closed DBA and opened the DBA then could select either source.

===================================================================

DTR:     D10331

SOR/STR: 6307

Title:   MGRS in NAD-27 to WGS-84

Description:

TAMPS is not calculating MGRS correctly when changing from Datum NAD-27 to

WGS-84 in the planner target updates dialog.  As an example, if an MGRS of 11SLV4634250648 is entered in WGS-84, and then the datum is alternately applied for that point, the sequence is:

WGS-84   11SLV4634250648

NAD-27   11SLK4642250449

WGS-84   11SLV4642550649

NAD-27   11SLK4650550451

WGS-84   11SLV4650950651

The MGRS should have toggled between:

WGS-84   11SLV4634250648

NAD-27   11SLK4642250449

and this was proven on a truth source (MADTRAN).

===================================================================

DTR:     D10332

SOR/STR: 96-10

Title:   Almanac load alert coming up Red

Description:

Setup online GPS to auto update from a NAVSSI emulator. After update a Red alert came up about the almanac update. Change the alert to Yellow. Also, the text in the main alert is compressed together and hard to read.

===================================================================

DTR:     D10333

SOR/STR: 6307

Title:   Target Longitude Changes

Description:

If a target point is entered in the planner target updates dialog using NAD-27 datum, each time the target is selected from the list and apply is selected, the longitude changes by a few seconds.  Example:

35:41:16N, 118:41:53W

35:41:16N, 118:41:50W

35:41:16N, 118:41:47W

35:41:16N, 118:41:44W

===================================================================

DTR:     D10334

SOR/STR: 96-01.3

Title:   Input media information in MIDB Data Exchange does not reflect TAMPS media

Description:

The only way to import certain MIDB data is via the MIDB Data Exchange tool.  When import is selected and File -> Set Tape Information is also selected, it displays a list of media that is not reflective of the TAMPS environment.  I believe what is shown are tape devices for DIA.  Floppy disk and Hard Drive information is also here.  The list should be changed to reflect the TAMPS environment.

===================================================================

DTR:     D10338

SOR/STR: SOR 95-43.1

Title:   Remove Import PFPS menus from FAMP and COMPASS MPMs

Description:

Both FAMP and COMPASS MPMs have the Import PFPS Routes menu under File > Import/Export Missions. Import/Export missions is not applicable to these MPMs and when selected it causes the MPMs to crash. This may also be a problem in HARM/SLAM/JSOW if they do not remove this menu.

===================================================================

DTR:     D10339

SOR/STR: SOR 95-47

Title:   Client Idle Time Cycling

Description:

In the Client Amp Info window, the "idle time" cycles between 0 and 60 for a connected client.  This value should either be displayed as 0 or not be displayed at all until the client disconnects.

===================================================================

DTR:     D10340

SOR/STR: SOR 96-01

Title:   Remove IDB selection from Dataset Removal

Description:

Remove the selection for IDB from the list under DBA> Utilities> Data Removal> Dataset since it no longer applies.

===================================================================

DTR:     D10341

SOR/STR: 96-01

Title:   GMI Dataset removal is not deleting catalog entry

Description:

After using the DBA Dataset removal tool to remove the GMI database it appeared to remove the data OK, however the MIDB Baseload entry is still in the TAMPS catalog when select Output> Database Catalog

===================================================================

DTR:     D10343

SOR/STR: 6697

Title:   Doghouse Display for Leg to Recovery Point

Description:

Currently, the Doghouse for the last point in the route (i.e., prior to the recovery point) does not give the option to show any data for the NEXT POINT (recovery pt).  Instead, only data for the current point may be seen.  Lt. D'Acquisto (Fleet Liason Officer) requests that the operator be able to select data for this last leg to the recovery point (e.g., bearing to recovery, fuel remaining, etc.) as for any other point in the route.

Lt. D'Acquisto states that the NEXT POINT option for ANY doghouse WILL NOT BE APPLICABLE for the following items:

True Heading

Magnetic Heading

Leg Time

Leg Fuel

Distance Leg

True Course

Magnetic Course

These items are always for the flight leg ahead; NEXT POINT would show data for the next point beyond the next leg, which is unacceptable.  In addition, the Waypoint # for the current Doghouse must always indicated the adjacent waypoint, not that for the next leg's Doghouse; accordingly, the NEXT POINT option is to be ignored for this composite data item also.

Per Lt. Todd Kiefer (IKE), the AGL and MSL should be relative to the NEXT POINT ONLY.

===================================================================

DTR:     D10347

SOR/STR: SOR 95-47

Title:   Modify Available IP Addresses, Apply closes widget

Description:

On a server system, select the Available IP Addresses view and select an entry to modify.  If the Apply button is selected after modifying the entry, the Modify widget should remain open but actually closes.

===================================================================

DTR:     D10348

SOR/STR: 95-43

Title:   TAMPS Logins would not bring up WSE, rqrd reload

Description:

On a standalone workstation that had not been connected to a server, I could not login using previously working accounts. I had to login as root but could not find anything obviously wrong. Rebooted system and tried again but still the same. What is happening is the login and password are accepted OK and the DOD warning window comes up but the WSE never comes up. After a couple minutes it brings back up the login window. Note! This was on Bld 3A. I had to reload system to correct the problem.

===================================================================

DTR:     D10350

SOR/STR: SOR 96-10

Title:   On Line GPS showing NAVSSI up when it is really down

Description:

Using a standalone Ultra connected via a router to SIPRNET, I input a bogus IP address for navssi and a valid cofig for siprnet. When open the online GPS update window it shows both NAVSSI and SIPRNET as being up when it should only show SIPRNET as up. When I manually tried to ftp to the navssi host it took about 4minutes and then returned No Route to Host msg.

===================================================================

DTR:     D10351

SOR/STR: SOR 95-47

Title:   Server MIDB Database Dump Update Failure

Description:

On the server, selected Utilities > Database Maintenance > Update Database Dumps.  Selected MIDB and Apply.  Dump flat file was created okay but the following warning message was displayed upon completion:  Attempt to insert NULL value into column "LOAD_DATE", table GMI.dbo.GMI_TEMP_CATALOG; column does not allow NULLS, update fails.  On the server, the Database Catalog for MIDB Baseload displays nothing for Date Last Change.  After a Database Update on the client, the Database Catalog does not display a MIDB entry at all even though the data is updated on the client.

===================================================================

DTR:     D10355

SOR/STR: 95-47

Title:   GUAC load errors on dropping/creating indexes

Description:

Selected to load GUAC  for Korea area. Load completed OK but there were errors in log about dropping and creating indexes and not being the owner or SA. For example "Only the owner of table "GUAC_CLIMATOLOGY" or a user with System Administrator (SA) role can create an index on it." Also, there were DB-LIBRARY errors: Attempt to bulk-copy an oversize row to SQL server. Bottom line, could not display GUAC.

===================================================================

DTR:     D10357

SOR/STR: SOR 96-01.03

Title:   Client to Server Update Objects

Description:

Client to Server connected, queried the MIDB for SAM's on the Client:highlighted the object on the DBA Module on the Client and selected Update -> Threats Edit Hooked Object and received the following msg:Error:Unable to obtain SUPPORT table for the window address by ID: -1 NAME: FAC.     Connected by ether net.

Showed gary from TRW he said to write a DTR.

===================================================================

DTR:     D10358

SOR/STR: 6214

Title:   Launch Details Crash

Description:

Created a new mission in the F14D MPM.  Selected Setup -> Defaults -> Aircraft.  Then selected Launch Details.  Selected OK and the MPM crashed.  This is repeatable.  Duplicated in AH1W also.  Occurs on standalones and connected clients.

===================================================================

DTR:     D10359

SOR/STR: SOR 95-47

Title:   Removing Conflicting Accounts

Description:

After connecting a client to a server, if the user selects close in the conflicting accounts HMI, a warning is displayed that says the remaining conflicting accounts will be deleted.  The warning should reflect what is actually happening, such as: " The accounts will be inaccessible while connected and restored after disconnecting".

===================================================================

DTR:     D10367

SOR/STR: SOR 95-47

Title:   MPLAN User Password for Authentication

Description:

After connecting a client to the server on MPLAN, logging in as root, and giving correct root password, log in under a user account.  After the conflicting account HMI is dismissed, user is asked to enter a password twice.  There is no indication what password is needed (the password of the user who logged in) and if an incorrect password is entered, the user will not be authenticated.  This will cause other problems to occur when using any account (like having the conflicting account HMI displayed every time any user logs in).  In order to correct these problems, you must reload the system.

===================================================================

DTR:     D10368

SOR/STR: SOR 95-47

Title:   Modifying Local NIS+ Host Table

Description:

If the SA modifies one of the several Aliases to the local hostname in the NIS+ Host Table, all the other aliases will be deleted causing major problems with MPLAN connection and/or MIDB functions.

===================================================================

DTR:     D10370

SOR/STR: SOR 95-47

Title:   MPLAN Connect Root Password

Description:

When connecting a client to the MPLAN server, if the user inputs an incorrect root password when queried, the connect process is allowed to proceed and succeeds.  After the connection is made and the login screen is displayed, the user can login as root using the incorrect password used at connect.

===================================================================

DTR:     D10371

SOR/STR: SOR 95-47

Title:   Conflicting Accounts Error

Description:

Connected a client to a server which had conflicting user accounts.  When the user conflict HMI appeard, changed a conflicting user name to a name that was already in the valid user list and selected OK.  Got a cryptic error message: "Unable to add user .....: add_status = 16646144".  Changed the name to a different name that was not in the valid user list and selected OK.  The conflicting account name was correctly removed from the conflicting user list, but an entry was added for the name that introduced the initial error.

===================================================================

DTR:     D10373

SOR/STR: SOR 95-47

Title:   MPLAN Database Update Confusing Messages

Description:

When a user performs a database update on a client machine via the MPLAN, a warning message is displayed stating:  "You will have to restart THIS machine, etc...".  After this message is acknowledged, another message is displayed stating:  "Restart the machine where the Sybase server resides".  These two messages are saying the same thing but in different ways which will be confusing to users who may mistakenly restart the server causing numerous problems!

===================================================================

DTR:     D10374

SOR/STR: SOR 95-47

Title:   Missions Not Transferred with Account

Description:

Created some missions using an account on a standalone workstation.  Connected the workstation to a server that had an account with the same name.  During the connection, I renamed the account on the workstation.  Logged into the account with the new name on the connected workstation and found that the missions were no longer tied to the account.  They were tied to the account that was already existing on the server prior to connecting.

===================================================================

DTR:     D10375

SOR/STR: 4612

Title:   Launch/Recovery Airbase Query Not Working after initial query.

Description:

In any MPM Start a new mission in a SoCal OpArea and open Launch/Recovery window. Select Display Airbases and Apply. Then Deselect All to change the query filters and select US and US-CA prov and Apply. The original query data goes away from the screen but a message comes up saying "No airbases found based on  current filter settings."  This used to work in 6.1.1 before the GEO and OpArea Selections were added to this widget. The only way for a planner to run another airbase query in L/R is to change OpAreas in New Mission or open another MPM.

===================================================================

DTR:     D10376

SOR/STR: SOR 95-47

Title:   Missing/Incorrect Help Files

Description:

The following dialogs do not have help files:

Connect to LAN dialog

Conflicting User Accounts dialog

Update Database Dump dialog

The following dialogs have help files that give inorrect information:

Mission Import/Export dialog

===================================================================

DTR:     D10379

SOR/STR: SOR 95-47

Title:   Mission Import/Export Causes Problems

Description:

Working on an E4000 server with one Ultra connected as a client.  Anytime an import or export was performed on either of the stations, the following problems were noted with the MPM that performed the operation:

1) No op areas listed in the new mission dialog.

2) No missions or planners listed in the mission delete dialog.

3) Mission list frozen in the open mission dialog.

4) Database error when attempting to open a mission.

5) Database error when attempting to save a mission.

These problems made the MPM unusable for mission planning.  Had to exit the MPM and open a new one to get the mission-related functions to work properly.

===================================================================

DTR:     D10381

SOR/STR: SOR 95-47

Title:   Successful Import Message

Description:

If an import or export to either a client or server database is performed and the database already contains missions with the same names as those being transferred, error messages are properly displayed.  However, a message saying "Mission Import Completed Successfully" is displayed also.

===================================================================

DTR:     D10382

SOR/STR: SOR 95-47

Title:   DAFIF Display Client/Server

Description:

DAFIF loaded to the server database from the client workstation can not be

accessed by either the client or the server.  DAFIF loaded using the server

station can be accessed by both stations.

This is a repeat of DTR #209 (which is in Integration_Build).

===================================================================

DTR:     D10384

SOR/STR: SOR 95-47

Title:   DTED Load from Server to Client

Description:

When loading DTED from the server to the client, the load window map display will show the correct area if there is only one area of DTED loaded.  If there is more than one area of DTED loaded, the map display will show a small portion of the world centered around the intersection of the Prime Meridian and the Equator.  Top View button will not enlarge view to show whole world so user cannot use box select to choose area desired for load.  Only option seems to be to load ALL DTED loaded on the server!

===================================================================

DTR:     D10385

SOR/STR: SOR 95-47

Title:   ddt_mmi load utility env variable parsing

Description:

The ddt_mmi load utility is incorrectly parsing the environment variable SYS_TAPE and placing a SERVER entry in the 8 mm Tape option menu.

===================================================================

DTR:     D10386

SOR/STR: SOR 95-47

Title:   ADRI Load from Server to Client

Description:

There is no requirement for ADRI load from the server to the client.  Therefore, the From Server radio button on the ddt_mmi Load Utility should be insensitive when ADRI is selected but is sensitive and gives an error message when selected and Apply is selected.

===================================================================

DTR:     D10387

SOR/STR: SOR 95-47

Title:   ARC-210 Unusable

Description:

ARC-210 is UNUSABLE.  Unable to create ARC-210 data files.  When save is selected, get an error about no WOD or MWOD being selected.  All editors, which normally are initialized with data, are empty.  Could be a problem with stored procedures.

Test Step SOR 95-47.17

===================================================================

DTR:     D10388

SOR/STR: SOR 95-47

Title:   Unable to Save Smartpack Packages

Description:

Created some smartpack contents, added them to a package and selected save.  No error messages were displayed.  Selected File -> Open in the Smartpack Package dialog, and no packages were listed.  No data was contained in sybase table SMARTP_CONTENT.

Test Step SOR 95-47.17

===================================================================

DTR:     D10389

SOR/STR: SOR 95-47

Title:   Mission Related Data Update

Description:

The Mission Related data update from the server to the client is not working correctly.  Created JNL loads, CAS files, GPS Waypoints files, interim threats, tactical waypoints and custom kneeboard formats on the server.  Then selected DBA -> Utilities -> Database Maintenance -> Update Database from Server on the client.  Selected Mission Related Data, Update Now and OK.  A message was displayed that said the update was successful, but when the corresponding sybase tables were checked, there was no data present.  Disconnected and checked each of the functions, but data was not available.

Test Step SOR 95-47.17

===================================================================

DTR:     D10390

SOR/STR: SOR 95-47

Title:   DCW Display on client

Description:

DCW loaded in the server database can not be displayed on the client.  The coverage tool shows no data loaded and DCW features do not appear when zooming in to a DCW area.

This DTR was created to replace DTR 206 which failed testing in the integration build.

===================================================================

DTR:     D10391

SOR/STR: SOR 95-47

Title:   Accounts Created on Client not usable on Server

Description:

Any user accounts created on a client machine before connecting to the server cannot be used to login to the server workstation after connecting .  When trying to login on the server using one of the accounts moved from the client to the server, the DOD banner warning will be displayed then the login process fails and the TAMPS Login is displayed.

===================================================================

DTR:     D10393

SOR/STR: SOR 95-47

Title:   Server/Client background displaying DTED crashes

Description:

Background DTED crashes when you do not deselect Include Server Data at scale 1:1M.

Server Lite wisconsin -> Client arizona:logged in on client as user scud: Selected OpArea with both server lite and client DTED.   Applications tried were DBA Module, FAMP, Aircraft MPM's AH1W, and F14D.

The workstation log error's:

DB-Library error.

Bad token from SQL Server:Datastream processing out of sync.

===================================================================

DTR:     D10394

SOR/STR: 96-01_8

Title:   Use of WGS-84 lat/lon in the DAFIF to locate spatial objects

Description:

SOF statement indicates that the DAFIF database should be using WGS-84 lat/lon columns to determine the location of spatial objects but instead lat_radians / lon_radians are being used.

The value is the same so there is no errors generated due to the use of lat_radians / lon_radians to locate spatial objects.

===================================================================

DTR:     D10397

SOR/STR: 96-01.18

Title:   Using the provided API tester to return data within a bounding box

Description:

Using the provided API tester, set up a query to return data limited by a bounding rectangle. The API tester found "no data" while the same query in ISQL returned eight active records. These records should have been returned via the tester also.

===================================================================

DTR:     D10401

SOR/STR: STR 6755

Title:   ait_routeValidationGetStatus() change to public

Description:

Need to change function ait_routeValidationGetStatus() from protected

to public.

===================================================================

DTR:     D10405

SOR/STR: 95-47

Title:   Intermittent crash of Database Catalog Option

Description:

Occasionally when select the View option from the Database Catalog display, the application will crash.

===================================================================

DTR:     D10443

SOR/STR: 96-01a

Title:   Error accessing MIDB Production/DEX tools

Description:

Attempted to open up the Data Exhange (Utilities -> MIDB Tools -> Database Admin -> Data Exchange6) and received the following error message: "Error determining the GCCS connection status."  After acknowledging the error message, nothing happens - can't open the DEX tools.

Further examination indicated that the following also returned the error message: (Error determining the GCCS connection status)

Utilities -> MIDB Tools -> Database Admin -> Data Exchange6

Utilities -> MIDB Tools -> Database Admin -> DBA Utility6

Utilities -> MIDB Tools -> Database -> Query6

Update -> Threats -> MIDB -> New Installation/Facility6

Update -> Threats -> MIDB -> New Unit6

Update -> Target -> New Target6

The following error was received when attempting to access the listed items (Unable to determine GCCS-M connection status)

Update -> Threats -> MIDB -> Edit Hooked Object6

Update -> Targets -> Edit Hooked Ojbect6

===================================================================

DTR:     D10486

SOR/STR: 96_01

Title:   MIDB Query Default Print Classification

Description:

DBA Module -> created a New Tgt and then did a query from the MIDB Tools -> Database Query -> Ran a query for the the New Created Tgt, then selected print and the print window class level is defaulted to a (higher classification and cavet).    Meaning it does not let you default to a lower classifcation.

===================================================================

DTR:     D10489

SOR/STR: 96-01.13

Title:   Planner target update not displaying correct data after exit and reenter mission

Description:

Created a new mission.  Used planner target update to create a target from scratch (no item was hooked).  Values entered were:

Elevation: 39 meters

Width: 11 meters

Height: 22 meters

Length: 33 meters

Applied the update, cancelled out, saved mission, exited the MPM.

Opened the mission again.

Selected planner target update and selected the target just entered.

Values displayed in the HMI were:

Elevation: 12 meters

Width: 3 meters

Height: 7 meters

Length: 10 meters

The data in the TAMPS_PLANNER_TARGETS table is correct.

===================================================================

DTR:     D10633

SOR/STR: SOR-95-47

Title:   Client Connect Fails to Mount Maps

Description:

The $LAN_MAPS/maps/? mount points are not created during the Client

connect process because Sysgen now creates the $LAN_MAPS directory.

===================================================================

DTR:     D10634

SOR/STR: SOR-97-11

Title:   JTIM_PATH Set Wrong on Client

Description:

JTIM_PATH is set wrong in tamps.env.low - the anonymous ftp fails

during JSIPS-N image fetch to a connected low side client.

===================================================================

DTR:     D10643

SOR/STR: 96-01

Title:   OBS and TRACK should not be part of the subset loaded from tape

Description:

The TAMPS subset definition for MIDB GMI does not include TRACK and OBS.  The data file that drives the MIDB Baseload function needs to be modified to exclude these two data sets.  Otherwise, if a baseload tape ever included these two data sets, we may run out of space in GMI.

===================================================================

DTR:     D10644

SOR/STR: D10399

Title:   Load ADRG gives error message

Description:

Whenever a user tries to load ADRG/CADRG, when the OK or Apply

button is pressed, an error message is displayed "cannot determine

ADRG filenames".

===================================================================

DTR:     D10647

SOR/STR: 96-01

Title:   Replication server drop subscription update

Description:

Update the drop subscription script (run when disconnecting from

GCCS-M) so that all subscriptions can be successfully dropped.

It seemed that there are some problems with TIE tables subcriptions deined for one single replication definition. Sometimes, a few of the subscriptions

won't drop until the other related subscriptions are dropped.

===================================================================

DTR:     D10648

SOR/STR: SOR 96-60H

Title:   Import Objects fails with new object

Description:

Created an object NAVY_TACANS under DAFIF_NAVAIDS>TACAN and built a query for the new object and made it a system query. The objec and query worked fine. Exported object to 3.5 FD and tape. Deleted object and then tried to import. Received msg "A system error occurred at the completion of the import process. Also, in .x-errors log showed "ERROR: Non-matching object determinators".

Fails SOT 96-60H.3

===================================================================

DTR:     D10650

SOR/STR: SOR-97-11B

Title:   Single Point Query Corruptions

Description:

GDE Internal DR delivered for Build 4.

===================================================================

DTR:     D10652

SOR/STR: SOR 97-11

Title:   JTIM Images Not Retrieved From SPA

Description:

Unable to retrieve an image from the JTIM SPA thinline.  Investigation showed a permission problem on the jtim directory.

===================================================================

DTR:     D10655

SOR/STR: 95-47

Title:   Strip Charts not displaying Chart data

Description:

Now stripcharts are not displaying any chart data in window. Charts were preserved and updated using DBA MapUpdate. Now not displaying local or server chart data.

DTR 615i refers to not being able to display server chart data when connected.

===================================================================

DTR:     D10662

SOR/STR: SOR 97-11

Title:   JTIM Product Request Crash

Description:

Initiating a request for either a target tasking product or a PPIP product causes the MPM to crash.

===================================================================

DTR:     D10666

SOR/STR: 96-01

Title:   AMP Info for DBA Target not showing CC or JMEM Type

Description:

(Object Query for Mary)

Amp information for DBA target does not show value for country code or JMEM_Type

===================================================================

DTR:     D10668

SOR/STR: 96-01a

Title:   C_EQP index not getting created - WW#2 MIDB load

Description:

C_EQP index does not get created on MIDB World Wide #2 load

===================================================================

DTR:     D10669

SOR/STR: 96-01a

Title:   Name in TGT definition not being displayed in AMP INFO

Description:

Name field appearing in TGT definition is not being displayed in AMP INFO for the programmatic planner target object (small triangle)

===================================================================

DTR:     D10670

SOR/STR: 96-01a

Title:   Datum selection not functioning in Planner Target Updates

Description:

Datum selection in planner target updates is not functional

===================================================================

DTR:     D10671

SOR/STR: SOR 97-11

Title:   Saving JTIM PGMs or TAMs

Description:

When trying to save a PGM product or TAM from the JTIM Query Results / Retrieve HMI, get an error message that says: "Only images may be stored on tamps".  Workaround is to open the image in the imagery toolkit and use File -> Save.

===================================================================

DTR:     D10673

SOR/STR: 96-01a

Title:   MIDB Query printer default classification incorrect

Description:

Print option in the MIDB production tools query window defaults to an incorrect classification.  The default selection is a higher classification with caveats and there are no options for any other classification.

===================================================================

DTR:     D10674

SOR/STR: 96-01a

Title:   Planner target update HORIZ_ORIENT_UM not being stored correctly

Description:

If you leave the toggle  alone, a NULL gets entered in the field.  If you toggle it to DEG-MAG, a 1 gets entered in the field.  If I toggle it back to DEG-TRUE, a NULL gets entered into the field.

Note: The object on planner targets is expecting 1 to be DEGREES TRUE and 2 to be DEGREES MAG.

More info from Mary:

Regarding DTR 674 (problems with HORIZ_ORIENT_UM in planner targets), if the decode table needs to have revised values, they are inserted within the src/dbinstall/tampsdb/create/mission/tamps_plnr_target_create.sql file as follows:

insert into TAMPS_HORIZ_ORIENT_UM_XREF

values

("1","DEGREES TRUE")

go

insert into TAMPS_HORIZ_ORIENT_UM_XREF

values

("2","DEGREES MAG")

go

===================================================================

DTR:     D10677

SOR/STR: SOR 96-01

Title:   MIDB Tools

Description:

On super client 2300 & Clients connected via ATM to server 4000.   Could not use the MIDB Tools on super client 2300 and clients ULTRA2.   This is from the DBA Module -> Util -> MIDB Tools:Database  -> Query & Count, Ref -> Cat Code & Equip Codes & CC & Gen Ref and Data Exchange.

ERROR MSG:Entry for user server TAMPS does not exist in the database access file.  Access to database denied.  Unable to access dataserver TAMPS.  Ether you do not have proper privileges, or the dataserver is not running and needs to be restarted.  Could not find entry for user in database access file.

===================================================================

DTR:     D10679

SOR/STR: SOR96-01

Title:   Update replication server scripts status windows

Description:

After resync is completed successfully, LAN deamon doesn't receive the

"connect" message.

===================================================================

DTR:     D10681

SOR/STR: SOR 96-01

Title:   RTM's not working

Description:

Queried for radar's and tried to do RTM's.  The systems tried were ULTRA2 Stand Alone, Server 4000, super client 2300 & client's ULTRA2 via ATM.  The system would only hang up and require killing the MPM or logoff to correct. This was with MIDB WW2 and NID from 9711 loaded.

===================================================================

DTR:     D10682

SOR/STR: SOR 97-11

Title:   NITF images

Description:

NITF data for actual and number of bits/pixel and justification of abpp was not being used. causes any NITF data other than 8 bit to be interpreted wrong.

===================================================================

DTR:     D10694

SOR/STR: SOR 97-11

Title:   Cancelling JTIM Product Requests

Description:

Cancelling JTIM product requests does not work correctly.  Cancelling a single request changes the status of all requests to "cancelled".

===================================================================

DTR:     D10700

SOR/STR: SOR 96-01

Title:   Maximum checks for subscription validation

Description:

I had set a maximum number of checking for subscription validation. It was set to 30. However, since we are not sure how many updates would be submitted during the synchronization process, I feel it would be safer to increse the number so it won't quit due to a large amount of updates.

===================================================================

DTR:     D10702

SOR/STR: SOR 95-47

Title:   Loading Radar Aimpoints Fails from Client

Description:

Unable to load radar aimpoints from client to server.  Worked OK on standalone W/S.

===================================================================

DTR:     D10703

SOR/STR: SOR 95-47

Title:   Landsat Imagery Load Fails, from Client

Description:

Unable to load landsat imagery from the client to the server.   Only the header file gets copied to the directory. Worked OK on standalone W/S.

===================================================================

DTR:     D10704

SOR/STR: D10200

Title:   Sysgen Can't Set Root Password

Description:

Set of root password at end of Sysgen prompts fails.  Fixes put in for D10200

assume NIS+ is running, which is not the case during initial Sysgen.

===================================================================

DTR:     D10716

SOR/STR: 6697

Title:   Kcard displaying N- for southerly planned msn

Description:

The Kcard is displaying N- for missions planned in the southern hemi.  The N-

should be displayed as an S.

===================================================================

DTR:     D10717

SOR/STR: SOR 96-01

Title:   Replication system status return

Description:

After JMCIS replication server had been shutdown, LAN deamon did not receive a correct status.

C.3
DTRS IN TEST

DTR:     D10132

SOR/STR: 6.2 init

Title:   Extra Pages on Xerox Printer

Description:

When printing strip charts from the Sparc ULTRA to the Xerox C55 printer, an extra (nearly blank) page is printed out after about every 2 or 3 pages.  The nearly blank pages have something like X123 or 12345 or X2345 patterns on them (printed once at the top of the page).

===================================================================

DTR:     D10233

SOR/STR: 6698

Title:   Kneeboard Card Ident Brg Rng Display Incorrect

Description:

The IDENT BRGRNG field on the kneeboard card is currently displaying a slash for points with no IDENT displayed and a BRG/RNG of 000/000 for points that are on top of an identifier.  The "BRG/RNG" part of the field should not be displayed if the range is zero.

===================================================================

DTR:     D10237

SOR/STR: 6699

Title:   Kneeboard Card Re-Order Data Item Selection

Description:

Due to the large number of data items available for selection in a small list window in the Re-Order window for kneeboard cards, a better selection mechanism is required.  The suggested approach is a cascading selection method similar to the Weaponeering6Loadout6Select Stores window.  The existing data items need to be grouped, where appropriate, and when the group label is selected from the first list, the next list window becomes active with the sub-items for that group item.  From the existing list in Build 3, the following groups should be implemented: Alt, Blank, Course, Distance, Divert, Fuel, Heading, Speed, Time, and UTM.  The sub-items for these groups are listed below.  All other existing data items besides those listed as sub-items below should remain in the top level list and should act as a selection when clicked on.  For the group labels, selecting the sub-item from the cascading list should act as the selection.

===================================================================

DTR:     D10238

SOR/STR: 6699

Title:   The sub-items for these Kcard groups should be the following:

Description:

Alt - Auto Alt, Alt MSL, Alt AGL; Blank - Small(5), Med(10), Large(15) (use 5, 10, and 15 spaces for these); Course - Mag Course, True Course, Course to Target; Distance - Cumulative Distance, Leg Distance, Distance to Target, Recovery Distance; Divert - Brg Rng, Divert Course - Mag, Divert Course - True, Divert Distance, Divert Fuel, Divert Heading - Mag, Divert Heading - True, Time to Divert; Fuel - Fuel Flow, Leg Fuel, Fuel Remaining; Heading - Mag Heading, True Heading; Speed - Calibrated A/S, Ground Speed, True A/S, Mach; Time - Clock Time, Elapsed Time, Leg Time, Recovery Time, Time to Target; UTM - UTM Zone, UTM Coord.

===================================================================

DTR:     D10346

SOR/STR: SOR 95-43

Title:   Problems Reusing deleted user account names

Description:

The DTR is written against Step 1 of SOR 95-43.

1.  Create a valid user account "example"

2.  Logout and login under another valid user account

3.  Delete the "example" user account using the accounts HMI

4.  Create a new user account using the same user name as the deleted one

5.  Try to log in under the deleted/recreated user account.

Sometimes you can log into this account but if you log out, you cannot log back in.  Other times you cannot log into this account at all.  If you can log into the account and open a shell, if you close the shell, you cannot reopen the shell.  This problem is repeatable on a standalone workstation.

===================================================================

DTR:     D10356

SOR/STR: SOR 95-47

Title:   Disconnect at Shutdown Reminder

Description:

When a user shuts down a connected client workstation, the user should be asked if the workstation should be disconnected from the LAN as well.  However, if the user is shutting down the workstation to update local databases, they should be warned to NOT disconnect from the MPLAN!

===================================================================

DTR:     D10360

SOR/STR: SOR 95-47

Title:   MPLAN - New IDD function uul_getUserList is inaccessible

Description:

MPLAN - New IDD function uul_getUserList is inaccessible

Problem description : During MPLAN client connection, user accounts on the client are transferred to the server.  For those accounts which conflict between client and server, the SA is permitted to rename the client account.  The new IDD function uul_getUserList permits MPMs access to those accounts which have been transferred to the server including those accounts which have been renamed.  This new IDD function is undefined when attempting to link the F/A-18 MPM.  It appears that this function was compiled with the C++ compiler which scrambles the name in the *uul* shared object library.  The F/A-18 MPM is compiled with the C compiler which is unable to find the C++ compiled function.  It appears that the other IDD functions are compiled with the C compiler rather than the C++ compiler.

F/A-18 Impact : Unable to utilize this IDD interface.  The F/A-18 MPM requires knowledge of those accounts which have been renamed in order to change the user names stored with the F/A-18 unique mission data.  Missions owned by users who have had their accounts renamed will be inaccessible while connected to the server via MPLAN.  The information is stored in a TAMPS Core data file *renames* but the content of this file is not documented in the IDD (it appears to be a simple ASCII file which could easily be parsed by the F/A-18 MPM but without being documented in the IDD the file format could change without approval by the F/A-18 program).

===================================================================

DTR:     D10361

SOR/STR: SOR 95-43

Title:   Error Invoking FA-18 MPM from WSE Menu Bar

Description:

Invoking the FA-18 MPM to be run from the WSE menu bar causes the FA-18 MPM to crash during startup.

Impact:  Must change the way the FA-18 MPM is being started up.  At this time we are unclear why the FA-18 MPM is crashing during startup.  We are able to run the FA-18 MPM from a shell, which is how we normally run it during MPM development.  We did notice that the WSE startup has changed where previously a remote shell login was used to invoke WSE.  Now the WSE is run directly.  We temporarily changed the WSE startup to again use a remote shell login and we were able to run FA-18 MPM without a problem.

===================================================================

DTR:     D10363

SOR/STR: SOR 95-47

Title:   Unable to transfer mission between client/server

Description:

The ability to transfer missions between client and server is performed through invocation of the new TAMPS core "Mission Data Transfer" HMI menu.  This new menu allows the user to select "Source" and "Destination" options for controlling the transfer of mission data.  The FA-18 MPM has registered a mission import/export callback that is invoked by the TAMPS core for allowing the MPM to import/export unique FA-18 mission data to tape devices.  It is understood that this MPM callback would be used by the TAMPS core for transfer of mission data between client and server.  Prior to invoking the import/export callback, the TAMPS core will assign the TAMPS environment variable $DYNAMIC_MPM to point to either the server or client dat area as required to handle the mission transfer as indicated by the "Source" and "Destination" fields on the HMI menu.  Our testing has shown that the $DYNAMIC_MPM environment variable is not being assigned correctly for handling data on the client.

FA-18 Impact:  Without being able to register a callback for specifically handling mission transfer across the MPLAN, the FA-18 MPM is being modified to handle the dynamic assignment of the $DYNAMIC_MPM environment variable in order to correctly transfer unique FA-18 mission data between client and server.  Unable to test this capability which allows validation of the MPLAN transfer process.  This is an essential capability of the MPLAN CONOPS.

===================================================================

DTR:     D10364

SOR/STR: SOR 97-13

Title:   PFPS - Unable to list only FA-18 PFPS missions

Description:

The new TAMPS core PFPS import menu lists all the mission contained on the PFPS floppy disk.  An option on the menu allows the user to show only the MPM (FA-18) mission which results in no mission listed.

FA-18 Impact:  No showstopper here since the FA-18 mission could be selected from the list of all missions.

===================================================================

DTR:     D10365

SOR/STR: SOR 97-13

Title:   PFPS - Improper Invocation of MPM Registered Callbacks

Description:

The FA-18 MPM registers with the TAMPS core callbacks for notification of operations dealing with mission new, open, delete, save, save_as, autosave, import, and export.  Operations dealing with mission save, save_as and autosave all were intended to be used on the current active mission.  Import of a PFPS mission through the TAMPS core functionality is invoking the mission save registered callback with a file operation argument set to APT_SAVE, APT_DELETE, and APT_NEW (note that APT_DELETE and APT_NEW are invalid file operations for the mission save registered callback).  The proper file operation should be APT_NO_FILE_OP which indicates that no file operation should be performed even though the mission save callback has been invoked (this is a patch put in by the TAMPS core when these registered callbacks were first introduced when it when it was discovered that the TAMPS core mission import functionality was invoking the mission save registered callback).

FA-18 Impact:  Invocation of the mission save registered callback without the proper file operation (APT_NO_FILE_OP) causes the FA-18 MPM to try a save of the current mission.  This fails because the data passed to the registered callback is for the PFPS mission being saved no the users current working mission.  An error is returned to the TAMPS core and an FA-18 error message is issued to the user indicating that the mission save operation has failed.  The TAMPS core proceeds to inform the user that the PFPS import of the mission has succeeded.  I am not sure what has really happened with the PFPS mission.

===================================================================

DTR:     D10366

SOR/STR: SOR 97-13

Title:   PFPS - Unable to use AXT_MISSION_SOURCE handle to get origin of mission

Description:

Import of a PFPS mission stores the mission in the TAMPS core mission database with a new mission field (Missison_Source) set to "PFPS".  Unlike a mission import the PFPS mission import does not support MPM registration of a callback to permit the MPM to know about the newly created TAMPS core mission.  The FA-18 MPM must stay in sync with the missions stored by the TAMPS core in order to maintain unique FA-18 mission data.  A new "Mission Handle" for "AXT_MISSION_SOURCE" was to be introduced which can be used when the FA-18 mission open callback is invoked by the TAMPS core.  Supoort for this new handle data is not provided.

FA-18 Impact:  The new "AXT_MISSION_SOURCE" handle will be used by the FA-18 mission open callback for determination of the origin of the mission.  Without this information, PFPS mission imported into TAMPS will be unusable.

===================================================================

DTR:     D10369

SOR/STR: SOR 95-47

Title:   MPLAN Hardware Connection

Description:

If an attempt is made to connect a client workstation to the MPLAN server and the Hardware (either Ethernet or ATM) is disconnected or broken somewhere, the connect process will hang up.  There should be a check at the beginning of the connect process to see if the client can communicate with the server.  If not, the connect process should be aborted and the user informed of a potential cable problem.

===================================================================

DTR:     D10399

SOR/STR: SOR 95-43

Title:   tet_getmapfilenames is slow

Description:

Calling tet_getmapfilenames to determine existence of files is slow.  For imagery, it can take up to 7 or 8 seconds.  This adds a considerable amount of time to our loading process, since we call tet_getmapfilenames for each CADRG, DTED, and CIB frame we wish to load.  This results in thousands of calls to this routine per load.

===================================================================

DTR:     D10400

SOR/STR: SOR 96-01

Title:   Equipment codes not retrieved by dft_getorderofbattle

Description:

When calling the routine dft_getorderofbattle, we get all of the fields correctly, with the exception that the equipment code field is always empty.  We have to have this field populated to correlate the threat sites returned by dft_getorderofbattle to the NID database.

===================================================================

DTR:     D10402

SOR/STR: SOR 96-01

Title:   MIDB Threat Data

Description:

The data is there but HARM MPM cannot get to it. We can't call up any of the threats.

===================================================================

DTR:     D10404

SOR/STR: SOR 95-43

Title:   HARM MU Load crashes when invoked

Description:

We think it is because the stored procedure you call has been moved to the new data base for stored procedures, but you didn't change the address for this particular SP.

===================================================================

DTR:     D10439

SOR/STR: ???

Title:   Creating SLAM ER Tagset crashes MPM

Description:

From SLAM ER MPM Developers:

System crashes when trying to create SLAM ER tagset.

Problem is with BAM tables:

(bam_insertFiles:  Failed to execute insert Failure return from insertFiles)

This problem occurs on both a 6.2 client workstation and the server.

===================================================================

DTR:     D10636

SOR/STR: SOR 96-01

Title:   Limit DBA MIDB Tools when connected to GCCS-M

Description:

During testing of the MIDB SOR while connected to GCCS-M, it was found that may of the support data bases do not exist on the GCCS-M server.  This causes the MIDB Query tool to NOT WORK.  Recommend that a message be displayed to the DBA when selecting this option while connected to GCCS-M.

Although Data Exchange does work, it seems dangerous to allow access to it while connected to GCCS-M.  Its main purpose is for a standalone TAMPS to process TFs, which is unnecessary while connected to GCCS-M: the implementation of DEX on GCCS-M should be how that it done.  The other reason for DEX is to backup and apply tactical updates, which should also not be required in a GCCS-M-connected environment.  Recommend that a message be displayed to the DBA when selecting this option while connected to GCCS-M.

Note: Access to the production software via the Update pulldown requires GCCS-M to install the SUPPORT isql directory, which is not done in the current version of their GMIDB segment.  PRC will handle this in the Juliet version of their GMIDB segment.  For now, we installed the appropriate data into jots19 to continue testing.

===================================================================

DTR:     D10637

SOR/STR: SOR 95-43

Title:   E-4000 NIS+ Installation Failed

Description:

NIS+ installation failed on the E-4000, halting Sysgen.

===================================================================

DTR:     D10641

SOR/STR: 6850

Title:   TOPSCENE not processing Threat Data correctly

Description:

Output of the radar and weapon max eff range (nm) does not match values in the database.  Also, need to change the units for lat/lon from radians to decimal.

===================================================================

DTR:     D10642

SOR/STR: SOR 96-01

Title:   dft_getTargetData only returns Planner Targets

Description:

The function dft_getTargetData() only returns data on Planner targets;

it does not include any data from the MIDB target tables.

===================================================================

DTR:     D10645

SOR/STR: 6425

Title:   GCCS WX Daemon Startup Script Incorrect

Description:

GCCS WX profiler startup script does not properly set the NIPS_HOME env

var before starting the daemon.  Also the shutdown option does not shut

down the daemon

===================================================================

DTR:     D10649

SOR/STR: SOR 95-47

Title:   mplan connect pre-connect warning help not working

Description:

mplan pre connect warning help does not work

===================================================================

DTR:     D10653

SOR/STR: 6698

Title:   Kcard ReOrder Tool wrong help file

Description:

Help file is the help file of the old Kcard ReOrder Tool

===================================================================

DTR:     D10654

SOR/STR: 6698

Title:   Kneeboard Card Launch/Recovery Name

Description:

The KCard should, in addition to ICAO, show the launch/recovery pt airbase name, as in the example provided. Some bases do not have an ICAO, and the planner cannot put a description in EFP for launch/recovery pts.

===================================================================

DTR:     D10656

SOR/STR: SOR 95-47

Title:   HI Client not accessing server Databases

Description:

When connected as a Hi client, all queries to databases returned no data, when there was data loaded on the server but none locally.

===================================================================

DTR:     D10657

SOR/STR: SOR 95-47

Title:   Can't Select Local Printer using Printer Designate HMI

Description:

This is a repeat of DTR #610 which fails but cannot be demoted:

MPLAN Admin > Set Default Printer, if a remote printer is the default for the workstation and the user then selects the local printer as the default (highlight and select OK), the designation fails.  The workstation is left with no printers available in the Set Default Printer HMI (including the local printer) and cannot print anywhere.

The correct method is to select Delete (when a remote printer is the default) then the local printer is made the default printer.  The Help file does not mention this fact though!!

===================================================================

DTR:     D10658

SOR/STR: SOR 95-47

Title:   Could not print to a remote workstation's printer

Description:

I was on a connected client workstation (california) with another workstation (iowa) and the permanent client (lifeboat) also connected (with printers) to the E4000.  I could designate and print to the printer on the permanent client but could not print to the iowa printer.  The iowa printer showed up as the default printer after designating but any print jobs sent to it did not reach it and also did not show up in the Print Queue HMI.

===================================================================

DTR:     D10659

SOR/STR: SOR 95-47

Title:   Default Printer at Disconnect

Description:

If a workstation has a remote printer designated as it's default printer and the remote printer is taken offline (the machine it is attached to is disconnected from the MPLAN), the workstation will then have no default printer.  The problem is, when the Sys Admin on that workstation tries to designate a different printer using the Set Default Printer HMI, this process fails and an error message is displayed.  The SysAdmin has to run:  "lpadmin -d cops" from the command line as the root user to clear the problem (and designate the workstation's local printer as default).

===================================================================

DTR:     D10660

SOR/STR: SOR 95-47

Title:   LAN Printer not working

Description:

With a serve lite(no local printer) using ethernet and one client connected with a printer. Designated the client printer as a network printer using the menu under MPLAN> Designate Network Printer. On the server lite selected the client printer as the default. It showe up in the Set Default Printer window as the default, but could not print anything from the server lite. In shell lpstat -l -p showed cops_arizona  faulted after the entry for Default port settings.

===================================================================

DTR:     D10661

SOR/STR: SOR 95-47

Title:   HI Client NIS Passwd table deleted

Description:

After disconnecting a Hi Client from MPLAN, user could not log into system using previous valid accounts. Logged in as root and checked niscat passwd and the table was empty.

===================================================================

DTR:     D10663

SOR/STR: SOR 95-47

Title:   Mission Import from tape messages

Description:

This is similar to DTR #381 except this pertains to mission import from media vice xfer between client/server.

If a Mission Import to either a client or server database from Media is performed and the database already contains missions with the same names as those being transferred, error messages are properly displayed.  However, a message saying "Mission Import Completed Successfully" is displayed also.

===================================================================

DTR:     D10665

SOR/STR: SOR 97-11

Title:   Incorrect JTIM Image Retrieve Time

Description:

After performing a JTIM query from the SPA thinline, all images show the same time to retrieve (2:36:00)

===================================================================

DTR:     D10672

SOR/STR: SOR 95-43

Title:   No Additional MPM Can Be Opened

Description:

It is becoming relatively common (a daily occurrence), during testing, for one of the workstations to reach a state where no additional MPMs can be opened.  The conditions under which this occurs vary, but a common thread seems to be that a DBA Module is open at the time of the failure, and usually the user reports recently loading or transferring data to/from the database.  Usually stopping and starting the object server clears the problem, but sometimes a reboot is required.

Related to ITR 629i

===================================================================

DTR:     D10680

SOR/STR: SOR 95-47

Title:   GCCS Admin applications need Hour Glass displays

Description:

The GCCS Admins applications sometimes take more than a few seconds.

An hourglass should be displayed per the HMI guide.

===================================================================

DTR:     D10683

SOR/STR: SOR 96-60H

Title:   Attempt to export an object that was imported, hangs up process

Description:

Exported a new test object NAVY_TACANS with one associated query to 3.5 floppy. Then deleted the object. Imported the object to same system and no problems. Rebooted system and Object/Query was there. Next, tried to export the same object to 8mm tape and it just hung up the process. Used the default tape device 8mm hi dens. Had to kill the oil_Export process. Also, it looked like the .odf file was not created. Created another new object and it exported to tape OK.

96-60H.2

===================================================================

DTR:     D10687

SOR/STR: SOR 97-11

Title:   JTIM MGRS Value Sticks

Description:

The MGRS value in the JTIM imagery toolkit only updates the first time a lat/lon is selected.  After that any lat/lon pick from the image using the arrow updates the lat/lon value, but not the MGRS.

===================================================================

DTR:     D10695

SOR/STR: SOR 95-47

Title:   Unable to Load Charts from Client

Description:

Tried to load a TPC chart from a client workstation to the E4000 server.  Got error message:  "Ran out of storage space on the selected destination drive.  You may choose another destination or cancel load" even though there is plenty of space available in the server maps directory.

This problem is caused by the problem reported in DTR 633 - server directories not being cross-mounted.

===================================================================

DTR:     D10697

SOR/STR: SOR 96-01

Title:   Missing data items in dft_getTargetData()

Description:

The function dft_getTargetData() does not fill in the vertical location error

or the photo chip number for planner targets, even though this information

is available in the data record.

===================================================================

DTR:     D10698

SOR/STR: SOR 95-47

Title:   MPM connect/update scripts being run at wrong time.

Description:

The update script is invoked after the user logs in followed by the MPM Connect script.

I would expect only the Connect script to be invoked.  Furthermore, the connect script

must be invoked AFTER the account deconfliction has taken place permitting the FA-18 connect script to address the client accounts which

have been renamed for transfer to the server.

===================================================================

DTR:     D10699

SOR/STR: SOR 95-47

Title:   Misleading Error When Loading Charts

Description:

If a user attempts to reload a chart which has already been loaded, an error message is displayed that says: "Ran out of storage space on the selected destination drive.  You may choose another destination or cancel load".  This error is misleading since the user will believe that there is no room to load additional charts, even though there may be plenty.

This problem is different than the problem described in DTR 695, and happens on any hardware set-up, including stand-alone workstations.

===================================================================

DTR:     D10710

SOR/STR: SOR 96-52M

Title:   PC Card Formatting Code Missing Colons

Description:

Commas missing from Boeing provided Core PC Card Formatting code.  Makes formatting code which is critical to TAMMAC functionality unusable.

===================================================================

DTR:     D10713

SOR/STR: SOR 95-43

Title:   Black Ghost cursor on PCs

Description:

On the two PC Xterms with Win95 loaded, the data entry fields all show a large black "Ghost" cursor in entry windows. The PC with NT looks OK.

===================================================================

DTR:     D10715

SOR/STR: HelpFilesInit

Title:   Lockheed help files

Description:

Corrections to existing help files.

C.4
DTRS IN WORK

DTR:     D10037

SOR/STR: 6.2 init

Title:   Display Aircraft Mission (Column Width)

Description:

The columns in the "Display Aircraft Missions" widget under the Route menu are varying in width.  They appear to be following the width of the longest mission name being displayed.  These columns should be a fixed width, as in 6.1.1.  This may also occur in the "Display Weapon Missions" widget, but we have no weapon MPMs to check with.

===================================================================

DTR:     D10038

SOR/STR: 6.2 init

Title:   Button Text Left Justified

Description:

The button text on many of the report creation windows is left justified.  All button text should be centered on the button, as in 6.1.1.

===================================================================

DTR:     D10121

SOR/STR: 6216

Title:   Polygon or Corridor Geo Create

Description:

Cannot edit the points of a Polygon or Corridor Geo - must pick new points from the map.  This should work like picking/editing points for a minefield in FAMP - each point can be entered/edited individually.

===================================================================

DTR:     D10122

SOR/STR: 6216

Title:   Corridor Geo Half-Width

Description:

When creating a new Corridor Geo, you must set the half-width before selecting points - you cannot change this setting at any other time.  Should be able to edit this parameter at any time.

===================================================================

DTR:     D10154

SOR/STR: 6.2 init

Title:   Amp Info Lat/Lon

Description:

Amp Info for many of the objects queried from the database, including airbases, navaids and waypoints contains Latitude and Longitude information twice, providing redundant information to the user.

===================================================================

DTR:     D10156

SOR/STR: SOR 97-10

Title:   Inability to Obtain CADRG or CIB Files by Scale

Description:

The tet_getMapFilenames interface dies not allow the user to obtain filenames based upon scale.  The net result is that the function returns all files within a geographic region instead of the specific files needed.  The user must then filter the returned list to extract the needed files, a requirement imposed on the user that was unexpected and will add to CADRG and CIB processing times for TAMMAC.

===================================================================

DTR:     D10187

SOR/STR: 6697

Title:   Doghouse Component Data Items:  HMI display of 2- & 3-part components

Description:

The 2- and 3-part HMIs presented for Doghouse Component Data Item editing show only a subset of the types available.  In particular, only the united 2-part component and the 3-part component (2 parts on left, one large part on right) are provided.  Based on the type of component selected by the user,  the left-portion or right-portion only (for a 2-part component) and the mirror of the 3-part component (i.e., one large part on the LEFT, and 2 smaller parts on the RIGHT) must also be displayable in the editing HMI

===================================================================

DTR:     D10225

SOR/STR: SOR 95-47

Title:   Date & Time Change While loading DAFIF

Description:

The Date that was loaded when the system was loaded was a 23 Dec 97.   During the loading of DAFIF ED5 9713, I changed the date back to 22 Dec 97.   This caused problems in sybase.    Because the DAFIF was hung up,  after 3 hrs I terminated the DAFIF load.   Talked to Bill M. and he said yes it does cause problems in the sybase, like NIS+ and other files.

Do not change the date & time during the time your loading data to sybase.

Stand alone systems.

===================================================================

DTR:     D10227

SOR/STR: 6.2 Init

Title:   Database and Dataset menu conformity

Description:

Dump/Restore shows the following database selections:

None

DAFIF_GPS

GMI

NID

tamps

TAMPS_SPROCS

and the Database usage shows this as the database dropdown:

NID

MIDB

MIDB_Subset

TAMPS

DAFIF/GPS

believe this should match, as closely as possible and in the same order, to what is in the Dump/ Restore dropdown and should read as follows:

DAFIF_GPS

GMI

GMI_SUBSET

NID

tamps

In addition, the tamps dataset of the Database Usage menu is not correct and should be modified as follows:  Delete from the menu selection the following databases/datasets: CONSTRAINT, DAFID, GMI, GPS, IDB, NID, TAC and TMP.  These are covered in other areas/menus and the remaining databases/datasets all fall under the tamps database.

===================================================================

DTR:     D10264

SOR/STR: SOR 95-43

Title:   Go-NoGo Fail on floppy

Description:

On a standalone Ultra2, the Go-NoGo test fails for the floppy drive. Report shows FATAL: Couldn't open /dev/rdsk/c0t0d0s2. Looks like it is looking for device name of /dev/rdsk/c0t0d0s0 which may not be correct on the Ultra2.

===================================================================

DTR:     D10265

SOR/STR: SOR 95-43

Title:   Go-NoGo Fail on TIDS

Description:

On standalone Ultra2 with TIDS connected to serial port A, the Go-NoGo test fot the TID fails. Report indicates Error: Bad status redeived from the E2-C TID. This may not have been updated for the new TIDS box.

===================================================================

DTR:     D10266

SOR/STR: SOR 95-43

Title:   Go-NoGo Fail on Monitor

Description:

On standalone Ultra2, the Host Graphics Monitor Test consistently fails. The screen goes through various test displays but the test fails. The report indicates Error: 3DRAM Test error, 3DRAM Memory error, Buffer A SFB Red Plane at (0,0).

===================================================================

DTR:     D10271

SOR/STR: SOR 95-43

Title:   Sysgen vxfs

Description:

Implement Veritas file system (vxfs) on E-4000.

SOT Step 95-43.1

===================================================================

DTR:     D10272

SOR/STR: SOR 95-43

Title:   Sysgen Quick IO

Description:

Implement Veritas Quick IO

SOT Step 95-43.1

===================================================================

DTR:     D10304

SOR/STR: 6698

Title:   Kneeboard Card Window Resizing

Description:

Resizing the kneeboard card window does not change the size of the displayed data, it only creates a larger blank area.  Resizing windows should result in the display area resizing or there is no point in resizing.  Chronic TAMPS problem - we should not be replicating it in new interfaces!!

===================================================================

DTR:     D10310

SOR/STR: SOR 96-01.2

Title:   MIDB New Installation/Facility Key screen opens behind WSE Menu

Description:

The New Installation/Facility Key screen opens up behind the WSE menu bar requiring the user to physically move the screen.

===================================================================

DTR:     D10321

SOR/STR: SOR 96-01.2

Title:   MIDB Baseload and MIDB TF load

Description:

Currently the system allows a DBA without Modify MIDB privileges to go through the process of loading an MIDB baseload tape before finally letting that user know that the Modify MIDB privilege is required.  MIDB TF load also applies though no warning is delivered.

These should be greyed out or not appear at all so that the user knows from the start that he/she does not have the proper privileges.

===================================================================

DTR:     D10335

SOR/STR: SOR 96-01.3

Title:   Exercise/Scenario data load capability

Description:

Currently the only way a user can load exercise/scenario data into TAMPS is via the MIDB Baseload function which (1) is not very intuitive and (2) deletes all MIDB data currently on the system to be replaced by whatever is on the exercise/scenario data tape.  NO WARNINGS are displayed.

A new menu item should be created for loading exercise/scenario data with a confirmation box/disclaimer indicating that all current MIDB data will be overwritten if the user proceeds.  Ideally, there should be an option to allow appended exercise/scenario data to the MIDB database without deleting the current load as long as it does not conflict with any data previously loaded.

===================================================================

DTR:     D10349

SOR/STR: 6216

Title:   Unable to Overwrite Saved Geos

Description:

When a user creates a new geo using the toolbar icon or one of the other "quick geo" selections from the geo filter menu, and then tries to create another new geo using a similar method, an error message is displayed that says:  "CURRENT_GEO will be overwritten.  Continue?"  If yes is selected, a new error message is displayed that says:  "Geo with name CURRENT_GEO exists.  Please rename with a name other than CURRENT_GEO".  If the user selects to overwrite the saved geo, it should be overwritten.  This worked in earlier builds and destroys the "quick geo" feature of the toolbar icon and the menu options.  Tested on E4000 server.

===================================================================

DTR:     D10352

SOR/STR: SOR 95-47

Title:   Hidden Widget in Update Database Dumps

Description:

When updating the Database Dump files on the server, the message window:  Database Updated Successfully is displayed behind the Update Database Dumps widget.

===================================================================

DTR:     D10372

SOR/STR: SOR 95-47

Title:   Mission Save As Function

Description:

Created a mission on the server of a client/server setup using one account, and then opened the mission on the client using a different account which had not yet been used to create a mission.  Got a message about Autosave being enabled and instructing me to rename the mission using Save As.  Selected Save As and tried to save with a different name, but got an error: "No planner selected".  The name of the account being used was not listed in the list of possible planners and could not be selected.  Was unable to perform a Save As operation until a new mission was created first.  Creating a new mission using the account added the account name to the list in the Save As dialog.

===================================================================

DTR:     D10383

SOR/STR: SOR 95-47

Title:   Chart/Imagery Data Load from Server to Client

Description:

When loading chart or imagery data from the server, the message window shows:  "Loading Chart/Imagery (X of X)".  It should show what percentage is loaded as it does when loading from a CDROM.

===================================================================

DTR:     D10398

SOR/STR: SOR 95-43

Title:   No length returned in tet_getmapdata

Description:

The tet_getmapdata routine returns a pointer to the data it retrieved.  However, no length is returned, so the caller does not know how long the data array is.  To workaround this, we stopped using the Core routine, and retrieved the file ourselves.

===================================================================

DTR:     D10403

SOR/STR: SOR 95-43

Title:   FOV Ellipses

Description:

They are very rough when drawn off of cardinal headings. At 270deg, one side is rough and the other is smooth.

===================================================================

DTR:     D10593

SOR/STR: SOR 95-43

Title:   ATM Card Driver only installs during sysgen

Description:

If a TAMPS workstation is loaded and there is not an ATM card installed before the load, then the system must be reloaded after installing an ATM card to connect using ATM. Just doing a boot -r does not load the driver. This may cause problems if systems are intially loaded without ATM and then deployed aboard a CV and ATM needs installed.

===================================================================

DTR:     D10646

SOR/STR: 95-47

Title:   Change workstation IP Address

Description:

There is no capability to change a workstations own IP_address once it has

been sysgen'd.  This capability may be needed if a case arises where a

workstation's ethernet subnet address happens to be the same as the ATM subnet address

of the MPLAN it is attempting to connect to.  If they are the same, the

error checking utilities of MPLAN to validate the Server address must be

bypassed.  The ability to change a workstations IP address would allow the

SA of the connecting workstation to change the ethernet address thus

ensuring maximum use of the MPLAN error checking.

===================================================================

DTR:     D10651

SOR/STR: 95-43

Title:   TAMPS loader stores NITF image size in bytes, not kbytes

Description:

When the TAMPS Database Administrator module loads an NITF image,

it stores the size of the image in bytes (as read from the image header).

This is contrary to the IDD description of the TIT_IMAGE_STRUCT

structure, which indicates that this value should be in kbytes.

No code appears to use this value (it is stored in the catalog for information

only), so it should be a matter of updating the loader code to convert the

loader code to kbytes.

===================================================================

DTR:     D10664

SOR/STR: SOR 97-11

Title:   Multiple JTIM Image Retrieve

Description:

Sent a retrieve request for 6 JTIM images from a client workstation.   The first attempt resulted in 3 images being retrieved (status changed to "Available").  The other 3 images remained in the "Retrieving" state, with no indication of a problem.  After several minutes, cancelled the retrieve request, sent another request for the remaining images, and the remaining images were successfully retrieved.  Tried requesting 6 images again and only 4 images were retrieved.  Results appear to be inconsistent when requesting multiple images.

===================================================================

DTR:     D10667

SOR/STR: SOR 97-11

Title:   Grid Not Filled in for JTIM Box

Description:

Sometimes when boxing in the world using the rubberband box function in the JTIM Query Details dialog, the southeast grid is not filled in.

===================================================================

DTR:     D10675

SOR/STR: SOR 97-11

Title:   JTIM Toolkit Under WSE

Description:

The JTIM Imagery Toolkit comes up under the WSE when it is opened from the Threat/Intel -> JSIPS-N -> Imagery Toolkit menu option.

===================================================================

DTR:     D10676

SOR/STR: SOR 96-01a

Title:   Database selection in Profile Maintenance incomplete

Description:

Database selection in the MIDB production tools (Profile maintenance) only lists four databases instead of the complete list.  The two systems (iceberg and missouri) that have MIDB loaded show the following in the database drop list box (profile maintenance) :

E4000:                          Missouri

Tamps                           Dafif-gps

Dafif-gps                        DB_Support

NID                                MS

Tamps_sprocs               Obscon

Neither of these show the gmi database or the rest of the listing.

===================================================================

DTR:     D10678

SOR/STR: SOR-95-43

Title:   Update Sysgen Printer/PC/Default Router Prompts

Description:

Prompt for a second Default Router on the CVIC E-4000, default both router

IP addresses to *.*.*.1 and *.*.*.2, where *.*.* is the TAMPS LAN network.

Indicate to the installer that router host names are not critical - provide

generic defaults.

Hard code the IP addresses of CVIC network printers and PC planning

workstation networks on the RFC 1597 private Class C network of

192.168.0.0.

Update the install instructions as necessary.

===================================================================

DTR:     D10684

SOR/STR: SOR 97-11

Title:   Incorrect JTIM Message

Description:

Selected a JTIM image that was marked "Saved" and displayed it in the imagery toolkit.  Selected File -> Exit and got a message saying "Image has not been saved.  Do you still wish to exit."  This message is incorrect.

===================================================================

DTR:     D10685

SOR/STR: SOR 97-11

Title:   Cryptic JTIM Error message

Description:

If a user tries to save an image using the same name a previously saved image, a cryptic error message is displayed: "Unable to save xxxx to TAMPS".  The message should say that an image with that name already exists.  Please use a different name.

===================================================================

DTR:     D10686

SOR/STR: SOR 97-11

Title:   JTIM Lat/Lon Select

Description:

When a user first enters the JTIM imagery toolkit, the "arrow" toolbar icon is highlighted, but cannot select lat/lon from the map.  Must select the arrow button again to get the lat/lon function to work properly.

===================================================================

DTR:     D10688

SOR/STR: SOR 97-11

Title:   Selecting JTIM Graphic Objects

Description:

When editing graphics in the JTIM imagery toolkit, it is difficult to determine when an item has been successfully selected.  Sometimes items appear to be selected when they are actually not, and vice versa.  There is no indication of what is selected until the user attempts to change color or delete the objects.

===================================================================

DTR:     D10689

SOR/STR: SOR 97-11

Title:   Changing JTIM Text Background

Description:

Changing color of JTIM text using the graphics menu causes the background to change color.  Once this has been done, there is no way to change it bakc to clear.

===================================================================

DTR:     D10690

SOR/STR: SOR 97-11

Title:   JTIM Imagery Toolkit Moves Under WSE

Description:

Each time an image chip is created or the image chip is cancelled using the right mouse button, the imagery tookit is moved up under the WSE menu bar.

In accordance with the TAMPS style guide, dialogs shall never be placed so that the top of the window is hidden by the WSE menu bar.

===================================================================

DTR:     D10691

SOR/STR: SOR 97-11

Title:   Editing JTIM Text also Affects Graphics

Description:

Placed some text on a graphics object in the JTIM imagery toolkit, then box selected the text and object in order to change the text font size.  The text correctly changed size, but the object size was also changed.  Changed the text color and the object border was also changed.  Changes using the text menu should only apply to selected text, and changes using the graphics menu should only apply to graphics objects.

===================================================================

DTR:     D10692

SOR/STR: SOR 95-43

Title:   Multicast Router Daemon not starting

Description:

Loaded a Workstation with the multicast option turned on. After load the multicast daemon was not running. It appears that the multicast loads before the interfaces are configured and it has the default IP address.

===================================================================

DTR:     D10693

SOR/STR: SOR 97-11

Title:   Arrows On JTIM Polygons

Description:

Arrow styles get applied to all JTIM polygons in the imagery toolkit.  Arrows should only be applied to individual lines.

===================================================================

DTR:     D10696

SOR/STR: SOR 95-47

Title:   MPLAN Set Default Printer HMI window

Description:

The HMI window for System Admin->MPLAN Administration->Set Default Printer is too narrow and truncates the printer location field.  Since this is a fixed-size window, user has no way of seeing whole field.

===================================================================

DTR:     D10705

SOR/STR: SOR 95-47

Title:   Loadout Crashes MPMs on PC

Description:

Selecting Weaponeering -> Loadout in any MPM on the PC Xterms that are loaded with Windows 95, crashes the MPM.  Opening the loadout on a PC loaded with Windows NT does not produce a crash.

===================================================================

DTR:     D10706

SOR/STR: SOR 96-01.3

Title:   Need way to view TAMPS Rep Server log for errors

Description:

We need a way to view the TAMPS Rep Server error log other than via a shell.  At a minimum, this could be via sitting at a GCCS-M machine and using the RSM tool, but this tool cannot access the TAMPS Rep Server log without a piece of the RSM software being installed on the TAMPS server.

As noted in 708, the DBA or SA should be notified when something is wrong.

Test step 96-01.3

===================================================================

DTR:     D10707

SOR/STR: SOR 95-47

Title:   Mouse Pointer Gets Moved on PCs

Description:

On the PC Xterms, the mouse pointer gets moved to the lower right corner of the display after performing various operations.  For example, each time the route is validated, the cursor gets moved.  This means that if Route Validation is ON, the pointer gets moved each time a new point is dropped on the map.

===================================================================

DTR:     D10708

SOR/STR: SOR 96-01

Title:   Doing certain Fac updates on TAMPS connected to GCCS-M cause rep to suspend

Description:

When connected to GCCS-M, facility creation of working records seemed to work.  However, things went downhill fast when a working record was attempted to be updated.  I first got a message "unable to connect to database" within the production software.  Tried to add a new facility again and the app got blown away.

We checked the TAMPS Rep Server log and it showed errors regarding FAC_VULNERABILITY (have no idea why, since we didn't edit that table).  We got rep back by doing a "skip transaction."  This is not good, since skipping the transaction will cause problems with any future updates to that record.

The DBA or SA should be notified when something is wrong.

===================================================================

DTR:     D10709

SOR/STR: 96-01.16

Title:   MIDB Dataset removal

Description:

There is a requirement that states that MIDB data (GMI or target) is not allowed to be removed if the MIDB data is being replicated from JMCIS.  There is no warning or information displayed that says the user is not permitted to remove the dataset.  When Utilities -> Data Removal -> Dataset... is selected a confirmation message pops up saying, "Do you really want to remove the GMI dataset?"

I believe a message should pop up indicating that the user does not have permission or is prohibited from removing the MIDB GMI or target data while being replicated from GCCS-M"

===================================================================

DTR:     D10711

SOR/STR: SOR 95-47

Title:   RTMs not displaying correctly on Client

Description:

On a connected Client RTMs only display as circles if there is no DTED for area loaded on local system. DTED displays fine in background and RTMs work OK on server and standalone. Also, when load DTED to a client from server, then RTMs would work correctly. On Permanent Client RTMs always circles even when DTED was loaded on client.

===================================================================

DTR:     D10712

SOR/STR: SOR 95-43

Title:   PC, DCW Features

Description:

DCW browse and DCW features not displaying consistently on PC Xterms. One PC doesn't display anything,  one was displaying browse but no features and the NT ver, displays both.

===================================================================

DTR:     D10714

SOR/STR: 6697

Title:   Stripchart crashes frequently

Description:

When on a standalone Ultra 1200, stripcharts are crashing frequently while pulling in TPC data and modifying doghouses. Also, when try to load a previously saved doghouse. Sometimes causes a logoff when trying to open a saved stripchart.

===================================================================

DTR:     D10718

SOR/STR: SOR 97-11

Title:   JTIM Causes Problems on PCs

Description:

If the JTIM Toolkit is opened on a PC Xterm and an image is loaded, it causes problems with color mapping.  The TAMPS map background becomes discolored and objects in the tookit are black and white.

This is caused by the display being set at 256 color instead of 24-bit.  However, if the display is changed to 24-bit, the TAMPS application becomes too large and unmanageable for the screen.

Note:  On the NT system,  changing to 24-bit and lowering the display resolution makes the system useable, but slower.

===================================================================

DTR:     D10719

SOR/STR: 6697

Title:   Saving strip charts logged me off the server lite

Description:

Created a msn with approx 9 nav pts.  Then selected Strip Charts -> did a save of the strip charts and during the save and exit this logged me of the server lite.  I was connected to client jersey via ethernet.

===================================================================

DTR:     D10720

SOR/STR: SOR 96-01

Title:   MIDB Units not creating Tgt ID & Tgt Definition for Planner Tgt Updates Window

Description:

The Units OOB data for MIDB, does not update the Tgt ID number and Tgt Definition name for the Planner Target Updates Window.

===================================================================

DTR:     D10721

SOR/STR: SOR 97-11

Title:   Unable to Display JTIM Images on TAMPS

Description:

Images retrieved from the JTIM SPA server and saved to the TAMPS database can not be displayed to the TAMPS map background.

===================================================================

DTR:     D10722

SOR/STR: SOR 96-01

Title:   JTIM Target Data Not Extracted from Target Folder

Description:

Unable to extract target data from target folders that are retrieved from JTIM SPA server.

===================================================================

DTR:     D10723

SOR/STR: SOR 95-47

Title:   LAN Admin Tool Edit option for High Side Client

Description:

High Side client should be able to edit the NIS+ hosts table, since he is still in his own NIS+ server domain during connection.

===================================================================

DTR:     D10725

SOR/STR: SOR 96-01

Title:   TAMPS-specific MIDB GMI view not created (FAC/EQP)

Description:

One of the three new views installed during Data Base installation do not get installed, due to an extra period in the Install_midb_tamps.csh file.

Workaround is to enter the following two commands in a shell:

cd $DB_INSTALL/midb_tamps

isql -Utamps -Ptamps60 < TAMPS_EQP_FAC_VIEW.sql

Note: This was introduced during the correction of DTR 483.

===================================================================

DTR:     D10727

SOR/STR: 6850

Title:   TOPScene SPROCS installation failing

Description:

The TOPScene SPROCS are being installed prior to the GMI data tables being

populated.  This causes the installtion to fail.

===================================================================

DTR:     D10728

SOR/STR: SOR 95-47

Title:   Printing causes lpsched to run away

Description:

Whenever a print job is sent to the Xerox printer, the lpsched process run away after a few minutes.  This occurred on both a standalone workstation and on a connected workstation.

===================================================================

DTR:     D10729

SOR/STR: SOR 95-47

Title:   LAN Admin Crash

Description:

Connected a workstation to the E4000 server via ATM.  Changed the local hostname and local IP address at connect.  After connecting, any LAN Admin HMI (Sys Admin->MPLAN Admin->LAN Admin) started will crash if an entry is selected in either Connected Clients view or NIS+ Host Table View.  If a LAN Admin HMI was started before the workstation was connected, it will not crash in the above manner.

Chuck G. discovered that this occurs if 3 or more clients are connected to the server.

===================================================================

DTR:     D10730

SOR/STR: 97-11a

Title:   Update database login field in JTIM file cleanup script

Description:

The script that cleans up unsaved files from the JTIM query retrieval

dialog logs into Sybase as the current username ($LOGNAME).  Since

this is run as a cron job, $LOGNAME is set to "root", which is not a

proper database user.  Use $DB_TAMPS_OWNER (and

$DB_TAMPS_SYBPASS) instead.

===================================================================

DTR:     D10731

SOR/STR: SOR 96-01

Title:   MIDB Query printer default classification incorrect

Description:

Print option in the MIDB production tools query window defaults to an incorrect classification.  The default selection is a higher classification with caveats and there are no options for any other classification.

Same as D673 that failed in B4.

===================================================================

DTR:     D10732

SOR/STR: SOR 96-01a

Title:   Default MIDB Query dataserver on clients

Description:

The MIDB Query Tool on the permanent client (Ultra-2300) and ATM clients should show  "TAMPS_SERVER" as the default dataserver when connected instead of the local "TAMPS" dataserver.

===================================================================

DTR:     D10733

SOR/STR: SOR 97-11

Title:   Create Cron job to cleanup unsaved JTIM image files

Description:

This ITR is being used to deliver a script to clean up image files in the

JTIM directory that have not been accessed in a certain number of

days (14 to begin with) that have not been saved and cataloged into

the TAMPS imagery catalog, and a cron file entry to run this script

periodically.

This is a dupe of 630 that failed.

===================================================================

DTR:     D10734

SOR/STR: SOR 95-43

Title:   2300 perm client can't change root or tamps passwd.

Description:

The 2300 super client, could not change local  root or tamps passwd using User Admin HMI since it is always connected. Cannot easily change root using a shell since may cause other big problems. Tamps Password can be changed in a shell. This is a security issue.

===================================================================

DTR:     D10735

SOR/STR: SOR 95-43

Title:   creating new accounts

Description:

Creating accounts and typing in the passwd in both places in the new widget, then moved back to the top and retyped the passwd and selected OK: Received the following msg:

this is not a valid user name.   Still could login with all privileges.

===================================================================

DTR:     D10736

SOR/STR: SOR 96-01

Title:   Threat Density Shading Crashes appllication

Description:

OOB -> SAM -> created range rings and then selected Threat Density Shading Window: -> then selected the radio button select -> line apply and then selected the radio button select -> filled and apply and the application crashed.

C.1  SCOPE

This appendix contains descriptions for DTRs closed, in test, and in work. Closed items have passed all CM and test phases.  They will appear on this CD release. "In test" items have passed CM phases and have been approved by test. cIn teste does not imply that an item has or has not been delivered with this CD release. "In test" items may be complete, but not yet marked closed at the time of this release snapshot. Therefore, refer to Appendix A for all items released with this CD version. "In work" items do not appear on this CD release.

C.2  DTRS CLOSED

DTR:     D10008

SOR/STR: 6.2 init

Title:   Remove Obsolete Files

Description:

Remove files that are obsolete in 6.2 that were not removed during initialization

===================================================================

DTR:     D10009

SOR/STR: SOR 95-43

Title:   Motif Failures

Description:

Several times while performing normal TAMPS functions (i.e. opening missions, initiating shutdown, etc.) the Motif window manager failed.  Had to logoff and back on to restore it.  There appears to be a greater tendency for this to happen soon after a system reboot.

One way to make Motif fail every time:

1.  Display a system modal window.

2.  Open the DBA or an MPM and move the window.

3.  Perform a database query of any type.

4.  Motif will crash after performing the query.

Motif can be restarted from a shell by typing mwm& and will function properly or by logging out and logging in again.

===================================================================

DTR:     D10010

SOR/STR: 6.2 init

Title:   Recovery Base Symbol Error

Description:

When creating missions, the recovery base is shown as a nav point symbol with a "2" next to it, rather than an airbase or carrier symbol.  When attach recovery is selected, the correct symbol is overlayed on the nav point symbol.

===================================================================

DTR:     D10011

SOR/STR: 6.2 init

Title:   Compass MPM Not Functioning

Description:

The COMPASS MPM is not working.  When it is selected from the Mission Planning menu, the MPM map window flashes on the screen and disappears.

===================================================================

DTR:     D10012

SOR/STR: 6216

Title:   Geo Filter Help is Incorrect

Description:

The help file for the new GEO tool (Display -> Geo Filter -> Custom) is incorrect in several places.  The "Geo" menu is described as containing the options "Current", "Display", "Clear" and "Delete", but the menu in the window actually contains "New Geo", "Current", "Display", "Declutter", "Edit" and "Delete".  The functional descriptions for "Current" and "Display" are also incorrect, and there are several spelling errors/typos.  Also should add a description of the Save and Apply functions.

===================================================================

DTR:     D10013

SOR/STR: 6216

Title:   Geo Filter Menu Logic is Incorrect

Description:

The gray/ungray logic in the Geo menu of the Geo Filter window is not correct.  The user should be able to create a new GEO even if a previously created GEO is highlighted if the "Selectable Geos" list.  "Display" should be grayed out if a GEO that is already displayed is highlighted.  "Declutter" should be grayed out if a GEO that is not displayed is highlighted.  "Current" should be grayed out if the current GEO is highlighted.

===================================================================

DTR:     D10014

SOR/STR: 6216

Title:   Geo Filter Scroll Bar Error

Description:

The scroll bars in the "Selectable Geos" and "Displayed Geos" regions of the GEO Filter window should only appear when the lists get filled to the point where a scroll bar is necessary to view all of the GEOs.

===================================================================

DTR:     D10015

SOR/STR: 6216

Title:   Geo Filter Editing Error

Description:

If a previously saved GEO is highlighted in the GEO Filter window, and then edited without changing the name, the system displays a "Delete GEO Confirmation" window.  Selecting either Yes or No appears to give the same result.

===================================================================

DTR:     D10016

SOR/STR: 6216

Title:   Creating New Geos

Description:

When creating new GEOs using the Rectangle, Circle or Polygon selection under the Display -> Geo Filter menu, or the GEO toolbar icon, the system displays a "Delete GEO confirmation" window.  Selecting either Yes or No in this window appears to give the same result.

===================================================================

DTR:     D10017

SOR/STR: 6216

Title:   Saving Geos

Description:

In an MPM, if a new GEO is created which has the same name as a GEO that has already been saved to the database, and then "Save" is selected, an error message is displayed that tells the user to change the name of the GEO.  However, when the message is acknowledged, all fields in the new GEO window are grayed out, including the name, so the GEO must be recreated.

===================================================================

DTR:     D10018

SOR/STR: 6216

Title:   Geo Filter Hidden Menu

Description:

When using the new Geo Filter -> Custom function to input a new geo, if cancel out of the draw mode by using the right mouse button or click twice on the same location using the left button, an error message comes up but is hidden behind the "Geo filter" window.

===================================================================

DTR:     D10019

SOR/STR: 6216

Title:   Geo Filter Edit

Description:

In a DBA module, selected a DBA built GEO that had a * next to it for editing.  Error message comes up: "Selected Geo must be the current Geo", even if the GEO already is the current GEO.  If the selected GEO is not the current GEO, it changes it to the current GEO.  Could not edit any GEOs with the *.

===================================================================

DTR:     D10020

SOR/STR: 6216

Title:   Geo Filter delete

Description:

In a DBA Module, selected a geo and then selected Delete.  A message window came up saying "Selected Geo does not exist".  Also, a confirmation window and a Geo Filter Delete hourglass came up.  When select No on the confirmation window, the file was deleted anyway.

===================================================================

DTR:     D10021

SOR/STR: 6.2 init

Title:   Make Arguments Omission for cc compiler

Description:

$TOPDIR/config/projpath needs -xildoff added to STD_CFLAG in make arguments for cc compiler.

===================================================================

DTR:     D10022

SOR/STR: 6.2 init

Title:   Ada Bindings

Description:

The following ADA bindings are documented in the IDD but are not implemented:

AUT_COMPUTEWINDCOMPONENTS

AUT_COMPUTEWINDDISTANCE

AUT_COMPUTEWINDRANGEFACTOR

DAL_GENCLAUSE

DAL_GENQUERYLIST

MPT_GET_SCALE_AND_ZOOM

UET_ERRORMSG

UMT_UPDATETABLE

The LBT_REGISTER binding is missing the FLAG argument.

Rep Specs were updated for the following record to repair compilation warnings:

APT_ACTION_POINT_T

APT_AIRCRAFT_T

CORNER_RADS

GEO_NODE_CIRCLE

GEO_NODE_POLY

GEO_NODE_ROUTE

POINT_RADIANS

THE TMT_IMAGERY_STRUCT record does not exist in the bindings area.  On the C side, the C structure TMT_ADRI_STRUCT  was changed to TMT_IMAGERY_STRUCT for STR 3112.

Appendix N incorrectly has and AOA field for the APV_JBACKLINK_T record.

The ART_CREATEMSNLAYERNAME ADA binding function description in IDD Appendix G should not have an ID argument.

The BDT_COMPUTECHECKSUM ADA binding function description and example in IDD Appendix G needs to be updated to reflect the actual ADA binding.

===================================================================

DTR:     D10025

SOR/STR: SOR 96-60A

Title:   Count By Decouple

Description:

Count By decouple mode is not functioning correctly.  When using Count By to key on a column of

information, highlight 1 or more items and then select decouple.  If a change is made to the map display,

the change is correctly not made to the decoupled widget but if a different column is selected in the

decoupled widget, the items highlighted in the display window of the decoupled widget will match the

objects selected on the map display even though the widget is decoupled.

===================================================================

DTR:     D10026

SOR/STR: SOR 96-60A

Title:   Count By Function Scrolling

Description:

When scrolling in Count By Function, if the scroll bar is clicked-on and dragged using the mouse, the data is not scrolled real-time as the elevator is moved up and down.  All other functions in TAMPS scroll the data real-time as the elevator is moved.

===================================================================

DTR:     D10027

SOR/STR: 6.2 init

Title:   TAMPS Database Offline After Restore

Description:

The TAMPS database was still "off-line" after database restore operation had successfully completed.  Could not login as any user except root.  Fix was to manually bring the database on-line with SQL command, "online database tamps".  The actual restore seemed to work fine.  Not sure why tamps database was still off-line.  New sybase 11 behavior?  Change to restore scripts?

SOT Step 95-43.1

===================================================================

DTR:     D10028

SOR/STR: SOR 95-43

Title:   Move magvar.dat

Description:

move magvar.dat from TAMPS Core to Sysgen COTS, just as dcw browse and jnl data have been moved from Core to COTS

===================================================================

DTR:     D10029

SOR/STR: 6.2 init

Title:   Archive/Restore Buttons Obscured

Description:

In the Archive/Restore window, the table list box partially obscures the Select All and the Deselect All Buttons.

===================================================================

DTR:     D10030

SOR/STR: 6.2 init

Title:   Import/Export Strike Name

Description:

When the Strike Package Import/Export window is opened and either the Import or Export pushbutton is selected, the Strike Name list box shrinks.

===================================================================

DTR:     D10031

SOR/STR: 6.2 init

Title:   Comms Processor Doesn't Start

Description:

When Communications -> Comms Administration is selected, the Comms Processor does not start.  If this functionality has been removed, the menu selections should be removed or grayed out, otherwise it should be fixed.

SOT Step 95-43.1

===================================================================

DTR:     D10032

SOR/STR: 6216

Title:   Geo Filter Create New Geo

Description:

In an MPM, if a new GEO is created which has the same name as a GEO that has already been saved to the database, and then "Save" is selected, no error message is brought up to tell the user to change the name of the GEO.  Also, all the fields in the new GEO window are grayed out, including the name, so the GEO must be recreated.

===================================================================

DTR:     D10033

SOR/STR: 6.2 init

Title:   BAK/GND (background tool)

Description:

The Bak/Gnd widget is not behaving the way it did in 6.1.1. The parent window is hidden whenever Edit is selected on any function that brings up a child window. This makes "Apply" useless on the child windows like Imagery or Grids.

===================================================================

DTR:     D10034

SOR/STR: 6.2 init

Title:   Load CADRG Filenames

Description:

Selected load ADRG in a DBA Module, with a Korea ONC/TPC CADRG CD in drive. Then when clicked on map to select Korea area charts, the pick window came up listing two /cdrom directory paths instead of just ONC and TPC like it did in 6.1.1 and earlier.

SOT Step 95-43.1

===================================================================

DTR:     D10035

SOR/STR: 6216

Title:   Geo Filter Delete Confirmation

Description:

The "Delete GEO Confirmation" dialog box is not descriptive enough.  It asks if you want to "Permanently remove geo?" when in actuality it might just be replacing, overwriting, etc.  The message that the user sees needs to be clearer and more informative as to what action is being taken.

===================================================================

DTR:     D10036

SOR/STR: 6216

Title:   Geo Filter Save Error

Description:

If you edit an existing geo and then try to save a new geo with a name that already exists, no error message pops up telling you that you are trying to save a geo with a name that already exists and to rename it.  The geo is deleted and the entry form is grayed out.  Should have an error message and the opportunity to rename the geo.

===================================================================

DTR:     D10039

SOR/STR: SOR 96-60A

Title:   Count By Data Display Error

Description:

There are several errors occuring in Count-By:

1.  Initial widget width:  I opened Count-By on AIRBASES NAVAIDS WAYPOINTS Layer and WAYPOINTS TERMINAL Bucket.  The Layer and Bucket titles were partially obscured because the widget was too narrow.

2.  When a Bucket with a large number of items (I used one with over 16,000 items) is selected for Count-By and the Column setting is set to NAME, Latitude or Longitude, you cannot scroll up or down in such a way to view all the data items.  If the Up or Down scroll arrows are selected, the data displayed is scrolled up or down more than one page at a time.  The data should be scrolled only a few items at a time when selecting the Up or Down arrows.  Sometimes resizing the widget will fix this problem.

Also, if the mouse pointer is clicked above or below the elevator positional indicator, the data displayed is scrolled up or down several pages at a time.  The data should be scrolled up or down one page at a time when this action is taken.

3.  When the Count-By widget is near the top of the terminal display and one of the lower column items is being displayed, the top Column item is obscured by the WSE bar when the Column Pull-Down Menu is selected.

===================================================================

DTR:     D10040

SOR/STR: SOR-95-43

Title:   F-14 MPM Missing S/W

Description:

F-14 MPM missing modified s/w in f14/src/f14gt subdirectory.

===================================================================

DTR:     D10041

SOR/STR: 6216

Title:   Geo Window Close

Description:

Closing the custom Geo window with the upper left window menu results in multiple copies of all listed geos in the Selectable and Displayed Geo lists.  Deleting one of the copies deletes it normally, but trying to display or delete the remaining copies results in "Selected Geo does not exist" message.  This behavior will be confusing to the user.

===================================================================

DTR:     D10042

SOR/STR: 6216

Title:   Geo Filter Delete

Description:

If the current Geo is deleted using the drop down menu in the custom Geo window, the Current Geo becomes corrupted.  With the custom Geo window still open, the Current Geo field properly reverts to the current op area.  However, when the Geo window is closed, the Current Geo is left in a corrupted state.  If the custom Geo window is re-opened, the Current Geo field will either be blank or filled with special charcters.  Subsequent queries against the database result in no records found because the query bounds are in an indeterminate state.  A new Geo must be created to clear the problem.  This will confuse users because they will not understand why queries are failing.

===================================================================

DTR:     D10043

SOR/STR: 6216

Title:   Default Current Geo

Description:

There is no way to revert the current Geo to the current Op Area.  The current Op Area is not listed in the selectable Geos list the way the old "No Geo" was listed in the old Geo implementation.  This leaves the user no way to revert to the Op Area for query constraints without deleting the current Geo (which does not work and is a separate DTR).  If the current Geo is a Saved Geo, deleting it to revert will also delete it for future use.  The current Op Area should be listed in the Selectable Geos list to allow reverting to it.

===================================================================

DTR:     D10044

SOR/STR: 6216

Title:   Geo Filter Drawing Cancel

Description:

Canceling a Geo creation drawing operation with the right mouse button results in two error messages.  If you cancel after pressing the Geo button on the toolbar, you are asked to confirm deletion of a Geo you have not yet created, and you also get a "unable to create geo" message.  Circle gives two "unable to create geo" messages, and polygon gives something else.  A right mouse button cancel is a cancel and should not require any confirmation actions.  This is inconsistent with the rest of drawing operations in TAMPS.

===================================================================

DTR:     D10047

SOR/STR: SOR 96-60A

Title:   Count-By Motif button crash

Description:

If the motif pull-down is used to close the count-by window, the MPM or DBA module being used will crash.  Query for some objects, select Clutter/Declutter, Highlight a layer and bucket, select Count-By, close with the Motif menu and MPM crashes.

===================================================================

DTR:     D10048

SOR/STR: SOR 96-60a

Title:   Count By Op Area Change

Description:

If a count by window is open, it will crash the first time it is accessed after a change op area.

===================================================================

DTR:     D10049

SOR/STR: SOR 97-12

Title:   Crypto Key Algorithm

Description:

The algorithm is not checking Crypto Keys as expected by the customer. For example, it loads a maintenance key as a valid weekly key.

===================================================================

DTR:     D10050

SOR/STR: SOR 96-10

Title:   NAVSSI_Host Environment Variable

Description:

In DBA when select Update>GPS Almanac> On Line Update, a message comes up stating that "unable to access environmental variable NAVSSI_HOST".  No other windows come up.

===================================================================

DTR:     D10051

SOR/STR: 6.2 init

Title:   Edit Flight Parameters Waypoint Error

Description:

In the A-6E MPM, when a waypoint is highlited and the "Edit

Flight Params" dialog is opened, the wrong waypoint is selected

in the list of waypoints at the top of dialog, but the waypoint # in

the dialog is correct.

===================================================================

DTR:     D10055

SOR/STR: 6.2 init

Title:   Initialization Build has incorrect MPMs

Description:

The initial 6.2 build has the wrong MPMs available.  The "RAAP" and

"Scenario" MPMs should be removed from the delivery.  The "C2A"

MPM should be added to the delivery.  The "A6E" and "BLAM" MPMs

should be delivered for test only.

===================================================================

DTR:     D10056

SOR/STR: 6.2 init

Title:   ACE_Wrappers Makefile does not have correct targets

Description:

The ./tamps/src/contrib/ACE_Wrappers/Makefile does not have the

correct "make" targets. Add "make" targets for std TAMPS

development make scripts.

===================================================================

DTR:     D10057

SOR/STR: 6.2 init

Title:   rootAcces.sh fix

Description:

- rootAccess.sh script fix. Script was hardcoded for /tamps. The

new topdirs should be /Refxxx/tamps62. The script now takes the

TOPDIR as an argument. Script is executed from root crontab.

- Also removed obsolete build scripts from /tamps/bin and checked in new Tamps62 Harvest build scripts; bld62_recovery.csh and

bld62.

===================================================================

DTR:     D10058

SOR/STR: 6216

Title:   Geo Filter Widget Resize

Description:

The Geo Filter widget cannot be resized.  It should be resizable and when resized, the list boxes should be made larger both in length and width.  Currently, if a Geo has a name longer than 26 characters the complete name cannot be viewed since there are no horizontal scroll bars.

===================================================================

DTR:     D10059

SOR/STR: 6216

Title:   Geo Filter Cancel

Description:

When a user selects the Geo Pushbutton or selects Display-> Geo Filter-> Rectangle, Circle, or Polygon and then pushes the right mouse button, the Create Geo function should be canceled.

Instead  a  bogus geo named "CURRENT_GEO" is added to the Selectable Geos list.  If this action is repeated, the error message:  "CURRENT_GEO will be removed (if deleting) or overwritten (if editing).  Continue?" is displayed.  Selecting YES continues with creating a new bogus geo which replaces the other bogus geo.  Selecting NO displays error message:  "Geo with name CURRENT_GEO exists.  Please rename geo with a name other than CURRENT_GEO."  It is obviously impossible to rename the geo since there is no HMI to do so.

===================================================================

DTR:     D10060

SOR/STR: 6216

Title:   DBA and MPM Creating Geos concurrently

Description:

If an MPM user and the DBA are concurrently creating geos and the same name is used for a geo by both, the MPM user is not warned of his/her geo being overwritten by the DBA geo and given the opportunity to rename their geo.  This occurs because the database is not searched for geo name conflicts whenever a new geo is being created.

===================================================================

DTR:     D10061

SOR/STR: 6216

Title:   Geo Filter Menu Logic

Description:

The "Display", "Declutter" and "New Geo" functions are still not

completely correct.

When two or more items are selected from the Selectable Geos list,

and if all items are currently displayed, "Display" should be insensitive

but is actually sensitive.

If two or more items are selected from the Selectable Geos list and all

items are NOT displayed, "Declutter" should be insensitive but is actually

sensitive.

If two or more geos are selected from the Selectable Geos list, user

cannot create a new geo.

This DTR is an extension of DTR D10013.

===================================================================

DTR:     D10062

SOR/STR: SOR 96-10

Title:   Update GPS On-Line Almanac ftp script

Description:

The gps_ftp.dat file needs to be updated to specify the path of the almanac file that is to be downloaded.

===================================================================

DTR:     D10063

SOR/STR: SOR-95-43

Title:   User accounts can't open MPMs

Description:

Due to Solaris 2.5.1 patches, TAMPS users are not able to successfully start MPMs, even with NIS+ at run level 0, due to credentials being created with a non-login password.

===================================================================

DTR:     D10065

SOR/STR: SOR 95-47

Title:   Remove sa password prompt from zet_uadmin

Description:

In build 2, the sybase sa password has been hardcoded, so we need to remove the prompt for the sa password from zet_uadmin.

===================================================================

DTR:     D10066

SOR/STR: 6.2 init

Title:   Comms Applications not building in harvest environment

Description:

The Comms applications are not building correctly under the new harvest environment.

SOT Step 95-43.1

===================================================================

DTR:     D10067

SOR/STR: 6698

Title:   Kneeboard Card Load/Save/ReOrder

Description:

The Load/Save and ReOrder functions do not operate in the new Default Kneeboard Card HMI.

===================================================================

DTR:     D10068

SOR/STR: SOR 96-52

Title:   PC-Card Go/NoGo not implemented.

Description:

The Go/NoGo functionality for PC-Card is not completed.

===================================================================

DTR:     D10069

SOR/STR: SOR 95-47

Title:   grant_privs.csh

Description:

Added grant_privs.csh to make_scripts to support changes in SOR-95-47.

===================================================================

DTR:     D10070

SOR/STR: SOR 95-47

Title:   MPM DD_MPMTABS data

Description:

After loading build 2, opened a non-poly MPM (AH-1W) and input a launch pt then OK out of launch window. Then got messages about cannot perform constant cruise and DD_MPMTABS data not loaded.  Therefore could not plan a basic route in MPM. Tried in F-14D and it worked OK.

===================================================================

DTR:     D10071

SOR/STR: SOR 95-47

Title:   DAFIF data load crashed DBA

Description:

Selected DAFIF to load in DBA utilities and after input date and classification selected Apply and then the DBA module crashed. Can not load DAFIF data. Almanac and MagVar loaded OK from CD.

===================================================================

DTR:     D10072

SOR/STR: SOR 95-47

Title:   Add User account errors

Description:

In the User Admin after creating an account "whale" , I attempted to create another with username "whale2" and received a message user ID already exists. I exited the User Admin tool and opened it again and then could create the "whale2" account

===================================================================

DTR:     D10073

SOR/STR: SOR 95-47

Title:   Data Removal tool not starting

Description:

In DBA when select utilities Data removal nothing happens. The next window does not come up.

===================================================================

DTR:     D10074

SOR/STR: SOR 95-47

Title:   Object Server connect problems

Description:

After starting a DBA, loaded magvar, almanac& DAFIF, then try to open an MPM it just brings up the application info window. The mpm process is running when checked in a shell. If the ost_server is killed using kill -9 then the MPM window comes up. The ost_server can then be restarted using the startup scripts. The other option is to reboot the system after using a DBA Module.

===================================================================

DTR:     D10075

SOR/STR: SOR 96-01

Title:   Updte Map Catalog

Description:

After loading build 2 and selecting the preserve maps option, I attempted to use the update maps catalog function to update some preserved DTED data. The following msg was displayed: "dnt_mapCatalogApplyCb cannot open dted directory".

===================================================================

DTR:     D10076

SOR/STR: SOR 95-43

Title:   Update Sysgen for Build 3

Description:

Incorporate Sysgen updates required for Build 3, including COTS updates, MPLAN support and MIDB updates

===================================================================

DTR:     D10077

SOR/STR: SOR 96-01

Title:   No Default MPM

Description:

Default MPMs are not being saved correctly with user accounts.  Default MPMs do not launch when the user logs into the system.  It appears that the .tamps.default_mpm file in the home directory is not being written to correctly.

===================================================================

DTR:     D10078

SOR/STR: SOR 96-01

Title:   NITF Imagery Load

Description:

When several NITF images are selected from an 8 mm tape for load, only the first image gets an entry in the sybase imagery table.  All other image files are being loaded to the maps directory, but can not be accessed through the background tool.

===================================================================

DTR:     D10079

SOR/STR: SOR 96-01

Title:   Can't Display Unrectified Imagery

Description:

Unrectified NITF images can not be displayed.  When an unrectified image entry is selected in the background tool, and OK is selected, nothing happens.

===================================================================

DTR:     D10080

SOR/STR: 6.2 init

Title:   sysgen_initialization (.files)

Description:

sysgen_initialization was created for the initial load of the Sysgen

baseline into the Harvest CM system. Harvest does not support

baseline load of ".", or hidden, files. Currently, the only method of

entering "." files is to check them in recursively, which requires a

package.

===================================================================

DTR:     D10081

SOR/STR: 6.2 Init

Title:   Audit Log empty

Description:

Turned audit function on and selected all event types. Rebooted system and then ran for over an hour. There were log files in /var/audit, about one every two hours, and /var/audit was up to about 10% full. When select Review Audit logs and select Primary file, get a message "No records in audit log.".

===================================================================

DTR:     D10082

SOR/STR: 6.2 Init

Title:   Audit Admin defaults

Description:

The audit admin function is now defaulted to ON vice OFF as it was in 6.1.1.

===================================================================

DTR:     D10083

SOR/STR: 6.2 Init

Title:   SIT_Default_Defines Mismatch

Description:

The standard menu items in the sit_default_defines header file are not the same as the standard menu items in the SIT_DEFAULT_DEFINES Ada binding.

===================================================================

DTR:     D10084

SOR/STR: 6698

Title:   New Kneeboard Card

Description:

When open the new kneeboard card output>route kneeboard card> kneeboard card,  the window is coming up under the wse bar. Reposition the widget so that it does not under the wse.

===================================================================

DTR:     D10085

SOR/STR: SOR 96-01

Title:   E2C MPM symbol sets

Description:

The E2C symbols are not coming up in the MPM. Even when selected via the Display> Change Symbology function. It looks like symbol set is loaded in the appropriate /tamps/static/.... dir but something not setting the objects correctly. Note! The F14 symbols work OK

===================================================================

DTR:     D10086

SOR/STR: E2C

Title:   E2C EMDU Save Crashes

Description:

In E2C MPM when tried to save an EMDU file the MPM crashed.

===================================================================

DTR:     D10087

SOR/STR: 6216

Title:   Deleting  GEO's crashes the module

Description:

When you select two or more GEO's to be deleted in the GEO Filter and then the confirmation window is displayed and you select Yes or No, the DBA Module/Aircraft MPM's will crash.   The GEO's are deleted.

===================================================================

DTR:     D10088

SOR/STR: SOR 96-01

Title:   Periodic query crashes module

Description:

DBA Module/Aircraft MPM's select -> Display -> Query for an object -> and then in  Clutter/Declutter -> highlight Layers -> highlight Buckets: select Periodic and set the time and then select Color By or Count By in Clutter/Declutter and this will crash the modules. This did not crash in build 1A.

===================================================================

DTR:     D10089

SOR/STR: 6698

Title:   Report threat assessment crash

Description:

Aircraft MPM's Select File -> Create New or old Msn -> Route -> Launch/Recovery and create the msn . Select Output -> Rpts -> Aircrew -> Threat Assessment and then select create and the Aircraft MPM's will crash.

===================================================================

DTR:     D10090

SOR/STR: E2C

Title:   E2C TID not Initializing

Description:

In E2C selected Output>TID Processing and get message "Unable to initialize TID."  In errors log it shows "Device invalid".

===================================================================

DTR:     D10091

SOR/STR: SOR 95-47

Title:   Strike Package not Saving

Description:

Could not save a Strike package. Get error msg "The strike package was not saved properly."

===================================================================

DTR:     D10092

SOR/STR: 6.2 Init

Title:   Line of Sight function not working

Description:

The line of sight tool under Weaponeering>Radar Prediction is not working. After inputting the data in  the Line of Sight window and Apply or OK, get a msg "Error generating Field of View. See System Log for details." In the Workstation log it just says Error performing LOS calculations for Field of View.

===================================================================

DTR:     D10093

SOR/STR: 6698

Title:   Reports New KCARD

Description:

Aircraft MPM's -> File -> create new msn or use old msn -> Route -> Launch/Recovery and create the new msn -> select Output -> Reports -> Aircrew -> Platform Performance Rpt -> and then if you try to select Kneeboard Card (KCARD)  it will not display.   You have to close out the Aircraft MPM and then reopen the Aircraft MPM and reselect the msn to select the KCARD.

===================================================================

DTR:     D10094

SOR/STR: 6698

Title:   Report New KCARD output to printer

Description:

Aircraft MPM's -> Output -> Reports -> Aircrew -> Kneeboard Card (KCARD) -> the KCARD is displayed -> select output -> the only msg that is displayed is:Route Kneeboard Card has been sent to the printer.   This process just sent the Kneeboard Card to the printer.   Where is the Output Printer Data Window?

===================================================================

DTR:     D10096

SOR/STR: 3660

Title:   DBA Crash Loading NITF

Description:

The DBA Module crashes after completing the load of ADRI or NITF from 8 mm.

STR 3660 Failure.

===================================================================

DTR:     D10097

SOR/STR: 6214

Title:   No Default in Launch Details Dialog

Description:

STR 6214 asked for a default button as part of the rework for the Launch Details dialog, but this was not implemented.

STR 6214 Failure

===================================================================

DTR:     D10098

SOR/STR: SOR 96-01

Title:   Typographical problem in sit_default_defines.h

Description:

In sit_default_defines.h, the constants MPM_SETUP_DEFAULTS_SCENARIOS_BUTTON and

MPM_SETUP_DEFAULTS_SCENARIOS_CALLBACK are both #defined as (FILE_TOTAL+24).  MPM_SETUP_DEFAULTS_SCENARIOS_CALLBACK

should be defined as (FILE_TOTAL+25).

===================================================================

DTR:     D10099

SOR/STR: SOR 96-01

Title:   Ada Binding Not Synchronized With C Header File

Description:

The Ada binding file sit_default_defines.a does not align with the C header file

sit_default_defines.h.  The misalignment is causing segmentation violations

in the Ada MPMs.

===================================================================

DTR:     D10100

SOR/STR: SOR 96-52M

Title:   PC Card Declassify (pcscrub utility)

Description:

When an attempt is made to declassify a PC card in either slot using the pcscrub utility, the card appears to be declassified since no error message is displayed after the utility finishes.  When you try accessing the card after scrubbing it using pcls, pcdf or any other utility besides pcformat, get error message "error = 0x011".  After reformatting the card, it works ok.

===================================================================

DTR:     D10101

SOR/STR: SOR 96-52M

Title:   PC Card Format

Description:

Sometimes when formatting a PC card when there is a card in both slots, the formatting process will either fail and provide an error message or freeze up.  When the process freezes up, you cannot kill the process with the Sys Admin Process Manager, from the shell with kill -9, or by logging out.  The only way to kill the frozen format process is to reboot the system.  This happens on an intermittent basis.

===================================================================

DTR:     D10102

SOR/STR: SOR 96-52M

Title:   PC card Format Failure

Description:

If a PC card format process fails, the files that were on the card are garbled but the directory still indicates that there are valid files on the card by listing the file names.

===================================================================

DTR:     D10103

SOR/STR: SOR 96-52M

Title:   PC Card File Copy

Description:

If you attempt to copy a file to a PC card which does not have enough free space to receive the file, the utility pccp will start writing the file to the card but will display an error message when the card gets full.  (Could be a pccp utility problem.)

===================================================================

DTR:     D10104

SOR/STR: 6.2 init

Title:   Audit log fills up with no warnings

Description:

In audit admin I turned auditting on and selected all events. At COB Thurs /var/audit was at about 50%.  After a long weekend, I logged in Monday and there was a message in console about "error softlimit". Checked /var/audit and it was at 99%, the only alerts were green ones related to new audit files. This was fixed in 6.1.1 under STR 6709. Maybe the new COTS or sysgen broke it. Note! This was on "wisconson" with the patch from Rob to get audit to work.

SOT Step 95-43.1

===================================================================

DTR:     D10105

SOR/STR: 6.2 init

Title:   Saving FAMP data is not working for planner

Description:

As user planner selected from the WSE_BAR -> Mission Planning -> Weapons -> FAMP: File New Msn -> Route -> UMPM and entered selected data and then selected DELTAC and entered data.   Tried to save msn and could not save msn as planner.   The workstation log:INSERT Permission denied on object DELTAC_MISSION_PLAN, databsae tamps, owner dbo.

SOT Step 95-43.1

Note! Problem occurs when logged in using an account with MPM role only.

===================================================================

DTR:     D10106

SOR/STR: 6.2 init

Title:   Reports crash

Description:

Aircraft MPM -> File new msn or old msn -> Output -> Reports -> Aircrew -> and by selecting the Load and Drop Report where data is displayed in window or not and then close the Load and Drop Report, and then by selecting the kneeboard Card this will crash the Aircraft MPM.

SOT Step 95-43.1

===================================================================

DTR:     D10107

SOR/STR: SOR 96-10

Title:   SIPRNET Login Failed

Description:

In test lab set up one of the Ultras to emulate the SIPRNET. I could ping siprnet and when bring up the On-Line Update window it shows SIPRNET as being up. However, when select Download Almanac it gives an error message saying the download failed. In errors log it looks like it is looking for a USER and PASS for the login.

===================================================================

DTR:     D10108

SOR/STR: 6.2 init

Title:   Chart Removal

Description:

Can not remove a chart from the system. Installed an ADRG ONC chart for an area that didn't have any charts loaded.  All indications in the data removal dialog box indicated that the chart was removed.  After this, the chart could still be displayed and all data remained intact in the /maps/1 directory.

===================================================================

DTR:     D10109

SOR/STR: 6.2 init

Title:   GO/NO GO

Description:

GO/NO GO tests currently in 6.2 build 2 is from the DTC (150 MB tape and 5 1/4 inch floppy Disk Drive, etc) and not for the Ultra-2.

===================================================================

DTR:     D10110

SOR/STR: SOR 96-10

Title:   GPS Almanac Update, No Delete

Description:

In a DBA selected Update>GPS Almanac> Manual Update and  attempted to delete an old almanac file. Kept getting  Warning that "cannot delete last week from almanac". I had three weeks loaded at the time, weeks 154, 161, and 162. Attempting to delete any of them gave the same results.

===================================================================

DTR:     D10111

SOR/STR: SOR 95-47

Title:   Two complete loads of DAFIF.

Description:

Tried to load  two complete Versions of DAFIF, and received the following msg:Can't allocate space for objects in the database 'DAFIF_GPS' because the 'default' segment is full.

===================================================================

DTR:     D10112

SOR/STR: SOR 95-47

Title:   DAFIF Update Delete not working and crashes DBA Module.

Description:

DBA module -> Update -> DAFIF Tear-off Window:Select/Delete -> and the DAFIF Version Window for Selection and Deletion option is displayed.    Then by selecting delete and selecting apply or ok crashes the DBA Module and does not delete the DAFIF Version.   The Workstation Log had the following msg:DB-Library error

Maximum number of DBPROCESSes already allocated.

ddt_mmi Terminated by System Fault 65280.

===================================================================

DTR:     D10113

SOR/STR: SOR 95-47

Title:   One time DAFIF/GPS window

Description:

DBA Module -> Output -> Database Usage Tear-off Window -> Databases -> DAFIF/GPS: Confirm Operation Window -> OK the DAFIF/GPS window is only displayed one time and if you try to query for it a second time the tamps database window is displayed.   You have to close out the DBA Module and reopen the DBA Module again and reselect the DAFIF/GPS Usage tool.

===================================================================

DTR:     D10115

SOR/STR: SOR 95-43

Title:   Dynamic Menu Stability Issue

Description:

Public function sit_init allocates a dynamic menu table of predefined length.  It returns a pointer to this table, after storing a copy in a global variable, SIT_table.   The Ada MPMs take the table  pointer and pass it to umt_ResizeTable.  This function allocates a new (larger) table, copies the old table to the new one, then frees the old one.  It then returns the pointer to the new table.  But freeing the old pointer wipes out the memory to which the global variable SIT_table points.  The problem is that sit_ungrayTemp, which is called by mpt_initialExposeCB, tries to manipulate widgets from the contents of SIT_table.  Since Ada code executed subsequent to the call to umt_ResizeTable may have overwritten that "free" memory, the MPM crashes with a segmentation violation.

===================================================================

DTR:     D10116

SOR/STR: SOR 95-43

Title:   Ada Package Unsigned Enhancement

Description:

The introduction of package BASE_TYPES as the basis for definitions of pointer types in package UNSIGNED has effecively masked the equality operators for those data types.  Types so affected are SHORT_INTEGER_PTR, SHORT_INTEGER_PTR2, SHORT_INTEGER_PTR3, INTEGER_PTR, INTEGER_PTR2, INTEGER_PTR3, FLOAT_PTR, FLOAT_PTR2, FLOAT_PTR3, SHORT_FLOAT_PTR, SHORT_FLOAT_PTR2, and SHORT_FLOAT_PTR3.  The equality operators need to be declared locally as renames of the equivalent BASE_TYPES operators in order to have them visible as members of UNSIGNED.

===================================================================

DTR:     D10117

SOR/STR: 6216

Title:   Multiple Geo Delete

Description:

If the DBA attempts to delete 2 or more Geos at the same time, ddt_mmi crashes.

===================================================================

DTR:     D10118

SOR/STR: 6216

Title:   Current Geo Setting

Description:

When a new Geo is created by the DBA or an MPM user, it becomes the current Geo.  When the newly created Geo is selected from the Selectable Geos list and "New Geo" option menu is selected, "Current" is sensitive but should not be.

===================================================================

DTR:     D10119

SOR/STR: 6216

Title:   Geo Name Matching

Description:

In an MPM or DBA, create a new Corridor or Polygon Geo and choose a name that exists in the DB.  When trying to save, get a warning to rename but if you rename and attempt a save to DB, another warning is displayed about selecting points from the map.  This means you have to start over and can't use the points already chosen.  This also applies if you try to rename an existing Corridor or Polygon Geo.

===================================================================

DTR:     D10120

SOR/STR: 6216

Title:   Create Geo cancel

Description:

If you try to create a geo using the toolbar icon or from the Display pull-down menu and then try to create another one using the same method, get Delete confirmation warning.  If you select No, get error message:  "Geo with name CURRENT_GEO exists.  Please rename..."  This message should not be displayed after cancelling the create.

===================================================================

DTR:     D10123

SOR/STR: 6216

Title:   Geo Edit

Description:

When editing a planner Geo from the DBA, system allows the DBA to save a Geo with the same name since a "*" is placed before the name.  This causes problems displaying, etc.

===================================================================

DTR:     D10124

SOR/STR: 6216

Title:   Deleting Geos

Description:

When deleting a geo, the functionality is correct but the messages are confusing.  The following messages are displayed:

a)  if the Geo is not displayed or is displayed but not current, get the Delete Geo Confirm dialog box and the Geo Filter Delete box at same time.  Should not get the Geo Filter Delete box unless YES is selected.

b)  if Geo is displayed and current, get Delete Geo Confirmation dialog box and Message window saying Selected Geo does not exist.  Should not get the Message window at all.

===================================================================

DTR:     D10125

SOR/STR: SOR 96-60A

Title:   Count By Function window coupling

Description:

In count By Function, if you select an item in the middle of the list box , hold down the shift key, and select an item of lower value, all items are highlighted in between the two both on the map and in the list box.  If you hold down the shift key and select an item of higher value than the first item selected, without deselecting the other highlighted items, all items between the first item selected and the high value item are highlighted on the map.  However, all items between the lowest value and highest value selected are highlighted in the Count By window list box.

===================================================================

DTR:     D10126

SOR/STR: 6216

Title:   Multiple Geo select/Display

Description:

If more than one Geo is selected from the Geo list box, then display is selected from the option menu, none of the non-displayed Geos selected will be displayed if the top Geo in the selected list is already displayed.

===================================================================

DTR:     D10127

SOR/STR: SOR 96-60A

Title:   Count By Function Window Migration

Description:

In Count By Function, if the window is the minimum width possible, an attempt to decrease the width by dragging the left side toward the right side moves the window to the right a small amount.

===================================================================

DTR:     D10128

SOR/STR: 6216

Title:   Create Geo Blank Field

Description:

If you leave a field blank while manually creating a rectangle or circle Geo, the blank field will be automatically filled in with zeros.  If you try to perform a query using this Geo, nothing is returned.  If you edit the Geo and put in a new value for the zeroed field, there is still no return from a query.

===================================================================

DTR:     D10129

SOR/STR: 6216

Title:   Geo Lat/Long Error

Description:

If you inadvertantly exchange the North and South Latitudes or the East and West Longitudes when manually creating a rectangle Geo, the Geo will appear to be drawn correctly using the North-most entered latitude on top and the west-most entered longitude on the left side and so forth.  If you use this geo to perform a query, nothing is returned.

===================================================================

DTR:     D10130

SOR/STR: 6216

Title:   Geo  Circle Blank Radius

Description:

If you manually create a circle but leave the radius blank, get a warning to please specify value for field Circle Radius but the input fields are insensitive preventing any entry.

===================================================================

DTR:     D10131

SOR/STR: 6.2 init

Title:   C2A MPM not in Build 2

Description:

Need to add C2A MPM to CD for Build 3.

===================================================================

DTR:     D10133

SOR/STR: 6698

Title:   KCard, missing Mission Name

Description:

The new Kneeboard card in build 2 does not print out the mission name in top left corner like the example provided in the design notebook shows.

===================================================================

DTR:     D10134

SOR/STR: 6698

Title:   KCard Flight Levels wrong

Description:

In the new KCard the altitude MSL is showing up as FL24000 when it should be either 24000M or FL240.

===================================================================

DTR:     D10135

SOR/STR: 6698

Title:   KCard, Missing Date

Description:

The new kneeboard card does not print out the date in the top left block like shown in example.

===================================================================

DTR:     D10136

SOR/STR: 6698

Title:   KCard, leg time is showing 00

Description:

Sometimes the new Kcard shows leg times equal to 00+00+00.

===================================================================

DTR:     D10137

SOR/STR: 6698

Title:   KCard Default data format wrong

Description:

The new KCard does not have the default data in the columns like the example provided by VX-9.

===================================================================

DTR:     D10138

SOR/STR: 6698

Title:   KCard, default font

Description:

Change default font size to Courier 10, per VX-9.

===================================================================

DTR:     D10139

SOR/STR: 6698

Title:   KCard UTM Coords

Description:

In the kneeboard card the UTM coordinates do not appear to be the correct format.

===================================================================

DTR:     D10140

SOR/STR: SOR 97-10

Title:   Missing DD_VALID_THREAT_TYPES table

Description:

There were two new files delivered in Build 2 to support the dft_get_order_of_battle function:

dd_valid_threat_types_create.sql and  dd_valid_threat_types_insert.sql.

These files were not added to the Install_datadict.csh file and therefore NEVER get installed on the target system.  Install_datadict.csh needs to be modified to install these files.

There is also a problem with the insert file.  It still uses the IDB table and field names.  It needs to be modified to reflect the new MIDB table and field names.

The affected directory is ../src/dbinstall/data_dict.

===================================================================

DTR:     D10141

SOR/STR: SOR 96-52M

Title:   upl_Seek problem

Description:

After creating a one megabyte file and then seeking to (one megabyte - 2) bytes, a subsequent two byte write appears at the wrong offset within the file.

===================================================================

DTR:     D10142

SOR/STR: SOR 96-68

Title:   bat library source code cleanup

Description:

BAT functionality was removed under SOR-96-68, however,

the code itself was not marked deleted under harvest version

control. This code should not get synched out since it is not being

built.

===================================================================

DTR:     D10143

SOR/STR: SOR 95-43

Title:   mwm crashes

Description:

mwm crashes after a full system modal application is run, and the user moves another window and attempts to update the map display with query results.  Reading the MPM header file while loading MPMs also causes mwm to crash.

===================================================================

DTR:     D10146

SOR/STR: 6698

Title:   KCard Text Overwrites data

Description:

In the new Kneeboard card, when a long text string is entered for a nav point description it overwrites other data on that nav pt line.

===================================================================

DTR:     D10148

SOR/STR: 6755

Title:   Autosave Message Box for Route Validation

Description:

If Route Validation is disabled and Autosave is enabled, a message

box comes up for each autosave asking the user if they want to

validate the route before saving.  This message box should be

eliminated to keep the autosave operation transparent to the user.

===================================================================

DTR:     D10150

SOR/STR: 6755

Title:   Bitmaps for Route Validation Toolbar Button

Description:

There is no icon for the route validation pushbutton.

===================================================================

DTR:     D10151

SOR/STR: SOR 96-10

Title:   On-Line GPS/Automatic Update

Description:

The fix for DTR 10050 was not implemented in the stand-alone executable (dpl_downloadGPSAlmanac) which performs the Automatic/Scheduled GPS download.  Specifically, dpl_downloadGPSAlmanac looks for  the NAVSSI_Host and SIPRNET_Host environment variables.

===================================================================

DTR:     D10152

SOR/STR: SOR 96-52M

Title:   PC Card Formatting with Cylinder, Head and Sector Information and Quick Format

Description:

After providing a formatted PC Card to TAMMAC it was determined that Cylinder, Head and Sector information must be included in the formatting partition definition in order for the TAMMAC system to use the PC Cards.  Discussions between the TAMPS IPT and TAMMAC resulted in agreement to add this capability to 96-52M in build 3.  It also was decided that a switch would be implemented in the format command to turn off read after write data integrity checking for high capacity TAMMAC map theater cards.

===================================================================

DTR:     D10155

SOR/STR: SOR 97-10

Title:   Failure to Close Sybase Connection

Description:

The tet_getMapFilenames interface failed on the 26th call made to it.  A message saying unable to connect to Sybase server was given.  Discussions with Chuck Ruby determined that previous connections were not being closed.  Sybase limit is 25 open connections.

===================================================================

DTR:     D10170

SOR/STR: D10076

Title:   Implement fixes required for 6.2 Build 3A

Description:

add fixes required to support MPLAN in Build 3A

SOT Step 95-43.1

===================================================================

DTR:     D10171

SOR/STR: SOR-95-47

Title:   Mission Xfer

Description:

MPM's request the ability to save the original planner name to missions being transferred vice having the planner name switched to the person who had initiated the mission transfer.

===================================================================

DTR:     D10181

SOR/STR: SOR 96-01

Title:   NIS+ cache needs refreshing after user add or delete

Description:

After a user is added or deleted using the TAMPS user administration

HMI, the update is not immediately visible to applications that use

getpwuid() or getpwnam() to get user information.

Many instances of this error were worked around with DTR 10072 (during

testing of which this problem was discovered), but the problem has still

been observed.

The problem is most visible when trying to re-create a user that was

previously removed from the system.  One way that might reproduce the

problem is to delete a user; add a different user (to reuse the old user's

UID); then re-add the first user.  Try this within one zet_uadmin run, or

restarting zet_uadmin before re-adding the user.

It was also noticed that "~user" continued to refer to a directory for

some time after a user was deleted with zet_uadmin (although the

directory no longer existed); it should say "unknown user".  This seems

to be related to this problem.

The best way to fix this would probably be to find some way to force

NIS+ (or the getpwuid library) to rebuild its cache; this could be done

within the zet_adduser.sh, zet_moduser.sh and zet_deluser.sh scripts,

or in the code after the scripts have exited.

===================================================================

DTR:     D10197

SOR/STR: SOR 95-47

Title:   DAFIF transaction stored procedures corrupted.

Description:

The stored procedures for performing DAFIF transaction loading have been corrupted.  The database name prefix was duplicated, causing the insert of the stored procedure.

===================================================================

DTR:     D10198

SOR/STR: SOR 95-47

Title:   DTED Load/Display errors

Description:

The manual option is greyed out for DTED load.

Cannot Display DTED after it is loaded

===================================================================

DTR:     D10199

SOR/STR: 6.2 Init

Title:   DOD Banner Not in Center

Description:

The DOD banner sometimes comes up in the upper left corner of the display vice the center.

===================================================================

DTR:     D10200

SOR/STR: SOR 95-47

Title:   Cannot change TAMPS password

Description:

Using the User Admin function the TAMPS password cannot be changed. SA must change it in a shell .

Note! Other problems besides just TAMPS password.

root password mod is difficult

any tamps user password change makes that account unusable

no checking between credential and login password creates good chance for

an unusable account

etc.

D10528i also related

===================================================================

DTR:     D10201

SOR/STR: 6.2 Init

Title:   Cannot Communicate with the MU

Description:

After loading a standalone system that had both a DSUR & MDLR attached, using MU/MDL utilities I could not view device info for the MU. The MDL worked OK but the MU kept getting "Error opening device".  After a shutdown and boot -r, I could check MU fine.

SOT Step 95-43.1

===================================================================

DTR:     D10202

SOR/STR: SOR 95-47

Title:   Could not save and reopen a Strike package

Description:

Created a F14 and E2C missions and saved them in a strike package. The strike saved without errors but when selected Strike Open nothing was listed in the window.

===================================================================

DTR:     D10203

SOR/STR: SOR 95-47

Title:   No Warning on Client Connect

Description:

When connecting a client workstation to a server system, no warning is

provided to the user if an unavailable IP address is used.  The user should be

warned and given a chance to change it prior to connecting.

===================================================================

DTR:     D10204

SOR/STR: SOR 95-47

Title:   Client / Server Coverage Tools

Description:

On a client system:  Prior to selecting the server coverage tool, the client

coverage tool correctly displays the data loaded on the client.  However,

once the server coverage tool has been displayed, the coverage tools

display the server data, regardless of whether client or server is selected.

===================================================================

DTR:     D10205

SOR/STR: SOR 95-47

Title:   DBA Crash with DCW Load

Description:

Attempting to load DCW from the client of a client / server system causes the

DBA module on the client to crash.  It appears that the data is loaded to the

server database successfully before crashing,

===================================================================

DTR:     D10206

SOR/STR: SOR 95-47

Title:   DCW Display on Client

Description:

DCW loaded in the server database can not be displayed on the client.  The coverage tool shows no data loaded and DCW features do not appear when zooming in to a DCW area.

===================================================================

DTR:     D10207

SOR/STR: SOR 95-47

Title:   CIB Display on Client / Server

Description:

CIB imagery loaded to the server database from the client workstation can not

be displayed on the client or the server.  The images appear in the coverage

tool on both systems, but do not appear in the background imagery select

tool on the client.

===================================================================

DTR:     D10208

SOR/STR: SOR 95-47

Title:   CADRG Display on Client / Server

Description:

CADRG and ADRG charts loaded to the server database from the client

workstation can not be displayed on the client or the server.  The charts

appear in the coverage tool on both systems, but do not display when

selected from the background tool.  Charts loaded to the server database

from the server station can only be displayed on the server.

===================================================================

DTR:     D10209

SOR/STR: SOR 95-47

Title:   DAFIF Display on Client / Server

Description:

DAFIF loaded to the server database from the client workstation can not be

accessed by either the client or the server.  DAFIF loaded using the server

station can be accessed by both stations.

===================================================================

DTR:     D10210

SOR/STR: 6697

Title:   Printer Error in Console Window

Description:

Console window displayed the following error: Device Busy Can't open  /var/spool/Xerox/xpxx/_dev_bpp0/number.  This happens when you use screen grab and strip Charts.   To get rid of the msg in the console window I had to do a reboot, because if not the msg  repeated over and over again.   Have not checked any all of the print functions.

===================================================================

DTR:     D10211

SOR/STR: SOR 96-01

Title:   MIDB Editors do not support deleting data

Description:

The MIDB production editors (which are GOTS) do not support deleting MIDB

records.  TAMPS has requirements to be able to delete (or to mark as

deleted) GMI and DBA target records.

96-01 SOF statements:

3.2.3.5.6      The GMI Editor CSC shall provide the ability to delete data.

3.2.4.3.4.1   The Target Editor CSC shall allow the DBA to delete any planner

or DBA created targets.

===================================================================

DTR:     D10212

SOR/STR: SOR 96-01a

Title:   Help updates required for Planner Target HMI

Description:

The help information for the Planner Target HMI needs to be updated for

the new HMI.

===================================================================

DTR:     D10213

SOR/STR: SOR 96-01a

Title:   Help updates required for scenario HMI

Description:

===================================================================

DTR:     D10214

SOR/STR: 6755

Title:   Help updates required for Selectable Route Validation

Description:

===================================================================

DTR:     D10215

SOR/STR: SOR 96-01a

Title:   Help updates required for OOB Query HMI

Description:

===================================================================

DTR:     D10216

SOR/STR: SOR 96-01

Title:   Archive/Restore Effective dates

Description:

The effective date and classification are greyed out in the Archive/Restore Window when you select databases to archive to media (8MM tape or 3.5 disk).

Process:DBA Module -> Util -> Archive/Restore -> Archive/Restore Window.

Gary from TRW said,  this is by design.    The window before this 6.2 B3 was not grayed out.

The Restore option has the effective date and classification not grayed out.

The Dump/Restore has no date or classifcation widget.

===================================================================

DTR:     D10217

SOR/STR: SOR 95-47

Title:   DBA - Database Usage, NID

Description:

When you select NID from the Database Usage tamps datasets, the query will return the whole data for tamps and at the bottom of the window the total is as follows:(NID Total).

Process:DBA -> Output -> Database Usage -> tamps Datasets -> NID.

Before it would just bring the NID data tables.

===================================================================

DTR:     D10218

SOR/STR: SOR 95-47

Title:   Ready to Reboot Confirmation

Description:

If an invalid client IP address is entered in the Connect to MPLAN window,

an error message is correctly displayed, but the "Ready to Reboot

Workstation" confirmation dialog is displayed on top of it.  The confirmation

dialog should not appear if an error is detected.

===================================================================

DTR:     D10219

SOR/STR: SOR 95-47

Title:   Connect with Different Subnet

Description:

If a client is connected using an IP address subnet that is different than the

server, the client gets hung up in the reboot process and the system must

be reloaded to recover.

===================================================================

DTR:     D10220

SOR/STR: SOR 95-47

Title:   Rename Accounts

Description:

An error message is displayed when trying to rename conflicting user

accounts during a client connect.

===================================================================

DTR:     D10221

SOR/STR: SOR 95-47

Title:   User Initialization HMI

Description:

After connecting a client to the server and logging in, the User

Initialization HMI appears in the upper left corner of the screen, and

without a motif border.

===================================================================

DTR:     D10222

SOR/STR: SOR 95-47

Title:   New Password for Client User

Description:

After connecting a client workstation, I entered and re-entered a new

password in the User Initialization HMI and then tried to log back in to that

account using the new password, but couldn't.  The password for the account

had not been updated.

===================================================================

DTR:     D10223

SOR/STR: SOR 95-47

Title:   Conflicting Accounts

Description:

Deleting conflicting user accounts does not appear to work properly.  I

selected Close in the Conflicting User Accounts HMI and then OK in the Delete

Conflicting Users dialog, but each time I logged back in with a DBA/SA

account, the Conflicting User Accounts HMI appeared with the same

conflicting accounts listed.

===================================================================

DTR:     D10226

SOR/STR: SOR 95-47

Title:   Not Updating Reports Database Catalog after Dump/Restore.

Description:

1. The Dump/Restore is not updating the Reports Database Catalog.   The databases that are not updating are:GMI, NID and DAFIF_GPS.  The DAFIF_GPS was not updated in the DAFIF Version Windows.

2. The loader window:DBA -> Util -> Load of tamps did update the the Reports Database Catalog for MIDB Baseload and NID.   Used the Data Removal Tool to remove the NID from the Reports Database Catalog, and it did remove.   Could not Remove MIDB Baseload with the Data Removal Tool.

3. Stand alone systems.

===================================================================

DTR:     D10228

SOR/STR: 6698

Title:   Kneeboard Card Lattitude Format

Description:

If change default units to DD:MM:SSH and printout a Kcard, it puts a space between the first and second digit of the lattitude. When using the defualt units of HDD:MM:SS the printout looks OK.

===================================================================

DTR:     D10229

SOR/STR: SOR 95-47

Title:   Cannot update NIS+ Host Table with new hostname

Description:

The NIS+ Host Table cannot be updated successfully.  To update the table successfully, you must add an entry with an identical Hostname and Alias first and then can add other Aliases for this Hostname.  When you try to add an entry using the WSE LAN Admin tool, the identical Hostname and Alias entry is created ok but when you try to add Aliases for this Hostname, get an error about duplicate Hostname and the entry is not put into the Table.

===================================================================

DTR:     D10230

SOR/STR: 6699

Title:   Kneeboard Card Reorder Function

Description:

If the Re-Order function is used to add data to the "Blank" column on the left side, there is no room for the extra data in the printout so it tries to print between the page 1& page 2 sections but overwrites some data. If data is added to the blank columns on the right side it is just not printed out, since the right side is already at the edge. Since there is no longer a selection for font size, there is no way to add additional columns and get it to printout in a readable format.

===================================================================

DTR:     D10231

SOR/STR: 6496

Title:   Audit Log Open

Description:

To attempt to fix the crash on open problem a limit of 50K records was imposed on primary file open in the audit logs. After only ten minutes with all audit events turned on I opened the log and received the message "maximum number of audit records (50000) reached. ...." Then it tells the SA to either use the date option or change a ZZT_MAX_NUM... environment variable. After acknowledging the message the log did open but contained only the oldest 50k worth of records, less than three minutes of data. This is an unsatisfactory solution to the problem of crashing on opening a large log. Although the audit functions are only available to a SA user, I doubt many in the Fleet will know how to change an environment variable and this message needs to changed.The logs in /var/audit at this time were only about 10MB total.

===================================================================

DTR:     D10232

SOR/STR: 6755

Title:   Invisible message when adding route points

Description:

When adding points to a route, route validation off, a message window flashes up and then dissapears before it can be read. Don't know what it says but this is annoying.

===================================================================

DTR:     D10234

SOR/STR: 6699

Title:   Course True Missing From Kneeboard Card Re-Order List

Description:

"Course True" should be one of the data items available in the selection list in the kneeboard card re-order window

===================================================================

DTR:     D10235

SOR/STR: 6698

Title:   Field Width For Elevation Is Too Small In Kneeboard Card

Description:

The field with for elevation is too narrow in the kneeboard card, resulting in in overrunning into the field next to it.  This cause the data next to it in the kneeboard card to be difficult or impossible to read.

===================================================================

DTR:     D10236

SOR/STR: 6699

Title:   Attempting To Load A Non-Kneeboard Card File Crashes The MPM

Description:

If Load File is selected from the Kneeboard Card window, and a file is selected from another directory that is not a kneeboard card file (*.RKC), the MPM crashes.  The user should not be allowed to select anything other than route kneeboard card (.RKC) files.

===================================================================

DTR:     D10239

SOR/STR: 6698

Title:   Target Data Items Blank in Kneeboard Card

Description:

If the CRS TGT, DIST TGT, or TIME TGT data items are placed in the kneeboard card, they are displayed blank even with an attack target flight event as part of the route.  These data items should display the course, distance, and time direct to the defined target from the turnpoint.

===================================================================

DTR:     D10240

SOR/STR: 6697

Title:   Doghouse Component Editor Current/Next Off By One Turn Point

Description:

When "Current Point" is selected in the component data editor for a data item, you get next point information.  When "Next Point" is selected, you get next-next (two points subsequent) information.  The current point info needs to be for the waypoint adjacent to the doghouse, and the next point info needs to be for the point subsequent to the point adjacent to the doghouse.

===================================================================

DTR:     D10241

SOR/STR: 6697

Title:   Doghouse Component Data Items Displayed Blank

Description:

The following doghouse component data items do not display any information in the doghouse:

"Distance Leg", "Ident Bearing Range", "Course to Target", "Time to Target", "Distance to Target".

===================================================================

DTR:     D10242

SOR/STR: 6697

Title:   Distance Cumulative Displays Leg Distance

Description:

Selecting "Distance Cumulative" in the doghouse component data editor results in display of leg distance instead.

===================================================================

DTR:     D10243

SOR/STR: 6697

Title:   Selecting "Altitude MSL" For A Leg Defined As AGL Reverts Selection To AGL.

Description:

If a doghouse is selected for a turn point which is defined by an AGL altitude, and "Altitude MSL" is selected in the component data editor for display, the selection is ignored and AGL altitude is displayed and selected when Exit and Apply Changes is selected.  The planner may want to display MSL altitude for cross reference even if the point is defined as an AGL altitude

===================================================================

DTR:     D10244

SOR/STR: 6697

Title:   Incorrect Clock Time Display In Doghouse

Description:

If "Clock Time" is selected for display in the doghouse component data editor, the only thing actually displayed in the doghouse are the words "Clock Time".

===================================================================

DTR:     D10245

SOR/STR: 6697

Title:   Divert Heading Incorrectly Displayed In Doghouse

Description:

If "Divert Heading" is selected for display in the doghouse component data editor, it displays as a true heading.  Divert heading should be displayed as magnetic heading.

===================================================================

DTR:     D10246

SOR/STR: 6697

Title:   Divert ID Displayed Incorrectly In Doghouse

Description:

If "Divert ID" is selected for display in a doghouse using the component data editor, the waypoint number is displayed instead.

===================================================================

DTR:     D10247

SOR/STR: 6697

Title:   Elevation Displayed Incorrectly In Doghouse

Description:

If "Elevation" is selected for display in a doghouse using the component data editor, the aircraft altitude AGL is displayed instead.

===================================================================

DTR:     D10248

SOR/STR: 6697

Title:   Headings In Doghouses Not Taking Wind Into Account.

Description:

If a true or magnetic heading are displayed in a doghouse, they do not take wind (crosswind) into account.

===================================================================

DTR:     D10249

SOR/STR: 6697

Title:   Course Displays In Doghouses Do Not Have T Or M Next To Them

Description:

If true or magnetic course are selected for display in a doghouse using the component data editor, they are just displayed as a 3 digit number, with no M ot T legend next to them to indicate what reference they are using.

===================================================================

DTR:     D10250

SOR/STR: 6697

Title:   Component Data Items Not Saving With Doghouse

Description:

If a doghouse is customized using the component data editor, and then saved, many of the selected data types do not save or recall with the doghouse load function.  The following data items are not recalled when a saved doghouse is loaded:  Bank Angle, Calibrated Air Speed, Course Magnetic, Course to Target, Course True, Description, Distance Leg, Distance to Target, Distance to Divert, Elevation, Flight Mode, Fuel Flow, Ident Bearing Range, MGRS, Speed Mach, Time to Target, True Airspeed, UTM Coord, UTM Zone, Wind Speed/Direction.

===================================================================

DTR:     D10251

SOR/STR: 6825

Title:   Strip Chart Tick Marks Scaled Incorrectly

Description:

Time ticks on strip charts are scaled incorrectly.  Planned a low level route with a constant groundspeed of 480 KTS.  Each strip in the series had a different scaling between time ticks, especially on strips that had one leg split over two strips.  The distance between tick marks varied from being correct (8 nm) to as short as 4 nm apart on some strip charts, as well as several distances in between.  With a constant 480 GS, the tick marks should all be 8 nm apart.  For legs that were split over two strips, the first strip generally had ticks that were very close together, while the second strip for that leg had correct spacing.

===================================================================

DTR:     D10252

SOR/STR: 6825

Title:   Strip Chart Tick Marks Incorrectly Placed With Respect To Turn Point

Description:

The tick marks are no longer rounding off to the nearest minute at each turn point, but they are not placed correctly with respect to the turn point time, either.  The tick marks are placed approximately 1 to 2 nm short of where they should be in the vicinity of the turn point based on turn point time.  Example: first strip with 3 legs, two turn points, with hack time of 00+00:00 on the second point.  Time zero tick mark appears one mile short of turn point with zero hack.  Time 2 tick appears 2 miles short of next turn point with turn point time of  02:04 elapsed in dog house ( 4 seconds should be .5 nm). Time tick 4 appears 1 nm past next turn point, which is at time 3:42 ( 18 seconds should be 2.4 nm).

===================================================================

DTR:     D10253

SOR/STR: 6825

Title:   Strip Chart Tick Marks Not Drawn Correctly On First Strip

Description:

Not all tick marks are drawn on first strip chart in series.  Had low level route with hack time of 00+00:00 at start point of low level, which was point 4 in mission route. Strip chart editor was brought up with a series of 4 to 10 (end).  The first strip had three legs on it (4-5-6-7).  The only time ticks displayed were at 2 minutes and 5 minutes, and were scaled incorrectly.  If the same route was brought up in the strip chart editor starting one point prior to the hack point (3 through 10),  then time ticks were displayed as "-0" at time -1, 0 (but 1 nm shy of the hack point), 1, and 2.  There was no tick mark for time 3.

===================================================================

DTR:     D10254

SOR/STR: 6496

Title:   Audit Log  ZZT_MAX_NUM_AUDIT_RECORDS environment variable

Description:

When trying to open the audit log with more than 50K of data, an error message tells the user to modify the ZZT_... env variable. When I looked in tamps.env the variable is not there.

===================================================================

DTR:     D10255

SOR/STR: 6217

Title:   Symbol  Annotation, Default Button

Description:

The STR calls for the "Apply" button to be the default. The finger button is set to default after selecting location vice the Apply. Apply is only the default after selecting Apply.

===================================================================

DTR:     D10256

SOR/STR: 6755

Title:   Manual Route Validation not updating Fuel data

Description:

In E2C MPM, input launch/recovery and then navpt #2. Opened the dynamic kneeboard card and checked it, fuel was blank in brief format. Then selected the calculate button on toolbar, a validating route message pops up briefly but it does nothing else. The fuel data is still not showing up in the Kcard. I checked the regular Kcard and it too, showed --- in the fuel column. I had to turn route validation on under Setup and add another navpoint to get fuel data.

===================================================================

DTR:     D10257

SOR/STR: 6755

Title:   Mission Save, Route Validation not Working

Description:

With Route Validation defaulted to off, and select File Save in a MPM, a message comes up asking do you want to validate current mission before saving.  I selected Yes and checked the dynamic and route kneeboard cards. The dynamic brief format still had --- for fuel, but the full format showed fuel and GWT data. The route kneeboard card had --- in the fuel fields. Again the only way to get fuel data in the printed Kcard is to turn route validation on in the setup>defaults. Similar problem to DTR 256.

===================================================================

DTR:     D10258

SOR/STR: SOR 95-43

Title:   Audit log not tracking logins

Description:

The auditting was configured with just login_logout selected. In the audit log it is only showing the user logouts. The log shows the "username"  login or logout and then WSE logout for logoffs, but there are no login events in log.

SOT Step 95-43.1

===================================================================

DTR:     D10259

SOR/STR: SOR 95-43

Title:   PST User Manuals will not open

Description:

I loaded the user manuals for mission planner from the 6.1/6.1.1 CD and they loaded OK. I then logged off and logged back on and selected User Manuals from WSE Help menu, and the User Manual window came up with Users Manual, Mission Planner in list. However, when attempt to open the manual nothing happens. In the error logs it shows a message about couldn't ececute "acroread": no such file or directory.

SOT Step 95-43.1

===================================================================

DTR:     D10261

SOR/STR: SOR 96-01

Title:   Remove Archive/Restore IDB

Description:

In DBA Archive/Restore window, IDB is still an option under Select Dataset. This needs to be removed since it is no longer applicable with MIDB and probably won't work anyway.

===================================================================

DTR:     D10262

SOR/STR: 6698

Title:   Reports/Kneeboard Card Causing Crash

Description:

In an MPM opened a mission and then selected the Platform Performance Report. Closed Report without printing and then selected the Route Kneeboard Card, selected create report and  TAMPS format and in a couple of seconds the MPM crashed.

===================================================================

DTR:     D10263

SOR/STR: 6.2 Init

Title:   Database Usage Print causing crash

Description:

If Laser Print Button is selected after querying database usage on DAFIF/GPS, get a print preview window.  If Laser Print Button is selected after querying the same a second time, DBA module will crash.

SOT Step 95-43.1

===================================================================

DTR:     D10267

SOR/STR: 6317

Title:   GPSMDL Loadset retrieve causes crash

Description:

Created a mdl loadset in F14D and saved it. Selected Retrieve and highlighted the loadset name in list, then OK and MPM crashed. Also, did the same thing in AH-1W.

===================================================================

DTR:     D10268

SOR/STR: 96-01

Title:   Archive/Restore MIDB (GMI)

Description:

Archive/Restore:

The MIDB (GMI database) is not on the list for archive/restore.   The archive/restore had IDB in the list.

===================================================================

DTR:     D10269

SOR/STR: SOR 95-43

Title:   Sysgen Build 4

Description:

Implement Sysgen changes required for Build 4, including COTS changes, MPLAN and MIDB support.

SOT Step 95-43.1

===================================================================

DTR:     D10270

SOR/STR: SOR 95-43

Title:   Sysgen Volume Manager

Description:

Implement Veritas Volume Manager installation for E-4000

SOT Step 95-43.1

===================================================================

DTR:     D10273

SOR/STR: 6697

Title:   Doghouse Component Data Items:  ICN Change

Description:

F/A-18 MPM found a misspelling of a Doghouse Component Data Item #define in "bsa_defines.h".   The item "bSa_DOGHOUSe_ID_BEARING_RANGE_NAME" should be "bsa_DOGHOUSE_ID_BEARING_RANGE".  This error caused an Ada bindings problem.

===================================================================

DTR:     D10275

SOR/STR: SOR 97-13

Title:   PFPS Import Messages not coming up in front

Description:

After successfully importing a PFPS mission from floppy the message about a successful import comes up behind the Import window. This also happens with other error messages from PFPS import.

===================================================================

DTR:     D10276

SOR/STR: SOR 97-12

Title:   Yearly Crypto Keys Change to Weekly

Description:

When a user tries to enter or modify the start/end dates for a yearly GPS

crypto key usin the Modify HMI, part of the logic treats the key as a

weekly key.  If the new dates overlap any dates for weekly keys in the

database, an error message is displayed when Apply is selected, and

the key can not be entered into the database.  This should only happen

when the date of another yearly key is overlapped.  Also, if the date change

is successful, the key type changes to weekly (CVw).

SOT Steps 97-12.4 and 97-12.8

===================================================================

DTR:     D10277

SOR/STR: SOR 97-12

Title:   GPS Crypto Key Help

Description:

The help files for the crypto key manual entry and modify HMIs are no longer correct.  The help files should be updated to reflect the new short title checks and key type algorithm.

===================================================================

DTR:     D10278

SOR/STR: SOR 97-12

Title:   Incorrect Short Title Error

Description:

If the cursor focus is changed before starting the short title entry in the crypto key manual entry function, an error message is displayed which says: "Key purpose is not operational or simulation. .....".  If no title has been entered yet, no error should be displayed.  If an invalid title is entered, the error should read something like:  "The short title entered does not match the format for an operational or simulation key.  Only operational and simulation keys can be loaded on TAMPS".

===================================================================

DTR:     D10279

SOR/STR: SOR 97-13

Title:   PFPS Import Default Classification

Description:

Since PFPS mission data does not contain Classification, TAMPS needs to set the classification to "Unclassified" as default on import. Otherwise when open a PFPS mission in a MPM, there is no classification at the bottom of the MPM and when go to output a report they come up as Top Secret.

===================================================================

DTR:     D10280

SOR/STR: SOR 95-47

Title:   Background Environment Window.

Description:

The environment HMI window in the background tool is not listing the Op Areas.  Select DBA -> Display -> Background -> Weather -> Edit to display the window.

===================================================================

DTR:     D10282

SOR/STR: SOR97-11a

Title:   ICWG 184.2 fixes

Description:

move jet_displayQueryResultsDialog from public to private.

change variable names in JET_IMAGERY_METADATA_T and JET_MTF_DATA.

add PPIP type to JET_CATEGORY_TYPE.

changed descriptions in tet_NITFFunctions to agree with prototypes

===================================================================

DTR:     D10283

SOR/STR: SOR 95-43

Title:   Sysgen External Interface Prompts

Description:

Implement user prompts for connections to external interfaces during Sysgen, such as SIPRNET, JMCIS...

SOT Step 95-43.1

===================================================================

DTR:     D10284

SOR/STR: SOR 95-47

Title:   Import/Export TAMPS Missions not working

Description:

When select Import/Export tamps missions get the new Mission Data Transfer window. Select Source=Workstation and Destination= Media then select either 8mm tape or 3 1/2 inch disk and OK. An Error Message window comes up saying "In bmt_missionOkCb - Error parsing device name".

===================================================================

DTR:     D10285

SOR/STR: SOR 95-47

Title:   Mission Data Transfer Window  Devices

Description:

Remove the 1/4 inch Cartdrige medial as an option under this new window. There are no QIC 150 drives on any 6.2 hardware.

===================================================================

DTR:     D10286

SOR/STR: SOR 95-47

Title:   Removing IP Addresses on Server

Description:

On a server system, if a user selects view -> NIS+ Host Table from the

LAN administration window, highlights an unassigned IP address and

selects edit -> remove, the IP address is only temporarily removed from

the list , and an error message is displayed saying:  "Error modifying NIS+

table".  When the NIS+ Table is reselected, the IP address is in the list

again.  The remove option works for IP addresses that have been assigned

a hostname, and should be consistent.

===================================================================

DTR:     D10287

SOR/STR: SOR 96-60H

Title:   Object Editor Import/Export FAILS

Description:

Could not Export using the Object Editor Import/Export New HMI window.

From the WSE_BAR selected DBA -> Object Editor -> highlighted DAFID_AIRBASES -> highlighted JOINT -> then selected Import/Export -> and the Object Import/Export new HMI window was displayed:Selected radio button Export -> then selecting 8mm tape or 3.5 disk, and then the verify Export Media Load window is displayed:Selected OK and then selected Apply at the Object Import/Export Window:and received the following Message window.A system error occurred at the completion of the export process.

===================================================================

DTR:     D10288

SOR/STR: 96-60H

Title:   Object Editor Import/Export New HMI window.

Description:

Crashed the Object Editor using the New HMI Import/Export window.

From the WSE_BAR selected DBA -> Object Editor -> highlighted DAFID_AIRBASES -> highlighted JOINT -> then selected Export User Directory radio button:highlighted the JOINT.odf  -> selected 8mm tape or 3.5 disk to active the OK or Apply buttons in the Object Import/Export Window: received the following ACK Window:Verify Export Media is loaded. Then by selecting OK in the ACK Window crashs the ALL the Object Editor Windows.

===================================================================

DTR:     D10289

SOR/STR: SOR 96-52M

Title:   Full PC Card Write Error

Description:

If you attempt to overwrite a file on a nearly full PC card with a file of identical filename, an error is displayed (and the file is not written) saying that the card is full - even if, by overwriting the file, the file being written would fit on the card.  The PC card driver should check for filename match and calculate the space available without the matching file before giving a card full indication.

===================================================================

DTR:     D10290

SOR/STR: SOR 95-47

Title:   Client Info Incorrect

Description:

The location, squadron, POC and phone/extension information is not being

displayed correctly on the server when amplify information is selected for

any of the connected clients.  Some of the fields are interchanged and

some information is just incorrect.  Also, the location is not correct in the connected client list.

===================================================================

DTR:     D10291

SOR/STR: SOR 95-47

Title:   Amplify Info Under WSE

Description:

The client Amplify Info window pops up under the WSE bar on the server.

===================================================================

DTR:     D10292

SOR/STR: SOR 95-47

Title:   Client Idle Time

Description:

In the client Amplify Info window, "Idle time" is displayed in seconds only.  The format would be much more usable in days, hours:min:sec.

Note: Modified text of this DTR on 1/15/98

===================================================================

DTR:     D10293

SOR/STR: SOR 95-47

Title:   Connected Client Status

Description:

Connected client workstation status, displayed in the server's LAN administration HMI, is not correct.  It shows "Active" if a user is logged in and "Unknown" if not.  The SOF statements state that the status should be "Active" when the client is powered up and "Inactive" when not.

===================================================================

DTR:     D10294

SOR/STR: SOR 95-47

Title:   New Missions on Client/Server

Description:

New missions created on connected clients must be created using op areas

that were created on the client.  Server op areas are listed in the New Mission

HMI, but if one is selected, nothing happens when OK is selected.  The

second time OK is selected, the MPM crashes.  The problem is the opposite

on the server.  Missions must be created using op areas that were created on

the server.

===================================================================

DTR:     D10295

SOR/STR: SOR 95-47

Title:   Opening Op Areas

Description:

When a user on a client opens a DBA module and tries to open an op area

that was created on the server, the selected op area is not displayed.  The

display either remains on the op area that was already displayed or reverts

to the default.

===================================================================

DTR:     D10296

SOR/STR: 6755

Title:   Route Validation not being save in Save User Defaults.

Description:

Route Validation is not being saved when you select route validation ON and then select  the Save User Defaults for your msn.   Meaning you have to reselect the route validation each time you open your aircraft mpm.

===================================================================

DTR:     D10298

SOR/STR: 6317

Title:   Error Saving MDL Loadsets in F14B Upgrade

Description:

Could not save a MDL loadset in F14B Upgrade MPM. Kept getting "Error in saving loadset" message. Tried with various combinations of files including only almanac and magvar. Same problem in F14A Upgrade. Other MPMs seem to allow saving

===================================================================

DTR:     D10299

SOR/STR: SOR 95-47

Title:   Deleting NIS+ Table Entries

Description:

No warning is provided to a system administrator when trying to remove or modify host table entries on the server.  As a minimum, a warning should be displayed anytime an attempt is made to delete or modify any entry for a connected client or the server, since these are destructive actions.

===================================================================

DTR:     D10300

SOR/STR: SOR 95-47

Title:   User Accounts on Clients

Description:

The functionality for creating new accounts on a client is available but does not work.  SOF statement 1.3.4.1.1.1 states that this is still a requirement.  If this requirement has been deferred, the documentation should be updated, and the System Admin -> User Administration -> Accounts option should be grayed out on clients.

===================================================================

DTR:     D10303

SOR/STR: SOR 96-01

Title:   MIDB Display of WW data is wrong

Description:

After loading MIDB Worldwide data from tape, queried for all primary airfields and they all displayed in the NE Quadrant of the world. In C/D text the coordinates have lat/lons in other quadrants but they are not displaying properlyl

===================================================================

DTR:     D10305

SOR/STR: 6698

Title:   Can only print one kneeboard card per kneeboard card session

Description:

Pressing the Print button in the Kneeboard card window more than once only results in one print job.  Must leave the kneeboard card and re-Create it to get another to print out.  One print job per kneeboard card is unacceptable.

===================================================================

DTR:     D10306

SOR/STR: SOR 95-43

Title:   Cleanup /var/audit on reload

Description:

If preserve /var/audit partition during solaris install, sysgen is not deleting old log files during arctic install.

SOT Step 95-43.1

===================================================================

DTR:     D10307

SOR/STR: SOR 95-43

Title:   Cannot load two complete versions of DAFIF

Description:

replace of DTR111.

Tried to load two complete versions of DAFIF on standalone Ultra and received the following error message: Can't allocate space for objects in the database 'DAFIF_GPS' because the 'default' segment is full. It looks like only 400MB is allowed for DAFIF.

SOT Step 95-43.1

===================================================================

DTR:     D10308

SOR/STR: SOR 95-47

Title:   MPMs and DBAs sometimes not starting.

Description:

Repeat of D074.

Sometimes MPMs and DBAs will not come up. If check in shell the applications are running but the only thing that comes up is the NATOP msg or starting application msg. It appears to be related to the object server since when kill the ost_server the MPM window comes up. The user would have to reboot to correct this problem. The previous DTR was put into test and developer indicated could not dupe.

===================================================================

DTR:     D10309

SOR/STR: 96-01.1

Title:   Crash displaying AAA planner and DBA threats

Description:

Consistent system crash attempting to display AAA planner and DBA threats.  The sequence I found to be consistent is:

F14D MPM

Threat/Intel -> Planner OOB-> Planner and DBA...

Select planner and OK

Select AAA

===================================================================

DTR:     D10311

SOR/STR: 96-01

Title:   Disk space required for world-wide MIDB load

Description:

Based on the test world-wide data tape, there must be a minimum of

245 Mb free in $DB_ARCHIVE_RESTORE (which is, via softlinks,

under /var on an installed system) in order to load the complete

FAC table set.  It would be better to leave some margin for growth,

so 300 Mb is a better figure.

Reworking the script to extract one file at a time would reduce the

disk space required to about 100 Mb, at a reduced speed since the

tape would repeatedly be rewould and re-read.

A different temporary directory could be used, if there is another

disk that can be expected to have enough free space.

===================================================================

DTR:     D10313

SOR/STR: SOR 95-47

Title:   Connected Client User Accounts corrupted

Description:

User accounts created on a client workstation prior to connecting to a server get corrupted after connecting.  The user directories do not get created correctly on the server, and the accounts are unusable.

===================================================================

DTR:     D10314

SOR/STR: SOR 95-47

Title:   Bogus Error Message

Description:

An error message about updating the NIS+ table is displayed each time a hostname is assigned to an IP address from the Available IP Addresses list, even though the NIS+ table actually gets updated.

===================================================================

DTR:     D10315

SOR/STR: SOR 95-47

Title:   Conflicting Host Names

Description:

Modified the host name of a previously assigned IP address and selected Apply.  This should have caused an error, but instead the new host name was created with the previous alias and IP address causing the IP address to be used for 2 different host names.

===================================================================

DTR:     D10317

SOR/STR: 6216

Title:   Geo Cancel Warning

Description:

Select Display>Geo Filter>Custom from DBA and select New Geo from the option menu.  Select pointing hand to begin creating a new geo.  When the right mouse button is selected to cancel the create geo function, get a warning message about not being able to create the geo.  There should be no warning since user intentionally cancelled the create geo function.

===================================================================

DTR:     D10318

SOR/STR: 96-01

Title:   FAC table being truncated

Description:

It appears that /var will need to be resized larger to accomodate the FAC tables in a FULL MIDB baseload.  Currently the load stops at the FAC_TIE table without indicating whether the table completed or not - NO alerts or errors are provided.  The last three tables: FAC_TRAIT, FAC_VULNERABILITY and FAC_XREF are all emply.

===================================================================

DTR:     D10319

SOR/STR: SOR 95-47

Title:   MPLAN NIS+ Host Tabel Update

Description:

If an Alias is set up for a valid Hostname and IP address and the Alias entry is removed from the NIS+ Host Table, the entry which has identical Hostname and Alias is also removed from the table.  If you remove an Alias entry, the Host entry should not be removed.

Additional Text (1/27/98): If the local host alias is removed, all of the other local host aliases will also be removed, causing significant system problems.  Recommend allowing alias to be deleted, but not for the local host.

===================================================================

DTR:     D10320

SOR/STR: SOR 95-47

Title:   /etc/hostname.xxx error in MPLAN

Description:

When connecting a client and server via either ATM or Ethernet, the MPLAN connect executable should check the /etc/hostname.xxx file on the client.  If connecting via Ethernet, the file in /etc should be hostname.hme0.  If connecting via ATM, the file should be hostname.fa0.  Only one of these files should be in the client /etc directory at one time but currently both can reside in /etc instead of one being replaced with the other depending on the connection method.

===================================================================

DTR:     D10322

SOR/STR: 96-01.2

Title:   MIDB GMI Restore without Modify MIDB privileges

Description:

As a user without Modify MIDB privileges, there is no warning messages when accessing the restore GMI database function.  Messages received are extremely old and does not reflect the current environment.  Without Modify MIDB privileges I should not be able to even try to restore the GMI database.  It should be greyed or not in the list.

===================================================================

DTR:     D10324

SOR/STR: SOR 95-43.2

Title:   COMPASS Crashes after connected and open a layer

Description:

The COMPASS MPM now starts and the servers can be started. After connecting if annotation tool is opened and symnbol selected or just about anything else that would creat a layer, open mission, query dafif, it crashes the MPM. If open these layers before connecting the MPM does not crash.

===================================================================

DTR:     D10325

SOR/STR: SOR 96-10.5

Title:   SIPRNET not connecting

Description:

After manually configuring "siprnet" in host table and adding a default router I could manually ftp the NAVSTAR.ALM file from siprnet almanac site. In DBA the SIPRNET shows configured but down and there is no means to pull data. In the shell ping does not work with the siprnet almanac site eventhough I can ftp into it.

===================================================================

DTR:     D10326

SOR/STR: SOR 95-47

Title:   Mission Tranfer - Dynamic_mpm switch

Description:

MPM's need the ability to save mission related data to the /tamps/dynamic/mpm area if the client is looking at Local DB or to the /tamps/dynamic/mpm_server area if the client is looking at the Server DB

===================================================================

DTR:     D10327

SOR/STR: TS96-01_05.doc

Title:   Interim Threat record merge to midb, tables missing.

Description:

Step:12  Hook one of the interim threats and update the MIDB.   Select DBA -> Update -> Threats -> Merge Planner OOB...   Failed

Received the following msg:FAIL to insert new SAM Site.

Mary Collins: Did a isql query for TAMPS_MIDB_DEFAULTS.   Data returned no TAMPS_ MIDB_Defaults Tables.

Also the DBA Interim Window has IDB and not MIDB at the top of the Editor window.

===================================================================

DTR:     D10328

SOR/STR: 97-13

Title:   handle to mission source

Description:

Need to provide MPMs the ability to access the misison source field from the input mission handle.  Additionally, need to set the apt_file_operation to apt_no_file_op when importing a PFPS route.

===================================================================

DTR:     D10330

SOR/STR: SOR 96-10.

Title:   On-Line GPS, cannot switch between NAVSSI & SIPRNET

Description:

In DBA > Update > OnLine, with both NAVSSI & SIPRNET configured and UP, I could not select SIPRNET as the source since it was grayed out. Opened and closed online gps window and still the same. If closed DBA and opened the DBA then could select either source.

===================================================================

DTR:     D10331

SOR/STR: 6307

Title:   MGRS in NAD-27 to WGS-84

Description:

TAMPS is not calculating MGRS correctly when changing from Datum NAD-27 to

WGS-84 in the planner target updates dialog.  As an example, if an MGRS of 11SLV4634250648 is entered in WGS-84, and then the datum is alternately applied for that point, the sequence is:

WGS-84   11SLV4634250648

NAD-27   11SLK4642250449

WGS-84   11SLV4642550649

NAD-27   11SLK4650550451

WGS-84   11SLV4650950651

The MGRS should have toggled between:

WGS-84   11SLV4634250648

NAD-27   11SLK4642250449

and this was proven on a truth source (MADTRAN).

===================================================================

DTR:     D10332

SOR/STR: 96-10

Title:   Almanac load alert coming up Red

Description:

Setup online GPS to auto update from a NAVSSI emulator. After update a Red alert came up about the almanac update. Change the alert to Yellow. Also, the text in the main alert is compressed together and hard to read.

===================================================================

DTR:     D10333

SOR/STR: 6307

Title:   Target Longitude Changes

Description:

If a target point is entered in the planner target updates dialog using NAD-27 datum, each time the target is selected from the list and apply is selected, the longitude changes by a few seconds.  Example:

35:41:16N, 118:41:53W

35:41:16N, 118:41:50W

35:41:16N, 118:41:47W

35:41:16N, 118:41:44W

===================================================================

DTR:     D10334

SOR/STR: 96-01.3

Title:   Input media information in MIDB Data Exchange does not reflect TAMPS media

Description:

The only way to import certain MIDB data is via the MIDB Data Exchange tool.  When import is selected and File -> Set Tape Information is also selected, it displays a list of media that is not reflective of the TAMPS environment.  I believe what is shown are tape devices for DIA.  Floppy disk and Hard Drive information is also here.  The list should be changed to reflect the TAMPS environment.

===================================================================

DTR:     D10338

SOR/STR: SOR 95-43.1

Title:   Remove Import PFPS menus from FAMP and COMPASS MPMs

Description:

Both FAMP and COMPASS MPMs have the Import PFPS Routes menu under File > Import/Export Missions. Import/Export missions is not applicable to these MPMs and when selected it causes the MPMs to crash. This may also be a problem in HARM/SLAM/JSOW if they do not remove this menu.

===================================================================

DTR:     D10339

SOR/STR: SOR 95-47

Title:   Client Idle Time Cycling

Description:

In the Client Amp Info window, the "idle time" cycles between 0 and 60 for a connected client.  This value should either be displayed as 0 or not be displayed at all until the client disconnects.

===================================================================

DTR:     D10340

SOR/STR: SOR 96-01

Title:   Remove IDB selection from Dataset Removal

Description:

Remove the selection for IDB from the list under DBA> Utilities> Data Removal> Dataset since it no longer applies.

===================================================================

DTR:     D10341

SOR/STR: 96-01

Title:   GMI Dataset removal is not deleting catalog entry

Description:

After using the DBA Dataset removal tool to remove the GMI database it appeared to remove the data OK, however the MIDB Baseload entry is still in the TAMPS catalog when select Output> Database Catalog

===================================================================

DTR:     D10343

SOR/STR: 6697

Title:   Doghouse Display for Leg to Recovery Point

Description:

Currently, the Doghouse for the last point in the route (i.e., prior to the recovery point) does not give the option to show any data for the NEXT POINT (recovery pt).  Instead, only data for the current point may be seen.  Lt. D'Acquisto (Fleet Liason Officer) requests that the operator be able to select data for this last leg to the recovery point (e.g., bearing to recovery, fuel remaining, etc.) as for any other point in the route.

Lt. D'Acquisto states that the NEXT POINT option for ANY doghouse WILL NOT BE APPLICABLE for the following items:

True Heading

Magnetic Heading

Leg Time

Leg Fuel

Distance Leg

True Course

Magnetic Course

These items are always for the flight leg ahead; NEXT POINT would show data for the next point beyond the next leg, which is unacceptable.  In addition, the Waypoint # for the current Doghouse must always indicated the adjacent waypoint, not that for the next leg's Doghouse; accordingly, the NEXT POINT option is to be ignored for this composite data item also.

Per Lt. Todd Kiefer (IKE), the AGL and MSL should be relative to the NEXT POINT ONLY.

===================================================================

DTR:     D10347

SOR/STR: SOR 95-47

Title:   Modify Available IP Addresses, Apply closes widget

Description:

On a server system, select the Available IP Addresses view and select an entry to modify.  If the Apply button is selected after modifying the entry, the Modify widget should remain open but actually closes.

===================================================================

DTR:     D10348

SOR/STR: 95-43

Title:   TAMPS Logins would not bring up WSE, rqrd reload

Description:

On a standalone workstation that had not been connected to a server, I could not login using previously working accounts. I had to login as root but could not find anything obviously wrong. Rebooted system and tried again but still the same. What is happening is the login and password are accepted OK and the DOD warning window comes up but the WSE never comes up. After a couple minutes it brings back up the login window. Note! This was on Bld 3A. I had to reload system to correct the problem.

===================================================================

DTR:     D10350

SOR/STR: SOR 96-10

Title:   On Line GPS showing NAVSSI up when it is really down

Description:

Using a standalone Ultra connected via a router to SIPRNET, I input a bogus IP address for navssi and a valid cofig for siprnet. When open the online GPS update window it shows both NAVSSI and SIPRNET as being up when it should only show SIPRNET as up. When I manually tried to ftp to the navssi host it took about 4minutes and then returned No Route to Host msg.

===================================================================

DTR:     D10351

SOR/STR: SOR 95-47

Title:   Server MIDB Database Dump Update Failure

Description:

On the server, selected Utilities > Database Maintenance > Update Database Dumps.  Selected MIDB and Apply.  Dump flat file was created okay but the following warning message was displayed upon completion:  Attempt to insert NULL value into column "LOAD_DATE", table GMI.dbo.GMI_TEMP_CATALOG; column does not allow NULLS, update fails.  On the server, the Database Catalog for MIDB Baseload displays nothing for Date Last Change.  After a Database Update on the client, the Database Catalog does not display a MIDB entry at all even though the data is updated on the client.

===================================================================

DTR:     D10355

SOR/STR: 95-47

Title:   GUAC load errors on dropping/creating indexes

Description:

Selected to load GUAC  for Korea area. Load completed OK but there were errors in log about dropping and creating indexes and not being the owner or SA. For example "Only the owner of table "GUAC_CLIMATOLOGY" or a user with System Administrator (SA) role can create an index on it." Also, there were DB-LIBRARY errors: Attempt to bulk-copy an oversize row to SQL server. Bottom line, could not display GUAC.

===================================================================

DTR:     D10357

SOR/STR: SOR 96-01.03

Title:   Client to Server Update Objects

Description:

Client to Server connected, queried the MIDB for SAM's on the Client:highlighted the object on the DBA Module on the Client and selected Update -> Threats Edit Hooked Object and received the following msg:Error:Unable to obtain SUPPORT table for the window address by ID: -1 NAME: FAC.     Connected by ether net.

Showed gary from TRW he said to write a DTR.

===================================================================

DTR:     D10358

SOR/STR: 6214

Title:   Launch Details Crash

Description:

Created a new mission in the F14D MPM.  Selected Setup -> Defaults -> Aircraft.  Then selected Launch Details.  Selected OK and the MPM crashed.  This is repeatable.  Duplicated in AH1W also.  Occurs on standalones and connected clients.

===================================================================

DTR:     D10359

SOR/STR: SOR 95-47

Title:   Removing Conflicting Accounts

Description:

After connecting a client to a server, if the user selects close in the conflicting accounts HMI, a warning is displayed that says the remaining conflicting accounts will be deleted.  The warning should reflect what is actually happening, such as: " The accounts will be inaccessible while connected and restored after disconnecting".

===================================================================

DTR:     D10367

SOR/STR: SOR 95-47

Title:   MPLAN User Password for Authentication

Description:

After connecting a client to the server on MPLAN, logging in as root, and giving correct root password, log in under a user account.  After the conflicting account HMI is dismissed, user is asked to enter a password twice.  There is no indication what password is needed (the password of the user who logged in) and if an incorrect password is entered, the user will not be authenticated.  This will cause other problems to occur when using any account (like having the conflicting account HMI displayed every time any user logs in).  In order to correct these problems, you must reload the system.

===================================================================

DTR:     D10368

SOR/STR: SOR 95-47

Title:   Modifying Local NIS+ Host Table

Description:

If the SA modifies one of the several Aliases to the local hostname in the NIS+ Host Table, all the other aliases will be deleted causing major problems with MPLAN connection and/or MIDB functions.

===================================================================

DTR:     D10370

SOR/STR: SOR 95-47

Title:   MPLAN Connect Root Password

Description:

When connecting a client to the MPLAN server, if the user inputs an incorrect root password when queried, the connect process is allowed to proceed and succeeds.  After the connection is made and the login screen is displayed, the user can login as root using the incorrect password used at connect.

===================================================================

DTR:     D10371

SOR/STR: SOR 95-47

Title:   Conflicting Accounts Error

Description:

Connected a client to a server which had conflicting user accounts.  When the user conflict HMI appeard, changed a conflicting user name to a name that was already in the valid user list and selected OK.  Got a cryptic error message: "Unable to add user .....: add_status = 16646144".  Changed the name to a different name that was not in the valid user list and selected OK.  The conflicting account name was correctly removed from the conflicting user list, but an entry was added for the name that introduced the initial error.

===================================================================

DTR:     D10373

SOR/STR: SOR 95-47

Title:   MPLAN Database Update Confusing Messages

Description:

When a user performs a database update on a client machine via the MPLAN, a warning message is displayed stating:  "You will have to restart THIS machine, etc...".  After this message is acknowledged, another message is displayed stating:  "Restart the machine where the Sybase server resides".  These two messages are saying the same thing but in different ways which will be confusing to users who may mistakenly restart the server causing numerous problems!

===================================================================

DTR:     D10374

SOR/STR: SOR 95-47

Title:   Missions Not Transferred with Account

Description:

Created some missions using an account on a standalone workstation.  Connected the workstation to a server that had an account with the same name.  During the connection, I renamed the account on the workstation.  Logged into the account with the new name on the connected workstation and found that the missions were no longer tied to the account.  They were tied to the account that was already existing on the server prior to connecting.

===================================================================

DTR:     D10375

SOR/STR: 4612

Title:   Launch/Recovery Airbase Query Not Working after initial query.

Description:

In any MPM Start a new mission in a SoCal OpArea and open Launch/Recovery window. Select Display Airbases and Apply. Then Deselect All to change the query filters and select US and US-CA prov and Apply. The original query data goes away from the screen but a message comes up saying "No airbases found based on  current filter settings."  This used to work in 6.1.1 before the GEO and OpArea Selections were added to this widget. The only way for a planner to run another airbase query in L/R is to change OpAreas in New Mission or open another MPM.

===================================================================

DTR:     D10376

SOR/STR: SOR 95-47

Title:   Missing/Incorrect Help Files

Description:

The following dialogs do not have help files:

Connect to LAN dialog

Conflicting User Accounts dialog

Update Database Dump dialog

The following dialogs have help files that give inorrect information:

Mission Import/Export dialog

===================================================================

DTR:     D10379

SOR/STR: SOR 95-47

Title:   Mission Import/Export Causes Problems

Description:

Working on an E4000 server with one Ultra connected as a client.  Anytime an import or export was performed on either of the stations, the following problems were noted with the MPM that performed the operation:

1) No op areas listed in the new mission dialog.

2) No missions or planners listed in the mission delete dialog.

3) Mission list frozen in the open mission dialog.

4) Database error when attempting to open a mission.

5) Database error when attempting to save a mission.

These problems made the MPM unusable for mission planning.  Had to exit the MPM and open a new one to get the mission-related functions to work properly.

===================================================================

DTR:     D10381

SOR/STR: SOR 95-47

Title:   Successful Import Message

Description:

If an import or export to either a client or server database is performed and the database already contains missions with the same names as those being transferred, error messages are properly displayed.  However, a message saying "Mission Import Completed Successfully" is displayed also.

===================================================================

DTR:     D10382

SOR/STR: SOR 95-47

Title:   DAFIF Display Client/Server

Description:

DAFIF loaded to the server database from the client workstation can not be

accessed by either the client or the server.  DAFIF loaded using the server

station can be accessed by both stations.

This is a repeat of DTR #209 (which is in Integration_Build).

===================================================================

DTR:     D10384

SOR/STR: SOR 95-47

Title:   DTED Load from Server to Client

Description:

When loading DTED from the server to the client, the load window map display will show the correct area if there is only one area of DTED loaded.  If there is more than one area of DTED loaded, the map display will show a small portion of the world centered around the intersection of the Prime Meridian and the Equator.  Top View button will not enlarge view to show whole world so user cannot use box select to choose area desired for load.  Only option seems to be to load ALL DTED loaded on the server!

===================================================================

DTR:     D10385

SOR/STR: SOR 95-47

Title:   ddt_mmi load utility env variable parsing

Description:

The ddt_mmi load utility is incorrectly parsing the environment variable SYS_TAPE and placing a SERVER entry in the 8 mm Tape option menu.

===================================================================

DTR:     D10386

SOR/STR: SOR 95-47

Title:   ADRI Load from Server to Client

Description:

There is no requirement for ADRI load from the server to the client.  Therefore, the From Server radio button on the ddt_mmi Load Utility should be insensitive when ADRI is selected but is sensitive and gives an error message when selected and Apply is selected.

===================================================================

DTR:     D10387

SOR/STR: SOR 95-47

Title:   ARC-210 Unusable

Description:

ARC-210 is UNUSABLE.  Unable to create ARC-210 data files.  When save is selected, get an error about no WOD or MWOD being selected.  All editors, which normally are initialized with data, are empty.  Could be a problem with stored procedures.

Test Step SOR 95-47.17

===================================================================

DTR:     D10388

SOR/STR: SOR 95-47

Title:   Unable to Save Smartpack Packages

Description:

Created some smartpack contents, added them to a package and selected save.  No error messages were displayed.  Selected File -> Open in the Smartpack Package dialog, and no packages were listed.  No data was contained in sybase table SMARTP_CONTENT.

Test Step SOR 95-47.17

===================================================================

DTR:     D10389

SOR/STR: SOR 95-47

Title:   Mission Related Data Update

Description:

The Mission Related data update from the server to the client is not working correctly.  Created JNL loads, CAS files, GPS Waypoints files, interim threats, tactical waypoints and custom kneeboard formats on the server.  Then selected DBA -> Utilities -> Database Maintenance -> Update Database from Server on the client.  Selected Mission Related Data, Update Now and OK.  A message was displayed that said the update was successful, but when the corresponding sybase tables were checked, there was no data present.  Disconnected and checked each of the functions, but data was not available.

Test Step SOR 95-47.17

===================================================================

DTR:     D10390

SOR/STR: SOR 95-47

Title:   DCW Display on client

Description:

DCW loaded in the server database can not be displayed on the client.  The coverage tool shows no data loaded and DCW features do not appear when zooming in to a DCW area.

This DTR was created to replace DTR 206 which failed testing in the integration build.

===================================================================

DTR:     D10391

SOR/STR: SOR 95-47

Title:   Accounts Created on Client not usable on Server

Description:

Any user accounts created on a client machine before connecting to the server cannot be used to login to the server workstation after connecting .  When trying to login on the server using one of the accounts moved from the client to the server, the DOD banner warning will be displayed then the login process fails and the TAMPS Login is displayed.

===================================================================

DTR:     D10393

SOR/STR: SOR 95-47

Title:   Server/Client background displaying DTED crashes

Description:

Background DTED crashes when you do not deselect Include Server Data at scale 1:1M.

Server Lite wisconsin -> Client arizona:logged in on client as user scud: Selected OpArea with both server lite and client DTED.   Applications tried were DBA Module, FAMP, Aircraft MPM's AH1W, and F14D.

The workstation log error's:

DB-Library error.

Bad token from SQL Server:Datastream processing out of sync.

===================================================================

DTR:     D10394

SOR/STR: 96-01_8

Title:   Use of WGS-84 lat/lon in the DAFIF to locate spatial objects

Description:

SOF statement indicates that the DAFIF database should be using WGS-84 lat/lon columns to determine the location of spatial objects but instead lat_radians / lon_radians are being used.

The value is the same so there is no errors generated due to the use of lat_radians / lon_radians to locate spatial objects.

===================================================================

DTR:     D10397

SOR/STR: 96-01.18

Title:   Using the provided API tester to return data within a bounding box

Description:

Using the provided API tester, set up a query to return data limited by a bounding rectangle. The API tester found "no data" while the same query in ISQL returned eight active records. These records should have been returned via the tester also.

===================================================================

DTR:     D10401

SOR/STR: STR 6755

Title:   ait_routeValidationGetStatus() change to public

Description:

Need to change function ait_routeValidationGetStatus() from protected

to public.

===================================================================

DTR:     D10405

SOR/STR: 95-47

Title:   Intermittent crash of Database Catalog Option

Description:

Occasionally when select the View option from the Database Catalog display, the application will crash.

===================================================================

DTR:     D10443

SOR/STR: 96-01a

Title:   Error accessing MIDB Production/DEX tools

Description:

Attempted to open up the Data Exhange (Utilities -> MIDB Tools -> Database Admin -> Data Exchange6) and received the following error message: "Error determining the GCCS connection status."  After acknowledging the error message, nothing happens - can't open the DEX tools.

Further examination indicated that the following also returned the error message: (Error determining the GCCS connection status)

Utilities -> MIDB Tools -> Database Admin -> Data Exchange6

Utilities -> MIDB Tools -> Database Admin -> DBA Utility6

Utilities -> MIDB Tools -> Database -> Query6

Update -> Threats -> MIDB -> New Installation/Facility6

Update -> Threats -> MIDB -> New Unit6

Update -> Target -> New Target6

The following error was received when attempting to access the listed items (Unable to determine GCCS-M connection status)

Update -> Threats -> MIDB -> Edit Hooked Object6

Update -> Targets -> Edit Hooked Ojbect6

===================================================================

DTR:     D10486

SOR/STR: 96_01

Title:   MIDB Query Default Print Classification

Description:

DBA Module -> created a New Tgt and then did a query from the MIDB Tools -> Database Query -> Ran a query for the the New Created Tgt, then selected print and the print window class level is defaulted to a (higher classification and cavet).    Meaning it does not let you default to a lower classifcation.

===================================================================

DTR:     D10489

SOR/STR: 96-01.13

Title:   Planner target update not displaying correct data after exit and reenter mission

Description:

Created a new mission.  Used planner target update to create a target from scratch (no item was hooked).  Values entered were:

Elevation: 39 meters

Width: 11 meters

Height: 22 meters

Length: 33 meters

Applied the update, cancelled out, saved mission, exited the MPM.

Opened the mission again.

Selected planner target update and selected the target just entered.

Values displayed in the HMI were:

Elevation: 12 meters

Width: 3 meters

Height: 7 meters

Length: 10 meters

The data in the TAMPS_PLANNER_TARGETS table is correct.

===================================================================

DTR:     D10633

SOR/STR: SOR-95-47

Title:   Client Connect Fails to Mount Maps

Description:

The $LAN_MAPS/maps/? mount points are not created during the Client

connect process because Sysgen now creates the $LAN_MAPS directory.

===================================================================

DTR:     D10634

SOR/STR: SOR-97-11

Title:   JTIM_PATH Set Wrong on Client

Description:

JTIM_PATH is set wrong in tamps.env.low - the anonymous ftp fails

during JSIPS-N image fetch to a connected low side client.

===================================================================

DTR:     D10643

SOR/STR: 96-01

Title:   OBS and TRACK should not be part of the subset loaded from tape

Description:

The TAMPS subset definition for MIDB GMI does not include TRACK and OBS.  The data file that drives the MIDB Baseload function needs to be modified to exclude these two data sets.  Otherwise, if a baseload tape ever included these two data sets, we may run out of space in GMI.

===================================================================

DTR:     D10644

SOR/STR: D10399

Title:   Load ADRG gives error message

Description:

Whenever a user tries to load ADRG/CADRG, when the OK or Apply

button is pressed, an error message is displayed "cannot determine

ADRG filenames".

===================================================================

DTR:     D10647

SOR/STR: 96-01

Title:   Replication server drop subscription update

Description:

Update the drop subscription script (run when disconnecting from

GCCS-M) so that all subscriptions can be successfully dropped.

It seemed that there are some problems with TIE tables subcriptions deined for one single replication definition. Sometimes, a few of the subscriptions

won't drop until the other related subscriptions are dropped.

===================================================================

DTR:     D10648

SOR/STR: SOR 96-60H

Title:   Import Objects fails with new object

Description:

Created an object NAVY_TACANS under DAFIF_NAVAIDS>TACAN and built a query for the new object and made it a system query. The objec and query worked fine. Exported object to 3.5 FD and tape. Deleted object and then tried to import. Received msg "A system error occurred at the completion of the import process. Also, in .x-errors log showed "ERROR: Non-matching object determinators".

Fails SOT 96-60H.3

===================================================================

DTR:     D10650

SOR/STR: SOR-97-11B

Title:   Single Point Query Corruptions

Description:

GDE Internal DR delivered for Build 4.

===================================================================

DTR:     D10652

SOR/STR: SOR 97-11

Title:   JTIM Images Not Retrieved From SPA

Description:

Unable to retrieve an image from the JTIM SPA thinline.  Investigation showed a permission problem on the jtim directory.

===================================================================

DTR:     D10655

SOR/STR: 95-47

Title:   Strip Charts not displaying Chart data

Description:

Now stripcharts are not displaying any chart data in window. Charts were preserved and updated using DBA MapUpdate. Now not displaying local or server chart data.

DTR 615i refers to not being able to display server chart data when connected.

===================================================================

DTR:     D10662

SOR/STR: SOR 97-11

Title:   JTIM Product Request Crash

Description:

Initiating a request for either a target tasking product or a PPIP product causes the MPM to crash.

===================================================================

DTR:     D10666

SOR/STR: 96-01

Title:   AMP Info for DBA Target not showing CC or JMEM Type

Description:

(Object Query for Mary)

Amp information for DBA target does not show value for country code or JMEM_Type

===================================================================

DTR:     D10668

SOR/STR: 96-01a

Title:   C_EQP index not getting created - WW#2 MIDB load

Description:

C_EQP index does not get created on MIDB World Wide #2 load

===================================================================

DTR:     D10669

SOR/STR: 96-01a

Title:   Name in TGT definition not being displayed in AMP INFO

Description:

Name field appearing in TGT definition is not being displayed in AMP INFO for the programmatic planner target object (small triangle)

===================================================================

DTR:     D10670

SOR/STR: 96-01a

Title:   Datum selection not functioning in Planner Target Updates

Description:

Datum selection in planner target updates is not functional

===================================================================

DTR:     D10671

SOR/STR: SOR 97-11

Title:   Saving JTIM PGMs or TAMs

Description:

When trying to save a PGM product or TAM from the JTIM Query Results / Retrieve HMI, get an error message that says: "Only images may be stored on tamps".  Workaround is to open the image in the imagery toolkit and use File -> Save.

===================================================================

DTR:     D10673

SOR/STR: 96-01a

Title:   MIDB Query printer default classification incorrect

Description:

Print option in the MIDB production tools query window defaults to an incorrect classification.  The default selection is a higher classification with caveats and there are no options for any other classification.

===================================================================

DTR:     D10674

SOR/STR: 96-01a

Title:   Planner target update HORIZ_ORIENT_UM not being stored correctly

Description:

If you leave the toggle  alone, a NULL gets entered in the field.  If you toggle it to DEG-MAG, a 1 gets entered in the field.  If I toggle it back to DEG-TRUE, a NULL gets entered into the field.

Note: The object on planner targets is expecting 1 to be DEGREES TRUE and 2 to be DEGREES MAG.

More info from Mary:

Regarding DTR 674 (problems with HORIZ_ORIENT_UM in planner targets), if the decode table needs to have revised values, they are inserted within the src/dbinstall/tampsdb/create/mission/tamps_plnr_target_create.sql file as follows:

insert into TAMPS_HORIZ_ORIENT_UM_XREF

values

("1","DEGREES TRUE")

go

insert into TAMPS_HORIZ_ORIENT_UM_XREF

values

("2","DEGREES MAG")

go

===================================================================

DTR:     D10677

SOR/STR: SOR 96-01

Title:   MIDB Tools

Description:

On super client 2300 & Clients connected via ATM to server 4000.   Could not use the MIDB Tools on super client 2300 and clients ULTRA2.   This is from the DBA Module -> Util -> MIDB Tools:Database  -> Query & Count, Ref -> Cat Code & Equip Codes & CC & Gen Ref and Data Exchange.

ERROR MSG:Entry for user server TAMPS does not exist in the database access file.  Access to database denied.  Unable to access dataserver TAMPS.  Ether you do not have proper privileges, or the dataserver is not running and needs to be restarted.  Could not find entry for user in database access file.

===================================================================

DTR:     D10679

SOR/STR: SOR96-01

Title:   Update replication server scripts status windows

Description:

After resync is completed successfully, LAN deamon doesn't receive the

"connect" message.

===================================================================

DTR:     D10681

SOR/STR: SOR 96-01

Title:   RTM's not working

Description:

Queried for radar's and tried to do RTM's.  The systems tried were ULTRA2 Stand Alone, Server 4000, super client 2300 & client's ULTRA2 via ATM.  The system would only hang up and require killing the MPM or logoff to correct. This was with MIDB WW2 and NID from 9711 loaded.

===================================================================

DTR:     D10682

SOR/STR: SOR 97-11

Title:   NITF images

Description:

NITF data for actual and number of bits/pixel and justification of abpp was not being used. causes any NITF data other than 8 bit to be interpreted wrong.

===================================================================

DTR:     D10694

SOR/STR: SOR 97-11

Title:   Cancelling JTIM Product Requests

Description:

Cancelling JTIM product requests does not work correctly.  Cancelling a single request changes the status of all requests to "cancelled".

===================================================================

DTR:     D10700

SOR/STR: SOR 96-01

Title:   Maximum checks for subscription validation

Description:

I had set a maximum number of checking for subscription validation. It was set to 30. However, since we are not sure how many updates would be submitted during the synchronization process, I feel it would be safer to increse the number so it won't quit due to a large amount of updates.

===================================================================

DTR:     D10702

SOR/STR: SOR 95-47

Title:   Loading Radar Aimpoints Fails from Client

Description:

Unable to load radar aimpoints from client to server.  Worked OK on standalone W/S.

===================================================================

DTR:     D10703

SOR/STR: SOR 95-47

Title:   Landsat Imagery Load Fails, from Client

Description:

Unable to load landsat imagery from the client to the server.   Only the header file gets copied to the directory. Worked OK on standalone W/S.

===================================================================

DTR:     D10704

SOR/STR: D10200

Title:   Sysgen Can't Set Root Password

Description:

Set of root password at end of Sysgen prompts fails.  Fixes put in for D10200

assume NIS+ is running, which is not the case during initial Sysgen.

===================================================================

DTR:     D10716

SOR/STR: 6697

Title:   Kcard displaying N- for southerly planned msn

Description:

The Kcard is displaying N- for missions planned in the southern hemi.  The N-

should be displayed as an S.

===================================================================

DTR:     D10717

SOR/STR: SOR 96-01

Title:   Replication system status return

Description:

After JMCIS replication server had been shutdown, LAN deamon did not receive a correct status.

C.3
DTRS IN TEST

DTR:     D10132

SOR/STR: 6.2 init

Title:   Extra Pages on Xerox Printer

Description:

When printing strip charts from the Sparc ULTRA to the Xerox C55 printer, an extra (nearly blank) page is printed out after about every 2 or 3 pages.  The nearly blank pages have something like X123 or 12345 or X2345 patterns on them (printed once at the top of the page).

===================================================================

DTR:     D10233

SOR/STR: 6698

Title:   Kneeboard Card Ident Brg Rng Display Incorrect

Description:

The IDENT BRGRNG field on the kneeboard card is currently displaying a slash for points with no IDENT displayed and a BRG/RNG of 000/000 for points that are on top of an identifier.  The "BRG/RNG" part of the field should not be displayed if the range is zero.

===================================================================

DTR:     D10237

SOR/STR: 6699

Title:   Kneeboard Card Re-Order Data Item Selection

Description:

Due to the large number of data items available for selection in a small list window in the Re-Order window for kneeboard cards, a better selection mechanism is required.  The suggested approach is a cascading selection method similar to the Weaponeering6Loadout6Select Stores window.  The existing data items need to be grouped, where appropriate, and when the group label is selected from the first list, the next list window becomes active with the sub-items for that group item.  From the existing list in Build 3, the following groups should be implemented: Alt, Blank, Course, Distance, Divert, Fuel, Heading, Speed, Time, and UTM.  The sub-items for these groups are listed below.  All other existing data items besides those listed as sub-items below should remain in the top level list and should act as a selection when clicked on.  For the group labels, selecting the sub-item from the cascading list should act as the selection.

===================================================================

DTR:     D10238

SOR/STR: 6699

Title:   The sub-items for these Kcard groups should be the following:

Description:

Alt - Auto Alt, Alt MSL, Alt AGL; Blank - Small(5), Med(10), Large(15) (use 5, 10, and 15 spaces for these); Course - Mag Course, True Course, Course to Target; Distance - Cumulative Distance, Leg Distance, Distance to Target, Recovery Distance; Divert - Brg Rng, Divert Course - Mag, Divert Course - True, Divert Distance, Divert Fuel, Divert Heading - Mag, Divert Heading - True, Time to Divert; Fuel - Fuel Flow, Leg Fuel, Fuel Remaining; Heading - Mag Heading, True Heading; Speed - Calibrated A/S, Ground Speed, True A/S, Mach; Time - Clock Time, Elapsed Time, Leg Time, Recovery Time, Time to Target; UTM - UTM Zone, UTM Coord.

===================================================================

DTR:     D10346

SOR/STR: SOR 95-43

Title:   Problems Reusing deleted user account names

Description:

The DTR is written against Step 1 of SOR 95-43.

1.  Create a valid user account "example"

2.  Logout and login under another valid user account

3.  Delete the "example" user account using the accounts HMI

4.  Create a new user account using the same user name as the deleted one

5.  Try to log in under the deleted/recreated user account.

Sometimes you can log into this account but if you log out, you cannot log back in.  Other times you cannot log into this account at all.  If you can log into the account and open a shell, if you close the shell, you cannot reopen the shell.  This problem is repeatable on a standalone workstation.

===================================================================

DTR:     D10356

SOR/STR: SOR 95-47

Title:   Disconnect at Shutdown Reminder

Description:

When a user shuts down a connected client workstation, the user should be asked if the workstation should be disconnected from the LAN as well.  However, if the user is shutting down the workstation to update local databases, they should be warned to NOT disconnect from the MPLAN!

===================================================================

DTR:     D10360

SOR/STR: SOR 95-47

Title:   MPLAN - New IDD function uul_getUserList is inaccessible

Description:

MPLAN - New IDD function uul_getUserList is inaccessible

Problem description : During MPLAN client connection, user accounts on the client are transferred to the server.  For those accounts which conflict between client and server, the SA is permitted to rename the client account.  The new IDD function uul_getUserList permits MPMs access to those accounts which have been transferred to the server including those accounts which have been renamed.  This new IDD function is undefined when attempting to link the F/A-18 MPM.  It appears that this function was compiled with the C++ compiler which scrambles the name in the *uul* shared object library.  The F/A-18 MPM is compiled with the C compiler which is unable to find the C++ compiled function.  It appears that the other IDD functions are compiled with the C compiler rather than the C++ compiler.

F/A-18 Impact : Unable to utilize this IDD interface.  The F/A-18 MPM requires knowledge of those accounts which have been renamed in order to change the user names stored with the F/A-18 unique mission data.  Missions owned by users who have had their accounts renamed will be inaccessible while connected to the server via MPLAN.  The information is stored in a TAMPS Core data file *renames* but the content of this file is not documented in the IDD (it appears to be a simple ASCII file which could easily be parsed by the F/A-18 MPM but without being documented in the IDD the file format could change without approval by the F/A-18 program).

===================================================================

DTR:     D10361

SOR/STR: SOR 95-43

Title:   Error Invoking FA-18 MPM from WSE Menu Bar

Description:

Invoking the FA-18 MPM to be run from the WSE menu bar causes the FA-18 MPM to crash during startup.

Impact:  Must change the way the FA-18 MPM is being started up.  At this time we are unclear why the FA-18 MPM is crashing during startup.  We are able to run the FA-18 MPM from a shell, which is how we normally run it during MPM development.  We did notice that the WSE startup has changed where previously a remote shell login was used to invoke WSE.  Now the WSE is run directly.  We temporarily changed the WSE startup to again use a remote shell login and we were able to run FA-18 MPM without a problem.

===================================================================

DTR:     D10363

SOR/STR: SOR 95-47

Title:   Unable to transfer mission between client/server

Description:

The ability to transfer missions between client and server is performed through invocation of the new TAMPS core "Mission Data Transfer" HMI menu.  This new menu allows the user to select "Source" and "Destination" options for controlling the transfer of mission data.  The FA-18 MPM has registered a mission import/export callback that is invoked by the TAMPS core for allowing the MPM to import/export unique FA-18 mission data to tape devices.  It is understood that this MPM callback would be used by the TAMPS core for transfer of mission data between client and server.  Prior to invoking the import/export callback, the TAMPS core will assign the TAMPS environment variable $DYNAMIC_MPM to point to either the server or client dat area as required to handle the mission transfer as indicated by the "Source" and "Destination" fields on the HMI menu.  Our testing has shown that the $DYNAMIC_MPM environment variable is not being assigned correctly for handling data on the client.

FA-18 Impact:  Without being able to register a callback for specifically handling mission transfer across the MPLAN, the FA-18 MPM is being modified to handle the dynamic assignment of the $DYNAMIC_MPM environment variable in order to correctly transfer unique FA-18 mission data between client and server.  Unable to test this capability which allows validation of the MPLAN transfer process.  This is an essential capability of the MPLAN CONOPS.

===================================================================

DTR:     D10364

SOR/STR: SOR 97-13

Title:   PFPS - Unable to list only FA-18 PFPS missions

Description:

The new TAMPS core PFPS import menu lists all the mission contained on the PFPS floppy disk.  An option on the menu allows the user to show only the MPM (FA-18) mission which results in no mission listed.

FA-18 Impact:  No showstopper here since the FA-18 mission could be selected from the list of all missions.

===================================================================

DTR:     D10365

SOR/STR: SOR 97-13

Title:   PFPS - Improper Invocation of MPM Registered Callbacks

Description:

The FA-18 MPM registers with the TAMPS core callbacks for notification of operations dealing with mission new, open, delete, save, save_as, autosave, import, and export.  Operations dealing with mission save, save_as and autosave all were intended to be used on the current active mission.  Import of a PFPS mission through the TAMPS core functionality is invoking the mission save registered callback with a file operation argument set to APT_SAVE, APT_DELETE, and APT_NEW (note that APT_DELETE and APT_NEW are invalid file operations for the mission save registered callback).  The proper file operation should be APT_NO_FILE_OP which indicates that no file operation should be performed even though the mission save callback has been invoked (this is a patch put in by the TAMPS core when these registered callbacks were first introduced when it when it was discovered that the TAMPS core mission import functionality was invoking the mission save registered callback).

FA-18 Impact:  Invocation of the mission save registered callback without the proper file operation (APT_NO_FILE_OP) causes the FA-18 MPM to try a save of the current mission.  This fails because the data passed to the registered callback is for the PFPS mission being saved no the users current working mission.  An error is returned to the TAMPS core and an FA-18 error message is issued to the user indicating that the mission save operation has failed.  The TAMPS core proceeds to inform the user that the PFPS import of the mission has succeeded.  I am not sure what has really happened with the PFPS mission.

===================================================================

DTR:     D10366

SOR/STR: SOR 97-13

Title:   PFPS - Unable to use AXT_MISSION_SOURCE handle to get origin of mission

Description:

Import of a PFPS mission stores the mission in the TAMPS core mission database with a new mission field (Missison_Source) set to "PFPS".  Unlike a mission import the PFPS mission import does not support MPM registration of a callback to permit the MPM to know about the newly created TAMPS core mission.  The FA-18 MPM must stay in sync with the missions stored by the TAMPS core in order to maintain unique FA-18 mission data.  A new "Mission Handle" for "AXT_MISSION_SOURCE" was to be introduced which can be used when the FA-18 mission open callback is invoked by the TAMPS core.  Supoort for this new handle data is not provided.

FA-18 Impact:  The new "AXT_MISSION_SOURCE" handle will be used by the FA-18 mission open callback for determination of the origin of the mission.  Without this information, PFPS mission imported into TAMPS will be unusable.

===================================================================

DTR:     D10369

SOR/STR: SOR 95-47

Title:   MPLAN Hardware Connection

Description:

If an attempt is made to connect a client workstation to the MPLAN server and the Hardware (either Ethernet or ATM) is disconnected or broken somewhere, the connect process will hang up.  There should be a check at the beginning of the connect process to see if the client can communicate with the server.  If not, the connect process should be aborted and the user informed of a potential cable problem.

===================================================================

DTR:     D10399

SOR/STR: SOR 95-43

Title:   tet_getmapfilenames is slow

Description:

Calling tet_getmapfilenames to determine existence of files is slow.  For imagery, it can take up to 7 or 8 seconds.  This adds a considerable amount of time to our loading process, since we call tet_getmapfilenames for each CADRG, DTED, and CIB frame we wish to load.  This results in thousands of calls to this routine per load.

===================================================================

DTR:     D10400

SOR/STR: SOR 96-01

Title:   Equipment codes not retrieved by dft_getorderofbattle

Description:

When calling the routine dft_getorderofbattle, we get all of the fields correctly, with the exception that the equipment code field is always empty.  We have to have this field populated to correlate the threat sites returned by dft_getorderofbattle to the NID database.

===================================================================

DTR:     D10402

SOR/STR: SOR 96-01

Title:   MIDB Threat Data

Description:

The data is there but HARM MPM cannot get to it. We can't call up any of the threats.

===================================================================

DTR:     D10404

SOR/STR: SOR 95-43

Title:   HARM MU Load crashes when invoked

Description:

We think it is because the stored procedure you call has been moved to the new data base for stored procedures, but you didn't change the address for this particular SP.

===================================================================

DTR:     D10439

SOR/STR: ???

Title:   Creating SLAM ER Tagset crashes MPM

Description:

From SLAM ER MPM Developers:

System crashes when trying to create SLAM ER tagset.

Problem is with BAM tables:

(bam_insertFiles:  Failed to execute insert Failure return from insertFiles)

This problem occurs on both a 6.2 client workstation and the server.

===================================================================

DTR:     D10636

SOR/STR: SOR 96-01

Title:   Limit DBA MIDB Tools when connected to GCCS-M

Description:

During testing of the MIDB SOR while connected to GCCS-M, it was found that may of the support data bases do not exist on the GCCS-M server.  This causes the MIDB Query tool to NOT WORK.  Recommend that a message be displayed to the DBA when selecting this option while connected to GCCS-M.

Although Data Exchange does work, it seems dangerous to allow access to it while connected to GCCS-M.  Its main purpose is for a standalone TAMPS to process TFs, which is unnecessary while connected to GCCS-M: the implementation of DEX on GCCS-M should be how that it done.  The other reason for DEX is to backup and apply tactical updates, which should also not be required in a GCCS-M-connected environment.  Recommend that a message be displayed to the DBA when selecting this option while connected to GCCS-M.

Note: Access to the production software via the Update pulldown requires GCCS-M to install the SUPPORT isql directory, which is not done in the current version of their GMIDB segment.  PRC will handle this in the Juliet version of their GMIDB segment.  For now, we installed the appropriate data into jots19 to continue testing.

===================================================================

DTR:     D10637

SOR/STR: SOR 95-43

Title:   E-4000 NIS+ Installation Failed

Description:

NIS+ installation failed on the E-4000, halting Sysgen.

===================================================================

DTR:     D10641

SOR/STR: 6850

Title:   TOPSCENE not processing Threat Data correctly

Description:

Output of the radar and weapon max eff range (nm) does not match values in the database.  Also, need to change the units for lat/lon from radians to decimal.

===================================================================

DTR:     D10642

SOR/STR: SOR 96-01

Title:   dft_getTargetData only returns Planner Targets

Description:

The function dft_getTargetData() only returns data on Planner targets;

it does not include any data from the MIDB target tables.

===================================================================

DTR:     D10645

SOR/STR: 6425

Title:   GCCS WX Daemon Startup Script Incorrect

Description:

GCCS WX profiler startup script does not properly set the NIPS_HOME env

var before starting the daemon.  Also the shutdown option does not shut

down the daemon

===================================================================

DTR:     D10649

SOR/STR: SOR 95-47

Title:   mplan connect pre-connect warning help not working

Description:

mplan pre connect warning help does not work

===================================================================

DTR:     D10653

SOR/STR: 6698

Title:   Kcard ReOrder Tool wrong help file

Description:

Help file is the help file of the old Kcard ReOrder Tool

===================================================================

DTR:     D10654

SOR/STR: 6698

Title:   Kneeboard Card Launch/Recovery Name

Description:

The KCard should, in addition to ICAO, show the launch/recovery pt airbase name, as in the example provided. Some bases do not have an ICAO, and the planner cannot put a description in EFP for launch/recovery pts.

===================================================================

DTR:     D10656

SOR/STR: SOR 95-47

Title:   HI Client not accessing server Databases

Description:

When connected as a Hi client, all queries to databases returned no data, when there was data loaded on the server but none locally.

===================================================================

DTR:     D10657

SOR/STR: SOR 95-47

Title:   Can't Select Local Printer using Printer Designate HMI

Description:

This is a repeat of DTR #610 which fails but cannot be demoted:

MPLAN Admin > Set Default Printer, if a remote printer is the default for the workstation and the user then selects the local printer as the default (highlight and select OK), the designation fails.  The workstation is left with no printers available in the Set Default Printer HMI (including the local printer) and cannot print anywhere.

The correct method is to select Delete (when a remote printer is the default) then the local printer is made the default printer.  The Help file does not mention this fact though!!

===================================================================

DTR:     D10658

SOR/STR: SOR 95-47

Title:   Could not print to a remote workstation's printer

Description:

I was on a connected client workstation (california) with another workstation (iowa) and the permanent client (lifeboat) also connected (with printers) to the E4000.  I could designate and print to the printer on the permanent client but could not print to the iowa printer.  The iowa printer showed up as the default printer after designating but any print jobs sent to it did not reach it and also did not show up in the Print Queue HMI.

===================================================================

DTR:     D10659

SOR/STR: SOR 95-47

Title:   Default Printer at Disconnect

Description:

If a workstation has a remote printer designated as it's default printer and the remote printer is taken offline (the machine it is attached to is disconnected from the MPLAN), the workstation will then have no default printer.  The problem is, when the Sys Admin on that workstation tries to designate a different printer using the Set Default Printer HMI, this process fails and an error message is displayed.  The SysAdmin has to run:  "lpadmin -d cops" from the command line as the root user to clear the problem (and designate the workstation's local printer as default).

===================================================================

DTR:     D10660

SOR/STR: SOR 95-47

Title:   LAN Printer not working

Description:

With a serve lite(no local printer) using ethernet and one client connected with a printer. Designated the client printer as a network printer using the menu under MPLAN> Designate Network Printer. On the server lite selected the client printer as the default. It showe up in the Set Default Printer window as the default, but could not print anything from the server lite. In shell lpstat -l -p showed cops_arizona  faulted after the entry for Default port settings.

===================================================================

DTR:     D10661

SOR/STR: SOR 95-47

Title:   HI Client NIS Passwd table deleted

Description:

After disconnecting a Hi Client from MPLAN, user could not log into system using previous valid accounts. Logged in as root and checked niscat passwd and the table was empty.

===================================================================

DTR:     D10663

SOR/STR: SOR 95-47

Title:   Mission Import from tape messages

Description:

This is similar to DTR #381 except this pertains to mission import from media vice xfer between client/server.

If a Mission Import to either a client or server database from Media is performed and the database already contains missions with the same names as those being transferred, error messages are properly displayed.  However, a message saying "Mission Import Completed Successfully" is displayed also.

===================================================================

DTR:     D10665

SOR/STR: SOR 97-11

Title:   Incorrect JTIM Image Retrieve Time

Description:

After performing a JTIM query from the SPA thinline, all images show the same time to retrieve (2:36:00)

===================================================================

DTR:     D10672

SOR/STR: SOR 95-43

Title:   No Additional MPM Can Be Opened

Description:

It is becoming relatively common (a daily occurrence), during testing, for one of the workstations to reach a state where no additional MPMs can be opened.  The conditions under which this occurs vary, but a common thread seems to be that a DBA Module is open at the time of the failure, and usually the user reports recently loading or transferring data to/from the database.  Usually stopping and starting the object server clears the problem, but sometimes a reboot is required.

Related to ITR 629i

===================================================================

DTR:     D10680

SOR/STR: SOR 95-47

Title:   GCCS Admin applications need Hour Glass displays

Description:

The GCCS Admins applications sometimes take more than a few seconds.

An hourglass should be displayed per the HMI guide.

===================================================================

DTR:     D10683

SOR/STR: SOR 96-60H

Title:   Attempt to export an object that was imported, hangs up process

Description:

Exported a new test object NAVY_TACANS with one associated query to 3.5 floppy. Then deleted the object. Imported the object to same system and no problems. Rebooted system and Object/Query was there. Next, tried to export the same object to 8mm tape and it just hung up the process. Used the default tape device 8mm hi dens. Had to kill the oil_Export process. Also, it looked like the .odf file was not created. Created another new object and it exported to tape OK.

96-60H.2

===================================================================

DTR:     D10687

SOR/STR: SOR 97-11

Title:   JTIM MGRS Value Sticks

Description:

The MGRS value in the JTIM imagery toolkit only updates the first time a lat/lon is selected.  After that any lat/lon pick from the image using the arrow updates the lat/lon value, but not the MGRS.

===================================================================

DTR:     D10695

SOR/STR: SOR 95-47

Title:   Unable to Load Charts from Client

Description:

Tried to load a TPC chart from a client workstation to the E4000 server.  Got error message:  "Ran out of storage space on the selected destination drive.  You may choose another destination or cancel load" even though there is plenty of space available in the server maps directory.

This problem is caused by the problem reported in DTR 633 - server directories not being cross-mounted.

===================================================================

DTR:     D10697

SOR/STR: SOR 96-01

Title:   Missing data items in dft_getTargetData()

Description:

The function dft_getTargetData() does not fill in the vertical location error

or the photo chip number for planner targets, even though this information

is available in the data record.

===================================================================

DTR:     D10698

SOR/STR: SOR 95-47

Title:   MPM connect/update scripts being run at wrong time.

Description:

The update script is invoked after the user logs in followed by the MPM Connect script.

I would expect only the Connect script to be invoked.  Furthermore, the connect script

must be invoked AFTER the account deconfliction has taken place permitting the FA-18 connect script to address the client accounts which

have been renamed for transfer to the server.

===================================================================

DTR:     D10699

SOR/STR: SOR 95-47

Title:   Misleading Error When Loading Charts

Description:

If a user attempts to reload a chart which has already been loaded, an error message is displayed that says: "Ran out of storage space on the selected destination drive.  You may choose another destination or cancel load".  This error is misleading since the user will believe that there is no room to load additional charts, even though there may be plenty.

This problem is different than the problem described in DTR 695, and happens on any hardware set-up, including stand-alone workstations.

===================================================================

DTR:     D10710

SOR/STR: SOR 96-52M

Title:   PC Card Formatting Code Missing Colons

Description:

Commas missing from Boeing provided Core PC Card Formatting code.  Makes formatting code which is critical to TAMMAC functionality unusable.

===================================================================

DTR:     D10713

SOR/STR: SOR 95-43

Title:   Black Ghost cursor on PCs

Description:

On the two PC Xterms with Win95 loaded, the data entry fields all show a large black "Ghost" cursor in entry windows. The PC with NT looks OK.

===================================================================

DTR:     D10715

SOR/STR: HelpFilesInit

Title:   Lockheed help files

Description:

Corrections to existing help files.

C.4
DTRS IN WORK

DTR:     D10037

SOR/STR: 6.2 init

Title:   Display Aircraft Mission (Column Width)

Description:

The columns in the "Display Aircraft Missions" widget under the Route menu are varying in width.  They appear to be following the width of the longest mission name being displayed.  These columns should be a fixed width, as in 6.1.1.  This may also occur in the "Display Weapon Missions" widget, but we have no weapon MPMs to check with.

===================================================================

DTR:     D10038

SOR/STR: 6.2 init

Title:   Button Text Left Justified

Description:

The button text on many of the report creation windows is left justified.  All button text should be centered on the button, as in 6.1.1.

===================================================================

DTR:     D10121

SOR/STR: 6216

Title:   Polygon or Corridor Geo Create

Description:

Cannot edit the points of a Polygon or Corridor Geo - must pick new points from the map.  This should work like picking/editing points for a minefield in FAMP - each point can be entered/edited individually.

===================================================================

DTR:     D10122

SOR/STR: 6216

Title:   Corridor Geo Half-Width

Description:

When creating a new Corridor Geo, you must set the half-width before selecting points - you cannot change this setting at any other time.  Should be able to edit this parameter at any time.

===================================================================

DTR:     D10154

SOR/STR: 6.2 init

Title:   Amp Info Lat/Lon

Description:

Amp Info for many of the objects queried from the database, including airbases, navaids and waypoints contains Latitude and Longitude information twice, providing redundant information to the user.

===================================================================

DTR:     D10156

SOR/STR: SOR 97-10

Title:   Inability to Obtain CADRG or CIB Files by Scale

Description:

The tet_getMapFilenames interface dies not allow the user to obtain filenames based upon scale.  The net result is that the function returns all files within a geographic region instead of the specific files needed.  The user must then filter the returned list to extract the needed files, a requirement imposed on the user that was unexpected and will add to CADRG and CIB processing times for TAMMAC.

===================================================================

DTR:     D10187

SOR/STR: 6697

Title:   Doghouse Component Data Items:  HMI display of 2- & 3-part components

Description:

The 2- and 3-part HMIs presented for Doghouse Component Data Item editing show only a subset of the types available.  In particular, only the united 2-part component and the 3-part component (2 parts on left, one large part on right) are provided.  Based on the type of component selected by the user,  the left-portion or right-portion only (for a 2-part component) and the mirror of the 3-part component (i.e., one large part on the LEFT, and 2 smaller parts on the RIGHT) must also be displayable in the editing HMI

===================================================================

DTR:     D10225

SOR/STR: SOR 95-47

Title:   Date & Time Change While loading DAFIF

Description:

The Date that was loaded when the system was loaded was a 23 Dec 97.   During the loading of DAFIF ED5 9713, I changed the date back to 22 Dec 97.   This caused problems in sybase.    Because the DAFIF was hung up,  after 3 hrs I terminated the DAFIF load.   Talked to Bill M. and he said yes it does cause problems in the sybase, like NIS+ and other files.

Do not change the date & time during the time your loading data to sybase.

Stand alone systems.

===================================================================

DTR:     D10227

SOR/STR: 6.2 Init

Title:   Database and Dataset menu conformity

Description:

Dump/Restore shows the following database selections:

None

DAFIF_GPS

GMI

NID

tamps

TAMPS_SPROCS

and the Database usage shows this as the database dropdown:

NID

MIDB

MIDB_Subset

TAMPS

DAFIF/GPS

believe this should match, as closely as possible and in the same order, to what is in the Dump/ Restore dropdown and should read as follows:

DAFIF_GPS

GMI

GMI_SUBSET

NID

tamps

In addition, the tamps dataset of the Database Usage menu is not correct and should be modified as follows:  Delete from the menu selection the following databases/datasets: CONSTRAINT, DAFID, GMI, GPS, IDB, NID, TAC and TMP.  These are covered in other areas/menus and the remaining databases/datasets all fall under the tamps database.

===================================================================

DTR:     D10264

SOR/STR: SOR 95-43

Title:   Go-NoGo Fail on floppy

Description:

On a standalone Ultra2, the Go-NoGo test fails for the floppy drive. Report shows FATAL: Couldn't open /dev/rdsk/c0t0d0s2. Looks like it is looking for device name of /dev/rdsk/c0t0d0s0 which may not be correct on the Ultra2.

===================================================================

DTR:     D10265

SOR/STR: SOR 95-43

Title:   Go-NoGo Fail on TIDS

Description:

On standalone Ultra2 with TIDS connected to serial port A, the Go-NoGo test fot the TID fails. Report indicates Error: Bad status redeived from the E2-C TID. This may not have been updated for the new TIDS box.

===================================================================

DTR:     D10266

SOR/STR: SOR 95-43

Title:   Go-NoGo Fail on Monitor

Description:

On standalone Ultra2, the Host Graphics Monitor Test consistently fails. The screen goes through various test displays but the test fails. The report indicates Error: 3DRAM Test error, 3DRAM Memory error, Buffer A SFB Red Plane at (0,0).

===================================================================

DTR:     D10271

SOR/STR: SOR 95-43

Title:   Sysgen vxfs

Description:

Implement Veritas file system (vxfs) on E-4000.

SOT Step 95-43.1

===================================================================

DTR:     D10272

SOR/STR: SOR 95-43

Title:   Sysgen Quick IO

Description:

Implement Veritas Quick IO

SOT Step 95-43.1

===================================================================

DTR:     D10304

SOR/STR: 6698

Title:   Kneeboard Card Window Resizing

Description:

Resizing the kneeboard card window does not change the size of the displayed data, it only creates a larger blank area.  Resizing windows should result in the display area resizing or there is no point in resizing.  Chronic TAMPS problem - we should not be replicating it in new interfaces!!

===================================================================

DTR:     D10310

SOR/STR: SOR 96-01.2

Title:   MIDB New Installation/Facility Key screen opens behind WSE Menu

Description:

The New Installation/Facility Key screen opens up behind the WSE menu bar requiring the user to physically move the screen.

===================================================================

DTR:     D10321

SOR/STR: SOR 96-01.2

Title:   MIDB Baseload and MIDB TF load

Description:

Currently the system allows a DBA without Modify MIDB privileges to go through the process of loading an MIDB baseload tape before finally letting that user know that the Modify MIDB privilege is required.  MIDB TF load also applies though no warning is delivered.

These should be greyed out or not appear at all so that the user knows from the start that he/she does not have the proper privileges.

===================================================================

DTR:     D10335

SOR/STR: SOR 96-01.3

Title:   Exercise/Scenario data load capability

Description:

Currently the only way a user can load exercise/scenario data into TAMPS is via the MIDB Baseload function which (1) is not very intuitive and (2) deletes all MIDB data currently on the system to be replaced by whatever is on the exercise/scenario data tape.  NO WARNINGS are displayed.

A new menu item should be created for loading exercise/scenario data with a confirmation box/disclaimer indicating that all current MIDB data will be overwritten if the user proceeds.  Ideally, there should be an option to allow appended exercise/scenario data to the MIDB database without deleting the current load as long as it does not conflict with any data previously loaded.

===================================================================

DTR:     D10349

SOR/STR: 6216

Title:   Unable to Overwrite Saved Geos

Description:

When a user creates a new geo using the toolbar icon or one of the other "quick geo" selections from the geo filter menu, and then tries to create another new geo using a similar method, an error message is displayed that says:  "CURRENT_GEO will be overwritten.  Continue?"  If yes is selected, a new error message is displayed that says:  "Geo with name CURRENT_GEO exists.  Please rename with a name other than CURRENT_GEO".  If the user selects to overwrite the saved geo, it should be overwritten.  This worked in earlier builds and destroys the "quick geo" feature of the toolbar icon and the menu options.  Tested on E4000 server.

===================================================================

DTR:     D10352

SOR/STR: SOR 95-47

Title:   Hidden Widget in Update Database Dumps

Description:

When updating the Database Dump files on the server, the message window:  Database Updated Successfully is displayed behind the Update Database Dumps widget.

===================================================================

DTR:     D10372

SOR/STR: SOR 95-47

Title:   Mission Save As Function

Description:

Created a mission on the server of a client/server setup using one account, and then opened the mission on the client using a different account which had not yet been used to create a mission.  Got a message about Autosave being enabled and instructing me to rename the mission using Save As.  Selected Save As and tried to save with a different name, but got an error: "No planner selected".  The name of the account being used was not listed in the list of possible planners and could not be selected.  Was unable to perform a Save As operation until a new mission was created first.  Creating a new mission using the account added the account name to the list in the Save As dialog.

===================================================================

DTR:     D10383

SOR/STR: SOR 95-47

Title:   Chart/Imagery Data Load from Server to Client

Description:

When loading chart or imagery data from the server, the message window shows:  "Loading Chart/Imagery (X of X)".  It should show what percentage is loaded as it does when loading from a CDROM.

===================================================================

DTR:     D10398

SOR/STR: SOR 95-43

Title:   No length returned in tet_getmapdata

Description:

The tet_getmapdata routine returns a pointer to the data it retrieved.  However, no length is returned, so the caller does not know how long the data array is.  To workaround this, we stopped using the Core routine, and retrieved the file ourselves.

===================================================================

DTR:     D10403

SOR/STR: SOR 95-43

Title:   FOV Ellipses

Description:

They are very rough when drawn off of cardinal headings. At 270deg, one side is rough and the other is smooth.

===================================================================

DTR:     D10593

SOR/STR: SOR 95-43

Title:   ATM Card Driver only installs during sysgen

Description:

If a TAMPS workstation is loaded and there is not an ATM card installed before the load, then the system must be reloaded after installing an ATM card to connect using ATM. Just doing a boot -r does not load the driver. This may cause problems if systems are intially loaded without ATM and then deployed aboard a CV and ATM needs installed.

===================================================================

DTR:     D10646

SOR/STR: 95-47

Title:   Change workstation IP Address

Description:

There is no capability to change a workstations own IP_address once it has

been sysgen'd.  This capability may be needed if a case arises where a

workstation's ethernet subnet address happens to be the same as the ATM subnet address

of the MPLAN it is attempting to connect to.  If they are the same, the

error checking utilities of MPLAN to validate the Server address must be

bypassed.  The ability to change a workstations IP address would allow the

SA of the connecting workstation to change the ethernet address thus

ensuring maximum use of the MPLAN error checking.

===================================================================

DTR:     D10651

SOR/STR: 95-43

Title:   TAMPS loader stores NITF image size in bytes, not kbytes

Description:

When the TAMPS Database Administrator module loads an NITF image,

it stores the size of the image in bytes (as read from the image header).

This is contrary to the IDD description of the TIT_IMAGE_STRUCT

structure, which indicates that this value should be in kbytes.

No code appears to use this value (it is stored in the catalog for information

only), so it should be a matter of updating the loader code to convert the

loader code to kbytes.

===================================================================

DTR:     D10664

SOR/STR: SOR 97-11

Title:   Multiple JTIM Image Retrieve

Description:

Sent a retrieve request for 6 JTIM images from a client workstation.   The first attempt resulted in 3 images being retrieved (status changed to "Available").  The other 3 images remained in the "Retrieving" state, with no indication of a problem.  After several minutes, cancelled the retrieve request, sent another request for the remaining images, and the remaining images were successfully retrieved.  Tried requesting 6 images again and only 4 images were retrieved.  Results appear to be inconsistent when requesting multiple images.

===================================================================

DTR:     D10667

SOR/STR: SOR 97-11

Title:   Grid Not Filled in for JTIM Box

Description:

Sometimes when boxing in the world using the rubberband box function in the JTIM Query Details dialog, the southeast grid is not filled in.

===================================================================

DTR:     D10675

SOR/STR: SOR 97-11

Title:   JTIM Toolkit Under WSE

Description:

The JTIM Imagery Toolkit comes up under the WSE when it is opened from the Threat/Intel -> JSIPS-N -> Imagery Toolkit menu option.

===================================================================

DTR:     D10676

SOR/STR: SOR 96-01a

Title:   Database selection in Profile Maintenance incomplete

Description:

Database selection in the MIDB production tools (Profile maintenance) only lists four databases instead of the complete list.  The two systems (iceberg and missouri) that have MIDB loaded show the following in the database drop list box (profile maintenance) :

E4000:                          Missouri

Tamps                           Dafif-gps

Dafif-gps                        DB_Support

NID                                MS

Tamps_sprocs               Obscon

Neither of these show the gmi database or the rest of the listing.

===================================================================

DTR:     D10678

SOR/STR: SOR-95-43

Title:   Update Sysgen Printer/PC/Default Router Prompts

Description:

Prompt for a second Default Router on the CVIC E-4000, default both router

IP addresses to *.*.*.1 and *.*.*.2, where *.*.* is the TAMPS LAN network.

Indicate to the installer that router host names are not critical - provide

generic defaults.

Hard code the IP addresses of CVIC network printers and PC planning

workstation networks on the RFC 1597 private Class C network of

192.168.0.0.

Update the install instructions as necessary.

===================================================================

DTR:     D10684

SOR/STR: SOR 97-11

Title:   Incorrect JTIM Message

Description:

Selected a JTIM image that was marked "Saved" and displayed it in the imagery toolkit.  Selected File -> Exit and got a message saying "Image has not been saved.  Do you still wish to exit."  This message is incorrect.

===================================================================

DTR:     D10685

SOR/STR: SOR 97-11

Title:   Cryptic JTIM Error message

Description:

If a user tries to save an image using the same name a previously saved image, a cryptic error message is displayed: "Unable to save xxxx to TAMPS".  The message should say that an image with that name already exists.  Please use a different name.

===================================================================

DTR:     D10686

SOR/STR: SOR 97-11

Title:   JTIM Lat/Lon Select

Description:

When a user first enters the JTIM imagery toolkit, the "arrow" toolbar icon is highlighted, but cannot select lat/lon from the map.  Must select the arrow button again to get the lat/lon function to work properly.

===================================================================

DTR:     D10688

SOR/STR: SOR 97-11

Title:   Selecting JTIM Graphic Objects

Description:

When editing graphics in the JTIM imagery toolkit, it is difficult to determine when an item has been successfully selected.  Sometimes items appear to be selected when they are actually not, and vice versa.  There is no indication of what is selected until the user attempts to change color or delete the objects.

===================================================================

DTR:     D10689

SOR/STR: SOR 97-11

Title:   Changing JTIM Text Background

Description:

Changing color of JTIM text using the graphics menu causes the background to change color.  Once this has been done, there is no way to change it bakc to clear.

===================================================================

DTR:     D10690

SOR/STR: SOR 97-11

Title:   JTIM Imagery Toolkit Moves Under WSE

Description:

Each time an image chip is created or the image chip is cancelled using the right mouse button, the imagery tookit is moved up under the WSE menu bar.

In accordance with the TAMPS style guide, dialogs shall never be placed so that the top of the window is hidden by the WSE menu bar.

===================================================================

DTR:     D10691

SOR/STR: SOR 97-11

Title:   Editing JTIM Text also Affects Graphics

Description:

Placed some text on a graphics object in the JTIM imagery toolkit, then box selected the text and object in order to change the text font size.  The text correctly changed size, but the object size was also changed.  Changed the text color and the object border was also changed.  Changes using the text menu should only apply to selected text, and changes using the graphics menu should only apply to graphics objects.

===================================================================

DTR:     D10692

SOR/STR: SOR 95-43

Title:   Multicast Router Daemon not starting

Description:

Loaded a Workstation with the multicast option turned on. After load the multicast daemon was not running. It appears that the multicast loads before the interfaces are configured and it has the default IP address.

===================================================================

DTR:     D10693

SOR/STR: SOR 97-11

Title:   Arrows On JTIM Polygons

Description:

Arrow styles get applied to all JTIM polygons in the imagery toolkit.  Arrows should only be applied to individual lines.

===================================================================

DTR:     D10696

SOR/STR: SOR 95-47

Title:   MPLAN Set Default Printer HMI window

Description:

The HMI window for System Admin->MPLAN Administration->Set Default Printer is too narrow and truncates the printer location field.  Since this is a fixed-size window, user has no way of seeing whole field.

===================================================================

DTR:     D10705

SOR/STR: SOR 95-47

Title:   Loadout Crashes MPMs on PC

Description:

Selecting Weaponeering -> Loadout in any MPM on the PC Xterms that are loaded with Windows 95, crashes the MPM.  Opening the loadout on a PC loaded with Windows NT does not produce a crash.

===================================================================

DTR:     D10706

SOR/STR: SOR 96-01.3

Title:   Need way to view TAMPS Rep Server log for errors

Description:

We need a way to view the TAMPS Rep Server error log other than via a shell.  At a minimum, this could be via sitting at a GCCS-M machine and using the RSM tool, but this tool cannot access the TAMPS Rep Server log without a piece of the RSM software being installed on the TAMPS server.

As noted in 708, the DBA or SA should be notified when something is wrong.

Test step 96-01.3

===================================================================

DTR:     D10707

SOR/STR: SOR 95-47

Title:   Mouse Pointer Gets Moved on PCs

Description:

On the PC Xterms, the mouse pointer gets moved to the lower right corner of the display after performing various operations.  For example, each time the route is validated, the cursor gets moved.  This means that if Route Validation is ON, the pointer gets moved each time a new point is dropped on the map.

===================================================================

DTR:     D10708

SOR/STR: SOR 96-01

Title:   Doing certain Fac updates on TAMPS connected to GCCS-M cause rep to suspend

Description:

When connected to GCCS-M, facility creation of working records seemed to work.  However, things went downhill fast when a working record was attempted to be updated.  I first got a message "unable to connect to database" within the production software.  Tried to add a new facility again and the app got blown away.

We checked the TAMPS Rep Server log and it showed errors regarding FAC_VULNERABILITY (have no idea why, since we didn't edit that table).  We got rep back by doing a "skip transaction."  This is not good, since skipping the transaction will cause problems with any future updates to that record.

The DBA or SA should be notified when something is wrong.

===================================================================

DTR:     D10709

SOR/STR: 96-01.16

Title:   MIDB Dataset removal

Description:

There is a requirement that states that MIDB data (GMI or target) is not allowed to be removed if the MIDB data is being replicated from JMCIS.  There is no warning or information displayed that says the user is not permitted to remove the dataset.  When Utilities -> Data Removal -> Dataset... is selected a confirmation message pops up saying, "Do you really want to remove the GMI dataset?"

I believe a message should pop up indicating that the user does not have permission or is prohibited from removing the MIDB GMI or target data while being replicated from GCCS-M"

===================================================================

DTR:     D10711

SOR/STR: SOR 95-47

Title:   RTMs not displaying correctly on Client

Description:

On a connected Client RTMs only display as circles if there is no DTED for area loaded on local system. DTED displays fine in background and RTMs work OK on server and standalone. Also, when load DTED to a client from server, then RTMs would work correctly. On Permanent Client RTMs always circles even when DTED was loaded on client.

===================================================================

DTR:     D10712

SOR/STR: SOR 95-43

Title:   PC, DCW Features

Description:

DCW browse and DCW features not displaying consistently on PC Xterms. One PC doesn't display anything,  one was displaying browse but no features and the NT ver, displays both.

===================================================================

DTR:     D10714

SOR/STR: 6697

Title:   Stripchart crashes frequently

Description:

When on a standalone Ultra 1200, stripcharts are crashing frequently while pulling in TPC data and modifying doghouses. Also, when try to load a previously saved doghouse. Sometimes causes a logoff when trying to open a saved stripchart.

===================================================================

DTR:     D10718

SOR/STR: SOR 97-11

Title:   JTIM Causes Problems on PCs

Description:

If the JTIM Toolkit is opened on a PC Xterm and an image is loaded, it causes problems with color mapping.  The TAMPS map background becomes discolored and objects in the tookit are black and white.

This is caused by the display being set at 256 color instead of 24-bit.  However, if the display is changed to 24-bit, the TAMPS application becomes too large and unmanageable for the screen.

Note:  On the NT system,  changing to 24-bit and lowering the display resolution makes the system useable, but slower.

===================================================================

DTR:     D10719

SOR/STR: 6697

Title:   Saving strip charts logged me off the server lite

Description:

Created a msn with approx 9 nav pts.  Then selected Strip Charts -> did a save of the strip charts and during the save and exit this logged me of the server lite.  I was connected to client jersey via ethernet.

===================================================================

DTR:     D10720

SOR/STR: SOR 96-01

Title:   MIDB Units not creating Tgt ID & Tgt Definition for Planner Tgt Updates Window

Description:

The Units OOB data for MIDB, does not update the Tgt ID number and Tgt Definition name for the Planner Target Updates Window.

===================================================================

DTR:     D10721

SOR/STR: SOR 97-11

Title:   Unable to Display JTIM Images on TAMPS

Description:

Images retrieved from the JTIM SPA server and saved to the TAMPS database can not be displayed to the TAMPS map background.

===================================================================

DTR:     D10722

SOR/STR: SOR 96-01

Title:   JTIM Target Data Not Extracted from Target Folder

Description:

Unable to extract target data from target folders that are retrieved from JTIM SPA server.

===================================================================

DTR:     D10723

SOR/STR: SOR 95-47

Title:   LAN Admin Tool Edit option for High Side Client

Description:

High Side client should be able to edit the NIS+ hosts table, since he is still in his own NIS+ server domain during connection.

===================================================================

DTR:     D10725

SOR/STR: SOR 96-01

Title:   TAMPS-specific MIDB GMI view not created (FAC/EQP)

Description:

One of the three new views installed during Data Base installation do not get installed, due to an extra period in the Install_midb_tamps.csh file.

Workaround is to enter the following two commands in a shell:

cd $DB_INSTALL/midb_tamps

isql -Utamps -Ptamps60 < TAMPS_EQP_FAC_VIEW.sql

Note: This was introduced during the correction of DTR 483.

===================================================================

DTR:     D10727

SOR/STR: 6850

Title:   TOPScene SPROCS installation failing

Description:

The TOPScene SPROCS are being installed prior to the GMI data tables being

populated.  This causes the installtion to fail.

===================================================================

DTR:     D10728

SOR/STR: SOR 95-47

Title:   Printing causes lpsched to run away

Description:

Whenever a print job is sent to the Xerox printer, the lpsched process run away after a few minutes.  This occurred on both a standalone workstation and on a connected workstation.

===================================================================

DTR:     D10729

SOR/STR: SOR 95-47

Title:   LAN Admin Crash

Description:

Connected a workstation to the E4000 server via ATM.  Changed the local hostname and local IP address at connect.  After connecting, any LAN Admin HMI (Sys Admin->MPLAN Admin->LAN Admin) started will crash if an entry is selected in either Connected Clients view or NIS+ Host Table View.  If a LAN Admin HMI was started before the workstation was connected, it will not crash in the above manner.

Chuck G. discovered that this occurs if 3 or more clients are connected to the server.

===================================================================

DTR:     D10730

SOR/STR: 97-11a

Title:   Update database login field in JTIM file cleanup script

Description:

The script that cleans up unsaved files from the JTIM query retrieval

dialog logs into Sybase as the current username ($LOGNAME).  Since

this is run as a cron job, $LOGNAME is set to "root", which is not a

proper database user.  Use $DB_TAMPS_OWNER (and

$DB_TAMPS_SYBPASS) instead.

===================================================================

DTR:     D10731

SOR/STR: SOR 96-01

Title:   MIDB Query printer default classification incorrect

Description:

Print option in the MIDB production tools query window defaults to an incorrect classification.  The default selection is a higher classification with caveats and there are no options for any other classification.

Same as D673 that failed in B4.

===================================================================

DTR:     D10732

SOR/STR: SOR 96-01a

Title:   Default MIDB Query dataserver on clients

Description:

The MIDB Query Tool on the permanent client (Ultra-2300) and ATM clients should show  "TAMPS_SERVER" as the default dataserver when connected instead of the local "TAMPS" dataserver.

===================================================================

DTR:     D10733

SOR/STR: SOR 97-11

Title:   Create Cron job to cleanup unsaved JTIM image files

Description:

This ITR is being used to deliver a script to clean up image files in the

JTIM directory that have not been accessed in a certain number of

days (14 to begin with) that have not been saved and cataloged into

the TAMPS imagery catalog, and a cron file entry to run this script

periodically.

This is a dupe of 630 that failed.

===================================================================

DTR:     D10734

SOR/STR: SOR 95-43

Title:   2300 perm client can't change root or tamps passwd.

Description:

The 2300 super client, could not change local  root or tamps passwd using User Admin HMI since it is always connected. Cannot easily change root using a shell since may cause other big problems. Tamps Password can be changed in a shell. This is a security issue.

===================================================================

DTR:     D10735

SOR/STR: SOR 95-43

Title:   creating new accounts

Description:

Creating accounts and typing in the passwd in both places in the new widget, then moved back to the top and retyped the passwd and selected OK: Received the following msg:

this is not a valid user name.   Still could login with all privileges.

===================================================================

DTR:     D10736

SOR/STR: SOR 96-01

Title:   Threat Density Shading Crashes appllication

Description:

OOB -> SAM -> created range rings and then selected Threat Density Shading Window: -> then selected the radio button select -> line apply and then selected the radio button select -> filled and apply and the application crashed.
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Section E.1

Operating System Installation

Sun ULTRA 2 and Enterprise 4000

Operating System Installation

1.
The following is a sequential list of steps required for proper installation of the Solaris 2.5.1 Operating System in support of TAMPS 6.2 on a Sun ULTRA 2 or Enterprise 4000 System.

a.  Instructions are marked as follows:

Installer follow steps in underline

Installer enter commands or click on fields in BOLD

Installer enter information in BOLD (or BOLD underline)

Installer follow instructions in <angle brackets> to enter required information (information inside the brackets is NOT to be typed literally)

Workstation prompts or comment in Italic

b.  Notes and Warnings are annotated as shown below, with the indicated definitions:


WARNING: 
Critical information required for successful installation of ANY TAMPS system.  Failure to heed the




Warning WILL result in a failed installation.



NOTE: 
Description of information or procedures required in the current step; OR





Important information required for successful installation of TAMPS on a standard fleet





configuration.  The Note may be disregarded on non-standard installations to meet differing





configuration requirements

General Notes and Warnings

NOTE:
Do not start Arctic installation of the CVIC Permanent Client until after the Enterprise 4000 Server has successfully completed its Arctic installation. The Permanent Client needs to able to talk to a properly configured server.

NOTE: 
On an Enterprise 4000 Server, you will be prompted for a root password at the end of the Operating System installation. Enter any root password and enter the same password when sysgen prompts for a root password. If installing to an ULTRA 2 you will not be prompted for a root password during the Operating System installation.

NOTE:  
If at any time during the TAMPS installation, the installer notes a message stating "Watchdog Reset" on the console screen, followed by an "ok" prompt, this is an indication that an automatic reboot has failed due to a transient hardware problem.  To successfully complete the installation, simply type boot at the ok prompt.  The problem causing the Watchdog Reset is usually not persistent, and should be no cause for alarm.

NOTE: 
The mouse/trackball is active during Solaris 2.5.1 installation, and is the preferred method for selecting actions.

2. 
Boot from the Solaris Operating System CD-ROM to install the Solaris Operating System.  Execute the following steps to shut the system down to run level 0 and enable a reboot from the CD/ROM.

a.
Shut down the system to the ok prompt.  Perform either step 1) or step 2) below:

1)
If currently running any version of TAMPS 6.X, use the System Shutdown TAMPS menu item to shut the system down.



Insert the Solaris 2.5.1 CD into the CD/ROM drive



Login as a TAMPS System Administrator (user tamps, or any other user with System Administrator role)



Select System Shutdown from the TAMPS Main menu bar

2)
If not running any version of TAMPS 6.X, but are running the UNIX system in multi-user mode (run level 2 or higher):



Insert the Solaris 2.5.1 CD into the CD/ROM drive



Become root (su or login)



Execute cd /



Execute shutdown -y -g0 -i0 (if running Solaris 2.2 or 2.3 OS), or init 0


or



Execute shutdown -h now (if running TAMPS 5.X with SunOS 4.1.3 operating system or earlier)

b.
Once the machine is shut down, and the "ok" prompt appears on the display:



Execute boot cdrom

NOTE: 
The boot process will take several minutes.

3.
BEGIN OPERATING SYSTEM INSTALLATION PROCESS:  Wait for the Sun Install program to come up in its Open Windows shell.  Respond to each of the prompt as discussed in the following steps.  The following pages present each Operating System window as it is displayed during installation.

Introduction



Click the Continue button.

System Identification Introduction



Click the Continue button.

System Host Name

WARNING: 
Do NOT use a host name which begins with a number.  The first character in a host name MUST be a letter for successful TAMPS installation.  For example, a host name of "server61" is valid, but a host name of "61server" will cause TAMPS installation to fail.

WARNING: 
Do NOT use a host name of tamps.

NOTE: 
You may name each machine with any name, within the bounds defined in the host name window and consistent with the above warnings.  For the purpose of this example the host name of nassau will be used throughout.



Click in the Host Name field.



Type the <host name> as desired

For example:
tamps1, or




tamps2, or




Server60, or




Client60



Click the Continue button.

Network Connectivity

WARNING:
ALL installation sites MUST select No. Sysgen will prompt for IP addresses and configure the Ethernet and ATM ports.



Click the No radio button, if it is not already selected.



Click the Continue button.

 Network Configuration Confirmation



Verify the displayed information, then



Click the Continue button.

System Time Zone

WARNING:
All TAMPS hosts must be installed as a GMT system with 0 offset for proper TAMPS operation.



Click the  Offset from GMT radio button, then



Click the Set... button.

System Time Zone Offset from GMT



Leave the Hours offset slider on 0, and



Click the Continue button.

System Date & Time

NOTE: 
Only set date and time if the default settings are incorrect.  Set the date and time to GMT date and time.



Verify correct values, or



Double Click in EACH field requiring update and  Type the appropriate date/time, then



Click the Continue button.

System Date & Time Confirmation



Verify the displayed information, then



Click the Continue button.

Solaris Software Installation Introduction



Click the Continue button.

System Software Installation Option

NOTE: 
If installing on a system on which a Solaris OS (either Solaris 2.3 from TAMPS 6.1 and earlier, or Solaris 2.5), this window will be presented to the installer.  This window will not be presented if the current system cannot be upgraded to Solaris 2.5.1 without an Initial installation.  Skip to the next page in these installation instructions if this window is not displayed.



Click the Initial button.

System Type

WARNING:
All TAMPS hosts must be installed as a UNIX OS Server system during Operating System installation. Regardless of the TAMPS configuration, every machine must be a UNIX Server.


Click the Standalone  radio button if it is not already selected.



Click the Continue button.

Server Platform Support


Click the Continue button.
Client Disk Space


Double Click in the # Clients field in the Root row.


Type 0 (for 0 Clients).


Click the Continue button.
Software Configuration

NOTE: 
The software group to select is dependent on the type of machine that the OS is being installed to.  If installing to an ULTRA 2  (which is any machine except an Enterprise 4000) select "Core System Support". If Installing to an Enterprise 4000 (LAN Server) , select "End User System Support".


List of configurations and sizes shown below are for illustration purposes only.  Sizes shown may vary depending on the actual Solaris Operating System CD being used. The actual sizes displayed are not critical and may not be modified

.



Click the Core System Support radio button if installing to an ULTRA 2.



Click the End User System Support radio button if installing to an Enterprise 4000.



Click the Continue button after selecting the appropriate software group.

Disks/File Systems

WARNING:
On an Ultra 2, Disks c0t0d0 and c0t1d0  should appear in Available Disks list originally, or the Selected Disks list after partial installation was attempted. On an Enterprise 4000, up to 30 disks should appear in the Available Disks or Selected Disks list. If one or more disks is not showing up as expected, perform the following steps on this page before proceeding further.

WARNING:
Select only the disks actually attached to your system.  The actual disk list may contain two disks with a size of "0". Hard disks will have the appropriate size indicated.  Drives with a size of "0" shown are the floppy drives attached to the system.  If such a disk of size 0 Mbytes is selected, the installation process will terminate, and the entire Operating System installation must be re-started from the beginning.
NOTE: 
 Only configure the BOOT disk during the Operating System installation.  All other drives on the system will be automatically configured by Arctic Start.


With the mouse pointer in the screen background, Press and hold the right mouse button.



Select the System Control->Halt System menu item to shut the system down.



Execute reset-all after the machine is shut down and the "ok" prompt appears on the display.



Press the <Stop> and <A> keys together until the "ok" prompt appears, after the boot process restarts.



Execute probe-scsi-all after the "ok" prompt re-appears on the display.

All drives should be displayed by probe-scsi-all. The following is an example of how an Ultra 2 Workstation should look.

/sbus@1f,0/SUNW,fas@e,8800000

Target 0


Unit 0
 Disk
SEAGATE ST19171W
...





Copyright (c) 1996 Seagate





All rights reserved

Target 1


Unit 0
 Disk
SEAGATE ST19171W
...





Copyright (c) 1996 Seagate





All rights reserved

If one or more drives are not listed, the drive hardware must be properly configured before proceeding further.



Re-execute all installation instructions starting from the system ok prompt, "Operating System Installation", Step 2b.

Disks/File Systems - Disk Selection

NOTE: 
Only the boot drive should be selected here.  Any other disk drives on the system will be automatically formatted by  Arctic Start.  If more that the boot disk is selected, you will see at least two messages about unallocated disk space.  These messages should be acknowledged and will cause no problems.

If a PC card device is attached to the system, it may show up as a disk of 0 size in list of available disks. Do not add it to list of available disks.



Click on the c0t0d0 disk in the Available Disks list.



Click the Add> button.



Click on the c0t1d0 disk in the Available Disks list.


Click the Add> button.


Click the Continue button.

Disks/File Systems - Preservation

NOTE: 
This window may not be displayed for an initial TAMPS installation.  If this window is not displayed, skip to section "Disks/File Systems - Layout Selection" in these instructions.

NOTE: 
See the section "Disk/File Systems - Partition Verification" for the partitions and sizes to be installed.



If installing TAMPS over top of an existing TAMPS installation, with IDENTICAL partition sizes:



Click the Preserve button;



Turn to the next page, section "Disks/File System - Preserve Data"  and follow the instructions there.



Otherwise, if NOT installing TAMPS over top of an existing TAMPS installation, OR  this partition sizes differ from the existing sizes:



Click the Continue button;



Skip the next page, section "Disks/File System - Preserve Data";



Turn to the following page, section "Disks/File System - Layout Selection"  and follow the instructions on that page.

Disks/File Systems - Preserve Data

WARNING:
Do NOT attempt to preserve any partitions unless ALL existing partitions are identical in size and location to those listed in the section "Disk/File Systems - Partition Verification".

WARNING:
Only preserve the partitions listed below.  Do NOT change the File System name for any partition.

NOTE: 
See the section "Disk/File Systems - Partition Verification" for the partitions and sizes to be installed.



Skip this page unless preserving one or more existing partitions.



On an Enterprise 4000,  There are no partitions that can be preserved during the OS installation.



On an ULTRA 2,  Click the Preserve radio button for each of the following partitions (use the scroll bar to view the entire partition list):



/var/audit



/maps/1



Click the Continue button.

Disks/File Systems - Layout Selection



Click the Manual Layout button.

Disks/File Systems - Preliminary Summary

NOTE: 
The summary list of file systems in this window may have more file systems listed than shown below.  The actual content will depend on what drives are selected, what file systems were previously installed on your drives, and whether or not preservation was selected.



Click the Customize... button.

Disks/File Systems - Partitions

WARNING:
Do not edit the mount point or size fields for partition 2.  Partition 2 MUST cover the entire disk.

WARNING:
The partition 1 label on the boot disk is NOT "/swap" but "swap" (no "/").

WARNING:
The partition 7 label is "/var/ftp/maps/1".  Note the "/" between "maps" and "1".

WARNING:
The database partitions (those with no mount point listed) MUST be installed with sizes on the partition numbers exactly as listed.  If the boot drive is smaller than 18 GBytes, Partition 7 (/maps/1 ) may be reduced to absorb the missing space.

NOTE: 
The section "Disk/File Systems - Partition Verification" contains a complete picture of the "Customize Disks" window.



ONLY If installing TAMPS over  top of an existing TAMPS installation, perform the following for each disk to recall the current disk partitions:



Click the Disk icon (to the upper-left of the Disk label).



Click the Load... button on the "Customize Disks by Cylinders" window.



Click the Continue button on the verification window.

NOTE: 
The "Customize Disks by Cylinders" window displays partition sizes in cylinders, not MB.  Verify correct partition sizes on the "Customize Disks" window after completing the following step.



Click the OK button on the "Customize Disks by Cylinders" window.



Skip the following section and  Turn to the "Disks/File Systems - Partition Verification" section in these instructions to verify mount points and sizes.



Otherwise, if NOT installing TAMPS over  top of an existing TAMPS installation, Turn to the "Disks/File Systems - Manual Partition" section on the next page, and follow the instructions.

Disks/File Systems - Partitions

NOTE: 
The correct disk partitions must be selected, otherwise sysgen will fail and TAMPS core will not be installed properly



If installing to an Ultra 2 workstation or  Ultra 2 Lightweight Server, goto page 1-

25



If Installing to an Enterprise 4000 Server goto page 1-

27

Disks/File Systems - Manual Partition for ULTRA 2

NOTE: 
The following partitions are for an ULTRA 2 only, which includes Workstation and Lightweight LAN configurations. If installing to an Enterprise 4000, goto page 1-

27



Click in the upper-left entry field (the Mount Point field) for disk c0t0d0.



Execute the following steps for each partition 0, 1, 3, 4, 5, 6, and 7 (skip partition 2):



Type the correct Mount Point value for the current partition.



Move to the Size field using the right arrow key.



Type the correct Size value for the current partition.



Move to the Mount Point field for the next partition using the down arrow and left arrow keys.

Disks/File Systems - Partition Verification for ULTRA 2

NOTE: 
The following partitions are for an ULTRA 2 only, which includes Workstation and Lightweight LAN configurations. If installing to an Enterprise 4000, goto page 1-

27

NOTE: 
The box in the upper left hand corner, 4090 shows the slice size of the last slice edited. It will change based last field selected in the Customize Disk dialog box.



Verify the Free space for  disk is 0 MB.  Note that "Rounding Error" may or may not be displayed.



Verify the Mount Points for disk.



Verify the Partition Sizes for  disk.



Double Click in any field containing an incorrect entry, and Type the correct value.



Click the OK button when verification complete.



Goto page 1-

29
. Ignore the pages containing slice sizes for Enterprise 4000 server.

Disks/File Systems - Manual Partition for Enterprise 4000 Server

NOTE: 
The following partitions are for an Enterprise 4000 Server only. If installing to an Ultra  2, go back to page 1-

25
 for disk slices or goto page 1-

29
 if done with disk slices.



Click in the upper-left entry field (the Mount Point field) for disk c0t0d0.



Execute the following steps for each partition 0, 1, 4, 6, and 7 (skip partitions 2,3,5):



Type the correct Mount Point value for the current partition.



Move to the Size field using the right arrow key.



Type the correct Size value for the current partition.



Move to the Mount Point field for the next partition using the down arrow and left arrow keys.

Disks/File Systems - Partition Verification for Enterprise 4000 Server

NOTE: 
The following partitions are for an Enterprise 4000 Server only. If installing to an Ultra  2, go back to page 1-

25
  for disk slices or goto page 1-

29
 if done with disk slices.

NOTE: 
The box in the upper left hand corner, 5497 shows the slice size of the last slice edited. It will change based last field selected in the Customize Disk dialog box.



Verify the Free space for  disk is 0 MB.  Note that "Rounding Error" may or may not be displayed.



Verify the Mount Points for disk.



Verify the Partition Sizes for  disk.



Double Click in any field containing an incorrect entry, and Type the correct value.



Click the OK button when verification complete.

Disks/File Systems - Final Summary

NOTE: 
The summary list of file systems in this window is accurate at this point.  Every partition on the previous verification page must be listed in this window. The picture shown on this page is for an ULTRA 2. The Enterprise 4000 server will have a different set of File Systems listed in the window.

NOTE: 
Any file system you preserved in a previous step should be marked as "PRESERVED" in the Options column.

NOTE: 
DTC-2:  The status for the all disks except the boot disk should still indicate "unconfigured".

ACE-VME:  The status for each hard disk should contain a list of mount points applied to that disk.

SPARC-10 or 20:  The status for each hard disk should contain a list of mount points applied to that disk.  Continue to format the rest of the hard drives in the list as desired, either with slices specific to your application or with any remaining space allocated to slice 7 (a mount point of /maps/x, where 'x' is the next map slice number in order, starting with 3).
NOTE: 
The diagram shown is for Ultra 2 Workstation Configuration. The list of File Systems shown will be different for a Enterprise 4000 Server.



Click the Continue button.

Disks/File Systems - Remote Mount



Click the Continue button.

Installation Profile



Review the Profile, ensuring the displayed information matches the information on this page and on the "Disks/File Systems - Partition Verification" page.   Click the Change button if any information needs correcting.



Click the Begin Installation button.

Begin Installation



Click the Reboot button.

 Installation Status

NOTE: 
Installation takes from 5 to 15 minutes from this point, depending on file systems preservation status.  The message "Installation Complete" will be displayed for several minutes while the software installation and file system creation actually completes.

NOTE: 
When the Operating System installation is complete, the installation routine will initiate an automatic system reboot.  The system is ready to proceed to the next applicable section of these instructions when a login prompt is displayed.

NOTE: 
On an Enterprise 4000 Server, you will be prompted for a root password at the end of the Operating System installation. Enter any root password and enter the same password when sysgen prompts for a root password. If installing to an ULTRA 2 you will not be prompted for a root password during the Operating System installation.

Section E.2

Sun ULTRA 2 and Enterprise 4000 Arctic Start

Sun ULTRA 2 and Enterprise 4000 Arctic Start

1.
The following is a sequential list of steps required for proper installation of the TAMPS software on a Sun ULTRA 2 TAMPS Server.

a.  Instructions are marked as follows:

Installer follow steps in underline

Installer enter commands in BOLD

Installer enter information in BOLD (or BOLD underline)

Installer follow instructions in <angle brackets> to enter required information (information inside the brackets is NOT to be typed literally)

Workstation prompts or comment in Italic

b.  Notes and Warnings are annotated as shown below, with the indicated definitions:


WARNING: 
Critical information required for successful installation of ANY TAMPS Sparc system.  Failure to heed




the Warning WILL result in a failed installation.



NOTE: 
Description of information or procedures required in the current step; OR





Important information required for successful installation of TAMPS on a Sparc





configuration.  The Note may be disregarded on non-standard installations to meet differing





configuration requirements

General Notes and Warnings

WARNING:  The Arctic instructions that follow assume the Operating System has already been installed in accordance with the instructions in Section 1.  If this is not the case, TAMPS installation may not be successful.

WARNING:  Do not start Arctic installation of the CVIC Permanent Client until after the Enterprise 4000 Server has successfully completed its Arctic installation. The Permanent Client Arctic installation will fail if it can not talk to a properly configured server. Disconnect the fiber channel to prevent sysgen from cSeeinge and formatting Server disks during Arctic installation of client.

NOTE:  
TAMPS can be installed from either the TAMPS CD-ROM, or from TAMPS Core and TAMPS MPM 8mm tapes.  Follow the instructions appropriate to the load media supplied.

NOTE:  
Some questions require certain answers.  Those questions are annotated with the allowable answers in (parentheses).

NOTE:  
Most questions have a default answer supplied.  If that answer is acceptable for your actual configuration, simply Press Return to accept the default answer .

NOTE:  
If installing TAMPS from tape, DO NOT remove the Solaris Operating System CD before beginning Arctic Start.  The Solaris CD is required during the first part of Arctic Start and will be ejected automatically when no longer needed.  If removed, you will be prompted to re-insert the CD.

NOTE: 
The default size of the /tamps slice as created by Arctic Start does NOT allow for space for all MPMs to be loaded.  A tactical MPM load is supported, with a maximum of approximately 12 MPMs.  If a non-tactical installation is required to support more MPMs, edit arctic.env for the DTC-2 and add 100 MB to the /tamps slice size.
2.
When the Operating System installation is complete, and the login prompt is displayed, begin the following procedures.

NOTE:  
Press Return after typing each of the commands or responses below.

NOTE:  
The Operating System prompts below use the host name "nassau" for illustration only.  The prompts displayed on your machine will match the actual host name entered during Operating System installation.

a.
Initiate Arctic Start after logging in as the root user.

1)
CD-ROM:  If loading TAMPS from CD-ROM:



Type the following required commands/information at the indicated prompts:



nassau console login:  root



#  csh



nassau#  eject cdrom



Remove the Solaris CD from the CD-ROM drive.  Insert the TAMPS CD, and wait for the CD-ROM status light to stop flashing.

NOTE:  
Execute the next two commands only if installing to an Ultra 2. The Enterprise 4000 should automatically mount the CD-ROM to /cdrom/cdrom0.



nassau#  mkdir /cdrom



nassau#  mount -rF hsfs /dev/dsk/c0t6d0s0 /cdrom

NOTE:  
If installing  to an Enterprise 4000 Server, cd /cdrom/cdrom0 instead of /cdrom



nassau#  cd /cdrom



nassau#  ./arctic.csh cdrom



Arctic Start displays the following message:



Installing Sysgen from CD, device /dev/dsk/c0t6d0s0.  Please wait...

2)
8mm Tape:  If loading TAMPS from 8mm tape:



Insert the TAMPS Core 8mm tape into the 8mm tape drive.



Type the following required commands/information at the indicated prompts:



nassau console login:  root



#  csh



nassau#  cd /tmp

NOTE: 
Wait for the light on the 8mm tape drive to go on steady before executing the following step.



nassau#  tar xof /dev/rmt/0



After the tar  is complete, and the system prompt returns, execute Arctic Start.



nassau#  ./arctic.csh   tape  /dev/rmt/0

The following message should appear  while sysgen retrieves the rest of its files from tape:


"Installing sysgen from tape , device /dev/rmt/0n; please wait..."

After sysgen retrieves the rest of its files,  the Main Sysgen application should start automatically.

b.
Arctic Start displays the following information, and prompts for required installation information with the questions indicated below.  Respond to each question as indicated below .

******************************************************************************************************************************************

******************************************************************************************************************************************

TAMPS System Installation

Warnings and non-fatal errors generated during installation are recorded in log files under the /var/adm/arctic_logs directory.

******************************************************************************************************************************************

******************************************************************************************************************************************

******************************************************************************************************************************************

SYSTEM CONFIGURATION INFORMATION

******************************************************************************************************************************************

Verify the configuration information presented. Enter selections as required/desired.

Allowable answers, if applicable, are shown in (), may be abbreviated, and may be entered in upper or lower case. Type <Return> to select the default show in []. if applicable.

*** Type <Return> to continue> ***



<Press Return Key>

******************************************************************************************************************************************

TAMPS Supported Installation Systems

******************************************************************************************************************************************

******************************************************************************************************************************************


Index
System Description

******************************************************************************************************************************************


                    Standard End-User Configurations


1
Sun ULTRA 2 Workstation


2
Sun Enterprise 4000 LAN Server


3
Sun ULTRA 2 Lightweight LAN Server Workstation


4       
Sun ULTRA 2 CVIC LAN Permanent Client Workstation

******************************************************************************************************************************************


                   Enter the  INDEX of the system to be installed (1-4) [1]:



Enter 1,2,3 or 4 to select the type of system to be installed.

NOTE:  
Mission planning is done on an ULTRA 2 workstation. This option is used for standalone workstations and workstation clients that will be connected to an Mission Planning Local Area Network (MPLAN).

NOTE:  
The Enterprise 4000 Server is used in an MPLAN configuration onboard an aircraft carrier.

NOTE:  
The ULTRA 2 Lightweight configuration is used for shore based MPLAN configuration which do not have an Enterprise 4000 machine.

NOTE:  
The ULTRA 2 CVIC LAN Permanent Client Workstation is a Mission Planning workstation that must always be connected to an Enterprise 4000 server and cannot operate in standalone mode.

WARNING: The Enterprise 4000 server must be installed before installing the Permanent Client

ROOT PASSWORD

The root password has not been set.

A password may contain any number of characters, but only the first eight characters are significant.  For example, if the password is entered as 'a1b2c3d4e5f6', then 'a1b2c3d4' could also be used to gain root access.

You will be prompted to enter the password twice.  The password will not appear on the screen as you type it.



Enter the root password (press <Return> to continue):  <root password as desired>



Re-enter the root password: <re-type the root password >

NOTE: 
On an Enterprise 4000 Server, you must enter the same password as was entered at the end of the Operating System installation.  If installing on an ULTRA 2 you may enter any password.

MIDB UNIQUE SERVER ID

The MIDB database requires a unique 5-digit numerical Server

ID on each machine for proper operation.  This code, also

known as the MIDB Site Code, should be assigned to each

TAMPS machine by higher authority.

If no such code is available, accept the default.  However,

either of any 2 machines with identical Server IDs will be

unable to import MIDB data created on the other.



Enter the MIDB unique Server ID [00000]:  <type ServerID code>

You selected a Server ID of '00001'.



         Is this correct (y or n)?   <type y or n>

NOTE: 
At this point in sysgen, the prompts will differ based on the configuration selected.


Refer to section 2-A for Ultra 2 Workstation specific prompts.


Refer to section 2-B for Enterprise 4000 Server specific prompts.


Refer to section 2-C for Ultra-2 Server Light specific prompts.


Refer to section 2-D for CVIC LAN Permanent Client Workstation specific prompts.

NOTE:  Refer to Section 3 after answering all the configuration specific prompts

_

Section 2-A

Ultra 2 Workstation Specific Prompts for Sysgen

WARNING:  
It is critical that the correct responses be determined before attempting to start installation. Currently the only way to recover from a mistake is to reinstall from scratch.

NOTE:  
Prompt for secondary IP Address (hme1) will not be shown unless the port is detected by sysgen.

TAMPS 6.2 SUN ULTRA 2 STANDALONE WORKSTATION EXTERNAL INTERFACES

System Network IP Address, Ethernet port hme0:

UNCONFIGURED

Secondary IP Address, Ethernet port hme1:

UNCONFIGURED


 ATM Network IP Address,  port el0:  

UNCONFIGURED

Configure Default Network Router:  

YES (UNCONFIGURED)

Connect to the GCCS Weather Profiler:  

YES (jots1 @ 121.0.0.1)

Configure JSIPS-N:  

YES (UNCONFIGURED)

Configure NAVSSI:  

YES (UNCONFIGURED)

Configure SIPRNET:  

NO

Configure TSCM:  

NO



Are these values correct (y or  n) ? <enter  y or  n>

NOTE:  
If the answer is Yes to Are these values correct?, sysgen will prompt for detailed information about the items listed as UNCONFIGURED.  Answer No  if any of the above items listed above are incorrect.

NOTE:
If the Answer is No to Are these values correct?,  sysgen will prompt for all the items beginning on the next page. Sysgen will only prompt for detailed information on an item if the answer is Yes to Configure item.

NOTE:  
The Ethernet port (hme0) is the workstations primary IP address when operating in standalone mode. The ATM port (el0) is the workstations primary IP address when connected as a client to Enterprise 4000 server in an MPLAN configuration.



System Ethernet Network IP Address, port hme0 [UNCONFIGURED]:

<enter IP address>



Secondary IP Address, Ethernet port hme1 [UNCONFIGURED]:


<enter IP address>



System Network Address,  ATM port el0 [UNCONFIGURED]: 


<enter IP address>

NOTE:  
The Default Network Router is connected to the Ethernet Hub or the ATM switch, and is used to communicate with external systems such as JSIPS, GCCS, etc. If you answer NO to cconfigure Default Routere, then TAMPS IP address must be on same class C network as the external systems. TAMPS will usually be on a different class C network, therefore, you should answer  NO to Configure Default Router only if TAMPS will not be communicating with any external systems.



Configure Default Network Router (YES, NO) [YES]:  




<enter YES or NO>




Default Network Router hostname:  





<enter hostname>




Default Network Router Host IP Address:  




<enter IP address>

NOTE:  
The GCCS Weather Profiler is an external system which TAMPS can use to obtain Weather Overlays that can be displayed in background of TAMPS window to show weather related data.


       Connect to the GCCS Weather Profiler (YES, NO) [YES]:  




<enter Yes or NO>


         

GCCS Weather Profiler hostname:  [jots1]





<enter hostname>


         
GCCS Weather Profiler IP address:  [121.0.0.1]





<enter IP address>

NOTE:  
Joint Service Imagery Processing System (JSIPS-N) is an external system which TAMPS can use to retrieve Imagery and Imagery related products.


       Configure JSIPS-N (YES, NO) [YES]:  






<enter Yes or NO>



       
JSIPS-N Server hostname:  







<enter hostname>


       
JSIPS-N Server IP address:  







<enter IP address>


       
JSIPS-N Server TCP port number [1200]:  





<enter port number>

NOTE:  
NAVSSI is an external system which TAMPS can use to retrieve GPS Almanac data


       Configure NAVSSI (YES, NO) [YES]:  






<enter Yes or NO>


       
NAVSSI Server hostname:  







<enter hostname>


       
NAVSSI Server IP address:  







<enter IP address>

NOTE:  
SIPRNET is an external system which TAMPS can use to retrieve GPS Almanac data


       Configure SIPRNET (YES, NO) [NO]:  






<enter Yes or NO>


       
SIPRNET Server hostname: 







<enter hostname>


       
SIPRNET Server IP address:  







<enter IP address>










NOTE:  
TSCM  is an external system which TAMPS can use to exchange Routes with.


       Configure TSCM (YES, NO) [NO]:


       
TSCM Server hostname:  







<enter hostname>


                TSCM Server IP address:







<enter IP address>

NOTE:  
Goto Section 3 to complete sysgen installation.

_

Section 2-B

Enterprise 4000 Server Specific Prompts for Sysgen

WARNING:  
It is critical that the correct responses be determined before attempting to start installation. Currently the only way to recover from a mistake is to reinstall.

NOTE:  
Prompt for Printer IP Address (hme1) will not be shown unless the port is detected by sysgen.

TAMPS 6.2 SUN ENTERPRISE 4000 LAN SERVER EXTERNAL INTERFACES

System Network IP Address, ATM port el0:  
UNCONFIGURED

Configure Default Network Router:  
YES (UNCONFIGURED)

TAMPS CVIC Permanent Client (backup server):  
YES (UNCONFIGURED)

HP LaserJet 6MP Printer IP Address:  
UNCONFIGURED

Connect to the GCCS MIDB Database:  
YES (GCCS_MIDB  Defaults)

Connect to the GCCS Weather Profiler:  
YES (jots1 @ 121.0.0.1)

Configure JSIPS-N:  
YES (UNCONFIGURED)

Configure NAVSSI:  
YES (UNCONFIGURED)

Configure SIPRNET:  
NO

Configure TSCM:  
NO



Are these values correct (y or  n) ? <enter  y or  n>

NOTE:  
If the answer is Yes to Are these values correct?, sysgen will prompt for detailed information about the items listed as UNCONFIGURED.  Answer No  if any of the above items listed above are incorrect.


If the Answer is NO to Are these values correct?,  sysgen will prompt for all the items beginning on the next page. Sysgen will only prompt for detailed information on an item if the answer is Yes to Configure item.

NOTE:  
See Appendix A for information configuring the HP LaserJet 6MP Printer.

NOTE:  
The primary ATM interface is the shipboard IP address used to communicate with the clients on an MPLAN and is published by IT21. The Ethernet port (hme0) is used to communicate with the printers.



System Network Address,  ATM port el0 [UNCONFIGURED]: 


<enter IP address>



System IP Address on the printer network,




network, Ethernet port hme0 [UNCONFIGURED]:


<enter IP address>




NOTE:  
The Default Network Router is connected to the Ethernet Hub or the ATM switch, and is used to communicate with external systems such as JSIPS, GCCS, etc. If you answer NO to cconfigure Default Routere, then TAMPS IP address must be on same class C network as the external systems. TAMPS will usually be on a different class C network, therefore, you should answer  NO to Configure Default Router only if TAMPS will not be communicating with any external systems.



Configure Default Network Router (YES, NO) [YES]:  



<enter YES or NO>




Default Network Router hostname:  




<enter hostname>




Default Network Router Host IP Address:  



<enter IP address>

WARNING:   You must install the Permanent client after the Server installation has completed. When installing the Permanent Client, the hostname and IP Address entered here must also be used when loading the Operating System on the Permanent Client.



TAMPS CVIC Permanent Client hostname:  




<enter hostname>


            
TAMPS CVIC Permanent Client Host IP Address 



<enter IP address>



HP LaserJet 6MP Printer IP Address :  





<enter IP address>

NOTE:  
GCCS is an external system used by TAMPS to receive MIDB threat updates. Anytime a change is made to the GCCS MIDB database, the changes are automatically replicated down to the Enterprise 4000 Server. The following information is required in order to properly setup a Sybase replication subscription.

NOTE:

The default values should work, however, the GCCS administrator should be consulted to confirm the responses.


GCCS MIDB DATA SERVER PARAMETERS


         
Connect to the GCCS MIDB Database (YES, NO) [YES]:  



<enter YES or NO>


         

GCCS MIDB Server hostname [jots19]:  





<enter hostname>


         

GCCS MIDB Server IP address [121.0.0.19]:  




<enter IP address>


         

Name of the GCCS MIDB Sybase Data Server [SDS]:  



<enter name of server>


         

GCCS MIDB Server port [3000]:  





<enter port number>


         

Password for the 'sa' user on the GCCS MIDB Data Server [MARS10]:  

<enter sa password>


         

Name of the GCCS MIDB primary Database [GMI]:  



<enter name of database>



GCCS MIDB Replication Server Parameters


         

GCCS MIDB Replication Server hostname:  [jots19]



<enter hostname>


         

GCCS MIDB Replication Server IP address:  [121.0.0.19]



<enter IP address>


         

Name of the GCCS MIDB Sybase Replication Server:  [RSV] 


<enter name of server>


         

GCCS MIDB Replication Server port:  [3006]




<enter port number>


         

Name of the GCCS MIDB Sybase Replication ID Server:  [RSV]


<enter name of server>


         

GCCS MIDB Replication ID Server port:  [3006]




<enter port number>


         

Password for the 'sa' user on the GCCS MIDB Replication Server:  [MARS10]
<enter password>


         

Password for the Subscription Creation user, 'isds_rssa', on the GCCS




MIDB Data and Rep Servers:  [MARS10]




<enter password>


         

Name of the GCCS MIDB RSSD (Replication Server Database):  [RSV_RSSD]
<enter name of database>

NOTE:  
The GCCS Weather Profiler is an external system which TAMPS can use to obtain Weather Overlays that can be displayed in background of TAMPS window to show weather related data.


       Connect to the GCCS Weather Profiler (YES, NO) [YES]:  




<enter Yes or NO>


         

GCCS Weather Profiler hostname:  [jots1]





<enter hostname>


         
GCCS Weather Profiler IP address:  [121.0.0.1]





<enter IP address>

NOTE:  
Joint Service Imagery Processing System (JSIPS-N) is an external system which TAMPS can use to retrieve Imagery and Imagery related products.


       Configure JSIPS-N (YES, NO) [YES]:  






<enter Yes or NO>



       
JSIPS-N Server hostname:  







<enter hostname>


       
JSIPS-N Server IP address:  







<enter IP address>


       
JSIPS-N Server TCP port number [1200]:  





<enter port number>

NOTE:  
NAVSSI is an external system which TAMPS can use to retrieve GPS Almanac data


       Configure NAVSSI (YES, NO) [YES]:  






<enter Yes or NO>


       
NAVSSI Server hostname:  







<enter hostname>


       
NAVSSI Server IP address:  







<enter IP address>

NOTE:  
SIPRNET is an external system which TAMPS can use to retrieve GPS Almanac data


       Configure SIPRNET (YES, NO) [NO]:  






<enter Yes or NO>


       
SIPRNET Server hostname: 







<enter hostname>


       
SIPRNET Server IP address:  







<enter IP address>










NOTE:  
TSCM  is an external system which TAMPS can use to exchange Routes with.


       Configure TSCM (YES, NO) [NO]:


       
TSCM Server hostname:  







<enter hostname>


                TSCM Server IP address:







<enter IP address>

NOTE:  
Goto Section 3 to complete sysgen installation.

_

Section 2-C

Ultra 2 Server Light Specific Prompts for Sysgen

 WARNING:  
It is critical that the correct responses be determined before attempting to start installation. Currently the only way to recover from a mistake is to reinstall from scratch.

TAMPS 6.2 SUN ULTRA 2 LIGHTWEIGHT LAN SERVER WORKSTATION EXTERNAL INTERFACES

Client Network type:

ETHER

System Ethernet Network IP Address, port hme0:

UNCONFIGURED

Secondary IP Address, Ethernet port hme1:

UNCONFIGURED

System ATM Network IP Address,  port el0:  

UNCONFIGURED

Configure Default Network Router:  

YES (UNCONFIGURED)

Connect to the GCCS Weather Profiler:  

YES (jots1 @ 121.0.0.1)

Configure JSIPS-N:  

YES (UNCONFIGURED)

Configure NAVSSI:  

YES (UNCONFIGURED)

Configure SIPRNET:  

NO

Configure TSCM:  

NO



Are these values correct (y or  n) ? <enter  y or  n>

NOTE:  
If the answer is Yes to Are these values correct?, sysgen will prompt for detailed information about the items listed as UNCONFIGURED.  Answer No  if any of the above items listed above are incorrect.


If the Answer is NO to Are these values correct?,  sysgen will prompt for all the items beginning on the next page. Sysgen will only prompt for detailed information on an item if the answer is Yes to Configure item.

NOTE:  
The TAMPS Client Network type determines if ATM or Ethernet will be used as the Server Lights primary IP address. The answer to this prompt depends on which type of network connection the clients will be using to communicate with the Server Light.



TAMPS Client Network type (ETHER,ATM) [ETHER]



<enter ETHER or ATM>

NOTE:   
If Client Network type is set to ETHER then IP address for hme0 will be used to communicate with clients. You will not see the


prompts for hme1 (second Ethernet port) if this port do not physically exist.



System Ethernet Network IP Address, port hme0 [UNCONFIGURED]:

<enter IP address>



Secondary IP Address, Ethernet port hme1 [UNCONFIGURED]:


<enter IP address>



System Network Address,  ATM port el0 [UNCONFIGURED]: 


<enter IP address>

NOTE:  
The Default Network Router is connected to the Ethernet Hub or the ATM switch, and is used to communicate with external systems such as JSIPS, GCCS, etc. If you answer NO to cconfigure Default Routere, then TAMPS IP address must be on same class C network as the external systems. TAMPS will usually be on a different class C network, therefore, you should answer  NO to Configure Default Router only if TAMPS will not be communicating with any external systems.



Configure Default Network Router (YES, NO) [YES]:  




<enter YES or NO>




Default Network Router hostname:  





<enter hostname>




Default Network Router Host IP Address:  




<enter IP address>

NOTE:  
The GCCS Weather Profiler is an external system which TAMPS can use to obtain Weather Overlays that can be displayed in background of TAMPS window to show weather related data.


       Connect to the GCCS Weather Profiler (YES, NO) [YES]:  




<enter Yes or NO>


         

GCCS Weather Profiler hostname:  [jots1]





<enter hostname>


         
GCCS Weather Profiler IP address:  [121.0.0.1]





<enter IP address>

NOTE:  
Joint Service Imagery Processing System (JSIPS-N) is an external system which TAMPS can use to retrieve Imagery and Imagery related products.


       Configure JSIPS-N (YES, NO) [YES]:  






<enter Yes or NO>



       
JSIPS-N Server hostname:  







<enter hostname>


       
JSIPS-N Server IP address:  







<enter IP address>


       
JSIPS-N Server TCP port number [1200]:  





<enter port number>

NOTE:  
NAVSSI is an external system which TAMPS can use to retrieve GPS Almanac data


       Configure NAVSSI (YES, NO) [YES]:  






<enter Yes or NO>


       
NAVSSI Server hostname:  







<enter hostname>


       
NAVSSI Server IP address:  







<enter IP address>

NOTE:  
SIPRNET is an external system which TAMPS can use to retrieve GPS Almanac data


       Configure SIPRNET (YES, NO) [NO]:  






<enter Yes or NO>


       
SIPRNET Server hostname: 







<enter hostname>


       
SIPRNET Server IP address:  







<enter IP address>










NOTE:  
TSCM  is an external system which TAMPS can use to exchange Routes with.


       Configure TSCM (YES, NO) [NO]:


       
TSCM Server hostname:  







<enter hostname>


                TSCM Server IP address:







<enter IP address>

NOTE:  
Goto Section 3 to complete sysgen installation.

_

Section 2-D

CVIC LAN Permanent Client Workstation Specific Prompts for Sysgen

WARNING:  
It is critical that the correct responses be determined before attempting to start installation.  Currently the only way to recover from a mistake is to reinstall from scratch.



TAMPS 6.2 SUN ULTRA 2 CVIC LAN PERMANENT CLIENT WORKSTATION EXTERNAL INTERFACES

System Network IP Address, ATM port el0:
UNCONFIGURED

System IP Address on the printer network, Ethernet port hme0:
UNCONFIGURED

System IP Address on the PC Workstation network,

Ethernet port hme1:
UNCONFIGURED

TAMPS CVIC Server:
YES (UNCONFIGURED)

Xerox DocuPrint C55 Printer IP Address:
UNCONFIGURED



Are these values correct (y or  n) ? <enter  y or  n>

NOTE:  
If the answer is Yes to Are these values correct?, sysgen will prompt for detailed information about the items listed as UNCONFIGURED.  Answer No  if any of the above items listed above are incorrect.


If the Answer is NO to Are these values correct?,  sysgen will prompt for all the items beginning on the next page. Sysgen will only prompt for detailed information on an item if the answer is Yes to Configure item.

NOTE:  
See Appendix A for information configuring the HP LaserJet 6MP Printer.

WARNING:  
The IP Address for ATM port el0 must be the same IP address that was used to answer the Enterprise 4000 Server prompt, cTAMPS CVIC Permanent Client Host IP Addresse.  If a different IP address is entered for these two prompts, then the Client


installation may fail or fail to properly configure client.

NOTE:  
The primary ATM interface is the shipboard IP address used to communicate with the Enterprise 4000 Server. The Ethernet port (hme0) is used to communicate with the printers. The Ethernet port (hme1) is used to communicate with the PC X terminals.



System Network Address,  ATM port el0 [UNCONFIGURED]: 


<enter IP address>



System IP Address on the printer network,




Ethernet port hme0 [UNCONFIGURED]:



<enter IP address>



System IP Address on the PC Workstation network,




Ethernet port hme1[UNCONFIGURED]:




<enter IP address>

NOTE:  
The CVIC Server is the Enterprise 4000 that the CVIC client will be permanently connected to.



TAMPS CVIC Server hostname:






<enter hostname>



TAMPS CVIC Server  Host IP Address [UNCONFIGURED]:


<enter IP address>

NOTE:  
The CVIC Permanent Client communicates with the Xerox printer via Ethernet (hme0)



Xerox DocuPrint C55 Printer IP Address {UNCONFIGURED]:


<enter IP address>

NOTE:  
Goto Section 3 to complete sysgen installation

_

Section E.3

Finishing Sysgen Installation
NOTE:  
You should see a prompt similar but not identical to the one below after answering the configuration specific prompts.

TAMPS ULTRA SYSTEM CONFIGURATION PARAMETERS

TAMPS 6.2  system will be configured as follows:

Configure external interfaces:   NO

Peripheral devices to be installed ,


                                    for Sun Workstation:   DEFAULT

Message PLAD for  COMMS package:   TAMPS

Set up as a COMPASS multicast router:   NO

Maps to be preserved, if able:   YES

.



Are these values correct (y or  n) ? <enter  y or  n>

NOTE:  
For standard fleet configurations , answering  Yes to accept default configuration parameters should be sufficient. If you wish to change the default parameters listed, answer  No . You will then be  prompted for the changes  to make to the configuration parameters.

FINAL CONFIRMATION

You have fully specified the system configuration. Automatic TAMPS 6.2 system installation is ready to begin.

You  may change any configuration parameter now, or install with the current configuration. Type 'no' at the following prompt to further modify the configuration.



Install a TAMPS 6.2 SUN ULTRA Workstation as currently specified (y or n) ? <enter  y or  n>

NOTE:  
If you answer No ,  you will be taken back to the previous screens,  where you can change the default parameters.

3.
Arctic Start will now proceed autonomously until the system is ready for "tamps" user login in approximately 2 Ω hours on an ULTRA 2, and 6-12 hours on a Enterprise 4000 server. The system will be automatically rebooted 3 to 4 times before completion.  Arctic Start will print status messages on the console display to keep you informed of progress.  The general content of those messages is reproduced below for information purposes only.

WARNING:  
If at any time during the TAMPS installation, the installer notes a message stating "Watchdog Reset" on the console screen, followed by an "ok" prompt, this is an indication that an automatic reboot has failed due to a transient hardware problem.  To successfully complete the installation, simply type boot at the ok prompt.  The problem causing the Watchdog Reset is usually not persistent, and should be no cause for alarm.

NOTE:  
Results of Arctic Start are recorded in log files contained in the /var/adm/arctic_logs directory.

NOTE:  
The order and content of the actual messages may differ from those reproduced below.  Differences should not be cause for alarm.  Failure of the TAMPS installation at any point is indicated unambiguously by either:  an error message stating that Arctic has exited unexpectedly, followed by a login prompt; or a reboot followed immediately by a login prompt with no intervening messages from Arctic.  In any of these cases, check the log files in /var/adm/arctic_logs for the source of the error.

"Starting TAMPS core installation..."

"Verifying proper  media  loaded..."

Starting first reboot..."

NOTE:  
At this point, Arctic will initiate the first of the automatic system reboots.  Once the reboot is complete, the messages will continue as follows.

Continuing TAMPS core installation(arctic_1)...

Creating disk slices...

Creating directories...

Creating symbolic links...

Installing core tarsets...

Configuring network interfaces...

Copying system files...

Updating tamps.env...

Updating arctic.env...

Updating WSE Menus...

Installing the Basic Security Module...

Setting eeprom variable, diag-level to min...

Starting next reboot...

NOTE:  
At this point, Arctic will initiate the second of the automatic system reboots.  Once the reboot is complete, the messages will continue as follows.

Continuing TAMPS core installation(arctic_2)...

Copying second set of system files...

Updating system services file...

Installing Go/NoGo...

Installing NIS+ server...

Adding system accounts to UNIX...

Setting up Anonymous FTP...

Setting directory ownership, group, and permissions...

Creating second set of symbolic links...

Changing file ownership, group, and permissions...

Installing Sybase database and creating databases

Installing Sybase interface file updates...

Updating Sybase Server Messages to 11.0.2.2

Populating TAMPS databases...

Populating MIDB databases...

Exporting File system ...

Copying third set of system files...

Installing XDM...

Installing startup scripts...

Installing root cron jobs...

Installing Comms license...

Installing Printer Software...

Starting final reboot...

4. 
At this point in the installation, the TAMPS Server will initiate a final reboot.  When the Server reboot is complete, a login window will be displayed on the Server display.  The TAMPS system has now completed Server installation of TAMPS Core software, and  is ready for login by the "tamps" user.  After login, MPMs may be installed, user accounts may be created, and data load may be initiated.

5.
See the MPM Installation section for MPM installation procedures.

6.
If Maps Data was preserved during Arctic Start, the existing maps files must be re-entered in the Maps Catalog.  As a TAMPS user with DBA privileges, bring up the DBA Core, select the Update -> Map Catalog menu item, and use the Update Map Catalogs function to individually enter each ADRG and DTED name in the catalog.  Note that only ADRG and DTED can be automatically re-entered.

Section E.4

MPM Installation
MPM Installation

1.
TAMPS Core software installation (Arctic Start) must be successfully completed before MPM installation is attempted.  The MPM installation function must be initiated from the System Admin -> Load MPMs menu item from the TAMPS Workstation Executive Menu bar after login as a System Administrator (such as the "tamps" user, or other created user with System Administration privileges).

2.
Follow the steps below to install MPMs.

WARNING:
The standard size of the /tamps slice does NOT allow for space for all MPMs to be loaded.  A tactical MPM load is supported, with a maximum of approximately 12 MPMs.  An attempt to load more MPMs than this may result in the /tamps slice filling up, and the MPM installation may fail.
NOTE: 
The TAMPS Workstation Executive Menu Bar will contain the updates from the latest MPM load only in login sessions started after the load is complete.

NOTE: 
MPM installation may be performed on either the TAMPS Server or the Client (if a Client/Server configuration is loaded).  Each MPM need only be loaded one time, from either the Client OR the Server, to be accessible from all TAMPS workstations.
NOTE: 
Any MPM may be installed, or re-installed, after TAMPS Core installation has been completed.

NOTE: 
The MPM installation window is completely graphically driven, and requires the use of the system mouse/trackball.



Log in as a TAMPS user with System Administration privileges.



Click the System Admin -> Load MPMs menu item on the TAMPS Workstation Executive menu bar.



Click the Install MPMs menu button



Select the device from which MPMs will be loaded, either CD-ROM, 8mm Tape, or QIC-150 Tape.

NOTE: 
If installing from CD-ROM, the TAMPS CD must be inserted in the CD-ROM drive, and the CD-ROM light must be our before clicking OK.  If installing from 8mm Tape, the MPM tape must be inserted in the tape drive, and the tape drive light must be on steady before clicking OK.



Click the OK button

NOTE: 
The list of MPMs presented in the software selection window will vary according to the MPMs actually delivered on the TAMPS CD or TAMPS MPM tape.  If a sufficient number of MPMs are available, the list is presented in a scrollable window.

NOTE: 
The entire MPM list is DESELECTED by default.  To select MPMs for load, either:  click the Select All button to select all MPMs, then individually, click on MPMs not desired for load to deselect them; or, individually click each MPM that you want loaded on your system.



Select the MPMs to be loaded at this time, using the Select All and Deselect All buttons as well as individual selections from the MPM list.



Click the Execute button to initiate the MPM load.

3. 
MPM installation status is indicated by status message windows displayed over the MPM Installation window.  Detailed status is also recorded in the Install Log window at the bottom of the MPM Installation window.  The status messages are also permanently recorded in the log file named at the top of the log window for later access.  MPM installation completion is indicated by the message "MPM load complete on host <Server Host Name>."  When MPM installation is complete, either select a different set of MPMs to load, or:



Click the Quit button.

4. 
If MPM installation from a different media is desired at this point, start over from the Install MPMs menu selection above.  Otherwise,



Click the Exit button.

5. If installation was from tape, the tape will be rewound.  If installation was from CD-ROM, the CD will be ejected.  Finally, the MPM window will close.
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Appendix A

Enterprise 4000 Server Information

Enterprise 4000 Key Switch

NOTE: 
The Enterprise 4000 has a key switch on the front panel which can be set in one of four positions. This switch is used to turn the power on and off to the main module containing the CPUs. This switch does not turn off power to the disk array which has its own separate power switch in the back.

During normal operation, the key switch should be set to the locked position. The key can then be removed and stored in a safe and secured location. This will prevent anyone from walking up the front of the Enterprise 4000 server and turning off the power or halting system by pressing ëStop-Aí on the console keyboard. During installation, the switch may be set to any of the 3 ON positions.

WARNING:  
Do not press Stop-A unless the Operating System is locked up and there is no other way to reboot the system.  One or more file systems may become corrupted because the system was not shutdown properly.
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Enterprise 4000 Network Connections
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Enterprise 4000 Printer Setup 

NOTE: 
The Enterprise 4000 does not have a parallel port, however, most printers including the HP 6MP laser printer are designed to communicate with the computer via a parallel port. To get around this problem, the Enterprise 4000 is connected to the JetDirect Ex Plus PrintServer through its primary Ethernet port (hme0). The JetDirect Ex Plus PrintServer is then connected the printer with a parallel port cable. See diagram on previous page labeled,  ìEnterprise 4000 Network Connectionsî.

NOTE: 
Sysgen will prompt for the IP address of the HP 6MP laser printer. The IP address is actually for the JetDirect Ex Plus PrintServer.

NOTE: 
Sysgen will attempt to reconfigure the JetDirect PrintServer to the IP address specified by the installer when running Sysgen. In order to do this, Sysgen must able to talk to the JetDirect PrintServer using the factory default IP address of 192.0.0.192 or the IP address specified during Sysgen. If the IP address is different then the factory default or sysgen specified value, then installation of the HP 6MP laser printer will fail, because sysgen cannot talk to the PrintServer. This can happen if TAMPS is reloaded with a different printer IP address, or the JetDirect PrintServer is moved from one TAMPS system to another.


To reset JetDirect PrintServer to its factory default IP address of 192.0.0.192, do the following:

1)  Disconnect power cord from JetDirect PrintServer

2)  Press test button on top of JetDirect PrintServer and keep button depressed

3)  With test button still pressed, plug power cord back in

4)  Wait five seconds, and then release test button

5)  Wait about five minutes for the JetDirect PrintServer to reset itself


To Check the current settings, do the following:

1)  Make sure the JetDirect PrintServer and printer are connected via parallel port cable

2)  Make sure printer is properly setup (toner and paper is in printer)

3)  Press test button on top of JetDirect PrintServer for 1 to 2 seconds.

4)  Two test pages should be printed, which includes the current IP address

NOTE: 
If Printer installation fails during Sysgen, then system will attempt to reinstall printer every time the machine is rebooted. Once printer has been successfully installed, the system will stop trying to install the printer on every reboot. The printer can also be reinstalled manually by typing the following commands as user, root:

1)  source /sysgen/common/env/arctic.env

2)  /sysgen/arctic/scripts/reinstall/install_printer

Appendix B

Ultra 2 Model 2300 Information

   Ultra 2 Model 2300 Printer Setup

NOTE: 
The 2300 CVIC Permanent Client uses the primary Ethernet port (hme0) instead of Parallel Port to communicate with the Xerox DocuPrint C55 Printer. Currently Sysgen does not automatically set the IP address for the Xerox printer. The IP address for the Xerox printer attached to the Permanent Client must be set manually using the following instructions.

NOTE: 
The front panel of the Xerox printer has a display, that allows you to negotiate through menu selections. There are two lines in the display. The first line shows the current menu selected. The bottom line, shows the next <menu item> that will be selected if the Enter button is pressed.  Use the ìPreviousî or ìNextî button to toggle through all menu choices, and press the ìEnterî button to select the menu choice. Press ìMenuî button to return to top of menu hierarchy.

1)  Take the printer off-line by Pressing the ìOn-lineî button until the On-line light is off.

2)  Press the ìMenuî button which will take you to the menu, TOP MENU

3)  Select ìCommunicationsî menu 

4)  Select ìNetwork Setupî menu

5)  Select ìTCP/IPî menu

6)  Select ìIP Addressî menu

7)  Select ìSet IP Addressî menu

8)  Set IP address. Use ìPreviousî or ìNextî  to change value of blinking number, and press ìSelectî button to move to next digit.
9)  Put the printer back on line by press ìOn-lineî button. On-line light should be on
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